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1 FOREWORD

Foreword
The U.S. Army Corps of Engineers' River Analysis System (HEC-RAS) is software that allows you to 
perform one-dimensional steady flow hydraulics; one and two-dimensional unsteady flow river 
hydraulics calculations; quasi Unsteady and full unsteady flow sediment transport-mobile bed 
modeling; water temperature analysis; and generalized water quality modeling (nutrient fate and 
transport).

The first version of HEC-RAS (version 1.0) was released in July of 1995. Since that time there have 
been several major releases of this software package, including versions: 1.1; 1.2; 2.0; 2.1; 2.2; 3.0, 
3.1, 3.1.1, 3.1.2, 3.1.3, 4.0, 4.1, 5.0 and now version 6.0 in 2020.
The HEC-RAS software was developed at the Hydrologic Engineering Center (HEC), which is a division 
of the Institute for Water Resources (IWR), U.S. Army Corps of Engineers.

The software was designed by Mr. Gary W. Brunner, leader of the HEC-RAS development team. The 
user interface and graphics were programmed by Mr. Mark R. Jensen, Alex Kennedy, Anton Rotter-
Sieren, Cameron Ackerman, and Stanford Gibson. The steady flow water surface profiles 
computational module and the majority of the one-dimensional unsteady flow computations 
modules was programmed by Mr. Steven S. Piper. The One-dimensional unsteady flow matrix 
solution algorithm was developed by Dr. Robert L. Barkau (Author of UNET and HEC-UNET). 
The two-dimensional unsteady flow modeling capabilities were developed by Gary W. Brunner, Ben 
Chacon (Resource Management Consultants, RMA), Steve S. Piper, Mark R. Jensen, Alex J. Kennedy, 
and Alex Sanchez.

The sediment transport interface module was programmed by Mr. Stanford A. Gibson. The quasi 
unsteady flow computational sediment transport capabilities were developed by Stanford A. Gibson 
and Steven S. Piper. The Unsteady flow sediment transport modules were developed by Stanford A. 
Gibson, Steven S. Piper, and Ben Chacon (RMA). Special thanks to Mr. Tony Thomas (Author of HEC-6 
and HEC-6T) for his assistance in developing the quasi-unsteady flow sediment transport routines 
used in HEC-RAS. The two-dimensional sediment transport modules were developed by Alex 
Sanchez and Stanford Gibson. The Debris flow capabilities in HEC-RAS (1D and 2D) were developed 
by Stanford Gibson and Alex Sanchez. Most of the sediment output was designed by Stanford Gibson 
and Alex Sanchez and programmed by Anton Rotter-Sieren.

The new 2D plotting library and plots (Breach Plot, Hydrographs, and DSS viewer) were developed by 
Mark R. Jensen, Anton Rotter-Sieren, and Ryan Miles (RMA).

The new 3D visualization tool was developed by Anton Rotter-Sieren and Alex Kennedy.

The water quality computational modules were designed and developed by Mr. Mark R. Jensen, Dr. 
Cindy Lowney and Zhonglong Zhang (ERDC-RDE-EL-MS).

The spatial data and mapping tools (RAS Mapper) were developed by Mark R. Jensen, Cameron T. 
Ackerman, Alex J. Kennedy, and Anton Rotter-Sieren. Special thanks to Mr. Will Breikreutz for his 
assistance in developing the RAS Tile server.
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The interface for channel design/modifications was designed and developed by Mr. Cameron T. 
Ackerman and Mr. Mark R. Jensen. The stable channel design functions were programmed by Mr. 
Chris R. Goodell.

The routines that import HEC-2 and UNET data were developed by Ms. Joan Klipsch. The routines for 
modeling ice cover and wide river ice jams were developed by Mr. Steven F. Daly of the Cold Regions 
Research and Engineering Laboratory (CRREL).

Many other HEC staff members have made contributions in the development of this software, 
including Vern R. Bonner, Richard Hayes, John Peters, Al Montalvo, and Michael Gee. Mr. Matt 
Fleming was the Chief of the H&H Division, and Mr. Chris Dunn was the director during the 
development of this version of the software.

This manual was written by Mr. Gary W. Brunner. Chapter 12 was written by Cameron T. Ackerman 
and Gary W. Brunner. Chapter 13 was written by Mr. Chris R. Goodell.

HEC-RAS uses the following third-party libraries:

Hierarchical Data Format (HDF) – HEC-RAS uses the HDF5 libraries in both the User Interface and the 
Computational engines for writing and reading data to binary files that follow the HDF5 standards. The HDF 
Group: http://www.hdfgroup.org/HDF5/
Geospatial Data Abstraction Library (GDAL) – HEC-RAS uses the GDAL libraries in the HEC-RAS Mapper tool. 
These libraries are used for all Geospatial data rendering, coordinate transformations, etc. GDAL: http://
www.gdal.org/
Bit Miracle LibTiff .Net. LibTiff.Net provides support for the Tag Image File Format (TIFF), a widely used 
format for storing image data. Bit Miracle: http://bitmiracle.com/libtiff/
Oxyplot – 2 dimensional X-Y plots in HEC-RAS Mapper. Oxyplot: http://oxyplot.org/
SQLite – Reading and writing database files. SQLite: https://www.sqlite.org/
cURL - HTTP support for GDAL http://curl.haxx.se/
Clipper – an open source freeware library for clipping and offsetting lines and polygons. http://
www.angusj.com/delphi/clipper.php

http://www.hdfgroup.org/HDF5/
http://www.gdal.org/
http://bitmiracle.com/libtiff/
http://oxyplot.org/
https://www.sqlite.org/
http://curl.haxx.se/
http://www.angusj.com/delphi/clipper.php
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2 INTRODUCTION TO HEC-RAS
Welcome to the U.S. Army Corps of Engineers River Analysis System (HEC-RAS) developed by the 
Hydrologic Engineering Center.  This software allows you to perform one-dimensional steady flow, 
one and two-dimensional unsteady flow calculations, sediment transport/mobile bed computations, 
and water temperature/water quality modeling. 

The HEC-RAS modeling system was developed as a part of the Hydrologic Engineering Center's "Next 
Generation" (NexGen) of hydrologic engineering software.  The NexGen project encompasses several 
aspects of hydrologic engineering, including:  rainfall-runoff analysis (HEC-HMS); river hydraulics 
(HEC-RAS); reservoir system simulation (HEC-ResSim); flood damage analysis (HEC-FDA and HEC-
FIA); and real-time river forecasting for reservoir operations (CWMS).

This chapter discusses the general philosophy of HEC-RAS and gives a brief overview of the 
capabilities of the modeling system.  Documentation for HEC-RAS is discussed, as well as an 
overview of this manual.

General Philosophy of the Modeling System
HEC-RAS is an integrated system of software, designed for interactive use in a multi-tasking 
environment. The system is comprised of a graphical user interface (GUI), separate analysis 
components, data storage and management capabilities, graphics, mapping and reporting facilities.

The HEC-RAS system contains the following river analysis components for: (1) one dimensional 
steady flow water surface profile computations; (2) one-dimensional and/or two-dimensional 
unsteady flow simulation; (3) Quasi unsteady or fully unsteady flow movable boundary sediment 
transport computations (1D and 2D); and (4) one dimensional water quality analysis. A key element 
is that all four components use a common geometric data representation and common geometric 
and hydraulic computation routines. In addition to the four river analysis components, the system 
contains several hydraulic design features that can be invoked once the water surface profiles are 
computed. HEC-RAS also has an extensive spatial data integration and mapping system (HEC-RAS 
Mapper).

Overview of Program Capabilities
HEC-RAS is designed to perform one-dimensional and two-dimensional hydraulic calculations for a 
full network of natural and constructed channels, overbank/floodplain areas, levee protected areas; 
etc… The following is a description of the major capabilities of HEC-RAS.

User Interface
The user interacts with HEC-RAS through a graphical user interface (GUI). The main focus in the 
design of the interface was to make it easy to use the software, while still maintaining a high level of 
efficiency for the user. The interface provides for the following functions:

File management
Data entry/editing and geospatial data interfaces
River analyses
Tabulation and graphical displays of input and output data
Inundation mapping and animations of water propagation
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Reporting facilities
On-line help

River Analysis Components
Steady Flow Water Surface Profiles. This component of the modeling system is intended for calculating 
water surface profiles for steady gradually varied flow. The system can handle a full network of channels, a 
dendritic system, or a single river reach. The steady flow component is capable of modeling subcritical, 
supercritical, and mixed flow regime water surface profiles.
The basic computational procedure is based on the solution of the one-dimensional energy equation. 
Energy losses are evaluated by friction (Manning's equation) and contraction/expansion (coefficient 
multiplied by the change in velocity head). The momentum equation is utilized in situations where the water 
surface profile is rapidly varied. These situations include mixed flow regime calculations (i.e., hydraulic 
jumps), hydraulics of bridges, and evaluating profiles at river confluences (stream junctions).
The effects of various obstructions such as bridges, culverts, dams, weirs, and other structures in the flood 
plain may be considered in the computations. The steady flow system is designed for application in flood 
plain management and flood insurance studies to evaluate floodway encroachments. Also, capabilities are 
available for assessing the change in water surface profiles due to channel modifications, and levees. 
Special features of the steady flow component include: multiple plan analyses; multiple profile 
computations; multiple bridge and/or culvert opening analysis; bridge scour analysis; split flow 
optimization; and stable channel design and analysis.
Unsteady Flow Simulation. This component of the HEC-RAS modeling system is capable of simulating one-
dimensional; two-dimensional; and combined one/two-dimensional unsteady flow through a full network of 
open channels, floodplains, and alluvial fans. The unsteady flow component can be used to performed 
subcritical, supercritical, and mixed flow regime (subcritical, supercritical, hydraulic jumps, and drawdowns) 
calculations in the unsteady flow computations module.
The hydraulic calculations for cross-sections, bridges, culverts, and other hydraulic structures that were 
developed for the steady flow component were incorporated into the unsteady flow module.
Special features of the unsteady flow component include: extensive hydraulic structure capabilities Dam 
break analysis; levee breaching and overtopping; Pumping stations; navigation dam operations; pressurized 
pipe systems; automated calibration features; User defined rules; and combined one and two-dimensional 
unsteady flow modeling.
Sediment Transport/Movable Boundary Computations. This component of the modeling system is 
intended for the simulation of one-dimensional and two-dimensional sediment transport/movable 
boundary calculations resulting from scour and deposition over moderate to long time periods. 
The sediment transport potential is computed by grain size fraction, thereby allowing the simulation of 
hydraulic sorting and armoring. Major features include the ability to model a full network of streams, 
channel dredging, various levee and encroachment alternatives, and the use of several different equations 
for the computation of sediment transport.
The model is designed to simulate long-term trends of scour and deposition in a stream channel that might 
result from modifying the frequency and duration of the water discharge and stage, or modifying the 
channel geometry. This system can be used to evaluate deposition in reservoirs, design channel 
contractions required to maintain navigation depths, predict the influence of dredging on the rate of 
deposition, estimate maximum possible scour during large flood events, and evaluate sedimentation in 
fixed channels.
Water Quality Analysis. This component of the modeling system is intended to allow the user to perform 
riverine water quality analyses. The current version of HEC-RAS can perform detailed temperature analysis 
and transport of a limited number of water quality constituents (Algae, Dissolved Oxygen, Carbonaceuos 
Biological Oxygen Demand, Dissolved Orthophosphate, Dissolved Organic Phosphorus, Dissolved 
Ammonium Nitrate, Dissolved Nitrite Nitrogen, Dissolved Nitrate Nitrogen, and Dissolved Organic Nitrogen). 
Future versions of the software will include the ability to perform the transport of several additional water 
quality constituents.
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Data Storage and Management
Data storage is accomplished using "flat" files (ASCII and binary), the HEC-DSS (Data Storage 
System), and HDF5 (Hierarchical Data Format, version 5). User input data are stored in flat files under 
separate categories of project, plan, geometry, steady flow, unsteady flow, quasi-steady flow, 
sediment data, and water quality information. Output data is predominantly stored in separate 
binary files (HEC and HDF5). Data can be transferred between HEC-RAS and other programs by 
utilizing the HEC-DSS.
Data management is accomplished through the user interface. The modeler is requested to enter a 
single filename for the project being developed. Once the project filename is entered, all other files 
are automatically created and named by the interface as needed. The interface provides for 
renaming, moving, and deletion of files on a project-by-project basis.

Graphics, Inundation Mapping, and Reporting
Graphics include X-Y plots of the river system schematic, cross-sections, profiles, rating curves, 
hydrographs, and inundation mapping. A three-dimensional plot of the terrain and many of the 
simulation results are now available. Inundation mapping is accomplished in the HEC-RAS Mapper 
portion of the software. Inundation maps can also be animated, and contain multiple background 
layers (terrain, aerial photography, etc…). Tabular output is available. Users can select from pre-
defined tables or develop their own customized tables. All graphical and tabular output can be 
displayed on the screen, sent directly to a printer (or plotter), or passed through the Windows 
Clipboard to other software, such as a word-processor or spreadsheet.
Reporting facilities allow for printed output of input data as well as output data. Reports can be 
customized as to the amount and type of information desired.

 HEC-RAS Documentation
The HEC-RAS package includes several documents. Each document is designed to help the modeler 
learn to use a particular aspect of the modeling system. There are three major pieces of 
documentation:

Documentation Description

User's Manual This manual is a guide to using HEC-RAS. The manual provides an introduction and 
overview of the modeling system, installation instructions, how to get started, a simple 
example, entering and editing geometric data, detailed descriptions of each of the major 
modeling components, and how to view graphical and tabular output.

2D User's Manual This document describes how to use the 2D modeling capabilities that are included in 
this version of the software. It also describes how to use RAS Mapper in support of 2D 
modeling (mesh generation) and inundation mapping for models containing 2D flow 
areas.

HEC-RAS Mapper This document describes how to use HEC-RAS Mapper to do the following: establish a 
horizontal coordinate system; develop an HEC-RAS terrain model; layout the geometric 
data model and extract terrain data; visualize results in the form of maps, plots, and 
tables.
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Sediment Transport 
User's Manual

This manual describes how to perform sediment transport modeling. The document 
describes 1D quasi unsteady; 1D unsteady flow, and 2D sediment transport modeling. 
Additionally sediment impact analysis (SIAM) and bank stability using BSTEM is also 
described.

Hydraulic Reference 
Manual

This manual describes the theory and data requirements for the hydraulic calculations 
performed by HEC-RAS. Equations are presented along with the assumptions used in 
their derivation. Discussions are provided on how to estimate model parameters, as well 
as guidelines on various modeling approaches.

Applications Guide This document contains a series of examples that demonstrate various aspects of HEC-
RAS. Each example consists of a problem statement, data requirements, and general 
outline of solution steps, displays of key input and output screens, and discussions of 
important modeling aspects.

Overview of this Manual
This user's manual is the primary piece of documentation on how to use the HEC-RAS system. The 
manual is organized as follows:

Chapters 1-2 provide an introduction and overview of HEC-RAS, as well as instructions on how to install the 
software.
Chapters 3-4 describe how to use the HEC-RAS software from an overview perspective. Understanding how 
this system works with projects is also discussed, including defining all the file types that are used.
Chapters 5 explains how to enter and edit geometric data to represent the river, floodplain, and hydraulic 
structures.
Chapters 6 and 7 explain in detail how to perform the different types of hydraulic analyses that are available, 
such as 1D steady flow modeling and 1D Unsteady Flow Modeling
Chapter 8 provides detailed discussions on how to view graphical and tabular output, as well as how to 
develop user-defined tables.
Chapter 9 describes how to perform a floodway encroachment analysis.
Chapter 10 provides discussions on "Trouble Shooting" and understanding the most common Errors, 
Warnings, and Notes.
Chapter 11 describes how to perform bridge scour computations from within HEC-RAS.
Chapter 12 describes how to perform channel modifications within HEC-RAS.
Chapter 13 describes how to use the Hydraulic Design Functions in HEC-RAS for performing stable channel 
design and analysis, as well as sediment transport potential calculations, and rip rap sizing.
Chapter 14 contains topics on advanced uses of the unsteady flow simulation capabilities, including: mixed 
flow regime for unsteady flow; dam break analysis; levee overtopping and breaching; modeling pump 
stations; navigation dams; and user defined rules for controlling gate operations.
Appendix A contains a list of references.
Appendix B contains a detailed description of the file formats used for importing and exporting GIS data to 
and from HEC-RAS.
Appendix C contains a description of all the output variables available from the HEC-RAS program.
Appendix D discusses how to import HEC-2 data into HEC-RAS
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3 INSTALLING HEC-RAS
You install HEC-RAS using the program HEC-RAS_Version_Setup.exe. The Setup program installs the 
software, user's manuals, sample applications, and the Help system.
This chapter discusses the hardware and system requirements needed to use HEC-RAS, how to 
install the software, and how to uninstall the software.

Important
You cannot simply copy files from the HEC and run HEC-RAS. You must use the Setup program, which 
decompresses and installs the files to the appropriate directories, as well as registers certain files 
(dll's, etc…) with the operating system.
Hardware and Software Requirements
Before you install the HEC-RAS software, make sure that your computer has at least the minimum 
required hardware and software. In order to get the maximum performance from the HEC-RAS 
software, recommended hardware and software is shown in parentheses. This version of HEC-RAS 
will run on a microcomputer that has the following:

Intel Based PC or compatible machine with Pentium processor or higher (an Intel I5 or higher is 
recommended. If you are going to perform 2D modeling, then a machine with multiple cores is 
recommended).
A hard disk with at least 1 Gigabyte of free space (10 Gigabytes or more is recommended).
A minimum of 8 Gigabyte of RAM if using Windows 7, Windows 8, or windows 10 (16 Gigabytes or more is 
recommended).
A mouse, touch pad, or touch screen.
Color Video Display (Recommend running in Super VGA (1024x768) or higher, and as large a monitor(s) as 
possible).
HEC-RAS Version 5.0.4 and newer will only run on 64-bit Windows operating systems, including 64-bit 
versions of Windows 7, 8.0, 8.1, and 10. Also, make sure your operating system is up to date with all of the 
Microsoft patches for that version of the operating system before trying to install HEC-RAS.

Installation Procedure
Installation of the HEC-RAS software is accomplished through the use of the Setup program.

To install the software onto your hard disk, do the following:
Download the setup program from our web page: www.hec.usace.army.mil.
Place the setup program in a temporary directory and execute it from there.
Follow the setup instructions on the screen.

The setup program automatically creates a program group called HEC. This program group will be 
listed under the Programs menu, which is under the Start menu. The HEC-RAS program icon will be 
contained within the HEC program group. The user can create a shortcut icon during the install 
process or by dragging a copy of the HEC-RAS icon onto the desktop from the Windows Start menu. 
The HEC RAS executable can be found in the c:\Program Files\HEC\HEC-RAS directory with the name 
"RAS.EXE".

http://www.hec.usace.army.mil


Installing HEC-RAS

HEC-RAS User's Manual– 28

•
•
•

•

Uninstall Procedure
The HEC-RAS Setup program automatically registers the software with the Windows operating 
system. To uninstall the software, do the following:

From the Start Menu navigate to where you can run the Control Panel.
From within the Control Panel folder, select Programs.
From the section labeled as Uninstall a Program select the HEC-RAS program from the list of installed 
software, and then press the Uninstall button.
Follow the uninstall directions on the screen and the software will be removed from your hard disk. It is up 
to the user to remove the HEC-RAS icon from the desktop.
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4 WORKING WITH HEC-RAS
HEC-RAS is an integrated package of hydraulic analysis programs, in which the user interacts with 
the system using a Graphical User Interface (GUI). The system can perform Steady Flow water surface 
profile calculations, One and Two-dimensional unsteady flow computations, Sediment Transport/
movable boundary computations, water quality analysis and several hydraulic design computations.

In HEC-RAS terminology, a Project is a set of data files associated with a particular river system. The 
modeler can perform any or all of the various types of analyses, included in the HEC-RAS package, as 
part of the project. The data files for a project are categorized as follows: plan data, geometric data, 
steady flow data, unsteady flow data, quasi-steady flow data, sediment data, water quality data, and 
hydraulic design data.

During the course of a study the modeler may want to formulate several different Plans. Each plan 
represents a specific set of geometric data and flow data (and possibly sediment data, water quality 
data, and hydraulic design information). Once the basic data are entered into the HEC-RAS, the 
modeler can easily formulate new plans. After simulations are made for the various plans, the results 
can be compared simultaneously in both tabular and graphical form.

HEC-RAS has the ability to lay out a model based on a geospatial coordinate system, or it can be 
developed without one. The very first versions of HEC-RAS did not utilize geospatial data, and all 
geometric data was developed from the HEC-RAS Geometry editor. However, if you want to bring in 
terrain data, extract model elevation information from that terrain, and perform inundation 
mapping of the model results, you must establish a geospatial coordinate system and develop a 
terrain model using HEC-RAS Mapper. HEC-RAS Mapper is a geospatial data development system in 
results mapping module contained directly from within HEC-RAS. HEC-RAS Mapper has an entirely 
separate user's manual that describes the following: how to establish a geospatial coordinate 
system for the project; developing a terrain model for use within HEC-RAS; laying out the HEC-RAS 
model geometry and extracting the terrain elevation data for model components; and visualizing 
results through maps, graphics, and tables.

In the current version of HEC-RAS, there are some duplication of tools for laying out the hydraulic 
model geometry between the Geometric data editor and HEC-RAS Mapper. If the user wants to work 
directly with a terrain model in a horizontal coordinate system, it is suggested to do most of that 
work in HEC-RAS Mapper. Once the model is laid out and terrain information is extracted, the user 
will still need to use the model component data editors (i.e. cross section editor, bridge/culvert 
editor, etc…) to parameterize the model fully.

This section provides an overview of how a hydraulic analysis study is performed with the HEC-RAS 
software.

Starting HEC-RAS
When you run the HEC-RAS Setup program, you automatically get a new program group called HEC
and program icon called HEC-RAS.  They should appear in the start menu under the section called 
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Programs.  The user also has the option of creating a shortcut on the desktop.  The HEC-RAS icon 

looks like the following:  

To start HEC-RAS from windows, double-click on the HEC-RAS icon. If you do not have an HEC-RAS 
shortcut, select Start | HEC | HEC-RAS.

When you first start HEC-RAS, you will see the main window as shown below (except you will not 
have any project files listed on your main window).

At the top of the HEC-RAS main window is a Menu bar with the options listed below.

File: This option is used for file management. Options available under the File menu include: New Project; 
Open Project; Save Project; Save Project As; Rename Project: Delete Project; Project Summary; Import HEC-2 
Data; Import HEC-RAS data; Generate Report; Export GIS Data; Export to HEC-DSS; Restore Backup Data; 
Debug Report; and Exit. In addition, the most recently opened projects will be listed at the bottom of the File 
menu, which allows the user to quickly open a project that was recently worked on.
Edit: This option is used for entering and editing data. Data are categorized into six types: Geometric Data; 
Steady Flow Data; Quasi-Unsteady Flow; Unsteady Flow Data; Sediment Data; and Water Quality Data.
Run: This option is used to perform the hydraulic calculations. The options under this menu item include: 
Steady Flow Analysis; Unsteady Flow Analysis; Quasi-Unsteady Sediment Analysis; Water Quality Analysis; 
Hydraulic Design Functions; and Run Multiple Plans.
View: This option contains a set of tools that provide for graphical and tabular displays of the model output. 
The View menu item currently includes: Cross Sections; Water Surface Profiles; General Profile Plot; Rating 
Curves; 3D Perspective Plots; Stage and Flow Hydrographs; Hydraulic Properties Plots; Detailed Output 
Tables; Profile Summary Tables; Summary Err, Warn, Notes; DSS Data; Unsteady Flow Spatial Plot; Unsteady 
Flow Time Series Plot; WQ Spatial Plot; WQ Time Series Plot; Sediment Spatial Plot; Sediment Time Series 
Plot, and Sediment XS Changes Plot.
Options: This menu item allows the user to change Program Setup options; set Default Parameters; 
establish the Default Units System (U.S. Customary or Metric); Convert Project Units (U.S. Customary to 
Metric, or Metric to U.S. Customary); and Convert Horizontal Coordinate System (this option allows the user 
to convert the entire HEC-RAS project from one horizontal coordinate system to another).
GIS Tools: This menu item allows the user to go to the HEC-RAS Mapper; which can be used to create terrain 
models for use with HEC-RAS; display inundation mapping; and perform dynamic animations of flooding; 
along with many other mapping layers.
Help: This option allows the user to get on-line help for HEC-RAS; display the HEC-RAS manuals (User's 
manual, Hydraulic Reference Manual, Applications Guide, and Release Notes); install example projects; How 
to customize the Help menu; go to the HEC-RAS web page; go to an online guide for selecting Manning's n 
values; view the terms and conditions of use statement; and display the current version information about 
HEC-RAS.
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Also on the HEC-RAS main window is a Button bar (above figure). The button bar provides quick 
access to the most frequently used options under the HEC-RAS menu bar. A description of each 
button is shown in the figure below. 

   
HEC-RAS Main Window Button Bar

Steps in Developing a Hydraulic Model with HEC-RAS
There are five main steps in creating a hydraulic model with HEC-RAS:

Starting a new project
Entering geometric data
Entering flow data and boundary conditions
Performing the hydraulic calculations
Viewing and publishing results
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Starting a New Project
The first step in developing a hydraulic model with HEC-RAS is to establish which directory you wish 
to work in and to enter a title for the new project. To start a new project, go to the File menu on the 
main HEC-RAS window and select New Project. This will bring up a New Project window as shown in 
the figure below.

New Project Window

As shown in the figure above, you first select the drive and path that they want to work in (to actually 
select a path you must double click the directory you want in the directory box), next enter a project 
title and file name. The project filename must have the extension ".prj"; the user is not allowed to 
change this. Once you have entered all the information, press the "OK" button to have the 
information accepted. After the OK button is pressed, a message box will appear with the title of the 
project and the directory that the project is going to be placed in. If this information is correct, press 
the OK button. If the information is not correct, press the Cancel button and you will be placed back 
into the New Project window.

Setting the unit system for the project is accomplished by selecting Unit System from the Options
menu of the main HEC-RAS window.

Entering Geometric Data
The next step is to enter the necessary geometric data, which consist of a background map layer 
(Optional), connectivity information for the stream system (River System Schematic), cross-section 
data, storage areas, two-dimensional (2D) flow areas, and hydraulic structure data (bridges, culverts, 
weirs, etc.).

Before any Geometric data and Flow data are entered, the user should select the Units 
System (U.S. Customary or Metric) that they would like to work in.



The current version of HEC-RAS has the ability to lay out the geometry of a model (i.e. stream 
centerline, cross sections, storage areas, 2D flow areas, and hydraulic structures) in either the 
Geometric Data editor or HEC-RAS Mapper. HEC is moving towards having a completely 
geospatial layout system for developing the geometry using HEC-RAS Mapper. The tools in the 
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This section describes how to use the HEC-RAS Geometric Data editor to lay out the Geometry, as 
well as how to put data into the data editors, and finish the parameterization of the model geometry.

To use the Geometric Data editor to enter geometry, select Geometric Data from the Edit menu on 
the main HEC-RAS window. Once this option is selected, the geometric data window will appear as 
show in the the figure below (except yours will be blank when you first bring this screen up for a new 
project). 

Geometric Data Window

When entering data directly into HEC-RAS from the geometric data editor, the data can still be 
entered in a georeferenced framework, or not. To establish a georeferenced framework, the use 
must first set a georeferenced projection in HEC-RAS Mapper. The various map and terrain layers can 
be brought into RAS Mapper. Any terrain or other background map layers that are brought into HEC-
RAS Mapper can also be used as background maps in the HEC-RAS Geometry editor. Displaying 
background maps and terrain that have been setup in HEC-RAS Mapper is accomplished by selecting 

the background mapping button on the Geometry editor.  To learn more about the 
background mapping capabilities, view the information on this option in Chapter 5 of this document.

Geometric data editor are the original tools for developing a geometric model. All of the new 
tools for geospatially laying out the model geometry are in HEC-RAS Mapper. If you want to use 
HEC-RAS Mapper to layout the geometric data model, please read the HEC-RAS Mapper User's 
manual. Once you have a model laid out within HEC-RAS Mapper, you can extract terrain data for 
cross sections, storage areas, 2D flow areas, and hydraulic structures. However, to complete the 
parameterization of the model (i,e, cross section coefficients, structure modeling approaches 
and coefficients, etc…) you must come back into the Geometric data editor to complete all the 
required Geometric data for the model.
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The modeler can develop the geometric data in HEC-RAS by first drawing in the river system 
schematic. This is accomplished, on a reach-by-reach basis, by pressing the River Reach button and 
then drawing in a reach from upstream to downstream (in the positive flow direction). After the 
reach is drawn, the user is prompted to enter a "River" and a "Reach" identifier. The River and reach 
identifiers can be up to 16 characters in length. As reaches are connected together, junctions are 
automatically formed by the interface. The modeler is also prompted to enter a unique identifier for 
each junction. For more information on developing the river system schematic, see Chapter 6 
"Entering and Editing Geometric Data."

After the river system schematic is drawn (See Figure 3-5), the modeler can start entering cross-
section and hydraulic structure data. Pressing the Cross Section button causes the cross section 
editor to pop up. This editor is shown in the figure below. As shown, each cross section has a River
name, Reach name, River Station, and a Description. The River, Reach and River Station
identifiers are used to describe where the cross section is located in the river system. The "River 
Station" identifier does not have to be the actual river station (miles or kilometers) at which the 
cross section is located on the stream, but it does have to be a numeric value (e.g., 1.1, 2, 3.5, etc.). 
The numeric value is used to place cross sections in the appropriate order within a reach.

Cross Section Data Editor

The basic data required for each cross section are shown on the Cross Section Data editor above. The 
required data for any cross section consists of: station-Elevation data (Cross section point 
coordinates); downstream reach lengths (distances from the current cross section to the next cross 
section downstream); Manning's n values (at a minimum you must have a left overbank, main 
channel, and right overbank Manning's n value. There are several options for horizontal and vertical 
variations of Manning's n values); main channel bank stations (defines the left and right bank limits 
of the main channel); and contraction and expansion coefficients (defaults to 0.1 and 0.3 
respectively). Additional cross section features are available under Options from the menu bar. 
These options include: adding, copying, renaming and deleting cross sections; adjusting cross 

HEC-RAS requires Cross sections to be ordered within a reach from the highest river station 
upstream to the lowest river station downstream.
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section elevations, stations, and n or k-values; skew cross section; ineffective flow areas; levees; 
blocked obstructions; adding a lid to a cross section; add ice cover; add a rating curve; horizontal 
variation of n or k-values; and vertical variation of n values.

Also, available from the Cross Section Data editor is the ability to plot any cross section or reach 
profile. Edit features are available to cut, copy, paste, insert, and delete data from the Cross Section 
X-Y Coordinates grid.
Once the cross-section data are entered, the modeler can then add any hydraulic structures such as 
bridges, culverts, dams, weirs and spillways. Data editors, similar to the cross section data editor, are 
available for the various types of hydraulic structures. If there are any stream junctions in the river 
system, additional data are required for each junction. The Junction data editor is available from the 
Geometric Data window.

Once geometric data are entered, the data should be saved to a file on the hard disk. This is 
accomplished by selecting the Save Geometric Data As option from the File menu on the Geometric 
Data editor. This option allows the user to enter a title for the geometric data. A filename is 
automatically established for the geometric data, and then saved to the disk. Once a title is 
established, geometric data can be saved periodically by selecting Save Geometric Data from the 
File menu of the Geometric Data editor.

Entering Flow Data and Boundary Conditions
Once the geometric data are entered, the modeler can then enter either steady flow or unsteady flow 
data. The type of flow data entered depends upon the type of analyses to be performed. For the 
discussion in this chapter, it is assumed that a steady flow hydraulic analysis will be performed. The 
data entry form for steady flow data is available under the Edit menu bar option on the HEC-RAS 
main window.

An example of the steady flow data entry form is shown in the figure below, which is the Steady 
Flow Data Editor. As shown below, steady flow data consist of: the number of profiles to be 
computed; the flow data; and the river system boundary conditions. At least one flow must be 
entered for every reach within the system. Additionally, flow can be changed at any location within 
the river system. Flow values must be entered for all profiles.

Boundary conditions are required in order to perform the calculations. If a subcritical flow analysis is 
going to be performed, then only the downstream boundary conditions are required. If a 
supercritical flow analysis is going to be performed, then only the upstream boundary conditions are 
required. If the modeler is going to perform a mixed flow regime calculation, then both upstream 
and downstream boundary conditions are required. The Boundary Conditions data entry form can 
be brought up by pressing the Reach Boundary Conditions button from the Steady Flow Data entry 
form.

Once all of the steady flow data and boundary conditions are entered, the modeler should save the 
data to the hard disk. This can be accomplished by selecting Save Flow Data As from the File option 
on the Steady Flow Data menu bar. Flow data is saved in a separate file. The user is only required to 
enter a title for the flow data, the filename is automatically assigned.
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Steady Flow Data window

Performing Hydraulic Computations
Once all of the geometric data and flow data are entered, the modeler can begin to perform the 
hydraulic calculations. As stated previously, there are five types of calculations that can be 
performed in the current version of HEC-RAS: Steady Flow Analysis, Unsteady Flow Analysis, 
Sediment Transport/Mobile Boundary Modeling, Water Quality Analyses, and Hydraulic Design 
Functions. The modeler can select any of the available hydraulic analyses from the Run menu bar 
option on the HEC-RAS main window. An example of the Simulation Manager window is shown in the 
figure below, which is the Steady Flow Analysis window.
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Steady Flow Analysis window

As shown in above, the modeler puts together a Plan by selecting a specific set of geometric data 
and flow data. A Plan can be put together by selecting New Plan from the File menu bar option of 
the Steady Flow Analysis window. Once a Plan Title and Short Identifier (Short ID) have been 
entered, the modeler can select a Flow Regime for which the model will perform calculations. 
Subcritical, Supercritical, or Mixed flow regime calculations are available.

Additional features are available under the Options menu for: performing a Floodway Encroachment 
Analysis; Setting locations for calculating flow distribution output; conveyance calculation options; 
friction slope methods; calculation tolerances; critical depth output; critical depth computation 
method; split flow optimization; data checking; setting log file levels; and viewing the log file output.

Once the modeler has selected a Plan and set all of the calculation options, the steady flow 
calculations can be performed by pressing the Compute button at the bottom of the Steady Flow 
Analysis window. When this button is pressed, the HEC-RAS system packages up all the data for the 
selected plan and writes it to a run file. The system then runs the steady flow model and passes it the 
name of the run file. This process is executed in a separate window. Therefore, the modeler can work 
on other tasks while it is executing.

Viewing and Printing Results
Once the model has finished all of the computations, the modeler can begin viewing the results. 
Several output features are available under the View option from the main window. These options 
include: cross section plots; water surface profile plots; general profile plots; rating curve plots; 3D 
perspective plots; hydrograph plots and hydraulic property tables (if unsteady flow simulation was 
performed); tabular output at specific locations (Detailed Output Tables); tabular output for many 
locations (Profile Summary Tables); summary of errors, warnings, and notes; and viewing data 
contained in HEC-DSS.

An example of a cross section plot is shown in the figure below. The user can plot any cross section 
by simply selecting the appropriate River, Reach and River Station from the list boxes at the top of 
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the plot. The user can also step through the plots by using the up and down arrow buttons. Several 
plotting features are available under the Options menu of the Cross-Section plot. These options 
include: zoom in; zoom out; full plot; pan; animate; selecting which plans, profiles and variables to 
plot; velocity distribution; viewing interpolated cross-sections; and control over the lines, symbols, 
labels, scaling, and grid options.

Hard copy outputs of the graphics can be accomplished in two different ways. Graphical plots can be 
sent directly from HEC-RAS to whichever printer or plotter the user has defined under the Windows 
Print Manager. Graphical plots can also be sent to the Windows clipboard. Once the plot is in the 
clipboard it can then be pasted into other programs, such as a word processor. Both of these options 
are available from the File menu on the various plot windows.

Cross Section Plot

An example of a profile plot is shown in the figure below. All of the options available in the cross-
section plot are also available in the profile plot. Additionally, the user can select which specific 
reaches to plot when a multiple-reach river system is being modeled. 



Working With HEC-RAS

HEC-RAS User's Manual– 39

Profile Plot

An example of an 3D Perspective Plot of terrain and water depth is shown in in the figure below. The 
user has the option to display depth, water surface, velocity, etc. Additionally, the velocity tracers 
can be turned on in the 3D view. User's can control movement through the 3D space, as well as 
create predefined flight paths, and then have the software fly through the area along the flight path 
automatically. To learn more about the 3D viewer, go to Chapter 8, Viewing Results in this manual. 

3D Perspective Plot of the Terrain and Water Depth.

Tabular output is available in two different formats. The first type of tabular output provides detailed 
hydraulic results at a specific cross section location (Detailed Output Table). An example of this type 
of tabular output is shown in below. 
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Tabular Detailed Output

The second type of tabular output shows a limited number of hydraulic variables for several cross 
sections and multiple profiles (Profile Summary Tables). An example of this type of tabular output is 
shown in in the figure below. There are several standard tables that are predefined and provided to 
the user under the Tables menu from the profile output tables. Users can also define their own 
tables by specifying what variables they would like to have in a table. User specified table headings 
can be saved and then selected later as one of the standard tables available to the project.

Tabular output can be sent directly to the printer or passed through the clipboard in the same 
manner as the graphical output described previously. This option is also available under the File
menu on each of the table forms.
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Profile Output Table

Getting and Using Help
On-line help is available from within the HEC-RAS software. Help can be accessed by selecting the 
Help menu option at the top of each window, or by pressing the F1 function key at any time. The 
help system is context sensitive, so when the F1 key is pressed, help will come up for the currently 
active HEC-RAS window. 
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5 WORKING WITH PROJECTS
To create a river hydraulics application with HEC-RAS, you work with projects.  A project is a 
collection of files that are used to build a model.  This section describes projects and how you build 
and manage the project files. 

Understanding Projects
As you develop an application, the management of all the files that get created is accomplished 
through the user interface.  When a new project is started, the user is requested to enter a title and 
filename for the project.  All other data are automatically stored by the user interface using the same 
name as the project file (e.g. filename.prj), except for the three character extension.  A project 
consists of:

One Project file (.PRJ)
One file for each Plan (.P01 to .P99)
One corresponding HDF5 output file for each Plan (.P01.hdf to .P99.hdf)
One Run file for each steady flow plan (.R01 to .R99)
One Run file for each unsteady flow plan (.X01 to .X99)
One Output file for each plan (.O01 to .O99)
One file for each set of Geometry data (.G01 to .G99)
One corresponding HDF5 file for each geometry file (.g01.hdf)
One file for each set of Steady Flow data (.F01 to .F99)
One file for each set of Unsteady Flow data (.U01 to .U99)
One file for each set of Quasi-Unsteady Flow data (.q01 to .q99)
One file for each set of Sediment data (.S01 to .S99)
One file for each set of Hydraulic Design data (.H01 to .H99)
One RAS Mapper file if you are using spatial terrain data (.rasmap)
One file for each set of Sediment Transport Capacity data (.SedCap01 to .SedCap99)
One file for each set of SIAM Input Data (.H01.SiamInput to .H99.SiamInput)
One file for each set of SIAM Output (.H01.SiamOutput to .H99.SiamOutput)
One file for each set of Water Quality data (.W01 to .W99)
One Log file per project (.log)
One text file for each plan executed, containing the computational messages that come out on the 
computation window (.comp_msgs.txt)

After unsteady flow computations are performed, some additional files will get created during the 
computations that are only used by the software as intermediate files.  These files are:

One Boundary condition file for each plan executed (.b01 to .b99)
One unsteady flow Log output file for project (.bco)
One geometric pre-processor output file for each set of Geometry data (.c01 to .c99)
One detailed computational level output file for each plan, if user turns this option on (.hyd01 to .hyd99)
One initial conditions file for each unsteady flow plan executed (.IC.O01 to .IC.O99)
One binary log file for each plan executed. Used only by the user interface (.p01.blf to .p99.blf)
One restart file (Hot start) for each unsteady flow plan. This will only show up if the user turns on the option 
to write it (.p01.rst to .p99.rst)
One HDF5 binary Output file for each plan that gets executed (.p01.hdf to .p99.hdf). This is the file that RAS 
Mapper uses for getting HEC-RAS computed results to then visualize as inundation maps and other spatial 
data displays.

After sediment transport computations are performed, some additional files will get created during 
the computations that are only used by the software as intermediate files.  These files are:
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One detailed sediment output file for each plan (.sed01 to .sed99)
One header file for the cross section output for each plan (.SedHeadXS01 to . SedHeadXS99)
One cross section output file for each plan (.SedXS01 to .SedXS99)

After water quality computations are performed, some additional files will get created during the 
computations that are only used by the software as intermediate files.  These files are:

One water quality log file per plan executed (.bc01 to .bc99)
One water quality restart file per plan executed (.p01.wqrst to .p99.wqrst)
One water quality color scale file for each project (.color_scales)

The Project File contains: the title of the project; the units system of the project; a list of all the files 
that are associated with the project; and a list of default variables that can be set from the interface.  
Also included in the project file is a reference to the last plan that the user was working with.  This 
information is updated every time you save the project.

Elements of a Project
The following sections describe the various types of files that can be included in a project.  All of 
these files are either created by the user interface or the various computation engines.  The modeler 
interacts with the data through the user interface, and is not required to create or edit any of these 
files directly.

Plan Files
Plan files have the extension .P01 to .P99.  The "P" indicates a Plan file, while the number represents 
the plan number.  As plans are created, they are numbered from 01 to 99.  The plan file contains: a 
description and short identifier for the plan; a list of files that are associated with the plan (e.g., 
geometry file and steady flow file); and a description of all the simulation options that were set for 
the plan.  The plan file is created automatically by the interface each time the user selects New Plan
or Save Plan As from the simulation windows.

Run Files
Run files have the extension .R01 to .R99.  The "R" indicates a Run file, while the number represents 
an association to a particular plan file.  A file with an extension of .R01 is the run file that corresponds 
to the plan file with the extension .P01.  The run file contains all of the necessary data to perform the 
computations that are requested by the associated plan file.  For example, if a steady flow analysis is 
requested, the run file will contain geometry data, steady flow data, and all the necessary 
computational options that are associated with the plan file.  The run file contains the input to any of 
the computational engines available in the HEC-RAS system.  The run file is automatically generated 
by the interface whenever the user presses the Compute button on the Simulation windows.  The 
run file is in an ASCII format, but it is not self explanatory.

Output Files
Output files have the extension .O01 to .O99.  The "O" indicates an Output file, while the number 
represents an association to a particular plan file.  A file with the extension .O12 is the output file that 
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corresponds to the plan file with an extension .P12.  The output file contains all of the computed 
results from the requested computational engine.  For example, if a steady flow analysis is 
requested, the output file will contain results from the steady flow computational engine.  The 
output files are in a binary file format and can only be read from the user interface.

In addition to the standard output file, there is also an HDF5 output file that corresponds to each 
Plan.  This output file is used to support HEC-RAS Mapper.  All of the output shown in HEC-RAS 
Mapper comes from this HDF5 output file.

Geometry Files
Geometry files have the extension .G01 to .G99.  The "G" indicates a Geometry file, while the number 
corresponds to the order in which they were saved for that particular project.  Geometry files contain 
all of the geometric data for the river system being analyzed.  The geometric data consist of: cross 
section information; hydraulic structures data (e.g., bridges and culverts); coefficients; and modeling 
approach information.  The geometry data are stored in an ASCII format.  The file contains key words 
to describe each piece of data, and is for-the-most-part self explanatory.  A geometry file is created 
by the user interface whenever the modeler selects New Geometry Data or Save Geometry Data As
from the Geometric Data window.  Each Geometry file has a corresponding HDF5 file that is used to 
support HEC-RAS Mapper.

Steady Flow Data Files
Steady flow data files have the extension .F01 to .F99.  The "F" represents that it is a steady Flow data 
file, while the number corresponds to the order in which they were saved for that particular project.  
Steady flow data files contain: the number of profiles to be computed; flow data; and boundary 
conditions for each reach.  The steady flow data files are stored in an ASCII format.  The file contains 
key words to describe each piece of data, and is for-the-most-part self explanatory.  Steady flow data 
files are automatically created by the user interface when the modeler selects New Flow Data or 
Save Flow Data As from the Steady Flow Data window.

Unsteady Flow Data Files
Unsteady flow data files have the extension .U01 to .U99.  The "U" represents that it is an unsteady 
flow data file, while the number corresponds to the order in which they were saved for that 
particular project.  Unsteady flow data files contain: flow hydrographs at the upstream boundaries; 
starting flow conditions; and downstream boundary conditions.  The unsteady flow data files are 
stored in an ASCII format.  The file contains key words to describe each piece of data, and is for-the-
most-part self explanatory.  Unsteady flow data files are automatically created by the user interface 
when the modeler selects New Flow Data or Save Flow Data As from the Unsteady Flow Data 
window. 

Quasi-Unsteady Flow Data Files
Quasi-Unsteady flow data files have the extension .Q01 to .Q99.  The "Q" represents that it is a quasi-
unsteady flow data file, while the number corresponds to the order in which they were saved for that 
particular project.  Quasi-Unsteady flow data files contain: flow hydrographs at the upstream 
boundaries; starting flow conditions; and downstream boundary conditions.  The quasi-unsteady 
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flow data files are stored in an ASCII format.  The file contains key words to describe each piece of 
data, and is for-the-most-part self explanatory.  Quasi-Unsteady flow data files are automatically 
created by the user interface when the modeler selects New Flow Data or Save Flow Data As from 
the Quasi-Unsteady Flow Data window.

Sediment Data Files
Sediment data files have the extension .S01 to .S99.  The "S" represents that it is a Sediment data file, 
while the number corresponds to the order in which they were saved for that particular project.  
Sediment data files contain: flow data; boundary conditions for each reach; and sediment data.  The 
sediment data files are stored in an ASCII format.  The file contains key words to describe each piece 
of data, and is for-the-most-part self explanatory.  Sediment data files are automatically created by 
the user interface when the modeler selects New Sediment Data or Save Sediment Data As from 
the Sediment Data editor. 

Water Quality Data Files
Water Quality data files have the extension .w01 to .w99. The "w" in the extension marks these files 
as water quality data files, while the number corresponds to the order in which they were saved for 
that particular project. Water Quality data files contain: temperature boundary conditions for each 
reach, initial conditions, advection dispersion parameters and meteorological data. The data files 
are stored in an ASCII format. The file contains key words to describe each piece of data, and is for-
the-most-part self explanatory. Water quality data files are automatically created by the user 
interface when the modeler selects New Water Quality Data or Save Water Quality Data As from 
the Water Quality Data window.

Hydraulic Design Data Files
Hydraulic design data files have the extension .H01 to .H99.  The "H" represents that it is a Hydraulic 
design data file, while the number corresponds to the order in which they were saved for that 
particular project.  Hydraulic design data files contain information corresponding to the type of 
hydraulic design calculation that is requested.  The Hydraulic design data files are stored in an ASCII 
format.  The file contains key words to describe each piece of data, and is for-the most-part self 
explanatory.  Hydraulic Design data files are automatically created by the user interface when the 
modeler selects New Hydraulic Design Data or Save Hydraulic Design Data As from the File menu 
of the Hydraulic Design Functions window.

A schematic diagram of how the data files fit together is shown in the figure below.  In this example 
there are three plans in the project.  Each plan represents a specific set of steady flow data and 
geometry data.  In this example there are three geometry files and one steady flow file.  The first 
geometry file could represent the existing conditions of the stream.  The second and third geometry 
file could represent some modification of that base geometry file, such as adding a bridge or culvert 
crossing; a channel modification; different roughness coefficients; or any other change to the base 
geometry file.  A plan is formulated by selecting a steady flow file and a geometry file, and then 
saving that plan with a specific title and short identifier.  For more information about formulating 
plans, see Chapter 7 of the HEC-RAS User’s Manual and Chapter 7 of the HEC-RAS Applications 
Guide. 
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Schematic of Project Data Files

Creating, Opening, Saving, Renaming, and Deleting Projects
The following commands from the File menu of the HEC-RAS main window allow you to create, 
open, save, rename, and delete projects. These commands are the same for all of the other data 
types that get created by the user interface (Plan data, geometry data, steady flow data, unsteady 
flow data, sediment data, and hydraulic design data).

File Menu Command Description

New Project  Closes the current project, prompting you to save the data if anything has been changed.  
The user is then prompted to enter a title and filename for the new project.

Open Project Closes the current project, prompting you to save the data if anything has been changed.  
Opens an existing project and all of the associated files.

Save Project Updates the project file and all other files in which data have been modified.

Save Project As Updates the project file and all other associated data, saving all the information to a new 
filename that you specify.

Rename Project Allows the user to rename the title of the currently opened project.

Delete Project  Deletes the project file and all other files associated with the selected project.  The user is 
prompted to make sure that they really want to delete all of the files.

Project Summary   Displays a summary of the project, including: directory locations; project plans; a list of the 
files contained in the project; and currently opened Plan Statistics (i.e. number of various 
elements).
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Project Options
From the Options menu of the main HEC-RAS window, the user can set several default project 
options.  These options include: program setup options; setting default hydraulic variables; 
establishing the default units system (English or Metric); and converting existing projects to a 
different units system (English to Metric or Metric to English).  The following four options (and sub-
options) are available from the Options menu:

Program Setup

Default File Viewer:  This option allows the user to change which program is used for viewing the report 
generator and log file output.  The default is the Windows Write program.  The user can change this to any 
file viewer on their system.
Default Project Folder:  This option allows the user to set the default directory in which they want HEC-RAS 
to look for data files.  When starting a new project, or opening an existing one, the HEC-RAS file chooser has 
a button to automatically switch the current directory to whatever the user has set for the “Default Project 
Folder.”
Open last project:  When this option is selected, the program will automatically open the last project 
worked on, during startup.
Automatically backup data: When this option is checked, the program will automatically make a backup of 
the currently opened project, plan, geometry,  and flow files.  The backup files are updated at specific timed 
intervals, which is user controlled.  The backup files are stored in the \HEC\RAS directory, with the titles 
RasBackup.prj, RasBackup.p01, RasBackup.g01, and as Backup.f01. 
Set time for backup:  This option allows the user to control the automatic          time interval between 
updating the backup files.  The default value is 20 minutes.
Use 64-bit computation engines (when available): When this option is selected, the software will use the 
64 bit versions of the computational engines, rather than the 32 bit versions.  The operating system must be 
a 64 bit operating system for this to work.  In general, the 64 bit versions of the software will run faster than 
the 32 bit.  Additionally, the 64 bit versions of the software can access all of the RAM memory available on 
the machine, which allows user to work on larger models that require more memory space.

Default Parameters: This option allows the user to set defaults for some of the hydraulic variables.

Unit System: This option allows the user to set the default units system to either English or Metric.  
Once the units system is set, the program assumes that all input data are entered in that units 
system.  Likewise, the display of all output data will be done in the default units system.

Convert Project Units: This option allows the user to convert an existing project from one units 
system to another.  Projects can be converted from English to Metric or from Metric to English.

Convert Horizontal Coordinate System: This option allows the user to convert the Horizontal 
coordinate system used in the project, to another horizontal coordinate system.
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6 ENTERING AND EDITING GEOMETRIC DATA
Geometric data consist of establishing the connectivity of the river system (River System Schematic), 
entering cross-section data, defining all the necessary junction information, adding hydraulic 
structure data (bridges, culverts, dams, levees, weirs, etc…), pump stations, storage areas, and two-
dimensional flow areas. The geometric data is entered by selecting Geometric Data from the Edit 
menu on the HEC-RAS main window. Once this option is selected, the Geometric Data window will 
appear as shown in Figure 5-1. The drawing area will be blank on your screen, until you have either 
drawn in your own river system schematic or imported data from a GIS.

IMPORTANT NOTE: The current version of HEC-RAS has the ability to lay out the geometry of a 
model (i.e. stream centerline, cross sections, storage areas, 2D flow areas, and hydraulic structures) 
in either the Geometric Data editor or HEC-RAS Mapper. HEC is moving towards having a completely 
geospatial layout system for developing the geometry using HEC-RAS Mapper. The tools in the 
Geometric data editor are the original tools for developing a geometric model. All of the new tools 
for geospatially laying out the model geometry are in HEC-RAS Mapper. If you want to use HEC-RAS 
Mapper to layout the geometric data model, please read the HEC-RAS Mapper User's manual. Once 
you have a model laid out within HEC-RAS Mapper, you can extract terrain data for cross sections, 
storage areas, 2D flow areas, and hydraulic structures. However, to complete the parameterization 
of the model (i,e, cross section coefficients, structure modeling approaches and coefficients, etc…) 
you must come back into the Geometric data editor to complete all the required Geometric data for 
the model.
This chapter describes how to enter and edit all of the necessary geometric data for a river system 
using the Geometric Data editor.

The following topics will be discussed in this section:

Developing the River System Schematic
Cross Section Data
Stream Junctions
Bridges and Culverts
Multiple Bridge and/or Culvert Openings
Inline Structures (Weirs and Gated Spillways)
Lateral Structures (Weirs, Gates, Culverts, and Rating Curves)
Storage Areas
Two-Dimensional Flow Areas
Storage Area/2D Flow Area Hydraulic Connections
Pump Stations
Cross Section Interpolation
River Ice
Viewing and Editing Data Through Tables
Importing Geometric Data
Geometric Data Tools
Georeferencing an HEC-RAS Model
Attaching and Viewing Pictures
Saving the Geometric Data
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Developing the River System Schematic

The modeler develops the geometric data by either first drawing in the river system schematic on the 
Geometric Data window (Figure 5-1) or by developing a schematic in HEC-RAS Mapper (See the 
separate HEC-RAS Mapper User's manual). The River System Schematic is a diagram of how the 
stream system is connected together. The river system is drawn on a reach-by-reach basis, by 
pressing the River Reach button and then drawing in a reach from upstream to downstream (in the 
positive flow direction). Each reach is identified with a River Name and a Reach Name. The River 
Name should be the actual name of the stream, while the reach name is an additional qualifier for 
each hydraulic reach within that river. A river can be comprised of one or more reaches. Reaches 
start or end at locations where two or more streams join together or spilt apart. Reaches also start or 
end at the open ends of the river system being modeled. 

Figure 5 1 Geometric Data Editor Window

Reaches are drawn as multi-segmented lines. Each reach must have at least two points, defining the 
start and end of the reach. However, it is more typical to draw a reach with several points that would 
follow along the main channel invert of the stream (this can be accomplished by first loading a 
background map into the Geometric Data editor). To draw a reach, first press the River Reach
button at the top of the Geometric Data editor, on the tools button bar. Move the mouse pointer to 
the location on the drawing area that you would like to have the reach begin (upstream end of the 
reach). Click the left mouse button once to define the first point of the reach. Move the mouse and 
continue to click the left mouse button to add additional points to the reach. To end a reach, move 
the mouse pointer to the location in which you would like the last point of the reach to be located, 
then double click the left mouse button. After the reach is drawn, the user is prompted to enter the 
River Name and the Reach Name to identify the reach. The river and reach identifiers are limited to 
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sixteen characters in length. If a particular River Name has already been entered for a previously 
defined reach of the same river, the user should simply select that river name from the list of 
available rivers in the river name text box. As reaches are connected together, Junctions are 
automatically formed by the interface. The modeler is also prompted to enter a unique identifier for 
each junction. Junctions are locations where two or more streams join together or split apart. 
Junction identifiers are also limited to sixteen characters. An example of a simple stream system 
schematic is shown in Figure 5-1.

In addition to river reaches, the user can draw Storage Areas, 2D Flow Areas, Storage Area/2D 
Flow Area Connections, Storage Area/2D Flow Area Boundary Condition Lines, and Pump 
Stations. A storage area is used to define an area in which water can flow into and out of. The water 
surface in a storage area is assumed to be a level pool. Storage areas can be connected to river 
reaches as well as other storage areas. The user can connect a storage area directly to the end of a 
reach or it can be connected to a reach by using the lateral structure option. To connect a storage 
area to the end of a river reach, simply draw or move the end point of a reach inside of the storage 
area. Storage areas can be connected to other storage areas hydraulically by using the SA/2D Area 
Conn option. Storage Area/2D Flow Area connections consist of culverts, gated spillways and a weir. 
The user can set up a Storage Area/2D Flow Area Connection as just a weir, a weir and culverts, or a 
weir and gated spillways.

To draw a Storage Area, select the storage area button at the top of the geometric editor window. 
Storage areas are drawn as polygons. Move the mouse pointer to the location in which you would 
like to start drawing the storage area. Press the left mouse button one time to start adding points to 
define the storage area. Continue using single left mouse clicks to define the points of the storage 
area. To end the storage area, use a double left mouse click. The storage area will automatically be 
closed into a polygon. Once you have finished drawing the storage area, a window will appear asking 
you to enter a name for the storage area. To enter and edit the data for a storage area, use the 
storage area editor button on the left panel of the geometric data window.

To draw a 2D Flow Area, select the 2D Flow Area button at the top of the geometric editor window. 
2D Flow areas are drawn as polygons, just like storage areas. Move the mouse pointer to the location 
in which you would like to start drawing the storage area. Press the left mouse button one time to 
start adding points to define the storage area. Continue using single left mouse clicks to define the 
points of the storage area. To end the 2D Flow Area, use a double left mouse click. The 2D Flow Area 
will automatically be closed into a polygon. Once you have finished drawing the 2D Flow Area, a 
window will appear asking you to enter a name. To enter and edit the data for a 2D Flow Area, use 
the 2D Flow Area editor button on the left panel of the geometric data window.

To enter a Storage Area/2D Flow Area Connection, select the SA/2D Area Conn button at the top of 
the Geometric data editor (this is a hydraulic structure that can be used to connect two storage 
areas, a storage area to a 2D Flow Area, or two 2D Flow Areas). Move the mouse pointer to the 
location of left end of the hydraulic structure. SA/2D Area Connections should be drawn from left to 
right looking in the positive flow direction. Click the left mouse pointer one time to start the drawing 
of the SA/2D Area Connection. You can continue to use single mouse clicks to add as many points as 
you want into the line that represents the SA/2D Area Connection. When you want to end the line, 
double click the mouse pointer. A window will pop up asking you to enter a name for the SA/2D Area 
Connection. The direction in which you draw the structure is important for establishing the positive 
flow direction for the flow. If you want the program to output positive flow when the flow is going 
from one area to another area, then you must draw from left to right looking in the positive flow 
direction. If flow happens to go in the other direction during the calculations, that flow will be output 
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as negative numbers. To enter and edit the data for a SA/2D Flow Area connection use the SA/2D 
Area Conn data editor on the left panel of the geometric data window.

To add boundary conditions directly to a 2D Flow Area or a Storage Area, select the SA/2D Area BC 
Lines button at the top of the Geometric data editor. Move the mouse point to the area of the outer 
boundary of the 2D Flow Area (or Storage Area) in which you would like to start the boundary 
condition line. Then click the left mouse pointer one time to start the drawing of the boundary 
condition line. You can continue to use single mouse clicks, along the outer boundary of the 2D Flow 
Area, to add as many points as you want into the line that represents the boundary condition. When 
you want to end the boundary condition line, place the mouse pointer over the location of where you 
want the line to end, and then double click the mouse pointer. A window will pop up asking you to 
enter a name for the boundary condition line. These boundary condition lines will show up in the 
Unsteady Flow Data editor, and will require you to select a boundary condition type (Flow 
Hydrograph, Rating Curve, or Stage Hydrograph) and enter the necessary data.

Pump stations can be connected between two storage areas, between a storage area and a river 
reach, or between two river reaches. To add a pump station to the schematic, click the Pump 
Station button at the top, under the tools button bar, and then left click on the schematic at the 
location where you want to place the pump station. To connect the pump station, either left click 
over top of the pump station and select edit, or just click on the pump station editor from the edit 
tool bar. Connecting pumps is accomplished by picking from and to locations from the pump data 
editor.

Adding Tributaries into an Existing Reach
If you would like to add a tributary or bifurcation into the middle of an existing reach, this can be 
accomplished by simply drawing the new reach, and connecting it graphically to the existing reach 
at the location where you would like the new junction to be formed. This is accomplished by ending 
the new river reach (tributary) right on top of the location of the main river, where you want the new 
Junction to be formed. Once the new reach is connected into the middle of an existing reach, you 
will first be prompted to enter a River and Reach identifier for the new reach. After entering the river 
and reach identifiers, you will be asked if you want to "Split" the existing reach into two reaches. If 
you answer "yes", you will be prompted to enter a new Reach identifier for the lower portion of the 
existing reach (the original reach name is kept for the upper portion of the reach) and a Junction 
name for the newly formed stream junction.

Editing the Schematic
There are several options available for editing the river system schematic. These options include: 
changing labels; moving Points/objects (such as labels, junctions, points in a reach or cross section, 
and 2D area cell centers); adding points (to a reach, cross section, storage area, 2D area boundary, 
and 2D Flow Area cell centers); deleting points; editing the schematic lines and symbols (line and 
point types and colors); changing the reach and river station text color; deleting entire reaches, 
junctions, storage areas/2D Flow Areas, storage area connections, pumps, nodes (cross sections, 
bridges/culverts, inline structures, lateral structures), and SA/2D Area boundary condition lines. 
Editing functions for the schematic are found under the Edit menu of the geometric data window. 
When a specific editing function is selected, the interaction of the user with the schematic is 
restricted to performing that type of operation. When the user is finished performing that editing 
function they should turn off that editing function by selecting it again from the Edit menu. When 

https://www.hec.usace.army.mil/confluence/display/RASUM/Adding+Tributaries+into+an+Existing+Reach


Entering and Editing Geometric Data

HEC-RAS User's Manual– 52

•

•

•

•

•

•

•

•

•

•

none of the editing functions are turned on, the schematic goes back to the default mode of 
interaction. The default interaction mode for the schematic is described in the "Interacting with the 
Schematic" section of this document. A description of each editing function follows:

Change Name: This option allows the user to change the identifiers of any reach or junction. To change an 
identifier, you must be in the Change Name edit mode. This is accomplished by selecting the Change Name
option from the Edit menu. Once you are in the Change Name edit mode, you then select the particular label 
that you would like to change by clicking the left mouse button over that label. When a label is selected, a 
pop up window will appear allowing you to enter a new label. The user can continue to change names by 
simply selecting the next label to be changed. The Change Name option can only be turned off by re-
selecting it from the edit menu or by selecting any other edit option.
Move Points/Objects: This option allows you to move any label, junction, points in the stream centerline of 
a reach, points defining the layout of cross sections, storage areas, 2D Flow Area boundaries, and 2D Flow 
Area cell centers. This is accomplished by first selecting Move Object from the Edit menu, then selecting the 
particular object that you would like to move. To select an object and then move it, simply place the mouse 
pointer over the object, then press the left mouse button down. Move the object to the desired location and 
then release the left mouse button. The Move Object option will remain in effect until the user either turns it 
off (which is accomplished by re-selecting it) or selects any other edit option.
Add Points: This option allows the user to add additional points to the line that defines a reach, cross 
section, storage area, 2D flow area boundaries, and 2D flow Area cell centers. This allows the user to make 
the schematic be drawn spatially correct as it would be on a map, as well as modify the 2D Flow Area mesh 
computational cells . To add additional points, first select Add Points from the Edit menu. Move the mouse 
pointer to the location in which you would like to add an additional point on the reach line, then click the left 
mouse button. After you have finished adding points to a reach, you can move them around by selecting the 
Move Object option from the Edit menu. To turn the "Add Points" mode off, simply re-select it from the Edit 
menu, or select any other edit function.
Remove Points: This option allows the user to remove points from a reach line, cross section line, storage 
area, 2D flow area boundary, or 2D Flow Area cell centers. To use this option, first select Remove Points
from the Edit menu. Move the mouse pointer over the point that you would like to delete and then click the 
left mouse button. This option can only be turned off by either re-selecting the option from the Edit menu or 
by selecting another edit function.
Lines and Symbols: This option allows the user to change the line and symbol types, colors, and widths for 
the information on the stream system schematic. When this option is selected a window will appear that 
shows each line type being used in the schematic. The user can select a particular line type, then change the 
properties of that line.
Reach and RS Text Color: This option allows the user to change the color of the text for reaches and river 
stations plotted on the schematic. The default color is black.
The Edit menu contains an option labeled Delete. The Delete menus has several submenus in order to 
delete the following objects.
Delete Reach: This option is used to delete a reach. This is accomplished by selecting the Delete Reach
option from the Edit menu. A list box containing all the available reaches will appear allowing you to select 
those reaches that you would like to delete. Warning - Be careful when you delete reaches. When you 
delete a reach, all of its associated data will be deleted also.
Delete Junction: This option is used to delete a junction. This is accomplished by selecting the Delete 
Junction option from the Edit menu. A list box containing all the available junctions will appear allowing 
you to select those junctions that you would like to delete.
Delete Storage Areas/2D Flow Areas: This option is used to delete a storage area or a 2D Flow Area. This is 
accomplished by selecting Delete Storage Areas/2D Flow Areas from the Edit menu. A selection box will 
appear allowing you to pick the storage areas or 2D Flow Areas that you would like to delete.
Delete SA/2D Area Connections: This option is used to delete a storage area or a 2D Flow Area hydraulic 
connection. This is accomplished by selecting the Delete SA/2D Area Connections option from the Edit
menu. A list box containing all the available storage area and 2D Flow Area connections will appear allowing 
you to select the ones that you would like to delete.



Entering and Editing Geometric Data

HEC-RAS User's Manual– 53

•

•

•

•

•

•

•

Delete Pump Station: This option allows the user to select one or more pump stations to be deleted from 
the schematic. This is accomplished by selecting Delete Pump Station from the Edit menu. A list box 
containing all the available pump stations will appear allowing you to select the ones that you would like to 
delete.
Delete Nodes (XS, Bridges, Culverts, etc…): This option allows the user to delete multiple locations at one 
time. For example, you can delete multiple cross sections at one time with this option. When this option is 
selected, a window will appear allowing you to select all of the nodes (cross sections, bridges, culverts, Inline 
structures, lateral structures, etc.) that you would like to delete.
Delete SA/2D Flow Area Boundary Condition lines: This option is used to delete a storage area or a 2D Flow 
Area Boundary Condition lines (BC Lines). This is accomplished by selecting the Delete SA/2D Area 
Boundary Condition lines option from the Edit menu. A list box containing all the available storage area 
and 2D Flow Area boundary condition lines will appear allowing you to select the ones that you would like to 
delete.
Delete 2D Flow Area Breaklines: This option allows the user to delete previously drawn 2D Flow Area 
Breaklines.
Delete 2D Flow Manning's Regions: This option allows the user to delete previously drawn 2D Flow Area 
Manning's n value regions.

Interacting with the Schematic
In addition to modifying the river schematic, there are options available from the View menu to 
zoom in, zoom previous, zoom out, full plot, pan, set schematic plot extents, and to display or not, 
many of the river system schematic labels. Additionally, the user has the ability to use the mouse to 
interact with the schematic. This is accomplished by moving the mouse pointer over an object (river 
reach line, junction, bridge, culvert, etc…) on the schematic and pressing down the left mouse 
button. Once the left mouse button is pressed down, a popup menu will appear with options that are 
specific to that type of object. For example, when the left mouse button is pressed down over a cross 
section, a menu will appear allowing the user to select options to: edit the cross section, plot the 
cross section, plot the profile for the reach that the cross section is in, display tabular output for the 
cross section, and plot the computed rating curve for that cross section.

Another way of interacting with the schematic is to press the right mouse button while the mouse 
pointer is located anywhere over the schematic drawing area. This will bring up a popup menu that 
is exactly the same as the View menu at the top of the drawing. This option is providing for 
convenience in getting to the View menu options.

Cool Graphics Window Tools: Most of the HEC-RAS graphical windows have some cool short cut 
tools. These tools include the following options:

Measuring Tool: On any of the graphical windows (Geometric Schematic, Profile Plot, Cross Section Plot, 
etc…) if you hold down the Cntrl Key, you will get a measuring tool. The measuring tool can be used to draw 
multi-point lines (polyline) on the graphic window. To draw a polyline, hold down the Cntrl Key and then 
use single clicks of the left mouse button to start and add points to the line. Double click the left mouse 
button to end the line. Once you end the line, a window will pop up giving you information about that line, 
such as: the length of the line; the area if the first and last point were connected to form a polygon; the X-axis 
length; the Y-axis length; and the slope of the line (dx/dy, from the first point to the last point). Additionally, 
the X and Y coordinates of the line get sent to the Windows Clipboard, so you can paste those coordinates 
into a table of some other application. This is a very handy feature for digitizing the coordinates of a cross 
section, measuring a length, or estimating a slope (i.e. on the profile plot).
Pan Tool: When you are zoomed in on the graphic within a window, if you hold down the Shift Key, the 
mouse pointer will change to a hand icon, and you can pan the graphic window. Releasing the Shift Key will 
change the mouse point back to the original icon.
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Mouse Wheel Feature: Now on any of the HEC-RAS graphical windows, the mouse wheel can be used to 
Zoom In and Zoom Out. Additionally the graphic will be re-centered based on where the mouse pointer is 
when using the mouse wheel to zoom in and out.

The following is a list of options available from the View menu:

Zoom In: This option allows the user to zoom in on a piece of the schematic. This is accomplished by 
selecting Zoom In from the View menu, then specifying the area to zoom in on with the mouse. Defining the 
zoom area is accomplished by placing the mouse pointer in the upper left corner of the desired area. Then 
press down on the left mouse button and drag the mouse to define a box containing the desired zoom area. 
Finally, release the left mouse button and the viewing area will display the zoomed in schematic. Also 
displayed will be a small box in the upper right corner of the viewing area. This box will contain a picture of 
the entire schematic, with a rectangle defining the area that is zoomed in. In addition to showing you where 
you are at on the schematic, this zoom box allows you to move around the schematic without zooming out 
and then back in. To move the zoomed viewing area, simply hold down the left mouse button over the 
rectangle in the zoom box and move it around the schematic. The zoom box can also be resized. Resizing the 
zoom box is just like resizing a window.
Zoom Previous: When this option is selected the program will go back to the previously defined viewing 
window of the schematic. For example, if the user zooms in on the display window of the geometric data 
editor, then selects the Zoom Previous option, the schematic drawing area will be put back to the previous 
display area before the last zoom in. The Zoom Previous option will remember up to the last 10 drawing 
rectangles displayed in the schematic window, so the user can select this option several times in a row to get 
back to a previous view.
Zoom Out: This option zooms out to an area that is twice the size of the currently zoomed in window. 
Zooming out is accomplished by selecting Zoom Out from the View menu on the geometric data window.
Full Plot: This option re-draws the plot to its full original size. The Full Plot option is accomplished by 
selecting Full Plot from the View menu on the geometric data window.
Pan: This option allows the user to move around when in a zoomed in mode. The pan option is 
accomplished by selecting Pan from the View menu of the geometric data window. When this option is 
selected, the mouse pointer will turn into a hand. Press the left mouse button and hold it down, then move 
the mouse. This will allow the user to move the zoomed in graphic. To turn the pan mode off, re-select the 
pan option from the view menu. A short cut way to use the pan option is to simply hold down the Shift Key
while the mouse is over the schematic. This will change the pointer to a hand graphic. Hold down the left 
mouse button and move the graphic. To stop panning, and change the pointer back to normal, release the 
Shift key.
Set Schematic Plot Extents: This option allows the user to set the extents of the viewing area for the river 
system schematic. The user can enter a specific coordinate system, or utilize the default data system. The 
default data plot extents are from 0 to 1 for both the X and Y axis.
Find: This option allows the user to have the interface locate a specific feature on the schematic. This is 
especially useful when very large and complex river systems are being modeled.

The following View menu options can be found on a new popup window by selecting View, then 
View Options. When View Options is selected, a window labeled Geometry Plot Options will 
appear that will allow you to toggle various objects on and off, such as: cross section properties; 
storage area/2D flow area properties; and Text labels.

Cross Section Properties:

Bank Stations: This option allows the user to display the main channel bank stations on the cross section 
lines of the schematic. This is accomplished by checking Display Bank Stations from the Geometry Plot 
Options window.
Ineffective Areas: This option allows the user to display the location of ineffective flow areas on top of the 
cross section lines of the schematic. This is accomplished by selecting Display Ineffective Areas from the 
Geometry Plot Options window.
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Levees: This option allows the user to display the location of levees on the cross section lines of the 
schematic. This is accomplished by selecting Display Levees from the Geometry Plot Options window.
Obstructions: This option allows the user to display the location of blocked obstructions on the cross 
sections lines of the schematic. This is accomplished by selecting Display Obstructions from the Geometry 
Plot Options window.
XS Direction Arrows: This option allows the user to display arrows along the cross sections in the direction 
in which they were extracted. This option is useful when you have coordinates defined for the cross section, 
such that the software can detect the direction that the cross section was extracted. Cross-sections are 
supposed to be entered from left to right while looking downstream. If a cross section has not been entered 
in this manner, it should be reversed. HEC-RAS has an option to reverse the cross section stationing. This 
option can be found under the Tools menu bar of the geometric data editor. To display the cross section 
direction arrows, select Display XS Direction Arrows from the Geometry Plot Options window.
Display Ratio of Cut Line Length to XS Length: This option will display a ratio next to each cross section. 
The ratio represents the length of the cross section cut line (based on the GIS coordinates) divided by the 
length of the cross section (based on station/elevation points). If this number is greater than 1.0 then the GIS 
cross section cut line is longer than the station/elevation points of the cross section. If this number is less 
than 1.0, then the cross section cut line is shorter than the length of the cross section station/elevation 
points. When the value is exactly 1.0, then the cross section cut line and the station elevations points are 
consistent with each other.

Storage Area/2D Flow Area Properties:

Fill in Storage Areas/2D Flow Areas: This option allows the user to turn on and off the fill in color for the 
storage areas and the 2D Flow Areas. Turning this off is very useful when a background picture is loaded.
2D Flow Area Cell Points: This option turns on the black points that represent the 2D Cell centers.
2D Flow Area Cell Point Numbers: This option turns on the numbering scheme for the 2D Flow Area cells.
2D Flow Areas Boundary Face Point Numbers: This option allows you to display the Face Point numbers of 
a 2D flow area on the schematic. To use this option select 2D Flow Area Face Point Numbering from the 
Geometry Plot Options window.
Display Break Lines Used in 2D Flow Areas: This option turns the display of the 2D Flow Area Breaklines on 
and off.
Display Land Cover Calibration Regions: This option turns the Land Cover regions on and off.

Text Labels:

Disable Text: HEC-RAS has several options for display text labels on the river system schematic. This option 
will turn all of the text labels off or on simultaneously. This option can be turned on or off by selecting 
Disable Text from the Geometry Plot Options window.
River and Reach: This option allows the user to display text labels for the River and Reaches. This is 
accomplished by selecting Display River and Reach Text from the Geometry Plot Options window.
River Stationing: This option allows you to display river station identifiers on the schematic. This is 
accomplished by selecting Display River Stationing Text from the Geometry Plot Options window.
Node Names: This option can be used to display and User entered Node Names that may have been added 
to cross sections or hydraulic structures. Node Names are longer text labels that can be added to any node 
to further describe that location. User's can add and change node names from the Tables menu option, then 
select Names, then Node Names.
Storage Area/2D Flow Area Names: This option allows you to display the text labels for storage areas and 
2D Flow Areas. To use this option select Display Storage Area/2D Flow Area Text from the Geometry Plot 
Options window.
SA/2D Area Connection Names: This option allows you to display the text labels for storage area 
connections. To use this option check the SA/2D Area Connection Names from the Geometry Plot Options
window.
BC Line Names: This option allows the user to turn the text labels for 2D Flow Area boundary conditions on 
and off.
Breakline Names: This option allows the user to turn the text labels for 2D Flow Area breaklines on and off.
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Land Cover Region Names: This option allows the user to turn the text labels for Land Cover Regions on and 
off.
Pump Station Names: This option allows the user to turn the text labels for pump stations on and off.
Junction Names: This option allows you to display the text labels for Junctions. To use this option select 
Junction Names from the Geometry Plot Options window.
Results: This option allows the user to display water surface or flow rate results, as numeric values, directly 
on the schematic. This option works in conjunction with the "Plot WS extents for Profile" option, which is 
available in the upper right hand corner of the Geometric Data editor window. If a user first turns on a 
specific profile to plot for the Plot WS extents for Profile option, then the computed water surface extents 
will be plotted in blue on top of each cross section. Additionally, if a user then checks either of the Results
option from the View menu, they can choose to have the interface also plot numeric values for the cross 
section stage and flow rate, right next to the text label of all the cross sections.

Highlight:

Highlight Active Node: This option will put a red circle around the active node (cross section, bridge, 
culvert, etc…) on the river system schematic. This option can be very handy when working with large 
complex data sets. The active node changes every time the user selects a new node from an editor or 
graphical plot.
Adjust Current Extents to Ensure Active Node is Visible: This option will move the viewing area of the 
stream system schematic to ensure that the active node is in the view. When fully zoomed out, this option 
has no effect. When zoomed in, the viewing area will move to show the active node. To turn this option on 
select Adjust Current Extents to Ensure Active Node is Visible from the View menu.

Background Map Layers

Another option available to users is the ability to display background images and terrain data behind 
the river system schematic. To display terrain data and other map layers in the Geometric data 
editor, the user must use HEC-RAS Mapper to do the following:

Establish a Horizontal Coordinate Projection to use for your model, from within HEC-RAS Mapper. This is 
normally done by selecting an existing projection file from an ESRI shapefile or other mapping layer.
Develop a terrain model in HEC-RAS Mapper. The terrain model is a requirement for 2D modeling, as it is 
used to establish the geometric and hydraulic properties of the 2D cells and cell faces. A terrain model is also 
need in order to perform any inundation mapping in HEC-RAS Mapper.
Build a Land classification data set within HEC-RAS Mapper in order to establish Manning's n values within 
the 2D Flow Areas (Optional). Additionally HEC-RAS has option for user defined polygons that can be used to 
override the Land Classification data or as calibration zones.
Add any additional mapping layers that may be needed for visualization, such as aerial photography, levee 
locations, road networks, etc…
Once you have accomplished the necessary steps outlined above, then you can display the terrain data and 
available map layers developed in RAS Mapper within the Geometric data editor. This is accomplished by 
selecting the Background Map Layer/Pictures button at the top of the Geometry editor. Pressing this 
button will bring up a window showing you the available Map Layers and terrain that can be turned on or off 
by checking that layer.



Entering and Editing Geometric Data

HEC-RAS User's Manual– 57

1.

2.

3.

4.

5.

Cross Section Data
After the river system schematic is completed, the next step for the modeler is to enter the cross 
section data. Cross section data represent the geometric boundary of the stream. An accurate 
representation of the stream channel and the overbank area (floodplain) are absolutely necessary to 
create an accurate hydraulics model. Cross sections are located at relatively short intervals along the 
stream to characterize the flow carrying capacity of the stream channel and its adjacent floodplain. 
Cross sections are required at representative locations throughout the stream and at locations 
where changes occur in discharge, slope, shape, roughness, at locations where levees begin and end, 
at hydraulic structures (bridges, culverts, inline weirs/spillways, and lateral weirs/spillways), and 
closely spaced around stream junctions. Cross sections can be entered by hand in the Geometric 
editor, or they can be extracted from terrain data from RAS Mapper.

Entering Data

To enter cross section data directly in the Geometric Data editor, the user presses the Cross Section
button on the Geometric Data window. Once the cross section button is pressed, the Cross Section 
Data Editor will appear as shown in the figure below (Except yours will be blank until you have added 
some data). To add a cross section to the model, the user must do the following:

From the Cross Section Editor, select the river and the reach that you would like to place the cross section in. 
This is accomplished by pressing the down arrow on the River and Reach boxes, and then selecting the river 
and reach of choice.
Go to the Options menu and select Add a new Cross Section from the list. An input box will appear 
prompting you to enter a river station identifier for the new cross section.
Enter all of the required data for the new cross section. Required data is the data that is openly displayed in 
the cross section editor window.
Enter any desired optional information (i.e., ineffective flow areas, levees, blocked obstructions, etc.). 
Optional cross section information is found under the Options menu.
Press the Apply Data button in order for the interface to accept the data. The apply data button does not 
save the data to the hard disk, it is used as a mechanism for telling the interface to use the information that 
was just entered. If you want the data to be saved to the hard disk you must do that from the File menu on 
the geometric data window.

The required information for a cross section consists of: the river, reach and river station identifiers; 
a description; X & Y coordinates (station and elevation points); downstream reach lengths; Manning's 
roughness coefficients; main channel bank stations; and contraction and expansion coefficients. All 
of the required information is displayed openly on the Cross Section Data editor (Figure 5-2). A 
description of this information follows:
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Cross Section Data Editor 
Cross section data entered in the manner described above is not geo-referenced (Does not have any 
horizontal coordinates describing its spatial location on the earth). If you want to have a model that 
is georeferenced, currently you must develop your model schematic and object layout using HEC-
GeoRAS and ArcGIS. Future versions of HEC-RAS will allow you to do this directly inside of HEC-RAS 
using RAS Mapper.

River, Reach, and River Station. The River and Reach boxes allow the user to select a specific 
hydraulic reach from the available reaches in the schematic diagram. The river and reach labels 
define which reach the cross section will be located in. The River Station tag defines where the cross 
section will be located within the specified reach. The river station tag does not have to be the actual 
river station of the cross section, but it must be a numeric value. Cross sections are ordered in the 
reach from highest river station upstream to lowest river station downstream. The up and down 
arrow buttons next to the river station box can be used to sequentially move through the river 
stations.

Description. The description box is used to describe the cross section location in more detail than 
just the river, reach, and river station. This box has a limit of 512 characters. The first line of 
information is displayed, unless the button to the right of the box is pressed. Also, the first 40 
characters of the description can be used as a label for cross section plots and tables.

Cross Section Coordinates. This table is used to enter the station and elevation information of the 
cross section. Station and elevation information is entered in feet (meters for metric).  Cross section 
stationing must be in increasing order. However, two or more stations can have the same value to 
represent vertical walls.

If you want to do any inundation mapping of the model results, or if you want to use 2D Flow 
Areas, your model must be georeferenced, and you must bring terrain data into HEC-RAS from 
within HEC-RAS Mapper.



The cross section stationing (x-coordinates) must be entered from left to right looking in the 
downstream direction.
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Downstream Reach Lengths. The downstream cross section reach lengths describe the distance 
between the current cross section and the next cross section downstream. Cross section reach 
lengths are defined for the left overbank, main channel, and the right overbank. Cross section reach 
lengths are entered in feet (meters for metric).

Manning's n Values. At a minimum, the user must specify Manning's n values for the left overbank, 
main channel, and the right overbank. Alternative roughness options are available from the Options
menu, in which you can have horizontally varying Manning's n values (up to 20 across each cross 
section) and vertically varying Manning's n values.

Main Channel Bank Stations. The main channel bank stations are used to define what portion of the 
cross section is considered the main channel and what is considered left and right overbank area. 
The bank stations must correspond to stations entered on the cross section X & Y coordinates table. 
If the user enters a value that does not correspond to the station points of the cross section, the 
interface will ask the user if they would like the value to be automatically interpolated and added to 
the cross section data.

Contraction & Expansion Coefficients (Steady Flow). Contraction and expansion coefficients are 
use to evaluate the amount of energy loss that occurs because of a flow contraction or expansion. 
The coefficients are multiplied by the change in velocity head from the current cross section to the 
next downstream cross section. In other words, the values entered at a particular cross section are 
used to compute losses that occur between that cross section and the next downstream cross 
section. Values entered at this location are used for steady flow hydraulic computations only. Values 
for Unsteady Flow modeling can be entered from the Tables menu of the Geometric data editor.

Once all of the required data for the cross section are entered, make sure you press the Apply data
button to ensure that the interface accepts the data that was just entered.

 Plotting the Cross Section. A display of the cross section can be seen directly from the cross 
section editor. Simply press the cross section plot button at the top of the editor to either display or 
un-display the cross section graphic.

 Attaching and Viewing Pictures at Cross Sections. To attach or view a previously attached 
picture to a cross section, press the picture button at the upper right hand side of the cross section 
editor. When this button is pressed, the picture viewer will pop up. You can attach a photo to a 
location, delete a picture, and view a currently attached photo.

Graphical Cross Section Editing. To jump to the Graphical Cross Section editor, press the button 

just to the right of the Apply Data button.  This will bring up the current cross section in the 
Graphical Cross Section editor, and allow you to graphically edit it. To learn more about Graphical 
Cross Section editing, view the section called "Graphical Cross Section Editing" under the Geometric 
Data Tools section of this manual.

Editing Data
The bulk of the cross section data is the station and elevation information. There are several features 
available under the Edit menu to assist the user in modifying this information. These features 
include the following:
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Undo Editing. This editing feature applies to all of the information on the cross section data editor. 
Once data has been entered and the Apply Data button has been pressed, the Undo Editing feature 
is activated. If any changes are made from this point, the user can get the original information back 
by selecting the Undo Edit option from the Edit menu. Once the Apply Data button is pressed, the 
new information is considered good and the Undo Edit feature is reset to the new data.

Cut, Copy, and Paste. Cut, Copy, and Paste features are available for the station and elevation 
information on the cross section editor. These features allow the user to pass cross section station 
and elevation data to and from the Windows Clipboard. To use this feature, first highlight a cell or 
multiple cells on the station and elevation table. Cells are highlighted by pressing down on the left 
mouse button and moving it over the cells that you would like to be highlighted. Next select either 
the Cut or Copy feature from the Edit menu. If Cut is selected, the information is placed in the 
Windows Clipboard and then it is deleted from the table. If Copy is selected, the information is 
placed in the Windows Clipboard, but it also remains in the table. Once the information is in the 
Windows Clipboard it can be pasted into the station and elevation table of any cross section. To 
paste data into another cross section, first go to the cross section in which you would like the data to 
be placed. Highlight the area of the table in which you want the data to be placed. Then select the 
Paste option from the Edit menu. The cut, copy, and paste features can also be used to pass station 
and elevation information between HEC-RAS and other programs.

Delete. This option allows the user to delete a single cell or multiple cells in the station/elevation 
table. Once the cells are deleted, everything below those cells is automatically moved up. To use this 
option, first highlight the cells that you would like to delete, then select the Delete option from the 
Edit menu. If you would like to clear cells, without moving the data below those cells, simply 
highlight the cells and press the delete key.

Insert. This option allows the user to insert one or several rows in the middle of existing data in the 
station/elevation table. To use this option, first highlight the area in the table that you would like to 
be inserted. Then select Insert from the Edit menu. The rows will be inserted and all of the data will 
be moved down the appropriate number of rows. The user can also insert a single row by placing the 
curser in the row just below where you would like the new row to be inserted. Then select Insert
from the Edit menu. The row will be inserted and all of the data below the current row will be moved 
down one row.

Options
Information that is not required, but is optional, is available from the Options menu at the top of the 
cross section data editor window (Figure 5-2). Options consist of the following:

Add a new Cross Section. This option initiates the process of adding a cross section to the data set. 
The user is prompted to enter a river station tag for the new cross section. The river station tag 
locates the cross section within the selected reach. Once the river station is entered, the cross 
section data editor is cleared (except for some default values that get set) and the user can begin 
entering the data for the cross section. Whenever a new cross section is added to the data set, 
default values will appear for the contraction and expansion coefficients (0.1 and 0.3 respectively). 
Also, if the new cross section is not the first or most upstream cross section of the reach, the program 
will set default Manning's n values equal to the n values of the cross section just upstream of the new 
cross section. If the user does not want these default values, they can simply change them to 
whatever values they would like.
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Copy Current Cross Section. This option allows the user to make a copy of the cross section that is 
currently displayed in the editor. When this option is selected, the user is prompted to select a river 
and reach for the new section, and then enter the river station. Once the information is entered, the 
new cross section is displayed in the editor. At this point it is up to the user to change the description 
and any other information about the cross section. This option is normally used to make 
interpolated cross sections between two surveyed cross sections. Once the section is copied, the 
user can adjust the elevations and stationing of the cross section to adequately depict the geometry 
between the two surveyed sections.

Rename River Station. This option allows the user to change the River Station of the currently 
displayed cross section.

Delete Cross Section. This option will delete the currently displayed cross section. The user is 
prompted with a message stating specifically which cross section is going to be deleted, and 
requesting the user to press the OK button or the Cancel button. Once the OK button is pressed, the 
user will be prompted with a question of whether or not they would like the cross section reach 
lengths to be automatically adjusted to account for the removal of the cross section. If the user 
answers YES then the reach lengths of the current cross section, that is being deleted, will be added 
to the reach lengths of the next upstream cross section. If the user answers NO, then the cross 
section will be deleted with out adjusting any reach lengths.

Adjust Elevations. This option allows the user to adjust all of the elevations of the currently 
displayed cross section. Positive or negative elevation changes can be entered. Once the value is 
entered, the interface automatically adjusts all the elevations in the table.

Adjust Stations. This option allows the user to adjust the stationing of the currently displayed cross 
section. Two options are available. The first option (Multiply by a Factor) allows the user to 
separately expand and/or contract the left overbank, main channel, and the right overbank. When 
this option is selected, the user is prompted to enter a multiplier for each of the three flow elements 
(left overbank, main channel, and right overbank). If the multiplier is less than one, the flow element 
is contracted. If the multiplier is greater than one, the flow element is expanded. Once the 
information is entered, and the user hits the OK button, the interface automatically performs the 
contraction and/or expansions. The cross section should be reviewed to ensure that the desired 
adjustments were performed. The second option (Add a Constant) allows the user to add or subtract 
a constant value from all the stations in the cross section. This would allow the entire cross section 
to be shifted to the right or the left.

Adjust n or k Values. This option allows the user to either increase or decrease all the n or k values of 
the current cross section. The user is prompted for a single value. This value is then used as the 
multiplier for all of the n or k values of the current cross section.

Skew Cross Section. This option allows the user to adjust the stationing of a cross section based on 
a user entered skew angle. Cross-sections are supposed to be taken perpendicular to the flow lines. 
This may not always be the case, such as at bridges. In order for the program to use the correct flow 
area, the cross section stationing must be adjusted by taking the cosine of the skew angle times the 
stationing. When this option is selected, a window will appear allowing the user to enter a skew 
angle. Once the angle is entered, the software will automatically adjust the cross section stationing. 
The user can get back to the original stationing by putting a zero skew into the field.
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Ineffective Flow Areas. This option allows the user to define areas of the cross section that will 
contain water that is not actively being conveyed (ineffective flow). Ineffective flow areas are often 
used to describe portions of a cross section in which water will pond, but the velocity of that water, 
in the downstream direction, is close to or equal to zero. This water is included in the storage 
calculations and other wetted cross section parameters, but it is not included as part of the active 
flow area. When using ineffective flow areas, no additional wetted perimeter is added to the active 
flow area. An example of an ineffective flow area is shown in Figure 6.3. The cross-hatched area on 
the left of the plot represents the ineffective flow area.
Two alternatives are available for setting ineffective flow areas. The first option allows the user to 
define a left station and elevation and a right station and elevation (normal ineffective areas). 
When this option is used, and if the water surface is below the established ineffective elevations, the 
areas to the left of the left station and to the right of the right station are considered ineffective. 
Once the water surface goes above either of the established elevations, then that specific area is no 
longer considered ineffective. In other words, the program now assumes that the area will be 
conveying water in the downstream direction, such that it now uses that area in the conveyance 
calculations of the active flow area. However, the user has the option to set the ineffective flow areas 
to permanent, which will prevent them from turning off. When this option is used, water is allowed to 
go over top of the ineffective flow area.

The second option allows for the establishment of blocked ineffective flow areas. Blocked 
ineffective flow areas require the user to enter an elevation, a left station, and a right station for each 
ineffective block. Up to ten blocked ineffective flow areas can be entered at each cross section. Once 
the water surface goes above the elevation of the blocked ineffective flow area, the blocked area is 
no longer considered ineffective. However, the user has the option to set the blocked ineffective flow 
areas to permanent, which will prevent them from turning off. When this option is used, water is 
allowed to go over top of the ineffective flow area.

Figure 5 3 Cross section with ineffective flow areas
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Levees. This option allows the user to establish a left and/or right stationing and elevation on any 
cross section, in which the water surface will be confined to inside of these stationing values, until 
the water surface goes above their trigger elevation (elevation at which this option turns off). When 
levees are established, no water can go to the left of the left levee station or to the right of the right 
levee station until either of the levee elevations is exceeded. Levee stations must be defined 
explicitly, or the program assumes that water can go anywhere within the cross section. An example 
of a cross section with a levee on the left side is shown in the figure below. In this example the levee 
station and elevation is associated with an existing point on the cross section.

 
Example of the Levee Option

The user may want to add levees into a data set in order to see what effect a levee will have on the 
water surface. A simple way to do this is to set a levee station and elevation that is above the existing 
ground. If a levee elevation is placed above the existing geometry of the cross section, then a vertical 

The Levee option is a cross section option to prevent water from getting to certain portions of 
the cross section, until the water level rises above user specified elevations. However, the water 
surface is assumed to be horizontal across the entire wetted portion of the cross section. If you 
have a constructed levee, and you want to model over topping or breaching of that levee, you 
should end your cross section at the top of that levee. Model the actual levee with a lateral 
structure, and model the area behind the levee with a 2D Flow Area, Storage Area, or another 
river reach. This approach is much more accurate for modeling constructed levees, as it allows 
for different water surface elevations to be computed inside the leveed area, and a much more 
detailed analysis of levee overtopping and breaching.
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wall is placed at that station up to the established levee height. Additional wetted perimeter is 
included when water comes into contact with the levee wall. An example of this is shown below.

Example Levee Added to a Cross Section

Obstructions. This option allows the user to define areas of the cross section that will be 
permanently blocked out. Obstructions decrease flow area and add wetted perimeter when the 
water comes in contact with the obstruction. An obstruction does not prevent water from going 
outside of the obstruction.

Two alternatives are available for entering obstructions. The first option allows the user to define a 
left station and elevation and a right station and elevation (normal obstructions). When this option 
is used, the area to the left of the left station and to the right of the right station will be completely 
blocked out. An example of this type of obstruction is shown in the figure below. 
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Example of Normal Obstructions

The second option, for obstructions, allows the user to enter up to 20 individual blocks (blocked 
obstructions). With this option the user enters a left station, a right station, and an elevation for 
each of the blocks. An example of a cross section with blocked obstructions is shown below.

Example of a Cross Section with Blocked Obstruction
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Add a Lid to XS. This option allows the user to add a lid (similar to a bridge deck/roadway) to any 
cross section. This is commonly used when trying to model a long tunnel. The ground geometry can 
be used to describe the bottom half of the tunnel, while the lid can describe the top half. A lid can be 
added to any number of cross sections in a row. The program treats cross sections with lids just like 
any other cross section. The energy equation is used to balance a water surface, with the assumption 
of open channel flow. The only difference is that the program will subtract out area and add wetted 
perimeter when the water surface comes into contact with the lid. For unsteady flow models, there is 
a check box to select the Preissmann Slot option when solving the unsteady flow equations for 
cross sections with lids. This option allows the unsteady flow equations to solve for a pressure flow 
water surface using the open channel flow equations.

Add Ice Cover. This option allows the user to enter ice cover for the currently opened cross section. 
For a detailed discussion of ice cover, and ice modeling, please review the section called Modeling 
Ice Cover later in this chapter.

Add a Rating Curve. This option allows the user to add a rating curve to a cross section as an 
alternative to the program computing the water surface. The user is required to enter flow versus 
elevation information for the rating curve. When the program is executed in a steady flow mode, the 
program will interpolate a water surface elevation from the rating curve for the given flow of a 
particular profile.

Horizontal Variation in n Values. This option allows the user to enter more than three Manning's n 
values for the current cross section. When this option is selected, an additional column for n values is 
added to the cross section coordinates table as shown in the figure below. A Manning's n value must 
be placed in the first row of the table. This n value is good for all cross section stations until a new n 
value shows up in the table. The user does not have to enter an n value for every station, only at the 
locations where the n value is changing. 

Cross Section with Horizontal Variation of n Values Selected

Horizontal Variation in k Values. This option allows the user to enter k values (roughness heights) 
instead of n values. The k values are entered in the same manner as the horizontal variation of n 
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values. To learn more about k values and how they are used in the program, see Chapter 3 of the 
Hydraulic Reference manual.

Vertical Variation in n Values. This option allows the user to enter Manning's n values that vary both 
horizontally as well as vertically. The user can vary the n value either by elevation or by flow. When 
this option is selected a window will appear as shown the figure below. The user enters the 
stationing for horizontal changes in n values across the top in row 0 (these stations are entered in the 
same manner as the horizontal variation of Manning's n value option). The elevations in which 
changes occur are entered in the first column. Then the actual Manning's n values are entered in 
rows 1-20 (columns 2-21). The program will interpolate Manning's n values whenever the actual 
water surface is between the entered elevations. If the water surface is below the first elevation 
entered, then the values from that elevation will be used. Likewise, if the water surface is above the 
last elevation entered, the program will use the n values from the last elevation specified. No 
extrapolation is done on either side of the user entered values.

Vertical Variation of Manning's n Values Window

Plotting
Once all the data have been entered for a cross section, you should plot the cross section to inspect 
it for possible data errors. To plot the current cross section from the cross section editor, you can 
either select Plot Cross Section from the Plot menu (this will bring up a separate plot window), or 
you can use the cross section plot button at the top of the cross section editor (this attaches a plot 
window to the cross section editor). 

Stream Junctions

Entering Junction Data

Stream junctions are defined as locations where two or more streams come together or split apart. 
Junction data consist of a description; reach lengths across the junction; tributary angles; and 
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modeling approach. To enter junction data the user presses the Junction button on the Geometric 
Data window (Figure 5-1). Once the junction button is pressed, the junction editor will appear as 
shown in Figure 5-10. 

Figure 5 10 Junction Data Editor

The junction editor will come up with one of the junctions loaded. Fill out the description and reach 
lengths for the junction. Reach lengths across the junction are entered here instead of the cross 
section data editor. This allows for the lengths across very complicated confluences (i.e., flow splits) 
to be accommodated. In the cross section data, the reach lengths for the downstream cross section 
of each reach upstream of the junction will be overridden by the lengths in the junction editor.

Selection a Modeling Approach
For steady flow hydraulics in HEC-RAS, a junction can be modeled by either the energy equation or 
the momentum equation. The energy equation does not take into account the angle of a tributary 
coming in or leaving, while the momentum equation does. In most cases the amount of energy loss 
due to the angle of the tributary flow is not significant, and using the energy equation to model the 
junction is more than adequate. However, there are situations where the angle of the tributary can 
cause significant energy losses. In these situations it would be more appropriate to use the 
momentum approach. When the momentum approach is selected, an additional column is added to 
the table next to the junction lengths. This column is used to enter an angle for any river reach that is 
coming into or exiting the main river. For the reaches that are considered to be the main river, the 
angle should be left blank or set to zero. Also, the user has the option to turn friction and weight 

When laying out cross sections around a junction (Upstream and downstream on the main stem 
river and tributaries connected to the junction), place the cross sections as close to the junction 
as possible. This is especially important for unsteady flow modeling, as the default 
computational option is that the model assumes the same water surface elevation at all cross 
sections bounding the junction. If this is a bad assumption, turn on the option labeled "Energy 
Balance Method" under the Unsteady Flow Computational Method. Cross sections laid out 
very far from the junction can lead to model stability issues if the elevation of the channel 
bottom for the cross sections that bound the junction are very different (Have very different 
invert elevations).
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forces on or off during the momentum calculations. The default is to have the weight force turned 
off.

For unsteady flow hydraulics there are two options for modeling the hydraulics at a junction. The 
default option makes some simplifying assumptions for the hydraulics at a junction. If the junction is 
a normal flow combining junction, then all cross sections that bound the junction are given the same 
water surface each time step, based on the computed water surface at the downstream side of the 
junction. If the junction is a flow split the water surfaces at the junction are based on the computed 
water surface at the upstream side of the junction. This simplifying assumption requires user's to 
place cross sections fairly close together around a junction, depending on the slope of the stream. If 
cross sections are too far apart, model stability problems can arise from the force water surfaces at 
all cross sections that bound the junction.

A new junction hydraulics option called the Energy Balance Method has been added for unsteady 
flow modeling. When this option is turned on, an energy balance is performed across the junction in 
order to compute the water surfaces, rather than forcing them to all be the same. This is a very useful 
option for medium to steep streams, or where junction reach lengths are fairly lengthy. 
If there is more than one junction in the river schematic, the other junctions can be selected from the 
Junction Name box at the upper left corner of the window. Enter all the data for each junction in the 
river system then close the window by pressing the OK button in the lower left corner of the window. 
When the junction data editor is closed the data are automatically applied.

Bridges and Culverts

Once all of the necessary cross-section data have been entered, the modeler can then add 1D bridges 
and culverts. For a discussion on modeling bridges in 2D, look here and see the HEC-RAS 2D User's 
Documentation. HEC-RAS computes energy losses caused by structures such as bridges and culverts 
in three parts. One part consists of losses that occur in the reach immediately downstream from the 
structure where an expansion of flow takes place. The second part is the losses at the structure itself, 
which can be modeled with several different methods. The third part consists of losses that occur in 
the reach immediately upstream of the structure where the flow is contracting to get through the 
opening.

The bridge routines in HEC-RAS allow the modeler to analyze a bridge with several different methods 
without changing the bridge geometry. The bridge routines have the ability to model low flow (Class 
A, B, and C), low flow and weir flow (with adjustments for submergence), pressure flow (orifice and 
sluice gate equations), pressure and weir flow, and high flows with the energy equation only. The 
model allows for multiple bridge and/or culvert openings at a single location.

The culvert hydraulics in HEC-RAS are based on the Federal Highway Administrations (FHWA) 
standard equations from the publication Hydraulic Design of Highway Culverts (FHWA, 1985), for 
inlet control situations, and a detailed energy balance into, through, and out of the culvert, for outlet 
control computations. The culvert routines include the ability to model circular, box, elliptical, arch, 
pipe arch, low profile arch, high profile arch, semi circular culverts, and ConSpan culvert shapes. The 
HEC-RAS program has the ability to model multiple culverts at a single location. The culverts can 
have different shapes, sizes, elevations, and loss coefficients. The user can also specify the number 

https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.5/entering-and-editing-geometric-data/bridges-and-culverts/bridges-in-2d-flow-areas
https://www.hec.usace.army.mil/confluence/rasdocs/r2dum/6.5/development-of-a-2d-or-combined-1d-2d-model/modeling-bridges-inside-2d-flow-areas
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of identical barrels for each culvert type. Culverts can also be buried into the ground and have 
different roughness coefficients for the bottom, versus the top and sides.

Cross Section Locations
The bridge and culvert routines utilize four user defined cross sections in the computations of energy 
losses due to the structure. A plan view of the basic cross section layout is shown in the figure below. 
Cross section 1 is located sufficiently downstream from the structure so that the flow is not affected 
by the structure (i.e., the flow has fully expanded). This distance should generally be determined by 
field investigation during high flows. However, generally field investigation during high flows is not 
possible. The expansion distance will vary depending upon the degree of constriction, the shape of 
the constriction, the magnitude of the flow, and the velocity of the flow. If no detailed information is 
available, a rough estimate of a 2:1 expansion ratio can be used for a first cut estimate of the 
expansion reach length. Additionally, the table below offers ranges of expansion ratios, which can be 
used for different degrees of constriction, different slopes, and different ratios of the overbank 
roughness to main channel roughness. Once an expansion ratio is selected, the distance to the 
downstream end of the expansion reach (the distance Le) is found by multiplying the expansion ratio 
by the average obstruction length (the average of the distances A to B and C to D). 

  

Cross Section Locations at a Bridge or Culvert

The average obstruction length is half of the total reduction in floodplain width caused by the two 
bridge approach embankments. In table below, b/B is the ratio of the bridge opening width to the 
total floodplain width, nob is the average Manning n value for the overbanks, nc is the n value for the 
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main channel, and Slope is the average longitudinal bed slope through the bridge reach. The values 
in the interior of the table are the ranges of the expansion ratio. For each range, the higher value is 
typically associated with a higher discharge. 

Ranges of Expansion Ratios

Opening Ratio Slope nob / nc = 1 nob / nc = 2 nob / nc = 4

b/B = 0.10 1 ft/mile 
5 ft/mile 
10 ft/mile

1.4 – 3.6 
1.0 – 2.5 
1.0 – 2.2

1.3 – 3.0 
0.8 – 2.0 
0.8 – 2.0

1.2 – 2.1 
0.8 – 2.0 
0.8 – 2.0

b/B = 0.25 1 ft/mile 
5 ft/mile 
10 ft/mile

1.6 – 3.0 
1.5 – 2.5 
1.5 – 2.0

1.4 – 2.5 
1.3 – 2.0 
1.3 – 2.0

1.2 – 2.0 
1.3 – 2.0 
1.3 – 2.0

b/B = 0.50 1 ft/mile 
5 ft/mile 
10 ft/mile

1.4 – 2.6 
1.3 – 2.1 
1.3 – 2.0

1.3 – 1.9 
1.2 – 1.6 
1.2 – 1.5

1.2 – 1.4 
1.0 – 1.4 
1.0 – 1.4

A detailed study of flow contraction and expansions at bridges was undertaken by the Hydrologic 
Engineering Center. The results of this study have been published as a research document entitled 
"Flow Transitions in Bridge Backwater Analysis" (RD-42 HEC, 1995). The purpose of this study was to 
provide better guidance to hydraulic engineers performing water surface profile computations 
through bridges. Specifically the study focused on determining the expansion reach length, Le; the 
contraction reach length, Lc; the expansion energy loss coefficient, Ce; and the contraction energy 
loss coefficient, Cc. A summary of this research, and the final recommendations, can be found in 
Appendix B of the HEC-RAS Hydraulic Reference manual.

The user should not allow the distance between cross section 1 and 2 to become so great that 
friction losses will not be adequately modeled. If the modeler feels that the expansion reach will 
require a long distance, then intermediate cross sections should be placed within the expansion 
reach in order to adequately model friction losses. The user will need to estimate ineffective flow 
areas for these intermediate cross sections.

Cross section 2 is located a short distance downstream from the bridge or culvert. This cross section 
should represent the natural ground (main channel and floodplain) just downstream of the bridge or 
culvert. This section is normally located near the toe of the downstream road embankment. This 
cross section should Not be placed immediately downstream of the face of the bridge deck or the 
culvert opening (for example some people wrongly place this cross section 1.0 foot downstream of 
the bridge deck or culvert opening). Even if the bridge has no embankment, this cross section should 
be placed far enough from the downstream face of the bridge to allow enough distance for some 
flow expansion due to piers, or pressurized flow coming out of the bridge. If a culvert is being 
modeled, the culvert routines automatically account for an exit loss. Therefore, cross section 2 
should be located far enough downstream from the culvert to capture the immediate expansion of 
flow in which the exit losses occur over. This distance will vary with the size of the bridge opening or 
culvert.

Cross section 3 should be located a short distance upstream from the bridge or culvert. This 
distance should only reflect the length required for the abrupt acceleration and contraction of the 
flow that occurs in the immediate area of the opening. Cross section 3 represents the natural ground 
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of the channel and overbank area just upstream of the road embankment. This section is normally 
located near the toe of the upstream road embankment. This cross section should Not be placed 
immediately upstream of the bridge deck or culvert opening (for example some people wrongly 
place this cross section 1.0 foot upstream of the bridge deck or culvert opening). The bridge and 
culvert routines used between cross sections 2 and 3 account for the contraction losses that occur 
just upstream of the structure (entrance losses for the culvert routines). Therefore, this cross section 
should be place just upstream of the area where the abrupt contraction of flow occurs to get into the 
bridge opening or culvert. This distance will vary with the size of the bridge opening or culvert.
Both cross sections 2 and 3 will have ineffective flow areas to either side of the bridge or culvert 
opening during low flow and pressure flow. In order to model only the effective flow areas at these 
two sections, the modeler should use the ineffective flow area option. This option is selected from 
the cross section data editor. For a detailed discussion of how to set the ineffective flow area stations 
and elevations, see Chapter 5 of the Hydraulic Reference manual.

Cross section 4 is an upstream cross section where the flow lines are approximately parallel and the 
cross section is fully effective. In general, flow contractions occur over a shorter distance than flow 
expansions. The distance between cross section 3 and 4 (the contraction reach length, Lc) should 
generally be determined by field investigation during high flows. Traditionally, the Corps of 
Engineers recommends locating the upstream cross section a distance equal to one times the 
average length of the side constriction caused by the structure abutments (i.e. 1:1 contraction ratio). 
The 1:1 contraction ratio is a reasonable first estimate for placing cross section 4 if no other detailed 
information or field data is available to further refine that estimate. The contraction distance will 
vary depending upon the degree of constriction, the shape of the constriction, the magnitude of the 
flow, and the velocity of the flow. As mentioned previously, the detailed study "Flow Transitions in 
Bridge Backwater Analysis" (RD-42, HEC, 1995) was performed to provide better guidance to 
hydraulic engineers performing water surface profile computations through bridges. A summary of 
this research, and the final recommendations, can be found in Appendix B of the HEC-RAS Hydraulic 
Reference manual.
When the user adds a bridge at a particular river station, the program automatically formulates two 
additional cross sections inside of the bridge structure. The geometry inside of the bridge is a 
combination of the bounding cross sections (2 and 3) and the bridge geometry. The bridge geometry 
consists of the bridge deck, abutments if necessary, and any piers that may exist. The user can 
specify different bridge geometry for the upstream and downstream sides of the structure if 
necessary. Cross section 2 and the structure information on the downstream side are used as the 
geometry just inside the structure at the downstream end. Cross section 3 and the upstream 
structure information are used as the bridge geometry just inside the structure at the upstream end. 
The user has the option to edit these internal bridge cross sections, in order to make adjustments to 
the geometry.

For a more detailed discussion on laying out cross sections around bridges and culverts, the user is 
referred to chapters 5 and 6 of the Hydraulic Reference Manual.

Contraction and Expansion Losses
Losses due to the contraction and expansion of flow between cross sections are determined during 
the standard step profile calculations. Contraction and Expansion losses are described in terms of 
coefficient times the absolute value of the change in velocity head between adjacent cross sections. 
When the velocity head increases in the downstream direction a contraction coefficient is used; and 
when the velocity head decreases in the downstream direction, an expansion coefficient is used. For 
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•
•
•
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a detailed discussion on selecting contraction and expansion coefficients at bridges, the user is 
referred to chapter 5 of the HEC-RAS Hydraulic Reference Manual.

Bridge Hydraulic Computations

Low Flow Computations

For low flow computations the program first uses the momentum equation to identify the class of 
flow. This is accomplished by first calculating the momentum at critical depth inside the bridge at 
the upstream and downstream ends. The end with the higher momentum (therefore most 
constricted section) will be the controlling section in the bridge. The momentum at critical depth in 
the controlling section is then compared to the momentum of the flow downstream of the bridge 
when performing a subcritical profile (upstream of the bridge for a supercritical profile). If the 
momentum downstream is greater than the critical depth momentum inside the bridge, the class of 
flow is considered to be completely subcritical (i.e., class A low flow). If the momentum downstream 
is less than the momentum at critical depth in the bridge, then it is assumed that the constriction will 
cause the flow to pass through critical depth and a hydraulic jump will occur at some distance 
downstream (i.e., class B low flow). If the profile is completely supercritical through the bridge then 
this is class C low flow. Depending on the class of flow the program will do the following:

Class A low flow. Class A low flow exists when the water surface through the bridge is completely 
subcritical (i.e., above critical depth). Energy losses through the expansion (sections 2 to 1) are 
calculated as friction losses and expansion losses. Friction losses are based on a weighted friction 
slope times a weighted reach length between sections 1 and 2. The average friction slope is based on 
one of the four available alternatives in HEC-RAS, with the average-conveyance method being the 
default. This option is user selectable. The average length used in the calculation is based on a 
discharge-weighted reach length. 
There are four methods for computing losses through the bridge (from 2 to 3):

Energy equation (standard step method)
Momentum balance
Yarnell equation
FHWA WSPRO method

The user can select any or all of these methods in the computations. If more than one method is 
selected, the user must choose either a single method as the final solution or tell the program to use 
the method that computes the greatest energy loss through the bridge as the answer at section 3. 
This allows the modeler to compare the answers from several techniques all in a single execution of 
the program. Minimal results are available for all the methods computed, but detailed results are 
available for the method that is selected as the final answer.

Energy losses through the contraction (sections 3 to 4) are calculated as friction losses and 
contraction losses. Friction and contraction losses between sections 3 and 4 are calculated the same 
as friction and expansion losses between sections 1 and 2.

Class B low flow. Class B low flow can exist for either subcritical or supercritical profiles. For either 
profile, class B flow occurs when the profile passes through critical depth in the bridge constriction. 
For a subcritical profile, the momentum equation is used to compute an upstream water surface 
above critical depth and a downstream water surface below critical depth, using a momentum 
balance through the bridge. For a supercritical profile, the bridge is acting as a control and is 
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1.

causing the upstream water surface elevation to be above critical depth. Momentum is used again to 
calculate an upstream water surface above critical depth and a downstream water surface below 
critical depth. The program will proceed with forewater calculations downstream from the bridge.
Class C low flow. Class C low flow exists when the water surface through the bridge is completely 
supercritical. The program can use either the energy or the momentum equation to compute the 
water surface through the bridge.

Pressure Flow Computations

Pressure flow occurs when the flow comes into contact with the low chord of the bridge. Once the 
flow comes into contact with the upstream side of the bridge, a backwater occurs and orifice flow is 
established. The program will handle two cases of orifice flow: the first is when only the upstream 
side of the bridge is in contact with the water; and the second is when the bridge constriction is 
flowing completely full. For the first case, a sluice gate type of equation is used, as described in 
"Hydraulics of Bridge Waterways" (FHWA, 1978). In the second case, the standard full flowing orifice 
equation is used. The program will begin checking for the possibility of pressure flow when the 
energy grade line goes above the maximum low chord elevation. Once pressure flow is computed, 
the pressure flow answer is compared to the low flow answer and the higher of the two is used. The 
user has the option to tell the program to use the water surface, instead of energy, to trigger the 
pressure flow calculation.

Weir Flow Computations

Flow over the bridge and the roadway approaching the bridge will be calculated using the standard 
weir equation. For high tailwater elevations the program will automatically reduce the amount of 
weir flow to account for submergence on the weir. This is accomplished by reducing the weir 
coefficient based on the amount of submergence. When the weir becomes highly submerged, the 
program will automatically switch to calculating losses based on the energy equation (standard step 
backwater). The criterion for when the program switches to energy based calculations is user 
controllable.

Combination Flow

Sometimes combinations of low flow or pressure flow occur with weir flow. In these cases an 
iterative procedure is used to determine the amount of each type of flow.

Entering and Editing Bridge Data

To enter bridge data the user presses the Bridge/Culvert button on the geometric data window 
(Figure 5-1). Once the bridge/culvert button is pressed, the Bridge/Culvert Data Editor will appear as 
shown in Figure 5-12 (your bridge/culvert editor will come up with a blank window until you have 
entered the bridge data). To add a bridge to the model, do the following:

Select the river and reach that you would like to place the bridge in. Selecting a reach is accomplished by 
pressing the down arrow on the river and reach box, then selecting the river and reach of choice.
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1.

2.

Go to the Options menu and select Add a Bridge and/or Culvert from the list. An input box will appear 
prompting you to enter a river station identifier for the new bridge.
Enter all of the required data for the new bridge. This includes:

Bridge Deck
Sloping Abutments (optional)
Piers (optional)
Bridge modeling approach information

Enter any desired optional information. Optional bridge information is found under the Options menu at the 
top of the window.
Press the Apply Data button for the interface to accept the data.

Figure 5 12 Bridge/Culvert Data Editor

The required information for a bridge consists of: the river, reach, and river station identifiers; a short 
description of the bridge; the bridge deck; bridge abutments (if they exist); bridge piers (if the bridge 
has piers); and specifying the bridge modeling approach. A description of this information follows:

River, Reach and River Station. The River and Reach boxes allow the user to select a river and reach 
from the available reaches that are defined in the schematic diagram. The reach label defines which 
reach the bridge will be located in. The River Station tag defines where the bridge will be located 
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within the specified reach. The river station tag does not have to be the actual river station of the 
bridge, but it must be a numeric value. The river station tag for the bridge should be numerically 
between the two cross sections that bound the bridge. Once the user selects Add a Bridge and/or 
Culvert from the options menu, an input box will appear prompting you to enter a river station tag 
for the new bridge. After the river station tag is entered, the two cross sections that bound the bridge 
will be displayed on the editor.

Description. The description box is used to describe the bridge location in more detail than just the 
reach and river station. This box has a limit of 256 characters. Only the first line of information is 
displayed, unless the button to the right of the box is pressed. Also, the first 40 characters of the 
description are used as a label for bridge plots and tables.

Bridge Deck/Roadway. The bridge deck editor is used to describe the area that will be blocked out 
due to the bridge deck, road embankment and vertical abutments. To enter bridge deck information 
the user presses the Deck button on the Bridge/Culvert Data Editor. Once the deck button is pressed, 
the Deck Editor will appear as in Figure 5-13 (except yours will be blank). The information entered in 
the deck editor consists of the following:

Figure 5 13 Bridge Deck/Roadway Data Editor

Distance - The distance field is used to enter the distance between the upstream side of the bridge 
deck and the cross section immediately upstream of the bridge (see Figure 5 14, "Upstream 
Distance"). This distance is entered in feet (or meters for metric).
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Width - The width field is used to enter the width of the bridge deck along the stream (Figure 5 14, 
"Bridge Width"). The distance between the bridge deck and the downstream bounding cross section 
will equal the main channel reach length minus the sum of the bridge "width" and the "distance" 
between the bridge and the upstream section. The width of the bridge deck should be entered in feet 
(meters for metric). 

Figure 5 14 Bridge Profile with Upstream Distance, Bridge Width, and Downstream Distance

Weir Coefficient - Coefficient that will be used for weir flow over the bridge deck in the standard weir 
equation. 
Upstream Stationing, High Chord, and Low Chord - This table is used to define the geometry of the 
bridge deck on the upstream side of the bridge. The information is entered from left to right in cross 
section stationing. The deck is the area between the high and low chord elevation information. The 
stationing of the deck does not have to equal the stations in the bounding cross section, but it must 
be based on the same origin. The Del Row and Ins Row buttons allow the user to delete and insert 
rows.

Downstream Stationing, High Chord, and Low Chord - This portion of the table is used to define the 
geometry of the bridge deck on the downstream side of the bridge. If the geometry of the 
downstream side is the same as the upstream side, then the user only needs to press the Copy US to 
DS button. When this button is pressed, all of the upstream bridge deck information is copied to the 
downstream side. If the bridge deck information on the downstream side is different than the 
upstream side, then the user must enter the information into the table.

U.S. Embankment SS - This field is used to enter the slope of the road embankment on the upstream 
side of the bridge. The slope should be entered as the horizontal to vertical distance ratio of the 
embankment. This variable is generally not used in the computations, but is used for display 
purposes in the profile plot. However, if the user has selected the FHWA WSPRO Bridge method for 
low flow, this field will be used in the computation of the bridge discharge coefficient.

D.S. Embankment SS - This field is used to enter the slope of the road embankment on the 
downstream side of the bridge. The slope should be entered as the horizontal to vertical distance 
ratio of the embankment. This variable is generally not used in the computations, but is used for 
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display purposes in the profile plot. However, if the user has selected the FHWA WSPRO Bridge 
method for low flow, this field will be used in the computation of the bridge discharge coefficient.

Max Submergence - The maximum allowable submergence ratio that can occur during weir flow 
calculations over the bridge deck. If this ratio is exceeded, the program automatically switches to 
energy based calculations rather than pressure and weir flow. The default value is 0.95 (95 percent 
submerged).

Submergence Criteria - When submergence occurs there are two choices available to figure out how 
much the weir coefficient should be reduced due to the submergence. The first method is based on 
work that was done on a trapezoidal shaped broad crested weir (FHWA, 1978). The second criterion 
was developed for an Ogee spillway shape (COE,1965). The user should pick the criterion that best 
matches their problem.

Min Weir Flow El - This field is used to set the minimum elevation for which weir flow will begin to be 
evaluated. Once the computed upstream energy becomes higher than this elevation, the program 
begins to calculate weir flow. However, the weir flow calculations are still based on the actual 
geometry of the deck/roadway, and are not affected by this elevation. If this field is left blank, the 
elevation that triggers weir flow is based on the lowest high chord elevation on the upstream side of 
the bridge deck. Also, weir flow is based on the elevation of the energy grade line and not the water 
surface.

Once all of the bridge deck information is entered, the user should press the OK button at the 
bottom of the window. Pressing the OK button tells the interface to accept the data and close the 
window. Once the deck editor closes, the graphic of the bridge deck will appear on the Bridge/
Culvert Data window. An example of this is shown in Figure 5-15. Note! The data are not saved to 
the hard disk at this point. Geometric data can only be saved to the hard disk from the File menu of 
the Geometric Data window. 
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Figure 5 15 Example Bridge Deck Plotted on Bounding Cross Sections

Sloping Bridge Abutments. The sloping bridge abutments editor is used to supplement the bridge 
deck information. Whenever bridge abutments are protruding towards the main channel (sloping 
inward abutments), it will be necessary to block out additional area that cannot be accounted for in 
the bridge deck/roadway editor. If the bridge has vertical wall abutments, then it is not necessary to 
use this editor. Vertical wall abutments can be included as part of the bridge deck/roadway data. To 
add sloping abutments, the user presses the

Sloping Abutment button on the Bridge/Culvert Data editor. Once this button is pressed the 
Abutment data editor will appear as in Figure 5-16. 
Sloping abutments are entered in a similar manner to the bridge deck/roadway. When the editor is 
open, it has already established an abutment # of 1. Generally a left and right abutment is entered 
for each bridge opening. Sloping abutment data are entered from left to right, looking in the 
downstream direction. In general it is usually only necessary to enter two points to describe each 
abutment.
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Figure 5 16 Abutment Data Editor

The data for each abutment consist of a skew angle (this is optional) and the station and elevation 
information. The station and elevation information represents the high chord information of the 
abutment. The low chord information of the abutment is assumed to be below the ground, and it is 
therefore not necessary to enter it. The geometric information for each abutment can vary from 
upstream to downstream. If this information is the same, then the user only needs to enter the 
upstream geometry and then press the Copy Up to Down button.

To add additional sloping abutments, the user can either press the ADD or the Copy button. To 
delete an abutment, press the Delete button. Once all of the abutment data are entered, the user 
should press the OK button. When the OK button is pressed, the abutment information is accepted 
and the editor is closed. The abutments are then added to the bridge graphic on the Bridge/Culvert 
Data editor. An example of a sloping bridge abutment is shown in Figure 5-17. This graphic is zoomed 
in on the left abutment of the bridge.
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Figure 5 17 Example of a Sloping Abutment

Bridge Piers. The bridge pier editor is used to describe any piers that exist in the bridge opening. 
Note! All piers must be entered through the Pier Editor, they should not be included as part of 
the ground or bridge deck. Several of the low flow bridge computations require that the piers be 
defined separately in order to determine that amount of area under the water surface that is blocked 
by the piers. If the piers are included with the ground or the bridge deck, several of the methods will 
not compute the correct amount of energy loss for the piers.

To enter pier information, the user presses the Pier button on the Bridge/Culvert Data editor. Once 
the pier button is pressed, the pier data editor will appear as in Figure 5-18 (Except yours will not 
have any data in it yet).
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Figure 5 18 Pier Data Editor

When the pier data editor appears it will have already defined the first pier as pier # 1. The user is 
required to enter a centerline station for both the upstream and downstream side of the pier. The 
pier geometry is entered as pier widths and elevations. The elevations must start at the lowest value 
and go to the highest value. Generally the elevations should start below the ground level. Any pier 
area below the ground will be clipped off automatically. Pier widths that change at a single elevation 
are handled by entering two different widths at the same elevation. The order of the widths in the 
table is very important. Keep in mind that the pier is defined from the ground up to the deck. If the 
pier geometry on the downstream side is the same as the upstream side, simply press the Copy Up 
to Down button after the upstream side data are entered.

The user also has the option of defining floating pier debris. If the Floating Debris option is selected, 
the user will need to enter a width and a height for the debris. The user can set a different height and 
width of debris for each pier, or there is a button that will allow the user to enter a single height and 
width that will be used for all of the piers (Set Wd/Ht for all…). Additionally there are buttons to 
turn pier debris on or off for all of the piers of the bridge (All On… and All Off...).
Additional piers can be added by pressing either the Add or the Copy button. If the piers are the 
same shape, it is easier to use the copy button and simply change the centerline stations of the new 
pier. To delete a pier, simply press the Delete button and the currently displayed pier will be deleted. 
Once all of the pier data are entered, press the OK button. When the OK button is pressed, the data 
will be accepted and the pier editor will be closed. The graphic of the bridge will then be updated to 
include the piers. An example bridge with piers is shown in Figure 5-19. This graphic is only the 
upstream side of the bridge with a zoomed in view.
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Figure 5 19 Bridge with Piers, zoomed in view

Bridge Modeling Approach. The Bridge Modeling Approach editor is used to define how the bridge 
will be modeled and to enter any coefficients that are necessary. To bring up the Bridge Modeling 
Approach editor press the Bridge Modeling Approach button on the Bridge/Culvert Data editor. 
Once this button is pressed, the editor will appear as shown in Figure 5-20 (Except yours will only 
have the default methods selected).
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Figure 5 20 Bridge Modeling Approach Editor

When the Bridge Modeling Approach editor comes up it will be ready to enter data for the first bridge 
opening (coefficient set # 1). If there is more than one bridge opening at the current location, the 
user can either use a single set of modeling approaches and coefficients, or establish a different set 
for each bridge opening.

Establishing a bridge modeling approach consists of defining which methods the program will use 
for low flow computations and high flow (flow at or above the maximum low chord) computations. 
The user can instruct the program to use any or all of the low flow methods during the computations 
by clicking the buttons under the Compute column. If either the Momentum or Yarnell method are 
selected, the user must enter a value for the pier loss coefficient that corresponds to that method. If 
the WSPRO method is selected, the user must press the "WSPRO Variables" button and enter 
additional information that is required for the method. Once the WSPRO Variables button is 
pressed, a data editor as shown in Figure 5-21 will appear.



Entering and Editing Geometric Data

HEC-RAS User's Manual– 85

Figure 5 21 WSPRO Data Editor

As shown in Figure 5-21, there are several variables that must be entered as well as some options 
that are available to the user. All of the required variables shown on the WSPRO data editor are used 
in the computation of the discharge coefficient, C, which is used in the WSPRO expansion loss 
equation. A detailed discussion of how the discharge coefficient is computed can be found in 
appendix D of the HEC-RAS Hydraulic Reference manual. The following is a description of each of the 
variables on the WSPRO Data Editor:

El of the top of the Embankment - These fields are used for entering the elevation of the top of the 
embankment (top of road) at the edges of the bridge opening. An elevation must be entered for both 
the left and right side of the bridge opening.

El of the toe of the Abutment - These fields are used for entering the elevation of the abutment toe 
(elevation at the station in which the abutment toe intersects with the natural ground inside the 
bridge opening) on both the left and right side of the bridge opening.

Abutment Type - This field is used for selecting the type of abutments. There are four abutment types 
available from this selection box.

Slope of the Abutments - This field is used for entering the slope of the abutments. This slope is taken 
as the horizontal distance divided by the vertical distance. If the abutments are vertical walls, then 
this field should be left blank or set to zero. If the left and right abutments do not have the same 
slope, take an average of the two and enter that into this field.

Top Width of Embankment - This field is used for entering the width of the top of the road 
embankment, in the area of the bridge opening. If the topwidth of the embankment varies from one 
end of the bridge opening to the other, use an average of the two widths.
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Centroid stationing of the projected bridge opening at the approach cross section - For the WSPRO 
bridge method, it is necessary to calculate the water surface topwidth inside of the bridge opening, 
and then project that width onto the approach cross section. The program calculates the 
conveyance within this projected width at the approach cross section. This conveyance is used in 
calculating a channel contraction ratio, which is an integral part in the calculation of the discharge 
coefficient. If this field is left blank, the program will automatically center the computed topwidth, 
such that the center of the topwidth will be at the center of conveyance at the approach cross-
section. The user can override this by entering their own centroid stationing value for the approach 
cross section.

Wing Walls - This field is used for selecting the type of wing walls. There are three choices available in 
the selection box: No wing walls present; Angular wing walls; and Rounded wing walls. If the user 
selects "Angular wing walls", then the fields labeled "Angle of Wing Wall" and "Length of Wing Wall" 
become active and must be filled out. If the user selects "Rounded wing walls", then the fields 
"Length of wing walls" and "Radius of entrance rounding" become active and must be filled out. If 
the user selects "No wing walls present" then no other information on wing walls is necessary. For 
more information on wing walls see appendix D of the HEC-RAS Hydraulic Reference manual.

Guide Banks Type - This field is used for selecting the type of guide banks if any exist. There are three 
choices available from the selection box: No guide bank present; Straight; and Elliptical. If the user 
selects "Straight" then the fields labeled "Length of guide banks", "Offset of Guide Banks", and 
"Skew of Guide Banks" become active and must be filled out. If the use selects "Elliptical" then only 
the fields "Length of Guide Banks" and "Offset of Guide Banks" become active. If the user selects "No 
Guide Bank present" then no other information about guide banks is necessary. For more 
information on Guide Banks see appendix D of the HEC-RAS Hydraulic Reference manual.

Optional Contraction and Expansion Losses - This box allows the user to turn on contraction and 
expansion losses at locations that are traditionally not in the WSPRO methodology. The basic 
WSPRO bridge method only computes expansion losses in the expansion reach (between the exit 
cross section and the section just downstream of the bridge). This option allows the user to turn on 
contraction and expansion losses individually at the following locations: downstream inside of the 
bridge; upstream inside of the bridge; upstream outside of the bridge; at the end of a guide bank (if 
guide banks exist); and at the approach cross section. The default for the WSPRO method is that 
contraction and expansion losses will not be calculated at these locations. Users should not turn 
these options on unless they feel that the standard WSPRO bridge approach is not producing enough 
energy loss through the bridge.

Three other options that the user has control over are: specifying that the piers are continuous the 
whole way through the bridge or not; using the Geometric Mean friction slope averaging technique 
through the bridge computations (from exit to approach section); and using the WSPRO tables to 
compute the Cd coefficient, rather than the theoretical equation. The default for the WSPRO 
methodology is to assume that the piers are continuous through the bridge, to use the Geometric 
Mean friction slope method, and compute Cd with the theoretical equation.

After all of the variables have been entered, the user must press the OK button for the WSPRO 
variables to be accepted. For more information about the computation of the discharge coefficient, 
and these data variable, see appendix D of the HEC-RAS Hydraulic Reference manual.

Once the user has selected which low flow bridge methods will be computed, they must also specify 
which of those methods will be used as the final answer to continue the computations on upstream 



Entering and Editing Geometric Data

HEC-RAS User's Manual– 87

1.

2.

3.

4.

with. Only one of the methods can be selected as the answer to "Use" in order to continue the 
computations upstream. An alternative to selecting a single method to use is to instruct the program 
to use the answer with the highest computed upstream energy elevation. This is accomplished by 
pressing the button under the "Use" column that corresponds to the Highest Energy Answer text 
field.

For a High Flow Method, the modeler can choose between Energy based calculations or pressure 
and weir flow calculations. If pressure and weir flow is the selected high flow method, the user must 
enter coefficients for the pressure flow equations. The first coefficient applies to the equation that is 
used when only the upstream side (inlet) of the bridge is submerged. If this coefficient is left blank, 
the program selects a coefficient based on the amount of submergence. If the user enters a 
coefficient, then that value is used for all degrees of submergence. The second coefficient applies to 
the equation that is used when both the upstream and downstream end of the bridge is sub-merged. 
Generally this coefficient is around 0.8. For more information on pressure flow coefficients see 
Hydraulics of Bridge Waterways (FHWA, 1978).

Max Low Chord - This field is used to set the maximum elevation of the deck low chord, and therefore 
the elevation at which pressure flow begins to be calculated. If this field is left blank, then the 
elevation that triggers pressure flow calculations is based on the highest low chord elevation on the 
upstream side of the bridge deck. If the user enters a value in this field, then the value set will be 
used to trigger when pressure flow calculations begin. Pressure flow is triggered when the energy 
elevation exceeds the maximum low chord. When pressure flow is calculated, the answer is 
compared to the low flow answer and the higher of the two is selected. Alternatively, the user can tell 
the program to use the water surface instead of the energy elevation to trigger pressure flow 
calculations. This option can be found under the Bridge and Culvert Options section of this manual.

Once all of the bridge modeling approach information is entered, the user should press the OK
button. When the OK button is pressed the information will be accepted and the editor will close. 
Remember! The data are not saved to disk at this point, it is only accepted as being valid. To 
save the geometric data, use the File menu from the Geometric Data Editor window.

Bridge Design Editor
The bridge design editor allows the user to enter or modify bridge data quickly and conveniently. 
With this editor the user can enter the deck/roadway data, sloping abutments, and pier information. 
To put together a bridge with this editor, the user would do the following:

From the Geometric Data window, open the Bridge/Culvert data editor. Select the River and Reach in which 
you would like to place the bridge.
Go to the Options menu and select Add a Bridge and/or Culvert from the list. An input box will appear 
prompting you to enter a river station identifier for the new bridge.
Open the Bridge Design editor by pressing the Bridge Design button on the lower left side of the Bridge/
Culvert Data editor.
Enter the required data for the bridge deck/roadway, sloping abutments (optional), and piers (optional).

When the Bridge Design button is pressed, a window will appear as shown in Figure 5-22. The user 
only has to enter a minimal amount of information to build or edit the bridge. To create the bridge 
deck/roadway, the user must enter a high cord elevation (top of road) and a low cord elevation 
(maximum elevation inside of the bridge opening). 
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Figure 5 22 Bridge Design Editor

The user has the option to limit the width of the bridge opening by selecting the Add Vertical Walls 
in Deck option. When this option is selected, the bridge opening will be limited to either the main 
channel bank stations (this is the default) or a user specified width (this is optional). Everything left 
and right of the bridge opening will be completely filled in all the way to the ground elevations. If the 
user enters a bridge opening width, the opening will be centered between the main channel bank 
stations.
The user also has the option to enter sloping abutments. Sloping abutments should only be entered 
after selecting to limit the width of the bridge opening with the vertical walls option. To enter sloping 
abutments, the user only has to enter a slope in units of horizontal to vertical. The program will 
automatically build a left and right sloping abutment that starts in the upper left and right corners of 
the bridge opening.

Once all of the bridge deck/roadway information is entered, the user can have the program build the 
deck/roadway by pressing the Make Deck/Roadway button.
The last option available in the Bridge Design editor is to enter pier information. The user enters the 
number of piers, the upstream and downstream stationing of the left most pier, the spacing between 
the centerline of the piers, and the width of the piers. The user then presses the Make Piers button 
to have the interface build the piers.

After all of the bridge data are entered, the user presses the Close button to get out of the editor. The 
bridge data can be changed at any time by either going back into the Bridge Design editor and 
entering new values, or by going to the more detailed editors for the bridge deck/roadway, sloping 
abutments, and piers.
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Culvert Hydraulic Computations
The culvert hydraulic computations in HEC-RAS are similar to the bridge hydraulic computations, 
except the Federal Highway Administration's (FHWA) standard equations for culvert hydraulics 
under inlet control are used to compute the losses through the structure (when a culvert is under 
inlet control conditions). Outlet control hydraulics are handled by balancing the energy equation 
from downstream to upstream. The HEC-RAS culvert routines are also capable of handling all 6 of the 
flow classifications outlined in the USGS publication "Measurement of Peak Discharge at Culverts by 
Indirect Methods" (USGS, 1976).

Because of the similarities between culverts and other types of bridges, the cross section layout, the 
use of ineffective areas, the selection of contraction and expansion coefficients, and many other 
aspects of bridge analysis apply to culverts as well.
The culvert routines in HEC-RAS have the ability to model nine different types of culvert shapes. 
These shapes include box (rectangular), circular, elliptical, arch, pipe arch, semi circular, low profile 
arch, high profile arch, and Con Span culverts. 
The analysis of flow in culverts is complicated. It is common to use the concepts of "Inlet" control 
and "Outlet" control to simplify the analysis. Inlet control flow occurs when the flow carrying 
capacity of the culvert entrance is less than the flow capacity of the culvert barrel. Which means the 
culvert entrance is controlling the resulting headwater elevation for a given flow passing through the 
culvert. Outlet control flow occurs when the culvert carrying capacity is limited by downstream 
conditions or by the flow capacity of the culvert barrel. The HEC-RAS culvert routines compute the 
headwater required to produce a given flow rate through the culvert for inlet control conditions and 
for outlet control conditions. In general, the higher headwater "controls," and an upstream water 
surface is computed to correspond to that energy elevation.

Inlet Control Computations. For inlet control, the required headwater is computed by assuming 
that the culvert inlet acts as an orifice or a weir. Therefore, the inlet control capacity depends 
primarily on the geometry of the culvert entrance. Extensive laboratory tests by the National Bureau 
of Standards, and the Bureau of Public Roads (now, FHWA), and other entities resulted in a series of 
equations which describe the inlet control headwater under various conditions. These equations are 
used by HEC-RAS in computing the headwater associated with inlet control.

Outlet Control Computations. For outlet control flow, the required headwater must be computed 
considering several conditions within the culvert and the downstream tailwater. For culverts flowing 
full, the total energy loss through the culvert is computed as the sum of friction losses, entrance 
losses, and exit losses. Friction losses are based on Manning's equation. Entrance losses are 
computed as a coefficient times the velocity head in the culvert at the upstream end. Exit losses are 
computed as a coefficient times the change in velocity head from just inside the culvert (at the 
downstream end) to outside the culvert.

When the culvert is not flowing full, the direct step backwater procedure is used to calculate the 
profile through the culvert up to the culvert inlet. An entrance loss is then computed and added to 
the energy inside the culvert (at the upstream end) to obtain the upstream energy (headwater). For 
more information on the hydraulics of culverts, the reader is referred to Chapter 6 of the HEC-RAS 
Hydraulics Reference manual.
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Entering and Editing Culvert Data
Culvert data are entered in the same manner as bridge data. To enter culvert data the user presses 
the Bridge/Culvert button on the Geometric Data window (Figure 5-1). Once this button is pressed, 
the Bridge/Culvert Data Editor will appear (Figure 5-12). To add a culvert group to the model the user 
must then do the following:

Select the river and reach that you would like to place the culvert in. This selection is accomplished by 
pressing the down arrow on the river and reach boxes and then selecting the river and reach of choice.
Go to the Options menu of the Bridge/Culvert editor and select Add a Bridge and/or Culvert from the list. 
An input box will appear prompting you to enter a river station identifier for the new culvert group. After 
entering the river station, press the OK button and the cross sections that bound the new culvert group will 
appear in the editor.
Enter all of the required data for the culvert group. This includes the road embankment information and the 
culvert specific data. The roadway information is entered in the same manner as a bridge (using the deck/
roadway editor). To enter culvert specific data, press the Culvert button on the Bridge/Culvert Data editor.
Once all of the culvert data are entered, press the OK button in order for the interface to accept the 
information.

River, Reach and River Station. The River and Reach boxes allow the user to select a river and reach 
from the available reaches that were put together in the schematic diagram. The reach label defines 
which reach the culvert will be located in. The River Station tag defines where the culvert will be 
located within the specified reach. The River Station tag does not have to be the actual river station 
of the culvert, but it must be a numeric value. The River Station tag for the culvert should be 
numerically between the two cross sections that bound the culvert. Once the user selects Add a 
Bridge and/or Culvert from the options menu, an input box will appear prompting you to enter a 
River Station tag for the new culvert. After the River Station tag is entered, the two cross sections 
that bound the culvert will be displayed on the editor.

Description. The description box is used to describe the culvert location in more detail than just the 
river, reach and river station. This box has a limit of 256 characters. Only the first line of information 
is displayed, unless the button to the right of the box is pressed. Also, the first 40 characters of the 
description are used as a label for culvert plots and tables.

Culvert Road Embankment. The culvert road embankment is virtually the same as the bridge deck/
roadway information. The road embankment is used to describe the area blocking the stream and 
the roadway profile. The only difference in the information for culverts is that the low chord 
elevations should be left blank or set to elevations below the ground data. This will cause the road 
embankment to completely fill the channel up to the roadway elevations (high chord data). 
Therefore, the only opening below the roadway will be whatever culvert openings are entered.

To enter the culvert roadway information, press the Deck/Roadway button on the Bridge/Culvert 
Data Editor window. For an explanation of the deck information, please review the section entitled 
Bridge Deck/Roadway found earlier in this chapter.
Culvert Data. To enter culvert specific information, press the Culvert button on the Bridge/Culvert 
Data Editor window. When this button is pressed, the Culvert Data Editor will appear as shown in 
Figure 5-23 (Except yours will be blank). The information entered in the Culvert Data Editor consists 
of the following:
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Figure 5 23 Culvert Data Editor

Culvert Group - The culvert group is automatically assigned to "Culvert #1" the first time you open the 
editor. The user can enter up to ten culvert types if they are working on a multiple culvert/opening 
problem. If all of the culvert barrels are exactly the same, then only one culvert group should be 
entered. The number of barrels is an input parameter in the culvert data. If the user has culverts that 
are different in shape, size, elevation, or loss coefficients, then additional culvert groups must be 
added for each culvert type. To add an additional culvert group you can either use the Add or Copy
buttons. The Add button increments the culvert group and clears the culvert editor. The Copy button 
increments the culvert group and makes a copy of the original culvert data. Once a copy is made of a 
culvert, the user can change any of the existing culvert information. Culverts can be deleted by 
pressing the Delete button.

Solution Criteria - This option allows the user to select between taking the higher of the inlet control 
and outlet control answers (Computed Flow Control), or specifically selecting the Inlet control or 
Outlet control answer. The default is to let the program compute both and take the higher of the 
two. In general this should be left this way. The only time a user should specifically select Inlet 
control or Outlet control, is when they feel the program is in error by selecting the higher of the two 
answers.
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Rename - This button allows the user to put in their own identifier for each of the culvert types. By 
default the culvert types will be labeled "Culvert #1," "Culvert #2," and so on. The user can enter up 
to twelve characters for each culvert type.

Shape - The shape selection box allows the user to select from one of the nine available shapes. This 
selection is accomplished by pressing the down arrow on the side of the box, then selecting one of 
the nine available shapes.

Span - The span field is used to define the maximum width inside of the culvert. The span is left blank 
for circular culverts.

Rise - The rise field describes the maximum height inside of the culvert.

Chart # - This field is used to select the Federal Highway Administration Chart number that 
corresponds to the type and shape of culvert being modeled. Once the user has selected a culvert 
shape, the corresponding FHWA chart numbers will show up in the chart # selection box. More 
information on FHWA chart numbers can be found in the Hydraulics Reference manual.

Scale# - This field is used to select the Federal Highway Administration Scale number that 
corresponds to the type of culvert entrance. Once the user has selected a culvert shape and chart #, 
the corresponding FHWA scale numbers will show up in the scale selection box. More information on 
FHWA scale numbers can be found in the Hydraulics Reference manual.

Distance to Upstream XS - This field is used to locate the culvert in space, relative to the two cross 
sections that bound the culvert crossing. The user should enter the distance between the upstream 
cross section and the upstream end of the culvert barrel.

Culvert Length - The culvert length field describes the length of the culvert along the centerline of the 
barrel.

Entrance Loss Coefficient - The coefficient entered in this field will be multiplied by the velocity head 
inside of the culvert at the upstream end. This value represents the amount of energy loss that 
occurs as flow transitions from the upstream cross section to inside the culvert barrel. This 
coefficient is used in the outlet control computations, and will not affect inlet control computations, 
as they are performed with the Federal Highway Inlet Control equations directly.

Exit Loss Coefficient - The coefficient entered in this field will be multiplied by the change in velocity 
head from inside the culvert to outside the culvert at the downstream end. This value represents the 
energy loss that occurs as water exits the culvert. This coefficient is used in the outlet control 
computations.

Manning's n for Top - The n-value fields are used for entering the Manning's n values of the culvert 
barrel. This version of HEC-RAS allows the user to enter a separate n value for the top (which includes 
top and sides) of the culvert, as well as for the bottom. If the culvert has the same roughness for the 
top and bottom, the user can enter the value for the top. The Manning's n value for the bottom will 
automatically be copied from the top field.

Manning's n for Bottom – This field is used to enter a Manning's n value for the bottom of the culvert. 
This n value will be used up to a user specified depth inside of the culvert. When the water surface 
gets higher than that depth, a composite Manning's n value is computed based on the bottom and 
top n values and their corresponding wetted perimeters.
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Depth to use Bottom n – This field is used to specify the depth that the "Bottom n value" is applied 
inside of the culvert. The surface of the culvert below this depth is given the n value for the bottom of 
the culvert, while the surface of the culvert above this depth is given the n value for the top of the 
culvert.

Depth Blocked – This field is used to block off a portion of the bottom of the culvert. When a value is 
entered into this field, the culvert is completely blocked up to the depth specified. This blocked out 
area persists the whole way through the culvert.

Upstream Invert Elevation - This field is used to describe the elevation of the culvert invert at the 
upstream end.

Downstream Invert Elevation - This field is used to describe the elevation of the culvert invert at the 
downstream end.

# Barrels - This field is used to display the number of identical barrels. The number of identical 
barrels is limited to 25. To enter more than one identical barrel, the user must provide different 
centerline stationing information for each barrel. As the centerline stationing information is added, 
the number of identical barrels will automatically change to reflect the number of centerline 
stations. The user does not enter anything into this field, it is just used to display the number of 
identical barrels.

Barrel Centerline Stations - This table is used to enter the stationing of each culvert barrel. Centerline 
stations must be provided for both the upstream and downstream side of each culvert barrel.

Barrel GIS Data – This table is used to enter X, Y coordinates for a line representing each barrel. X, Y 
coordinates are only used when culverts are connected to 2D Flow Areas. When a Culvert is put into a 
Bridge/Culvert crossing of a 1D River Reach, then the X, Y coordinates are not needed or used. This 
table is only relevant to Lateral Structures and SA/2D Area Connections in which culverts will be 
connected to 2D Flow Area cells. It is not needed for pure 1D bridge/Culvert crossings.
Once all of the culvert information is entered, the user should press the OK button at the bottom of 
the window. Pressing the OK button tells the interface to accept the data and close the window. 
Once the culvert editor is closed, the graphic of the culvert will appear on the Bridge/Culvert Data 
editor window. An example culvert with two culvert types and two identical barrels for each culvert 
type is shown in Figure 5-24. Note! The data are not saved to the hard disk at this point. 
Geometric data can only be saved from the File menu on the Geometric Data window.
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Figure 5 24 Bridge/Culvert Data Editor with example culvert

Bridge and Culvert Options
Some additional options that are available, but not required, are found under the Options menu 
from the Bridge/Culvert Data Editor. These include the following:

Add a Bridge and/or Culvert. This option initiates the process of adding a bridge or culvert to the 
data set. The user is prompted to enter a river station tag for the new bridge or culvert. The river 
station tag locates the bridge or culvert within the selected reach. Once the river station is entered, 
the Bridge/Culvert Data editor is cleared and the user can begin entering the data for that new bridge 
or culvert.

Copy Bridge and/or Culvert. This option allows the user to make a copy of the bridge and/or culvert 
crossing and place it in another reach and/or river station within the current project.

Rename River Station. This option allows the user to change the river station of the currently 
opened Bridge and/or Culvert crossing.
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Delete Bridge and/or Culvert. This option will delete the currently displayed bridge or culvert. The 
user is prompted with a message stating specifically which bridge or culvert is going to be deleted, 
and requesting them to press the OK button or the Cancel button.

Internal Bridge Cross-Sections. This option allows the user to edit the two cross sections inside of a 
bridge. These two cross sections are a copy of the cross sections just upstream and downstream of 
the bridge. If the ground elevations inside of the bridge are different than just outside of the bridge, 
then the internal bridge cross sections should be modified to reflect the changing elevations. This 
option allows the user to change the station and elevation data, roughness coefficients, and main 
channel bank stations for each of the two internal bridge cross sections.

Momentum Equation. This option allows the user to change the components of the momentum 
equation. The momentum equation is one of the optional low flow methods in the bridge routines. 
The user has the option of turning the friction and weight force components on or off. The default is 
to include the friction force but not the weight component. The computation of the weight force is 
dependent upon computing a mean bed slope through the bridge. Estimating a mean bed slope can 
be very difficult with irregular cross section data. A bad estimate of the bed slope can lead to large 
errors in the momentum solution. The user can turn this force on if they feel that the bed slope 
through the bridge is well behaved for their application (smooth, with no deep scour hole).

Momentum Class B Defaults. If the program computes that the flow must pass through critical 
depth inside the bridge (Class B flow), critical depth will automatically be located inside the bridge at 
the most constricted cross section. If both cross sections are identical, the program will locate 
critical depth at the upstream inside cross section. This option allows the user to control where the 
program sets critical depth for class B flow. If the user feels that it would be better to set critical 
depth inside the bridge at the downstream end, then this can be selected.

Pressure Flow Criteria. This option allows the user to select either the energy grade line or the 
water surface, to be used as the criterion for when the program begins checking for the possibility of 
pressure flow. By default the program uses the energy grade line. This does not change how pressure 
flow is calculated, only when the program will begin checking for pressure flow.

Ice Option. This option allows the user to select how ice will be handled inside of the bridge during 
ice computations. This option is only pertinent if the user is performing a profile computation with 
the effects of ice included. When this option is selected, a window will appear asking the user to 
select one of three available options. These options include: no ice inside of the bridge; a constant 
amount of ice through the bridge; dynamic ice effects are to be computed through the bridge.

Skew Bridge/Culvert. This option allows the user to make adjustments to bridge/culvert data that is 
skewed (i.e. not perpendicular to the flow lines going through the bridge/culvert. When this option is 
selected, a window will appear allowing the user to enter a skew angle for the deck/roadway, as well 
as the piers. The stationing of the deck/roadway is reduced, by multiplying it by the cosine of the 
user entered skew angle. Additionally, the user has the option to adjust the upstream and 
downstream cross sections bounding the bridge by the same skew angle. A separate skew angle is 
entered for bridge piers. The piers are assumed to go the whole way through the bridge as a single 
continuous pier. For more details on modeling bridges that are skewed to the flow, see the section 
called "Bridges on a Skew" in chapter 5 of the Hydraulic Reference Manual.
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Bridge and Culvert View Features
Several options are available for viewing the bridge/culvert geometric data. These options include: 
Zoom In; Zoom Out; Display Upstream XS; Display Downstream XS; Display Both; Highlight Weir, 
Opening Lid and Ground; Highlight Piers; and Grid. These options are available from the View menu 
on the bridge/culvert data editor.

Zoom In. This option allows the user to zoom in on a piece of the bridge or culvert. This is 
accomplished by selecting Zoom In from the View menu, then specifying the area to zoom in on with 
the mouse. Defining the zoom area is accomplished by placing the mouse pointer in the upper left 
corner of the desired area. Then press down on the left mouse button and drag the mouse to define a 
box containing the desired zoom area. Finally, release the left mouse button and the viewing area 
will display the zoomed in area of the bridge or culvert.

Zoom Out. This option displays the bridge or culvert back into its original size before you zoomed in. 
Zooming out is accomplished by selecting Zoom Out from the View menu bar on the bridge/culvert 
data editor.

Full Plot. When this option is selected, the graphic is automatically redrawn back to its full extent, 
showing the entire bridge/culvert.

Pan. When this option is selected, the user can move the zoomed in portion of the graphic. This is 
accomplished by first selecting the Pan option, then pressing and holding down the left mouse 
button while over the graphic. Next, move the graphic in the desired direction, and then release the 
left mouse button. The graphic will be redrawn with a new portion of the graphic shown in the 
zoomed in area.

Display Upstream XS. When this option is selected, only the upstream side of the bridge or culvert 
will be displayed.

Display Downstream XS. When this option is selected, only the downstream side of the bridge or 
culvert will be displayed.

Display Both. When this option is selected, both the downstream and upstream sides of the bridge 
will be displayed in the viewing area.

Highlight Weir, Opening Lid and Ground. When this option is selected, various portions of the 
bridge/culvert graphic will be highlighted. The program will highlight in red the combination of the 
deck/roadway high cord and any ground to the left and right of this data. The red color shows what 
the program will use for weir flow if the Pressure and Weir option is selected for high flows.
The program will also highlight any bridge openings. Within the bridge opening, the ground 
information will be highlighted in blue and the lid of the opening (deck/roadway low cord data) will 
be highlighted in green. If the any of these three colors show up in an area where they should not be, 
then there must be a geometric mistake in the data. This option is very useful for detecting any data 
entry errors that may otherwise go unnoticed.

Highlight Piers. When this option is turned on the interface will highlight what it thinks is the extent 
of the pier information. This option allows the user to see exactly what the program thinks piers are, 
and to see how the pier information has been clipped. Piers are clipped below the ground and above 
the low chord of the bridge.

Grid. This option allows the user to have a grid overlaid on top of the bridge or culvert graphic.
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Bridges in 2D Flow Areas

Overview

Bridges can be modeled in 2D Flow Areas using two approaches: (1) Simplified 1D/2D Bridge 
Modeling, and (2) Detailed Bridge Modeling. The simplified bridge modeling approach is applicable 
for all types of flows through bridges but is not intended to capture the details of the bridge 
hydraulics through the bridge. It's purpose is to capture the overall head losses from the bridge. It 
can also be applied with any of the 2D flow solvers including the Diffusion Wave Equation solver. In 
the detailed bridge modeling approach, the bridge piers are specified in the terrain since it cannot 
yet utilize the bridge deck and pier geometry specified in the SA/2D Connection. It also cannot 
simulate pressured flow with or without overtopping. Future versions of HEC-RAS will be able to 
simulate pressured flow and overtopping.  

Simplified 1D/2D Bridge Modeling

In the first approach, the bridge is setup using an internal SA/2D Connection, and the bridge 
geometry and parameters are specified similar to how bridges are entered for 1D bridge modeling. 
The figure below shows an example layout of an internal SA/2D connection with a bridge.

Figure 1. Example 2D bridge layout in the Geometric Data editor.

The SA/2D connection is enforced as a breakline and has faces running along the bridge centerline. 
The connection also shows 1D bridge cross-sections upstream and downstream of the bridge as 
dotted, red lines. The bridge curves are computed using the water surfaces defined on 1D bridge 
cross-sections. For this reason, it is important to utilize a grid resolution which is consistent with the 
cross-section spacing. The mesh resolution should be such that the cell computation points are at or 
close to the cross-sections. 

In the example shown in the figure below there is a 40-ft bridge deck, with 5-ft upstream and 
downstream distances from the bridge centerline to the upstream and downstream cross-sections 
are 25 ft. Therefore, an appropriate mesh resolution should be 50 ft. 
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The steps for adding a 2D bridge are:

Draw a centerline for the bridge opening/embankment using the SA/2D Area Connection tool
Bridge centerline is drawn left to right looking downstream.

Develop an appropriate mesh (cell size and orientation) for the bridge.
Use the structure mesh controls (cell size and enforcement). Some hand editing may be required 
depending on the bridge and what else is near the bridge (i.e. levee, another bridge, railroad tracks, 
road, etc…).

Enter the bridge data.
Deck/roadway; distance from upstream bridge deck to outside cross section piers; abutments; bridge 
modeling approach; Manning’s n values for the 1D bridge cross sections; and hydraulic tables 
controls (HTAB) into the SA/2D Area Connection editor.

Pre-process the geometry in order to create the bridge curves.
Review the bridge family of rating curves for hydraulic accuracy.

Run the model and review the results.
Make any necessary changes to the data in order to improve the results.

Multiple Bridge/Culvert Openings
HEC-RAS has the ability to model multiple bridge and/or culvert openings at any individual river 
crossing. Types of openings can consist of bridges, culvert groups (a group of culverts is considered 
to be a single opening), and conveyance areas (an area where water will flow as open channel flow, 
other than a bridge or culvert opening). Up to seven openings can be modeled at a given location, 
and any combination of bridges and culvert groups can be used. Conveyance type openings can 
range from zero to a maximum of two, and the conveyance areas must be located on the far left and 
far right of the river crossing.

Note

The detailed bridge modeling approach does NOT automatically modify the terrain to account 
for the bridge geometry. Therefore, the user must make sure the bridge geometry with the 
exception of the bridge deck is included in the terrain. 
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An example multiple opening is shown in Figure 5-25. As shown in this example, there are three types 
of openings: a conveyance area (left side, labeled as opening #1), a bridge (labeled as opening #2), 
and a culvert group (labeled as opening #3). During low flow conditions, flow will be limited to the 
bridge opening. As flow increases, the culverts will begin to take some of the flow away from the 
bridge opening. The conveyance area was defined as ineffective flow (no conveyance) until the water 
surface goes above the top of the bridge. This was accomplished by setting blocked ineffective flow 
areas. In this example, three blocked ineffective flow areas were established: one to the left of the 
bridge (which encompasses the whole conveyance area), one between the bridge and the culvert 
group, and one to the right of the culvert group.

Figure 5 25 Example Multiple Opening River Crossing

Entering Multiple Opening Data
Multiple opening data are entered in the same manner as any other bridge or culvert crossing. In 
general, the user should perform the following steps to enter multiple opening data:

Press the Bridge/Culvert button on the Geometric Data window.
Select the river and reach in which you would like to place the multiple opening river crossing. This is 
accomplished from the River and Reach boxes near the top of the window.
Select Add a Bridge and/or Culvert from the Options menu of the bridge and culvert editor. Enter the river 
station at which you want to place the multiple opening crossing. Once you have done this, the two cross 
sections that bound this river station will appear in the window. These two cross sections, along with the 
bridge and culvert information, will be used to formulate the two cross sections inside the multiple opening 
river crossing.
Enter the deck and road embankment data by using the Deck/Roadway editor.
Enter any piers or sloping abutments that are required.
Select the Bridge Modeling Approach button and enter a set of coefficients and modeling approaches for 
each bridge opening.
Enter Culvert data for any culvert openings.
Select the Multiple Opening Analysis button on the bridge and culvert editor. Enter the types of openings 
and their station limits. Start at the left most station of the crossing and work your way to the right end. This 
is explained in greater detail under the section entitled "Defining the Openings".
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Deck/Road Embankment Data. There can only be one deck and road embankment entered for any 
bridge and/or culvert crossing. The deck editor is used to describe the area that will be blocked out 
due to the bridge deck and road embankment. As shown by the gray shaded area in Figure 5-25, the 
deck and roadway data are used to block out area around the bridge as well as around the culverts. 
In the area of the bridge, high and low chord information is entered in order to define the top of road 
as well as the bridge opening. In the area of the culverts, the high chord information is entered to 
define the rest of the top of the road embankment. However, the low chord information can be left 
blank, or set to elevations below the ground, because the culvert data define the culvert openings.

Piers and abutments. All piers are entered from the pier editor, which was described previously 
under bridge data. The number of bridge openings has no impact on how pier data are entered. Piers 
are treated as separate information. Once the user establishes that there is more than one bridge 
opening, the program is smart enough to figure out which piers go with which opening. If any sloping 
abutment data are required for a bridge opening, it can be entered as described previously under the 
bridge data section.

Bridge Modeling Approach. A bridge modeling approach and coefficient set must be established for 
at least one bridge opening. If there is more than one bridge opening, and the user has only 
established a single coefficient set and bridge modeling approach, those data will be used for all of 
the bridge openings. The user can establish a different set of coefficients and modeling approaches 
for each bridge opening. 

Figure 5 26 Bridge Modeling Approach Editor

As shown in Figure 5-26, the user must enter information under the Bridge Modeling Approach editor 
for at least one bridge Opening. Bridge openings are referred to as Bridge # 1, Bridge # 2, etc., up to 
the number of bridge openings. Bridge # 1 represents the left most bridge opening while looking in 
the downstream direction. Bridge # 2 represents the next bridge opening to the right of Bridge # 1, 
and so on. The user can enter additional coefficient sets and modeling approaches by selecting 
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either the Add or Copy button. If either of these buttons is selected, the Bridge # will automatically 
be incremented by one. The user can then enter or change any of the information on the editor for 
the second bridge opening. Any bridge opening that does not have a corresponding coefficient set 
and modeling approach, will automatically default to what is set for Bridge # 1.

Culvert Data. Culvert information is added in the same manner as described in the previous section 
called "Entering and Editing Culvert Data." Culverts will automatically be grouped based on their 
stationing.

Defining the Openings
Once all of the bridge and/or culvert data are entered for a multiple opening river crossing, the last 
step is to define the number and type of openings that are being modeled. This is accomplished by 
pressing the Multiple Opening Analysis button on the Bridge/Culvert Data editor. Once this button is 
pressed, an editor will appear as shown in Figure 5-27 (except yours will be blank the first time you 
bring it up).

Figure 5 27 Multiple Opening Analysis window

The user selects from the three available opening types: Conveyance; Culvert Group; and Bridge. 
Openings must be established in order from left to right, while looking in the downstream direction. 
In addition to establishing the number and types of openings, the user must also enter a Station Left 
and a Station Right for each opening. These stations are used to establish limits for each opening as 
well as stagnation points. Stagnation points are the locations at which flow separates (on the 
upstream side) from one opening to the next adjacent opening. Stagnation points can either be set 
to fixed locations or they can be allowed to migrate within limits.

As shown in Figure 5-27 (numerical representation) and Figure 5-25 (graphical representation), there 
are three openings established in this example. The first opening is defined as a conveyance area, 
and it ranges from station 98 (the left most station of the section) to station 260. That means that any 
water in this area will be treated as normal open channel flow, and the water surface will be 
calculated by performing standard step calculations with the energy equation. The second opening 
is the bridge opening. This opening has a left station of 260 and a right station of 740. This bridge will 
be modeled by using the cross section data, bridge deck, and pier information that lie within these 
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two stations (260 and 740). The bridge coefficients and modeling approach for this opening will be 
based on the data entered for bridge opening #1, since it is the first bridge opening. The third 
opening is a culvert group. This opening has a left station of 650 and a right station of 940. Any 
culverts that lie within these stations will be considered as being in the same culvert group.

Notice that the right station of the bridge opening overlaps with the left station of the culvert group. 
This is done on purpose. By overlapping these stations, the user is allowing the program to calculate 
the location of the stagnation point between these two openings. This allows the stagnation point to 
vary from one profile to the next. In the current version of the HEC-RAS software, stagnation points 
are allowed to migrate between any bridge and culvert group openings. However, stagnation points 
must be set to a fixed location for any conveyance opening type. A more detailed explanation of 
stagnation points, and how the program uses them, can be found in the HEC-RAS Hydraulics 
Reference manual, under the section on Multiple Openings (Chapter 7).
Once the user has entered all of the information into the Multiple Opening Analysis window, simply 
press the OK button to accept the data.

Multiple Opening Calculations
Multiple opening calculations are computationally intensive. An iterative solution approach is used, 
by which the amount of flow through each opening is adjusted until the computed upstream 
energies of each opening are balanced within a predefined tolerance. The general approach of the 
solution scheme is as follows:

The program makes a first guess at the upstream water surface by setting it to the computed energy of the 
cross section just downstream of the bridge.
The program sets an initial flow distribution. This is accomplished by first calculating the amount of active 
flow area in each opening, based on the water surface from step one. The program then apportions the flow 
by using an area weighting (i.e., if an opening has 40 percent of the active flow area, then it will receive 40 
percent of the flow).
Once a flow distribution is established, the program then calculates the water surface and energy profiles for 
each opening, using the estimated flow.
Once the program has computed the upstream energy for each opening, a comparison is made between the 
energies to see if a balance has been achieved (i.e., all energies are within the predefined tolerance). If the 
energies are not within the set tolerance, the program re-distributes the flow based on the computed 
energies.
The program continues this process until either the computed energies are within the tolerance or the 
number of iterations reaches a pre-defined maximum. The energy balance tolerance is set as 3 times the 
user entered water surface calculation tolerance (The default is 0.03 feet or 0.009 meters). The maximum 
number of iterations for multiple opening analysis is set to 1.5 times the user entered maximum number of 
iterations from the normal water surface calculations (the default is 30 for multiple openings).

A more detailed discussion of how the program performs the multiple opening analyses can be 
found in Chapter 7 of the HEC-RAS Hydraulic Reference manual.

Inline Structures (Dams, Weirs and Gated Spillways)

HEC-RAS has the ability to model inline dams, weirs, and gated structures with radial gates (often 
called tainter gates), vertical lift gates (sluice gates), overflow gates (open to the air or with a closed 
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top), gates modeled with user defined curves, culverts, culverts with flap gates, user defined outlet 
rating curves, and user specified outlet time series. The spillway crest of the gates can be modeled as 
an ogee shape, broad crested weir, or a sharp crested weir shape.

This section of the User's manual will describe how to enter the data for inline structures. For 
information on general modeling guidelines and the hydraulic computations of Inline Structures, 
please see Chapter 8 of the HEC-RAS Hydraulic Reference manual. To find out how to view specific 
results for an inline structure, see Chapter 9 of this User's manual.

Entering and Editing Inline Structure Data
Inline structure data are entered in a similar manner as bridge and culvert data. To enter an inline 
structure, press the Inline Structure button from the Geometric Data window. Once this button is 
pressed, the Inline Structure Data editor will appear as shown in the figure below (except yours will 
be blank until you have entered some data).

Inline Structure Data Editor
To add an inline structure to a model, the user must do the following:

Select the river and reach that you would like to place this inline structure into. This is accomplished by first 
selecting a River, then selecting a specific reach within that river. The River and Reach selection buttons are 
at the top of the Inline Structure Data editor.
Go to the Options menu at the top of the window and select Add an Inline Structure from the list. An input 
box will appear asking you to enter a river station identifier for locating this structure within the reach. After 
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entering the river station, press the OK button and a copy of the cross section just upstream of this river 
station will appear on the screen. This cross section is used in formulating the inline structure crossing.
Enter all of the data for the Inline structure. This data will include a Weir/Embankment profile, any gated 
spillways that you may be modeling, culverts, and/or outlet rating curves. All of the outlet types are optional, 
except the embankment profile of the inline structure. If the user does not enter any gated spillways, 
culverts, etc…, then the program assumes that there is only an inline weir.
Once all of the Inline Structure data are entered, press the Apply Data button in order for the interface to 
accept the data. The editor can then be closed by selecting Exit from the File menu at the top of the window.

River, Reach, and River Station. The River and Reach boxes allow the user to select a river and 
reach from the available reaches that were put together in the schematic diagram. The river and 
reach labels define which river and reach the inline structure will be located in. The River Station tag 
defines where the structure will be located within the specified reach. The River Station tag does not 
have to be the actual river station of the structure, but it must be a numeric value. The River Station 
tag for the inline structure should be numerically between the two cross sections that bound the 
structure. Once the user selects Add an Inline Structure from the options menu, an input box will 
appear prompting you to enter a River Station tag for the new structure. After the River Station tag is 
entered, the cross section just upstream of the Inline Structure will be displayed on the editor.

Description. The description box is used to describe the Inline Structure location in more detail than 
just the river, reach and river station. This box has a limit of 256 characters. Only the first line of 
information is displayed, unless the button to the right of the box is pressed. Also, the first 40 
characters of the description are used as a label for the Inline Structure plots and tables.

Pilot Flow. This option allows the user to put in a flow rate that will be used as a minimum flow 
release from the structure. If you have an inline structure in HEC-RAS, no cross section in the model 
can go dry during the simulation. While you can have a zero flow at the structure, the upstream and 
downstream cross sections must always have water in them. The pilot flow option is a simple way to 
ensure that there is always some minor flow going through the structure.

Breach (Plan Data). This button allows the user to define information for evaluating the breaching 
of this inline structure. The data is actually stored in the currently opened plan file. The editor can 
also be brought up from the plan editor. This option is only for unsteady flow modeling. To learn 
more about this option, see Chapter 8 "Performing an Unsteady Flow Analysis."

Rules (unsteady Data). This button brings up the Unsteady Flow Data and Boundary Conditions 
editor and allows the user to define a set of rules for controlling the gate openings. For more details 
on the Rules editor, please see Chapter 8, Performing an Unsteady Flow Analysis", in this manual.

All Culverts: This drop down selection box allows user to add flap gates to any culverts entered on 
the inline structure. The default is for "No Flap Gates", which means flow can go in both directions 
through the culverts. The other options include "Flaps prevent Negative Flow", which means flow 
can only go in the positive flow direction through the culverts (Downstream), and "Flaps prevent 
Positive Flow", which means flow can only go in the negative direction through the culverts 
(upstream).

Weir/Embankment Editor
The Embankment and Weir data are entered together, and are used to describe the embankment 
blocking the stream as well as any uncontrolled overflow weirs. To enter the weir and embankment 
data, press the Weir/Embankment button and the editor will appear (see figure below). The Weir/
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Embankment Data editor is similar to the Deck/Roadway editor for bridges and culverts. The data on 
the Weir/Embankment editor is the following:
Distance - The distance field is used to enter the distance between the upstream side of the Weir/
Embankment (the top of the embankment) and the cross section immediately upstream of the 
structure. This distance is entered in feet (or meters for metric). 

Weir and Embankment Data Editor

Width - The width field is used to enter the width of the top of the embankment along the stream. 
The distance between the top of the downstream side of the embankment and the downstream 
bounding cross section will equal the main channel reach length of the upstream cross section 
minus the sum of the weir/embankment "width" and the "distance" between the embankment and 
the upstream section. The width of the embankment should be entered in feet (meters for metric).

Weir Coefficient - Coefficient that will be used for weir flow over the embankment in the standard 
weir equation.

Station and Elevation Coordinates - This table is used to define the geometry of the Weir and the 
Embankment. The information is entered from left to right in cross section stationing. The user 
enters stations and elevations of the top of the embankment and weir. The stationing does not have 
to equal the stations in the bounding cross section, but it must be based on the same origin. 
Everything below these elevations will be filled in down to the ground. The Del Row and Ins Row
buttons allow the user to delete and insert rows.
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U.S. Embankment SS - This field is used to enter the slope of the road embankment on the upstream 
side of the structure. The slope should be entered as the horizontal to vertical distance ratio of the 
embankment.

D.S. Embankment SS - This field is used to enter the slope of the road embankment on the 
downstream side of the structure. The slope should be entered as the horizontal to vertical distance 
ratio of the embankment.

Weir Crest Shape - When submergence occurs over the weir there are two choices available to figure 
out how much the weir coefficient should be reduced due to the submergence. These two criteria are 
based on the shape of the weir. The first method is based on work that was done on a trapezoidal 
shaped broad crested weir (FHWA, 1978). The second criterion was developed for an Ogee spillway 
shape (COE, 1965). The user should pick the criterion that best matches their problem. If the user 
selects the Ogee Spillway shape, then some additional information is required. For an Ogee shaped 
weir the user must enter the "Spillway Approach Height" and the "Design Energy Head". The spillway 
approach height is equal to the elevation of the spillway crest minus the mean elevation of the 
ground just upstream of the spillway. The design energy head is equal to the energy grade line 
elevation (at the design discharge) minus the elevation of the spillway crest. In addition to these two 
parameters, the user has the option to have the program calculate the weir coefficient at the design 
discharge. This is accomplished by pressing the Cd button. Once this button is pressed, the program 
will compute a weir coefficient for the Ogee spillway based on the design head. During the weir 
calculations, this coefficient will fluctuate based on the actual head going over the spillway. The 
curves used for calculating the Ogee spillway coefficient at design head, and discharges other than 
design head, were taken from the Bureau of Reclamation publication "Design of Small Dams", 
Figures 249 and 250 on page 378 (Bureau of Reclamation, 1977).

Gated Spillway Editor
In addition to uncontrolled overflow weirs, the user can add gated spillways (this is optional). To add 
gated spillways to the structure, press the Gate button on the Inline Structure data editor. Once this 
button is pressed, the gated editor will appear as shown in the figure below (Except yours will be 
blank until you have entered some data).



Entering and Editing Geometric Data

HEC-RAS User's Manual– 107

Gated Spillway Editor

The Gated Spillway editor is similar to the Culvert editor in concept. The user enters the physical 
description of the gates, as well as the required coefficients, in the Gated Spillway editor. The 
functionality of the gates is defined as part of the Unsteady Flow Data editor or the Steady Flow data 
editor (on a per profile basis). The following is a list of the data contained on this editor:

Gate Group - The Gate Group is automatically assigned to "Gate #1" the first time you open the 
editor. The user can enter up to 20 different Gate Groups at each particular river crossing, and each 
gate group can have up to 25 identical gate openings. If all of the gate openings are exactly the same, 
and any opened gates will be operated in the same manner, then only one gate group needs to be 
entered. However, if the user has gate openings that are different in shape, size, elevation, have 
different coefficients, or they will be operated differently, then additional Gate Groups must be 
added for each Gate type. To add an additional gate group you can either use the Add or Copy
buttons. The Add button increments the Gate # and clears the gate editor. The Copy button 
increments the Gate # and makes a copy of the original Gate group data. Once a copy is made of the 
gate data, the user can change any of the existing gate information. Gate groups can be deleted by 
pressing the Delete button. Also, if the gates are identical, but the user wants to be able to open the 
gates to different elevations, then the user must have a separate gate group for each set of gates that 
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will be opened to different elevations. In steady flow computations, the user can specify the number 
of gates in a group to be opened, but in unsteady flow computations all of the gates in a group are 
opened in exactly the same way (this is a limitation of our unsteady flow implementation of gates 
currently)

Geometric Properties of the Gates
Height - This field is used to enter the maximum possible height that the gate can be opened in feet 
(meters for metric).

Width - This field is used for entering the width of the gate in feet (meters).

Invert - This field is used for entering the elevation of the gate invert (sill elevation of the spillway 
inside of the gate) in feet (meters for metric). For overflow gates this is the lowest elevation that the 
gate will open to.

Opening Centerline Stations - This table is used for entering the centerline stationing of the gate 
openings. The user should enter a different centerline stationing for each gate opening that is part of 
the current gate group. All gate openings within the same gate group are exactly identical in every 
way, except their centerline stationing. As a user adds new centerline stationing values, the number 
of identical gates in the group is automatically incremented and displayed in the field labeled "# 
Openings".
Opening GIS Data – This table is used to enter X, Y coordinates for a line representing each gate. X, Y 
coordinates are only used when gates are connected to 2D Flow Areas. When a Gate is put into a 
Inline Structure of a 1D River Reach, then the X, Y coordinates are not needed or used. This table is 
only relevant to Lateral Structures and SA/2D Area Connections in which culverts will be connected 
to 2D Flow Area cells. It is not needed for pure 1D Inline Structures.

Gate Flow Coefficients
Gate Type (or methodology) - This field is used for selecting the type of gate. Five options are 
available for gate types: sluice (vertical lift gate), radial (tainter gate), Overflow (closed top), Overflow 
(open to the air), and User Defined Curves. Once a gate type is selected, the right hand side of the 
gate editor will change to show the required information for that gate type. Not all of the information 
is required for each gate type.

Discharge Coefficient - This field is used for entering the coefficient of discharge for the gate opening. 
This coefficient ranges from 0.6 to 0.8 for Radial gates and 0.5 to 0.7 for sluice gates. This coefficient 
is not required for overflow gates that are open to the air.

Trunnion Exponent - This field is used to enter the trunnion height exponent, which is used in the 
radial gate equation. The default value for this field is 0.0.

Opening Exponent - This field is used to enter the gate opening exponent, which is used in the radial 
gate equation. A default value of 1.0 is automatically set for this field.

Head Exponent - This field is used to enter the upstream energy head exponent, which is used in the 
radial gate equation. A default value of 0.5 is automatically set for this field.
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Trunnion Height - This field is used for entering the height from the spillway crest to the trunnion 
pivot point. This data is only used for radial gates. See Chapter 8 of the Hydraulic Reference manual 
for more details on this variable.

Orifice Coefficient - This field is used to enter an orifice coefficient, which will be used for the gate 
opening when the gate becomes more than 80 percent submerged. Between 67 percent and 80 
percent submerged, the program uses a transition between the fully submerged orifice equation and 
the free flow gate equations. When the flow is less than 67 percent submerged, the program uses the 
free flow gate equations. This coefficient is not required for overflow gates that are open to the air.

Head Reference – This field is used to select the reference point for which the upstream energy head 
will be computed from. The default is the gate sill (invert), which is normally used when the flow 
through the gate goes out into a channel. If the gate causes the flow to jet out freely into the 
atmosphere, then the head reference should be selected as the centerline elevation of the gate 
opening. If the gate crest is an ogee spillway crest, then the center of the gate opening should be 
used. Ogee spillway crests are normally designed to follow the shape of water jetting freely into the 
atmosphere.

Coefficients for Weir Flow over the Gate Sill
If a gate is opened to the point at which the top of the gate is no longer touching the water (or if an 
open air overflow gate is being used), then the flow through the gate is modeled as weir flow. The 
program will automatically transition from gate flow to weir flow when the upstream head is 
between 1.0 to 1.1 times the height of the gate opening. The following parameters are required to 
model weir flow through the gate opening.

Weir Shape - This parameter allows the user to select between a Broad Crested shape weir, an Ogee 
shaped weir, or a sharp crested weir. Depending on which shape is selected, the program will use a 
different submergence criteria during the calculations. In addition to the submergence criteria, if the 
user selects the Ogee shape, the program will bring up additional data entry fields that must be 
entered by the user. For the ogee weir shape, the additional fields are the Spillway Approach Height 
and the Design Energy Head, which are explained below. Once these fields are entered, the user 
should press the button labeled Cd. When this button is pressed, the program will compute a weir 
coefficient for the Ogee spillway based on the design head. During the weir calculations, this 
coefficient will fluctuate based on the actual head going over the gated spillway. The curves used for 
calculating the Ogee spillway coefficient at design head, and discharges other than design head, 
work taken from the Bureau of Reclamation publication "Design of Small Dams", Figures 249 and 250 
on page 378 (Bureau of Reclamation, 1977).

Weir Method – This field is only available when the Sharp Crested Weir shape is selected. If a sharp 
crested weir shape is selected, then the user has three choices for defining the weir coefficient: User 
Entered Coefficient; Compute with Rehbock equation; and Compute with Kindsvater-Carter 
Equation. If the "User Entered Coefficient" option is selected, then the user simple enters a 
coefficient that will be used for weir flow through the gate, for all head ranges. If the "Rehbock 
equation" is selected, the user is asked to enter a spillway approach height (explained below), and 
the weir coefficient is then computed with the Rehbock equation. If the "Kindsvater-Carter equation" 
is selected, then the user must enter a spillway approach height, and also select which form of the 
Kindsvater- Carter equation will be used. The form of the Kindsvater-Carter equation is based on 
selecting one of eleven equations that are based on varying L/b. Where L is the width of the gate 
opening, and b is the top width of the approaching water upstream of the gate. If more than one gate 
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is defined at a particular opening, you must figure out an average approach width for flow going to 
each gate.

Weir Coefficient - This field is used for entering a weir coefficient that will be used for the gate 
opening. This coefficient will only be used when the gate is opened to an elevation higher than the 
upstream water surface elevation. When this occurs, the flow through the gate is calculated as weir 
flow. If the Kindsvater-Carter equation is selected, then this field is used to select which form of the 
equation will be used to compute the coefficient.

Spillway Approach Height - The spillway approach height is equal to the elevation of the spillway 
crest minus the mean elevation of the ground just upstream of the spillway.

Design Energy Head - The design energy head is equal to the energy grade line elevation (at the 
design discharge) minus the elevation of the spillway.

User Defined Gate Curves
When the user selects "User Defined Curves" for the gate type, then the editor will change to look like 
the one shown in the figure below.

Gate Editor with User Defined Curves Selected.
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As shown in the figure above, the user must select the button that says "Enter/Edit User Defined 
Curves". This will bring up another editor that allows the user to enter the curves into a table. The 
user is also required to give a name for each set of curves. More than one curve set can be entered, 
and the user can then select a different curve set for each gate group (if desired). Each curve set 
represents the head versus flow relationships for one single gate opening. When there are 2 or more 
identical gates in a group, each gate in the group gets the same curve set applied to it. When the 
"Enter/Edit User Defined Curves" button is pressed, a new editor will appear as shown in figure 
below.

Editor for Entering/Editing Gate Curves.

As shown in figure above, the user enters gate openings in the first column. Headwater elevations 
are entered in the first row. The remaining fields are the corresponding flow for a given gate opening 
and upstream headwater elevation. To enter a new curve set, the user must first select the "New 

The user defined gate curves represent a set of curves, one curve for each gate opening, in which 
the curve is based on headwater only control, and no downstream tailwater influence. To 
include the influence of tailwater, the user would have to enter a full family of rating curves 
(Headwater, tailwater and flow) for every possible gate opening). This is beyond the scope of this 
option. The normal mode of computing gate flow from the gate flow equations takes into 
account the influence of tailwater, but this user entered curve method does not.
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User Curve" button at the top of the editor. When this button is selected the user will be prompted to 
enter a name for the curve set. Other buttons at the top of the editor are for renaming the curve set, 
deleting the curve set, and copying the curve set to a new name. Once the curve set, or sets, are 
entered, the user simple selects a curve set for each gate group desired. The user also has the option 
to use curve sets for some gate groups and have the program calculate the flow from equations for 
others.
Once all of the data for the gates has been entered, the user needs to press the OK button for the 
data to be accepted. If the user does not want to use the new data, and would like to go back to the 
original data they had before entering the Gate Editor, press the Cancel button. If the user presses 
the OK button, this does not mean that the data is saved to the hard disk, it is only stored in memory 
and accepted as being good data. This data is part of the geometry data, and is stored in the 
geometric data file. The data can be stored to the hard disk by selecting one of the save options from 
the File menu of the Geometric Data window.

Culverts
User can also enter culverts at inline structures. Culverts can be entered as groups of identical 
culvert barrels (up to 25 barrels per culvert group), or the user can have up to 20 different culvert 
groups in which the culverts can be all kinds of shapes, sizes, elevations, roughness, etc… Culverts 
can compute flow in both directions, or user's have the option to have flap gates to prevent either 
negative flow (Flow upstream), or positive flow (Flow downstream) through the culverts. For details 
on the specific data to model a culvert, please review the section on culverts earlier in this chapter.

Outlet Rating Curves
If a user has an outlet type that does not exist in HEC-RAS, or cannot be modeled accurately with the 
available weirs, gates, and culverts, then an outlet rating curve can be used to model that specific 
outlet. The Outlet Rating curve can be based on upstream water surface elevations versus outlet 
flow, or it can be based on upstream total flow versus the flow through the outlet. This method does 
not take into account downstream tailwater influences on the flow rate.

Outlet Time Series
This option allows the user to specify a time series of flows to be used as an additional outlet through 
the inline structure. When this option is selected, the user enters a name to identify the outlet. For 
example, let's say you call the time series "Hydropower", which may represent flows going through a 
hydropower station at the structure. Then, the user can attach a flow hydrograph to the inline 
structure in the Unsteady Flow Data editor. This flow is then assigned to the user specified Outlet 
time Series specified on the inline structure. Only one, Outlet time series can be defined per inline 
structure, and only one hydrograph can be entered/attached to the inline structure in the unsteady 
flow data editor. If you have more than one time series you would like to use, combine them into one 
flow hydrograph outside of HEC-RAS, and then use that as the time series data.
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Lateral Structures (Weirs, Gated Spillways, Culverts, and Diversion 
Rating Curves)

At any lateral structure HEC-RAS has the ability to model lateral weirs, gated spillways, culverts, 
diversion rating curves, and an outlet time series. The user can set up a single lateral weir, a weir and 
separate set of gates, a weir and group of culverts, or any combination of weir, gates, culverts, rating 
curves, and a time series outlet. The gated spillways can have either radial gates (often called tainter 
gates), vertical lift gates (sluice gates), overflow gates (open to the air or with a covered top), or user 
defined gate curves. The spillway crest of the gates can be modeled as either an ogee shape, broad 
crested weir, or sharp crested weir shapes. The culverts can be any of the available shapes from the 
standard HEC-RAS culvert capability. The diversion rating curve can be used alone, or in conjunction 
with the other hydraulic outlet types. The rating curve can be used to represent an entire structure or 
a particular outlet that could not be modeled with HEC-RAS. Lateral structures can be connected to 
storage areas, 2D Flow Areas, or another river reach.

The lateral structure option can also be used to model a levee. In general, the user should end their 
cross sections at the inside top of the levee, and then use the lateral structure option to represent 
the top of the levee along the stream. The area behind the levee could be represented with either a 
2D Flow Area, storage area (or combination of interconnected storage areas), or another river reach. 
Water that goes above the levee will be modeled as weir flow. The user also has the option to 
evaluate levee breaching.
HEC-RAS now has the option to have georeferenced lateral structures. Under the menu item labeled 
GIS Tools, there is now a table option called Lateral Structure Centerlines Table. User can use the 
Measure Tool to draw a line that would represent the lateral structure geospatial X and Y 
coordinates, then paste those coordinates into the Lateral Structure Centerline Table (This is 
optional). If a user inserts geospatial coordinates for a lateral structure, not only will it be drawn 
geospatially correct, but HEC-RAS will figure out how elements (1D cross sections and 2D Face 
Points) are connected to the lateral structure based on its spatial location.

This section of the User's manual will describe how to enter the data for lateral weirs, gated 
spillways, culverts, lateral rating curves, and outlet time series. For information on general modeling 
guidelines and the hydraulic computations of lateral weirs, gated spillways, and culverts, please see 
Chapter 8 of the HEC-RAS Hydraulic Reference manual. To find out how to view specific results for a 
lateral structure, see Chapter 9 of this User's manual.

Entering and Editing Lateral Structure Data
Lateral weir, gated spillway, and culvert data are entered in a similar manner as bridge and culvert 
data. To enter a lateral structure, press the Lateral Structure button from the Geometric Data 

If you put in a Geospatial centerline for a lateral structure, the length of the lateral structure 
weir/embankment stationing must be within 0.5% of the length of the centerline put in (i.e. they 
need to be consistent with each other in terms of length).





Entering and Editing Geometric Data

HEC-RAS User's Manual– 114

1.

2.

window. Once this button is pressed, the Lateral Structure Data editor will appear as shown in the 
figure below (except yours will be blank until you have entered some data).
To add a lateral structure to a model, the user must do the following:

Select the river and reach that you would like to place this lateral structure into. This is accomplished by first 
selecting a River, then selecting a specific reach within that river. The River and Reach selection buttons are 
at the top of the Lateral Structure Data editor.
Go to the Options menu at the top of the window and select Add a Lateral Structure from the list. An input 
box will appear asking you to enter a river station identifier for locating this structure within the reach. The 
river station you enter will represent the location of the upstream end of the lateral structure. The river 
station must be unique, and should be numerically between the river station values of the upstream cross 
section and the next section downstream. After entering the river station, press the OK button and a profile 
plot of the channel invert and cross sections in the vicinity of the lateral weir/spillway will be displayed.
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1.

2.

Lateral Weir, Gated Spillway, and Culvert Editor

Enter all of the data for the Lateral Weir, Gated Spillways, Culverts, Diversion Rating Curves, and Outlet Time 
Series. All of the outlet types are optional, and can be mixed and matched to form a single lateral structure. 
If the user does not enter any gated spillways, culverts, rating curves, or outlet time series, then the program 
assumes that there is only a lateral weir. If the user wants to enter only gated spillways, culverts, or a rating 
curve, and no lateral weir, they must still enter a weir embankment.
Once all of the data are entered, press the Apply Data button in order for the interface to accept the data. 
The editor can then be closed by selecting Exit from the File menu at the top of the window.
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3. If any gated spillways were entered, the user must go to the Steady or Unsteady Flow Data Editor to control 
the gate settings for each individual event. If an outlet time series was entered, then the user must attach a 
flow hydrograph to the lateral structure in the Unsteady Flow Data editor.

The user can have up to two lateral structures defined between any two given cross sections. 
However, the lateral structure must be placed on opposite sides of the channel (i.e. one on the left 
and one on the right), and the river stations of each lateral structure must be different (though still 
contained within the two cross section river station values). Also, any lateral structure can be longer 
than the distance between cross sections. The user can have a lateral structure that extends 
downstream, encompassing up to 100 cross sections. If you have a lateral structure that is longer 
than that, you must break it up into separate lateral structures.

River, Reach, and River Station. The River and Reach boxes allow the user to select a river and 
reach from the available reaches that were defined in the schematic diagram. The river and reach 
labels define which river and reach the lateral structure will be located in. The Head Water River 
Station (HW RS) tag defines where the structure will be located within the specified reach. The River 
Station tag does not have to be the actual river station of the structure, but it must be a numeric 
value. The River Station tag for the lateral structure should be numerically between the two cross 
sections that bound the upstream end of the structure. Once the user selects Add a Lateral 
Structure from the options menu, an input box will appear prompting you to enter a River Station 
tag for the new structure. After the River Station tag is entered, a profile plot of the reach thalweg will 
be displayed for the bounding cross sections in the graphic window. The river and reach in which the 
lateral structure is defined is considered to be the headwater side of the structure. Whatever the user 
connects the lateral structure to is considered to be the tailwater side of the structure.

Description. The description box is used to describe the Lateral Structure location in more detail 
than just the river, reach and river station. This box has a limit of 256 characters. Only the first line of 
information is displayed, unless the button to the right of the box is pressed. Also, the first 40 
characters of the description are used as a label for the Lateral Structure plots and tables.

HW Position. The headwater position box is used to define where the lateral structure is located 
spatially within the reach that it is defined. The user can select one of the following: Left overbank; 
Next to left bank station; Next to right bank station; and Right overbank. When the user selects "Left 
overbank", the weir is assumed to be located at the left end (beginning cross section station) of the 
cross section data, looking in the downstream direction. When the user selects "Next to left bank 
station", the weir is assumed to be located on the left edge of the main channel. When the user 
selects "Next to right bank station", the weir is assumed to be located on the right edge of the main 
channel. When the user selects "Right overbank", the weir is assumed to be located at the right end 
of the cross section data.

Tailwater Connection. This area of the editor is used to define what the lateral structure is 
connected to (i.e. where the water leaving from the main river will be going). A lateral structure can 
be connected to a storage area; 2D Flow Area; cross sections in another river reach; or nothing at all 
(defined as leaving the system). To set the tailwater connection, first select the connection type from 
the area labeled: Type. Then, depending on the type of tailwater connection, other information may 
be required. If the tailwater connection type is Out of the System, then no other information is 
required. If the tailwater connection type is a Storage Area/2D Flow Area, then the user is required 
to select a storage area or a 2D Flow Area from a drop down list of the currently defined storage 
areas. If the tailwater connection type is Cross Sections of a River/Reach, then the user is required 
to select the river, reach, and range of cross sections that the lateral structure is connected to. The 
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tailwater connection can be to a single cross section (all the flow goes to one point), or it can be set 
to a range of cross sections (the flow will be distributed over the range of cross sections). In addition 
to the cross section(s) the user must define if the connection is on the right over bank; next to the 
right bank station; next to the left bank station, or on the left overbank. Water can also flow in the 
reverse direction through a lateral structure if the connected to location has a higher water surface 
than the from location. Reverse flow gets labeled as negative flows for a lateral structure.

Structure Type. This field is used to select the type of routing that will be used for this structure. 
There are two options, Weir/Gates/Culverts/ Diversion Rating Curves (the default) and Linear 
Routing. The default option is where the program calculated the flow across the structure by 
performing detailed hydraulic calculations for the weir, gated spillways, culverts, and any rating 
curve. The second option, Linear Routing, is a simplified method in which the user just puts in a 
linear routing coefficient. This coefficient can vary between 0.0 and 1.0, with 1.0 representing 
sending the maximum flow over the structure and 0.0 representing no flow. The linear routing 
method is a simple storage accounting method. This method can be very useful when the user has 
many lateral structures connected to storage areas, and a detailed flow calculation over each 
structure is not necessary. Also, the linear routing method is computationally faster and more stable. 
Typical values for the linear routing coefficient are from 0.05 to 0.2. However, this coefficient needs 
to be calibrated.

Culvert Flap Gates. The drop down box right above the Structure Type pertains to having flap gates 
on culverts. This option only affects the flow through the culverts, not the weir or the gated 
structures. The options are no flap gates (default), Flaps prevent negative flow, and flaps prevent 
positive flow. No flap gates means that flow is allowed to go in both directions through the culvert. 
The "Flaps prevent negative flow" option means that flow can only go in the positive flow direction 
through the culverts. Positive flow is assumed to be taking flow away from the river for a lateral 
structure. Therefore, the "Flaps prevent negative flow" option would allow water to go away from 
the main river through the culverts, but not back into the river. The final option, "flaps prevent 
positive flow", would only allow water to come into the main river through the culverts, but not away 
from the main river.

Overflow Computation Method. This option is used to control what equations are used to compute 
the flow across a Lateral Structure. By default the "Weir" equation is used. However, if the Lateral 
Structure is connected to a 2D Flow Area, then there is the option to use the 2D Flow equations to 
figure out how much flow is going across the Lateral Structure, and in which direction. When the 2D 
Flow Equations overflow method is selected, an average water surface elevation is computed one 
the 1D river side, in front of each 2D cell that is connected with the Lateral Structure. This water 
surface is then applied as a stage boundary condition for each individual cell of the 2D area. So, if 
water is above the weir profile, and the elevation is higher in the 1D river than the 2D cell, then water 
will go from the 1D river to the 2D cell. If the 2D cell is higher than the 1D river, then water will go 
from the 2D cell to the 1D river. If the water is below the elevation of the weir, then the flow is zero for 
that cell.

2D Boundary. This option is used only when a Lateral Structure is connected to a 2D Flow Area. In 
general for this type of flow connection, flow is computed across the structure and passed into and 
out of the 2D cells, and no velocity is considered at the face. If this option is turned on, in addition to 
flow, a velocity is computed and applied to the face of the 2D cells. By default this is off, which 
produces a more stable solution, but less velocity accuracy. If turned on, it will produce more 
accurate flow velocities into the 2D area, but may be less stable.
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Optimization. This option is for steady flow modeling, or the initial conditions of an Unsteady flow 
model. When modeling in a steady flow mode (or unsteady flow initial conditions), the user can have 
the software figure out how much flow will leave through the lateral structure, and how much will 
continue on downstream. This calculation requires an iterative solution. Pressing the Optimization 
button brings up an editor that allows the user to turn the optimization option on. When 
optimization is not turned on, the program will assume all of the water is still going downstream, 
though it will calculate what could have gone out the lateral weir based on the computed water 
surface. When optimization is turned on, the software calculates the flow out of the lateral structure, 
reduces the flow in the main river, and then recalculates the profile in the main river. This operation 
continues until there is a balance between the calculated and assumed flows for the main river.

Breach. This button allows the user to define information for evaluating the breaching of this lateral 
structure. The data is actually stored in the currently opened plan file. The editor can also be brought 
up from the plan editor. This option is only for unsteady flow modeling. To learn more about this 
option, see Chapter 16 "Advanced Features for Unsteady Flow Routing."

Weir/Embankment Editor
The Embankment and Weir data are entered together, and are used to describe the embankment in 
which the outlets will be placed, as well as any uncontrolled weirs. To enter the weir and 
embankment data, press the Weir/Embankment button and the editor will appear as shown in the 
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figure below. 

Lateral Weir/Embankment Editor

The Lateral Weir/Embankment Data editor is similar to the Deck/Roadway editor for bridges and 
culverts. The data on the Weir/Embankment editor is the following:

Weir Width - The width field is used to enter the width of the top of the embankment. This value will 
only be used for graphical plotting, and does not have any effect on the computations. The width of 
the embankment should be entered in feet (meters for metric).

Weir Computations – This field allows the user to select either the standard weir equation or Hager's 
lateral weir equation. When the standard weir equation is selected, the user will also need to enter a 
weir flow reference head, and a weir coefficient. If Hager's lateral weir equation is selected, the user 
must also enter: default weir coefficient; weir average height; an average bed slope, and a weir angle 
in degrees if it is anything other than parallel to the stream.

Weir flow reference - This value is used to select whether weir flow is computed by using the energy 
gradeline or the water surface from the cross sections. The default is to use the energy gradeline.

Weir Coefficient - Coefficient that will be used for weir flow over the embankment in the standard 
weir equation.
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Weir Crest Shape - When submergence occurs over the weir/embankment there are four choices 
available to figure out how much the weir coefficient should be reduced due to the submergence. 
These four criteria are based on the shape of the weir. The first method is based on work that was 
done on a trapezoidal shaped broad crested weir (FHWA, 1978). The second criterion was developed 
for an Ogee spillway shape (COE, 1965). The third is for a sharp crested weir. The last selection is 
when there really is no weir, and flow is just traveling overland. This is called a "Zero Height" weir. 
The user should pick the criterion that best matches their problem. If the user selects the Ogee 
Spillway shape, then some additional information is required. For an Ogee shaped weir the user 
must enter the "Spillway Approach Height" and the "Design Energy Head". The spillway approach 
height is equal to the elevation of the spillway crest minus the mean elevation of the ground just 
upstream of the spillway. The design energy head is equal to the energy grade line elevation (at the 
design discharge) minus the elevation of the spillway crest. In addition to these two parameters, the 
user has the option to have the program calculate the weir coefficient at the design discharge. This is 
accomplished by pressing the Cd button. Once this button is pressed, the program will compute a 
weir coefficient for the Ogee spillway based on the design head. During the weir calculations, this 
coefficient will fluctuate based on the actual head going over the spillway. The curves used for 
calculating the Ogee spillway coefficient at design head, and discharges other than design head, 
were taken from the Bureau of Reclamation publication "Design of Small Dams", Figures 249 and 250 
on page 378 (Bureau of Reclamation, 1977).

HW Distance to Upstream XS - This field is used to enter the distance between the upstream end of 
the Weir/Embankment (based on where the user will start to enter the embankment data) and the 
cross section immediately upstream of the structure. This distance is entered in feet (or meters for 
metric).

TW Flow Goes – If the lateral structure is set to send flow to another river reach, this field will be 
active. This field is used to select where the flow will go to in the tailwater (TW) reach. Flow can be 
set to go into a single point, or it can be set to go over a range of cross sections.

TW Distance to Upstream Cross Section – If the lateral structure is set to send flow to another river 
reach, this field we be active. This field is used to enter a distance between the connected tailwater 
cross section, and the actual location in which the weir begins to connect. Default value is zero, 
meaning the weir starts at the selected tailwater cross section and continues downstream from 
there. Only positive values can be entered. Any number greater than zero means that the weir 
connection starts downstream of the connected cross section, by the user entered distance.

Weir Station and Elevation - This table is used to define the geometry of the Weir and the 
Embankment. The information is entered from upstream to downstream in stationing. The user 
enters stations and elevations of the top of the embankment and weir. The stationing is relative, so it 
can be started at any number (i.e. 0, 100, etc…). The user enters stations and elevations from the 
upstream end to the downstream end of the lateral structure. Everything below these elevations will 
be filled in to the ground. By default, the lateral structure will be lined up with the river/reach by 
comparing the stationing entered with the reach lengths of the river/reach. If the lateral structure is 
connected to the right overbank of the reach, then the right overbank reach lengths are used. If the 
lateral structure is connected to the right or left bank station of the main channel, then the main 
channel reach lengths will be used. The Filter button allows the user to filter the station and 
elevation points in order to reduce the total number of points. This feature is often used when a 
lateral weir is used to represent a natural overflow area, and the data has come from a GIS.
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Headwater Connections – This table will by default show the weir stationing that intersects with the 
cross sections in the river/reach that the structure is defined in. The software automatically aligns 
the weir with the cross sections in the reach based on the weir stationing and the reach lengths in 
the cross sections (either left overbank, main channel, or right overbank reach lengths). However, if 
the user does not like how the defined weir intersects with the cross sections in the reach, they can 
define their own intersection points by entering the desired weir stationing to intersect with each of 
the cross sections in the reach. Water surface elevations for the lateral structure will then be 
interpolated based on the user entered stationing.

Tailwater Connections – This table can be used to line up the weir to either a 2D Flow Area or cross 
sections in another reach in a user controlled manner. By default the weir is automatically lined up 
to any 2D Flow Area or cross sections of another river reach that it is connected too. However, this 
editor will allow users to hand change the connection locations to the 2D Flow Area Face points, or 
cross section river station locations of the river reach. The user can select to use "User specified 
intersections", which will allow them to describe where the stationing of the weir hits the tailwater 
cross sections or 2D Flow Area Face points. If this option is used the user must completely define 
where the entire length of the weir intersects the various tailwater cross sections or 2D Flow Area.
If Hager's Lateral weir equation is selected from the "Weir Computations" field, then the following 
additional fields will appear:

Default Weir Coefficient (Cd) – This weir coefficient will be used for the first iteration of trying the 
Hager lateral weir equation. The equation is iterative, and requires hydraulic results in order to make 
a weir coefficient calculation. The default weir coefficient is only used for the first guess at the 
hydraulic computations.

Weir Average Height – This field is used for entering the average height of the weir above the ground.

Average Bed Slope (Optional) – This field is used for entering the average slope of the stream bed in 
the reach of river that contains the lateral weir. If the use does not enter this field, the HEC-RAS 
program will compute the slope by estimating an average bed elevation for each cross section, then 
computing the slope of the average bed elevation. Average bed elevation of an irregular cross 
section is obtained by subtracting hydraulic depth from the water surface elevation.

Weir Angle in Degrees (Optional) – This field can be used to enter and angle for the weir. If the weir is 
parallel to the stream, the angle is assumed to be zero. If the weir is angled inwards towards the 
center of the river, an angle (beta) is required. This is used for channels that have a contraction, and 
weir flow is allowed to go over the contracted section. A diagram showing the angle (beta) is shown 
below:

Gated Spillway Editor
In addition to uncontrolled overflow weirs, the user can add gated spillways (this is optional). To add 
gated spillways to the structure, press the Gate button on the Lateral Weir and Gated Spillway data 
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editor. Once this button is pressed, the lateral gated editor will appear as shown in the figure below 
(except yours will be blank until you have entered some data).

Lateral Gated Spillway Editor

The Gated Spillway editor is similar to the Culvert editor in concept. The user enters the physical 
description of the gates, as well as the required coefficients, in the Gated Spillway editor. The 
functionality of the gates is defined as part of the Unsteady flow Data, or the Steady Flow data (on a 
per profile basis). The data for modeling a gate in a lateral structure is the same as the data for 
modeling a gate in an inline structure. Please refer to the previous section on inline structures to get 
a detailed explanation of the data for the gate editor.

Culvert Editor
In addition to the lateral weir and gates, the user can also enter lateral culverts. To add culverts to 
the structure, press the Culvert button on the lower left side of the editor. When this option is 
selected the following window will appear.
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Culvert Editor for Lateral Culverts

The required culvert data is the same as for an inline culvert. To see an explanation of each field on 
the editor, review the information on culverts found earlier in this chapter. The only difference is that 
the centerline stationing of each culvert is based on the stationing entered in the Weir/Embankment 
editor.

Diversion Rating Curve Editor
Diversion rating curves are used to remove flow from a main river. The diversion, rating curve can be 
used in conjunction with a lateral weir, gated structures, and culverts, or it can be used alone.
To add a diversion, rating curve to the system, press the "Diversion Rating Curve" button on the left 
hand side of the Lateral Structure editor. When this button is pressed, the following editor will 
appear:
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Lateral Rating Curve Editor
The user first selects the type of rating to be used: channel water surface versus diverted flow or 
channel flow versus diverted flow. Next, the distance between the location of the diversion and the 
cross section just upstream of the structure must be entered in order to locate the diversion. Finally, 
the user enters the actual rating curve. The curve is entered as the amount of flow leaving, verses the 
elevation of the water in the main river or flow in the main river. NOTE: This rating curve does not 
take into account any influence of the tailwater elevation in order to reduce the flow.

Outlet Time Series
This option allows the user to specify a name for an Outlet time series. Then a Flow Hydrograph can 
be specified for the Lateral Structure in the Unsteady Flow Data editor. The flow time series will be 
labeled in the output based on the user entered name for the Outlet Time series.

Linear Routing Option
The user can choose to use a linear routing option instead of entering structure information and 
having the program compute the flow from the structures. The linear routing option is selected by 
going to the Structure Type pull down and selecting "Linear Routing" from the list. This option uses 
a coefficient times the difference in available storage between the too and from connection. When 
this option is selected, a linear routing button will appear on the left side of the window. Selecting 
the linear routing button will bring up the following window:
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Simple Spillway Data Editor

The equation used for the linear routing computations is the following:
Q = K (Available Storage)/hour

Where:
Q = Flow per hour
K = Linear Routing Coefficient (0.0 to 1.0)
Available Storage = ∆Z (Surface Area)
Surface Area = surface area of receiving storage area.
∆Z is the difference between the headwater and tailwater water surface elevation on each side of the 
lateral structure. If both water surfaces are below the spillway crest elevation, then the flow is zero. If 
one water surface is above the spillway elevation and the other is not, then ∆Z is compute as the 
water surface above the spillway crest minus the spillway crest elevation.

The flow is computed in cfs per hour. If the user selected time step is not 1 hour, then the flow for the 
time step is compute by multiplying the flow by the ratio of the user entered time step divided by 1 
hour.

As shown in the Linear Routing editor, the user must enter a linear routing coefficient for both the 
positive and negative flow directions. Additionally, the minimum elevation of the spillway crest
must be entered. If both water surfaces go below the spillway crest, no flow is passed over the 
structure. Also, the user must enter the HW Distance to Upstream XS, which allows the program to 
figure out where the location of the lateral connection with respect to the upstream cross section. 
This location will be used for interpolating water surface elevations on the river side of the 
connection.

Storage Areas

 
Storage Areas are lake like regions in which water can be diverted into or from. Storage areas can be 
located at the beginning of a reach (as an upstream boundary to a reach), at the end of a reach (as a 
downstream boundary to a reach), or they can be located laterally to a reach. Storage areas can be 
connected to a river reach by using a lateral structure connection. Storage areas can be connected to 
another storage area by using a storage area connection. Storage area connections can consist of a 
weir and gated spillways; a weir and culverts; just a weir; or a linear routing option. An example river 
system with storage areas is shown in Figure 5 39. 
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Figure 5 39 Example Schematic with Storage Areas

To add a storage area to the river system, first use the storage area drawing tool at the top of the 
geometric editor. Once the storage area, drawing tool is selected, the user single clicks the left 
mouse button to begin drawing the storage area. Additional points are added by moving the mouse 
and single clicking. The storage area will be represented as a polygon. To finish drawing the storage 
area, double click the left mouse button. The first and last point will then be connected, and the 
storage area will be filled in with a blue color. The user will then be prompted to enter a name for the 
storage area.

After the storage area is drawn and labeled, the user must enter data to describe the storage area. 
This is accomplished with the storage area editor, which is one of the buttons on the left side of the 
geometric editor. Press the storage area editor button and the following editor will appear:
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Figure 5 40 Storage Area Editor

As shown in the figure above, the user has two options for entering information about the volume of 
the storage area. The first option is a simple area times a depth option. The user enters the area of 
the storage, and a minimum elevation. The storage area is assumed to have the same area at all 
elevations, therefore the volume is simply the depth times the area. The second option is to enter 
and elevation versus volume relationship for the storage area. This option provides more detail and 
accuracy, and is the recommended method whenever possible. Also shown in the storage area editor 
are any connections or references to that particular storage area. Valid connections to a storage area 
are: lateral structures, storage area connections, and a cross section connected directly to a storage 
area.

Storage areas can be converted to two-dimensional flow areas by pressing the button labeled "-> 
2DFlow". When this option is selected, the interface will now think that this area is a 2D Flow Area, 
and the user will then need to define the 2D computational mesh. See 2D Flow Areas below for more 
information on how to do this.
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2D Flow Areas

 
Two Dimensional Flow Areas (2D Flow Areas) are regions of a model in which the flow through that 
region will be computed with the HEC-RAS two dimensional flow computation algorithms. 2D Flow 
Areas are defined by laying out a polygon that represents the outer boundary of the 2D Flow Area. 
Then the user must define the computational mesh.

2D Flow Area can be located at the beginning of a reach (as an upstream boundary to a reach), at the 
end of a reach (as a downstream boundary to a reach), or they can be located laterally to a reach. 2D 
Flow Areas can be connected to a river reach by using a lateral structure connection. 2D Flow Areas 
can be connected to another 2D Flow area or a Storage Area by using a SA/2D Area Connection (this 
is described later in this chapter).

The HEC-RAS 2D modeling capability uses a Finite-Volume solution scheme. This algorithm was 
developed to allow for the use of a structured or unstructured computational mesh. This means that 
the computational mesh can be a mixture of 3-sided, 4-sided, 5-sided, etc… computational cells (up 
to 8 sided cells). However, the user will most likely select a nominal grid resolution to use (e.g. 200 X 
200 ft cells), and the automated tools within HEC-RAS will build the computational mesh. 
Note: for a more detailed description of how to use the HEC-RAS two-dimensional modeling 
capabilities, please see the separate User's manual that comes with HEC-RAS called "2D Modeling 
User's Manual".

A 2D Flow Area, and computational mesh, is developed in the HEC-RAS Geometry editor by doing the 
following:

Draw a Polygon Boundary for the 2D Flow Area
The user must add a 2D flow area polygon to represent the boundary of the 2D area using the 2D flow 
area drawing tool in the Geometric Data editor (just as the user would create a Storage Area). The 
best way to do this in HEC-RAS is to first bring in terrain data and aerial imagery into HEC-RAS 
Mapper. Once you have terrain data and various Map Layers in RAS Mapper, they can be displayed as 
background images in the HEC-RAS Geometry editor. Additionally, the user may want to bring in a 
shapefile that represents the protected area, if they are working with a leveed system. The 
background images will assist the user in figuring out where to draw the 2D flow area boundaries in 
order to capture the tops of levees, floodwalls, and any high ground that will act as a barrier to flow.

Use the background mapping button on the HEC-RAS Geometry editor to turn on the terrain and 
other Map Layers, in order to visualize where the boundary of the 2D Flow Area should be drawn.

For levees and roadways this is obviously the centerline of the levee and the roadway. However, 
when using a lateral structure to connect a main river to the floodplain (when there is no actual 
levee), try to find the high ground that separates the main river from the floodplain. Use this high 
ground as a guide for drawing the 2D boundary, as well as defining the Lateral Structure Station 
Elevation data.

The boundary between a 1D river reach and a 2D Flow Area should be high ground that separates 
the two.
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To create the 2D Flow Area, use the 2D Flow Area tool (the button on the Geometric Editor Tools Bar 
labeled 2D Flow Area, highlighted in red on Figure 12). Begin by left-clicking to drop a point along the 
2D Flow Area polygon boundary. Then continue to use the left mouse button to drop points in the 2D 
Flow Area boundary. As you run out of screen real-estate, right-click to re-center the screen. Double-
click the left mouse button to finish creating the polygon. Once you have finished drawing the 2D 
area polygon by double clicking, the interface will ask you for a Name to identify the 2D Flow Area. 
Shown in Figure 5-41 is an example 2D Flow Area polygon for an area that is protected by a levee. The 
name given to the 2D Flow Area in this example is: "2D Interior Area".

Figure 5 41. Example 2D Flow Area polygon.

Adding Break Lines inside of the 2D Flow Area
Before the computational mesh is created the user may want to add break lines to enforce the mesh 
generation tools to align the computational cell faces along the break lines.  Break lines can also be 
added after the main computational mesh is formed, and the mesh can be regenerate just around 
that break line.  In general, break lines should be added to any location that is a barrier to flow, or 
controls flow/direction. 

Break lines can be imported from Shapefiles (GIS Tools/Breaklines Import from Shapefile); drawn by 
hand; or detailed coordinates for an existing breakline can be pasted into the break line coordinates 
table (GIS Toools/Breaklines Coordinates Table).  To add break lines by hand into a 2D flow are, 
select the 2D Area Break Line tool (highlighted in Red in Figure 3-2), then left click on the geometry 
window to start a break line and to add additional points.  Double click to end a break line.  While 
drawing a breakline, you can right click to re-center the screen in order to have more area for 
drawing the breakline.  Once a break line is drawn the software will ask you to enter a name for the 
break line.  Add break lines along levees, roads, and any high ground that you want to align the mesh 
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faces along.  Break lines can also be placed along the main channel banks in order to keep flow in the 
channel until it gets high enough to overtop any high ground berm along the main channel. 

Creating the 2D Flow Area Computational Mesh
Select the 2D Flow Area editor button on the left panel of the Geometric Data editor (Under the 
Editors set of buttons on the left) to bring up the 2D Flow Area editor window:

Figure 5 42. 2D Flow Area Mesh Generation Editor

The 2D Flow Area editor allows the user to select a nominal grid size for the initial generation of the 
2D flow area computational mesh. To use this editor, first select the button labeled Generate 
Computational points on regular Interval …. This will open a popup window that will allow the 
user to enter a nominal cell size. The editor requires the user to enter a Computational Point 
Spacing in terms of DX and DY (see Figure 3-5). This defines the spacing between the computational 
grid-cell centers. For example, if the user enters DX = 50, and DY = 50, they will get a computational 
mesh that has grids that are 50 x 50 everywhere, except around break lines and the outer boundary. 
Cells will get created around the 2D flow area boundary that are close to the area of the nominal 
grid-cell size you selected, but they will be irregular in shape.

Since the user can enter break lines, the mesh generation tools will automatically try to "snap" the 
cell faces to the breaklines. The cells formed around break lines may not always have cell faces that 
are aligned perfectly with the break lines. An additional option available is Enforce Selected 
Breaklines. The Enforce Selected Breaklines option will create cells that are aligned with the 
breaklines, which helps ensures that flow cannot go across that cells face until the water surface is 
higher than the terrain along that break line. When using the Enforce Selected Breaklines option, the 
software will create cells spaced along the breakline at the nominal cell size entered buy the user. 
However, the user can enter a different cell spacing to be used for each breakline. This is 
accomplished by selecting GIS Tools/Breaklines Cell Spacing Table, and then entering a user 
defined cell spacing for each breakline.

The popup editor has an option to enter where the user would like the cell centers to start, in terms 
of an upper left X and an upper left Y coordinate. These Starting Point Offset fields are not required. 
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By default it will use the upper left corner of the polygon boundary that represents the 2D flow area. 
Use of the Shift Generated Points option allows the user to shift the origin of the grid cell centers, 
and therefore the location of the cell centers. 

Figure 5 43. 2D Flow Area Computational Point Spacing Editor

After the Computational Point Spacing (DX and DY) has been entered, press the Generate Points in 
2D flow area button. Pressing this button will cause the software to compute a series of X and Y 
coordinates for the cell centers. The user can view these points by pressing the View/Edit 
Computational Point's button, which brings the points up in a table. The user can cut and paste 
these into a spreadsheet, or edit them directly if desired (It is not envisioned that anyone will edit the 
points in this table or Excel, but the option is available).

There are five additional fields on the 2D Flow Areas editor (Figure 5-42) that are used during the 2D 
pre-processing. These fields are:

Default Manning's n Value: This field is used to enter a default Manning's n values that will be used 
for the Cell Faces in the 2D Flow Area. User's have the option of adding a spatially varying landuse 
classification versus Manning's n value table (and a corresponding Land Classification layer in RAS-
Mapper), which can be used to override the base Manning's n values where polygons and roughness 
are defined. Even if a Land Use Classification versus Manning's n value table is defined, for any areas 
of the 2D Flow Area not covered by that layer, the base/default Manning's n value will be used for 
that portion of the 2D Flow Area.

Cell Volume Filter Tol: This tolerance is used to reduce the number of points in the 2D cell elevation 
volume curves that get developed in the 2D Pre-processor. Fewer points in the curve will speed up 
the computations, but reduce the accuracy of the elevation volume relationship. The default 
tolerance for filtering these points is 0.01 ft.

Face Profile Filter Tol: This filter tolerance is used to reduce the number of points that get extracted 
from the detailed terrain for each face of a 2D cell. The default is 0.01 ft.

Warning: If there is an existing computational mesh and the "Generate Points in 2D Flow Area" 
option is used, all of the existing mesh points will be replaced with the newly generated points. 
Any hand editing that was done by the user will be lost.
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Face Area-Elev Filter Tol: This filter tolerance is used to reduce the number of points in the cell face 
hydraulic property tables. Fewer points in the curves will speed up the computations, but reduce the 
accuracy of the face hydraulic property relationships. The default is 0.01 ft.

Face Conveyance Tol Ratio:This tolerance is used to figure out if more or less points are required at 
the lower end of the face property tables. It first computes conveyance at all of the elevations in the 
face property tables. It then computes the conveyance at an elevation half way between the points 
and compares this value to that obtained by using linear interpolation (based on the original points). 
If the computed value produces a conveyance that is within 2% (0.02) of the linear interpolation 
value, then no further points are needed between those two values. If linear interpolation would 
produce a value of conveyance that is more than 2% from the computed value at that elevation, then 
a new point is added to that table. This reduces the error in computing hydraulic properties, and 
therefore conveyance due to linear interpolation of the curves. A higher tolerance will results in 
fewer points in the hydraulic property tables of the cell faces, but less hydraulic accuracy for the flow 
movement across the faces. The default value is 0.02, which represents a 2% change.

Face Laminar Depth: This field is used to define the depth of water at which turbulent flow would 
transition to laminar flow for sheet flow flowing over a plane. The default is 0.2 feet.
Once a nominal grid size has been selected and a base Manning's n-value has been entered, the user 
should press the OK button to accept the data and close the editor. When the OK button is selected 
the software automatically creates the computational mesh and displays it in the Geometric Data 
Editor graphics window (See Figure 5-44).

Figure 5 44. Example 2D computational mesh for an interior of a levee protected area.
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As mentioned previously, cells around the 2D Flow Area boundary will be irregular in shape, in order 
to conform to the user entered polygon. The mesh generation tools utilize the irregular boundary, as 
well as try to ensure that no cell is smaller in area than the nominal cell size. The cells around the 
boundary will be equal to or larger than the nominal cell size; therefore, if a boundary cell is going to 
be smaller than the nominal cell size it gets combined with a neighbor cell. Additionally, breaklines 
can be placed inside of a 2D Flow Area in order to align the mesh to a geometric feature (levee, road, 
etc…) Shown in Figure 5-45, is a zoomed in view of a mesh with break lines on top of levees. 

Figure 5 45. Zoomed in view of the 2D Flow Area computational mesh.

The HEC-RAS terminology for describing the computational mesh for 2D modeling begins with the 2D 
Flow Area. The 2D Flow Area defines the boundary for which 2D computations will occur. A 
computational mesh (or computational grid) is created within the 2D Flow Area.

Each cell within the computational mesh has the following three properties:

Cell Center:The computational center of the cell. This is where the water surface is computed for the 
cell.

Cell Faces:These are the cell boundary faces. Faces are generally straight lines, except along the 
outer boundary of the 2D Flow Area, in which a cell face can be a multi-point line.

Cell Face Points:The cell Face Points (FP) are the ends of the cell faces. Later on in this document 
the Face Point (FP) numbers for the outer boundary of the 2D Flow Area will be used to hook the 2D 
Flow Area to a Lateral Structure.
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Figure 5 46. Description of HEC-RAS 2D modeling computational mesh terminology. 

Edit/Modify the Computational Mesh 
The computational mesh will control the movement of water through the 2D flow area. Specifically, 
one water surface elevation is calculated for each grid cell center at each time step. The 
computational cell faces control the flow movement from cell to cell. Within HEC-RAS, the 
underlying terrain and the computational mesh are preprocessed in order to develop detailed 
elevation–volume relationships for each cell, and also detailed hydraulic property curves for each 
cell face (elevation vs. wetted perimeter, area, and roughness). By creating hydraulic parameter 
tables from the underlying terrain, the net effect is that the details of the underlying terrain are still 
taken into account in the water storage and conveyance, regardless of the computational cell size. 
However, there are still limits to what cell size should be used, and important considerations for 
where smaller detailed cells are needed versus larger coarser cells.

In general, the cell size should be based on the slope of the water surface in a given area, as well as 
barriers to flow within the terrain. Where the water surface slope is flat and not changing rapidly, 
larger grid cell sizes are appropriate. Steeper slopes, and localized areas where the water surface 
elevation and slope change more rapidly will require smaller grid cells to capture those changes. 
Since flow movement is controlled by the computational cell faces, smaller cells may be required to 
define significant changes to geometry and rapid changes in flow dynamics.
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The computational mesh can be edited/modified with the following tools: break lines; moving 
points; adding points, and removing points.

Break Lines

The user can add new break lines at any time. HEC-RAS allows the user to enter a new break line on 
top of an existing mesh and then regenerate the mesh around that break line, without changing the 
computational points of the mesh in other areas. The user can draw a new break line, then left click 
on the break line and select the option Enforce Break line in 2D Flow Area. Once this option is 
selected, new cells will be generated around the break line with cell faces that are aligned along the 
break line. Any existing cell centers that were already in the mesh in the area of the break line are 
remove first (within a buffer zone around the break line, based on the cell size used around the break 
line). 
Additionally the user can control the size/spacing of cells along the break line. To control the cell 
spacing along a break line, right click on the break line and select the option Edit Break Line Cell 
Spacing. A window will appear allowing the user to enter a minimum and maximum cell spacing to 
be used when forming cells along that break line. The minimum cell spacing is used directly along 
the break line. The software will then increase the cell size around the break line, in order to provide 
a gradual cell size transition from the break line to the nominal cell size being used for the mesh. The 
user can enter a Maximum cell size if desired. If no maximum cell size is entered, the software 
automatically transitions the cells from the minimum cell size around the break line, to the default 
mesh cell size. To enforce the new cell spacing, the user must select the Enforce Break line in 2D Flow 
Area option, after entering the break line cell spacing. Break line cell spacing's are saved, such that if 
the mesh is regenerated, the user defined break line cell spacing will automatically be used. User can 
also bring up a table that will show all of the break lines and any user entered break line cell spacing 
values. To open this table, select GIS Tools, then Break Lines Cell Spacing Table. Once the table is 
open, users can add or change break line cell spacing values from the table. Then if the user 
regenerates the whole mesh, or just the area around a specific break lines, the new break line cell 
spacing will be used.
When creating a mesh around a break line, it may be desirable or even necessary to use smaller cells 
than the nominal cell size used in other areas of the mesh. However, transitions from a larger cell 
size immediately to a smaller cell size, may not produce the most accurate computational model. So 
it is better to transition cell sizes gradually. The HEC-RAS mesh generation tools allow the user to 
enter a minimum and a maximum cell spacing to use around break lines. The mesh generation tools 
will automatically transition from the smaller cell size right at the break line to the larger cell size 
away from the break line.

Hand Based Mesh Editing Tools

The hand editing mesh manipulation tools are available under the Edit menu of the HEC-RAS 
Geometric Data editor. If the user selects Edit then Move Points/Object, the user can select and move 
any cell center or points in the bounding polygon. If a cell center is moved, all of the neighboring 
cells will automatically change due to this movement. If the user selects Edit then Add Points, then 
wherever the user left-clicks within the 2D flow area, a new cell center is added, and the neighboring 
cells are changed (once the mesh is updated). The software creates a local mesh (Just the area 
visible on the screen, plus a buffer zone), such that while you are editing, just the local mesh will get 
updated. The entire mesh only updates once the user has turned off the editing feature, which saves 
computational time in creating the new mesh. If the user selects Edit then Remove Points, then any 
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click near a cell center will remove that cell's point, and all the neighboring cells will become larger 
to account for the removed cell. 
The user may want to add points and move points in areas where more detail is needed. The user 
may also want to remove points in areas where less detail is needed. Because cells and cell faces are 
preprocessed into detailed hydraulic property tables, they represent the full details of the underlying 
terrain. In general, the user should be able to use larger grid cell sizes than what would be possible 
with a model that does not preprocess the cells and the cell faces using the underlying terrain. Many 
2D models simply use a single flat elevation for the entire cell, and a single flat elevation for each cell 
face. These types of 2D models generally require very small computational cell sizes in order to 
model the details of the terrain. 
HEC-RAS makes the computational mesh by following the Delaunay Triangulation technique and 
then constructing a Voronoi diagram (see Figure 5-47 below, taken from the Wikimedia Commons, a 
freely licensed media file repository):

Figure 5 47. Delaunay - Voronoi diagram example.

The triangles (black) shown in Figure 18 are made by using the Delaunay Triangulation technique 
(http://en.wikipedia.org/wiki/Delaunay_triangulation  ). The cells (red) are then made by bisecting 
all of the triangle edges (Black edges), and then connecting the intersection of the red lines (Voronoi 
Diagram). This is analogous to the Thiessen Polygon method for attributing basin area to a specific 
rain gage.

You may want to add points and move points in areas where you need more detail. You may also 
want to remove points in areas where you know you need less detail. Because cells and cell faces are 
pre-processed into detailed hydraulic property tables, they represent the full details of the 

http://en.wikipedia.org/wiki/Delaunay_triangulation
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underlying terrain. In general, you should be able to get away with larger grid cell sizes than what 
you would be able to with a model that does not do this pre-processing of the cells and the cell faces 
using the underlying terrain. Many 2D models simply use a single flat elevation for the entire cell, and 
a single flat elevation for each cell face. These types of 2D models generally require very small 
computational cell sizes in order to model the details of the terrain.

Storage Area and 2D Flow Area Connections

 
Storage Area/2D Flow Area connections (SA/2D Area Conn) are used to link two storage areas 
together with a hydraulic structure, or two 2D Flow Areas, or a storage area to a 2D Flow Area. The 
SA/2D Area Conn tool can also be used to place a hydraulic structure in the middle of a 2D Flow Area 
in order to control how flow travels from one series of cells to another series of cells. The SA/2D Area 
Conn has three Structure Type options: 1) Weir, Gates, Culverts, Outlet RC and Outlet TS; 2) Linear 
Routing option (The Linear Routing option is for storage areas only, not 2D Flow Areas); or 3) Bridge 
(internal to a 2D Flow Area). To establish a hydraulic connection between two storage areas, 2D flow 
areas; or inside of a 2D Flow Area, press the "SA/2D Area Conn" button at the top of the geometric 
data window. Once the storage area connection drawing tool is invoked, the user simple presses the 
left mouse button one time to start drawing the centerline of the hydraulic structure. Continue left 
clicking to digitize the centerline of the hydraulic structure, then double click to end. This structure 
should be drawn from left to right while looking in the positive flow direction (i.e. downstream). If 
this structures is drawn between two storage areas, a storage area and a 2D flow area, or between 
two 2D flow areas, the user will need to define the From and To locations within the SA/2D Area 
Connection editor. If the structure is drawn completely inside of a single 2D Flow Area, then the To 
and From connections are automatically set to the 2D area.

Once a SA/2D Area Connection is drawn, the user must enter information describing the hydraulics of 
the connection. This is accomplished by pressing the SA/2D Area Conn editor button on the left 
hand side of the geometric data editor. When this button is pressed, the following window will 
appear:

https://www.hec.usace.army.mil/confluence/display/R2DUM/.Modeling+Bridges+Inside+2D+Flow+Areas+v6.5
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SA/2D Area Connection Editor

As shown in the figure above, this example is for a hydraulic structure connecting a storage area to a 
2D Flow Area. The user should first enter a description for the SA/2D area connection. Next the From
and To connections must be set correctly. After that the user should select the Structure Type from 
the drop down box. As mentioned previously, the user has the choice of three different structure 
types: 1) Weir, Gates, Culverts, Outlet RC and Outlet TS; 2) Linear Routing option (The Linear Routing 
option is for storage areas only, not 2D Flow Areas); or 3) Bridge (internal to a 2D Flow Area). Once a 
structure type is selected, the window will place editor buttons specific to that type of structure onto 
the left side of the editor. In this example, the default structure type (Weir, Gates, Culverts, etc.) is 
shown on the window.
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Note: The user also has the option to perform a breaching analysis of any SA/2D Flow Area 
connection. The breach data is stored in the currently opened Plan, however, the user can get to the 
breach editor by pressing the button labeled "Breach (plan data)" on this editor. Breach information 
for a SA/2D Flow Area is the same as for a Dam or a levee breaching analysis.

Weir Embankment Editor
The user must enter data for the Weir/Embankment editor at a minimum. The other editors (gates, 
culverts, rating curves, and time series outlet) are optional. In this example data was entered for 
weir/embankment and Culverts. When the weir/embankment editor is selected, the window shown 
below will appear.

Weir/Embankment Editor for Storage Area Connections

To complete the data for the weir/embankment, the user enters a Weir Width (used only for drawing 
the schematic); a Weir Coefficient (used in the weir flow calculations); a Weir Crest Shape (used to 
assist in the calculation of the weir coefficient, as well as defining submergence criteria); and the 
Station/Elevation Points that describe the top of the weir/embankment profile. The weir/
embankment can have up to 500 points to describe the profile. The program will use all of the 
information entered by the user for calculating weir flow between the two storage areas. After all of 
the data is entered, simply press the OK button to have the data accepted by the program.

Culvert Data Editor
When the culvert editor button is selected, the following window will appear.
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The culvert editor shown above has exactly the same information as the normal culvert editor used 
at a 1D river crossing. For detailed information about this editor, please review the Bridge/Culverts 
section found earlier in this document.

If the user is connecting Culverts to 2D Flow Areas, it may be advantageous to define coordinates for 
each of the culvert barrels. This will allow you to connect the ends of a barrel to a specific cell. In the 
Culvert Data Editor there is a button on the lower left portion of the editor labeled "Individual 
Barrel Centerlines". This new button opens the Edit GIS Data Table editor, for entering the X and Y 
coordinates for the centerline of each culvert barrel added to the model, which allow users to view 
the barrels spatially. [Note: Separate centerlines must be added even for identical barrels within the 
same culvert group, and the barrels may also be connected to different cells.]

All Culvert centerlines (as well as gates, rating curves, and flow time series outlets), must be drawn 
from upstream to downstream. Keep in mind that is how the original centerline of the SA/2D Area 
Connection is drawn which defines upstream and downstream. Therefore, when users draw the 
centerline for the SA/2D Area Connection, it is drawn from left to right looking in the downstream 
direction. Based on that convention, when the centerlines for the hydraulic outlets (culverts, gates, 
rating curves, etc.) are drawn, yet again the centerlines must be drawn from the upstream side of the 
structure to the downstream side of the structure. For the example provided in, the structure being 
used to model the levee was drawn from the south end of the levee to the north end of the levee. 
Therefore, the culverts were drawn from the right hand side of the structure (head water) to the left 
hand side of the structure (tailwater).
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If the user presses the button labeled "Individual Barrel Centerlines" from the Culvert Data Editor, 
the EditGISDataTable centerline coordinate editor opens.

As shown in the figure below, The Feature Centerline Table contains the centerline X and Y 
coordinate data for all of the structures in the model. When the Edit GIS Data Table editor is 
opened, it will highlight the culvert that was open and selected in the Culvert Data Editor. To use 
this editor, from the Features table (located on the left of the editor), select a single culvert barrel 
(highlight it), and then past in the X and Y coordinates for the barrel into the data table (on the right 
hand side of the editor). Hint: The easiest way to define the culvert barrel X and Y centerline 
coordinates is to go back to the Geometric Data editor, hold down the Ctrl key, and digitize the 
culvert barrel centerline from the headwater side of the structure to the tailwater side of the 
structure. This digitized line can be copied to the clipboard from the Measure Line editor that pops 
up once digitizing the line is complete. Once all of the barrel coordinates have been entered, close all 
of the SA/2D Area Connection windows, and the digitized culvert(s) will appear in the Geometric 
Data editor window. Additionally, there is an option to import the culvert X and Y centerline 
coordinates at the bottom of the editor.

Note: In HEC-RAS, the process for adding centerline X and Y coordinates for individual hydraulic 
outlets (gates, rating curves and flow time series, etc.) is exactly the same as described above for 
culverts.
If the user is connecting a storage area to another storage area, an additional button will appear on 
the editor labeled "Htab Param". This editor is used to define the limits of the family of rating curves 
that will be developed for the storage area to storage area connection. When this button is pressed, 
the following editor will appear: 
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As shown in figure above, the user must enter a number of points for the free flow curve (default is 
50, max 80); number of submerged curves (default is 50, max 60); number of points on the 
submerged curves (default is 20, max 50); and head water maximum elevation. Additionally, the user 
can enter a tailwater maximum elevation and a maximum flow rate. All of these parameters are used 
to define the limits of the family of rating curves that get created when the geometric pre-processor 
runs.

Gate Data Editor
If the user has decided to use the Gates option, pressing this button will bring up the window shown 
in the figure below. This editor is the same gate editor that is used for inline and lateral gated 
spillways. For information about this editor, please review the sections on inline gated spillways 
found earlier in this chapter.
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Gated Spillway Editor for Storage Area Connections

Diversion Rating Curve
Diversion rating curves are used to remove flow from a main river. The diversion, rating curve can be 
used in conjunction with a lateral weir, gated structures, and culverts, or it can be used alone.
To add a diversion, rating curve to the system, press the "Diversion Rating Curve" button on the left 
hand side of the Lateral Structure editor, shown below.
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Lateral Rating Curve Editor

The user first selects the type of rating to be used: channel water surface versus diverted flow or 
channel flow versus diverted flow. Next, the distance between the location of the diversion and the 
cross section just upstream of the structure must be entered in order to locate the diversion. Finally, 
the user enters the actual rating curve. The curve is entered as the amount of flow leaving, verses the 
elevation of the water in the main river or flow in the main river. NOTE: This rating curve does not 
take into account any influence of the tailwater elevation in order to reduce the flow.

Outlet Time Series
This option allows the user to specify a name for an Outlet time series. Then a Flow Hydrograph can 
be specified for the Lateral Structure in the Unsteady Flow Data editor. The flow time series will be 
labeled in the output based on the user entered name for the Outlet Time series.

Linear Routing Option
The final option for connecting a Storage Area to another Storage Area is to model the connection as 
a Linear Routing Method. This option uses a coefficient times the difference in available storage 
between the two storage areas, divided by the time step. 
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Simple Spillway Data Editor

As shown in the Linear Routing editor, the user must enter a linear routing coefficient for both the 
positive and negative flow directions. Additionally, the minimum elevation of the spillway crest must 
be entered. If both water surfaces go below the spillway crest, no flow is passed between the storage 
areas. The Linear routing option can only be used to connect two storage areas. It cannot be used 
when one of the connections is a 2D Flow Area.

2D Flow Area and Storage Area External Boundary Conditions

 
User can define boundary condition location lines spatially along 2D Flow Areas and storage areas. 
This is accomplished using the SA/2D Area BC Lines drawing tool on the Geometric Data editor Tools 
button bar. To use this option, select the SA/2D Area Conn tool button at the top of the geometric 
data editor, then draw a line along the outer boundary of the 2D flow Area (or storage area) where 
you want the boundary condition to be located. Once the line is drawn the interface will ask you to 
enter a unique name for the boundary condition line. After you have drawn all the boundary 
condition lines you want along 2D flow Areas and Storage areas, save the geometry data. Then you 
can go into the Unsteady Flow Data editor and define the boundary condition types/data for each of 
these boundary condition lines. 

Pump Stations

 
A pump station can be used to pump water between two storage areas, a storage area and a river 
reach, between two river reaches, a river reach and a 2D Flow Area, a Storage Area and a 2D Flow 
Area, between two 2D Flow Areas, or from one cell to another cell within the same 2D Flow Area. 
Each pump station can have up to ten different pump groups, and each pump group can have up to 
twenty identical pumps. To add a pump station to the system, select the Pump Station drawing tool 
at the top of the geometric data editor. When this button is pressed, move the mouse to the location 
that represents where the pump station will be located, and click the left mouse button. An editor 
will pop up asking you to enter a name for the Pump Station.  This will establish a pump station 
location and Icon.
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Once a pump station is added to the system, the user must edit the pump station and fill in the 
required data. To bring up the pump station editor, select the pump station editor button on the left 
hand side of the geometric data editor, or move the mouse over the pump station icon on the 
schematic, press down on the left mouse button, then select Edit Pump Station. When the Pump 
Station editor is selected, the following window will appear:

Figure 5 56 Pump Station Editor with Pump Connection Data

As shown in Figure 5 56, there are three tabs on the pump station editor, the first is for the pump 
connection data, the second is for the pump group data, and the third is for applying advanced rule 
controls over the pump station. The Pump Connection Data contains the following data:

Rename Pump Station: This option allows the user to rename the pump station to something other 
than the default.

Pump Inlet: This is the location of where the pump station is pumping from. This can be either a 
storage area, 2D Flow Area, or a river station from a river reach. The Set RS button allows the user to 
connect a pump from a river station of a reach, the Set SA/2D button allows the pump to be 
connected from a Storage Area or a 2D Flow Area.
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Pump Outlet: This is the location of where the pump station is pumping to. This can be either a 
storage area or 2D Flow Area (use Set SA/2D button) or a river station from a river reach (use Set RS 
button).

Optional On-Off Monitor Reference: By default the program uses the "Pump Inlet" location to 
determine when the pump should turn on or off. However, the user has the option to set a different 
location to be used as the monitor point for determining whether the pump should be turned on or 
off. This optional monitor location can be a storage area, 2D Flow Area (if you are using a 2D Flow 
Area, you must add a reference point into the geometry data within that 2D flow Area); or a river 
station within a river reach.

Highest elevation in pump line: This option allows the user to enter an elevation to be used as the 
highest elevation in the pump line. One example of where this may be useful is if a pump station was 
being used to pump water over top of a levee. In this situation, the too and from water surface 
elevations does not completely quantify the required head to pump the water over the levee. So it is 
necessary to enter the elevation of the highest point in the pump line (top of the levee) in order to 
accurately compute the flow going through the pump.

Steady Flow Optimization: This option is for steady flow modeling only. If water is being pumped 
from or to a river reach, the amount of flow going into or out of the reach should be accounted for 
when computing the water surface profiles. However, the water surface profiles will affect the 
computation of the amount of flow through the pumps. Therefore, to calculate this accurately, the 
pump flow and water surface profiles must be calculated iteratively until a balance is found between 
the river flows and the pump flows. This optimization feature is not done automatically by the steady 
flow program, however, the user can have the program do this by selecting Steady flow 
optimization. When this option is selected, a window will appear allowing the user to turn the pump 
flow optimization on.
In addition to the pump connection data the user must fill out the pump group data. Select the 
Pump Group Data tab and the editor will look like the following (Figure 5-57):
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Figure 5 57 Pump Station Editor with Pump Group Data

As shown in Figure 5-57, the pump group data consists of the following:

Pump Group Name: By default the first pump group is called "Group #1", and the second would be 
"Pump Group #2", etc. The user has the option to rename any pump group to whatever they would 
like. This is done by pressing the "Rename Group" button.

Add Group: This button is used to add another pump group. If you have pumps that have different 
flow capacities and use different pump efficiency curves, they must be entered as a separate pump 
group.

Rename Group: This allows you to rename a pump group.

Delete Group: This button is used to delete the current pump group.

Bias group operations to on (Steady Flow Only): This option is only relevant for a steady flow run. 
When this option is selected, and a particular water surface profile is between the on and off 
elevation for a pump, the program will assume the pump is turned on. If this option is not checked, 
then the program will assume the pump is off when the water surface is between the on and off 
elevations.
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Startup (min): This option is used for unsteady flow only. When a pump is triggered to turn on, the 
default operation is that the pump turns on instantly and starts pumping to full capacity the very 
next time step. This option allows the user to enter a start up time in which the pumps will transition 
from zero flow to full capacity over the user entered time step in minutes. This option is very useful 
to prevent the unsteady flow computations from going unstable when to large of a flow change is 
experienced from a pump turning on.

Shutdown (min): This option is used for unsteady flow only. When a pump is triggered to turn off, the 
default operation is that the pump turns off instantly and stops pumping the very next time step. 
This option allows the user to enter a shut down time in which the pumps will transition from full 
capacity to zero flow over the user entered time step in minutes. This option is very useful to prevent 
the unsteady flow computations from going unstable when to large of a flow change is experienced 
from a pump turning off so abruptly.

Pump Width: This field is only used for drawing the width of the pump line onto the geometric data 
window.

Number of Pumps in Group: This field is used to enter the number of identical pumps in the current 
pump group. Identical pumps must use the same pump efficiency curve but can have different on 
and off trigger elevations.

Pump Efficiency Curve: This table is used to enter the pump efficiency curve, which is a table of static 
heads versus flow rates. The head represents the total head in the system, which is normally the 
difference in the water surface elevations between the from and the to location. Note: The entered 
flow is the pump rate capacity at that particular head. In HEC-RAS, the flows entered for a 
given head difference, must already account for all energy losses in the pump line (friction, 
bends, junctions, etc…). Do not enter the rated pump curve from the manufacturer, that curve 
does not account for losses in the pump line. An example of how to compute a pump efficiency curve 
is shown in Figure 5-58 below. As shown in Figure 5-58, the user must compute all energy losses in 
the system, between the two static pools. The energy losses in the line are subtracted from the 
manufacturer pump efficiency curve to get the curve for use in HEC-RAS. The pump efficiency curve 
can be plotted for visual inspection by pressing the Plot Pump Curves button at the bottom of the 
window.
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Pump Efficiency Curve for HEC-RAS

Pump Operations: This table is used to define the trigger elevations for when the pumps will turn on 
and off. The monitor location for triggering a pump on or off is by default the from location, unless 
otherwise specified in the Optional On-Off Reference field. In general, the pump on elevation must 
be higher than the pump off elevation. Trigger elevations must be specified for all of the pumps. If 
the user puts the pump off elevation higher than the pump on elevation, then the pump turns on 
when the water surface goes below the on elevation, and the pump remains on until the water 
surface gets higher than the pump off elevation. This would be for example, pumping water up to a 
storage tank. When the pump off elevation is lower than the pump on elevation (typical way of using 
it), the pump turns on when it goes above the on elevation, and the pump turns off when it goes 
below the off elevation. This is the typical use of the pumps for interior ponding areas.

The bottom half of the window shows a table with all the individual pumps in the group. The table 
contains the following:

Pump Name: This field contains the name of each of the individual pumps. Pumps are automatically 
names "Pump #1", then "Pump #2", etc. The user can double click in the Pump Name field and 
change these names to be more specific to the location.

WS Elev On: This is the elevation at which the pump will be turned on. This is based on the elevation 
of the water surface at the "Inlet" location connected to the pump.

WS Elev Off: This is the elevation at which the pump will be turned off. This is based on the elevation 
of the water surface at the "Inlet" location connected to the pump.

Pump GIS Data: Another table directly to the right of the individual Pump Name table, is a table 
containing the GIS coordinates of the individual pumps. If the user clicks on a pump row in the Pump 
Names table (ex, if Pump #1 was selected), then the X, Y coordinates in the

Pump Coordinates table are for Pump #1. If another Pump is selected, then the X, Y coordinates will 
be for that pump. Entering X, Y coordinates for a pump is only need when connecting pumps to 2D 
Flow Areas. This is required in order to figure out which cell(s) the pump is connected to in the 2D 
Flow Area. User must draw a spatial line that goes from the Pump Inlet to the Pump Outlet. This line 
will be used to show the Pump connection spatially in the Geometric Data editor, as well as establish 
which cell the pump is connected to. X, Y coordinates are not required if you are not connecting 
pumps to a 2D Flow Area. But if even one end of the pump is connected to a 2D Flow Area, the X, Y 
coordinates are required.

The final tab, labeled Advanced Control Rules, is an optional tab used to specify rules that will 
override the physical pump data. When this tab is selected the editor will appear as follows:
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5 59. Pump Editor with Advanced Control Rules Tab Selected.

As shown in the Figure 5-59 the Advanced Control Rules tab has three buttons at the top of the 
editor, Add New Rule; Delete Rule, and Copy Rule. The Delete Rule button will delete the currently 
selected rule from the list of pump rules shown in the text box labeled Pump Rules. The Copy Rule 
button makes a copy of the currently opened rule. The Add New Rule button allows the user to enter 
a new rule. When this button is selected an editor will appear as shown below:

5 60. Rule Types Editor.
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As shown in Figure 5-60, there are six types of rules that can be applied to a pump station. Each of 
the six rule types allow the user to specify a minimum and maximum flow for the entire pump 
station. This minimum and maximum flow will narrow the range of possible flows that have been 
computed for the pump station based on the physical pump data. The rule types only differ in how 
and when the minimum and maximum flow range gets applied.

The first rule type, Always apply this rule, is applied at for all time steps in the solution. The second 
rule type, Apply Based on Target Flow, is applied only when a target minimum and/or maximum 
flow is exceeded (flow is greater than specified maximum or less than specified minimum) at a user 
specified flow monitoring location. The flow monitoring location can be a cross section within a river 
reach, or a storage area. The third rule type, Apply based on target WS, is applied only when a 
target minimum and/or maximum water surface elevation is exceeded (stage is greater than 
specified maximum or less than specified minimum) at a user specified stage monitoring location. 
The fourth rule type, Apply based on Day/Hour, is only applied only during a user specified time 
window. The user enters a starting day and time, and an ending day and time. The specified 
maximum and minimum flows are then applied to the pump station only during the user specified 
time window. The fifth rule type, Apply based on day/hour and flow, is a combination of a user 
specified time window, and a maximum and/or minimum flow target at a user specified flow 
monitoring location. The last rule type, Apply based on day/hour and WS, is a combination of a user 
specified time window, and a maximum and/or minimum stage target at a user specified stage 
monitoring location.

The user can also apply a transition time in minutes to the maximum and minimum flow for each of 
the rules. Therefore if a rule will change the flow from the currently computed value to a user 
entered maximum, the transition time is used to allow for the flow change to occur over a user 
specified time. This same concept is used for the minimum flow rate also.

The user can specify as many rules as they want for each pump station. The rules will be applied to 
the pump station in the order that they have been entered (which is also the order in which they 
appear in the editor). The user can move a rule up or down in the list by highlighting a rule, then 
using the up and down arrow buttons to move the rule.

After all of the pump data are entered, press the OK button to have the data excepted by the 
program. This does not save the data to the hard disk, it only allows it to be used in the current 
execution of the program. To save the data permanently, you must save the geometry data from the 
File menu of the Geometric Data Editor.

Cross Section Interpolation
Occasionally it is necessary to supplement surveyed cross section data by interpolating cross 
sections in between two surveyed sections. Interpolated cross sections are often required when the 
change in velocity head is too large to accurately determine the energy gradient. An adequate 
depiction of the change in energy gradient is necessary to accurately model friction losses as well as 
contraction and expansion losses.

Cross section interpolation can be accomplished in three ways from within the HEC-RAS interface. 
The first method is to simply copy one of the bounding cross sections and then adjust the station 
and elevation data. The cross section editor allows the user to raise or lower elevations and to shrink 
or expand various portions of any cross section. The second and third options allow for automatic 
interpolation of cross section data. From the Geometric Data editor, automatic interpolation options 
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are found under the Tools menu bar as shown in Figure 5-61.

Figure 5 61 Automatic Cross Section Interpolation Options

The first cross section interpolation option, Within a Reach, allows for automatic interpolation over 
a specified range of cross sections within a single reach. When this option is selected, a window will 
pop up as shown in Figure 5-62. The user must first select the River and Reach that they would like to 
perform the interpolation in. Next the user must select a starting River Station and an ending River 
Station for which interpolation will be performed. The user must also provide the maximum 
allowable distance between cross sections. If the main channel distance between two sections is 
greater than the user defined maximum allowable, then the program will interpolate cross sections 
between these two sections. The program will interpolate as many cross sections as necessary in 
order to get the distance between cross sections below the maximum allowable. Additionally the 
user can specify the number of decimal places used for the stationing and elevations of the 
interpolated cross sections.

Cut Line GIS Coordinates. When cross sections are interpolated, there location on the river system 
schematic is also interpolated. HEC-RAS has two options for interpolating the coordinates of the 
cross section cut lines: Linear Interpolation cut lines from the bounding XS's and Generate for 
display as perpendicular segments to reach invert. The default method is linear interpolation 
from the bounding cross sections. This method simply draws straight lines between the two cross 
sections and interpolates the cross section coordinates based on main channel distance. The second 
method (perpendicular segments to the reach invert line) scales the cross sections along the river 
reach invert line. A perpendicular segment across the river reach is drawn for the main channel. 
However, the overbanks are based on average slopes of the invert line upstream and downstream 
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from the point of intersection. 

Figure 5 62 Automatic Cross Section Interpolating Within a Reach

Once the user has selected the cross section range and entered the maximum allowable distance, 
cross section interpolation is performed by pressing the Interpolate XS's button. When the program 
has finished interpolating the cross sections, the user can close the window by pressing the Close
button. Once this window is closed, the interpolated cross sections will show up on the river 
schematic as light green lines. The lighter color is used to distinguish interpolated cross sections 
from user-entered data. Interpolated cross sections can be plotted and edited like any other cross 
section. The only difference between interpolated sections and user-defined sections is that 
interpolated sections will have an asterisk  attached to the end of their river station identifier. This 
asterisk will show up on all input and output forms, enabling the user to easily recognize which cross 
sections are interpolated and which are user defined.

The second type of automatic cross section interpolation, Between 2 XS's, allows the user to have 
much greater control over how the interpolation is performed. When this option is selected, a Cross 
Section Interpolation window will appear as shown in Figure 5-63.
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Figure 5 63 Detailed Cross Section Interpolation Window

This cross section interpolation window displays only two cross sections at a time. The user can get 
to any two cross sections from the River, Reach and River Station boxes at the top of the window. 
Interpolated cross section geometry is based on a string model as graphically depicted in Figure 561. 
The string model consists of chords that connect the coordinates of the upstream and downstream 
cross sections. The cords are classified as master and minor cords. As shown in Figure 5-63, five 
master cords are automatically attached between the two cross sections. These master cords are 
attached at the ends of the cross sections, the main channel bank stations, and the main channel 
inverts. Minor cords are generated automatically by the interpolation routines. A minor cord is 
generated by taking an existing coordinate in either the upstream or downstream section and 
establishing a corresponding coordinate at the opposite cross section by either matching an existing 
coordinate or interpolating one. The station value at the opposite cross section is determined by 
computing the decimal percent that the known coordinate represents of the distance between 
master cords and then applying that percentage to the opposite cross section master cords. The 
number of minor cords will be equal to the sum of all the coordinates of the upstream and 
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downstream sections minus the number of master cords. Interpolation at any point in between the 
two sections is then based on linear interpolation of the elevations at the ends of the master and 
minor cords. Interpolated cross sections will have station and elevation points equal to the number 
of major and minor cords.

This interpolation scheme is used in both of the automated interpolation options ("Within a Reach" 
and "Between 2 XS's"). The difference is that the Between 2 XS's option allows the user to define 
additional master cords. This can provide for a better interpolation, especially when the default of 
five major cords produces an inadequate interpolation. An example of an inadequate interpolation 
when using the default cords is shown below.

Figure 5 64 Cross Section Interpolation Based on Default Master Cords

As shown in Figure 5-64, the interpolation was adequate for the main channel and the left overbank 
area. The interpolation in the right overbank area failed to connect two geometric features that 
could be representing a levee or some other type of high ground. If it is known that these two areas 
of high ground should be connected, then the interpolation between these two sections should be 
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deleted, and additional master cords can be added to connect the two features. To delete the 
interpolated sections, press the Del Interp button.
Master cords are added by pressing the Master Cord button that is located to the right of the 
Maximum Distance field above the graphic. Once this button is pressed, any number of master cords 
can be drawn in. Master cords are drawn by placing the mouse pointer over the desired location (on 
the upper cross section), then while holding the left mouse button down, drag the mouse pointer to 
the desired location of the lower cross section. When the left mouse button is released, a cord is 
automatically attached to the closest point near the pointer. An example of how to connect master 
cords is shown in Figure 5-65.

Figure 5 65 Adding Additional Master Cords for Interpolation

User defined master cords can also be deleted. To delete user defined master cords, press the 
scissors button to the right of the master cords button. When this button is pressed, simply move 
the mouse pointer over a user defined cord and click the left mouse button to delete the cord.
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Once you have drawn in all the master cords that you feel are required, and entered the maximum 
distance desired between sections, press the interpolate button. When the interpolation has 
finished, the interpolated cross sections will automatically be drawn onto the graphic for visual 
inspection. An example of this is shown in Figure 5-66.

Figure 5 66 Final Interpolation with Additional Master Cords

As shown in Figure 5-66, the interpolation with the addition of user defined master cords is very 
reasonable.

In general, the best approach for cross section interpolation is to first interpolate sections using the 
"Within a Reach" method. This provides for fast interpolation at all locations within a reach. The 
"Within a Reach" method uses the five default master cords, and is usually very reasonable for most 
cross sections. Once this is accomplished, all of the interpolated sections should be viewed to ensure 
that a reasonable interpolation was accomplished in between each of the cross sections. This can be 
done from the "Between 2 XS's" window. Whenever the user finds interpolated cross sections that 
are not adequate, they should be deleted. A new set of interpolated cross sections can be developed 
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by adding additional master cords. This will improve the interpolation.
An additional option available in the "Between Two XS's" interpolation method is the ability to 
specify a constant distance for interpolation and to specify a specific location to interpolate a cross 
section. The Constant Distance option allows the user to put in a distance. This distance will be 
used to interpolate cross sections starting from the upstream cross section and moving downstream. 
Once the user entered distance can no longer be met between the two cross sections, then 
interpolation stops. The second option, Set Location (ft), allows for the interpolation of a single 
cross section at a specified distance from the upstream cross section.

CAUTION: Automatic geometric cross section interpolation should not be used as a replacement for 
required cross section data. If water surface profile information is required at a specific location, 
surveyed cross section data should be provided at that location. It is very easy to use the automatic 
cross section interpolation to generate cross sections. But if these cross sections are not an 
adequate depiction of the actual geometry, you may be introducing error into the calculation of the 
water surface profile. Whenever possible, use topographic maps to assist you in evaluating whether 
or not the interpolated cross sections are adequate. Also, once the cross sections are interpolated, 
they can be modified just like any other cross section.

If the geometry between two surveyed cross sections does not change linearly, then the interpolated 
cross sections will not adequately depict what is in the field. When this occurs, the modeler should 
either get additional surveyed cross sections, or adjust the interpolated sections to better depict the 
information from the topographic map.

River Ice
The current version of HEC-RAS allows the user to model ice-covered channels. This section of the 
user's manual will describe how to enter the data describing the ice cover and the ice cover 
properties. If the ice cover geometry is known, that is, if the ice cover thickness and roughness are 
known throughout the reaches of interest, the user can supply these data and describe the ice cover 
directly. If the ice cover results from a wide-river type jam, HEC-RAS will estimate the jam thickness 
in reaches where the ice jam occurs. In this case, the user can supply the material properties of the 
jam or use the default values. To find out how to view specific results for a channel with an ice cover, 
see Chapter 9 of this User's manual.

Entering and Editing Ice Data
River ice data can be entered in two ways: by using the Add Ice Cover option under the Options
Menu found at the top of the Cross Section Data Editor, or by using Tables Menu found at the top of 
the Geometric Data window. Both ways of entering data will be described below. It is important to 
remember that at least two cross sections are required to define the ice cover. A cross section should 
be placed at the upstream and downstream ends of each ice-covered reach.

Entering Ice Data at a Cross Section
To enter river ice data the user presses the Cross Section button on the Geometric Data window. 
Once the cross section button is pressed the Cross Section Data Editor will appear. See the CROSS 
SECTION DATA section of the User's Manual, for information on selecting the appropriate river, 
reach, and cross section in the Cross Section Data Editor. Once a cross section with an ice cover has 
been selected, choose the "Add ice cover..." option under the Options Menu found at the top of the 
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Cross Section Data Editor. This will open the Ice Cover Editor (see figure below). All ice data for this 
cross section can be entered with this editor.

Ice Cover Editor

Ice Cover Thickness. The ice cover thickness in the left overbank (LOB), main channel (Channel), 
and right overbank (ROB), are entered here. If there is no ice in any of these areas, a thickness of zero 
should be entered.

Ice Cover Manning's n Values. The Manning's n value of the ice cover in the left overbank (LOB), 
main channel (Channel), and right overbank (ROB), are entered here. If any part of a cross section 
has a non-zero ice thickness, a Manning's n value must be supplied.

Ice Cover Specific Gravity. The default value is 0.916. The user can supply an alternative value here.

Wide River Ice Jam. The boxes under this option are checked if this section is to be treated as a wide 
river ice jam. In this case, HEC-RAS will estimate the jam thickness using the complete ice jam force 
balance as described in the Hydraulic Reference Manual. The user can confine the jam to the main 
channel or allow the jam to be in the channel and overbank areas by checking the proper boxes. If 
the ice cover is confined to the channel, the overbanks can have a known ice thickness (including an 
ice thickness of zero) assigned to them in the Ice Cover Thickness option. If the Wide River Ice Jam 
option is selected, an ice cover thickness must be supplied for the main channel using the Ice Cover 
Thickness Option or through the Ice Tables (see below). This ice cover thickness will be used as the 
initial estimate of the ice jam thickness and will also serve as the minimum thickness allowed for the 
ice jam at that section. If the jam is allowed in the overbank areas, the channel and overbanks 
hydraulic properties will be combined to calculate a single jam thickness for the channel and 
overbanks. NOTE: A wide river jam cannot be selected for an entire river channel. A cross section 
with fixed ice cover geometry must be included at the upstream end and the downstream end of the 
wide river ice jam to serve as the boundary conditions for the jam. There is no limit to the number of 
separate wide river jams that can exist in a river network. However, every ice jam must have a cross 
section with fixed ice geometry at its upstream and downstream limit. Ice jams can extend through 
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any number of junctions. However, the jam will only be extended between reaches that have 
identical reach names.

Internal Friction Angle of the Jam (degrees). This describes the "strength" of the ice jam as a 
granular material. The default value is 45_degrees.

Ice Jam Porosity (fraction water filled). This describes the fraction of the ice jam that is filled with 
liquid water. The default value is 0.4.

Coefficient K1 (longitudinal to lateral stress in jam). This describes the ratio of the lateral stress 
and the longitudinal stress in the jam. It is the efficiency of the jam in transferring longitudinal stress 
into lateral stress against the channel banks. The default value is 0.33

Maximum mean velocity under ice cover. This option limits the maximum mean velocity under a 
wide river ice jam. The default value is 5 fps. If the maximum mean velocity is greater than this, the 
ice cover will be thinned until the maximum velocity is attained, or the minimum ice thickness 
supplied by the user is reached. In any case, the jam thickness will not be allowed to be thinner than 
the user supplied thickness. This option prevents the jam from thickening to such an extent that the 
entire cross sectional area of the channel would become blocked.

Ice Cohesion. At present, the ice jam cohesion is set to the default value of zero. This cannot be 
changed by the user. A value of zero is appropriate for breakup ice jams.

Fixed Manning's n Value (or Nezhikovsky's data will be used). The Manning's n value of the ice 
jam can be specified by the user or estimated using the empirical relationships developed from 
Nezhikovsky's data (1964). The empirical relationships estimate the Manning's n value on the basis 
of the jam thickness and the total water depth. The default is the user supplied Manning's n value.
Once all the ice data have been entered and edited, click the OK button. At the bottom of the Cross 
Section Data Editor, in the space entitled "List of special notes for cross section," the words "Ice 
cover" will now appear. The user can now click on the words "Ice cover" to return to the ice cover 
editor for that cross section.

Entering Ice Data Through a Table
Ice cover information can also be entered using the Tables Menu found at the top of the Geometric 
Data Window. To enter data the user selects the Ice Cover Option under the Tables Menu. All the 
information that can be entered under the Ice Cover Editor can also be entered using the Ice Cover 
table. It is often very convenient to enter and view data for more than one cross section at a time 
(figure below). 
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Entering Ice Information Using a Table

The user has the option of entering the ice thickness in the left overbank (LOB ice Thickness), the 
main channel (Chan ice Thickness), and the right overbank (ROB ice Thickness); the Manning's n 
value of the left overbank ice cover (LOB ice Mann n), the main channel ice cover (Chan ice Mann n), 
and the right overbank ice cover (ROB ice Mann n); and the specific gravity of the ice cover (Ice 
gravity). The user can also choose if the ice cover in the main channel is the result of a wide river ice 
jam (Ice Jam Chan. Note: only y or n can be entered here), and choose if the overbanks are also 
included in the wide river ice jam (Ice Jam OB. Note: only y or n can be entered here). The user can 
further select the internal friction angle of the ice jam (Friction Angle); the porosity of the ice jam 
(Porosity); the longitudinal to lateral stress ratio of the ice jam (Stress K1 ratio); the maximum 
allowable under ice flow velocity (Max Velocity); and if the Manning's n value of the ice jam is fixed, 
that is selected by the user, or if the Manning's n value will be determined by HEC-RAS (Note: only y 
or n can be entered here).

As in all instances where a Table is used to enter data, in each column the user has the option of 
entering one or more values, adding a constant to one or more of the values, multiplying a group of 
values by a factor, or changing a group of values to a specific value. Additionally, cut, copy, and paste 
buttons are provided to pass data to and from the Windows Clipboard.

Entering Ice Data at Bridges
The influence of ice on the hydraulics of bridges is a relatively unstudied area. Little is known about 
the ways in which a wide river ice jam interacts with the various components of a bridge. The 
important components of a bridge that may interact with an ice jam include the piers, low chord, 
approaches, and deck. Previous investigations of ice jams in rivers with bridges have largely ignored 
their presence, arguing that observed ice jams did not contact the low steel significantly. Removing 
the bridge information for an ice jam study still remains an option. However to allow a user to 
efficiently use HEC-RAS with ice and with bridges, three separate options are provided. These 
options allow the user to selectively decide at each bridge whether or not the ice cover can interact 
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with the structure. When modeling ice at bridges, users should carefully evaluate the results for 
consistency and accuracy.

Ice information at bridges is entered using the Bridge/Culvert editor found under the Geometry 
editor. Use the options menu in the Bridge/Culvert editor to select the ice option. This will open a 
window as shown in the figure below.

Entering Ice Information at Bridges

No ice computed in the bridge. In this case no ice calculations will be preformed at the bridge itself 
and the ice thickness at the bridge will be assumed to be zero.

Ice remains constant through the bridge. In this case, the ice thickness at the cross section 
immediately upstream of the bridge will be used. If the ice thickness is calculated as a wide river jam, 
this thickness will be used.

Dynamic ice jam computed through the bridge. In this case, the wide river ice jam calculations will 
be preformed at the bridge cross section. The user must check for inconsistent results, especially if 
any part of the ice jam is above the low chord of the bridge.

Setting Tolerances for Ice Jam Calculations
The user can override the default settings for the ice jam calculation tolerances which are used in the 
solution of the ice jam force balance equation. The tolerances are set as multiples of the water 
surface calculation tolerance used in the solution of the energy equation, described in the Simulation 
Options section of Chapter 7. The user can change the values of these tolerances by changing the 
water surface calculation tolerance. The tolerances are as follows:

Ice thickness calculation tolerance. This tolerance is compared with the difference between the 
computed and assumed ice thickness at a cross section. It is set to ten times the water surface 
calculation tolerance. Its default value is 0.1 ft.

Global ice thickness calculation tolerance. This tolerance is compared with the difference between 
the computed ice thickness at each cross section between successive solutions of the ice jam force 
balance equation and the energy equation. It is set to ten times the water surface calculation 
tolerance. Its default value is 0.1 ft.

Global water level calculation tolerance. This tolerance is compared with the difference between 
the computed water surface elevations at each cross section between successive solutions of the ice 
jam force balance equation and the energy equation. It is set to six times the water surface 
calculation tolerance. Its default value is 0.06 ft.
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Maximum number of ice jam iterations. This variable defines the maximum number of times for 
successive solutions of the ice jam force balance equation and the energy equation. It is set to 2.5 
times the maximum number of iterations. Its default value is 50.

Viewing and Editing Data through Tables
Once cross-section and hydraulic structure data are entered, the user can view and edit certain types 
of data in a tabular format. The following options are available from the Tables menu option on the 
Geometric Data editor:

Manning’s n or k values
It is often desirable to view and edit the Manning's n values or roughness heights (k values) for 
several cross sections all at the same time. From the Geometric Data editor, the user can select 
Manning's n or k values from the Tables menu item. Once this option is selected, a window will 
appear as shown in Figure 5-70.

As shown in Figure 5-70, the user has the options of selecting either n or k values to be used as the 
roughness coefficient, add a constant to one or more of the n or k values, multiply a group of n or k 
values by a factor, or change a group of n or k values to a specific value. Additionally, cut, copy, and 
paste buttons are provided to pass data to and from the Windows Clipboard. The user can optionally 
select to view all regions of the cross sections, the left overbank only, the main channel only, the 
right overbank only, or both overbanks. The main channel roughness coefficients are shown shaded 
in green in order to make it easier to distinguish between overbank and channel roughness 
coefficients in the table.
To add a constant to a group of n or k values, the user must first highlight the values that they would 
like to change. Highlighting is accomplished by placing the mouse in the upper left cell of the desired 
cells to highlight, then press the left mouse button and drag the cursor to the lower left corner of the 
desired cells to highlight. When the left mouse button is released, the cells that are selected will be 
highlighted (except the first cell). Once the user has highlighted the desired cells to be modified, 
press the Add Constant button. This will bring up a pop up window, which will allow the user to 
enter a constant value that will be added to all cells that are highlighted. 
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Figure 5 70. Manning's n Data View and Editing Table

To multiply a group of n or k values by a factor, the user first highlights the desired cells. Once the 
cells are highlighted, pressing the Multiply by a Factor button will bring up a pop up window. This 
window allows the user to enter a value that will be multiplied by each of the highlighted cells.

To set a group of n or k values to the same number, the user must first highlight the values that they 
would like to change. Once the cells are highlighted, pressing the Set Values button will bring up a 
pop up window. This window will allow the user to enter a specific n or k value, which will replace all 
of the highlighted values.

The last option (Replace) is to find and replace a specific number with a new number. When this 
option is selected the user is asked to put in a number to search for and also a number to replace it 
with. This option only searches and replaces data in highlighted fields.
An additional option is the Reduce Channel to a Single n-Value. This option will find the Manning's 
n or k value at the midpoint between the main channel bank station, then change the entire channel 
to a single roughness coefficient equal to that midpoint value.
The user can also go directly into the table and change any individual values.

Reach Lengths
The user has the ability to view and edit cross section reach lengths in a tabular format. This is 
accomplished by selecting Reach Lengths from the Tables menu of the Geometric Data editor. Once 
this option is selected, a window will appear as shown in Figure 5-71. The user has the same editing 
features as described previously for the n values table. See the discussion under Manning's n or k 
values, in the previous section, for details on how to edit the data.
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Figure 5 71. Reach Lengths View and Editing Table

Contraction and Expansion Coefficients (Steady Flow)
The user has the ability to view and edit contraction and expansion coefficients for Steady flow 
hydraulics in a tabular format. This is accomplished by selecting Contraction/Expansion 
Coefficients (Steady Flow) from the Tables menu of the Geometric Data editor. Once this option is 
selected, a window will appear as shown in Figure 5-72. The user has the same editing features as 
described previously for the n values table. See the discussion under Manning's n values, in the 
previous section, for details on how to edit the data.
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Figure 5 72. Contraction and Expansion Coefficients (Steady Flow) Table

Contraction and Expansion Coefficients (Unsteady Flow)
In general, contraction and expansion losses are not used in unsteady flow, and therefore the default 
coefficients are 0.0. Forces due to contractions and expansion are handled in the momentum 
equation through pressure force differences. However, because HEC-RAS is a one-dimensional 
unsteady flow model, the one-dimensional momentum equation does not always capture all of the 
forces acting on the flow field at a sharp contraction and/or expansion zone. In order to better 
approximate the forces acting on the water, and the resulting water surface elevation, at a 
contraction and/or expansion, the user can enter empirical contraction and expansion coefficients 
for unsteady flow modeling. These coefficients will be multiplied by a change in velocity head, just 
like in steady flow modeling, but the resulting energy loss gets converted to an equivalent force for 
placement into the momentum equation.
The user has the ability to view and edit contraction and expansion coefficients for Unsteady Flow 
hydraulics in a tabular format. This is accomplished by selecting Contraction/Expansion 
Coefficients (Unsteady Flow) from the Tables menu of the Geometric Data editor. Once this option 
is selected, a window will appear similar to the one shown in Figure 5-73. The user has the same 
editing features as described previously for the n values table. See the discussion under Manning's n 
values, in the previous section, for details on how to edit the data.
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Figure 5 73. Contraction and Expansion Coefficients (Unsteady Flow) Table

Minor Losses
Minor losses due to bends, junctions, etc… can be added to both the steady flow and the unsteady 
flow solution. Minor losses are computed by the user entering a K loss coefficient at a specific cross 
section. The K loss coefficient can vary from 0.0 to 1.0. This loss coefficient gets multiplied by the 
velocity head at that specific cross section in order to compute the minor energy loss. This energy 
loss gets added to the energy equation for steady flow computations. For unsteady flow 
computations, the energy loss is converted to an equivalent force and inserted into the momentum 
equation. In both cases the energy loss is assumed to act as a force in the upstream direction to slow 
the flow down.
To use the minor loss option, select Minor Losses from the Tables menu at the top of the Geometric 
editor. When this option is selected, a table will appear allowing the user to enter a K loss coefficient 
at any desired cross section.

Bank Stations
This table allows the user to set or move the main channel bank stations. If the main channel bank 
stations have not been set, and the user brings up this table, the bank stations will be set to the ends 
of the cross section. If the bank stations are already set the user can adjust the bank stations by 
adding a constant, multiplying them by a factor, or setting them to a specific value. If the new bank 
stations do not exist in the cross section, the program will automatically interpolate them.
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Levees
This table allows the user to easily enter and edit levee stations and elevations. The editor allows the 
user to quickly move levee stations and/or elevations. This can be very useful when trying to decide 
on a location for levee setbacks and/or the levee elevations.

Ice Cover
This option allows the user to enter ice cover data in a tabular form. A detailed discussion of ice 
cover information was presented earlier in this chapter.

Names
This option allows the user to change the name of any of the objects that make up the model 
schematic of the river system. When this option is selected, a submenu will appear that lists all of the 
objects of the schematic in which the user may want to change the current name of. This list 
includes: River and Reach Names; River Stations; Node Names; Node Descriptions; Junctions; 
storage Areas; Storage Area Connections; and Pump Stations.

River and Reach Names

This option will bring up a table of all the River and Reach names in the model. The user can change 
any name by simply going to the appropriate cell and changing the current label.

River Stationing

This option allows the user to view and edit the cross section river stationing in a tabular form. This is 
accomplished by selecting Names, then River Stations from the Tables menu of the Geometric Data 
editor. Once this option is selected, a window will appear as shown in Figure 5-74. This table allows 
the user to change the river stationing of individual cross sections, add a constant value to the river 
stationing of selected cross sections (those cross sections highlighted by the user), multiply the 
selected cross sections river stationing by a factor, or to renumber the cross section river stationing 
based on the main channel reach lengths
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Figure 5 74. Cross Section River Stationing View and Editing Table

Node Names

This option allows the user to add an additional name to a node (a node is a cross section, bridge, 
culvert, inline structure, etc…). The name can be up to 16 characters long. The user can request that 
the name be displayed on a profile plot or on a cross-section plot. To use this feature, select Names, 
then Node Names from the Tables menu. When this option is selected a window will appear as 
shown in Figure 5-75. Enter any text name that you want at a desired location within the model.
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Figure 5 75. Node Name Table Editor

Node Descriptions

This table allows the user to enter a description for any node (cross section, bridge, culvert, inline 
structure, lateral structure, and pump stations). The description can be up to six rows of text. The 
table allows the user to display any number of the rows at one time. The user can request that the 
description be displayed on a profile plot or on a cross-section plot. To use this feature, select 
Names, then Node Descriptions from the Tables menu. Enter any text description that you want at 
a desired location within the model.

Junctions

This option allows the user to change the name of any junction that is currently in the model.

Storage Areas

This option allows the user to change the name of any storage area that is currently in the model.

Storage Area Connections

This option allows the user to change the name of any storage area connection that is currently in 
the model.
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Pump Stations

This option allows the user to change the name of any pump station that is currently in the model.

Picture File Associations
This table allows the user to see and edit the directories that pictures are attached to for the project. 
For example, if all of the pictures for a project were in a directory separate from the project, and 
these pictures were then moved to another directory, this table would allow you to easily change the 
associated directory for the pictures.

Ineffective Flow Area Elevations
This table allows the user to see the trigger elevations for all of the ineffective flow areas in the 
model. The user can change any of the elevations directly from this table.

Bridge Width Table
This option allows the user to view and/or modify bridge width and distance data. Previous versions 
of HEC-RAS (versions 2.21 and earlier) allowed the user to enter a zero length between the cross 
sections inside of a bridge and the cross sections just outside of the bridge. This creates and 
unrealistic water surface profile in the vicinity of the bridge. Current versions require the user to 
maintain some distance between the outside cross sections and the bridge structure. This table was 
added to make the process of modifying old data sets less painful. When this option is selected, a 
window will appear as shown in Figure 5-76. As shown in Figure 5-76, the user is given the length 
between the cross sections that bound the bridge (Dist Avail), the distance between the upstream 
cross section and the bridge (Upstream Dist), the bridge width (Bridge Width), and the distance 
between the downstream cross section and the bridge (Downstream Dist). The user must ensure 
that the upstream and downstream distances are greater than zero. This will require entering an 
upstream distance, and then changing the bridge width to allow for a positive downstream distance.
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Figure 5 76. Bridge Width and Distance Table

Weir and Gate Coefficient Table
This table allows the user to see and edit all of the weir and gate coefficients for all of the inline and 
lateral structures within the model.
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HTAB Internal Boundaries Table
This table allows the user to see and edit all of the Hydraulic Tables properties that have been 
specified for internal boundaries, such as bridges, culverts, inline structures, lateral structures, and 
storage area connections. These hydraulic table properties are used in defining the limits that the 
pre-processor uses for building the family of curves for each internal boundary structure. This option 
is only used in an unsteady flow simulation.
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Linear Routing Coefficients
This option allows the user to view and edit any linear routing coefficients that have been entered for 
either lateral structures or storage area connections.
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Preissmann Slots on Lidded XS’s
This table allows the user to turn the Preissmann slot option on or off for any or all of the cross 
sections that have lids added to them. An example of this table is shown below in Figure 5-77.

Figure 5 77. Table Editor for Preissmann Slot Option.
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As shown in the Figure above, every cross section that has a lid will show up in the table. If the user 
wants the Preissmann slot option to be used during unsteady flow calculations, then that cross 
section must be checked in the column labeled Add Preissmann Slot. An easy way to turn this 
option on or off for all of the cross sections is to click on the column heading of the check box column 
(which will highlight all of the locations in the table). Then, pressing the space bar will toggle the 
check mark on and off for all of the highlighted locations.

The Preissmann Slot option will instruct the computational code to treat this cross section and lid 
as a pressurized pipe. This option is only for unsteady flow computations. If the option is turned on, 
the conveyance curves for the cross section will be truncated at the maximum low chord elevation of 
the lid. Preissmann slot theory will be used for modeling the flow once it becomes pressurized. For 
more on modeling pressurized pipes in HEC-RAS, please review the section on modeling pressurized 
pipes in Chapter 16 of this manual, as well as the HEC-RAS Hydraulic Reference manual.

Manning’s n by Land Classification
This table allows the user to enter Manning's n values for various Land Classification types. This 
option requires the user to have added a Land Classification Map layer into the HEC-RAS project 
inside of RAS Mapper. If a land Classification Layer has been developed within HEC-RAS Mapper, that 
layer can then be selected (associated with a specific geometry file). Once a Land Classification layer 
is selected, the types of land classifications contained within that layer will show up in the table (See 
Figure below). The user can then enter a Manning's n values to associate with each Land 
Classification type (name). Currently this option for entering Land Classifications, and associating 
Manning's n values with them, is only used for defining Manning's n values for 2D Flow Areas. See the 
Figure below for this example:
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Figure 5 78. Manning's n by Land Class Table.

As shown in the Figure above, the editor displays the Manning's n values that may be contained 
within the Land Cover file (Default Mann n). The user can override these default Manning's n values 
for this specific geometry file by entering their own defaults into the column labeled Base Mann n 
(Blank for default). If this column is left blank, the software will use the Manning's n values from the 
Land Cover Layer. If the user enters values in this column, then these values will be used for those 
Land Cover layer types.
Additionally, the user has the option to draw polygons on top of the geometry, in which they can 
redefine the Manning's n values within that polygon. This option could be used for calibrating 
Manning's n values within that region (Inside of the polygon), or it could be used for defining main 
channel Manning's n values based on user defined regions (polygons). To use this option, draw 
polygons onto the geometric editor, using the drawing tool labeled 2D Area Mann n Regions. After 
drawing the polygon the user is required to give it a unique name. Once the polygons are drawn they 
will show up in the Manning's n by Land Cover Table. Right now these Manning's n values only work 
for 2D Flow Areas.

Importing Geometric Data
HEC-RAS has the ability to import geometric data in several different formats. These formats include: 
a GIS format (developed at HEC); the USACE Standard Surveyor format; HEC-2 data format; HEC-RAS 
data format; UNET geometric data format; and the MIKE11 cross section data format. Data can be 
imported into an existing HEC-RAS geometry file or for a completely new geometry file. Multiple data 
files can be imported into the same geometric data file on a reach-by-reach basis.
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Supported File Formats

GIS Format

A file format for interfacing HEC-RAS with GIS/CADD systems has been developed at HEC. A detailed 
description of the file format is contained in Appendix B of this manual. Chapter 14 of this manual 
provides detailed discussions on how to import GIS/CADD data into HEC-RAS, as well as how to 
export computed water surface profiles back to GIS/CADD systems.

USACE Survey Data Format

The U.S. Army Corps of Engineers (USACE) has developed a standard file format for survey data. This 
format is documented in Chapter 6 of Engineering Manual (EM) 1110-1-1005. The USACE survey 
format encompasses a wide range of data types. The current version of HEC-RAS has the capability 
to read this file format, but only cross section data are extracted from the file. At this time all other 
data are ignored.

HEC-2 Data Format

The HEC-2 program was the predecessor to the HEC-RAS software package. The HEC-2 program was 
used for many years to compute steady flow water surface profiles. Consequently, thousands of data 
sets exist in the HEC-2 data format. HEC-RAS has two ways of importing HEC-2 data. The first way is 
accomplished through the use of the Import HEC-2 Data option from the File menu on the main 
HEC-RAS window. When this method is used, it is assumed that the user has started a new project; 
and therefore all of the HEC-2 data is imported (geometric data, flow data, and plan information). A 
second way of importing HEC-2 data is provided from the geometric data editor. This way of 
importing HEC-2 data allows the user to bring the data into existing HEC-RAS geometric data files. 
This method also allows the user to import multiple HEC-2 data files into the same HEC-RAS 
geometric data file. However, when importing HEC-2 data from the geometric data window, only the 
geometric data contained in the HEC-2 files will be imported. All of the other data (flow data and 
plan information) will be ignored.

HEC-RAS Format

This option allows the user to combine several HEC-RAS geometry files into a single geometry file. 
For example, if several pieces of a river system were developed as separate HEC-RAS models, this 
option could be used to put them together into one model.

UNET Geometric Data Format

This option allows the user to import a UNET geometric data file (CSECT geometry file). UNET is an 
unsteady flow program developed by Dr. Robert Barkau. The Corps, as well as many other agencies, 
has used this software for many years. UNET models are often very complex, consisting of many river 
reaches that can be connected in numerous ways. The HEC-RAS UNET importer does not have 
enough information to draw the schematic in the proper manner. The river reaches and storage 
areas will be connected correctly, but the user will need to edit the schematic to make it look like the 
actual river system.
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MIKE11 Cross-Section Data

This option allows the user to import cross section data from the MIKE11 program. MIKE11 is a one-
dimensional river hydraulics model developed by the Danish Hydraulic Institute. Users must first 
export the MIKE11 data to a raw text file. This is an available option from MIKE11. Once the data is in 
the text file format, it can be imported into HEC-RAS.

CSV (Comma Separate Value) Format

This option allows for the import of comma separated value data. It is only intended to import cross 
section geometry and does not resolve the river network. River system connectively must be 
completed by forming junctions after all of the cross section data has been imported.

The data must be in the format of "River Station", "X", "Y", "Z" or "River Station", "Station", 
"Elevation", as shown in Figure 5-83. Once a file has been selected, you must choose the file format 
and select the Column Headers that correspond to the HEC-RAS geometry convention. By default, 
HEC-RAS looks for keywords (such as "River", "Reach", "X", "Y", "Z", "Elevation", etc…) to 
automatically populate the selected data list item. The River and Reach data is optional – if it is not 
specified, all cross sections will be assigned to the same river reach.

Figure 5 83. CSV data import window.

After identifying the Column Headers, using the dropdown lists, for the data in the CSV file, the 
standard RAS Geometric Data Import window (Figure 5-82) will appear to guide you through the 
import process of identifying exactly what data you would like to import. After the cross sections are 
imported, most likely you will need to adjust the river centerlines and establish connectivity with 
junctions. 
One option for completing the River Network is to create a georeferenced stream centerline (or a 
stick figure diagram of the system). Then import the RAS cross sections onto the stream network. A 
detailed discussion on creating a georeferenced stream centerline is provided in a later Section of 
this document: Example of Georeferencing an HEC-RAS Model.

Geometric Data Importer
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To import data into a HEC-RAS geometric data file, the user selects the File | Import Geometric Data
menu option on the Geometric Data window. Once this option is selected, the user then selects one 
of the available formats from the list. Once this choice is made, a window will appear allowing the 
user to select a file containing the data to import. After the user has selected a file, an import window 
will appear to guide you through the import process.

The Import Options window will guide you through the process of importing all or part of the import 
file. The initial tab of the Import Options dialog is the Intro tab, shown in Figure 5-79. HEC-RAS will 
read the import file and look for a "UNITS" tag. Based on the value associated with the tag, you will 
be offered the option to import the data in the current unit system or to convert the data from one 
unit system to another. If no unit system is found in the file the import dialog will default to your 
current RAS project units.

Figure 5 79. Unit system conversion is an import option in HEC-RAS

River Reach Stream Lines
The next tab on the import options window is the River Reach Stream Lines (Figure 5-80). This set of 
options allows you to specify which river reaches to import, how to import the data, and what to 
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name the river and reach. Import options for the river and reaches are summarized in Table 5-2. 

Figure 5 80. River and reach import options.

Table 5-2. Summary of River Reach Import option fields.

Column Description

Import As River The name of the River once it is imported to RAS.

Import As Reach The name of the Reach once it is imported to RAS.

Import Status Identifies whether the river reach exists in the RAS geometry file or is new.

Import Stream Lines Checkbox to choose what river reaches to import. Use the spacebar to toggle the 
checkbox. All rows can be selected by clicking on the column header.

Merge Mode The river reach can replace existing data, append upstream, or append downstream.
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Cross Section and IB Nodes
The next tab on the Import Options window allows you to import cross sections and internal 
boundaries (bridges and inline structures). The Cross Sections and IB Nodes screen options are 
shown in Figure 5-81.

Figure 5 81. Cross section and internal boundary import options.

There are several options for importing cross-sectional data. You must first specify the Import River 
and Import Reach upon which the cross sections reside. The import dialog will inform you what river 
and reach name the data will import to (Import As) in the HEC-RAS geometry. (The Import As 
information was specified on the River Reach Stream Lines tab). You then specify the cross sections 
to import and the specific cross section properties to import.
Only those cross-sectional properties available from the import file will be available for import. 
Properties selected will be imported for each cross section specified during the import process. The 
properties import option will allow you to update individual pieces of data (such as bank station 
data) without modifying the other data already specified in HEC-RAS.

The cross sections that will be imported and how they will be imported are specified in the import 
table. Import table options are summarized in the table below.
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Table 5-3. Summary of Cross Section and IB Nodes Import option fields.

Column Description

Import File River The name of the River in the import file. Refer to the associated Import As field to see the 
name of the river that the cross section will be imported into.

Import File Reach The name of the Reach in the import File. Refer to the associated Import As field to see the 
name of the reach that the cross section will be imported into.

Import File RS The name of the River Station in the import file.

Import As RS The name of the River Station the cross section will be imported into. This data may be 
user-specified and changed using the provided tools. The "Reset" button will replace the 
river station data with the data in the import file.

Import Status The Import Status will be "New" or "Exists". New will add the cross section to the data. 
Exists will update (replace) the existing data with the properties specified.

Import Data Checkbox to choose what river stations to import. Use the spacebar to toggle the checkbox. 
All rows can be selected by clicking on the column header. You can also use the buttons 
provided to select all of the New cross sections (Check New) or those that Exist (Check 
Existing).

There are also several tools provided to change the river station name. River station identifiers are 
the link between the GeoRAS generated data and the HEC-RAS data. Cross-sectional river stations 
must be numbers in HEC-RAS. HEC-RAS will use the river stations (along with River names) for 
determining the order of cross sections for performing water surface profile calculations. River 
station numbers must increase in the upstream direction. Import options for river stations allow you 
to match river stations to the existing geometry, round the river station value for import, and create 
river stationing.

Match River Stations to Existing Geometry

The Match Import File RS to Existing Geometry RS option allows you to specify a numeric tolerance to 
search for duplicate cross sections in existing geometry files. This tool is useful when you are re-
importing cross section data where you may have modified the stream centerline or cross section 
layout. The newly computed river stations may differ from the original stationing due to small spatial 
changes made in the GIS. This tool is also convenient if you are updating cross sections that have 
river stations that were rounded during the initial import of the data.

Round Selected River Stations

GeoRAS may export the river stationing to more decimal places than are necessary. You can round 
the river stations to the precision appropriate for your study.

Create River Stations

By default, GeoRAS will compute river stations in the unit system of the digital terrain model and will 
use a zero station at the most downstream end of each river reach. If you wish to change the river 
stationing you can do so in the GIS, or you can do so during the import process. It is recommended 
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that you document the method used if you change the river stations. Documenting the method used 
to compute new river stations will be important if you need to re-import cross-sectional data – the 
river station identifier is the link between the GeoRAS generated data and the HEC-RAS data.

Storage Areas and Connections
The Storage Areas and Connections tab, shown in Figure 5-82, allows you to specify storage areas 
and storage area connections to import and what name to import them with.

Figure 5 82. Storage Areas and Connections import options.

Geometric Data Tools
Several tools are available from the Geometric Data editor to assist you in the development and 
editing of data. These tools consist of: cross section interpolation; Channel design/modification; 
channel modification; graphical cross section editor; channel bank stations; reverse stationing data; 
set ineffective flow areas to permanent mode; cross section points filter; fixed sediment elevation; 
pilot channels; and GIS cut line check. The cross section interpolation tool has been described 
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previously in this chapter. Channel modification is described separately in Chapter 12 of this manual. 
The following is a short description of each of the tools.

Graphical Cross Section Editor
A graphical cross section editor is available from the Tools menu of the Geometric Data Editor 
window. When this option is selected, a window will appear as shown in Figure 5-84.

The user has the option to move objects (objects are ground points, main channel bank stations, 
Manning's n value station locations, ineffective flow areas, levees, and blocked obstructions), delete 
objects, or add new objects. To move an object, the user first selects Move Objects from the Options
menu. Then move the mouse pointer over the object that you want to move, press down the left 
mouse button, and then move the object. When you are finished moving the object, simply release 
the left mouse button and the object will be moved. To delete an object, first select Delete Objects
from the Options menu. Next, move the mouse pointer over the object that you would like to delete 
and click the left mouse button. Whatever object is closest to the mouse pointer will be deleted. To 
add an object to the cross section, first select the type of object you want to add from the available 
list under the Options menu. Once you have selected an object type to add, move the mouse pointer 
to the location where you would like to add it and click the left mouse button. If the object that you 
are adding requires more than one point, such as blocked ineffective flow areas and blocked 
obstructions then continue to move the mouse pointer and click the left mouse button to add the 
additional points.
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Figure 5 84. Graphical Cross Section Editor

Other available options from the Graphical Cross Section editor are the ability to zoom in and zoom 
out, full plot, pan, overlay a grid onto the cross section plot, and to undo all of the graphical editing. 
When the Undo Edits option is selected, the cross section is automatically returned to its original 
state before this particular editing session began. However, once this editor is closed, or if the user 
selects a different cross section from the editor, it is assumed that the user is happy with the changes 
that were made and they are saved in memory. The data is not saved to the hard disk, so it is still 
possible to get the original data back if needed.

Bank Station Tools

Several tools have been added to make it convenient to change the location of the main channel 
bank stations. These tools are in the form of buttons across the top of the graphic window displaying 
the currently opened cross section.

Tool Description

Allows the user to move the left bank of the main channel one point at a time to the left. Simply click 
this button to have the left main channel bank station move one point to the left.
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Tool Description

Allows the user to move the left bank of the main channel one point at a time to the right. Simply click 
this button to have the left main channel bank station move one point to the right.

Allows the user to move the main channel bank stations to cross section points that are just above the 
currently displayed water surface profile. The user can turn on any of the previously computed water 
surface profiles to be displayed on the plot. Once a water surface profile is displayed, and the user 
presses this button, the main channel bank stations will be move to the first two points that are above 
the water line on the plot. This option is very useful if you would like to set the main channel bank 
stations to a consistent stationing based on a particular flow event. For example, if a water surface 
profile is computed for the 2-year flow event, the user could then move all of the main channel bank 
stations just outside of this flow profile.

This tool is very similar to the previously described tool. It does the same thing, only moving the main 
channel bank stations inward to just above the water line (assuming the current main channel bank 
stations are above the water line).

Allows the user to move the right bank of the main channel one point at a time to the left. Simply click 
this button to have the right main channel bank station move one point to the left.

Allows the user to move the right bank of the main channel one point at a time to the right. Simply click 
this button to have the right main channel bank station move one point to the right.

Allows the user to set the left or right bank of the main channel to a stationing of one of the existing 
points in the cross section. Once this button is pressed, the user can set the stationing of the left and 
right bank of the main channel by simply moving the mouse to the desired location and clicking the left 
mouse button. The program assumes the left bank when the mouse is left of the lowest point in the 
view area, and it assumes the right bank when the mouse pointer is right of the lowest point in the view 
area.

Allows the user to move the station locations of existing Manning's n values. When this option is 
selected, vertical lines will appear at all of the current Manning's n value (or K-value) break points. The 
user can move the mouse pointer over the n value break locations at the top of the graphic, press and 
hold the left mouse button down, and then move the n value break location to the new desired 
location.

Persistent Scale

This option allows the user to set a persistent scale, in both the vertical and horizontal, to be used 
when plotting any cross section. When this option is checked, additional data fields will be displayed 
to the right of the option. The user has the option to set a left and right stationing, or a maximum 
width for the X-axis. Likewise, a top and bottom elevation, or a height can be set for the Y-axis. By 
setting a persistent scale, as the user moves from one cross section to the next, it is much easier to 
visualize how cross sections are changing from one to the next.

Compare Geometry Files

This option allows the user to compare cross sections from two different geometry files (one being 
the currently opened geometry file). When this option is selected, additional data fields and buttons 
will show up to the right of this option. The user first selects the second geometry file to use for 
comparing to the currently opened geometry file. Next the user selects the specific river, reach, and 
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river stationing to plot against the currently displayed cross section. The second geometry, which 
will be displayed in pink on the graphic, is only for visualization, as it cannot be modified by the 
graphical editor.

Merge Cross Sections

This option allows the user to merged data from one cross section into another. This option works in 
conjunction with the Compare Geometry Files option described above. To use this option, the user 
must first turn on the compare geometry files option and select the desired geometry file and cross 
section to compare to the current geometry file and cross section. Next the user turns on the Merge 
Cross Sections option. When this option is selected some additional data fields will show up next to 
the Compare Geometry Files data fields. Additionally two red vertical lines will show up on the plot, 
defaulted to the main channel bank stations of the existing cross section. An example of what the 
Graphical Cross Section editor will look like when the two options are turned on is shown in the 
figure below.

Figure 5 85. Graphical Cross Section Editor with Merge Cross Section Option.

As shown in the Figure above, the two red lines indicate the zone for merging data. The merge data 
zone can be everything inside of the two lines, or everything outside the two lines. The merge data 
zone can be changed by either graphically grabbing one of the vertical lines or moving it, or by 
entering a value in the appropriate fields under the Merge XS data area at the upper right hand 
corner of the window. Before the data is merged, the user may want to shift the comparison cross 
section (shown in purple) left or right, and/or up and down, to align the appropriate portion of the 
cross section with the appropriate portion of the current cross section (shown in black). Shifting the 
comparison cross section can be accomplished by entering a Shift X and/or Shift Y value into the 
appropriate fields in the upper right corner of the window. Additionally the cross section can be 
shifted by holding down the Shift key and then pressing the arrow keys. The amount of shift for each 
press of an arrow key can be controlled by entering a value for the X and Y shift amount in the fields 
in the upper right corner of the window. Once the merge zone has been set, and the comparison 
cross section has been shifted appropriately, the user can press either the button labeled Inside or 
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Outside. If the button labeled Inside is pressed, then the data for the current cross section, inside of 
the merge zone (between the two red lines), is replaced with the data from the comparison cross 
section. If the button labeled Outside is pressed, then the data outside of the two red lines is 
replaced (i.e. the data from the current cross section, outside of the red lines, is replaced with the 
data from the comparison cross section. 

Channel Bank Stations
This tool allows the user to select a water surface profile from a previous run, and then have the 
program move the main channel bank stations to the station/elevation points closest to the edge of 
the water surface.

Reverse Stationing Data
Cross section data should be entered into HEC-RAS from left to right when looking downstream. This 
is the assumed direction for all of the cross sections and other structure data. If you have data that 
has not been entered from left to right while looking downstream, this editor will allow you to 
reverse the data to the assumed direction. To bring up this editor, select Reverse Station Data from 
the Tools menu of the geometric data editor. When this option is selected a window will appear as 
shown in Figure 5-86.
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Figure 5 86. Reverse Cross Section Stationing Editor

As shown in Figure 5-86, you first select the river and reach which contains the data to be reversed. 
Then select the particular river stations of the data that is not in the correct format (left to right 
looking downstream). Add those locations to the box on the right side of the editor, by pressing the 
arrow button in the middle of the editor. Continue to do this until you have all of the cross section 
that you want to reverse the stationing for. Finally, press the OK button and the data will be 
reversed.

Cross Section Points Filter
This tool allows a user to filter out unnecessary points in cross sections. With the use of GIS data, 
cross sections can contain many more points than actually necessary to describe the terrain. HEC-
RAS has a limit of 500 points in any cross section. Because of this limit, it is occasionally necessary to 
filter out points that are not needed. To bring up this editor, select Cross Section Points Filter from 
the Tools menu of the geometric data editor. When this option is selected a window will appear as 
shown in Figure 5-87.
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As shown in Figure 5-87, the editor allows the user to filter points on a cross section by cross section 
basis, or for a range of cross sections at one time (Multiple Locations option tab). To filter a single 
cross section, the user selects the river, reach, and river station they want to work on. Then press the 
button labeled Filter Points on Selected XS to filter the points. 

Figure 5 87 Cross Section Points Filter Editor

The cross section points filter performs two different types of filtering on each cross section. The first 
type is called a Near and Colinear Points Filter, this method simply searches for points that are 
close together. If two points are found to be within the horizontal and vertical distance tolerance, 
then the second point is removed. The second pass of this filter searches for points that are in a 
straight line, or nearly in a straight line. This filter searches to find three consecutive points that may 
be in a straight line. If a line is connected between points one and three, and point two is less than a 
predefined tolerance from that line (vertical filter tolerance based on a distance perpendicular to the 
line), then the second point is a candidate to be removed. A second check is done to ensure the slope 
of the line that connects point one and two together, is not changing significantly when point one 
and three are connected (minimum change in slope tolerance). Options are available to only filter 
cross sections that have more than 500 points, as well as to restore a cross section back to the 
original points before filtering occurred.
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The second type of filter is called Minimize Area Change. To use this filter press the Minimize Area 
Change tab below the graphic window. When this tab is selected the user will be asked to enter the 
number of points that they would like the new cross section to be trimmed down to. After a number 
is entered, the user presses the Filter Points on Selected XS button to perform the filtering. This 
filtering method will drop out one point at a time until the cross section is down to the user desired 
number of points. The decision process for dropping a point is to find the point in the cross section 
that will cause the area of the cross section to change the least. 
Additionally, this editor allows the user to select multiple cross sections and perform the filter 
operation on all of them at once. This is done by first selecting the Multiple Locations tab. Then 
select the cross sections that you would like to filter. Set the filter tolerances to any desired values, 
and then press the Filter Points on Selected XS button.

Fixed Sediment Elevations
This option allows the user to fill in portions of cross sections with sediment. The sediment is 
assumed to be at a constant elevation in any particular cross section. To use this option select Fixed 
Sediment Elevations from the Tools menu of the geometric data editor. When this option is selected, 
a window will appear as shown in Figure 5-88.



Entering and Editing Geometric Data

HEC-RAS User's Manual– 194

Figure 5 88. Fixed Sediment Elevation Editor
As shown in Figure 5-88, the user selects a particular river and reach to work on, then a range of cross 
sections to apply the sediment fill to. There are three options for having a sediment fill over a range 
of cross sections. The first option is to enter a sediment elevation at an upstream or downstream 
cross section then project the sediment fill on a slope over the range of selected cross sections. The 
second option is to set the upstream and downstream elevations, then allow the program to use 
linear interpolation for the cross sections in between. The final option is to set the sediment 
elevation individually on a cross-section by cross-section basis.

The lower left hand portion of the editor is used to set the sediment values over a range of sections. 
The table on the lower right hand side of the editor shows the actual values that are applied to each 
cross section. The user can change any value in the table directly, or they can highlight a section of 
values and use the four buttons above the table to modify the values. These four buttons allow for 
adding a constant; multiplying the values by a factor; setting all of them to a specific value; or setting 
them to the cross section invert.
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1.

2.

Pilot Channels
Pilot channels are an option that was added for unsteady flow modeling. Occasionally, when 
modeling low flows (such as at the beginning or end of a storm event), the program will go unstable. 
This instability can occur for many reasons. The following is a list of some of the main causes for 
instabilities at low flows:

At low flows the depths are very small. As the flood wave begins to come into the reach, the depths change 
dramatically percentage wise. Unsteady flow models use derivatives that are based on the change in depth 
with respect to time and distance. If the depth changes significantly during any time step, the derivatives 
can become very large, and oscillations will occur. These oscillations can grow to the point where the 
solution becomes unstable.
Also during low flows, it is much more likely that your river may be flowing in a pool and riffle sequence. At 
the riffles, the flow may be passing through critical depth and going supercritical. By default, the unsteady 
flow solver in HEC-RAS cannot handle flows going down to or passing through critical depth (unless the 
mixed flow option is turned on). This again causes instabilities in the solution, and may eventually cause the 
solution to go unstable.

Pilot channels are one of the available options to help prevent the model from going unstable. A 
pilot channel cuts a rectangular notch into the bottom of the cross section. Generally this notch is 
not very wide (often 1 ft is used), but it provides depth to the cross section at low flows (typically 
make it 5 to 10 feet deep). Additionally, the use of a pilot channel can smooth-out irregularities in the 
channel bottom. This also helps the stability of the model solution. The pilot channel area and 
conveyance are barrowed from the lower portion of the main channel, such that the total area and 
conveyance properties of the cross section relate to the original cross section at higher flows. In 
other words, when the depth of flow gets higher, the area and conveyance of the pilot channel are 
ignored. To use the pilot channel option, select Pilot Channel from the Tools menu of the geometric 
data editor. When the pilot channel option is selected a window will appear as shown in Figure 5-89.
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Figure 5 89. Pilot Channel Editor

As shown in Figure 5-89 the user selects a river, reach, and range of river stations to apply the pilot 
channel too. On the lower left hand side of the form are some utilities to enter the pilot channel 
information. The user enters the pilot channel width (typically the width should be narrow), and the 
Manning's n value (should be equal to or higher than the main channel n value). The user can either 
enter an elevation for the invert of the pilot channel and project it on a slope over the range of cross 
sections, or they can enter an upstream and a downstream invert elevation and have the program 
use linear interpolation for the cross sections in between. A list of the final pilot channel values for 
each of the cross sections is shown in the table on the lower right hand side of the editor. The user 
can modify the table directly and change any value on a cross section-by-cross section basis. The 
profile plot on the editor will display the invert elevation of the pilot so you can compare it to the 
actual channel invert. Once you have finished adding the pilot channel information, press the OK 
button, and then save the geometric data.
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Ineffective Areas - Set to Permanent Mode
The default method for ineffective flows is that the area defined as ineffective will contain water but 
have no conveyance (the velocity is assumed to be zero). This remains true until the water surface 
reaches a trigger elevation (an elevation set by the user, as to when the ineffective flow area should 
become effective again). Once the water surface is higher than the trigger elevation, the entire 
ineffective flow area becomes effective. Water is assumed to be able to move freely in that area 
based on the roughness, wetted perimeter and area of each subsection.

Occasionally you may have a need to have these ineffective flow areas remain ineffective 
permanently. The ineffective flow areas can be set to the permanent mode individually from the 
cross section editor, or through a table from the geometric data editor. To bring up the table, select 
Set Ineffective Areas to Permanent Mode from the Tools menu of the geometric data editor. When 
this option is selected a window will appear as shown in Figure 5-90.

Figure 5 90. Editor to Set Ineffective Flow Areas to Permanent

The editor for this option allows the user to select the river, reach, and river stations, of the cross 
sections in which you want to set the ineffective flow areas to the permanent mode. Add those 
locations to the box on the right side of the editor, by pressing the arrow button in the middle of the 
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editor. Continue to do this until you have all of the cross section that you want. Finally, press the OK
button and the data will be reversed.

Ineffective Areas – Fix Overlapping
This tool will search through all of the cross sections and check to see if the user has entered blocked 
ineffective areas that overlap each other. The computational program does not like to have 
overlapping ineffective flow areas so this must be rectified before the computations can begin. This 
tool will find all the cross sections that have overlapping ineffective flow areas and it will adjust the 
stationing of the block with the lower elevation so it does not overlap the adjacent ineffective area.

Ineffective Areas – Convert Multiple Blocks to Single “Normal” Ineffective
This tool will convert cross sections with multiple blocked ineffective flow areas to a cross section 
with the "Normal" ineffective flow areas (just one left and one right ineffective flow area in the 
overbanks).

Manning’s n Set Channel to Single Value
This option allows the user to select a set of cross sections in which the Manning's n value will be set 
to a single value. This option will change any cross section that has more than one n value inside of 
the channel to a single value. The n value at the low point in the main channel is what is used for the 
entire channel.

Vertical Datum Adjustment
These tools allows the user to adjust the elevation data of the entire model or selected nodes (cross 
sections, bridges/culverts, structures, etc…), storage areas, storage area connections, or pump 
stations contained in the project. When this option is selected a submenu will come up that allows 
the user to select to adjust the Entire Geometry model with a single value; define a Table of 
locations and adjustment values; or select various types of nodes (cross sections, bridges, culverts, 
etc…) in the project. Once an option is selected a new window will appear allowing the user to enter 
a factor(s) to multiply or add to all of the elevations of the selected nodes.

Reach Connectivity
This tool allows the user to view how reaches are connected together. When working with a very 
large model with lots of reaches, it can often be difficult to see how the reaches are connected, or if 
there is a problem with a connection. This tool displays the connections in a text table.

Reach Order for Computations
When this option is selected a window will pop up showing the order of the reaches for 
computations (see Figure 5-91). The reaches are listed from upstream to downstream order. For 
complex models the reach order is very important. The HEC-RAS software will automatically 
compute the order for computations. However, the user can change the order if they do not like the 
order that the program came up with. Warning: changing the computational order for reaches can 
cause the computational programs not to work correctly. Before changing the computational order, 
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be sure you fully understand what the steady flow and unsteady flow computational modules 
require for computational orders.

Figure 5 91. HEC-RAS Reach Computational Order Table

Reach Order – Find Loops
When this option is selected, the program will search through the model schematic and find any 
loops in the system that will cause the backwater computations to fail. This can occur if the user puts 
in a looped system that would continue to loop water.

Flow Roughness Factors
This option allows the user to adjust roughness coefficients with changes in flow. This feature is very 
useful for calibrating an unsteady flow model for flows that range from low to high. Roughness 
generally decreases with increases flow and depth. This is especially true on larger river systems. 
This feature allows the user to adjust the roughness coefficients up or down in order to get a better 
match of observed data. To use this option, select Flow Roughness Factors from the Tools menu of 
the Geometric Data editor. When this option is selected, a window will appear as shown in Figure 
5-92.

As shown in Figure 5-92, the user first selects a river, reach, and a range of cross sections to apply the 
factors to. Next a starting flow, flow increment, and a number of increments is entered. Finally, a 
roughness factor is entered into the table for each of the flows. The user can create several sets of 
these factors to cover a range of locations within the model. However, one set of factors cannot 
overlap with another set of factors. Hence, you can only apply one set of roughness change factors to 
any given cross section.
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Note: Flow Roughness factors is available as an option in both the Geometry Editor (saved with the 
geometry data) and the Plan Editor (saved in the plan file). If you put these factors in the geometry 
editor, they will be applied to every event that uses that geometry file. Normally you would do this 
when flow roughness factors are needed for a wide range of events, and you can come up with a set 
of factors that works well from low to high events. If you want to use flow roughness factors for real 
time calibration, or you believe they are much more event specific, then you would place them in the 
Plan File. When placed in the Plan file, they only get applied to that event being run with that plan.

Additionally, if you place these factors in both the geometry and the plan file, then you will be 
factoring the roughness twice. Factors placed in the geometry file get used during the Geometry Pre-
Processing, and they will affect the hydraulic tables that get computed. Factors placed in the Plan 
file are used in real time during the unsteady flow computations, and they get applied each time step 
at each cross section location.

Figure 5 92. Flow versus Roughness Change Factors Editor

Seasonal Roughness Change Factors. This option allows the user to change roughness with time of 
year. This feature is most commonly used on larger river systems, in which temperature changes can 
cause changes in bed forms, which in turn causes changes in roughness. This factor can be applied in 
conjunction with the flow roughness change factors. When applying both, the seasonal roughness 
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factor gets applied last.
To use this option, select Seasonal Roughness Factors from the Tools menu of the Geometric Data 
editor. When this option is selected a window will appear as shown in Figure 5-93.

As shown in Figure 5-93, the user first selects a river, reach, and range of river station to apply the 
factors to. Next the user enters the day and month in the Day column, for each time that a new 
roughness factor will be entered. By default the program will automatically list the first of each 
month in this column. However, the user can change the day to whatever they would like. The final 
step is to then enter the roughness change factors.

Figure 5 93. Seasonal Roughness Factors Editor

Geometric Data Options
A few new options have been added to the HEC-RAS Geometric Data editor. To select one of the 
options go to the Options menu at the top of the Geometric Data Editor, and select the desired 
option. The following is a list of the currently available options:
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Main Channel Manning's n Value Compositing
When this option is selected, the window shown in the figure below will be invoked.

Main Channel Manning's n Value Compositing Editor

This editor allows the user to control how HEC-RAS will composite Manning's n values for the main 
channel only. The default option is the top option. This option will composite all of the main channel 
manning's n values into a single n value, as long as the side slopes of the main channel are greater 
than 5H:1V. The user has the option to change this slope criterion. The second option is to tell HEC-
RAS to not composite Manning's n values for any of the cross sections in the model. For more details 
on Manning's n value compositing for the main channel, see the Hydraulic reference manual.

Hydrologic Unsteady Routing
This option allows the user to define portions of a model to be routed with a hydrologic routing 
technique instead of using the full unsteady flow equations. The software will simultaneously solve 
the unsteady flow equations and the hydrologic routing reaches each time step. This option is very 
useful when encountering portions of the model that are very steep and full unsteady flow routing is 
either unstable or not possible at all. Currently the only hydrologic routing method available is 
Modified Puls routing. This option only works as part of an unsteady flow model, and is ignored when 
using a geometry file in steady flow mode.

To use the hydrologic routing option, go to the Options menu at the top of the Geometric Editor and 
select the option called Hydrologic Unsteady Routing. When this option is selected the following 
window will appear.
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Hydrologic Unsteady Flow Routing Editor

To use the Modified Puls routing option, the user must first create a steady flow plan with the exact 
same geometry file. The purpose of the steady flow plan is to compute a range of water surface 
profiles from very low to the highest expected flow rate. The results from the steady flow run are 
used within the hydrologic routing reaches in order to provide the necessary discharge-volume 
relationships required by Modified Puls routing. As shown in the figure above, a Steady Flow Output 
Plan must be selected at the bottom of the editor, which will be used for importing the computed 
rating curves. Based on the computed rating curves from the steady flow run, and the known 
distances between cross sections, the program can compute a volume for any flow rate on the fly, in 
order to solve the Modified Puls equations.

Users can establish hydrologic routing reaches almost anywhere in the model. A hydrologic routing 
reach must be at least two cross sections long. A hydrologic routing reach can be an upstream piece, 
downstream piece, or an intermediate piece of any existing HEC-RAS unsteady flow river reach. A 
hydrologic routing reach can also encompass an entire HEC-RAS river reach. Hydrologic routing 
reaches can contain bridges/culverts and lateral structures, but it cannot contain an inline structure. 
If you have an inline structure within a reach that you want to perform hydrologic routing, you must 
stop the hydrologic routing reach at least two cross sections upstream of the structure, and you can 
start a new routing reach downstream of the structure. The hydraulics of bridges and culverts will be 
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incorporated into the routing through the resulting steady flow water surface profiles. Flow over 
lateral structures are computed each time step as they would normally be for unsteady flow routing.

To establish a piece of a model as a hydrologic routing reach, select the Add Region button. When 
this button is pressed, a window will appear in which you can select a river, reach, and a range of 
cross sections (upstream and downstream end of the reach) to establish as a hydrologic routing 
reach. Multiple hydrologic routing reaches can be set within the same model. There is also a button 
to edit the limits of an existing reach, and a button to delete reaches.

Two check boxes exist at the top of the window. The first check box is labeled Use Modified Puls 
Routing. If this box is not checked, the modified puls routing option will be ignored, and HEC-RAS 
will perform full unsteady flow routing at all of the cross sections. When this box is checked, any 
hydrologic routing reaches listed in the table will be modeled with the Modified Puls routing method. 
The second check box is labeled Tailwater Check. When this option is turned on, the downstream 
interface of any hydrologic routing reach will be monitored to see if the next cross section 
downstream has a higher computed water surface than the last section of the hydrologic routing 
reach. If the downstream water surface (tailwater) is higher than the last cross sections water surface 
of the hydrologic routing reach, then that water surface is forced into the downstream portion of the 
hydrologic routing reach. This allows for downstream conditions to influence the water surface, 
volume, and flow rate in the hydrologic routing reach.

The last step required to use the hydrologic routing reach is to import computed rating curves from a 
previously run steady flow model that used the exact same geometry file. This is accomplished by 
selecting the steady flow output plan and then pressing the Import Rating Curves (RC's) from 
Steady Flow Output button. There is also an option to plot the rating curves at the bottom of the 
editor, in order to visually inspect them. In general, users should set up a steady flow model with 
many water surface profiles (at least 20) in order to get good definition in the flow versus elevation 
points of the rating curves. Flows should range from lower than expected to route, to higher than 
expected to route within the unsteady flow model.

Georeferencing an HEC-RAS Model
Georeferencing is the process by which real-world coordinates are assigned to an HEC-RAS model to 
reference it to other data. An HEC-RAS model that shares a common coordinate system with GIS 
layers allows the developer of the model to visualize limits of the defined study area using 
background data.
The use of aerial photographs, for example, can be extremely beneficial for identifying the location 
of a landform such as levee or road or structures such as bridges and weirs while showing the user 
it's representation in the hydraulic model. Therefore, background data is quite useful for model 
development. HEC-RAS results may also be quickly visualized using automated GIS procedures using 
tools such as HEC-RAS Mapper and HEC-GeoRAS. Additionally, floodplain maps may also be 
developed if the HEC-RAS model is georeferenced.
HEC-RAS allows the user to have a stream system schematic, and hydraulic elements, that is drawn 
spatially correct. This requires that the stream centerlines, cross sections, storage areas, and 2D Flow 
Areas have GIS coordinate information in order to draw them in a georeferenced framework. 
Generally, GIS coordinate information can be developed by laying out the model geospatially using 
HEC-RAS Mapper. However, HEC-RAS also has editors and tools for allowing the user to enter and 
manipulate GIS coordinate information directly in the HEC-RAS Geometric Data editor. The following 
is a list of the GIS tools available from the GIS Tools menu at the top of the Geometric Data editor.
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GIS Tools in HEC-RAS
GIS tools in HEC-RAS are provided on the Geometric Data editor on the GIS Tools menu shown in 
Figure 5-96. The GIS Tools provide capabilities for editing and modifying x and y coordinates 
associated with the river network, cross sections, and other features in HEC-RAS. These GIS 
coordinate data can be edited directly through the different table options or computed based on the 
data available. The GIS Tools also provide visual displays of the data that can be exported to the GIS 
for processing.

Figure 5 96. GIS Tools Menu Options

Tables
The x and y position that establish the location of the river reaches, cross-sectional cut lines, storage 
area outlines, storage area connections, levee lines, and ineffective areas are available through 
Tables from the GIS Tools menu. These tables identify the object and provide simple spreadsheet 
operations including cut, copy, and paste. This allows you easy access to geo-reference an individual 
object, such as a cross section cut line. The following is a list of the available tables from the GIS 
Tools menu:

Reach Invert Lines Table: This option allows the user to numerically edit the coordinates of the river 
reach schematic lines. When the river system schematic is hand drawn on the screen, the 
coordinates of the river reach lines are put into a simple coordinate system that ranges from 0.0 to 
1.0 in both the X and Y direction. However, the user has the option of taking real world coordinates 
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(such as UTM or State Plane coordinates) off of a map and entering them into this table. If the user 
decides to use real world coordinates, real world coordinates must be added for all of the reaches of 
the schematic. If this is not done, the schematic will still be displayed in the simple 0.0 to 1.0 
coordinate system (the hand drawn coordinates). Once real world coordinates have been entered for 
all of the river reaches, then the schematic will be drawn in that coordinate system. To enter/edit the 
reach schematic lines, select the Reach Invert Lines Table option from the GIS Tools menu. Once 
this option is selected, a window will appear allowing the user to enter/edit the coordinates of any of 
the reaches defined in the schematic (Figure 5-97).

Figure 5 97. GIS coordinates for River/Reach lines

XS Cut Lines Table: This option allows the user to numerically edit the coordinates of the cross 
section schematic lines. When the river system is hand drawn on the screen, the default coordinate 
system is a simple 0.0 to 1.0 range for both the X and Y direction. However, the user can add spatially 
references map layers into the HEC-RAS Geometry editor, to be used as background map layers. If 
the user adds spatially referenced background map layers, then the coordinate system used will be 
based on the background maps. As cross sections are entered, they are automatically scaled based 
on the coordinates of the river reach line and the main channel distance between cross sections. 
Each cross section is drawn as a straight line perpendicular to the river reach schematic line. The 
user has the option of entering the real world coordinates (UTM or State Plane) of the cross section 
schematic lines. Each cross section schematic line must have at least two points, a start and an end, 
but additional points can be added if the cross section was taken as a multi segmented line. In order 
for the cross section schematic lines to be plotted in the real world coordinate system, the user must 
enter real world coordinates for all of the cross sections in the reach. To enter/edit the cross section 
schematic lines, select the XS Cut Lines Table option from the GIS Tools menu. Once this option is 
selected, a window will appear allowing the user to enter/edit the coordinates of any of the cross 
section schematic lines. User's can also use the Measuring Tool feature built into HEC-RAS to 
digitize the appropriate locations of a cross section. The measure tool is accessed by holding down 
the Cntrl Key and using the mouse to lay out a line. Once the line is ended, statistics about the line 
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are shown on the screen and the X and Y coordinates of that line are sent to the Windows clipboard. 
The user can then paste them into the Cross Section Cut Line table if desired.

Lateral Structure Centerline Tables: This table allows user to enter/edit the X and Y coordinates 
that define the centerline of a Lateral Structure. Users can cut/past coordinates into the table. 
Additionally X, Y coordinates can be imported from Shapefiles (Import Lines). Also, the number of 
points in the table can be filtered down to a more manageable number of points using the Filter
option.

Storage Area/2D Flow Area Outlines Table: This option allows the user to enter/edit the X and Y 
coordinates that define the outline of a storage area or a 2D Flow Area. If you are using GIS data, 
these coordinates may be in the UTM or State Plane coordinate system. If you are not using GIS data, 
the coordinate system for the storage areas will just be in a 0 to 1.0 system. The coordinates of a 
storage area can also be edited graphically by using the Move Object option from the edit menu. The 
button called "Filter Multiple Lines" allows the user to select multiple storage areas and/or 2D Flow 
Areas, for filtering the number of points in the polygon that describes the storage area or 2D Flow 
Area. Once the user selects the storage areas and 2D Flow Areas to be filtered, they will be prompted 
for a point filter tolerance (default is 0.1). This tolerance is a collinear point filtering tolerance. The 
software puts a line between points 1 and 3, then if point 2 is a distance less that the tolerance away 
from that line, then it assumes that point two is not needed (i.e. the three points are basically on a 
straight line), so point to is dropped from the polygon perimeter.

Storage Area/2D Flow Area Connection Centerline Table: This option is used to define the 
coordinates of the hydraulic structure that is being used to connect two storage areas, or a storage 
area to a 2D Flow Area, or two 2D Flow Areas. The connection should be drawn from left to right 
looking in what the user considers to be the positive flow direction. This line will be drawn on the 
river system schematic, and will represent the hydraulic structure being used to connect two areas.

2D Flow Area Boundary Condition Lines: This option will show the coordinates of any 2D Flow Area 
external Boundary Condition lines.

Breaklines: This option brings up a table that shows the X and Y coordinates for each of the 
breaklines. Users can edit the X and Y coordinates directly, they can cut/paste values, and they can 
import breaklines from Shapefiles.

GIS Levee Lines Table: This option allows the user to edit/enter the coordinates for a user specified 
levee. Levees can be defined in the GIS system and imported into HEC-RAS. The coordinates will 
consist of X, Y, and Z (elevation).

Manning's n Calibration Regions Table: This option allows the user to enter/edit the X and Y 
coordinates that define the outline of the Manning's n Override/Calibration regions polygons.

Culvert Centerlines: There are two options under this menu option. The first is to Import Barrel 
Centerline from a Shapefile, and the second is to enter/edit the X and Y culvert barrel centerline 
coordinates.

GIS Ineffective Flow Area Table: This option allows the user to edit/enter the coordinates for a user 
specified ineffective flow areas. Ineffective flow areas can be defined in the RAS Mapper as a polygon. 
The coordinates will consist of X, Y, and Z (trigger elevation for when it will be turned off).
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GIS Cut Lines
The GIS Cut Lines menu item provides useful tools for quickly computing geospatial information for 
cross sections. The tools allow to georeference cross sections and to adjust the geospatial length of 
the cross section to match the width specified by the cross-section's station-elevation data.

Accept Displayed Locations (as Georeferenced). This tool allows the user set the GIS cut line x and 
y positions to the coordinates displayed in the Geometric data editor. You can do this for several 
cross sections at a time using this menu option, or you can do this one cross section at a time by 
using the left mouse button to click on a specific cross section.

Remove Georeferenced Cut Line Data: This option allows user's to select cross sections and then 
request that all the georeferenced coordinates for those cross sections be removed, and the cross 
section go back to being laid out as straight lines along the stream centerline. The location of the 
cross sections will be based on their river stationing and reach lengths between the cross sections.

Adjust Cut Line Lengths to Match XS Lengths. You can adjust the length of the cut line to match the 
width defined by the cross section's station-elevation data. This tool will invoke the table (Figure 
5-98) showing the river station, cut line length, cross section length, and ratio of cut line length to 
cross section length. You then specify how you would like to adjust the cut line: whether RAS should 
adjust the left side, right side, or both sides the line equally to make the cut line length equal to the 
cross section length.
Once you have decided which side to extend or trim, you then choose to adjust the cut line lengths or 
cross section lengths using the provided buttons.

Figure 5 98. Dialog for adjusting cross section and cut line lengths

Extend Cut Lines and Sta/Elev. The menu option to extend the cut line and station elevation data 
allows you to extend both the cut line and cross section in the left bank or right bank. This is used to 
extend the cross section to improve floodplain mapping and should only be used once the cross 
section has reached high ground. The dialog use for extending a cross section is shown in Figure 
5-99. 
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Figure 5 99. Dialog for extending a cut line.

Project XS to Straight Cut Line. This is an option to straighten a cross section based on its first and 
last point in the XS Cut Line. This option adjusts the Cut Line and the internal station/elevation data 
to match the new length of the line.

Reverse Cut Lines. This option will reverse the order of the horizontal coordinates of the cross 
section cut line. Cross sections must be laid out from left to right looking downstream. You can ask 
HEC-RAS to show you the direction a cross section line was laid out. If the cross section cut line is not 
laid out from left to right (but the station/elevation data are), you can reverse the cross section cut 
line with this option. If you need to reverse the order of the cross section cut line and the station/
elevation data, there is a separate tool to do that under the Tools menu of the Geometric Data 
editor.

Scale Cut Lines to Reach Lines

As discussed previously, the cross sections may look georeferenced, but they actually may not be. 
Cross sections that do not have geospatial information are drawn perpendicular to the stream 
centerline and the spacing is based on the downstream reach lengths.
By default, the Geometric Schematic scales the display of the cross sections based on the river 
network. This is handy when the data is not georeferenced (when the river schematic is very short 
when compared with real world distance), but we want to turn this option off when we georeference 
the cross sections. Select the GIS Tools | Scale Cut Lines to Reach Lines menu item to turn it on or 
off, the default is on.

GIS Coordinate Operations
The GIS Coordinate Operations allow you to switch the x an y coordinates; add and multiply the 
coordinates by a factor; and to filter points in the GIS lines for a few of the objects in HEC-RAS: 
reaches, cross sections, and storage areas/2D Flow Areas. These tools are useful if you accidentally 
imported the northing and easting data incorrectly. 
Other tools allow you to add and multiple the coordinate values. This is convenient for performing 
simple coordinate transformations or for removing a false northing or easting. Coordinate 
manipulation options are shown in Figure 5-100.
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Figure 5 100. Coordinate manipulation menu options.

Plot GIS Profile Reach Bounds
If you intend to perform a floodplain delineation based on the computed HEC-RAS results, you will 
need to verify what RAS thinks are the limits of the model. You can plot this information using the 
Plot GIS Profile Reach Bounds menu option for each water surface profile. After selecting this option 
you will need to choose the profile(s) to plot and river reach(es). The bounds will be plotted in 
magenta (by default) as illustrated in Figure 5-101.
The GIS Profile Reach Bounds is also referred to as the Bounding Polygon. This data will be used in 
the GIS to keep the floodplain delineation to occur only over the limits of the hydraulic model.

Figure 5 101. GIS bounding polygon information limits floodplain delineation to the area modeled in 
HEC-RAS
.
Limit GIS Bounds to Bridge Openings. This option will limit the GIS bounding polygon to the inside 
of a Bridge opening at all bridge locations.
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Example of Georeferencing an HEC-RAS Model
In this example the Baxter River dataset will be used demonstrate how to georeference an HEC-RAS 
model. Specifically, the River Network, Cross Sections, Storage Areas, and Storage Area connections, 
shown in the figure below, will be georeferenced using methods in HEC-RAS and using the GIS.

A non-georeferenced model schematic.

To successfully georeference a RAS model, you decide on a coordinate system and have at least one 
background dataset that has been projected to that coordinate system. A digital raster graphic (DRG) 
of a topographic quad sheet, an aerial photograph, or a digital terrain model (DTM) may be available 
for reference.

Once the coordinate system has been defined and a background dataset acquired, you should 
establish the stream centerline first. Georeferencing the river network will assist you in spatially 
locating the cross sections.

The river network may be created in either the GIS using HEC-GeoRAS or created directly in HEC-RAS; 
however, you will not have access to production level digitizing tools in HEC-RAS so this option is 
limited to very simply river networks.

Creating the River Network using HEC-GeoRAS
Open ArcMap and load the 3D Analyst and Spatial Analyst Extensions. Turn on the HEC-GeoRAS 
toolbar and Save the ArcMap document.

Set the Coordinate System for the data frame (map) and load the background data (image, DTM, 
etc). The GeoRAS tools for establishing the Stream Centerline topology require that you load a 
terrain model.
The Stream Centerline is used to establish the river reach network and is shown in Figure 5-103. The 
river network must be digitized in the direction of flow with reach end points coincident at junctions.
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Figure 5 103. River network for the Baxter River example dataset.

Digitize the stream centerlines for the river reaches shown. From the GeoRAS toolbar, select the RAS 
Geometry | Create Layer | Stream Centerline menu item.

Start editing the feature class by selecting the Editor | Start Editing menu item. The stream 
centerline must be created in the direction of flow, so start at the top end of the river and zoom in so 
that the channel is easily identified. 
Select "Create New Feature" for the Task and "River" for the Target feature class. Select the Sketch
tool and begin digitizing the line in the downstream direction. (Left-click drops a vertex.) Continue 
digitizing the line until you reach the junction. If you need to pan, simply select the Pan tool, pan 
through the map, and re-select the Sketch tool to continue digitizing. To finish the reach line at the 
junction, double-click to drop the endpoint.
Digitize each river reach, individually. There are three river reaches in total, with one junction at the 
confluence of Tule Creek. You will create the junction after creating all the reaches.
Creating a Junction. To create a junction, the endpoints of each reach must be coincident. While in 
Edit mode, select "Modify Features" for the Task. Next set the snapping tolerance, by selecting the 
Editor | Options menu item. On the General tab, set the Snapping Tolerance to "10" map units.

Next select the Editor | Snapping menu item. Click on snapping to the End points for the River layer, 
as shown Figure 5-104.

Figure 5 104. Select the option for snapping at end points
Next, select the Edit tool and grab the endpoint of a river reach line by pressing and holding the left 
mouse button. Move it towards another reach endpoint. When the point is within the snapping 
tolerance, a sketch of the endpoint will appear and snap to the endpoint. Release the mouse button 
and the endpoint will snap. The progression of steps to snap endpoints in illustrated in Figure 5-105. 
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Figure 5 105. Progression for creating a junction using snapping.

Repeat the snapping process for the other reach. Verify that the reach network has been created in 
the downstream direction by changing the line symbol to include and arrow at the end of the line. In 
a later step, you will use the GeoRAS tools to double-check the connectivity.

River and Reach Names. Each river must have a unique river name, and each reach within a river 

must have a unique reach name. Use the  (River Reach ID) tool to give each river reach a name.
Click on the River Reach ID tool to make it active. Use the cursor to select each river reach. The River 
and Reach Name dialog (shown in Figure 5-106) will appear allowing you to enter the river and reach 
name. For this example, the Baxter River has an Upper Reach and a Lower Reach and Tule Creek is a 
Tributary.

Figure 5 106. River and Reach name assignment dialog.

After labeling each River reach, look at the attributes for the River layer and verify that the River and 
Reach information was provided for each reach. To open the attribure table, right-click on the River 
layer and select the Open Attribute Table menu item.

Network Connectivity. To verify the river reach connectivity, select the RAS Geometry | Stream 
Centerline Attributes | Topology menu item. The fields FromNode and ToNode will be populated 
with integer data. Verify that the endpoints at the junction all share a common node number. The 
complete attribute table for the River layer is shown in Figure 5-107.

Figure 5 107. Completed Stream Centerline attribute table.
Lastly, run the RAS Geometry | Stream Centerline Attributes | Lengths/Stations menu item. This 
computes the length of each reach for determining the cross-section river stationing. The FromSta
and ToSta fields will be populated with the FromSta being the downstream endpoint of the reach. 
The FromSta and ToSta data are "backwards" from the FromNode and ToNode because the actual 
river stationing is calculated from downstream to upstream!
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Export the data by selecting the RAS Geometry | Extract GIS Data menu item. The dialog shown in 
Figure 5-108 will be invoked allowing you to choose the destination directory and filename. 

Figure 5 108. Filename and location for GIS export.

After pressing OK, GeoRAS will export the GIS data to an XML file and then convert the XML file to the 
SDF format. Two files will be created: "GIS2RAS.xml" and "GIS2RAS.RASImport.sdf". This process will 
take several seconds. The dialog shown inFigure 5-109 will appear when the process is has 
successfully created the files. You now have a file you can import into your RAS model.

Figure 5 109. Successful GIS data export dialog

Creating the River Network using HEC-RAS

If you don't have access to GIS tools or your river network is very simple, creating the river network in 
HEC-RAS is an option. To get started, open the RAS project that needs to be georeferenced.
Open the Geometric Data editor and create a New Geometry File. Add the background data by 

clicking on the Add Background Data  button. If the image does not come in correctly, select 
the View | Set Schematic Plot Extents menu item and press the Set to Computed Extents button 
in the Geometry Extents window shown in Figure 5-110. This will zoom out the bounds of the image.

Figure 5 110. Dialog for setting the display extents in HEC-RAS.

Press the OK button to use the new extent coordinates and to dismiss the window.
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Select the River Reach creation tool and digitize the Baxter River. You will want to be zoomed in to 
a reasonable scale. Digitize the centerline of the river in the downstream direction. You can pan by 
right clicking. This will pan the display window so that the mouse is centered. 
After double clicking to end the river the dialog shown in Figure 5-111 will be invoked to provide you 
a place to enter the River and Reach name.

Figure 5 111. River and reach name data entry dialog.

Create the Tule Creek Tributary. Make sure to end the line on the Baxter River at the confluence. 
You will then be asked if you would like to split the Baxter River. Select Yes and provide a reach name 
for the Lower Reach of the Baxter River. Next, provide a junction name.

Save the geometry. You will now have an HEC-RAS geometry that has a georeferenced River Network 
like that in Figure 5-112. This can be imported into an existing RAS geometry.

Figure 5 112. A georeferenced river network in HEC-RAS.

Importing the Stream Centerline

Once you have an import file created using GeoRAS or a geometry file created in RAS with a 
georeferenced stream centerline, you can import the stream centerline from either the GeoRAS 
export file or the RAS geometry file. The RAS Geometric Data importer works the same for either file.

Open HEC-RAS and load the non-georeferenced geometry shown in Figure 5-113. Save the geometry 
to a new geometry so that if anything goes wrong you won't destroy your existing model data.
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Figure 5 113. A non-georeferenced appears as a stick diagram in HEC-RAS.

Select the File | Import Geometry Data | GIS Import menu item. Select the RASImport.sdf file to 
import created using GeoRAS. (If you created the centerline in a RAS geometry file, select File | 
Import Geometry Data | HEC-RAS Format instead and choose the geometry file.)

HEC-RAS may display a warning or error message because it is expecting cross section data and the 
file only has the river network information. Continue through the error message.
Click on the River Reach Stream Lines tab. Note that the importer, as shown in Figure 5-114, thinks 
that the river reaches are all "new".

Figure 5 114. The HEC-RAS geometry importer looks to match the names in the import file with names in 
the RAS geometry file.

HEC-RAS thinks that the river reaches are new because the names in the import file do not match 
those that are in the existing RAS model. Select the appropriate names to import the river and 
reaches to by using the list boxes in the Import As columns. When completed, the Import Status will 
change to "exists", as shown in Figure 5-115.
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Figure 5 115. When river and reach names in the import file and geometry file match, the import status 
is "exists".
You are now ready to import the stream centerlines. Press the Finished-Import Data button. The 
stream centerline will import, replacing the existing river network. The HEC-RAS model will no longer 
look like a stick diagram, but will look georeferenced with a river network like that in Figure 5-116.

Figure 5 116. An HEC-RAS model with a georeferenced river network.

The cross sections look like they could be georeferenced, but they are not. They are actually drawn 
perpendicular to stream centerline and are spaced based on the channel downstream reach lengths. 
You can verify that the cross sections are not georeferenced by looking at the Cut Lines table. Select 
the GIS Tools | XS Cut Lines Table menu option. In the river station list box there is a label of "NO 
DATA!!" after each river station (see Figure 5-117).

Figure 5 117. Cross sections without cut line information display "NO DATA!!" in the river station list.

Note that the storage areas are also not georeferenced. We will complete the remainder of the 
georeferencing within the HEC-RAS Geometric Data editor.
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Storage Areas and Connections

Load the background image using the Add Background Data button and turn it on. Let's 
georeference the storage areas first.

Zoom into the area around the storage area on the north side of the river. Use the line creation tool 
available in RAS to create the outline of where the storage area should be. The line creation tool 
becomes active in any display in RAS when you press the Ctrl key.

Press the Ctrl key, while depressed, left-mouse click around the area that the storage area 
represents. When the polygon is completed, release the Ctrl key. The dialog shown in Figure 5-118 
will be displayed summarizing some of the line information and the x and y coordinates will be 
copied to the clipboard. Press the OK button to continue.

Figure 5 118. Summary dialog from the line creation tool.

Now you need to paste the spatial information into the storage area table. Select the GIS Tools | 
Storage Area Outlines Table. The table shown in Figure 5-119 will open with the previous outline 
information.

Figure 5 119. Storage area outline information.

Select the entire table by clicking in the upper left hand corner of the table, as shown in Figure 5-120, 
and paste the information using the Ctrl+V paste command. The coordinates of the line you create 
will replace the previous data. Press OK to accept the changes.
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Figure 5 120. Storage area outline information replaced with georeferenced data.

Georeference each storage area as you did for the first. The storage areas should finally look like 
those in Figure 5-121.

Figure 5 121. Geometric schematic with georeferenced storage areas.

Note that the storage area connection on the south side of the river is not georeferenced. You can 
georeference it the same as with the storage areas. Use the line creation tool to draw a line between 
the storage areas. Paste the results in the Storage Area Connections Lines Table accessible from 
the GIS Tools menu and the storage area connection will be drawn between the storage areas (see 
Figure 5-122).
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Figure 5 122. Geometric schematic with a georeferenced storage area connection.

Cross Sections

As discussed previously, the cross sections may look georeferenced, but they are not.  Cross sections 
that do not have geospatial information are drawn perpendicular to the stream centerline and the 
spacing is based on the downstream reach lengths.

By default, the Geometric Schematic scales the display of the cross sections based on the river 
network.  This is handy when the data is not georeferenced (when the river schematic is very short 
when compared with real world distance), but we want to turn this option off when we georeference 
the cross sections.  Select the GIS Tools| Scale Cut Lines to Reach Lines menu item, as shown in 
Figure 5-123, to remove the check.

Figure 5‑123. The Scale Cut Lines to Reach Lines menu item should be unchecked when using 
georeferenced data.

Cross sections should be georeferenced first at locations where you have a pretty good idea where 
they should go.   The hydraulic structures in your model are the place to start.  If you do not have 
bridges in your model, you should start by locating where the most downstream and most upstream 
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cross sections are located.  This will allow HEC-RAS to establish where the cross sections should be 
along the river using the channel downstream reach lengths.

For this example, we are going to start with the most upstream bridge on the Upper Reach of the 
Baxter River.  As shown in Figure 5-124, the bridge sections are located approximately 3000 ft 
upstream of the bridge and will need to be moved to the correct location.

Figure 5‑124. The bridge sections are upstream of the real world location.

Use the mouse to left click on the downstream bridge cross section and select the Move Cut Line 
Upstream/Downstream option.  The selected cross section and river centerline will be highlighted.  
Next, use the crosshairs and left click on the stream centerline just downstream of the bridge.  The 
cross section will be repositioned (see Figure 5-125) and RAS will georeference it based on the stream 
centerline, cross section width, and bank stations.

The model schematic will then update to reflect the changes to all the cross sections based on the 
position of the georeferenced cross sections.  A message will appear at the bottom of the schematic 
explaining to the user that all the cross sections do not have GIS information.  The georeferenced 
cross sections are green, while those without geospatial data will be brown.
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Figure 5‑125. The downstream bridge location has been georeferenced.

The downstream bridge cross section is not exactly where it should be, so use the edit tools to move 
the endpoints of the cross section.  Select the Edit | Move Object menu item.  This will place vertices 
on each cut line, as shown in Figure 5-126, and allow you to move the points using the mouse.  Move 
the points on the downstream bridge cross section.

Figure 5‑126. Vertices are display on the cut lines while in Move Object mode.

Do the same for the cross section on the upstream side of the bridge (see Figure 5-127), as well.  Note 
that as soon as you move a point on a cross section that is not georeferenced it becomes 
georeferenced!

Figure 5‑127. The upstream and downstream bridge cross sections have been georeferenced.

HEC-RAS will use the main channel reach lengths for determining where to lay out the cross sections, 
however, the stream centerline you created for georeferencing the model may not be identical the 
centerline used when the river hydraulics model was first created.  So you need to continue to 
position cross sections with known locations.
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Zoom into the RAS schematic to the bridge just upstream from the airport runway.  Note that the 
bridge river station position is about right on (see Figure 5-1286).  It was placed there based on the 
downstream reach length.  But to properly model this bridge, the cut line must follow the bridge out 
to high ground.  Therefore, the cut line had to bend to follow the road.  In this case, just moving the 
cut line points would be more difficult that using the line creation tool. Use the line creation tool to 
draw a line where the downstream bounding bridge cross section should be located.

Figure 5‑128. Bridges not perpendicular to the river require moving the bounding sections.

Once you have copied the cross section to the clipboard, paste it into the cut line table shown in 
Figure 5-129, as accessed through the GIS Tools | XS Cut Lines Table.

Figure 5‑129.  Cross section cut lines table data.

Press OK to accept your edits and the cross sections will look like those shown in Figure 5-130.
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Figure 5‑130.  The ratio of the cut line to cross section width is displayed next to the cross section 
(r=1.07).

The downstream bridge cross section is now georeferenced, but there are two key pieces of 
information displayed that show you a mistake (1) the bank stations are not on either side of the 
stream centerline and (2) the ratio of the cut line to cross section width is 1.07 [r=1.07].  You need to 
adjust the cut line by shortening the left side.   Use the Edit Object mode to move the left endpoint in 
until the banks are positioned correctly and the ratio is 1.  The display of the cut line to cross section 
ratio is turned on/off through the View | Display Ratio of Cut Line Length to XS Length menu item.

What happens if the bank positions move to the correct position but the ratio remains greater than 
1?  Move the right bank in.  The GIS Tools | GIS Cut Lines | Adjust Cut Line Lengths to Match Sta/
Elev option can also be used to adjust the cut line lengths.

Obviously, the next step is to georeferenced the cross section just upstream of the bridge.  Again, use 
the line creation tool and paste the cut line information into the cut line table.  Adjust the cut line as 
necessary to look like Figure 5-131.

Figure 5‑131. The downstream and upstream cut lines have been georeferenced.
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It looks like there are some problems with how cross sections intersect near the bridge.  We will need 
to remedy that problem of cross section intersecting.  Not only hydraulically incorrect but attempts 
to perform floodplain delineation will not be successful.  Prior to fixing overlapping cross sections, 
position all cross sections for which you know there location.

Reposition all cross sections around bridges.  Next, look at any cross sections that HEC-RAS may 
have placed in the correct location.  If any non-georeferenced cross section looks good, left click on 
that cross section and select the Accept Displayed Locations (as Georeferenced) menu item.  This 
will store the cross section line to the XS Cut Lines table.  If you want to accept the cut line 
information for more than one cross section, select the GIS Tools | GIS Cut Lines | Accept Displayed 
Locations (as Georeferenced) menu item and select the cross sections in the selection dialog.  The 
color of all of the cross sections will turn green.  The final, georeferenced geometry will look similar 
to that shown in Figure 5-132.  Now you can re-run the model and export the results to the GIS for 
floodplain mapping.

Figure 5‑132. A completely georeferenced HEC-RAS model.

Attaching and Viewing Pictures
The user can attach a picture to any cross section or hydraulic structure (bridge, culvert, etc.). Once 
pictures are attached, they can be viewed from a picture viewer within the HEC-RAS geometric data 
editor. The picture viewer supports the following graphics formats: bit map (.bmp); icon (.ico); 
windows metafile (.wmf); GIF (.gif); and JPEG (*.jpg).

Pictures are attached to cross sections or hydraulic structures from within the picture viewer. To 
bring up the picture viewer, go to the geometric data editor and click on the View Picture button 
with the left mouse button. An editor will appear as shown in Figure 5-133. To attach a picture to a 
particular river station, first select the River, Reach, and River Station in which you would like to 
attach the picture. Next select the Add Picture button, and a file selection box will appear allowing 
you to select a graphics file to attach to the selected location. If the picture file is not in the same 
location as your data files, you can select the drive and path of the picture from within the file 
selection box. Once a graphic file is located and selected, press the Open button to attach it to the 
selected location. The picture should automatically show up inside of the picture viewer. An example 
picture is shown in Figure 5-134. Additional pictures can be added by selecting a different location, 
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then select the Add Picture button to attach the picture. Only one picture can be attached to a 
model object.

Figure 5 133. HEC-RAS Picture Viewer

Once pictures are attached to the viewer, the user can move to different pictures by using the up and 
down arrow buttons, or selecting a specific river stationing that has a picture attached to it. Options 
are available to zoom in, zoom full, and Pan by right clicking on the picture. Additionally, when a 
picture is loaded, the Add Picture button changes to Remove Picture in order to delete it. The user 
can resize the picture viewer to whatever size they want. However, if you are viewing a bitmap 
picture, and you make the window larger than the actual picture resolution, the photo will begin to 
distort. 
Once pictures are attached to the geometry file, a small red square will be displayed on the river 
system schematic at each location where a picture exists. When the user clicks the left mouse button 
over a cross section, a pop up menu will appear. If that particular cross section has a picture 
attached to it, one of the menu options will be to view the picture. Selecting the View Picture option 
from the pop up menu will bring up the picture viewer and automatically load that particular picture.

The pictures are stored as part of the geometry data (not the actual picture, but its location on the 
hard disk). In general, it is a good idea to keep the picture files in the same directory as your project 
data files. This will make it easier to keep track of all the files associated with a particular project. 
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Figure 5 134. Picture Viewer with Example Bit Map Photo

Saving the Geometric Data
To save the geometric data, use the Save Geometry Data As option from the File menu of the 
Geometric Data window. When this option is selected, the user is prompted to enter a title for the 
geometric data. Once you have entered the title, press the OK button and the data will be saved to 
the hard disk. If the geometric data have been saved before (and therefore a title has already been 
entered), then it is only necessary to select the Save Geometry Data option. When this option is 
selected, the geometry data are saved with the previously defined title.

In general, it is a good idea to periodically save your data as you are entering them. This will prevent 
the loss of large amounts of information in the event of a power failure, or if a program error occurs 
in the HEC-RAS user interface.
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7 PERFORMING A STEADY FLOW ANALYSIS
This chapter discusses how to calculate steady flow water surface profiles. The chapter is divided 
into two parts. The first part discusses how to enter steady flow data and boundary conditions. The 
second part discusses how to develop a plan and perform the calculations.

Entering and Editing Steady Flow Data
Once all of the geometric data are entered, the modeler can then enter any steady flow data that are 
required. To bring up the steady flow data editor, select Steady Flow Data from the Edit menu on 
the HEC-RAS main window. The steady flow data editor should appear as below.

The user is required to enter the following information: the number of profiles to be calculated; the 
peak flow data (at least one flow for every river reach and every profile); and any required boundary 
conditions. The user should enter the number of profiles first. The next step is to enter the flow data. 
Flow data are entered directly into the table. Use the mouse pointer to select the box in which to 
enter the flow then type in the desired value.

Flow data are entered from upstream to downstream for each reach. At least one flow value must be 
entered for each reach in the river system. Once a flow value is entered at the upstream end of a 
reach, it is assumed that the flow remains constant until another flow value is encountered within 
the reach. The flow data can be changed at any cross section within a reach. To add a flow change 
location to the table, first select the reach in which you would like to change the flow (from the river 
and reach boxes above the table). Next, select the River Station location for which you want to enter 
a flow change. Then press the Add Flow Change Location button. The new flow change location will 
appear in the table. If the user wants to add multiple flow change locations, select the button labeled 
Add Multiple. This will bring up a window that will allow the user to select multiple locations all at 
one time.
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Each profile is automatically assigned a title based on the profile number, such as profile #1 is 
assigned a title of "Prof #1," profile #2 is assigned a title of "Prof #2," etc. The user can rename the 
title for each profile by simply going into the options menu and selecting Edit Profile Names. Once 
this option is selected, a dialog will appear allowing you to rename each of the profile titles.

Steady Flow Data Options
Several options are available from the steady flow data editor to assist users in entering the data. 
These features can be found under the Options menu at the top of the window. The following 
options are available:

Undo Editing. This option allows the user to retrieve the data back to the form that it was in the last 
time the Apply Data button was pressed. Each time the Apply Data button is pressed, the Undo 
Editing feature is reset to the current information.

Copy Table to Clipboard (with headers). This option allows the user to copy all of the reach, river, 
river station, and corresponding flow data to the clipboard. This can be very useful if you want to 
manipulate the data outside of HEC-RAS, such as in Excel.

Delete Row From Table. This option allows the user to delete a row from the flow data table. To use 
this option, first select the row to be deleted with the mouse pointer. Then select Delete Row From 
Table from the options menu. The row will be deleted and all rows below it will move up one.

Delete All Rows From Table. This option allows the user to delete all of the rows from the table. To 
use this option, select Delete All Rows From Table from the Options menu. When this option is 
selected a window will appear with a question to make sure that deleting all of the row is what you 
really want to do.

Delete Column (Profile) From Table. This option allows the user to delete a specific column 
(profile) of data from the table. To use this option, first select the column that you want to delete by 
placing the mouse over any cell of that column and clicking the left mouse button. Then select 
Delete Column (Profile) From Table from the Options menus. The desired column will then be 
deleted.

Ratio Selected Flows. This option allows the user to multiply selected values in the table by a factor. 
Using the mouse pointer, hold down the left mouse button and highlight the cells that you would like 
to change by a factor. Next, select Ratio Selected Flows from the options menu. A pop up window 
will appear allowing you to enter a factor to multiply the flows by. Once you press the OK button, the 
highlighted cells will be updated with the new values.

Edit Profile Names. This option allows the user to change the profile names from the defaults of 
PF#1, PF#2, etc.

Set Changes in WS and EG. This option allows the user to set specific changes in the water surface 
and energy between any two cross sections in the model. The changes in water surface and energy 
can be set for a specific profile in a multiple profile model. When this option is selected, a window 
will appear as shown in Figure 6-3. As shown, there are five options that the user can select from: 
Additional EG, Change in EG, Known WS, Change in WS, and K Loss. The Additional EG option 
allows the user to add an additional energy loss between two cross sections. This energy loss will be 
used in the energy balance equation in addition to the normal friction and contraction and 
expansion losses. The Change in EG option allows the user to set a specific amount of energy loss 
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between two cross sections. When this option is selected, the program does not perform an energy 
balance, it simply adds the specified energy loss to the energy of the downstream section and 
computes a corresponding water surface. The Known WS option allows the user to set a water 
surface at a specific cross section for a specific profile. During the computations, the program will 
not compute a water surface elevation for any cross section where a known water surface elevation 
has been entered. The program will use the known water surface elevation and then move to the 
next section. The Change in WS option allows the user to force a specific change in the water surface 
elevation between two cross sections. When this option is selected, the program adds the user 
specified change in water surface to the downstream cross section, and then calculates a 
corresponding energy to match the new water surface. The K Loss option allows the user to 
calculate an additional energy loss that will be added into the solution of the energy balance. This 
energy loss is calculated by taking the user entered K coefficient, times the velocity head at the 
current cross section being solved. The user entered K coefficient can range from 0.0 to 1.0. The K 
value is very analogous to a minor loss coefficient, as found in pipe flow hydraulics.

As shown in the figure above, to use the "Set Internal Changes in WS and EG" option, the user first 
selects the river, reach, river station, and profile that they would like to add an internal change too. 
Once the user has established a location and profile, the next step is to select one of the five 
available options by pressing the appropriate button. Once one of the five buttons are pressed, a row 
will be added to the table at the bottom, and the user can then enter a number in the value column, 
which represents the magnitude of the internal change or required coefficient.
Observed WS. This option allows the user to enter observed water surfaces at any cross section for 
any of the computed profiles. The observed water surfaces can be displayed on the profile plots, 
cross section plots, and in the summary output tables. To use this option select Observed WS from 
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the Options menu.

As shown in figure above, the user selected a River, Reach, and River Station location, then press the 
Add an Obs. WS Location (or Add Multiple) to enter a row in the table. Then enter the observed 
water surface for any of the profiles that are applicable. The column in the table labeled Dn Dist can 
be used to enter a distance downstream from the currently selected cross section, to further define 
the actual location of the observed water surface data.

Observed Rating Curves (Gages). This option allows the user to enter an observed rating curve at a 
gaged location for comparison with computed results. When the user enters an observed rating 
curve it will show up on the Rating Curve output plot along with the computed water surface versus 
flow information. To use this option select Observed Rating Curves (Gages) from the Options
menu.

As shown in the figure above, the user can Add or Delete a rating curve by pressing one of the 
buttons at the top. For each rating curve the user is required to select the River, Reach, and River 
Station that corresponds to the location of the gage. If the gage is not located exactly at one of the 
user entered cross sections, select the cross section up stream of the gage and then enter a distance 
downstream from that section to the gage. A description can optionally be entered for the gage. 
Stage and flow values should be entered for the mean value rating curve at that gage location. In 
addition to the mean rating curve, the user can enter the actual measured points that went into 
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developing the rating curve. This is accomplished by pressing the Measured Point Data button, 
which will pop up another editor. In the measured point data editor the user can enter the flow and 
stage for each measured point that has been surveyed for the gage. Additionally a description can be 
added for each point (i.e. 72 flood, slope-area measurement, etc…). If measured point data are also 
entered, then that data will show up on the rating curve plot when comparing the computed water 
surfaces to the observed.

Gate Openings. This option allows the user to control gate openings for any inline or lateral gated 
spillways that have been added to the geometric data. When this option is selected, a window will 
appear as shown in the figure below.

As shown in the figure above, for each profile the user can specify how many gates are opened per 
gate group, and at what elevation they are opened too. For the example shown in 6, there are three 
gate groups labeled "Left Group," "Center Group," and "Right Group." Each gate group has five 
identical gate openings. All of the gate openings have a maximum opening height of ten feet. For 
profile number 1, only the middle gate group is opened, with all five gates opened to a height of five 
feet. For the second profile, all three gate groups are opened. The Left gate group has two gates 
opened to seven feet, the Center gate group has five gates opened to four feet, and the Right gate 
group has two gates opened for seven feet. This type of information must be entered for all of the 
profiles being computed.

Optimize Gate Openings. This option allows the user to have the program compute a gate setting at 
a structure in order to obtain a user specified water surface upstream of the structure. Given a user 
entered flow and upstream stage for each profile, the program will iterate with different gate 
settings until the desired upstream water surface is obtained. This option is very handy when 
modeling dams and reservoirs.

Initial Split Flow Optimizations (LS and Pumps). This option allows the user to enter initial 
estimates of the flow that is leaving the main river through a lateral structure or a pump station. Flow 
values can be entered for each profile. When a value is entered for this option, that amount of flow is 
subtracted from the main river before the first profile is computed. This option can be useful in 
reducing the required computation time, or allowing the program to reach a solution that may not 
otherwise been obtainable.

Inline and Lateral Structure Outlet TS Flows: There is an option on the Inline Structure editor to 
add a time series of flows type of outlet. This is generally used for Unsteady flow modeling and 
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representing hydropower flows. However, if you are running a model in Steady Flow mode, you can 
still use this feature. The flow data for this feature will be just the flow rate for this outlet for each 
profile. The flow entered is a portion of the total flow going through the inline structure for that 
specific profile.

Storage Area Elevations. This option allows the user to enter water surface elevations for storage 
areas that have been entered into the geometric data. Storage areas are most often used in unsteady 
flow modeling, but they may also be part of a steady flow model. When using storage areas within a 
steady flow analysis, the user is required to enter a water surface elevation for each storage area, for 
each profile.

Saving Steady Flow Data

The last step in developing the steady flow data is to save the information to a file. To save the data, 
select the Save Flow Data As from the File menu on the steady flow data editor. A pop up window 
will appear prompting you to enter a title for the data.

Importing Steady Flow Data from DSS
HEC-DSS is a data base system that was specifically designed to store data for applications in water 
resources. The HEC-DSS system can store almost any type of data, but it is most efficient at storing 
large blocks of data (e.g., time-series data). These blocks of data are stored as records in HEC-DSS, 
and each record is given a unique name called a "pathname." A pathname can be up to 391 
characters long and, by convention, is separated into six parts. The parts are referenced by the 
letters A, B, C, D, E, and F, and are delimited by a slash "/" as follows:  /A/B/C/D/E/F/

The pathname is used to describe the data in enough detail that various application programs can 
write to and read data from HEC-DSS by simply knowing the pathname. For more information about 
HEC-DSS, the user is referred to the "HEC-DSS, User's Guide and Utility Manuals" (HEC, 1995).

Many of the HEC application programs have the ability to read from and write to the HEC-DSS. This 
capability facilitates the use of observed data as well as passing information between software 
programs. The ability to read data from HEC-DSS has been added to HEC-RAS in order to extract flow 
and stage data for use in water surface profile calculations. It is a common practice to use a 
hydrologic model (i.e., HEC-HMS) to compute the runoff from a watershed and then use HEC-RAS to 
compute the resulting water surface profiles.

Reading data from HEC-DSS into HEC-RAS is a two-step process. First, the user must establish 
connections between HEC-RAS cross-section locations and pathnames contained in the HEC-DSS 
file. These connections are established by selecting the "Set Locations for DSS Connections"
option from the File menu of the Steady Flow Data editor. When this option is selected, a window 
will appear as shown in the figure below. The user selects cross-section locations for DSS 
connections by selecting a River, Reach, and River Station, then pressing the "Add selected location 
to table" button. When this button is pressed, a new row will be added to the table at the top of the 
window. The user should do this for all the locations where they want to establish connections to 
HEC-DSS data.

The next step is to open a particular HEC-DSS file. The user has the option of either typing the 
filename in directly, or using the open button, which is right next to the filename field. Once a DSS 
file is selected, a listing of the pathnames for all of the data contained in that file will appear in the 
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table at the bottom of the window. The user can establish connections to more than one DSS file if 
desired.

To establish the connection between an HEC-RAS cross section and a particular pathname in the DSS 
file, the user selects the row in the upper table that contains the river station that they want to 
connect data to. Next, they select the pathname that they want to connect to that river station from 
the lower table. Finally, they press the button labeled "Select DSS Pathname," and the pathname is 
added to the table at the top of the window.

To make it easier to find the desired pathnames, a set of pathname part filters were added to the top 
row of the lower table. These filters contain a list of all the DSS pathname parts contained within the 
currently opened DSS file. If the user selects a particular item within the list of one of the pathname 
parts, then only the pathnames that contain that particular pathname part will be displayed. These 
filters can be used in combination to further reduce the list of pathnames displayed in the table. 
When a particular filter is left blank, that means that pathname part is not being filtered.

Another feature on the editor to assist in selecting the appropriate pathnames is the "Plot Selected 
Pathname" button. This button allows the user to get a plot or a table of the data contained within 
any record in the DSS file. The user simply selects a DSS pathname, and then presses the Plot 
Selected Pathname button, and a new window will appear with a graphic of the data contained 
within that record.

Once all of the pathname connections are set, the user presses the OK button to close the editor. The 
next step is to import the data. This is accomplished by selecting "DSS Import" from the File menu 
of the Steady Flow Data editor. When this option is selected, a window will appear as shown in the 
figure below.
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First the user sets a time window, which consists of a starting date and time and an ending date and 
time. When data are extracted from DSS, the program will only look at the data that is contained 
within the user specified time window.

Below the time window there are two options for selecting flow data to be extracted from the DSS 
file. The first option allows the user to pick off flow data at a specified time interval, starting with the 
beginning of the time window for the first profile. The second and subsequent profiles would be 
based on adding the user specified time interval to the start time of the time window. Flow data is 
extracted from the hydrographs at each of the locations being read from DSS. The second option 
listed on the window allows the user to get an overall peak flow for a profile computation. When this 
option is selected, the peak flow will be extracted from each hydrograph, within the time window 
specified. These peak flows will be made into the final profile in the flow data editor.

The bottom portion of the window contains options for interpolating flow data at locations that do 
not have hydrographs in the DSS file. After the flow data are read in, it will be necessary to 
interpolate flow data at all of the locations listed in the flow data editor that do not have values in 
the DSS file. Three options are available: no interpolation, linear interpolation, or using the flow data 
from an existing profile to calculated ratios for interpolating between points that have data. Once all 
the options are set, the user presses the "Import Data" button, to have the data imported and fill out 
the flow data editor.

Importing Steady Flow Data from an Existing Output Profile
This option allows the user to select an existing Plan from the current project, and to import flow 
data from that plans output into the current steady flow file. This can be a very handy option if you 
want to take the computed flows from an unsteady flow run and import them into a steady flow file, 
in order to make a steady flow analysis model. The user must already have all the flow change 
locations they want in the table first, before using this option.
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Performing Steady Flow Calculations
Once all of the geometry and steady flow data have been entered, the user can begin calculating the 
steady flow water surface profiles. To perform the simulations, go to the HEC-RAS main window and 
select Steady Flow Analysis from the Run menu. The Steady Flow Analysis window will appear as in 
Figure 6 9 (except yours may not have a Plan title and short ID).

Simulation Options
The following is a list of the available simulation options under the Options menu of the Steady Flow 
Analysis window:

Encroachments. This option allows the user to perform a floodway encroachment analysis. For a 
detailed description of how to use the floodway encroachment capabilities of HEC-RAS, see Steady 
Flow Floodway Encroachment Analysis. For a description of how the encroachment calculations are 
performed for the various encroachment methods, see the Hydraulic Reference Manual.

Flow Distribution Locations. Flow Distribution Locations have been removed as a simulation option, 
and are now a geometry level option. Subdividing the left overbank, main channel, and right overbank, 
for the purpose of computing additional hydraulic information can now be done through the Htab 
Parameters menu in the Geometry Editor. 

Conveyance Calculations. This option allows the user to tell the program how to calculate 
conveyance in the overbanks. Two options are available. The first option, At breaks in n values 
only, instructs the program to sum wetted perimeter and area between breaks in n values, and then 
to calculate conveyance at these locations. If n varies in the overbank the conveyance values are 
then summed to get the total overbank conveyance. The second option,

Between every coordinate point (HEC-2 style), calculates wetted perimeter, area, and conveyance 
between every coordinate point in the overbanks. The conveyance values are then summed to get 
the total left overbank and right overbank conveyance. These two methods can provide different 
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answers for conveyance, and therefore different computed water surfaces. The At breaks in n 
values only method is the default.

Friction Slope Methods. This option allows the user to select one of five available friction slope 
equations, or to allow the program to select the method based on the flow regime and profile type. 
The five equations are:

Average Conveyance (Default)
Average Friction Slope
Geometric Mean Friction Slope
Harmonic Mean Friction Slope
HEC-6 Slope Average Method

Set Calculation Tolerances. This option allows the user to override the default settings for the 
calculation tolerances. These tolerances are used in the solution of the energy equation. Warning !!!
- Increasing the default calculation tolerances could result in computational errors in the water 
surface profile. The tolerances are as follows:

Water surface calculation tolerance: This tolerance is used to compare against the difference 
between the computed and assumed water surface elevations. When the difference is less than the 
tolerance, the program assumes that it has a valid numerical solution. The default value is 0.01.

Critical depth calculation tolerance: This tolerance is used during the critical depth solution 
algorithm. The default value is 0.01.

Maximum number of iterations: This variable defines the maximum number of iterations that the 
program will make when attempting to balance a water surface. The default value is 20.

Maximum difference tolerance: This tolerance is used during the balance of the energy equation. As 
the program attempts to balance the energy equation, the solution with the minimum error 
(assumed minus computed water surface) is saved. If the program goes to the maximum number of 
iterations without meeting the specified calculation tolerance, the minimum error solution is 
checked against the maximum difference tolerance. If the solution at minimum error is less than this 
value, then the program uses the minimum error solution as the answer, issues a warning statement, 
and then proceeds with the calculations. If the solution at minimum error is greater than the 
maximum difference tolerance, then the program issues a warning and defaults the solution to 
critical depth. The computations then proceed from there. The default value is 0.30.

Flow Tolerance Factor: This factor is only used in the bridge and culvert routines. The factor is used 
when the program is attempting to balance between weir flow and flow through the structure. The 
factor is multiplied by the total flow. The resultant is then used as a flow tolerance for the balance of 
weir flow and flow through the structure. The default value is 0.001

Maximum Iteration in Split Flow: This variable defines the maximum number of iterations that the 
program will use during the split flow optimization calculations. The default value is 30.
Flow Tolerance Factor in Weir Split Flow: This tolerance is used when running a split flow optimization 
with a lateral weir/gated spillway. The split flow optimization continues to run until the guess of the 
lateral flow and the computed value are within a percentage of the total flow. The default value for 
this is 2 percent (.02).

Maximum Difference in Junction Split Flow: This tolerance is used during a split flow optimization at a 
stream junction. The program continues to attempt to balance flow splitting from one reach into two 
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until the energy gradelines of the receiving streams are within the specified tolerance. The default 
value is 0.02.

Each of these variables has an allowable range and a default value. The user is not allowed to enter a 
value outside of the allowable range.

Critical Depth Output Option. This option allows the user to instruct the computational program to 
calculate critical depth at all locations.

Critical Depth Computation Method. This option allows the user to select between two methods 
for calculating critical depth. The default method is the Parabolic Method. This method utilizes a 
parabolic searching technique to find the minimum specific energy. This method is very fast, but it is 
only capable of finding a single minimum on the energy curve. A second method, Multiple Critical 
Depth Search, is capable of finding up to three minimums on the energy curve. If more than one 
minimum is found the program selects the answer with the lowest energy. Very often the program 
will find minimum energies at levee breaks and breaks due to ineffective flow settings. When this 
occurs, the program will not select these answers as valid critical depth solutions, unless there is no 
other answer available. The Multiple Critical Depth Search routine takes a lot of computation time. 
Since critical depth is calculated often, using this method will slow down the computations. This 
method should only be used when you feel the program is finding an incorrect answer for critical 
depth.

Flow Optimizations. This option allows the user to have the program optimize the split of flow at 
lateral structures, lateral diversions, stream junctions, and pump stations. When this option is 
selected, a window will appear as shown in the figure below. There are four tabs to choose from. One 
tab is for each of the following: Junctions; Lateral Weirs/Diversions; Reach-Storage Areas; and Pump 
Stations.

When the Lateral Weir/Diversion tab is selected, a table with all of the lateral weirs/spillways and 
rating curves defined in the model will be displayed. To have the program optimize the split of flow 
between the main stream and a lateral weir/spillway (or rating curve), the user simply checks the 
column labeled "Optimize." If you do not want a particular lateral weir/spillway to be optimized, the 
user should not check the box. For the first iteration of the flow split optimization, the program 
assumes that zero flow is going out of the lateral structure. Once a profile is computed, the program 
will then compute flow over the lateral structure. The program then iteratively reduces the flow in 
the main channel, until a balance is reached between the main river and the lateral structure. The 
user has the option to enter an initial estimate of the flow going out the lateral structure. This can 
speed up the computations, and may allow the program to get to a solution that may not have 
otherwise been possible. This option is available by selecting "Initial Split Flow Values" from the 
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"Options" menu of the Steady Flow Data editor.

When the Junction tab is selected, the table will show all of the junctions in the model that have 
flow splits. To have the program optimize the split of flow at a junction, check the optimize column, 
otherwise leave it unchecked. Flow optimizations at junctions are performed by computing the 
water surface profiles for all of the reaches, then comparing the computed energy grade lines for the 
cross sections just downstream of the junction. If the energy in all the reaches below a junction is not 
within a specified tolerance (0.02 feet), then the flow going to each reach is redistributed and the 
profiles are recalculated. This methodology continues until a balance is reached.

When the Reach – Storage Areas tab is selected, a window will appear displaying all of the storage 
areas that are upstream boundaries to river reaches. If optimization is set to on for a particular 
storage area, the program will optimize the amount of flow coming out of the storage area, based on 
the user specified elevation of the storage area.

The final tab is for Pumps. When this tab is pressed a table will appear showing all of the locations 
where pump stations are connected to the main rivers. The user can then turn on optimization for 
the split of flow between the main river and the pump station.

Check Data Before Execution. This option provides for comprehensive data input checking. When 
this option is turned on, data input checking will be performed when the user presses the compute 
button. If all of the data are complete, then the program allows the steady flow computations to 
proceed. If the data are not complete, or some other problem is detected, the program will not 
perform the steady flow analysis, and a list of all the problems in the data will be displayed on the 
screen. If this option is turned off, data checking is not performed before the steady flow execution. 
The default is that the data checking is turned on.

Set Log File Output Level. This option allows the user to set the level of the Log file. The Log file is a 
file that is created by the computational program. This file contains information tracing the program 
process. Log levels can range between 0 and 10, with 0 resulting in no Log output and 10 resulting in 
the maximum Log output. In general, the Log file output level should not be set unless the user gets 
an error during the computations. If an error occurs in the computations, set the log file level to an 
appropriate value. Re-run the computations and then review the log output, try to determine why 
the program got an error.
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When the user selects Set Log File Output Level, a window will appear as shown in Figure 6-12. The 
user can set a "Global Log Level," which will be used for all cross sections and every profile. The user 
can also set log levels at specific locations for specific profiles. In general, it is better to only set the 
log level at the locations where problems are occurring in the computations. To set the specific 
location log level, first select the desired reach and river station. Next select the log level and the 
profile number (the log level can be turned on for all profiles). Once you have everything set, press 
the Set button and the log level will show up in the window below. Log levels can be set at several 
locations individually. Once all of the Log Levels are set, press the OK button to close the window.

View Log File. This option allows the user to view the contents of the log file. The interface uses the 
Windows Write program to accomplish this. It is up to the user to set an appropriate font in the Write 
program. If the user sets a font that uses proportional spacing, the information in the log file will not 
line up correctly. Some fonts that work well are: Line Printer; Courier (8 pt.); and Helvetica (8 pt.). 
Consult your Windows user's manual for information on how to use the Write program.

View Runtime Messages File. This option will allow the user to open a file that contains the runtime 
messages from the last time the Steady Flow model was computed.

Warning !!! - Setting the log output level to 4 or 5 can result in very large log file output. Log level 
values of 6 or larger can result in extremely large log files.
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8 PERFORMING A 1D UNSTEADY FLOW ANALYSIS
This chapter shows how to calculate unsteady flow water surface profiles using the 1D Unsteady 
Flow solver in HEC-RAS. If the user is interested in 2D modeling, or combined 1D/2D, please review 
the 2D Modeling User's Manual. The chapter is divided into four parts. The first part explains how to 
enter unsteady flow data and boundary conditions. The second part describes how to develop a plan 
and perform the calculations. The third part focuses on calibrating an unsteady flow model, and the 
last part talks about model accuracy, stability, and sensitivity.

Entering and Editing Unsteady Flow Data
Once all of the geometric data are entered, the modeler can then enter any unsteady flow data that 
are required. To bring up the unsteady flow data editor, select Unsteady Flow Data from the Edit
menu on the HEC-RAS main window.

Boundary Conditions
Initial Conditions
Unsteady Flow Options
Observed Data

Performing an Unsteady Flow Simulation
Once all of the geometry and unsteady flow data have been entered, the user can begin performing 
the unsteady flow calculations. To run the simulation, go to the HEC-RAS main window and select 
Unsteady Flow Analysis from the Run menu. The Unsteady Flow Analysis window will appear as in 
Figure 7-14 (except yours may not have a Plan title and short ID).
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Figure 7 14. Unsteady Flow Analysis Window

Calibrating Unsteady Flow Models
Calibration is the adjustment of a model's parameters, such as roughness and hydraulic structure 
coefficients, so that it reproduces observed data to an acceptable accuracy. The following is a list of 
common problems and factors to consider when calibrating an unsteady flow model.

Observed Hydrologic Data
Roughness Coefficients
River and  Floodplain Storage
Steps in the Calibration Process
Calibration Suggestions and Warnings

Model Accuracy, Stability, and Sensitivity
This section of the manual discusses model accuracy, stability, and sensitivity. In order to develop a 
good unsteady flow model of a river system, the user must understand how and why the solution of 
the unsteady flow equations becomes unstable. This knowledge will help you figure out why your 
particular model may be having stability problems. Additionally, it is important to understand the 
trade-offs between numerical accuracy (accurately solving the equations) and model stability. 

https://www.hec.usace.army.mil/confluence/display/RASUM/.Observed+Hydrologic+Data+v6.4
https://www.hec.usace.army.mil/confluence/display/RASUM/.Roughness+Coefficients+v6.4
https://www.hec.usace.army.mil/confluence/display/RASUM/.River+and+Floodplain+Geometry+v6.4
https://www.hec.usace.army.mil/confluence/display/RASUM/.Steps+To+Follow+in+the+Calibration+Process+v6.4
https://www.hec.usace.army.mil/confluence/display/RASUM/.Calibration+Suggestions+and+Warnings+v6.4


Performing a 1D Unsteady Flow Analysis

HEC-RAS User's Manual– 243

•
•

•
•

•
•
•
•

•
•

Finally, model sensitivity will be discussed in order to give you an understanding of what parameters 
affect the model and in what ways.

Model Accuracy
Model Stability

Finding and Fixing Stability Problems
Model Sensitivity

Dam and Levee Breach Modeling
Dam and levee breaching are a common application of the unsteady flow model in HEC-RAS because 
these processes are fundamentally unsteady. However, because of the rate of change and the 
uncertainties surrounding the parameters, these can be the most difficult unsteady flow modeling 
projects.

The HEC-RAS documentation has several sources of information on dam and levee breach modeling.  
This section includes an overview section and a section on each of the three major approaches to 
simulating the breach development:

Dam and Levee Breach Modeling with HEC-RAS
User Entered Breach Data
Simplified Physical Breaching
DL Breach

There is also more information in the:

Advanced Unsteady Features Documentation (separate dam and levee) and the
Technical Reference Manual

Entering and Editing Unsteady Flow Data
Once all of the geometric data are entered, the modeler can then enter any unsteady flow data that 
are required. To bring up the unsteady flow data editor, select Unsteady Flow Data from the Edit
menu on the HEC-RAS main window. The Unsteady flow data editor should appear as shown in 
Figure 7-1.

Unsteady Flow Data
The user is required to enter boundary conditions at all of the external boundaries of the system, as 
well as any desired internal locations, and set the initial flow and storage area conditions at the 
beginning of the simulation.
Boundary conditions are entered by first selecting the Boundary Conditions tab from the Unsteady 
Flow Data editor. River, Reach, and River Station locations of the external bounds of the system will 
automatically be entered into the table. Boundary conditions are entered by first selecting a cell in 
the table for a particular location, then selecting the boundary condition type that is desired at that 
location. Not all boundary condition types are available for use at all locations. The program will 
automatically gray-out the boundary condition types that are not relevant when the user highlights a 
particular location in the table. Users can also add locations for entering internal boundary 
conditions. To add an additional boundary condition location, select either the Add RS button or 
the Add Storage Area button. The Add RS button allows users to enter additional river station 
locations for boundary conditions. 

https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/model-accuracy-stability-and-sensitivity#id-.ModelAccuracy,Stability,andSensitivityv6.4-ModelAccuracy
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/model-accuracy-stability-and-sensitivity#id-.ModelAccuracy,Stability,andSensitivityv6.4-ModelStability
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/model-accuracy-stability-and-sensitivity/finding-and-fixing-model-stability-problems
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/model-accuracy-stability-and-sensitivity#id-.ModelAccuracy,Stability,andSensitivityv6.4-ModelSensitivity
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/performing-a-dam-or-levee-breach-analysis-with-hec-ras
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/performing-a-dam-or-levee-breach-analysis-with-hec-ras/user-enter-breach-data
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/performing-a-dam-or-levee-breach-analysis-with-hec-ras/simplified-physical-breaching
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/performing-a-dam-or-levee-breach-analysis-with-hec-ras/simplified-physical-breaching
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/advanced-features-for-unsteady-flow-routing/dam-break-analysis
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/advanced-features-for-unsteady-flow-routing/levee-overtopping-and-breaching
https://www.hec.usace.army.mil/confluence/rasdocs/ras1dtechref/latest/performing-a-dam-break-study-with-hec-ras
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The Add Storage Area button allows user to add storage area locations for insertion of a boundary 
condition.

Figure 7 1. Unsteady Flow Data Editor

Boundary Conditions
Initial Conditions
Unsteady Flow Data Options
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Boundary Conditions
There are several different types of boundary conditions available to the user. The following is a 
short discussion of each type:

Flow Hydrograph

A flow hydrograph can be used as either an upstream boundary or downstream boundary condition, 
but it is most commonly used as an upstream boundary condition. When the flow hydrograph button 
is pressed, the window shown in Figure 7-2 will appear. As shown, the user can either read the data 
from a HEC-DSS (HEC Data Storage System) file, or they can enter the hydrograph ordinates into a 
table. If the user selects the option to read the data from DSS, they must press the "Select DSS File 
and Path" button. When this button is pressed a DSS file and pathname selection screen will appear 
as shown in Figure 7-3. The user first selects the desired DSS file by using the browser button at the 
top. Once a DSS file is selected, a list of all of the DSS pathnames within that file will show up in the 
table. 
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Figure 7 2. Example Flow Hydrograph Boundary Condition
The user also has the option of entering a flow hydrograph directly into a table, as shown in Figure 
7-2. The first step is to enter a "Data time interval." Currently the program only supports regular 
interval time series data. A list of allowable time intervals is shown in the drop down window of the 
data interval list box. To enter data into the table, the user is required to select either "Use 
Simulation Time" or "Fixed Start Time." If the user selects "Use Simulation Time", then the 
hydrograph that they enter will always start at the beginning of the simulation time window. The 
simulation starting date and time is shown next to this box, but is grayed out. If the user selects 
"Fixed Start Time" then the hydrograph is entered starting at a user specified time and date. Once a 
starting date and time is selected, the user can then begin entering the data.
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Figure 7 3. HEC-DSS File and Pathname Selection Screen 
An option listed at the bottom of the flow hydrograph boundary condition is to make this boundary a 
"Critical Boundary Condition." When you select this option, the program will monitor the inflow 
hydrograph to see if a change in flow rate from one time step to the next is exceeded. If the change in 
flow rate does exceed the user entered maximum, the program will automatically cut the time step 
in half until the change in flow rate does not exceed the user specified max. Large changes in flow 
can cause instabilities. The use of this feature can help to keep the solution of the program stable. 
This feature can be used for multiple hydrographs simultaneously. The software will evaluate all of 
the hydrographs then calculate a time slice based on the hydrograph with the largest percentage 
increase over the user specified maximum flow change.

Two other options at the bottom of this editor are "Min Flow" and "Multiplier." Both of these 
options apply to user entered hydrographs or hydrographs read from HEC-DSS. The "Min Flow" 
option allows the user to specify a minimum flow to be used in the hydrograph. This option is very 
useful when too low of a flow is causing stability problems. Rather than edit the user entered 
hydrograph or the DSS file (depending upon where the hydrograph is coming from), the user can 
enter a single value, and all values below this magnitude will be changed to that value. The 
"Multiplier" option allows the user to multiply every ordinate of the hydrograph by a user specified 
factor. This factor will be applied to the user-entered hydrograph or a hydrograph read from HEC-
DSS.

Stage Hydrograph

A stage hydrograph can be used as either an upstream or downstream boundary condition. The 
editor for a stage hydrograph is similar to the flow hydrograph editor (Figure 7-2). The user has the 
choice of either attaching a HEC-DSS file and pathname or entering the data directly into a table.
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Stage and Flow Hydrograph

The stage and flow hydrograph option can be used together as either an upstream or downstream 
boundary condition. The upstream stage and flow hydrograph is a mixed boundary condition where 
the stage hydrograph is inserted as the upstream boundary until the stage hydrograph runs out of 
data; at this point the program automatically switches to using the flow hydrograph as the boundary 
condition. The end of the stage data is identified by the HEC-DSS missing data code of "-901.0". This 
type of boundary condition is primarily used for forecast models where the stage is observed data up 
to the time of forecast, and the flow data is a forecasted hydrograph.

Rating Curve

The rating curve option can be used as a downstream boundary condition. The user can either read 
the rating curve from HEC-DSS or enter it by hand into the editor. Shown in Figure 7-4 is the editor 
with data entered into the table. The downstream rating curve is a single valued relationship, and 
does not reflect a loop in the rating, which may occur during an event. This assumption may cause 
errors in the vicinity of the rating curve. The errors become a problem for streams with mild 
gradients where the slope of the water surface is not steep enough to dampen the errors over a 
relatively short distance. When using a rating curve, make sure that the rating curve is a sufficient 
distance downstream of the study area, such that any errors introduced by the rating curve do not 
affect the study reach.
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Figure 7 4. Example Rating Curve Boundary Condition Editor

Normal Depth

The Normal Depth option can only be used as a downstream boundary condition for an open-ended 
reach. This option uses Manning's equation to estimate a stage for each computed flow. To use this 
method the user is required to enter a friction slope (slope of the energy grade line) for the reach in 
the vicinity of the boundary condition. The slope of the water surface is often a good estimate of the 
friction slope, however this is hard to obtain ahead of time. The average bed slope in the vicinity of 
the boundary condition location is often used as an estimate for the friction slope.
As recommended with the rating curve option, when applying this type of boundary condition it 
should placed far enough downstream, such that any errors it produces will not affect the results at 
the study reach.
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Lateral Inflow Hydrograph

The Lateral Inflow Hydrograph is used as an internal boundary condition. This option allows the user 
to bring in flow at a specific point along the stream. The user attaches this boundary condition to the 
river station of the cross section just upstream of where the lateral inflow will come in. The actual 
change in flow will not show up until the next cross section downstream from this inflow 
hydrograph. The user can either read the hydrograph from DSS or enter it by hand.

Uniform Lateral Inflow Hydrograph

The Uniform Lateral Inflow Hydrograph is used as an internal boundary condition. This option allows 
the user to bring in a flow hydrograph and distribute it uniformly along the river reach between two 
user specified cross section locations. The hydrograph for this boundary condition type can be either 
read in from DSS, or entered by hand into a table.

Groundwater Interflow

The groundwater boundary condition can be applied to a river reach or a storage area. Groundwater 
can flow into, or out of, a reach or storage area, depending on the water surface head. The stage of 
the groundwater reservoir is assumed to be independent of the interflow from the river, and must be 
entered manually or read from DSS. The groundwater interflow is similar to a uniform lateral inflow 
in that the user enters an upstream and a downstream river station, in which the flow passes back 
and forth. The groundwater interflow option can also be linked directly to a storage area, for 
modeling groundwater exchange with ponding areas. The computed flow is proportional to the head 
between the river (or storage area) and the groundwater reservoir.

The computation of the interflow is based on Darcy's equation. The user is required to enter the 
coefficient of permeability (hydraulic conductivity, K, in feet/day), a time series of stages for the 
groundwater aquifer, and the distance between the river and the location of the user entered 
groundwater aquifer stages (this is used to obtain a gradient for Darcy's equation). If the 
groundwater time-series represents the stage immediately at the cross section (for instance if the 
user has detailed results from a groundwater model), then the user should enter the "K of the 
streambed sediment" and the "Thickness of the streambed sediments." If the groundwater time-
series is the stage some distance from the cross section (such as a monitoring well), then the user 
should enter an "Average K of the groundwater basin" and the "Distance between the river and the 
location of the groundwater stage."

Time Series of Gate Openings

This option allows the user to enter a time series of gate openings for an inline gated spillway, lateral 
gated spillway, or a gated spillway connecting two storage areas. The user has the option of reading 
the data from a DSS file or entering the data into a table from within the editor. Figure 7-5 shows an 
example of the Times Series of Gate Openings editor. As shown in Figure 7-5, the user first selects a 
gate group, then either attaches a DSS pathname to that group or enters the data into the table. This 
is done for each of the gate groups contained within the particular hydraulic structure.
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Figure 7 5. Example Time Series of Gate Openings Editor

Elevation Controlled Gate

This option allows the user to control the opening and closing of gates based on the elevation of the 
water surface upstream of the structure (Based on upstream WS); or based on the water surface at a 
user specified cross section or storage area (from any location in the model) (Based on specified 
reference); or based on a difference in water surface elevation from any two user defined reference 
locations (Based on difference in stage). A gate begins to open when a user specified elevation is 
exceeded. The gate opens at a rate specified by the user. As the water surface goes down, the gate 
will begin to close at a user specified elevation. The closing of the gate is at a user specified rate 
(feet/min.). If the gate operating criteria is a stage difference, the user can specify a stage difference 
for when the gate should open and a stage difference for when the gate should begin to close. Stage 
differences can be positive, zero, or negative values. The user must also enter a maximum and 
minimum gate opening, as well as the initial gate opening. Figure 7-6 shows an example of this 

Be Careful Opening or Closing Gates Too Quickly

Warning: Opening and closing gates too quickly can cause instabilities in the solution of the 
unsteady flow equations. If instabilities occur near gated locations, the user should either reduce 
the computational time step and/or reduce the rate at which gates are opened or closed.
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editor.

Figure 7 6. Elevation Controlled Gate Editor

Navigation Dam

This option allows the user to define an inline gated structure as a hinge pool operated navigation 
dam. The user specifies stage and flow monitoring locations, as well as a range of stages and flow 
factors. This data is used by the software to make decisions about gate operations in order to 
maintain water surface elevations at the monitor locations. A detailed discussion can be found in the 
Navigation Dams section.

Internal Boundary Stage and/or Flow Hydrograph

This option allows the user to enter a known stage hydrograph and/or a flow hydrograph, to be used 
as an internal boundary condition. The boundary condition can be used at a cross section 
immediately upstream of an inline structure in order to force a known stage and/or flow for part or 
all the simulation. It can also be used at an "open" cross section (one not associated with a hydraulic 
structure). For example, in order to force the water surface to match the water surface from known 
gage data. If the user enters only a stage hydrograph, then the program will force the stage at this 
cross section and it will solve for the appropriate flow (in order to balance the unsteady continuity 
and momentum equations). Similarly, if the user enters only a flow hydrograph, then the program 
will force the flow at this cross section and it will solve for the appropriate stage. The user may also 
enter both stage and flow data. In this case, the program will force the stage (and solve for flow) as 
long as there is stage data. Once the stage data runs out, the program will start using the flow data 
(force the flow and solve for stage). This can often be useful when performing a forecast. Regardless 
of whether a stage and/or flow hydrograph is entered, if all of the time series data runs out before 
the end of the simulation, then the program will treat the cross section as a regular cross section and 
will solve for both flow and stage in the normal manner.

https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/advanced-features-for-unsteady-flow-routing/navigation-dams
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The Internal Boundary (IB) Stage and Flow Hydrograph editor is shown in Figure 7-7. In the example 
above, the program will force the stage to be 108 feet up until the start of the simulation time (that is, 
during the initial backwater and warm up period) and then it will start using the flow data. The flow 
for the first \[non-warm up\] time step will be 1100 cfs transitioning to 1125 cfs over the next hour. 
After two hours, the program will no longer force either stage or flow but, instead, will solve for both 
in a normal manner. Note: For an inline structure that has known discharges for all or part of the 
simulation, entering a single stage at the start of the simulation is a quick and easy way to enter an 
initial stage. (The alternative way to enter an initial stage is to go to the *Options* menu on the 
Unsteady Flow Data editor and select *Internal RS Stages…{*}) For the simulation in Figure 7-7, if the 
user had entered another stage, for example 107.5 feet at 01:00 hours, then the program would 
transition down to a stage of 107.5 feet during the first hour. At the start of the second hour, the flow 
would immediately be forced to a value of 1125 cfs. These sudden transitions may cause stability 
problems if the values are too far out of balance. For instance, if the program computed a flow value 
of 4400 cfs in order to force a water surface of 107.5 at the end of the first hour, then the system will 
receive a "shock" as the flow is forced to 1125 during the next time step. If a known hydrograph is 
entered for an inline structure (i.e. for the cross section immediately upstream of the inline structure) 
that has gates, then a boundary condition for the gate operations must still be entered (time series, 
elevation control, etc.). When the hydrograph information runs out, the program will use the gate 
operations from the boundary conditions and will solve for the flow and stage at the inline structure 
in a normal manner (computing weir and/or gate flow). As with the change from a stage hydrograph 
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to a flow hydrograph, the change from known (stage or flow) hydrograph to normal inline operations 
can cause a "shock" if the new computed value is too far out of balance from the previous one. If the 
stage and/or flow hydrograph for a reservoir is entered for the entire simulation, then the physical 
characteristics of the inline structure will not affect the solution. In this situation, the inline structure 
does not even have to be entered into the geometry—the IB hydrograph could just be attached to an 
"open" cross section and the headwater and tailwater stages and flows would be the same. 
However, neither does it matter if the inline structure is included, and it may be convenient for 
display and/or output. If the user elects to use a DSS stage/flow hydrograph, then the "end of data" 
should be entered as a -901 in the DSS record, which is the missing data code for HEC-DSS. If the data 
is entered in the table, as shown in the example, then the end of data is a blank line. Do _not_ enter 
-901 in the table (unless this happens to be a real value). 

"Rules" Editor

Currently HEC-RAS has the ability for the user to develop their own set of rules for controlling Inline 
structures, Lateral Structures, and Storage area Connections. The details of how the "Rules" editor 
can be used can be found in the User Defined Rules for Hydraulic Structures section.

Meteorological Data

HEC-RAS now has the capability to have spatially varying precipitation, wind, and infiltration. Spatial 
precipitation and wind data are added into the Unsteady Flow Boundary Conditions editor. While 
infiltration information is defined as a spatial layer in HEC-RAS Mapper.

Spatial precipitation and wind data can be entered into HEC-RAS as either gridded data or point 
gage data. The spatial precipitation/wind data is added into HEC-RAS through the Unsteady Flow 
Boundary Conditions editor. When that editor is open, you will find a tab on the main window called 
"Meteorological Data".

Precipitation

This option allows the user to enter a precipitation hyetograph to either a Storage Area or a 2D Flow 
Area. This option allows the user to enter incremental precipitation vs time via table entry or read in 
through HEC-DSS. Note, when hand entering precipitation in the table, the value entered for a given 
time should be the incremental precipitation over the previous period. The precipitation is used for 
the entire storage area or 2D flow area, with no spatial variability. If you want to use precipitation 
that is variable both spatially and in time, you can do that from the Meteorological Data Tab. 

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=KMbV-cexP7w

https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/advanced-features-for-unsteady-flow-routing/user-defined-rules-for-hydraulic-structures-and-pumps
http://youtube.com/watch?v=KMbV-cexP7w
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NOTE: To learn how to enter and use spatial precipitation and/or wind data with HEC-RAS, please 
review the section called "Global Boundary Conditions" in the 2D Modeling User's Manual here.

Initial Conditions
In addition to the boundary conditions, the user must establish the initial conditions of the system at 
the beginning of the unsteady flow simulation. Initial conditions consist of flow and stage 
information at each of the cross sections, as well as elevations for any storage areas defined in the 
system. Initial conditions are established from within the Unsteady Flow Data editor by selecting the 
Initial Conditions tab. After the Initial Conditions tab is selected, the Unsteady Flow Data editor will 
appear as shown in Figure 7-8.
As shown in Figure 7-8, the user has two options for establishing the initial conditions of the system. 
The first option is to enter flow data for each reach and have the program perform a steady flow 
backwater run to compute the corresponding stages at each cross section. This option also requires 
the user to enter a starting elevation for any storage areas that are part of the system. This is the 
most common method for establishing initial conditions. Flow data can be changed at any cross 
section, but at a minimum the user must enter a flow at the upper end of each reach. To add 
additional river station locations to the table use the Add RS button. If the river system is dendritic 
(no loops anywhere in the system), the user can leave all of the flow data fields blank. When this is 
done the software gets flow data from the first value of all of the boundary condition hydrographs 
(Upstream and lateral inflows). Flows are set from upstream to downstream by adding flows 
together at junctions as appropriate.

The user can also enter an initial water surface elevation for all storage areas in the model. A storage 
area can start out dry by entering the minimum elevation of the storage area. The button called 
Import Min SA Elevations is an option to assist in getting the minimum elevation for any storage 
area. A new option introduced into HEC-RAS since version 5.0, is that user's can leave storage area 
elevations blank. If a storage area's initial conditions is left blank then generally it will start out dry. 
However, if that storage area is connected to a lateral structure, and the water surface in the river is 
higher than the lateral structures minimum weir elevation, then the storage area will be set to an 
average elevation of the water surface going over the weir. This option is very useful for setting the 
initial conditions in storage areas that are hydraulically connected right at the beginning of the 
simulation. Additionally, if a storage area is an upstream boundary of a river reach, and the initial 
conditions are left blank, then the storage area will be set to the same water surface elevation at the 
upstream cross section of that reach.

A second method is to read in a file of stages and flows that were written from a previous run, which 
is called a "Restart File." This option is often used when running a long simulation time that must be 
divided into shorter periods. The output from the first period is used as the initial conditions for the 
next period, and so on. Additionally, this option may be used when the software is having stability 
problems at the very beginning of a run. Occasionally the model may go unstable at the beginning of 
a simulation because of bad initial conditions. When this happens, one way to fix the problem is to 
run the model with all the inflow hydrographs set to a constant flow, and set the downstream 
boundaries to a high tailwater condition. Then run the model and decrease the tailwater down to a 
normal stage over time (use a stage hydrograph downstream boundary to do this). Once the 
tailwater is decreased to a reasonable value, those conditions can be written out to a file, and then 
used as the starting conditions for the unsteady flow run.

https://www.hec.usace.army.mil/confluence/rasdocs/r2dum/latest/boundary-and-initial-conditions-for-2d-flow-areas/global-boundary-conditions
https://www.hec.usace.army.mil/confluence/rasdocs/r2dum/latest/boundary-and-initial-conditions-for-2d-flow-areas/global-boundary-conditions
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Another option available is to set the initial flow and stage from a profile from a previous run. This 
option can be selected from the File menu, and it is called Set Initial Conditions (flow and stage) 
from previous output profile. When this option is selected, a window will appear allowing the user 
to select a plan and profile from an existing run in the project. Once the OK button is selected, then 
all of the flows and stages from that plan/profile will be set for the initial conditions of the current 
unsteady flow file. This option can be very handy when the initial conditions are causing some 
oscillation or stability problems in the run.

Figure 7 8. Initial Conditions Editor.

Unsteady Flow Data Options
Several options are available from the Unsteady Flow Data editor to assist users in entering and 
viewing the data. These features can be found under the Options menu at the top of the window. 
The following options are available:
Delete Boundary Condition. This option allows the user to delete a boundary condition from the 
table. To use this option, first select the row to be deleted with the mouse pointer. Then select 
Delete Boundary Condition from the options menu. The row will be deleted and all rows below it 



Performing a 1D Unsteady Flow Analysis

HEC-RAS User's Manual– 257

will move up one. Only user inserted boundary conditions can be deleted from the table. If the 
boundary condition is an open end of the system, the system will not allow that boundary to be 
deleted. There must always be some type of boundary condition at all the open ends of the system.
Internal RS Initial Stages. This option allows the user to specify starting water surface elevations for 
any internal cross section within the system. A common application of this would be to specify the 
starting pool elevation for the first cross section upstream of a dam (modeled with the inline 
structure option). The user specifies locations and water surface elevations, which are then used to 
establish the initial conditions of the system at the beginning of a run.
Flow Minimum and Flow Ratio Table. This option brings up a global editor that will show all the 
locations in which flow hydrographs have been attached as boundary conditions. The editor allows 
the user to enter a minimum flow or a flow factor for each flow hydrograph boundary condition. The 
minimum flow option will prevent any flow read from either HEC-DSS or a user entered hydrograph 
from going lower than the user specified minimum. Values that are lower than the minimum 
specified are automatically changed to the minimum value. The flow factor option allows the user to 
specify a factor to be multiplied by all ordinates of the flow hydrograph. This option is commonly 
used in planning type studies for performing sensitivity analysis (i.e. what if the flow were 20% 
higher?).

Observed Data
Observed data are entered into the Unsteady Flow Data editor from the Observed Data tab. This 
option allows the user to enter data in the form of observed time series data, high water marks, or 
an observed rating curves at a gage. When an observed time series is attached to a specific river 
station location, the user can get a plot of the observed flow or stage hydrograph on the same plot as 
the computed flow and stage hydrographs. Additionally the observed data will show up on profile 
and cross section plots. If high water marks are entered, they will show up on the cross section and 
profile plots when the Max Water Surface profile is being plotted. If an observed Rating curve from a 
gage is entered it will appear on the rating curve plot for comparison to the computed stage verses 
flow values.

Observed Stage and Flow Time Series Data

To use the observed time series option, the user selects the Observed Data tab from the Unsteady 
Flow Data editor. When this tab is selected the window will appear as shown in Figure 7-9. As shown 
in the figure below, the user first selects the button labeled "Select RS's". This will bring up a new 
window that will allow the user to choose cross section locations to add into the observed data 
table. In addition to cross section locations, the observed data tables will include any 2D Flow Area 
Boundary Condition lines (BC Lines), as well as any Reference Points added to 2D flow areas or 
storage areas. Observed flow and stage time series can be added to the BC Lines, while only 
observed stage time series can be added to reference points. 
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Figure 7 9. Observed Data tab for entering observed data 
Once the user has entered locations for the observed data, the next step is to press the "Edit" button 
above the data type you want to enter (i.e. Observed Stages; Observed Flows; or Observed Rating 
Curves). If the user presses the Edit button above the Observed Stage or Flow table, a window will 
appear as shown in Figure 7-10.
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Figure 7 10. Observed Stage Time Series Editor 
As shown in Figure 7-10, the window has two tabs. A "Detailed" tab and a "Table" tab. The detailed 
tab allows the user to view and edit data for one location at a time. The Table Tab allows the user to 
see the information for all the observed data locations. Whether you view the data in the detailed or 
table view, the user must first select a Source for the data. The "Source" options are: DSS; Table; 
Constant. Selecting DSS means the user has the observed data stored in an HEC-DSS file and wants 
to read the data from that DSS file. Selecting Table means the user wants to enter the data into a 
table directly in this editor. Selecting Constant means the user only has a "High Water Mark" for this 
location and wants to enter that High Water Mark as a "Constant" value. High Water Marks will be 
discussed in more detail below. 
There is also an option called "Use this Time Series". This option must be turned on for all observed 
data that you want to be used for a run. If this option is not turned on, then it will not be used during 
the run and the user will not be able to plot the observed data against the computed results in any of 
the plots.
If the DSS source is selected, then the user must select the DSS file to use from the Filename chooser, 
as shown in Figure 7-10. Then the user must select the specific DSS pathname that contains the 
observed data. The DSS filename and location, as well as the DSS pathname can be cut and pasted 
into these fields.
If the Table source is selected, then the window will add a table for entering the data. An example 
Table is shown in Figure 7-11 below.
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Figure 7 11. Table for entering Observed Time Series Data.
As shown in Figure 7-11, the table has a drop down at the top. This drop down allows the user to 
select how they want to enter the data. The options are:
Create Regular Interval Time Series: This option allows the user to enter the observed data at a 
regular interval, such as 1 hour, etc… The user can select to have the Observed data start at the 
beginning of the simulation time (Which is based on the time window for the run) or they can select 
to enter a fixed start time for the data.
Enter Date/Time in All Rows: This option allows the user to enter the data as irregular data, 
meaning the dates and time are not on a regular interval. For this method, the user must enter the 
data/time for all the observed values.
Enter Simulation Time in All Rows: This option allows the user to enter the simulation time 
Additionally, the user must select the Data Type; Time Interval; and the Units of the data. The Data 
Type can be: INST-VAL; PER-AVE; or PER-CUM. "INST-VAL" stands for instantaneous values, which is 
the most common for this type of data. "PER-AVE" stands for Period Average data, which means that 
the data is and average over the time period. "PER-CUM" stands for Period Cumulative, which means 
the data are cumulative values over the time period, and they are stored with a date and time at the 
end of the time period. PER-CUM does not make sense for observed time series data, but it is used for 
other data types, such as precipitation data.
If the Constant value is selected for the "Source" of the data, the window will change and only 
require the user to enter is single value and the units of that value. 
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High Water Marks

To enter Observed High Water Marks into HEC-RAS, select the Edit within the Observed Stages area, 
then select the Constant values as the data source. The editor will like what is shown in Figure 7-12

Figure 7 12. Observed High Water Marks entered ad Constant values. 
If the high water mark is not exactly at one of the user entered cross section locations, then the user 
should pick the cross section just upstream of the observed location and then enter the distance 
from that cross section to the observed high water mark under the column labeled Dn Dist.

Observed Rating Curves

To use the Observed Rating Curve option, the user presses the Edit button within the Observed 
Rating Curves portion of the window (Near the bottom). When this button is selected a window will 
appear as shown below in Figure 7-13.
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Figure 7 13. Observed Rating Curve Editor. 
As shown in Figure 7-13, the user can either enter the data in a Table, or it can be read in from DSS.
Water Temperature (for Unsteady Sediment). 
This option allows the user to put in a time series of water temperature data to be used in 
conjunction with the Unsteady Flow Sediment Transport capabilities. Water Temperatures are used 
for Fall velocities in computing sediment deposition.

Performing Unsteady Flow Calculations
Once all of the geometry and unsteady flow data have been entered, the user can begin performing 
the unsteady flow calculations. To run the simulation, go to the HEC-RAS main window and select 
Unsteady Flow Analysis from the Run menu. The Unsteady Flow Analysis window will appear as in 
Figure 7-14 (except yours may not have a Plan title and short ID).
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Figure 7 14. Unsteady Flow Analysis Window 

Defining a Plan
The first step in performing a simulation is to put together a Plan. The Plan defines which geometry 
and unsteady flow data are to be used, as well as provides a description and short identifier for the 
run. Also included in the Plan information are the selected programs to be run; simulation time 
window; computation settings; and the simulation options.
Before a Plan is defined, the user should select which geometry and unsteady flow data will be used 
in the Plan. To select a geometry or unsteady flow file, press the down arrow button next to the 
desired data type. When this button is pressed, a list will appear displaying all of the available files of 
that type that are currently available for the project. Select the geometry and unsteady flow file that 
you want to use for the current Plan.
To establish a Plan, select Save Plan As from the File menu on the Unsteady Flow Analysis window. 
When Save Plan As is selected, a window will appear prompting you to enter a title for the Plan. After 
you enter the title, press the OK button to close the window and accept the title. The user will also be 
prompted to enter a short identifier for the Plan. The short identifier is limited to 12 characters. It is 
very important to enter a short identifier that is descriptive of the Plan. When viewing multiple plan 
output from the graphics and tables, the Short ID will be used to identify each Plan.
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Selecting Programs to Run
There are three components used in performing an unsteady flow analysis within HEC-RAS. These 
components are: a geometric data pre-processor; the unsteady flow simulator; and an output post-
processor. Additionally, there is an option to automate the process of computing a Static flood 
inundation map (Depth Grid), or other static map layers (i.e. Arrival time grids, flood duration grids, 
etc…) after the unsteady flow simulation has finished. Computing static (Grids to disk) inundation 
maps is accomplished by checking the Floodplain Mapping option under the Programs to Run area. 
However, this option will only work if you have previously set up the computation of Static Map 
Layers for this particular Plan in HEC-RAS Mapper. Please see the Chapter on HEC-RAS Mapper in this 
document, for details on how to do this.

Geometric Preprocessor
The Geometric Preprocessor is used to process the geometric data into a series of hydraulic 
properties tables, rating curves, and family of rating curves. This is done in order to speed up the 
unsteady flow calculations. Instead of calculating hydraulic variables for each cross-section, during 
each iteration, the program interpolates the hydraulic variables from the tables. The preprocessor 
must be executed at least once, but then only needs to be re-executed if something in the 
geometric data has changed.

Cross Section Property Tables

Cross sections are processed into tables of elevation versus hydraulic properties of areas, 
conveyance, and storage. The preprocessor creates hydraulic property tables for the main channel, 
and the floodplain. The floodplain hydraulic property tables are a combination of the left overbank 
and right overbank properties summed together in a single set of curves called the "Floodplain". The 
Unsteady flow engine uses a simple arithmetic average of the left and right overbank reach lengths 
in order to compute a floodplain reach length (i.e. the floodplain reach length is computed as the left 
overbank reach length plus the right overbank reach length, then divide by 2). The floodplain reach 
length is used to calculate storage volume, friction losses, etc… and all other hydraulic properties 
used in the continuity and momentum equation for the floodplain area. This is different than what is 
done in the steady flow computational program, in which it computes left overbank and right 
overbank hydraulic properties separately.

Each hydraulic property table contains a minimum of 21 points (a zero point at the invert and 20 
computed values), and can have up to a maximum of 100 points. The user is required to set an 
interval to be used for spacing the points in the cross section tables. The interval can be the same for 
all cross sections or it can vary from cross section to cross section. This interval is very important, in 
that it will define the limits of the table that is built for each cross section. On one hand, the interval 
must be large enough to encompass the full range of stages that may be incurred during the 
unsteady flow simulations. On the other hand, if the interval is to large, the tables will not have 
enough detail to accurately depict changes in area, conveyance, and storage with respect to 
elevation.

The interval for the cross section tables is defined as part of the geometric data. To set this interval, 
the user selects the HTab Parameters (Hydraulic Table Parameters) button from the Geometric 
Data editor. When this option is selected, a window will appear as shown in the figure below.
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As shown in Figure 7-15, the table contains three columns in which the user can enter a Starting 
Elevation, Increment, and Number of Points. The first time the user opens this editor all of the 
columns are automatically filled. The starting elevation columns are automatically filled to an 
elevation one foot higher than the invert. However, the user can change the starting elevation values 
to whatever they want. The second and third columns are used for the table increment and the 
number of points. These two variables will describe the extent to which the table encompasses the 
cross section data. A default value will be set for the increment and the number of points. Normally 
the increment will be set to one foot, and the number of points will be set to a value that will allow 
the table to extend to the top of the cross section. If this combination would end up with less than 20 
points, then the number of points is set to 20 and the increment is reduced to get the table to the top 
of the cross section. The user can set these values individually for each cross section, or they can 
highlight a series of cross sections and use the Set Values button to enter the value for all of the 
highlighted sections. Other options are available to multiply highlighted fields by a factor or add a 
constant to all of them. Additionally, cut, copy, and paste are available for manipulating the data 
(using standard windows function keys). Warning: The hydraulic tables for cross sections must be 
high enough to capture all possible water surface elevations. It is up to the user to ensure that 
the combination of the increment and number of points produces a table that will extend to a 
high enough elevation. If the computed water surface goes above the table, properties are 
extrapolated by extending the last to points linearly. This extrapolation can often cause the 
model to go unstable.

Three additional fields are also in the table, under the heading of "Horizontal Velocity Mapping". 
These fields are used for computing more detailed velocity estimates within a cross section, than the 
default of a single average value in the left overbank, main channel, and the right overbank. These 
fields can be used to enter a number of slices to further discretize the computation of average 
velocities within a cross section. These vertically and horizontally averaged velocities are used for 
mapping velocity within the 1D cross sectional flow fields. Once the Geometric preprocessor is run, 
the user can view the cross section hydraulic property tables for the channel and floodplain from the 
HEC-RAS interface. During steady flow profile computations, the program will calculate the flow, 
area, wetted perimeter, percentage of conveyance, and average velocity for each of the user defined 
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slices. For details on how the flow distribution output is actually calculated, see Chapter 4 of the 
HEC-RAS Hydraulic Reference Manual. For information on viewing the flow distribution output, see 
Chapter 9 of the User's Manual (this manual).

Hydraulic Structure Property Tables

Hydraulic structures, such as bridges and culverts, are converted into families of rating curves that 
describe the structure as a function of tailwater, flow, and headwater. The user can set several 
parameters that can be used in defining the curves. To set the parameters for the family of rating 
curves, the user can select the "HTab Parameters" button from the Bridge and Culvert editor or 
from the Storage Area Connection editor. When this button is pressed, the window in Figure 7-16 
will appear:

Figure 7 16. Hydraulic Properties Table for Bridges/Culverts 
As shown in Figure 7-16, the user can set the number of points to be computed on the free-flow 
rating curve (maximum of 100 points); the number of submerged curves to be computed (maximum 
of 60); and the number of points on the submerged curves (maximum of 50). The default values for 
these parameters are 50, 50, and 20 respectively. Additionally, the user can refine the curves by 
setting limits on the extent of the curves. This can be accomplished by entering the head water 
maximum elevation (required), tail water maximum elevation (optional), and the maximum possible 
flow (recommended). In general, the curves will come out better if the user enters a headwater 
maximum elevation and a maximum flow rate.

Viewing the Preprocessor Hydraulic Properties Tables

 Once Hydraulic Table parameters have been entered for the cross sections and the structures, 
and the preprocessor has been run, the user can view the computed curves by either selecting 
Hydraulic Property Plots from the View menu of the main HEC-RAS window, or by pressing the HT
button on the main HEC-RAS window. When this option is selected the following window will appear.
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Figure 7 17. Plot of Hydraulic Property Tables Computed by the Preprocessor. 
As shown in Figure 7-17, the user can plot properties for cross sections, internal boundaries (Bridges 
and culverts), or storage area connections by selecting the type of plot from the Type menu option. 
Additionally the information can be viewed in tabular form by selecting the Table tab on the plot. 
The user should view all of the computed curves for their model closely to ensure that they are 
hydraulically appropriate.
Structures that are gated, such as gated spillways, are not converted into curves because it would 
require a new family of curves for each possible gate setting. The hydraulics through gated 
structures is calculated on the fly during the unsteady flow calculations. No hydraulic table 
parameters are required for gated structures. Additionally, if a storage area connection is set up as a 
weir only, it can either be preprocessed into curves, or the user has the option of having the program 
compute the hydraulics on the fly for each time step.

Unsteady Flow Simulation
The unsteady flow computational program in HEC-RAS uses the same hydraulic calculations (cross 
section properties, bridge and culvert hydraulics, weirs, gated structures, etc…) that HEC developed 
for steady flow, however, the solution of the unsteady flow equations (Continuity and momentum 
equation) are solved using a unique skyline matrix solver developed by Dr. Robert Barkau for his 
UNET (Unsteady NETwork model) program. The unsteady flow simulation is actually a three-step 
process. First data is read from HEC-DSS, if necessary, and then converted into the user specified 
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computation interval. Next, the RasUnsteady.exe program runs. This software reads the hydraulic 
properties tables computed by the pre-processor, as well as the boundary conditions and flow data 
from the interface. The program then performs the unsteady flow calculations. The final step is a 
program called RasDSSWriter.exe. This software takes the results from the RasUnsteady.exe run and 
writes the stage and flow hydrographs to an HEC-DSS file.

Post-Processor
The Post-Processor is used to compute detailed hydraulic information for a set of user specified time 
lines during the unsteady flow simulation period. In general, the unsteady flow computations only 
compute stage and flow at all of the computation nodes, as well as stage and flow hydrographs at 
user specified locations. If the Post Processor is not run, then the user will only be able to view 
the stage and flow hydrographs, and inundation mapping (HEC-RAS Mapper), no other output 
from HEC-RAS. By running the Post Processor, the user will have all of the available plots and tables 
for unsteady flow that HEC-RAS normally produces for steady flow.

By default, the Post-Processor will compute detailed output for a maximum stage water surface 
profile. This profile does not represent any specific instance in time, but rather represents a profile of 
the maximum stage that occurred at each cross section during the entire simulation. This profile is 
often useful for getting a quick view of the maximum extent of flooding during a specific event. If you 
only want to get this maximum envelope profile, then simple select "Max. Prof." from the Detailed 
Output Interval drop down list.

In addition to the maximum water surface profile, the user can request the software to write out a 
series of instantaneous profiles at a specific time interval. This is accomplished from the 
Computation Settings section of the Unsteady Flow Analysis window. The user turns on this 
option by selecting an interval from the box labeled Detailed Output Interval. The Post-Processor 
will then compute detailed output for each of the instantaneous profiles requested, as well as the 
maximum stage envelope profile. When the unsteady flow program runs, flow and stage water 
surface profiles are written to DSS for the entire system, starting with the beginning of the simulation 
and then at the user specified time interval for the entire simulation.

When the Post-Processor runs, the program reads from HEC-DSS the maximum water surface profile 
and the instantaneous profiles (stages and flows). These computed stages and flow are sent to the 
HEC-RAS steady flow computation program RasSteady.exe. Because the stages and flows are already 
computed, the RasSteady.exe program does not need to calculate a stage, but it does calculate all of 
the hydraulic variables that are normally computed for steady flow. This consists of over three 
hundred hydraulic variables that are computed at each cross section for each flow and stage.

WARNING: The purpose of the post processor is to compute hydraulic output variables that are 
not computed by the Unsteady Flow computational engine. However, the Post Processor is 
actually just the Steady Flow computational engine. There are a few differences between 
assumptions made in the steady flow and the unsteady flow computations engines that will 
affect some of the post processor output. For example, the unsteady flow engine combines the 
left and right overbanks areas into a single "Floodplain" flow area, while the steady flow 
engine computes hydraulics for the left and right overbank separately. Therefore, some of the 
post processor output is computed like the steady flow program performs computations, even 
though the unsteady flow program makes some different assumptions. Specifically, the 
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computation of left and right overbank cumulative volumes is based on separate reach lengths 
in the steady flow program, and the post processor. However, the unsteady flow program 
combines the left and right overbank hydraulic properties in the equations, and uses a simple 
average of the two overbank lengths to compute volumes between the cross sections in the 
floodplain area. Also, the bridge computations are performed with a set of pre computed 
curves in the unsteady flow engine, while the steady flow engine computes the hydraulics 
through the bridge each time. These differences can lead to some small differences in some of 
the post processor output, as compared to how the Unsteady flow engine actually performs 
hydraulic calculations.

At hydraulic structures such as bridges and culverts, the unsteady flow program only reports the 
stage just upstream and downstream of the structure. During the Post-Processing of the results, the 
Steady.exe program calculates the hydraulics of the structures by using the computed tailwater and 
flow, and then performing detailed hydraulic structure calculations. This is done so that the user can 
see detailed hydraulic information inside of the hydraulic structures for each of the profiles that are 
being post processed. However, this process can produce slightly different results for the upstream 
headwater elevation. Occasionally, you may notice a water surface elevation computed from the 
Post-Processor that is higher at the structure than the next upstream sections water surface. This 
difference is due to the fact that the unsteady flow simulation uses a pre-computed family of rating 
curves for the structure during the unsteady flow calculations. The program uses linear interpolation 
between the points of the rating curves to get the upstream headwater for a given flow and tailwater. 
The Post-Process performs the calculations through the structure and does not use rating curves (it 
solves the actual structure equations).

Once the Post-Processor is finished running, the user can view output from all of the HEC-RAS plots 
and tables. The maximum water surface profile and user specified instantaneous profiles can be 
viewed by selecting Profiles from the Options menu on each of the output windows (tables or plots). 
The overall maximum water surface profile will be labeled "Max W.S.", while the instantaneous 
profiles are labeled by the date and time. For example, a profile from January 5, 1999 at 1:00 p.m. 
would be labeled "05Jan1999 1300".

WARNING: Specifying a detailed output interval for post processing that is small can lead to 
long computational times and huge output files. Select this interval wisely, in that you only get 
detailed output when you really need it.

Simulation Time Window
The user is required to enter a time window that defines the start and end of the simulation period. 
The time window requires a starting date and time and an ending date and time. The date must have 
a four digit year and can be entered in either of the two following formats: 05Jan2000 or 
01/05/2000. The time field is entered in military style format (i.e. 1 p.m. is entered as 1300).

Unsteady Flow Computation Settings
The Computation Settings area of the Unsteady Flow Analysis window contains: the computational 
interval; hydrograph output interval; detailed output interval; Mapping Output Interval; a 
computation level output flag; the name and path of the output DSS file, and whether or not the 
program is run in a mixed flow regime mode.
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The computation interval is used in the unsteady flow calculations. This is probably one of the most 
important parameters entered into the model. Choosing this value should be done with care and 
consideration as to how it will affect the simulation. The computation interval should be based on 
several factors. First, the interval should be small enough to accurately describe the rise and fall of 
the hydrographs being routed. A general rule of thumb is to use a computation interval that is equal 
to or less than the time of rise of the hydrograph divided by 20. In other words, if the flood wave goes 
from its base flow to its peak flow in 10 hours, then the computation interval should be equal to or 
less than 0.5 hours (30 Minutes). This way of estimating the time step tends to give an upper 
boundary as to what the value should be.

A second way of computing the appropriate time step is by applying a numerical accuracy criteria 
called the Courant condition. The Courant condition criteria looks at cross section spacing and flood 
wave velocity. The basic premise is that the computational interval should be equal to or less than 
the time it takes water to travel from one cross section to the next. A detailed description of the 
Courant condition can be found under the Model Accuracy, Stability, and Sensitivity section of this 
chapter. Use of a time step based on the Courant condition will give the best numerical solution, but 
it may cause the model to take a lot longer to run.

Additional considerations must be made for hydraulic structures, such as bridges, culverts, weirs, 
and gated spillways. Within bridges and culverts, when the flow transitions from unsubmerged to 
submerged flow, the water surface upstream of the structure can rise abruptly. This quick change in 
water surface elevation can cause the solution of the unsteady flow equations to go unstable. One 
solution to this problem is to use a very small time step, on the order of 1 to 5 minutes. This allows 
the module to handle the changes in stage in a more gradual manner. Additionally, when gates are 
opened or when flow just begins to go over a lateral weir, the change in stage and flow can be 
dramatic. Again, these types of quick changes in stage and flow can cause the solution of the 
unsteady flow equations to go unstable. The only solution to this problem is to shorten the 
computational time step to a very short interval. This may require the user to set the value as low as 
1 to 5 minutes. The time step should be adjusted to find the largest value that will still solve the 
equations accurately. Additional variables that affect stability are the number of iterations and the 
Theta weighting factor. These two variables are discussed under the calculation tolerances section 
below.

The Hydrograph Output Interval is used to define at what interval the computed stage and flow 
hydrographs will be written to HEC-DSS. This interval should be selected to give an adequate 
number of points to define the shape of the computed hydrographs without losing information 
about the peak or volume of the hydrographs. This interval must be equal to or larger than the 
selected computation interval.

The Detailed Output Interval field allows the user to write out profiles of water surface elevation 
and flow at a user specified interval during the simulation. Profiles are not written for every 
computational time step because it would require too much space to store all of the information for 
most jobs. Also, when the Post-Processor is run, the program will compute detailed hydraulic 
information for each one of the instantaneous profiles that are written. This option is turned on by 
selecting an interval from the drop-down box next to the detailed hydrograph output label. The 
selected interval must be equal to or greater than the computation interval. However, it is suggested 
that you make this interval fairly large, in order to reduce the amount of post-processing and storage 
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required for a detailed hydraulic output. One example for selecting this variable would be, if the time 
window of the simulation was set at 72 hours, then one might want to set the instantaneous profiles 
to an interval of every 6 hours. This would equate to 13 profiles being written out and having detailed 
hydraulic information computed for them.

Mapping Output Interval. This field is used to enter the interval at which the user will be able to 
visualize mapping output within HEC-RAS Mapper. A limited set of output is written to a separate 
HDF5 output file that corresponds to the Plan file. For example, if you are running Plan 1, the Plan 
filename will be something like "filename.p01". An output file will be written out by the unsteady 
flow computational program, with the name "filename.p01.hdf". This file will contain results from 
the unsteady flow simulation, written out at the interval the user defines for the Mapping Output 
Interval. The user will then be able to visualize spatial mapping output in HEC-RAS Mapper based on 
this time interval.

Computation Level Output. This option will instruct the program to write out a limited set of 
variables for each cross section at each computational time step to a separate output file. The 
variables that are written to this file are: water surface elevation; flow; maximum depth of water in 
the main channel; numerical error in the calculated water surface elevation; numerical error in the 
calculated flow; average velocity in the channel; and average velocity of the entire section. After a 
simulation is complete the user can plot and tabulate each of these variables spatially, or as a time 
series at an individual cross section. Because this output is at the computational time step level, it 
can be very useful in debugging model stability problems. The user can get to plots and tables of this 
information by selecting the Unsteady Flow Spatial Plot or the Unsteady Flow Time Series Plot
options from the View menu of the main HEC-RAS window. Detailed descriptions of plotting and 
tabulating this output can be found under the Viewing Results Chapter of this manual.

Warning: Turning the Computation Level Output option on can create very large output files and it 
will also potentially slow down the computations. This option writes several output variables to a file 
for all locations in the model and for every computational time step. If you have a large data set and/
or are running it for a long simulation time period, this file will be very large.

The field labeled DSS Output Filename is required before an execution can be made. The program 
will always write some results to a HEC-DSS file, so the user is required to select a path and filename 
to be used for this information. Hydrographs written to the DSS file are based on the user selected 
hydrograph output locations, as well as some default locations that HEC-RAS will always output a 
hydrograph.

Unsteady Flow Simulation Options
From the Options menu of the Unsteady Flow Analysis window, the following options are available: 
stage and flow output locations; flow distribution locations; flow roughness factors; seasonal 
roughness factors; unsteady encroachments; dam breach; levee breach; ungaged lateral inflows; 
mixed flow options; time slicing; calculation options and tolerances; output options; friction slope 
methods for cross sections and bridges; initial backwater flow optimizations; run time 
computational options; checking data before execution, viewing the computation log, and viewing 
the computational log file.
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Stage and Flow Output Locations. This option allows the user to specify locations where they want 
to have hydrographs computed and available for display. By default, the program sets locations of 
the first and last cross section of every reach. To set the locations, the user selects Stage and Flow 
Output Locations from the Options menu of the Unsteady Flow Analysis window. When this option 
is selected a window will appear as shown in Figure 7-18.

Figure 7 18. Stage and Flow Hydrograph Output Window.

As shown in Figure 7-18, the user can select individual locations, groups of cross sections, or entire 
reaches. Setting these locations is important, in that, after a simulation is performed, the user will 
only be able to view stage and flow hydrographs at the selected locations.
Flow Distribution Locations. This option allows the user to specify locations in which they would 
like the program to calculate flow distribution output. The flow distribution option allows the user to 
subdivide the left overbank, main channel, and right overbank, for the purpose of computing 
additional hydraulic information.

The user can specify to compute flow distribution information for all the cross sections (this is done 
by using the Global option) or at specific locations in the model. The number of slices for the flow 
distribution computations must be defined for the left overbank, main channel, and the right 
overbank. The user can define up to 45 total slices. Each flow element (left overbank, main channel, 
and right overbank) must have at least one slice. The flow distribution output will be calculated for 
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all profiles in the plan during the computations.
Flow Roughness Factors. This option allows the user to adjust roughness coefficients with changes 
in flow. This feature is very useful for calibrating an unsteady flow model for flows that range from 
low to high. Roughness generally decreases with increases flow and depth. This is especially true on 
larger river systems. This feature allows the user to adjust the roughness coefficients up or down in 
order to get a better match of observed data. To use this option, select Flow Roughness Factors
from the Options menu of the Unsteady Flow Simulation manager. When this option is selected, a 
window will appear as shown in Figure 7-19.
As shown in Figure 7-19, the user first selects a river, reach, and a range of cross sections to apply the 
factors to. Next a starting flow, flow increment, and a number of increments is entered. Finally, a 
roughness factor is entered into the table for each of the flows. Between the user entered flows, the 
model will use linear interpolation to obtain a roughness factor. If a flow is greater than the last user 
entered value, then that value is held constant. The user can create several sets of these factors to 
cover a range of locations within the model. However, one set of factors cannot overlap with another 
set of factors. Hence, you can only apply one set of roughness change factors to any given cross 
section.

Additionally, if you place these factors in both the geometry and the plan file, then you will be 
factoring the roughness twice. Factors placed in the geometry file get used during the Geometry Pre-
Processing, and they will affect the hydraulic tables that get computed. Factors placed in the Plan 
file are used in real time during the unsteady flow computations, and they get applied each time step 
at each cross section location. 

Flow Roughness factors is available as an option in both the Geometry Editor (saved with the 
geometry data) and the Plan Editor (saved in the plan file). If you put these factors in the 
geometry editor, they will be applied to every event that uses that geometry file. Normally you 
would do this when flow roughness factors are needed for a wide range of events, and you can 
come up with a set of factors that works well from low to high events. If you want to use flow 
roughness factors for real time calibration, or you believe they are much more event specific, 
then you would place them in the Plan File. When placed in the Plan file, they only get applied to 
that event being run with that plan.
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Figure 7 19. Flow versus Roughness Change Factors Editor

Seasonal Roughness Change Factors. This option allows the user to change roughness with time of 
year. This feature is most commonly used on larger river systems, in which temperature changes can 
cause changes in bed forms, which in turn causes changes in roughness. This factor can be applied in 
conjunction with the flow roughness change factors. When applying both, the seasonal roughness 
factor gets applied last.  To use this option, select Seasonal Roughness Factors from the Options
menu of the Unsteady Flow Simulation manager. When this option is selected a window will appear 
as shown in Figure 7-18.

As shown in Figure 7-20, the user first selects a river, reach, and range of river station to apply the 
factors to. Next the user enters the day and month in the Day column, for each time that a new 
roughness factor will be entered. By default the program will automatically list the first of each 
month in this column. However, the user can change the day to whatever they would like. The final 
step is to then enter the roughness change factors. During the simulation, roughness factors are 
linearly interpolated between the user entered values.
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Figure 7 20. Seasonal Roughness Factors Editor

Automated Roughness Calibration. This option allows the user to perform an automated 
manning's n value calibration for an unsteady flow model. The results of this option are a set of flow 
versus roughness relationships, that can be applied in order to obtain a model that is calibrated from 
low to high flows. 
To use this option, the user should first adjust the base Manning's n values (Channel and overbank 
values) in order to get a reasonable starting point for the automated calibration technique. The base 
set of Manning's n values should be within what is considered to be reasonable values for the type of 
river and overbank land use they are being applied to.

After a base set of Manning's n values are established, the user must break up the model into reaches 
for the purpose of applying and calibrating flow versus roughness factors. Once the flow versus 
roughness factors are set up, then the automated calibration of those reaches can be performed. 
To use this option, select Automated Roughness Calibration from the Options menu of the 
Unsteady Flow Simulation manager. When this option is selected a window will appear as shown in 
Figure 7-21.
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Figure 7 21. Automated Manning's n Value Editor

For a detailed discussion of the Automated Manning's n value editor and how to use this feature, 
please see Chapter 16 Advanced Features for Unsteady Flow Routing.
Unsteady Flow Encroachments. This option allows the user to perform an encroachment analysis 
using the unsteady flow simulation option. Currently, encroachments are limited to method 1 within 
the unsteady flow analysis module. In general the user should first perform the encroachment 
analysis with the steady flow computations module, as documented in Chapter 10 of this manual. 
Once a good steady flow encroachment analysis is completed, the final encroachments can be 
imported into the unsteady flow plan for further analysis and refinement. The user will need to have 
two unsteady flow plans, one without encroachments (representing the base flood) and one with 
encroachments (representing the encroached floodplain).

To add encroachments to an unsteady flow plan, the user selects Unsteady Encroachments from 
the Options menu of the Unsteady Flow Simulation editor. When this option is selected the following 
window will appear:
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Figure 7 22. Unsteady Flow Encroachment Data Editor

As shown in Figure 7-22, the user can enter a left station and a right station for the encroachments at 
each cross section. Additionally, the user has the option to import the encroachments calculated 
from a steady flow plan. This is accomplished by pressing the button labeled Get Encroachments 
from Steady Flow Plan, which is shown in the upper right part of the editor. When this button is 
pressed the user is asked to select a previously computed steady flow plan, and a specific profile 
from that plan. When the user presses the OK button, the program will go and get the final computed 
encroachments from that particular steady flow plan and profile.

Once all of the encroachments are entered, the user presses the OK button to have the interface 
accept the data. However, this information is not stored to the hard disk, the user must save the 
currently opened plan file for that to happen. The next step is to run the unsteady flow analysis with 
the encroachment data. The user should have two unsteady flow plans, one without encroachments 
and one with encroachments. Once both plans have been successfully executed, then comparisons 
between the plans can be made both graphically and in a tabular format.
Ungaged Lateral Inflows. This option can be used to automatically figure out the contribution of 
runoff from an ungaged area, given a gaged location with observed stage and flow. The software will 
compute the magnitude of the ungaged area hydrograph, based on routing the upstream flow 
hydrograph and subtracting it from the observed downstream flow hydrograph to get the ungaged 
inflow contribution. This is an iterative process, in which the program figures out a first estimate of 
the ungaged inflow, then reroutes the upstream and ungaged inflow again, until the routed 
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hydrograph matches the downstream observed hydrograph within a tolerance. More details of this 
simulation option can be found in Chapter 16 of this manual.

Computational Options and Tolerances. This option allows the user to set some computation 
options and to override the default settings for the calculation tolerances. These tolerances are used 
in the solution of the unsteady flow equations. There are separate tabs for: General; 2D Flow 
Options; 1D/2D Options; Advanced Time Step control; and 1D Mixed Flow Options.

When the "Calculation Options and Tolerances: option is selected, a window will appear as shown in 
Figure 7-23.

Figure 7 23 Computational Options and Tolerances with 1D Options tab shown.

The calculation options and tolerances are as follows:
General (1D Options) (see Figure 7-23):
Theta (implicit weighting factor): This factor is used in the finite difference solution of the unsteady 
flow equations. The factor ranges between 0.6 and 1.0. A value of 0.6 will give the most accurate 
solution of the equations, but is more susceptible to instabilities. A value of 1.0 provides the most 
stability in the solution, but may not be as accurate for some data sets. The default value is set to 1.0. 
Once the user has the model up and running the way they want it, they should then experiment with 
changing theta towards a value of 0.6. If the model remains stable, then a value of 0.6 should be 
used. In many cases, you may not see an appreciable difference in the results when changing theta 
from 1.0 to 0.6. However, every simulation is different, so you must experiment with your model to 
find the most appropriate value.

Increasing the default calculation tolerances could result in computational errors in the water 
surface profile.
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Theta for warm up: The unsteady flow solution scheme has an option to run what we call a "warm up 
period" (explained below). The user has the option to set a different value for theta during the warm 
up period versus the simulation period. 

Water surface calculation tolerance: This tolerance is used to compare the difference between the 
computed and assumed water surface elevations at cross sections. If the difference is greater than 
the tolerance, the program continues to iterate for the current time step. When the difference is less 
than the tolerance, the program assumes that it has a valid numerical solution. The default value is 
set to 0.02 feet.

Storage area elevation tolerance: This tolerance is used to compare the difference between 
computed and assumed water surface elevations at storage areas. If the difference is greater than 
the tolerance, the program continues to iterate for the current time step. When the difference is less 
than the tolerance, the program can go on to the next time step. The default tolerance for storage 
areas is set to 0.05 feet.

Flow calculation tolerance: This tolerance is used to compare against the numerical error in the 
computed flow versus the assumed flow for each iteration of the unsteady flow equations. The user 
enters a flow in cfs (or cms in metric data sets). The software monitors the flow error at all 
computational nodes. If the flow error is greater than the user entered tolerance, then the program 
will continue to iterate. By default, this option is not used, and is therefore only used if the user 
enters a value for the tolerance.

Maximum error in water surface solution: This option allows the user to set a maximum water surface 
error that will cause the program to stop running if it is exceeded. The default value is 100 ft. If during 
the computations, a numerical errors grows larger than this tolerance at any node, the program will 
stop the simulation at that point and issue a message saying that the maximum water surface error 
tolerance has been exceeded.

Maximum number of iterations: This variable defines the maximum number of iterations that the 
program will make when attempting to solve the unsteady flow equations using the specified 
tolerances. The default value is set to 20, and the allowable range is from 0 to 40.

Maximum Iterations without improvement (0-40): This option allows the user to set a maximum 
number of iterations in which the solver can iterate without improving the answer. This option is not 
used by default. If turned on, it can increase the speed of the computations, but may cause larger 
errors or instabilities to occur if not used correctly. A good starting point for this option would be 5. 
What this means is, that if the program iterates five times and does not improve any of the solution 
errors, at all nodes in the system, then it will stop iterating and use the previous iteration that had 
the best answers up to that point. The premise here is that if the iteration scheme is not able to 
improve the solution for 5 consecutive iterations, more than likely it is not going to improve, and 
there is no point in wasting computational time by iterating all the way to the maximum number of 
iterations.

Number of warm-up time steps: Before the user entered simulation period begins, the program can 
run a series of time steps with constant inflows. This is called a warm-up period. This is done in order 
to smooth the profile before allowing the inflow hydrographs to progress. This helps to make a more 
stable solution at the beginning of the simulation. The default number of warm-up time steps is set 
to 0. This value ranges from 0 to 200.
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Time step during warm-up period: During the warm-up period described in the previous paragraph, it 
is sometimes necessary to use a smaller time step than what will be used during the unsteady flow 
calculations. The initial conditions from the backwater analysis uses a flow distribution in the 
reaches which is often different than that computed by unsteady flow. This can cause some 
instabilities at the beginning of the simulation. The use of a smaller time step during the warm-up 
period helps to get through these instabilities. The default is to leave this field blank, which means to 
use the time step that has been set for the unsteady flow simulation period.

Minimum time step for time slicing: The program has an option to interpolate between time steps 
when it finds a very steep rise in an inflow hydrograph (see flow hydrograph boundary conditions 
earlier in this chapter). This option allows the user to set a minimum time step to use when the 
program starts reducing time steps during a steep rise or fall in flow at a flow boundary condition. 
This prevents the program from using to small of a time step during time slicing.

Maximum number of time slices: This option defines the maximum number of interpolated time steps 
that the program can use during time slicing, as described in the previous paragraph.
Lateral Structure flow stability factor: This factor is used to increase the stability of the numerical 
solution in and around a lateral structure. This factor varies from 1.0 to 3.0. As the value is increased, 
the solution is more stable but less accurate. A value of 1.0 is the most accurate, but is susceptible to 
oscillations in the computed lateral flow. The default value is 1.0. If you observe oscillations in the 
computed flow over a lateral structure, you should first check to see if you are using a small enough 
computation interval. If the computation interval is sufficiently small, you should then try increasing 
this coefficient to see if it solves the problem.

Inline Structure flow stability factor: This factor is used to increase the stability of the numerical 
solution in and around an Inline Structure. This factor varies from 1.0 to 3.0. As the value is increased, 
the solution is more stable but less accurate. A value of 1.0 is the most accurate, but is susceptible to 
oscillations in the computed flow. The default value is 1.0. If you observe oscillations in the 
computed flow over the inline structure, you should first check to see if you are using a small enough 
computation interval. If the computation interval is sufficiently small, you should then try increasing 
this coefficient to see if it solves the problem.

Weir flow submergence decay exponent: This coefficient is used to stabilize the solution of flow over a 
weir for highly submerged weirs. This factor varies from 1.0 to 3.0. As the headwater and tailwater 
stages become closer together, occasionally oscillations in the solution can occur. This exponent will 
prevent this from happening. The default value of one has no effect. As you increase the coefficient, 
dampening of the oscillations will occur. See the section called Model Accuracy, Stability, and 
Sensitivity later in this chapter for greater detail on this factor.

Gated Spillway flow submergence decay exponent: This coefficient is used to stabilize the solution of 
flow over a gated spillway for highly submerged flows. This factor varies from 1.0 to 3.0. As the 
headwater and tailwater stages become closer together, occasionally oscillations in the solution can 
occur. This exponent will prevent this from happening. The default value of 1.0 has no effect. As you 
increase the coefficient, dampening of the oscillations will occur. See the section called Model 
Accuracy, Stability, and Sensitivity later in this chapter for greater detail on this factor.

DSS Messaging Level: This option will control the amount and detail of messages that get written to 
the Log File when reading and writing data to HEC-DSS. A value of 1 is minimal information and a 
value of 10 turns on the maximum amount of information. The default for this variable is 4.
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Wind Forces: This option allows you to pick a frame of reference for computing wind forces, as well as 
which Drag (friction) Formulation equation to use. The default Reference Frame is Eulerian, which 
means the speed of the wind is based on a fixed point and does not account for the direction or 
speed of the water. If the user selects Lagrangian, then the software will take into account the speed 
and direction of the water to obtain the net speed of the air over the water. The Drag Formulation 
allows the user to select from one of four Drag coefficient equations, or to enter a constant drag 
coefficient. The default is the Hsu 1988 equation. Please see the Hydraulic Reference manual for 
more information on these equations.

Geometric Preprocessor Options: This section of the 1D computational options allows the user to 
control whether or not the program will read in previously computed curves for internal boundary 
conditions, like bridges and culverts, etc.. Or the user can force the geometric pre-processor to 
recomputed all internal boundary conditions.

1D Numerical Solution: By default the 1D equation solver uses a Finite Difference scheme with a 
Skyline/Gaussian reduction matrix solution technique to solve the 1D Unsteady flow equations. 
There is an option to use the "Pardiso" matrix equation solver. We have found that even though the 
Pardiso solver can make use of multiple processor cores, the Skyline matrix solver is generally faster 
for dendritic river systems. However, for large, complex, looped systems, the Pardiso solver may 
produce faster computational results. The user should try the Pardiso solver is they have a larger 
complex system of interconnected reaches. If you turn on the Pardiso solver, there is an option to 
control the number of processor cores used for solving the matrix. By default, "All Available" will be 
used. However, the speed of the solution is sensitive to the number of cores used, and it is not 
always faster with using the maximum number of cores available. So user's should test the number 
of cores to get the maximum computational speed benefit.

A new 1D Finite Volume solution scheme has been added to HEC-RAS as an option. This numerical 
scheme is similar to what we do in our 2D Finite Volume solver. 
The current 1D Finite Difference solution scheme has the following deficiencies:

1.Cannot handle starting or going dry in a XS
2.Low flow model stability issues with irregular XS data.
3.Extremely rapid rising hydrographs can be difficult to get stable
4.Mixed flow regime (i.e. flow transitions) approach is approximate
5.Stream junctions do not transfer momentum

The new 1D Finite Volume approach has the following positive attributes:

1.Can start with channels completely dry, or they can go dry during a simulation (wetting/
drying).
2.Very stable for low flow modeling
3.Can handle extremely rapid rising hydrographs without going unstable.
4.Handles subcritical to supercritical flow, and hydraulic jumps better.
5.Junction analysis is performed as a single 2D cell when connecting 1D reaches (continuity and 
momentum is conserved through the junction).

However, there are some draw backs to the new 1D Finite Volume solution scheme. These 
deficiencies are:

1.You cannot use lidded cross sections with the new 1D Finite Volume solution scheme. Which 
also means that it cannot handle pressurize flow, even with the Priessman slot option turned 



Performing a 1D Unsteady Flow Analysis

HEC-RAS User's Manual– 282

on. If you have lidded cross sections, as soon as the water hits the high point of the lids low 
chord it will go unstable.
2.The 1D Finite Volume solution scheme is sensitive to the volume of water between any two 
cross sections. The equations are written from a "volume" perspective. If two cross sections are 
very close together, then there is very little volume between those two cross sections. The 1D 
Finite Volume scheme will require smaller time steps in order to handle the change in volume 
over the time step for this type of situation. The 1D Finite Difference scheme handles this better, 
because the equations are written in terms of change in water surface and velocity, which may 
be a small change for cross sections that are closer together. Therefore, for the 1D Finite Volume 
scheme to work well with larger time steps, users may need to remove cross sections that are 
very close together.
3.The 1D Finite Volume scheme is computationally slower, than the 1D Finite Difference solution 
scheme. This is due to the fact that the 1D Finite difference scheme combined the properties of 
the left and right overbank together (area, wetted perimeter, average length between cross 
sections, etc.) and solved the equations for a main channel and a single floodplain. The new 1D 
Finite Volume solution scheme keeps the left and right overbank properties completely 
separate. Thus the equations are written for a separate left overbank, main channel, and right 
overbank, and then solved. This is more computational work for every time step, but it is 
computationally more accurate.

2D Flow Options
When selecting the Tab labeled "2D Flow Options" on the Computational Options and Tolerances 
window, the editor will look like what is shown in Figure 7-24.

Figure 7 24 Computation Options and Tolerances with 2D Flow Area Options shown

As shown in Figure 7-24, there are several computational options and tolerances that can be set for 
the 2D module. These Options are discussed below.
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Use Coriolis Effects: Only used in the Full Momentum Equation
This option allows the user to turn on the effects of the Earth's rotation on the solution (Coriolis 
Effect). When this option is turned on, the user must enter the latitude of the center of the 2D Flow 
Area in degrees (this is the field labeled "Latitude for Coriolis" in the table). A latitude with a value 
greater than zero is considered in the northern hemisphere, and a value less than zero is considered 
in the southern hemisphere.

Theta (0.6 – 1.0): 1.0 (default)
This is the implicit weighting factor that is used to weight spatial derivatives between the current 
solution time line and the previously solved solution time line. Theta of 1.0 (Default), uses only the 
currently solved time line for the spatial derivatives. This provides for the most stable solution, but 
possibly at the loss of some accuracy. Theta of 0.6, provides for the most accurate solution of the 
equations, but tends to be less stable. In general it has been found that in application of most real 
world flood runoff types of events, Theta of 1.0, will give about the same answers as Theta of 0.6. 
However, this should be tested for each model due to site specific geometry and flood propagation, 
in which it may make a difference in the results.

Theta Warm-up (0.6 – 1.0): 1.0 (default)
This is the value of Theta (see description above) that is used during the model warmup and ramp up 
periods. This value of Theta is only used if the user has turned on the unsteady flow warm-up option, 
or the Boundary Condition Ramp up Option for 2D areas.

2D water surface calculation tolerance (ft):0.01 (default)
This is the 2D water surface solution tolerance for the iteration scheme. If the solution of the 
equations gives a numerical answer that has less numerical error than the set tolerance, then the 
solver is done with that time step. If the error is greater than the set tolerance, then the program will 
iterate to get a better answer. The program will only iterate up to the maximum number of iterations 
set by the user. The default is set to 0.01 ft based on experience in using the model for a range of 
applications.

Maximum Number of iterations (0 – 40):20 (Default)
This is the maximum number of iterations that the solver will use while attempting to solve the 
equations (in order to get an answer that has a numerical error less than the user specified tolerance 
at all locations in the 2D computational mesh domain). The default is set to 20. However, the user 
can change it from 0 to 40. It is not recommended to change this unless you are sure that changing 
the value will either improve the chances that the model will converge (I.e. increasing the value), or 
speed up the computations without causing any significant errors.

Equation Set: Diffusion Wave (Default); SWE-ELM (original/faster); and SWE-EM (stricter 
momentum).
The HEC-RAS two-dimensional computational module has the option of running the following 
equation sets: 2D Diffusion Wave equations; Shallow Water Equations (SWE-ELM) with a Eulerian-
Langrangian approach to solving for advection; or a new Shallow Water Equation solver (SWE-EM), 
that uses an Eulerian approach for advection. The new SWE equation solution method is more 
momentum conservative, but may require smaller time steps and produce longer run times. The 
default is the 2D Diffusion Wave equation set. In general, most flood applications will work fine with 
the 2D Diffusion Wave equations. The Diffusion Wave equation set will run faster and is inherently 
more stable. However, there are definitely applications where the 2D SWE should be used for greater 
accuracy. The good news is that it easy to try it both ways and compare the answers. It is simply a 
matter of selecting the equation set you want, and then running it. Create a second Plan file, use the 
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other equation set, run it, and compare it to the first Plan for your application. 
The new SWE solver (SWE-EM) is an explicit solution scheme that is based on a more conservative 
form of the momentum equation. This solver requires time steps to be selected to ensure the 
Courant number will be less than 1.0, in general (not always). This solver produces les numerical 
diffusion than the original SWE solver. However, in general, this new solver is only needed when 
user's are interested in taking a very close look at changes in water surfaces and velocities at and 
around hydraulic structures, piers/abutments, and tight contractions and expansions. The original 
SWE solver is more than adequate for most problems requiring the full momentum equation based 
solution scheme.

Initial Conditions Ramp up Time (hrs): Default is Blank (not used)
This option can be used to "Ramp up" the water surface from a dry condition to a wet condition 
within a 2D area (or from a flat water surface if an initial water surface elevation was entered). When 
external boundary conditions, such as flow and stage hydrographs (or 1D reaches), are connected to 
a 2D area, the first value of the connected flow or stage may be too high (i.e. a very large flow or a 
stage much higher than the cell elevation it is attached to). If the model were to start this way, such a 
high discontinuity could cause a model instability. This option allows the user to specify a time (in 
hours) to run the computations for the 2D Flow Area, while slowly transitioning the flow boundaries 
from zero to their initial value, and the stage boundaries from a dry elevation up to their initial wet 
elevation. The user specifies the total "Initial Conditions Ramp up Time" in this field (10 hours, for 
example). The user must also specify a fraction of this time for Ramping up the boundary conditions. 
A value of 0.5 means that 50% of the Initial Conditions time will be used to Ramp Up the boundary 
conditions to their initial values, the remaining time will be used to hold the boundary conditions 
constant, but allow the flow to propagate through the 2D Flow Area, thus giving it enough time to 
stabilize to a good initial condition throughout the entire 2D Flow Area. The Ramp up time for the 
boundary conditions is entered in the next row, which is labeled "Boundary Condition Ramp up 
Fraction".

Boundary Condition Ramp up Fraction (0 to 1.0): 0.5 (50%) Default value
This field goes along with the previous field "Initial Conditions Ramp up Time". This field is used to 
enter the fraction of the Initial Conditions Ramp up Time that will be used to ramp up the 2D Flow 
Area boundary Conditions from zero or dry, to their initial flow or stage. User's can enter a value 
between 0.0 and 1.0, representing the decimal fraction of the Initial Conditions Ramp up Time.

Number of Time Slices (Integer Value): 1 (Default)
This option allows the user to set a computational time step for a 2D area that is a fraction of the 
overall Unsteady flow computation interval. For example, if the user has set the Unsteady Flow 
overall computation interval to 10 minutes, then setting a value of 5 in this field (for a specific 2D 
area) means that the computation interval for that 2D area will be 1/5 of the overall computation 
interval, which for this example would be 2 minutes (e.g. 10/5 = 2). Different values can be set for 
each 2D Flow Area. The default is 1, which means that 2D Flow Area is using the same computational 
time step as the overall unsteady flow solution (computation Interval is entered by the user on the 
unsteady flow analysis window).

Eddy Viscosity Transverse Mixing Coefficient: Default is Blank (not used)
The modeler has the option to include the effects of turbulence in the two dimensional flow field. 
Turbulence is the transfer of momentum due to the chaotic motion of the fluid particles as water 
contracts and expands as it moves over the surface and around objects. Turbulence within HEC-RAS 
is modeled as a gradient diffusion process. In this approach, the diffusion is cast as an Eddy Viscosity 
coefficient. To turn turbulence modeling on in HEC-RAS, enter a value for the Eddy Viscosity 
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Transverse or Longitudinal Mixing Coefficient for that specific 2D Flow Area. These coefficients 
require calibration in order to get at an appropriate value for a given situation. The default in HEC-
RAS is zero for this coefficient, meaning it is not used. Additional diffusion using the Eddy Viscosity 
formulation can be obtained by entering a value greater than zero in this field. HEC-RAS also has an 
option to add an additional amount of turbulence using the Smagorinsky formulation.
Note: For the details on how to use the HEC-RAS Turbulence modeling, please review the section in 
the HEC-RAS 2D User's Manual. For information of the equations used for turbulence modeling, 
please review the section in Chapter 2 of the Hydraulic Reference manual.

Boundary Condition Volume Check: Default is not checked
This option is used to keep track of potential volume errors that may arise when 1D connections are 
made to 2D Flow Areas (i.e. Lateral structure connected from a 1D River to a 2D Flow Area). If this is 
turned on, the program will evaluate the volume transfer across the hydraulic connection to ensure 
that the volume passing over the computational time step is not more water than is truly available in 
the 2D Flow Area. Where this comes into play is when water is leaving a 2D flow area and going into a 
1D River Reach over a lateral structure. Flow use computed by a weir equation and is based on the 
water surface elevations on both sides of the weir. However, there may not be enough volume left in 
the 2D flow area to satisfy that flow rate over the computational time step. If this option is turned on 
the program will make a check for this, and if the 2D Flow Area can not send that amount of water 
out, the software will redo the time step with a lower flow transfer rate. Turning this option on can 
improve the accuracy of these types of computations, but it will also slow down the computations.

Number of Cores to use in computations: All Available (Default)
The HEC-RAS two-dimensional computational module was developed from the ground up with 
parallel processing in mind. The HEC-RAS 2D computations will use as many CPU cores as there are 
available on your machine (which is the default mode for running). However, HEC-RAS provides the 
option to set the number of cores to use for the 2D computations. In general, it is recommended to 
use the default of "All Available". However, you may want to experiment with this for a specific data 
set to see if it will either speed up or slow down computations based on a specific number of cores. 
The ideal number of cores for a given problem is size and shape dependent (shape of the 2D Flow 
Area). As you use more cores, the problem is split into smaller pieces, but there is overhead in the 
communications between the pieces. So, it is not necessarily true that a given problem will always 
run faster with more cores. Smaller data sets (2D areas with fewer cells) may actually run faster with 
fewer cores. Large data sets (2D Areas with lots of cells) will almost always run faster with more 
cores, so use all that is available.

Shown below are the results of testing a few data sets by running them with different numbers of 
Cores. Each model was run several times with the number of cores set to: 1, 2, 4, 8, and 16. As you 
can see four of the data sets had speed improvements up to 8 cores, but actually ran slower with 16 
cores. These are smaller data sets ranging from 10,000 to 80,000 cells. However, one data sets had 
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speed improvements all the way up to 16 cores. This was the largest data set, with 250,000 cells.

Matrix Solver. By default HEC-RAS uses a matrix solver for the 2D equations called "Pardiso". This is 
a direct solver. For HEC-RAS 6.0 and newer some additional "Iterative" solvers have been added. In 
general, the Pardiso solver produces a more stable solution. The new Iterative solvers "may" 
produce a faster solution (Not always), but run the risk of increasing model instability. In general 
user's should get ther model up and running with the Pardiso matrix solver, then they can try the 
iterative solvers to see if they get any performance increases with their data set.

1D/2D Options
When selecting the Tab labeled "1D/2D Options" on the Computational Options and Tolerances 
window, the editor will look like what is shown in Figure 7-25.
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Figure 7 25 Calculation Options and Tolerances with 1D/2D Options tab shown

Maximum iterations between 1D and 2D. Default is zero (meaning this is not turned on)
There are also some options for Controlling 1D/2D Iterations, which can be used to improve the 
computations of flow passing from a 1D element (reach or storage area) to a 2D Flow Area. By default 
this option is turned off, and most 1D to 2D connections will not need iterations. However, when 
the1D/2D hydraulic conditions become highly submerged, or there are flow reversals, or tidally 
influence stages/flows, then iterating between the 1D solution and 2D solution may be necessary to 
get an accurate and stable answer. To turn on the 1D/2D iterations option, select the "1D/2D 
Options" tab. Then you can set the Maximum iterations between 1D and 2D, as well as tolerances 
for controlling the convergence criteria. Iteration can be set from 0 to 20, with zero meaning that it 
does not do any extra iterations (this is the default). In general, only use this option if you are having 
a stability problem at a 1D/2D hydraulic connection. Set the number of 1D/2D Iterations to as low as 
possible in order to get a stable answer between a 1D and 2D connection that is having stability 
problems. The Number of 1D/2D Iterations will cause the entire solution to be done multiple times 
for each time step in order to get the desired convergence. This could dramatically lengthen run 
times. If you turn this option on, it is suggested that you start with a low value, like 3 or so. If the 
stability problem still exists with that number of iterations, then increase it from there.

The convergence criteria for 1D/2D iterations consists of a Water Surface Tolerance, Flow 
Tolerance (%), and a Minimum Flow Tolerance. The water surface tolerance is currently only used 
when an upstream 1D reach is connected to a downstream 2D Flow Area. In this situation, the 1D 
region is computed, then the 2D region. The assumed water surface elevation at the boundary is re-
evaluated. If the water surface has changed more than the Water Surface Tolerance, then the 
program will iterate. When the water surface elevation at the boundary has change less than the 
tolerance, the solution stops iterating and moves on to the next time step.

The Flow Tolerance (%) gets used for the following 1D/2D connections: Lateral Structure; SA/2D 
Hydraulic Connection (SA to 2D, or 2D to 2D); and 2D Flow Area to 1D Reach connection (Currently in 
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the 5.0 Beta version, this only works when an upstream 2D flow Area is connected to a downstream 
1D river reach). The default value for the Flow Tolerance (%) is 0.1 %. If 1D/2D iterations are turned 
on, then the flow between these types of 1D/2D connections gets recomputed after each trial to see 
if it has changed more than the user defined Flow Tolerance (%). If it has changed more than the flow 
tolerance, then the program iterates. A companion tolerance to the Flow Tolerance, is the Minimum 
Flow Tolerance (cfs). The purpose of this tolerance is to prevent the program from iterating when 
the flow passed between a 1D and 2D element is very small, and not significant to the solution. For 
example, you may have a connection from a 1D reach to a 2D Flow Area via a Lateral Structure, in 
which the flow under certain conditions is very low, so the actual change in the flow from one 
iteration to the next could be very small (put the percent error is very high). Such a small flow may 
have no significance to the solution, so iterating the entire solution to improve this small flow 
between the 1D and 2D elements makes no sense, and may be just wasting computational time. In 
general it is a good idea to set a minimum flow when turning on 1D/2D iterations. The default value is 
1 cfs, however, this is most likely model specific.

Advanced Time Step Control Tab
Some new variable time step capabilities have been added to the unsteady flow engine for both 1-
dimensional (1D) and 2D unsteady flow modeling. Two new options are available. One is a variable 
time step based on monitoring Courant numbers (or residence time within a cell), while the other 
method allows users to define a table of dates and time step divisors. The variable time step option 
can be used to improve model stability, as well as reduce computational time (not all models will be 
faster with the use of the variable time step). The information contained in this section is 
supplemental to Chapter 8 of the HEC-RAS 5.0 User's Manual.

These new Variable Time Step options are available from the Unsteady Flow Analysis window and 
also by going to the Computational Options and Tolerances window. There is a new button right next 
to the Computation Interval directly on the Unsteady Flow Analysis window, which will take users to 
this new feature. 
When the Variable Time Step control editor ellipse button is clicked, the modified HEC-RAS Unsteady 
Computation Options and Tolerances window opens to the new Advanced Time Step Control tab 
(Figure 7-26). Alternatively, users can open the window and navigate to the new tab, from the 
Options | Computation Options and Tolerances menu option.
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Figure 7 26. Variable Time Step Editor within the Computational Options and Tolerances.

As shown in Figure 7-26, the new Advanced Time Step Control tab now has three different methods 
for selecting and controlling the computational time step: (1) Fixed Time Step (default); (2) Adjust 
Time Step Based on Courant which is a variable time step based on the Courant number; and (3) 
Adjust Time Step Based on Time Series of Divisors which is a variable time step based on a user 
entered table of dates, times, and time step divisor's. The two new variable time step options 
(Courant number and Time Step Divisor) are discussed in the following sections.

Courant Number Method
The first new variable time step option is to use the Courant number method, from the new 
Advanced Time Step Control tab. In the example shown in Figure 7-26, the Courant number is being 
used for the variable time step. To use this method, select the Adjust Time Step Based on Courant 
option and provide the following information: 
• Maximum Courant: This is the maximum Courant number allowed at any 2D cell or 1D cross section. 
If the maximum Courant number is exceeded, then the time step is cut in half for the very next time 
interval. Because HEC-RAS uses an implicit solution scheme, Courant numbers can be greater than 
one, and still maintain a stable and accurate solution. In general, if the flood wave is rising and 
falling slowly (depth and velocity are changing slowly), the model can handle extremely high 
Courant numbers. For these types of cases, users may be able to enter a Maximum Courant number 
as high as 5.0 or more. However, if the flood wave is very rapidly changing (depth and velocity are 
changing very quickly over time), then the Maximum Courant number will need to be set closer to 
1.0. The example shown in Figure 2 6 is for a Dam break type of flood wave, in which depth and 
velocity are changing extremely rapidly. Because of the rapid changes in depth and velocity, the 
Maximum Courant number was set to 1.0.
• Minimum Courant: This is the minimum Courant number threshold for 2D cells and 1D cross 
sections. If the Courant number at "all" locations goes below the minimum, then the time step will 
be doubled. However, the time step will only be doubled if the current time step has been used for 
enough time steps in a row to satisfy the user entered criteria called "Number of steps below 
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Minimum before doubling" (see below for an explanation of this field). The "Minimum Courant" value 
should always be less than half of the "Maximum Courant" value. If the Minimum Courant value is 
equal to or larger than half the Maximum Courant value, the HEC-RAS Version 5.0.4 software will just 
flip back and forth between halving and doubling the time steps. In the example shown in Figure 2 6, 
since the Maximum Courant number was set to 1.0, the minimum was set to 0.45 (less than half of 
the maximum), which allowed the model to stay stable, but also run faster.
• Number of steps below Minimum before doubling: This field is used to enter the integer number of 
time steps in which the Courant number must be below the user specified minimum before the time 
step can be increased. This can prevent the model from increasing the time step too quickly and/or 
from flipping back and forth between time steps. Typical values for this field may be in the range of 5 
to 10.
• Maximum number of doubling base time step: This field is used to enter the maximum number of 
times the base time step can be doubled. For example, if the base computation interval is 10 
seconds, and the user wants to allow it to go up to 40 seconds, then the value for this field would be 
2 (i.e., the time step can be doubled twice: 10s to 20s to 40s). The value displayed in the box to the 
right of the user entered value is what the entered maximum time step will end up being.
NOTE: The HEC-RAS software requires that all time steps end up exactly hitting the Mapping Output 
Interval. This requirement is because output for HEC-RAS Mapper must be written to the output file 
for all cross sections, storage areas, and 2D cells at the mapping interval. Because of this fact, if users 
enter a "Maximum number of doubling base time step" that results in a computation interval that 
does not exactly land on the mapping output interval, then the unsteady flow computational 
program will compute its own time steps that work with the parameters entered in the Adjust Time 
Step Based on Courant section. Furthermore, the base time step will be changed to something close 
to what was entered, but when doubling it, all values will still line up with the mapping output 
interval. When the model runs it will list what time step it is currently using in the message window of 
the computational output window.
• Maximum Number of halving base time step: This field is used to enter the maximum number of time 
that the base computation interval can be cut in half. For example, if the base computation interval 
is 10 seconds, and the user wants to allow it to go down to 2.5 seconds, then the maximum number 
of halving value would need to be set to 2 (i.e., the time step can be cut in half twice: 10s to 5s to 
2.5s). The value displayed in the box to the right of the user entered value is what the entered 
maximum time step will end up being.
For the Courant number method, the default approach for computing the Courant number is to take 
the velocity times the time step divided by the length (between 1D cross sections, or between two 2D 
cells). For 2D, the velocity is taken from each face and the length is the distance between the two cell 
centers across that face. For 1D, the velocity is taken as the average velocity from the main channel 
at the cross section, and the length is the distance between that cross section and the next cross 
section downstream.
An optional approach to using a traditional Courant number method is to use Residence Time. With 
this method, the HEC-RAS software is computing how much flow is leaving a 2D cell over the time 
step, divided by the volume in the cell. The Residence Time method is only applied to 2D cells. When 
this method is turned on, it is used for the 2D cells, but 1D cross sections still use the traditional 
Courant number approach.

User Defined Dates/Time vs Time Step Divisor
Another option available from the Advanced Time Step Control tab, is to set the variable time step 
control based on a user defined table of dates and times verses a time step divisor (Figure 7-26). 
As shown in Figure 7-26 the user can select the option called "Adjust Time Step Based on Time Series 
of Divisors", from the Advanced Time Step Control tab. When this option is selected the user must 
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enter a table of Dates and times verses time step Divisors. The first date/time in the table must be 
equal to the starting date/time of the simulation period. To use this method, enter a base time step 
equal to the maximum time step desired during the run. Then in the table, under the Divisor column, 
enter the integer number to divide that time step by for the current date/time in the table. Once a 
time step is set for a date/time, the Unsteady Flow Analysis compute will use that time step until the 
user sets a new one. 
In the example shown in Figure 7-26, the base computational interval was set at 1 minute. Based on 
the table of dates/times and Divisors entered, the actual time steps that will be used are displayed in 
the first column labelled "Time Step".
The Time Step Divisor method for controlling the time step requires much more knowledge by the 
user about the events being modelled, the system being routed through, as well as knowledge of 
velocities, cross section spacing, and 2D cell sizes. However, if done correctly, this method can be a 
very powerful tool for decreasing model run times and improving accuracy.

1D Mixed Flow Options. 
When this option is selected, the program will run in a mode such that it will allow the 1D Finite 
Difference solution scheme to handle subcritical flow, supercritical flow, hydraulic jumps, and draw 
downs (sub to supercritical transitions). This option should only be selected if you actually have a 
mixed flow regime situation. The methodology used for mixed flow regime analysis is called the 
Local Partial Inertia (LPI) solution technique (Fread, 1996). When this option is turned on, the 
program monitors the Froude number at all cross section locations for each time step. As the Froude 
number gets close to 1.0, the program will automatically reduce the magnitude of the inertial terms 
in the momentum equation. Reducing the inertial terms can increase the models stability. When the 
Froude number is equal to or greater than 1.0, the inertial terms are completely zeroed out and the 
model is essentially reduced to a diffusion wave routing procedure. For Froude numbers close to 1.0, 
the program will use partial inertial effects, and when the Froude number is low, the complete 
inertial effects are used. 
Note: more information about mixed flow regime calculations can be found in Chapter 14 of the HEC-
RAS User's manual.

Output Options. This option allows the user to set some additional output flags. When this option is 
selected a window will appear as shown in Figure 7-27. The following is a list of the available options:
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Figure 7 27. Unsteady Flow Output Control Options Window

Restart File Options: This tab allows the user to write out an Initial conditions file or files, sometimes 
called a "Hot Start" file. A hot start file can be used to set the initial conditions of the system for a 
subsequent run. This is commonly done in real time forecasting, where you want to use the results at 
a specific time from a previous run to be the initial conditions of the next run. The user can either 
enter a time in hours from the beginning of the current simulation, or they can enter a specific Date 
and Time. This time represents the time at which the conditions of the system will be written to the 
"Hot Start" file. The program writes flow and stage at all of the computational nodes, as well as the 
stage in all of the storage areas to the file. An additional option is available to write multiple restart 
files out from a single run. This is accomplished by first specifying how and when you want the first 
file to be written, then entering the number of hours between subsequent writes of the file. The last 
option of this section allows the user to ensure that the very last time step also gets written out as a 
separate restart file. Filenames for restart files are labeled as follows:

Projectname.p##.DDMMMYYY hhmm.rst
p##=plan number
DD=Day
MMM=Month
YYYY=Year
hh=hour
mm=minute
rst=file extension

Detailed Log Output: This tab allows the user to turn on detailed output that is written to a log file. 
The user can have the Input Hydrographs written to the log file; the final computed hydrographs; 
and they also can have the software write detailed information for each iteration of the unsteady 
flow equations (Write Detailed Log Output for Debugging). The detailed output at the iteration 
level can be written for the entire simulation period, or the user has the option to set a specific time 
window in which the program will only output information within this time. This option is used when 
there is a problem with the unsteady flow solution, in that it may be oscillating or going completely 
unstable. When this occurs, the user should turn this option on and re-run the program. After the run 



Performing a 1D Unsteady Flow Analysis

HEC-RAS User's Manual– 293

has either finished or blown up, you can view the log file output by selecting View Computation Log 
File from the Options menu of the Unsteady Flow Simulation window. This log file will show what is 
happening on a time step by time step basis. It will also show which cross section locations the 
program is having trouble balancing the unsteady flow equations, as well as the magnitude of the 
errors. There is an additional option to turn on this detailed log output only when a certain number 
of iterations has been met or exceeded (Automatic Detailed Log Output).
Computation Level Output: This tab allows the user to write out a limited list of variables at the 
computational time step level. This is a very useful tool for assisting in debugging an unsteady flow 
model. It is often very helpful to seem a few output variables, like water surface and flow, at the 
detailed computational time step in order to see when and where a model is going unstable. By 
default, only the water surface and the flow rate will be written out when the computational output 
option is turned on from the Unsteady Flow Computational window. This option allows the user to 
select additional variables to be written to that file. The following variables are available to be 
written tot the computational level output file:

WSEL=Water surface elevation (Default)
Flow=Flow rate (Default) 
WS Error=Numerical error in water surface comp.
Flow Error=Numerical error in computed flow
Depth =Depth of the water from channel invert
Invert =Elevation of main channel invert
Vel Channel=Average velocity in main channel
Vel Total=Average velocity of entire cross section
Courant Chan=Courant Number for main channel only
Courant Total=Courant Number for entire cross section
Diff Eqn Parts =Separate components of the unsteady flow equations (Momentum and 
Continuity equations)

Friction Slope Method for Cross Sections. By default the program uses the Average Friction Slope 
method for determining friction forces for the momentum equation during an unsteady flow run. 
This option allows the user to select one of the other five available methods in HEC-RAS. To learn 
more about the friction slope averaging techniques in HEC-RAS, see chapter 2 of the hydraulic 
reference manual.

Friction Slope Method for Bridges. By default the program uses the Average Conveyance friction 
slope averaging technique for computing frictional forces through bridges. This has been found to 
give the best results at bridge locations. This option allows the user to select one of the other five 
available methods.

Initial Backwater Flow Optimizations. If your model has a flow split, lateral structure, or pump 
stations, it may be necessary to optimize the flow splits during the initial backwater computations in 
order to get a reasonable initial condition for the unsteady flow computations. This option allows 
the user to turn on flow optimizations at the various locations where flow may be leaving the system 
and it is a function of the water surface elevation (which would require optimization to get the right 
values).

Sediment Computational Options and Tolerances. As of HEC-RAS version 5.0 and newer, there is 
now the ability to perform Unsteady Flow Sediment Transport (deposition and erosion) 
computational capabilities. This Option, and the next two (called: Sediment Output Options and 
Sediment Dredging Options), are used to control the sediment transport computations within the 
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Unsteady Flow computational program. Please refer to Chapter 17 for the details of performing 
sediment transport computations within HEC-RAS.

Check Data Before Execution. This option provides for comprehensive input data checking. When 
this option is turned on, data checking will be performed when the user presses the compute button. 
If all of the data are complete, then the program allows the unsteady flow computations to proceed. 
If the data are not complete, or some other problem is detected, the program will not perform the 
unsteady flow analysis, and a list of all the problems in the data will be displayed on the screen. If 
this option is turned off, data checking is not performed before the unsteady flow execution. The 
default is that the data checking is turned on. The user can turn this option off if they feel the 
software is erroneously stopping the computations from running. If this does happen the user should 
report this as a bug to the HEC-RAS development team.

View Computation Log File. This option allows the user to view the contents of the unsteady flow 
computation log file. The interface uses the Windows Notepad program to accomplish this. The log 
file contains detailed information of what the unsteady flow computations are doing on a time step 
by time step basis. This file is very useful for debugging problems with your unsteady flow model.

View Runtime Messages. This option allows the user to bring up a viewer that will show the user all 
of the messages that were written to the computational window for the last time the model was 
computed.

Saving the Plan Information
To save the Plan information to the hard disk, select Save Plan from the File menu of the simulation 
window. Whenever any option is changed or modified on the Unsteady Flow Analysis window, the 
user should Save the Plan.

Starting the Computations
Once all of the data have been entered, and a Plan has been defined, the unsteady flow 
computations can be performed by pressing the Compute button at the bottom of the Unsteady 
Flow Simulation window. When the compute button is pressed, a separate window will appear 
showing you the progress of the computations (Figure 7-28). The information that appears in the 
window is an indicator of the programs progress during the computations, and a list of any 
computational messages that come up during the run. When the computations have been 
completed, the user can close the computations window by clicking the upper right corner of the 
window, or the close button at the bottom. If the computations ended normally (i.e. all of the 
processes ran with no error messages), then the user can begin to look at the output. If the program 
does not finish normally, then the user should turn view the computational messages to see what 
problems may have occurred, then begin debugging the problem.
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Figure 7 28. Unsteady Flow Computations Window 

Calibration of Unsteady Flow Models
Calibration is the adjustment of a model's parameters, such as roughness and hydraulic structure 
coefficients, so that it reproduces observed data to an acceptable accuracy. The following is a list of 
common problems and factors to consider when calibrating an unsteady flow model.
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1.
2.
3.
4.
5.

Observed Hydrologic Data

Stage Records

In general, measured stage data is our most accurate hydrologic data. Measured stage data is 
normally well within +/- 1.0 feet of accuracy. However, errors can be found in measured stage data. 
Some common problems are:

The gages float gets stuck at a certain elevation during the rise or fall of the flood wave.
The recorder may systematically accumulate error over time.
The gage reader of a daily gage misses several days (cooperative stream gage program).
There is an error in the datum of the gage.
Subsidence over time causes errors in the stage measurement.

Flow Records

Flow records are generally computed from observed stages using single valued rating curves. These 
rating curves are a best fit of the measured data. The USGS classifies good flow measurements from 
Price current meters to be within ±5% of the true value. Some believe that this assumed error is 
optimistic. In any case, ±5% on many river systems, translates into a stage error of ±1.0 feet. Acoustic 
velocity meters (AVM) provide a continuous record, but the current USGS technique calibrates these 
meters to reproduce measurements from Price current meters, so the AVM is as accurate as the 
current meter. Boat measurements are almost always suspect. In general it is very difficult to get 
accurate velocity measurements using a price current meter from a boat. Newer techniques using 
acoustic velocity meters with three beams mounted on boats are thought to be much better.

Published discharge records should also be scrutinized. Continuous discharge is computed from 
discharge measurements, usually taken at bi-weekly or monthly intervals and the continuous stage 
record. The measurements are compiled into a rating curve and the departures of subsequent 
measurements from the rating curve are used to define shifts. The shifts are temporary changes in 
the rating curve due to unsteady flow effects (looped rating curve) and short term geomorphic 
changes. The quality of the record depends on the frequency of discharge measurements and the 
skill of the hydrologist. The only way to depict the quality of the published flow data is to compare 
the measured flow values to the currently published rating curve. However, if the flow 
measurements are infrequent, one can only apply the flow record to the model and see how well the 
stage record is reproduced. Remember! Most published flow records for large streams are in mean 
daily flow. The modeler must somehow assign time values to these records.

High Water Marks 

High water marks are estimated from the upper limit of stains and debris deposits found on 
buildings, bridges, trees, and other structures. Wind and wave actions can cause the debris lines to 
be higher than the actual water surface. Capillary action can cause stains on buildings to migrate 
upward, depending on the material used for the building walls. High water marks in the overbank 
area are often higher than in the channel. The overbank water is moving slower and may be closer to 
the energy gradeline. High water marks on bridge piers are often equal to the energy gradeline, not 
the average water surface. This is due to the fact that the water will run up the front of the pier to an 
elevation close to the energy gradeline. 
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A comparison between high water marks and the computed maximum water surface profile is 
included in the figure below. Note the scatter in the high water marks, which mark is accurate? 

Ungaged Drainage Area

For an unsteady flow model to be accurate, it must have flow input from all of the contributing area. 
In many studies a significant portion of the area is ungaged. Discharge from ungaged areas can be 
estimated from either hydrologic models or by taking flow from a gaged watershed with similar 
hydrologic characteristics and multiplying it by a simple drainage area ratio.
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An example of accounting for ungaged drainage area is shown below for the Red River of the North.

As shown in the above figure, ungaged areas can be accounted for by using a pattern hydrograph of 
a hydrologically similar watershed (Middle River), then calculating a drainage area ratio of 
contributing areas (Ungaged area divided by pattern hydrograph area).

River and Floodplain Geometry
It is essential to have an adequate number of cross sections that accurately depict the channel and 
overbank geometry. This can be a great source of error when trying to calibrate. Additionally, all 
hydraulic structures must be accurately depicted. Errors in bridge and culvert geometry can be 
significant sources of error in computed water surface profiles. Another important factor is correctly 
depicting the geometry at stream junctions (flow combining and splitting locations). This is 
especially important at flow splits, and areas in which flow reversals will occur (i.e. flow from a main 
stem backing up a tributary).

Also, a one-dimensional model assumes a constant water surface across each cross section. For 
some river systems, the water surface may vary substantially between the channel and the 
floodplain. If this is the case in your model, it may be necessary to separate the channel and the 
floodplain into their own reaches or model the overbank area as a series of storage areas.

Roughness Coefficients
Roughness coefficients are one of the main variables used in calibrating a hydraulic model. 
Generally, for a free flowing river, roughness decreases with increased stage and flow (Figure 7-31). 
However, if the banks of a river are rougher than the channel bottom (due to trees and brush), then 
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the composite n value will increase with increased stage. Sediment and debris can also play an 
important role in changing the roughness. More sediment and debris in a river will require the 
modeler to use higher n values in order to match observed water surfaces.  An example plot of 
roughness versus discharge for the Mississippi River at Arkansas City is shown below.

Looped Rating Curves

Excluding cataclysmic events such as meander cutoffs or a new channel, the river will pass any given 
flow within a range of stages. The shift in stage is a result of the following: shifts in channel geometry 
or bed forms; the dynamics of the hydrograph (how fast the flood wave rises and falls); backwater 
(backwater can significantly change the stage at a given cross section for a given flow); and finally, 
the slope of the river (flatter streams tend to have greater loops in the rating curve). The figure below 
shows a looped rating for a single event. Generally, the lower stages are associated with the rising 
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side of a flood wave, and the higher stages are associated with the falling side of the flood wave.

Alluvial Rivers

In an alluvial stream the channel boundary, as well as the meandering pattern of the stream, are 
continuously being re-worked by the flow of water. Alluvium is unconsolidated granular material, 
which is deposited by flowing water. An alluvial river is incised into these alluvial deposits. The flow 
characteristics of the stream are defined by the geometry and roughness of the cross-section below 
the water surface. The reworking of the cross section geometry and meander pattern is greatest 
during high flow, when the velocity, depth of water, and sediment transport capacity are the 
greatest. For some streams, which approach an equilibrium condition, the change in morphology 
(landforms) is small. For other streams, the change in morphology is much larger. The change can be 
manifest as changes in roughness or a more dynamic change such as the cut-off of a meander loop, 
which shortens the stream and starts a process which completely redefines the bed.

As shown in the figure below of a meandering river, pools are at the outside of bends, and a typical 
pool cross-section is very deep. On the inside of the bend is a point bar. Crossings are between the 
meander bends. A typical crossing cross-section is much shallower and more rectangular than a pool 
cross-section.  The morphology of a typical meandering river is shown below.
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1.
2.

An invert profile for the Mississippi River is shown in the the figure below. Note the pools and 
crossings. The water surface profile is controlled by the crossing cross-sections (high points in the 
invert), particularly at low flow. The conveyance properties of pool cross-sections are only remotely 
related to the water surface. This poses a significant problem when calibrating a large river.

As stage and flow increase you have an increase in stream power (stream power is a function of 
hydraulic radius, slope, and velocity). The bed forms in an alluvial stream tend to go through the 
following transitions:

Plane bed without sediment movement.
Ripples.
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3.
4.
5.
6.

Dunes.
Plane bed with sediment movement.
Anti-dunes.
Chutes and pools.

Generally, anti-dunes and chutes and pools are associated with high velocity streams approaching 
supercritical flow. The bed form process for alluvial streams is shown in the figure below.

 
Typical Manning's roughness coefficients for the different bed forms of alluvial streams presented 
above are shown in the table below.

Bed Forms Range of Manning's n

Ripples 0.018 – 0.030

Dunes 0.020 – 0.035

Washed Out Dunes 0.014 – 0.025

Plane Bed 0.012 – 0.022

Standing Waves 0.014 – 0.025

Antidunes 0.015 – 0.031

Note: This table is from the book "Engineering Analysis of Fluvial Streams", by Simons, Li, and 
Associates.

Bed forms also change with water temperature. Because water is more viscous at lower 
temperatures, it becomes more erosive, reducing the height and the length of the dunes. At higher 
temperatures, when the water is less viscous, the dunes are higher and of greater length. Since the 
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larger dunes are more resistant to flow, the same flow will pass at a higher stage in the summer than 
in the winter. Larger rivers such as the Mississippi River and the Missouri River show these trends. 
The figure below shows the seasonal shift in bed roughness due to water temperature for the 
Mississippi River at St. Louis. 

River and Floodplain Storage

Cross Sectional Storage

The active flow area of a cross section is the region in which there is appreciable velocity. This part of 
the cross section is conveying flow in the downstream direction. Storage is the portion of the cross 
section in which there is water, but it has little or no velocity. Storage can be modeled within a cross 
section by using the ineffective flow area option in HEC-RAS. The water surface elevation within the 
cross section storage is assumed to have the same elevation as the active flow portion of the cross 
section. 

The storage within the floodplain is responsible for attenuating the flood hydrograph and, to some 
extent, delaying the flood wave. Effects of Overbank Storage. Water is taken out of the rising side of 
the flood wave and returned on the falling side. An example of the effects of overbank storage is 
shown in the figure below. In this example, the water goes out into storage during the rising side of 
the flood wave, as well as during the peak flow. After the peak flow passes, the water begins to come 
out of the storage in the overbank and increases the flow on the falling side of the floodwave.
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Off Line Storage

Off line storage is an area away from the main river in which water can go from the main river to the 
ponding area. The connection between the ponding area and the river may be a designed overflow, 
or it may just be a natural overflow area. The water in the ponding area is often at a different 
elevation that the main river, therefore, it must be modeled separately from the cross sections 
describing the main river and floodplain. Within HEC-RAS, ponding areas are modeled using what we 
call a storage area. Storage areas can be connected hydraulically to the river system by using a 
lateral weir/spillway option in HEC-RAS.

The effect that off line storage has on the hydrograph depends on the available volume and the 
elevation at which flow can get into and out of the storage area. Shown in the figure below is an 
example of an off-line storage area that is connected to the river through a lateral weir/spillway. The 
flow upstream and downstream of the offline storage area remains the same until the water surface 
elevation gets higher than the lateral weir. Water goes out into the lateral storage facility the whole 
time it is above the weir (i.e. the storage area elevation is always lower than the river elevation in this 
example). This continues until later in the event, when the river elevation is below the lateral weir 
and flow can no longer leave the river. In this example, the flow in the storage area does not get back 
into the river system until much later in the event, and it is at a very slow rate (possible drained by 
culverts to a downstream location).
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Hydraulic Structure Coefficients
Bridges and culverts tend to have a local effect on stage, and a minimum affect on the flow 
hydrograph (this depends on the amount of backwater they cause and the steepness of the stream). 
However, in flat streams, increases in a water surface at a structure can cause a backwater upstream 
for a substantial distance (depends on amount of stage increase and slope of the stream). The 
coefficients that are important in bridge modeling are: Manning's n values; contraction and 
expansion coefficients; pier loss coefficients, and pressure and weir flow coefficients for high flows. 
Culvert hydraulics are dependent upon the size of the culverts and shape of the entrance. Additional 
variables include Manning's n values and contraction and expansion coefficients.

The effects of Inline weirs/spillways can be substantial on both the stage and the flow attenuation of 
the hydrograph. The effects on the hydrograph will depend upon the available storage volume in the 
pool upstream of the structure, as well as how the structure is operated. Lateral weir/spillway 
structures can have a significant impact on the amount of water leaving the river system. Therefore 
gate and weir coefficients for these structures can be extremely critical to getting the right amount of 
flow leaving the system.

Tools Available in HEC-RAS to Support Model Calibration
The following is a list of tools that the user should be aware of and use frequently during any 
calibration of an HEC-RAS model:
1. Manning's n Value Tables (Tables for other parameters).
2. Flow versus Roughness Factors options.
3. Graphical Plots with Observed data options.

Profile Plots
Cross section Plot
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•

1.

2.

3.

4.
5.

6.

7.

8.

1.
2.
3.
4.

Hydrograph (Stage and Flow) Plots

4. Tabular Output Tables

Steps To Follow in the Calibration Process
The following is a general list of steps to follow when calibrating an unsteady flow model:

Run a range of discharges in the Steady-Flow mode (if possible), and calibrate n values to established rating 
curves at gages and known high water marks.
Select specific events to run in unsteady flow mode. Ensure each event encompasses the full range of flows 
from low to high and back to low flow.
Adjust cross section storage (ineffective areas) and lateral weirs to get good reproduction of flow 
hydrographs (Concentrate on timing, peak flow, volume, and shape).
Adjust Manning's n values to reproduce stage hydrographs.
Fine tune calibration for low to high stages by using "Discharge-Roughness Factors" where and when 
appropriate.
Further refine calibration for long-term modeling (period of record analysis) with "Seasonal Roughness 
Factors" where and when appropriate.
Verify the model calibration by running other flow events or long term periods that were not used in the 
calibration.
If further adjustment is deemed necessary from verification runs, make adjustments and re-run all events 
(calibration and verification events).

General Trends When Adjusting Model Parameters
n order to understand which direction to adjust model parameters to get the desired results, the 
following is a discussion of general trends that occur when specific variables are adjusted. These 
trends assume that all other geometric data and variables will be held constant, except the specific 
variable being discussed.
Impacts of Increasing Manning's n. When Manning's n is increased the following impacts will occur:

Stage will increase locally in the area where the Manning's n values were increased.
Peak discharge will decrease (attenuate) as the flood wave moves downstream.
The travel time will increase.
The loop effect will be wider (i.e. the difference in stage for the same flow on the rising side of the flood wave 
as the falling side will be greater). An example of this is looped curve is shown in the figure below.
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Impacts of Increasing Storage. When storage within the floodplain is increased, the following 
impacts will occur:

Peak discharge will decrease as the flood wave moves downstream.
The travel time will increase.
The tail of the hydrograph will be extended.
The local stage (in the area of the increased storage) may increase or decrease. This depends upon if you are 
trading conveyance area for storage area, or just simply increasing the amount of storage area.

Calibration Suggestions and Warnings
The following is a list of suggestions and warnings to consider when calibrating an unsteady flow 
model:

Calibrate mostly to stages. Flow data is derived from stage. Be wary of discharge derived from stage using 
single value rating curves.
Do not force a calibration to fit with unrealistic Manning's n values or storage. You may be able to get a single 
event to calibrate well with parameters that are outside of the range that would be considered normal for 
that stream, but the model may not work well on a range of events. Stay within a realistic range for model 
parameters. If the model is still not calibrating well, then there must be other reasons why.
If using a single-valued rating curve at the downstream boundary, move it far enough downstream so it 
doesn't affect the results in the study reach.
Discrepancies may arise from a lack of quality cross-section data. If you are using cross sections cut from a 
10 meter DEM, then you should not expect to be able to get a good model calibration with such poor terrain 
data.
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The volume of off-channel storage areas is often underestimated, which results in a flood wave that travels 
to fast and will generally have to high of a peak downstream. Try to closely evaluate all of the areas that 
water can go and include them in the model.
Be careful with old HEC-2 and RAS studies done for steady flow only. The cross sections may not depict the 
storage areas. Defining storage is not a requirement for a steady flow model to get a correctly computed 
water surface elevation.
Calibration should be based on floods that encompass a wide range of flows, low to high. Be careful, to low 
of a flow can cause an unsteady flow model to go unstable. This is general caused by flow passing through 
critical depth between pools and riffles.
For tidally influenced rivers and flows into reservoirs, the inertial terms in the momentum equation are very 
important. Adjusting Manning's n values may not help. Check cross sectional shape and storage. Also, 
setting Theta towards a value of 0.6 will often help with the numerical accuracy in tidal situations.
You must be aware of any unique events that occurred during the flood. Such as levee breaches and 
overtopping.

Model Accuracy, Stability, and Sensitivity
This section of the manual discusses model accuracy, stability, and sensitivity. In order to develop a 
good unsteady flow model of a river system, the user must understand how and why the solution of 
the unsteady flow equations becomes unstable. This knowledge will help you figure out why your 
particular model may be having stability problems. Additionally, it is important to understand the 
trade-offs between numerical accuracy (accurately solving the equations) and model stability. 
Finally, model sensitivity will be discussed in order to give you an understanding of what parameters 
affect the model and in what ways.

Model Accuracy
Model accuracy can be defined as the degree of closeness of the numerical solution to the true 
solution. Accuracy depends upon the following:

Assumptions and limitations of the model (i.e. one dimensional model, single water surface across each 
cross section, etc…).
Accuracy of the geometric Data (cross sections, Manning's n values, bridges, culverts, etc…).
Accuracy of the flow data and boundary conditions (inflow hydrographs, rating curves, etc…).
Numerical Accuracy of the solution scheme (solution of the unsteady flow equations).

Numerical Accuracy. If we assume that the 1-dimensional unsteady flow equations are a true 
representation of flow moving through a river system, then only an analytical solution of these 
equations will yield an exact solution. Finite difference solutions are approximate. An exact solution 
of the equations is not feasible for complex river systems, so HEC-RAS uses an implicit finite 
difference scheme.

Model Stability
An unstable numerical model is one for which certain types of numerical errors grow to the extent at 
which the solution begins to oscillate, or the errors become so large that the computations cannot 
continue. This is a common problem when working with an unsteady flow model of any size or 
complexity. Figure 7-40 is an example of a model that ran all the way through, but produced an 
unstable solution.
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F
igure 7 40. Hydrograph from an unstable solution.

The following factors will affect the stability and numerical accuracy of the model:

Cross section spacing.
Computation time step.
Theta weighting factor for numerical solution.
Calculation Options and Tolerances.
Lateral Structures/Weirs
Steep streams/mixed flow regime
Downstream Boundary Conditions
Cross section geometry and table properties
Bridges and Culvert crossings
Initial/low flow conditions
Drops in bed profile.
Manning's n values
Missing or bad main channel data

For more information on how to identify and address these stability issues see the page on "Finding 
and Fixing Model Stability Problems" 

Cross-Section Spacing

Cross sections should be placed at representative locations to describe the changes in geometry. 
Additional cross sections should be added at locations where changes occur in discharge, slope, 
velocity, and roughness. Cross sections must also be added at levees, bridges, culverts, and other 
structures.

Bed slope plays an important role in cross section spacing. Steeper slopes require more cross 
sections. Streams flowing at high velocities may require cross sections on the order of 100 feet or 
less. Larger uniform rivers with flat slopes may only require cross sections on the order of 5000 ft or 
more. However, most streams lie some where in between these two spacing distances.

Not enough cross sections: When cross sections are spaced far apart, and the changes in hydraulic 
properties are great, the solution can become unstable. In general, cross sections spaced too far 

https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/model-accuracy-stability-and-sensitivity/finding-and-fixing-model-stability-problems
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apart will cause additional numerical diffusion, due to the derivatives with respect to distance being 
averaged over to long of a distance. Also, if the distance between cross sections is so great, such that 
the Courant number would be much smaller than 1.0, then the model may also become unstable. An 
example of varying cross section spacing is shown in Figure 7-41. Figure 7-41 shows an inflow 
hydrograph (dashed green line) and two outflow hydrographs (solid blue and black line with 
squares). As shown in the figure, as cross section spacing is increased, the hydrograph will show 
some numerical attenuation/diffusion.

Figure 7 -41. The 
affects of cross section spacing on the hydrograph.

The general question about cross section spacing is "How do you know if you have enough cross 
sections." The easiest way to tell is to add additional cross sections (this can be done through the 
HEC-RAS cross section interpolation option) and save the geometry as a new file. Then make a new 
plan and execute the model, compare the two plans (with and without interpolated cross sections). 
If there are no significant differences between the results (profiles and hydrographs), then the 
original model without the additional cross sections is ok. If there are some significant differences, 
then additional cross sections should be gathered in the area where the differences occur. If it is not 
possible to get surveyed cross sections, or even cross sections from a GIS, then use the HEC-RAS 
interpolated cross sections. However, at least check the reasonableness of the interpolated cross 
sections with a topographic map. Edit any cross sections that do not look reasonable.

Cross Sections too Close. If the cross sections are too close together, then the derivatives with respect 
to distance may be overestimated (computed as steeper slopes than they should be), especially on 
the rising side of the flood wave. This can cause the leading edge of the flood wave to over steepen, 
to the point at which the model may become unstable. Figure 7-42 is an example where cross 
sections were placed very close together, and a very dynamic hydrograph was run through the river 
reach. The leading edge of the flood wave over steepened, and caused the model to produce an 
unstable result, which appears as a wall of water building just upstream of the flow going through 
critical depth. The solution to this problem is to remove some cross sections, which will allow the 
model to do a better job at computing the special derivatives.
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Figure 7 42. 
Stability problem from cross sections spaced to close together.

One of the first steps in stabilizing an unsteady flow model is to apply the correct cross section 
spacing. Dr. Danny Fread equation and P.G. Samuel's have developed equations for predicting 
maximum cross section spacing. These two equations are good starting points for estimating cross 
section spacing. Dr. Fread's equation is as follows:

Δx≤cTr20

where: Δx = Cross section spacing (ft)
Tr = Time of rise of the main flood wave (seconds)
c = Wave speed of the flood wave (ft/s)
Samuel's equation is as follows:

Δx≤0.15DS0

where: D = Average bank full depth of the main channel (ft)
So=Average bed slope (ft/ft)
Samuels equation is a little easier to use since you only have to estimate the average bank full depth 
and slope. For Fread's equation, although the time of rise of the hydrograph (Tr) is easy enough to 
determine, the wave speed (c) is a little more difficult to come by. At areas of extreme contraction 
and expansion, at grade breaks, or in abnormally steep reaches, inserting more cross sections may 
be necessary.

Computational Time Step.

Stability and accuracy can be achieved by selecting a time step that satisfies the Courant Condition:

Cr=VwΔtΔx≤1.0

Therefore:
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Δt≤ΔxVw

where: Vw = Flood wave speed, which is normally greater than the average velocity.
Cr = Courant Number. A value = 1.0 is optimal.
Δx=Distance between cross sections.
Δt=Computational time step.
For most rivers the flood wave speed can be calculated as:

Vw=dAdA

However, an approximate way of calculating flood wave speed is to multiply the average velocity by 
a factor. Factors for various channel shapes are shown in the table below.
Table 7-2 Factors for Computing Wave Speed from Average Velocity

Ratio Vw/V

Wide Rectangular 1.67

Wide Parabolic 1.44

Triangular 1.33

Natural Channel 1.5

Too large of a time step: When the solution scheme solves the unsteady flow equations, derivatives 
are calculated with respect to distance and time. If the changes in hydraulic properties at a give cross 
section are changing rapidly with respect to time, the program may go unstable. The solution to this 
problem in general is to decrease the time step. An example of a hydrograph routed with two 
different time steps (1 minute and 10 minutes) is shown in Figure 7-43 below. As shown in the Figure, 
the hydrograph routed with a 10 minute time step has a much lower peak flow, and the leading edge 
of the floodwave is not as steep. This is due to the fact that the time based derivatives in the solution 
are averaging the changes in the floodwave over too long of a time step, thus numerically 
dampening the floodwave.
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Figure 7 43. 
Hydrograph routed with two different time steps (1 and 10 minutes).

Too Small of a Time Step. If a time step is selected that is much smaller than what the Courant 
condition would dictate for a given flood wave, this can also cause model stability problems. In 
general to small of a time step will cause the leading edge of the flood wave to steepen, possible to 
the point of oscillating and going unstable.

Practical Time Step Selection

 For medium to large rivers, the Courant condition may yield time steps that are too restrictive (i.e. a 
larger time step could be used and still maintain accuracy and stability). A practical time step is:

Δt≤Tr20

where: Tr=Time of rise of the hydrograph to be routed.
However, you may need to use a smaller time step when you have lateral weirs/spillways and 
hydraulic connections between storage areas and the river system. Also, if you are opening and 
closing gates quickly, or modeling a Dam or Levee breach, you will need to use very small time steps 
(less than a minute, maybe even as low as 5 seconds).



Performing a 1D Unsteady Flow Analysis

HEC-RAS User's Manual– 314

Theta Weighting Factor

Theta is a weighting applied to the finite difference approximations when solving the unsteady flow 
equations. Theoretically Theta can vary from 0.5 to 1.0. However, a practical limit is from 0.6 to 1.0 
Theta of 1.0 provides the most stability, but less numerical accuracy. Theta of 0.6 provides the most 
accuracy, but less numerical stability. The default in HEC-RAS is 1.0. Once you have your model 
developed, reduce theta towards 0.6, as long as the model stays stable.

Larger values of theta increase numerical diffusion, but by how much? Experience has shown that for 
short period waves that rapidly rise, theta of 1.0 can produce significant errors. However, errors in 
the solution can be reduced by using smaller time steps.

When choosing theta, one must balance accuracy and computational robustness. Larger values of 
theta produce a solution that is more robust, less prone to blowing up. Smaller values of theta, while 
more accurate, tend to cause oscillations in the solution, which are amplified if there are large 
numbers of internal boundary conditions. Test the sensitivity of theta to your data set. If reducing 
theta does not change the solution, then the larger value should be used to insure greater stability.

For rivers with tidal boundaries, in which the rising tide will propagate upstream, the user should 
always try to use a theta value as close to 0.6 as possible. Tidal waves are very dynamic. In order for 
the solution to be able to accurately model a tidal surge, theta must be close to 0.6.

Calculation Options and Tolerances

 Within the HEC-RAS software there are several calculation options and tolerances that can affect the 
stability and accuracy of the solution. Some of the more important calculation options and 
tolerances are:
Calculation Tolerances: Three solution tolerances can be set or changed by the user: Water surface 
calculation (0.02 default); Storage area elevation (0.02 default); and Flow calculation (Default is that 
it is not used). The default values should be good for most river systems. Only change them if you are 
sure!!!

Making the tolerances larger will actually make the mode less stable. Making the tolerances smaller 
will make the model more stable, but may cause the program to iterate more, thus increasing the 
run time.

Maximum Number of Iterations: At each time step derivatives are estimated and the equations are 
solved. All of the computation nodes are then checked for numerical error. If the error is greater than 
the allowable tolerances, the program will iterate. The default number of iterations in HEC-RAS is set 
to 20. Iteration will generally improve the solution. This is especially true when your model has 
lateral weirs and storage areas.

Warm up time step and duration: The user can instruct the program to run a number of iterations at 
the beginning of the simulation in which all inflows are held constant. This is called the warm up 
period. The default is not to perform a warm up period, but the user can specify a number of time 
steps to use for the warm up period. The user can also specify a specific time step to use (default is to 
use the user selected computation interval). The warm up period does not advance the simulation in 
time, it is generally used to allow the unsteady flow equations to establish a stable flow and stage 
before proceeding with the computations.
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Time Slicing: The user can control the maximum number of time slices and the minimum time step 
used during time slicing. There are two ways to invoke time slicing: rate of change of an inflow 
hydrograph or when a maximum number of iterations is reached.

At each time step derivatives are estimated and the equations are solved. All of the computation 
nodes are then checked for numerical error. If the error is greater than the allowable tolerances, the 
program will iterate. The default number of iterations in HEC-RAS is set to 20. Iteration will generally 
improve the solution. This is especially true when your model has lateral weirs and storage areas.

Inline and Lateral Structure Stability Issues

 Inline and Lateral Structures can often be a source of instability in the solution. Especially lateral 
structures, which take flow away or bring it into the main river. During each time step, the flow over a 
weir/spillway is assumed to be constant. This can cause oscillations by sending too much flow 
during a time step. One solution is to reduce the time step. Another solution is to use Inline and 
Lateral Structure stability factors, which can smooth these oscillations by damping the initial 
estimate of the computed flows.

The Inline and Lateral Structure stability factors can range from 1.0 to 3.0. The default value of 1.0 is 
essentially no damping of the computed flows. As you increase the factor you get greater dampening 
of the initial guess of the flows (which will provide for greater stability).

Long and flat Lateral Weirs/Spillways

 during the computations there will be a point at which for one time step no flow is going over the 
lateral weir, and then the very next time step there is. If the water surface is rising rapidly, and the 
weir is wide and flat, the first time the water surface goes above the weir could result in a very large 
flow being computed (i.e. it does not take a large depth above the weir to produce are large flow if it 
is very wide and flat). This can result in a great decrease in stage from the main river, which in turn 
causes the solution to oscillate and possible go unstable. This is also a common problem when 
having large flat weirs between storage areas. The solution to this problem is to use smaller 
computational time steps, and/or weir/spillway stability factors.

Opening gated spillways to quickly

When you have a gated structure in the system, and you open it quickly, if the flow coming out of 
that structure is a significant percentage of the flow in the receiving body of water, then the resulting 
stage, area and velocity will increase very quickly. This abrupt change in the hydraulic properties can 
lead to instabilities in the solution. To solve this problem you should use smaller computational time 
steps, or open the gate a littler slower, or both if necessary

Weir and Gated Spillway Submergence Factors. 

When you have a weir or gated spillway connecting two storage areas, or a storage area and a reach, 
oscillations can occur when the weir or gated spillway becomes highly submerged. The program 
must always have flow going one way or the other when the water surface is above the weir/spillway. 
When a weir/spillway is highly submerged, the amount of flow can vary greatly with small changes in 
stage on one side or the other. This is due to the fact that the submergence curves, which are used to 
reduce the flow as it becomes more submerged, are very steep in the range of 95 to 100 percent 
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submergence. The net effect of this is that you can get oscillations in the flow and stage hydrograph 
when you get to very high submergence levels. The program will calculate a flow in one direction at 
one time step. That flow may increase the stage on the receiving side of the weir, so the next time 
step it sends flow in the other direction. This type of oscillation is ok if it is small in magnitude. 
However, if the oscillations grow, they can cause the program to go unstable.

To reduce the oscillations, the user can increase the Weir/Spillway Submergence Factor. This factor 
can vary from 1.0 to 3.0. A factor of 1.0 leaves the submergence criteria in its original form. Using a 
factor greater than 1.0 causes the program to use larger submergence factors earlier, and makes the 
submergence curve less steep at high degrees of submergence. A plot of the submergence curves for 
various factors is shown in Figure 7-44.

The net result of using a weir flow submergence factor greater than 1.0, is the flow rate will be 
reduced more at lower degrees of submergence, but the computations will be much more stable at 
high degrees of submergence.

Figure 7 44. Weir/Spillway Submergence Factors.

Steep Streams and Mixed Flow Regime

 Higher velocities and rapid changes in depth and velocity are more difficult to model and keep a 
stable solution. As the Froude number approaches 1.0 (critical depth), the inertial terms of the St. 
Venant equations and their associated derivatives tend to cause model instabilities (For the 1D Finite 
Difference solver). The default solution methodology for unsteady flow routing within HEC-RAS is 
generally for subcritcal flow. The software does have an option to run in a mixed flow regime mode. 
However, this option should not be used unless you truly believe you have a mixed flow regime river 
system. If you are running the software in the default mode (subcritical only, no mixed flow), and if 
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the program goes down to critical depth at a cross section, the changes in area, depth, and velocity 
are very high. This sharp increase in the water surface slope will often cause the program to 
overestimate the depth at the next cross section upstream, and possible underestimate the depth at 
the next cross section downstream (or even the one that went to critical depth the previous time 
step). One solution to this problem is to increase the Manning's n value in the area where the 
program is first going to critical depth. This will force the solution to a subcritical answer and allow it 
to continue with the run. If you feel that the true water surface should go to critical depth, or even to 
a supercritical flow regime, then the mixed flow regime option should be turned on. Another solution 
is to increase the base flow in the hydrographs, as well as the base flows used for computing the 
initial conditions. Increased base flow will often dampen out any water surfaces going towards or 
through critical depth due to low flows.

Bad downstream boundary condition

If the user entered downstream boundary condition causes abrupt jumps in the water surface, or 
water surface elevations that are too low (approaching or going below critical depth), this can cause 
oscillations in the solution that may lead to it going unstable and stopping. Examples of this are 
rating curves with not enough points or just simply too low of stages; and normal depth boundary 
conditions where the user has entered too steep of a slope. Shown in Figure 7-45 is an example in 
which a Normal depth boundary condition was used with too steep of an energy slope entered by 
the user. The net affect was that for any given flow, the water surface elevation was computed much 
lower than it should have been, as shown in the figure. The water surface just upstream of the 
boundary condition becomes very steep, and potentially can lead to an unstable solution.

Figure 7 45. Example of a bad downstream boundary condition.
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Cross section Geometry and Table properties

All of the cross sections get converted to tables of hydraulic properties (elevation versus area, 
conveyance, and storage). If the curves that represent these hydraulic properties have abrupt 
changes with small changes in elevation, this can also lead to instability problems. This situation is 
commonly caused by: levees being overtopped with large areas behind them (since the model is one 
dimensional, it assumes that the water surface is the same all the way across the entire cross 
section); and ineffective flow areas with large amounts of storage that are turned on at one 
elevation, and then turn off at a slightly higher elevation (this makes the entire area now used as 
active conveyance area). There are many possible solutions to these problems, but the basic solution 
is to not allow the hydraulic properties of a cross section to change so abruptly. If you have a levee 
with a large amount of area behind it, model the area behind the levee separately from the cross 
section. This can be done with either a storage area or another routing reach, whichever is most 
hydraulically correct for the flow going over the levee or if the levee breaches. With large ineffective 
flow areas, the possible solutions are to model them as being permanently on, or to put very high 
Manning's n values in the ineffective zones. Permanent ineffective flow areas allow water to convey 
over top of the ineffective area, so the change in conveyance and area is small. The use of high 
Manning's n values reduces the abruptness in the change in area and conveyance when the 
ineffective flow area gets turned off and starts conveying water.

Cross section property tables that do not go high enough: The program creates tables of elevation 
versus area, conveyance, and storage area for each of the cross sections. These tables are used 
during the unsteady flow solution to make the calculations much faster. By default, the program will 
create tables that extend up to the highest point in the cross section, however, the user can override 
this and specify their own table properties (increment and number of points). If during the solution 
the water surface goes above the highest elevation in the table, the program simply extrapolates the 
hydraulic properties from the last two points in the table. This can lead to bad water surface 
elevations or even instabilities in the solution.

Not enough definition in cross section property tables: The counter problem to the previous paragraph 
is when the cross section properties in a given table are spread too far apart, and do not adequately 
define the changes in the hydraulic properties. Because the program uses straight-line interpolation 
between the points, this can lead to inaccurate solutions or even instabilities. To reduce this 
problem, we have increased the allowable number of points in the tables to 100. With this number of 
points, this problem should not happen.

Bridge and Culvert crossings

 Bridge/Culvert crossings can be a common source of model stability problems when performing an 
unsteady flow analysis. Bridges may be overtopped during an event, or even washed out. Common 
problems at bridges/culverts are the extreme rapid rise in stages when flow hits the low chord of the 
bridge deck or the top of the culvert. Modelers need to check the computed curves closely and make 
sure they are reasonable. One solution to this problem is to use smaller time steps, such that the rate 
of rise in the water surface is smaller for a given time step. Modelers may also need to change 
hydraulic coefficients to get curves that have more reasonable transitions.

An additional problem is when the curves do not go high enough, and the program extrapolates from 
the last two points in the curve. This extrapolation can cause problems when it is not consistent with 
the cross section geometry upstream and downstream of the structure.
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For bridge and culvert crossing the program creates a family of rating curves to define all the 
possible headwater, tailwater, and flow combinations that can occur at a particular structure. One 
free flow curve (headwater versus flow, with no influence from the tailwater) is calculated with fifty 
points to define it, then up to fifty submerged curves (headwater versus flow, staring at a particular 
tailwater) are calculated with up to 20 points to define each curve. The user can control how many 
submerged curves get calculated, how many points in each curve, and the properties used to define 
the limits of the curves (maximum headwater, maximum tailwater, maximum flow, and maximum 
head difference). By default, the software will take the curves up to an elevation equal to the highest 
point in the cross section just upstream of the structure. This may lead to curves that are too spread 
out and go up to a flow rate that is way beyond anything realistic for that structure. These type of 
problems can be reduced by entering specific table limits for maximum headwater, tailwater, flow, 
and head difference. An example set of curves are shown in Figure 7-46.

Figure 7 46. 
Example Family of Curves for a Bridge crossing.

Ineffective flow areas are required up and downstream of bridges and culverts to properly define the 
contraction and expansion zones. Unsteady flow models, and particularly dam breach models, need 
these zones to be adequately defined. When the bridge is overtopped, the ineffective flow areas will 
turn off. This sudden and large increase in conveyance can cause model instability. One solution is to 
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use very high Manning's n values (.2 to 1.0) in the ineffective flow zones, so when they turn off the 
increase in conveyance is not so great. This is also more physically appropriate as the cross sections 
just upstream and downstream can not flow completely freely because of the bridge embankment.

Initial Conditions and Low Flow

When starting a simulation it is very common to start the system at low flows. Make sure that the 
initial conditions flow is consistent with the first time step flow from the unsteady flow boundary 
conditions. User's must also pay close attention to initial gate settings and flows coming out of a 
reservoir, as well as the initial stage of the pool in the reservoir. The initial condition flow values must 
be consistent with all inflow hydrographs, as well as the initial flows coming out of the reservoir.

Flows entered on the initial conditions tab of the Unsteady Flow Data editor are used for calculating 
stages in the river system based on steady flow backwater calculations. If these flows and stages are 
inconsistent with the initial flows in the hydrographs, and coming out of the reservoir, then the 
model may have computational stability problems at the very beginning of the unsteady flow 
computations.

If any portion of an inflow hydrograph is so low that it causes the stream to go through a pool and 
riffle sequence, it may be necessary to increase the base flow. The minimum flow value must be 
small enough that it is negligible when compared to the peak of the flood wave. A good rule of 
thumb is to start with a minimum flow equal to about 1 % of the peak flood (inflow hydrograph, or 
dam breach flood wave) and increase as necessary to 10%. If more than 10% is needed, then the 
problem is probably from something else.

If you have some cross sections that are fairly wide, the depth will be very small. As flow begins to 
come into the river, the water surface will change quickly. The leading edge of the flood wave will 
have a very steep slope. Sometimes this steep slope will cause the solution to reduce the depth even 
further downstream of the rise in the water surface, possibly even producing a negative depth. This 
is due to the fact that the steep slope gets projected to the next cross section downstream when 
trying to solve for its water surface. The best solution to this problem is to use what is called a pilot 
channel. A pilot channel is a small slot at the bottom of the cross section, which gives the cross 
section a greater depth without adding much flow area. This allows the program to compute shallow 
depths on the leading edge of the flood wave without going unstable. Another solution to this 
problem is to use a larger base flow at the beginning of the simulation.

Drops in the Bed Profile

Significant drops in the bed profile can also be a source of model stability problems, especially at 
low flows. If the drop is very small, then usually an increase in baseflow will drowned out the drop, 
thus preventing the model from passing through critical depth. If the drop is significant, then it 
should be modeled with an inline structure using a weir. This will allow the model to use a weir 
equation for calculating the upstream water surface for a given flow, rather than using the unsteady 
flow equations. This produces a much more stable model, as the program does not have to model 
the flow passing through critical depth with the unsteady flow equations. HEC-RAS automatically 
handles submergence on the weir, so this is not a problem. An example of a profile drop that causes 
a model stability problem is shown in Figure 7-47.
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Figure 7 47. Stability 
Problem caused by drop in bed profile.

When an Inline Structure (weir) is added to the above data set, the model is able to obtain a stable 
and accurate solution of the profile (Figure 7-48).

Figure 7 48. Stable 
solution using Inline Structure to represent profile drop.

Some additional solutions to the problem of significant drops in the channel invert are: increase the 
base flow to a high enough value to drowned out the drop in the bed profile; put a rating curve into 
the cross section at the top of the drop (this will prevent the unsteady flow equations being solved 
through the drop, the rating curve will be used instead); and add more cross section, if the drop is 
gradual, and run the program in mixed flow regime mode.
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Manning's n Values

Manning's n values can also be a source of model instability. Manning's n values that are too low, will 
cause shallower depths of water, higher velocities, and possibly even supercritical flows. This is 
especially critical in steep streams, where the velocities will already be high. User's should check 
there estimated Manning's n values closely in order to ensure reasonable values. It is very common 
to underestimate Manning's n values in steep streams. Use Dr. Robert Jarrets equation for steep 
streams to check your main channel Manning's n values. An example model stability problem due to 
too low on Manning's n values being used in steep reaches is shown in Figure 7-49.

Figure 7 49. 
Model stability problem due to low Manning's n values.

Over estimating Manning's n values will cause higher stages and more hydrograph attenuation than 
may be realistic.
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Missing or Bad Channel Data

Another typical source of instabilities occurs when the main channel has a wide flat bed. This is 
usually found when cross sections are approximated or when terrain data is used to develop cross 
sections exclusive of real bathymetric data. Many times reaches are developed in GIS using LIDAR 
data or other aerial means. These survey methods don't penetrate water surfaces so the main 
channel is left with a flat horizontal bed equal to the water surface elevation (Figure 7-50). For dam 
breach analyses, shallow streams are normally okay, since the dam break flood wave is usually much 
greater than the depth of water in the channel. However, wide flat stream beds tend to cause 
instabilities because at lower flows, the area to depth ratio is very high. When this occurs, a small 
increase in depth is seen as a large relative increase in depth.

Figure 7 50. 
Example Cross Section missing most of the main channel.

Additionally, in the cross section plot, if high ground that is not appropriately accounted for can be a 
source of instabilities. High ground can be modeled as levees or with ineffective flows to remove the 
abrupt changes in storage and conveyance when the high ground is overtopped.

Stream Junction Issues

 The unsteady flow equation solver, by default, makes a simplifying assumption at stream junctions. 
The unsteady solver forces the same exact water surface at all cross sections that bound a junction 
(Upstream and downstream of the junction). This simplifying assumption is fine for flat to 
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moderately sloping streams. However, once you get to medium to steep sloping streams, this is 
normally a bad assumption, and can even cause model instability issues.

In general, cross sections placed around stream junctions should be placed as close to the junction 
as possible, such that the assumption of equal water surface elevation is not so bad. Sometimes this 
is not possible. For example, in steep streams, the first cross section of a tributary coming into a 
main stem may have a higher channel invert than the main stem river. If you are starting the model 
at a low flow, the program computes the water surface in the main river below the junction, then 
forces that water surface on the cross sections upstream of the junction, both in the main river and 
the tributary. This can often end up with way too low of a water surface elevation in the tributary, for 
the given flow rate, which very quickly causes the model to go unstable in the tributary reach near 
the junction.

The solution to this problem, is to first ensure you have the cross sections bounding the junction, as 
close to the junction as possible. Second, compare at the main channel elevations of all the cross 
sections that bound the junction. If one cross section is much higher than the others (say the 
tributary one), then there will be a problem trying to run this model at low flow. Either extract a new 
cross section closer to the junction (thus having a lower main channel), or adjust the main channel 
data of that cross section.

An additional option that has been added to HEC-RAS to assist in this problem, is the option to use 
an "Energy Balance Method" to compute the water surface elevations across the junction during the 
unsteady flow computations. This option will allow for sloping water surface elevations across the 
junction and can help alleviate many model stability issues at junctions in medium to steep sloping 
streams.

Model Sensitivity
Model sensitivity is an important part of understanding the accuracy and uncertainty of the model. 
There are two types of sensitivity analysis that should be performed, Numerical Sensitivity and 
Physical Parameter Sensitivity.

Numerical Sensitivity

Numerical Sensitivity is the process of adjusting parameters that affect the numerical solution in 
order to obtain the best solution to the equations, while still maintaining model stability. The 
following parameters are typically adjusted for this type of sensitivity analysis:

Computational Time Step - The user should try a smaller time step to see if the results change 
significantly. If the results do change significantly, then the original time step is probably too large to 
solve the problem accurately.

Theta Weighting Factor - The default value for this factor is 1.0, which provides the greatest amount 
of stability for the solution, but may reduce the accuracy. After the user has a working model, this 
factor should be reduced towards 0.6 to see if the results change. If the results do change, then the 
new value should be used, as long as the model stays stable. Be aware that using a value of 0.6 gives 
the greatest accuracy in the solution of the equations, but it may open the solution up to stability 
problems.
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Weir/Spillway Stability Factors – If you are using these factors to maintain stability, try to reduce 
them to the lowest value you can and still maintain stability. The default value is 1.0, which is no 
stability damping.

Weir/Spillway Submergence Exponents – In general these parameters will not affect the answers 
significantly, they only provide greater stability when a spillway/weir is at a very high submergence. 
Try reducing them towards 1.0 (which is no factor) to see if the model will remain stable.

Physical Parameter Sensitivity

 Physical Parameter Sensitivity is the process of adjusting hydraulic parameters and geometric 
properties in order to test the uncertainty of the models solutions. This type of sensitivity analysis is 
often done to gain an understanding of the possible range of solutions, given realistic changes in the 
model parameters. Another application of this type of sensitivity analysis is to quantify the 
uncertainty in the model results for a range of statistical events (2, 5,10, 25, 50, 100 yr, etc…). The 
following data are often adjusted during this type of sensitivity analysis:

Manning's n Values – Manning's n values are estimated from physical data about the stream and 
floodplain. Sometimes Manning's n values are calibrated for a limited number of events. Either way, 
the values are not exact! The modeler should estimate a realistic range that the n values could be for 
their stream. For example, if you estimated an n value for a stream as 0.035, a realistic range for this 
might be 0.03 to 0.045. The modeler should run the lower Manning's n values and the higher 
Manning's n values to evaluate their sensitivity to the final model results.

Cross Section Spacing – Cross section spacing should always be tested to ensure that you have 
enough cross sections to accurately describe the water surface profiles. One way to test if you have 
enough cross sections is to use the HEC-RAS cross section interpolation routine, and interpolate 
enough cross sections to cut the average distance between cross sections in half. Re-run the model, 
if the results have not changed significantly, then your original model was probably fine. If the results 
do change significantly, then you should either get more surveyed cross sections or use the 
interpolated cross sections. If you use the interpolated cross sections, then you should at least look 
at a topographic map to ensure that the interpolated cross sections are reasonable. If the 
interpolated cross sections are not reasonable in a specific area, then simply edit them directly to 
reflect what is reasonable based on the topographic map.

Cross Section Storage – Portions of cross sections are often defined with ineffective flow areas, which 
represents water that has no conveyance. The extent of the storage within a cross section is an 
estimate. What if the ineffective flow areas were larger or smaller? How would this effect the results? 
This is another area that should be tested to see the sensitivity to the final solution.

Lateral Weir/Spillway Coefficients – Lateral weir/spillway coefficients can have a great impact on the 
results of a simulation, because they take water away or bring water into the main stream system. 
These coefficients can vary greatly for a lateral structure, depending upon their angle to the main 
flow, the velocity of the main flow, and other factors. The sensitivity of these coefficients should also 
be evaluated.

Bridge/Culvert Parameters – In general, bridge and culvert parameters normally only effect the 
locally computed water surface elevations just upstream and downstream of the structure. The 
effect that a bridge or culvert structure will have on the water surface is much greater in flat streams 
(a small increase in water surface can back upstream for a long distance if the river is flat). However, 
the sensitivity of the water surface elevations around a bridge or culvert may be very important to 
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localized flooding. The bridge and culvert hydraulic parameters should also be evaluated to test 
their sensitivity.

Finding and Fixing Model Stability Problems
Detecting Model Stability Problems. One of the hardest things about using an unsteady flow model 
is to get the model to be stable, as well as accurate, for the range of events to be modeled. When you 
first start putting together an unsteady flow model, undoubtedly you will run in to some stability 
problems. The question is, how do you know you are having a stability problem? The following is a 
list of stability problem indicators:

Program stops running during the simulation with a math error, or states that the matrix solution went 
unstable.
Program goes to the maximum number of iterations for several time steps in a row with large numerical 
errors.
There are unrealistic oscillations in the computed stage and flow hydrographs, or the water surface profiles.
The computed error in the water surface elevation is very large.

What do you do when this happens?

Note the simulation time and location from the computation window when the program either blew up or 
first started to go to the maximum number of iterations with large water surface errors.
Use the HEC-RAS Profile and Cross Section Plots as well as the Tabular Output to find the problem location 
and issue.
If you cannot find the problem using the normal HEC-RAS output - Turn on the "Computation Level Output" 
option and re-run the program.
View the time series and profile output associated with the Computation Level Output option. Locate the 
simulation output at the simulation time when the solution first started to go bad.
Find the river station locations that did not meet the solution tolerances. Then check the data in this general 
area.

The Computational Window is the first place to look for problems. When the maximum number of 
iterations is reach, and solution error is greater than the predefined tolerance, the time step, river, 
reach, river station, water surface elevation and the amount of error is reported. When the error 
increases too much, the solution will stop and say "Matrix Solution Failed". Often the first river 
station to show up on the window can give clues to the source of instabilities.
An example of the Computation Window with an unstable model solution is shown in Figure 7-51. 
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Figure 7 51. Example Unsteady Flow Computation window with unstable solution. 
The first place to look for instabilities and errors is the Computations Window during and just after 
the simulation is run. The red progress bar indicates the model went unstable and could not 
complete the simulation. The Computation Messages window provides a running dialog of what is 
happening in the simulation at a given time step in a given location. This allows the user to watch 
errors propagate during the simulation. Once the simulation has crashed, don't close the 
Computations Window. Instead, scroll up through the messages and try to determine where the 
propagation of errors began, and at what time. 
Sometimes the first error to occur is at the beginning of the simulation and is just a result of the 
model settling out after the transition from initial conditions to the first time step. Particularly if the 
error only occurs once for that given river station. It is better to focus on reoccurring errors or 
compounding errors first. The example shown in Figure 7-52 shows a relatively small error at river 
station 259106* that grows to 0.4 ft in the next few time steps. 
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Figure 7 52. Example of growing computational errors. 

Utilizing the Profile Plot.

The profile plot is typically the first graphical tool to use to try to pinpoint instabilities. Obvious 
errors are shown distinctly in this plot and you can see what is going on in the entire reach at the 
same time. Stepping through each profile using the animation tool allows you to see changes over 
time, including the progression of the flood wave as well as propagation of errors. The profile output 
is taken from the detailed output file. Therefore, it is sometimes necessary to refine the detailed 
output interval to adequately see the beginning of instabilities. The profile plot allows the user to 
click on a given node to determine its river stationing. Find the node where the instability first occurs 
and investigate further.

Computational Level Output for Debugging

An additional feature that has been added to HEC-RAS to help user's find model stability problems, is 
the "Computational Level Output" option. When performing an unsteady flow analysis the user can 
optionally turn on the ability to view output at the computation interval level. This is accomplished 
by checking the box labeled Computation Level Output on the Unsteady Flow Analysis window (In 
the Computations Settings area on the window). When this option is selected an additional binary 
file containing output at the computation interval is written out. Users can control what output is 
written to this file from the options called Output Options. There is a tab labeled "Computation 
Level Output Options" on this window that allows you to control what gets written to this file, and 
there is also a time window option for controlling the time period for writing this data. After the 
simulation the user can view computation level output by selecting either Unsteady Flow Spatial 
Plot or Unsteady Flow Time Series Plot from the View menu of the main HEC-RAS window.
Visualization of computation level output can be accomplished with either Spatial Plots or Time 
Series Plots. From the Spatial Plots the user can view either a profile plot, a spatial plot of the 
schematic, or tabular output. The user can select from a limited list of variables that are available at 
the computation level output. These are water surface elevation (XS WSEl); Flow (XS Flow); 
computed maximum error in the water surface elevation (XS WSEL ERROR); computed maximum 
error in the flow (XS FLOW ERROR); and maximum depth of water in the channel (DEPTH). Each of the 
plots can be animated in time by using the video player buttons at the top right of the window. This 
type of output can often be very useful in debugging problems within an unsteady flow run. 
Especially plotting the water surface error and animating it in time. An example of the computational 
level output spatial plot is shown in Figure 7-53.
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Figure 7 53. Example Spatial Plot from Computational Level Output. 
The other type of plot available at the computation interval output level is the Unsteady Flow Time 
Series Plot. When this option is selected the user will get a plot as shown in the Figure above. Some 
of the same options and variables are available for the Time Series Plots as were available for the 
Spatial Plots.
Once a location of an instability is determined on the profile plot, or the computational spatial plot, 
the cross section plot can be used to further investigate the cause of the instability. The cross section 
plot will show isolated problems such as incorrectly placed bank stations, poor n-values, and bad 
station-elevation data. In addition, scrolling through its neighboring cross sections can give you an 
idea of transition problems like contractions and expansions that occur to abruptly, poorly defined 
ineffective flow areas, or incorrectly handled levees or natural high ground spots.

Detailed Log Output for Debugging

If you detect a possible stability problem, and you are unable to find the location using the graphical 
output discussed above, another option for finding the location of the problem is to turn on the 
detailed log output for debugging. Detailed log output is turned on by selecting Options and then 
Output Options from the Unsteady Flow Simulation manager. When this option is selected the 
following window will appear:
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Figure 7 54. Detailed Log Output Control 
As shown in Figure 7-54, the tab labeled "Detailed Log Output" allows the user to control this option. 
Three check boxes are listed. The first box can be used to turn on an echo of the hydrograph input to 
the model. This can be used to ensure that the model is receiving the correct flow data. The second 
check box can be used to turn on an echo of the computed hydrographs that will be written to the 
HEC-DSS. This is a good option for checking what was computed. However, if the user has selected 
to have hydrographs computed at many locations, this could end up taking a lot of file and disk 
space. The third check box, labeled "Write detailed log output for debugging", is used to control the 
detailed output of results from the unsteady flow simulation. Selecting this option will cause the 
software to write detailed information on a time step by time step basis. This option is useful when 
the unsteady flow simulation is going unstable or completely blowing up (stopping). Checking this 
box turns on the detailed output for every time step. The user has the option to limit this output to a 
specific time window during the unsteady flow simulation. Limiting the log output is accomplished 
by entering a starting date and time and an ending date and time. Additionally the user can request 
that detailed log output only be written when the program reaches a certain number of iterations.
Viewing Detailed Log Output. After the user has turned on the detailed log output option, re-run 
the unsteady flow simulation. The user can then view the detailed log output by selecting View 
Computational Log File from the Options menu of the Unsteady Flow Simulation window. When 
this option is selected the detailed log output file will be loaded into the default text file viewer for 
your machine (normally the NotePad.exe program, unless you have changed this option within HEC-
RAS). 
The detailed log output file will contain the following output:
DSS Output: Shows all of the hydrograph data that will be used as input to the model, including data 
read from HEC-DSS.
Unsteady Flow Computations Output: Detailed unsteady flow calculations including:

Job control parameters
Initial conditions calculations
Detailed output for each time step
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Table Output: Final computed hydrographs that are written to HEC-DSS.
The program lists the computed initial conditions from a backwater calculation for each of the river/
reaches. They are listed in the order they were computed during the backwater analysis, which is 
downstream to upstream. An example of the initial conditions output is shown in Figure 7-55 below.

Figure 7 55. Example of Initial Conditions Output. 
During the unsteady flow computations, the program will output detailed information for cross 
sections, bridges/culverts, inline weir/spillways, lateral weir/spillways, storage areas, and storage 
area connections. This information should be reviewed closely when the software is having stability 
problems. An example of the detailed output for cross sections is shown in Figure 7-56 below.

Figure 7 56. Detailed Output at a Cross Section 
When the program has stability problems, it will generally try to solve them by iterating. An example 
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of a stability problem is shown in Figure 7-55. In this example the program did not solve the 
equations to the specified tolerances, and therefore it was iterating to improve the solution. As 
shown in Figure 7-57, the program iterated to the maximum number of iterations. At the end of the 
iterations a warning message states "WARNING: USED COMPUTED CHANGES IN FLOW AND STAGE 
AT MINIMUM ERROR. MINIMUM ERROR OCCURRED AT ITERATION XX." This message means that 
the program could not solve the unsteady flow equations to the required tolerance within the 
specified number of iterations (default number of iterations is 20). Therefore it used the iteration 
that had the least amount of error in the numerical solution.

Figure 7 57. Example Detailed Time Step Output for Cross Sections 
One way to find and locate potential stability problems with the solution is to do a search in the file 
for the word "WARNING". The user then needs to look at the detailed output closely to try and detect 
both where and why the solution is going bad. 
The variables that are printed out during the iterations are the following:
Iter= Iteration Number
River = The name of the river in which the largest stage error is occurring.
Station = River station with the largest error in the calculated stage. 
Elev = Computed water surface elevation at that river station 
DZ= The "Numerical Error" in the computed stage at that location
Storage= Name of the storage area.
Zsa= Computed elevation of the storage area
Dzsa= The "Numerical Error" in the computed storage area elevation.
River= The name of the river in which the largest flow error is occurring.
Station= River station with the largest error in the calculation of flow
Q= Computed flow
DQ= The "Numerical Error" in the computed flow at the listed river station
After the iterations output, the program will show the computed stages and flows for all of the cross 
sections in which the user has selected to have hydrographs computed. This is also useful 
information for detecting model stability problems. It is not always obvious as to which cross section 
or modeling component is causing the problem. Sometimes the program may blow up at one cross 
section, but the real problem is caused by a cross section upstream or downstream from this 
location. Detecting, finding, and fixing stability problems will require lots of experience to become 
proficient at it. Good luck, and don't get to discouraged!!! 
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Performing a Dam or Levee Breach Analysis with HEC-RAS

HEC-RAS can simulate Dam or Levee breaching. Users can analyze breaches on multiple Dams and/
or levees simultaneously within the same unsteady flow run.  There is no limit to the number of 
breach locations.  Breach data can be entered for a any and all Dams (Inline Structures) and Levees 
(Lateral Structures).   However users can also turn specific locations on or off for any specific 
analysis.

The breach data entered, and the erosion process used in HEC-RAS for a Dam or a Levee are almost 
identical. Dams are entered as Inline Structures in HEC-RAS, and Levees are entered as Lateral 
Structures. Both types of structures have a breaching option, and the breaching editor used is almost 
identical. There are some minor differences in the data entered. Most of the differences are in how it 
is applied hydraulically in the model.

User has can select from three Breaching Methodologies:

User Entered Data
Simplified Physical
DL Breach

 The User Entered Data method requires the user to enter all of the breach information (i.e. breach 
size, breach development time, preach progression, etc…).

 The Simplified Physical breaching method allows the user to enter velocity versus breach down-
cutting and breach widening relationships, which are then used dynamically compute out the breach 
progression versus the actual velocity being computed through the breach, on a time step by time 
step basis.  (e.g. The model updates the breach rates based on the velocity during the simulation)

•
•

•

Note: Dam Breach Modeling Information is Distributed in Three Documentation Locations

Note: There are three sections on Dam Breach Modeling distributed throughout the HEC-RAS 
Documentation.

Information on the User Interface in this Section 
A more detailed discussion on the methods and practices in the "Dam Breach Analysis" section of 
Advanced Unsteady Features
Practical guidance on how to build a Dam Break study in the Technical Reference Manual 
("Performing a Dam Break Study in HEC-RAS")



https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/performing-a-dam-or-levee-breach-analysis-with-hec-ras/user-enter-breach-data
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/performing-a-dam-or-levee-breach-analysis-with-hec-ras/simplified-physical-breaching
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/performing-a-dam-or-levee-breach-analysis-with-hec-ras/dl-breach
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/advanced-features-for-unsteady-flow-routing/dam-break-analysis
https://www.hec.usace.army.mil/confluence/rasdocs/ras1dtechref/latest/performing-a-dam-break-study-with-hec-ras
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Note: The documentation in this chapter for dam and levee breaching is just an overview of how to 
use the User Interface to enter the data. For a more detailed discussion of Dam and Levee Breach, 
please go to the section on Dam and Levee Breaching in Chapter 14 of this Manual (Advanced 
Features for Unsteady Flow Analysis) or the chapter of the Technical Reference Manual titled 
"Performing a Dam Breach Study with HEC-RAS"

Dam (Inline Structure) Breach

HEC-RAS stores the breach data in the "Plan" (*pxx) file. Plan information includes temporal 
information, like when a dam breaches.  However, the breach is associated with an inline structure, 
which is a geometry feature.  Therefore, HEC-RAS allows users to access the breach editor in two 
ways.   First there is a button on the Inline Structure editor that is labeled Breach (Plan Data) (left 
pane of the Figure below). Second, from the Unsteady Flow Simulation Manager, the user can select 
Dam (Inline Structure) Breach from the Options menu (right pane in the Figure below). 

Figure - Two methods to access the Dam Breach Editor, through the Inline Structure Editor in the 
Geometry (left) and through the Plan Options (Right)

Both of these methods launch the Breach Editor depicted in the Figure below.  The Breach Editor 
allows users to selects the Inline Structure to breach. Select the Breach This Structure check box to 
use the specified information to compute a breach.   HEC-RAS will only breach the structure if this 
box is checked. This box was added to allow the user to turn certain breaches on or off for different 
simulaitons, without losing the user entered breach information.

https://www.hec.usace.army.mil/confluence/rasdocs/ras1dtechref/latest/performing-a-dam-break-study-with-hec-ras
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Next the decision needs to be made as to whether the user is going to compute the breach 
dimensions and development time and enter it as "User Entered Data", or if they want to use the 
"Simplified Physical" breaching option (his option requires velocity versus erosion rate information).

Next, select a Breach Method, in the drop down box.  You can select one of three available methods:

User Defined Data

Simplified Physical Breaching

DL Breach 

Levee (Lateral Structure) Breach.

 
Levee breaches are very similar to the Dam Break option described above. The options and data 
entered to describe the breach is the same as a Dam Break. 

While the modeling methods and parameters are identical, there are a couple important conceptual 
differences modeling levees.  A levee is oriented parallel to flow (while a dam is perpendicular).  
Therefore a levee can cross several cross section.  Most importantly, this means that HEC-RAS will 
compute multiple water surface elevations and associate them with different locations along the 

Modeling Note: Make sure you select "Breach This Structure"

If you specify all of the breach parameters but the structure does not breach during the 
simulation, the most common issue is that the Breach This Structure check box was not 
selected.



https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/performing-a-dam-or-levee-breach-analysis-with-hec-ras/user-enter-breach-data
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/performing-a-dam-or-levee-breach-analysis-with-hec-ras/user-enter-breach-data
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/performing-a-dam-or-levee-breach-analysis-with-hec-ras/simplified-physical-breaching
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/performing-a-dam-or-levee-breach-analysis-with-hec-ras/simplified-physical-breaching
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/performing-a-dam-or-levee-breach-analysis-with-hec-ras/dl-breach
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-1d-unsteady-flow-analysis/performing-a-dam-or-levee-breach-analysis-with-hec-ras/dl-breach
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levee (verses a dam which will only respond to the single 1D water surfaces upstream and 
downstream of it).  

The Advanced Unsteady Flow Options portion of the documentation has a detailed section 
dedicated to Levee Breach Modeling.

Figure - Levee Breaching Editor

To use this option, define the levee as a lateral structure in the HEC-RAS geometry first. The lateral 
weir profile describes the top of the levee along the stream both at and between the cross sections. 
Second, enter a weir coefficient to calculate the flow over the levee when water surface gets high 
enough. You can enter breach data for the levee from the Levee (lateral structure) Breach option 
from the Unsteady Flow Simulation window (exactly like the Dam options pictured above). The levee 
breaching information is stored in the unsteady flow plan file, like the dam break. The levee breach 
editor is depicted above.

Levee Failures are very sensitive to the User Selected Center Station

The levee failure model will track the failure criteria at the "Center Station."  Choosing a center 
station for a dam is trivial, because you are comparing the embankment profile to a single 1D 
water surface elevation.  But a levee can have irregular and sloping embankments and water 
surface profiles (especially if the levee is long).  The Center Station is not only the center of the 
breach, but the location HEC-RAS evaluates the failure criteria.  Select it carefully based on 
simulations to help you estimate where the levee will overtop.



https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/advanced-features-for-unsteady-flow-routing/levee-overtopping-and-breaching
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A dam breach example is included in the example data files, and in the zip file below.

User Enter Breach Data

Global Breach Data

If the "User Entered Data" Breaching Method is selected, then the following data must be entered 
for the breaching analysis:
More detail on each of these parameters is available here.  
The Bold data types below are always visible, others are only available if specific options are 
selected.  
Bold Red data types below tend to be sensitive but uncertain (see inset below).

https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/advanced-features-for-unsteady-flow-routing/dam-break-analysis/entering-dam-break-data
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Some of the data are illustrated in the figure below.

Data Type Description

      Mandatory Data for All User Entered Breach Data Models*

Center Station The centerline stationing of the final breach.

Final Bottom 
Width

The bottom width of the breach at its maximum size.

Final Bottom 
Elevation

The elevation of the bottom of the breach after it has been fully developed.

Left Side Slope  Left side slope of the trapezoidal breach.

Right Side Slope Right side slope of the trapezoidal breach.

Breach Weir Coef The weir coefficient for the breach area. For an overtopping failure, or when 
the top of a piping failure collapses, the program uses a weir equation to 
calculate the flow through the breach. Suggested range of values are 2.0 to 3.2, 
with 2.6 as a default value for most earth dams. 

Breach Formation 
Time 

Breach Development Time in hours.  Time between the beginning of the breach 
(i.e. significant erosion) to the full breach development.

Failure Mode Select a failure process.  Either Overtopping of Piping.

     Piping-Specific Options and Data  
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Data Type Description

Piping Coefficient Orifice coefficient used to compute losses through the "pipe" for the piping 
failure (before it collapses).  Typical Orifice coefficients for an engineered 
orifice are around 0.8. However, for a piping breach, the coefficient should be 
lower to represent additional energy losses.  

Initial Piping Elev. Center of the piping flow when a piping failure develops.

Trigger Failure At Select the Method HEC-RAS will use to initiate the breach from the three 
options below

      Trigger Methods  

WS Elev HEC-RAS starts breaching when the the water surface elevation on one side of 
the structure reaches the specified value (Starting WS).

Starting WS Specify the water surface elevation to start the breach.

WS Elev + Duration This method assumes that the embankment fails after the water holds a 
certain elevation for a period of time (e.g. the process requires time to saturate 
a levee).  Therefore it requires an elevation and a duration, and includes a 
couple additional options. 

Threshold WS HEC-RAS tracks the time that the water surface exceeds this elevation.

Duration Above 
Threshold

If the water surface elevation exceeds the Threshold WS (above) for more than 
this Duration (time in hours) the breach will initiate.

Immediate 
Initiation WS

This is an "override elevation" that is higher than the Threshold WS.  If the water 
surface elevation exceeds this elevation, than the duration no longer matters.  
HEC-RAS switches to an immediate failure.  This essentially defaults to the WS 
Elev trigger mechanism if the water gets high enough (e.g. overtopping). 

Accumulate 
Duration

This feature accumulates all time above the specified Threshold WS even it it 
drops below the threshold in between.  If this is off the Duration Above 
Threshold resets ever time the water surface drops below the threshold. 

 

Set Time If users know when they want the breach to form, independent of the 
hydraulics, they can simply set the time.

Start Date Breach Date in DDMMMYYY format (e.g. 02Aug1983).

Start Time Breach Time in 24 hour, 0000 format(e.g. 1730).

*Note - Some of these are also required for DLBreach

Select Sensitive and Uncertain Parameters Carefully and Test Their Sensitivity

The Final Bottom Width and the Breach Formation Time tend to be the most speculative of the 
mandatory parameters, but results can also be very sensitive to them.  The other two Breach 
Methods represent alternate approaches to compute these more theoretically.  However, if 
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Breach Progression 

In addition to the User Entered Data in the left pane, the Breach editors have several tabs with 
additional features and data entry.  The first tab (Breach Plot) displays the structure with the outline 
of the fully developed breach based on the User Entered Data.  The second tab includes the Breach 
Progression data.

By default the breach progression is assumed to be linear (left pane of the figure below) between the 
breach initiation and the full breach size (Full Formation Time). But breaches tend to start slowly, 
and finish asymptotically, with the maximum deepening and widening in the middle of the breach.  
Therefore, users can customize this breach progression.  A sinusoidal breach progression is available 
by simply pressing the Sine Wave button right pane of Figure below).  Then the user can adjust this 
assumption if they have better insight, or input their own breach progression.

Figure - Dam Breach, Breach Progression Editor with the default, linear, option on the left and the User 
Specified Sine Wave specified on the right.

The breach progression is defined as a fraction of total breach progression as a function of the total 
Time (from zero to 1.0).  A Breach Fraction of 1.0 is the total Breach Width (the same rate is applied 
to vertical breach progression - see note below) and Time Fraction of 1.0 is the total Breach 
Duration Time (hrs). The user-entered curve is plotted in the graphic next to the table. HEC-RAS 
then uses breach progression curve during the breach formation time to adjust the growth rate of 
the breach.

While the linear breach progression curve is default, non-linear breach progressions are more 
realistic.

users are going to select these here, they should test their sensitivity.  Empirical equations are 
available in the Parameter Calculator tab, and more information on selecting these is available 
here.

Versions since 4.2 Use Equal Growth Rates for Breach Downcutting and Widening

Previous to version 4.2, the breach grew vertically and horizontally at rates that reached the 
maximum breach depth and width at the user entered "Breach Formation Time". For example, if 
a user entered breach dimensions of 400 ft wide and 100 ft deep, over a period of 2 hours, the 
horizontal growth rate was 200ft/hr and the vertical growth rate was 50 ft/hr. While this was 



https://www.hec.usace.army.mil/confluence/rasdocs/ras1dtechref/latest/performing-a-dam-break-study-with-hec-ras/estimating-dam-breach-parameters/estimating-breach-parameters
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Breach Repair Editor

The fourth Tab on the Breach editor is labeled Breach Repair (Optional). This option allows the user 
to fill the breach in during the unsteady flow simulation. This could represent emergency 
management actions, that attempt to fill a breach during an event, or it could represent a repair after 
the event in a long term simulation. Depending on the length of the simulation, this may be 
necessary to represent an extended time frame. If this option is selected the user must enter three 
pieces of information: the number of hours after the full breach to start the repair; total repair time; 
and the final filled in elevation of the repair work. In general, this option was added for levee 
breaching analysis, and is not normally used during a Dam Breaching analysis.

generally sufficient for Dam breaches, it was not acceptable for levees.  Levee breaches are much 
wider than they are tall. As of version 4.2, RAS computes the breach growth rate to reach the 
"Final Bottom Width" in the user entered "Breach Formation Time". Then this same breach 
growth rate is used for the vertical down cutting of the breach. So in the previous example of a 
400 ft breach bottom width and a 2 hour breach development time, the growth rate is 200 ft/hr, 
which is used for both the down cutting and widening rates. The breach will reach the maximum 
depth in this case, well before it reaches the maximum width, which is common in how levee 
breaches tend to develop. 
User's can change the vertical Breach Growth Rate by entering a value other than 1.0 under the 
option labeled "User Specified Vertical/Horizontal Growth Ratio" and the Breach Progression 
Tab. A value of 0.5, that means the vertical growth rate will be half the computed Horizontal 
growth rate.  

Warning: Breach growth rates after version 4.2 tend to generate larger peak flows.

The breach growth rate change described in the previous paragraph will generally results in RAS 
version 4.2 and newer yielding a higher peak flow through the breach, than versions 4.1 and 
older. If the user wants the same results as version 4.1 and older, you must compute a vertical/
horizontal growth rate that will results in the breach reaching its maximum width and depth at 
the end of the breach formation time. For example (assuming an overtopping breach), if you 
specified a 400 ft breach bottom width and a 2 hour breach formation time, this is a horizontal 
growth rate of 200 ft/ hour. However, if you Dam is only 100 ft high, then to reproduce the version 
4.1 or older results, the user would need to enter a "User Specified Vertical/Horizontal Growth 
Ratio" of 0.25. This would cause the program to grow the breach vertically down to the 100 ft 
depth in exactly 2 hours. Piping breaches are more complicated, in that they have an initial 
elevation for the hole, and the vertical growth is both up and down.
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Breach Parameter Calculator

The last Tab on the Breach Editor is Labeled Parameter Calculator. This option helps users compute 
sensitive and uncertain parameters (e.g. Final Width and Breach Duration) based on some physical 
data about a Dam.  This tool uses several regression equations, to compute aproximate Dam Breach 
bottom Widths, side slopes, and breach development times. Currently the calculator computes these 
dat with 5 different regression equations, they are: MacDonald et al (1984); Froehlich (1995); 
Froehlich (2008); Von Thun & Gillete (1990); and Xu and Zhang (2009).  More information on this tool 
is available here.

Simplified Physical Breaching
If the User selects to use the "Simplified Physical" Breach Method from the drop down at the top of 
the editor, the Breaching Editor will change to look the following way:

Figure 7 60. Simplified Physical Breaching Option for HEC-RAS 

Once the User selects "Simplified Physical" breaching option, there are several fields in which labels 
change, some additional information required, and some previous information that is not required. 
The main changes between this method and the "User Entered Data" breach method are the 
following:
Max Possible Bottom Width – This field is now used to enter a maximum possible breach bottom 
width. This does not mean this will be the final breach bottom width, it is really being used to limit 
the breach bottom width growth to this amount. The actual bottom width will be dependent on the 
velocity verses erosion rate data entered, and the hydraulics of flow through the breach. This field is 

https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/advanced-features-for-unsteady-flow-routing/dam-break-analysis/estimating-dam-break-parameters
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/advanced-features-for-unsteady-flow-routing/dam-break-analysis/estimating-dam-break-parameters
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used to prevent breaches from growing larger than this user set upper limit during the run.
Min Possible Bottom Elev – This field is used to put a limit on how far down the breach can erode 
during the breaching process. This is not necessarily the final breach bottom elevation, it is a user 
entered limiter (I.e. the breach cannot go below this elevation). The final breach elevation will be 
dependent on the velocity verses erosion rate data entered, and the hydraulics of flow through the 
breach.
Starting Notch Width or Initial Piping Diameter – If the Overtopping failure mode is selected, the user 
will be asked to enter a starting notch width. The purpose of this is that the software will us this 
width at the top of the dam to compute a velocity, from the velocity it will get a down cutting erosion 
rate (based on user entered data), which will be used to start the erosion process. If a Piping Failure 
model is selected, the user must enter an initial piping diameter. Once the breach is triggered to 
start, this initial hole will show up immediately. A velocity will be computed through it, then the 
down cutting and widening process will begin based in user entered erosion rate data.
Mass Wasting Feature – This option allows the user to put a hole in the Dam or the Levee at the 
beginning of the breach, in a very short amount of time. This option would probably most often be 
used in a levee evaluation, in which a section of the levee may give way (Mass Wasting), then that 
initial hole would continue to erode and widen based on the erosion process. The require data for 
this option is a width for the mass wasting hole; duration in hours that this mass wasting occurs over 
(this would normally be a short amount of time); and the final bottom elevation of the initial mass 
wasting hole (it is assumed that the hole is open all the way to the top of the levee or Dam if this 
option is used).
When using the "Simplified Physical" breaching option, the user is required to enter velocity versus 
Downcutting erosion rates, as well as velocity versus erosion widening rates. To enter this data the 
user selects the "Simplified Physical" breach Tab. When this Tab is selected the editor will look like 
the following:
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Figure 7 61. HEC-RAS Simplified Physical Breach Option. 

As shown in Figure 7-61 above, the user is required to enter Velocity versus Down-cutting erosion 
rates and velocity versus erosion widening rates. This data is often very difficult to come by. User's 
will need to consult with Geotechnical engineers to come up with reasonable estimates of this data 
for your specific Levee or Dam. Another way to estimate this information is to try to derive it by 
simulating a historic Levee or Dam breach, and adjusting the velocity versus erosion rate data until 
the model simulates the correct breach width and time. This is obviously an iterative process, and 
may require the user to perform this at multiple locations to see if there is a consistent set or erosion 
rates that will provide a reasonable model for simulating Levee breaches (or Dams) in your 
geographical area. 
We realize that this data is not readily available for any specific levee or dam. The hope is that over 
time we will be able to develop guidelines for these erosion rates based on analyzing historical levee 
and dam breaches. 

Levee (Lateral Structure) Breach. 
This option is very similar to the Dam Break option described previously. The only difference is that 
the breaching is performed on a levee. The options and data entered to describe the breach is the 
same as a Dam Break. 
In order to use this option, the user must first define the levee as a lateral structure within HEC-RAS. 
The lateral weir profile is used to describe the top of the levee along the stream both at and between 
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the cross sections. Second, a weir coefficient is entered for calculating the flow that may go over top 
of the levee if the water surface gets high enough. Entering breach data for the levee can be 
accomplished from the lateral weir editor or from the Levee (lateral structure) Breach option from 
the Unsteady Flow Simulation window. The levee breaching data is stored as part of the unsteady 
flow plan file, just as it is for a dam break. When the levee breach option is selected, a breach editor 
will appear as shown in Figure 7-62.

Figure 7 62. Levee Breaching Editor 
As shown in Figure 7-62, this editor contains the same information as the Dam Breach editor. For a 
description of the variables please review the section on Dam Breaching above. More detailed 
information about levee breaching can be found in Chapter 14 of this manual. 

DL Breach
DL Breach is a physical breaching algorithm developed by Dr. Weiming Wu (Wu, 2016, Wu, 2013 ). Dr. 
Wu collaborated with HEC to include this method in HEC-RAS to provide a breaching algorithm that 
estimates breach development based on physical processes and parameters. DLBreach computes 
breach development for overtopping and piping failures through cohesive, cohesionless, or 
composite structures. The HEC-RAS version of DLBreach, combines the breach development 
algorithms from Wu (2013) with HEC-RAS hydraulics.

DL Breach Acknowledgements and References
DLBreach Data and Parameterization in HEC-RAS

Standard Breach Data (Left Pane)
Embankment Parameters

https://webspace.clarkson.edu/~wwu/Reports/Technical%20Report%20of%20DLBreach%20Apr-2016.pdf
https://ascelibrary.org/doi/10.1061/%28ASCE%29HY.1943-7900.0000741
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Transport Parameters
Overtopping Erosion Model

DLBreach Data and Parameterization in HEC-RAS

To use DL Breach, select Physical Breaching (DLBreach)  from the 
Breach Method drop down in the top left corner of the breaching editor. Selecting DLBreach will 

make the Physical Breaching (DLBreach) data tab  (See Figure Below). 
 DLBreach requires most of the same data and parameters that the other breach methods require. 
Enter these data in the left panel of the breach editor. However, some of these values have different 
definitions or purposes in DLBreach. Define the following parameters and data in the breach editor 
for DLBreach:

Standard Breach Data (Left Pane)
Embankment Parameters
Transport Parameters

Overtopping Erosion Model

 Select Physical Breaching (DLBreach) from the Breach Method drop down to activate the DLBreach tab and 
parameters.
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Standard Breach Data (Left Pane)

Center Station
The lateral, cross section station of the breach centerline. The breach will start at this lateral station 
(e.g. 50 m or the midpoint of the dam in Figure 1).

Max Possible Bottom Width. 
The maximum bottom width of the final breach. 

Min Possible Bottom Elev. 
The model will erode through the dam until it reaches this elevation. This is the vertical limit of the 
breach. HEC-RAS will not erode to a negative elevation (e.g. for an arbitrary laboratory datum) with 
this method. Adjust the model datum so the Min Possible Bottom Elev: is positive if this value 
would otherwise be negative.

Left Side Slope
Define the left side slope of the final breach opening. Side slopes in the breaching editor are a 
horizontal to vertical (H:V) ratio or the base divided by the height. (Remember, displays in HEC-RAS 
are vertically distorted, so these slopes may appear steeper in HEC-RAS editors.) For example, a side 
slope of 2 represents 2 horizonal units for every vertical unit or a side slope that is twice as wide as it 
is high. Note: the H/V convention in HEC-RAS is opposite the convention in the stand alone version of 
DLBreach. 

Right Side Slope
Define the right side slope of the final breach opening (Horizontal : Vertical – see note in previous 
entry).

Note: Unlike the other breach algorithms in HEC-RAS DLBreach assumes the right and left side slopes 
are the same. Therefore, if a DLBreach model defines different breach side slopes, HEC-RAS will 
average the side slopes and use the average for both the right and left side slopes in DLBreach.

Note:

The top width will generally be larger, based on the breach side slopes.


Note:

The current version of HEC-RAS will not erode below elevation Zero. 
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Figure 2: Diagram of the breach geometry variables in the left pane. In this example, the breach 
reached the minimum possible elevation but the widening stopped before it reached the 
maximum width.

Breach Weir Coeff
Enter the weir coefficient that HEC-RAS will use to compute flow through the breach. HEC-RAS uses 
the broad crested weir equation to compute flow through the breach for overtopping breaches (or 
after the piping breach collapses). This is the broad crested weir coefficient for that breach.

Failure Mode
Select the failure mode in this drop-down menu. DLBreach includes the same two failure modes as 
the other breaching methods in HEC-RAS, Piping or Overtopping. The interface will update based on 
this choice, activating different data fields appropriate for each method.

Piping Parameters and Data:

A piping failure starts with an enclosed flow channel that forms through the embankment. HEC-RAS 
simulates this flow channel with uniform diameter pipe and uses the orifice equation to compute 
flow in the pipe. DLBreach uses cohesive or non-cohesive transport equations to compute pipe 
sidewall erosion and increases the diameter of the pipe as the flow erodes material. When the pipe 
grows large enough that it can no longer hold a competent "ceiling" in the breach material, it 
collapses, and transitions into an overtopping breach phase.
Erosion rate tends to be directly and non-linearly related to flow, making the pipe expand faster at 
higher pipe flow rates. Therefore, the total breach time can be very sensitive to the initial breach 
diameter and the pipe flow parameters.
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Figure 3: Piping geometry parameters and coefficient.

Piping Coefficient
HEC-RAS computes flow through the pipe – during the piping phase of a breach – with the orifice 
equation. The orifice equation has a coefficient that regulates the flow efficiency through the pipe. A 
Piping Coefficient of 1 would be completely efficient. The HEC-RAS default for a piping breach is 0.5. 
Good data on the conduit efficiency of piping failures are not available. But it is likely that these 
natural conduits are less efficient than the straight, smooth pipes used to simulate them. So 
reducing the flow efficiency with this coefficient is appropriate. This coefficient will regulate flow 
through the piping failure and will affect the breach time. It is also one of the most significant 
difference between DLBreach in HEC-RAS and the stand alone DLBreach equation.

Initial Piping Elev
Define the center elevation of the piping conduit. HEC-RAS and DLBreach assume that the piping 
conduit is horizontal (only has one elevation) and rectangular. As the conduit expands, it grows 
symmetrically from this initial elevation. The Initial Piping Elevation will be the center of the piping 
breach until the pipe ceiling collapses and it transitions to an overtopping breach.

Initial Piping Diameter
Define the initial "diameter" for the piping conduit. Piping conduits in HEC-RAS are square. 
Therefore, the "diameter" is actually the width and the height of the piping conduit. Piping failures 
progress slowly at small diameters (with smaller flows and lower erosion rates), making the breach 
time sensitive to this parameter.

Overtopping Parameters and Data:

Pilot Breach (aka Mass Wasting Feature) (Overtopping Failure Only). The other breaching functions 
in HEC-RAS have a "Mass Wasting" feature, which simulates a pressure build up behind the 
embankment that "blows out" a chunk of the embankment quickly. DLBreach does not use the mass 
wasting model. However, overtopping breaches in DLBreach require a "Pilot Breach," a starting 
notch that guides the overtopping erosion. HEC-RAS uses the Mass Wasting interface to define the 
pilot breach for DLBreach.  
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The Pilot Breach option requires a Width and Bottom Elevation.

Duration
The Duration is optional. If the Duration is zero or blank, the full Pilot Breach will form 
immediately.

Trigger Failure At
HEC-RAS has three overtopping breach-initiation options. Because DLBreach starts simulations once 
the breach begins, HEC-RAS users can select any of these three options to initiate a physical breach 
simulation just like they would for the other breach methods. The three methods allow users to 
initiate the breach:

at a specific time (Set Time),
when the water reaches a specific a water surface elevation (WS Elev), or
after the water surface has exceeded a specified water surface elevation for a specified period of time (WS 
Elev + Duration) – with the option to add a second elevation that triggers immediate failure (regardless of 
duration).

Starting WS
If the water surface trigger elevation (WS Elev) is selected, enter the trigger a water surface elevation 
into this field. HEC-RAS monitors the water surface elevation at the breach Center Station the user 
enters. Dam breaches have horizontal water surface elevations, so the water surface elevation is the 
same across the embankment. But levees have sloped water surfaces, making the water surface site-
specific.

WS Elev+Duration

Note:

The bottom elevation convention is different than the Pilot Channel Depth convention in 
DLBreach.
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The WS Elev+Duration trigger mechanism monitors the time that the water on the embankment 
exceeds a threshold and triggers the failure when the water exceeds that elevation for a specified 

time. This option has four additional fields or options:

Threshold WS
HEC-RAS will monitor the time that the water surface exceeds this water surface elevation at the 
breach Center Station. If that time exceeds the Duration Above Threshold (next field), HEC-RAS will 
trigger the breach and start the DLBreach simulation.  

Duration Above Threshold: 
This is a time in hours. If the water surface elevation at the breach Center Station exceeds the 
Threshold WS for the Duration Above Threshold, DLBreach will initiate the breach.

Immediate Initiation WS: 
The WS Elev+Duration option supports a failure mechanism where a moderate water surface 
saturates and loads an embankment long enough to cause a failure. However, the same 
embankment might fail immediately if the water surface gets high enough. The Immediate Initiation 
WS initiates a breach, without waiting for the Duration Above Threshold, if the water surface at the 
breach Center Station, reaches this (higher) water surface. 
three additional fields of data to enter. The first variables Threshold WS. This variable is the water.

Set Time
If the user selects the Set Time option, then a starting date and time to initiate the breach must be 



Performing a 1D Unsteady Flow Analysis

HEC-RAS User's Manual– 352

entered.

Embankment Parameters

Enter data and parameters specific to DLBreach the remaining embankment parameters in the 
Physical Breaching (DLBreach) tab.

Embankment Geometry

The first few entries in the Physical Breaching (DLBreach) tab continue to define the embankment 
geometry, with parameters the other methods do not need.

Embankment Width
The embankment width is the thickness of the (flat) top of the embankment between the sloping 
sections. In an Inline Structure (dam) this is the a longitudinal distance (along the stream) and in a 
Lateral Structure (e.g. levee) this distance is lateral to the main flow direction

US Slope
This field is used to enter the slope of the embankment on the upstream side. The slope is entered in 
values representing the horizontal to vertical ratio. For example, a value of 2 represents 2 units 
moved horizontally for every 1 unit moved vertically. Note the H/V convention in HEC-RAS is 
opposite of the slope convention in the stand alone DLBreach

DS Slope
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This field is used to enter the slope of the embankment on the downstream side. The slope is entered 
in values representing the horizontal to vertical ratio. For example, a value of 2 represents 2 units 
moved horizontally for every 1 unit moved vertically.

Breach Roughness
This field is used to define the Manning's Roughness Coefficient n for the breach. The breach is 
divided into three segments: upstream slope, flat top, and downstream slope. The user can have the 
same or different Manning's n values for the three segments.

Embankment Soil

 
Soil Type
Specify the soil type of the embankment (cohesive or cohesionless).

Cohesive Soils: 
Have enough (<0.063 mm) silt and clay (0.004 mm) content that the particles "stick" together. The 
surface area-to-mass ratio for these particles is so large that the electro-chemical forces between 
particles is larger than the frictional or gravitational forces.

If the embankment is cohesionless, DLBreach will use a non-equilibrium transport approach to 
erode . 
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Both cohesionless and cohesive soils, the following parameters must be entered: Sediment 
Diameter, Porosity, Specific Gravity, Clay Content, Cohesion, and Friction Angle. 

All Material Types

Sediment Diameter (mm)
Enter the median sediment diameter of the core (d50).

Porosity (decimal fraction): 
Define the porosity of the embankment material. The porosity is the fraction of voids and should be 
entered as a decimal (not percent). So if the soil porosity is 30%, enter 0.3.

Specific Gravity (unitless): 
Enter the specific gravity of the embankment material. The default is 2.65, which is appropriate for 
almost all embankment materials.

Clay Content (decimal fraction): 
Enter the clay content of the embankment if the Soil Type is Cohesive. Like porosity, enter the value 
as a decimal between 0.0 and 1.0 (where 0.0 is 0% and 1.0 is 100%). Do Not enter this parameter as a 
percent.

Cohesion (Stress Units – lbf/ft2 or Pa):
Enter the cohesion of the embankment material if the Soil Type is Cohesive. 

Friction Angle (degree) 
This field is used to enter the internal friction angle of the core material. The soil friction angle can be 
estimated according to soil types. The average frication angles are usually between:

Soil Type Range

Gravel 34o-40o

Sand 32o-38o

Silt 24o-33o

Clay ~22o

Wu (2016) provides the following guidance on these parameters:
"The actual friction angle may vary by ±3o–6o from the average value, because it is also affected by 
other properties of the soil, such as moisture, clay fraction, chemical composition, and compaction. 
Once the friction angle is estimated, the soil cohesion can thus be determined by using the known final 
breach slope."  

"Furthermore, the soil cohesion and friction angle are important factors for the stability of headcut, 
pipe top block, and clay core, and in turn influence the breach peak discharge, breach width and failure 
time. Therefore, the estimated soil cohesion and friction angle can be validated indirectly by comparing 
these calculated breach properties against measured data."

http://www.geotechdata.info/parameter/angle-of-friction
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Transport Parameters

The last three variables, the adaptation , critical shear stress, and erodibility are transport 
parameters. Both the overtopping and piping use these transport parameters. Piping uses 

cohesionless transport (and ) or excess shear for cohesives (which uses critical shear stress and 
erodibility). Overtopping (including the post-collapse phase of piping) also uses these parameters. 

Surface erosion uses  for cohesionless and critical shear/erodibility for cohesive, and the 
headcut algorithms use critical shear and erodibility to determine the vertical erosion rates.

 is part of the non-equilibrium transport used for the cohesionless erosion model. Therefore DL 

Breach only requires  if it applies the transport model to a cohesionless embankment.
Critical shear stress and erodibility – on the other hand – are cohesive parameters of the excess shear 
equation. They are only required for cohesive embankments (or cohesive core materials, which are 
defined separately, under the Core column.

Cohesionless Transport Parameters Cohesive Transport Parameters

Adaptation Critical Shear Stress ( )

Erodibility (kd)

Adaptation : (unitless)
Non-equilibrium sediment transport models use an adaptation length to compute the rate of 
erosion. A non-equilibrium model does not just erode the computed capacity but takes time to 
entrain the full capacity. It uses an adaptation length (Ls) to control this temporal lag, such that:

Where A is the cross section flow area in the breach channel, Ct is the transported sediment 
concentration, Ct* is the transport capacity (or, strictly, the equilibrium concentration under the flow 
conditions for the sediment parameters) and Q is the flow through the breach.  

Instead of requiring users to define an adaptation length (which can be an abstract parameter that 
can be difficult to estimate) DLBreach makes Ls a function of the breach channel width. So users 

define a linear multiplier ( ) such that:

 

Wu (2016) recommends:

HEC-RAS defaults to 6.0 based on this recommendation.
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Critical Shear Stress (Stress Units – lbf/ft2 or Pa):
If the Soil Type is Cohesive, DLBreach uses the excess shear stress to erode the pipe or embankment. 
The excess shear stress requires two user parameters, Critical Shear Stress and erodibility, to 
compute erosion from the pipe or embankment:

These parameters are difficult to measure and highly variable. However, Wu et al. (2013) constrained 
the critical shear stress for breach calculations. He calibrated 30 different breaches by setting critical 
shear stress to 0.15 Pa (US Customary) and adjusting Erodibility (see next), and recommends that 
approach to these parameters.

Erodibility (kd) 
If the Soil Type is Cohesive, then the user must use this field to enter an erodibility coefficient for 
core material. Wu et al (2013) calibrated 30 breaches by setting critical shear stress and adjusting the 
erodibility. The calibrations (some of which were also sensitive to initial pipe diameter and other, 
interrelated model variables) required erodibilities that varied between 2.5 and 30 cm3/N-s (US 
Customary).

Overtopping Erosion Model

DLBreach can compute dam and levee breaches with a wide range of process and failure modes. 
Figure 4 organizes the different failure processes that DLBreach simulates into a flow chart, where 
the nodes represent user decisions. Figure 5 replicates this process flow chart with the actual 

Note:

Erodibility Unit Diversity in HEC-RAS Erodibility has a variety of units, and it has different units in 
different places in HEC-RAS. The cohesive editor of the sediment transport module has units of 
mass/area/time (e.g. kg/m3/hr or lb/ft3/hr). BSTEM has units of Volume/Force-time (m3/N-s or ft3

/lbf-s).
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interface options that direct these decisions in the model.  

The user decisions that direct how DLBreach computes the embankment failure include the Failure 
Mode (Piping or Overtopping), the Soil Type (Cohesive or Coheisonless) and, finally, the Erosion 
Model.

The DLBreach Erosion Model determines which process and 
equations (surface, composite or headcut) DLBreach will use to erode the embankment. These 
are overtopping algorithms, and are not used in the While DLBreach is in a piping mode. However, 
DLBreach will switch to these routines after the piping conduit collapses in a piping breach, so they 
are required for either failure mode. must be selected and the data corresponding to the selected 
erosion model must be entered for the breaching analysis. For all overtopping Erosion Models, users 
are required to enter Embankment Sediment Parameters and users have the option to Model a cover 
layer.

DLBreach includes three overtopping Erosion Models:

Surface Erosion
Headcut Erosion
Composite (Zoned) Structure

 Flow chart of the different failure models included in DLBreach. The interface options used to select these 
are included in a similar flow chart in the next Figure).
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Figure: Flow chart of the different failure models included in DLBreach. The interface options used 
to select these are included in a similar flow chart in the next Figure).

Figure: Flow Chart of HEC-RAS options to activate the different failure modes, processes, and 
algorithms from the previous flow chart.

Surface Erosion Model
Surface Erosion is appropriate for non-cohesive embankments or loose cohesive embankments 
without compaction. Therefore, HEC-RAS allows Surface Erosion with cohesive or cohesionless 
methods, but compacted, cohesive embankments should use the Headcut Erosion method (see 
next section). This method erodes sediment from the downstream slope (in a one-way breach), 
rotating the downstream slope around the downstream toe to account for the sediment eroded with 
the transport (cohesionless) or excess shear (cohesive) equation. At the same time, DLBreach lowers 
the flat-top weir representing the breach.
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Figure: Conceptual 
diagram of three sequential stages of a one-way Surface Erosion breach in DL Breach. 

If the Surface Erosion model is selected, the model will not require additional data.

Headcut Erosion Model
Most breach experiments and field observations of actual breaches included a headcut phase. As 
water flows over the breach, it erodes the top of the embankment. But the flow over the breach also 
forms a plunge pool on the downstream end of the embankment (the Figure below), which attacks 
the downstream toe of the embankment, pushing the headcut upstream. DLBreach computes the 
headcut by idealizing the downstream face of the breach with a vertical face, and computing the rate 
that this vertical, downstream, embankment face translates upstream. By eroding the berm in two 
directions (vertically and upstream) DLBreach estimates the impact of these two interacting 
processes (observed in actual breaches), which adds a non-linear effect accelerating the breach. 
When the headcut advances to the upstream slope, the embankment crest vanishes, and the breach 
flow increases significantly until the upstream water surface falls.

Figure: Idealized 
headcut geometry in DLBreach. The headcut equations compute the rate of upstream erosion, 
which pushes the vertical downstream face of the embankment upstream by a computed 
X.
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If modelers selects Headcut Erosion, the Headcut Method options will appear in the interface below 
the transport parameters. 

DLBreach includes three methods to compute the headcut migration. Select the method from the 
dropdown box next to the Headcut Method. HEC-RAS will populate one or two data fields for the 
parameters that these methods require. The three headcut methods available in DLBreach are:

SITES (USDA-NECS, 1997)
Temple (1992)
Temple/Hansen Energy (Temple et al. 2005)

These three equations have similar forms. They all compute the rate of the headcut migration (X/t) 
as a function of the product of the square or cube root of the unit flow (q) through the breach and the 
head drop (H) over the breach, so that:

 
Where m and n are 2 or 3 and C is a linear, user-defined coefficient.

Temple (1992)
The 1992 Temple equation computes head cut migration the square root of the breach height and 
the cube root of the unit flow. Define CT to use Temple (1992) to compute headcut migration.

Temple et al. (2005)
The subsequent 2005 version of this equation is similar, except it raises both unit flow and breach 
height to the cube root. Therefore, the empirical coefficient has different units and behavior. Define 
C2 to compute headcut migration with this method.

   

SITES (USDA-NECS, 1997)
The SITES method has the same cube-root form as Temple et al (2005), but adds a threshold, 
computing headcut migration as the difference between the cube root of the qH product and a user 
defined threshold. This method requires this threshold Ao and, a linear coefficient (C1) similar to the 
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other equations (with the same units as C2, but different behavior because of the threshold).

 

Composite (Zoned) Structure Model
Some embankments include resistant, internal cores that affect breaching processes. These cores 
can include internal clay, steel or concrete cores or a concrete floodwall on the crest. DLBreach 
includes algorithms to account for these composite structures. Breaching composite structures is a 
third overtopping mechanism, mutually exclusive with Surface Erosion and Headcut methods.

To simulate this process, select Composite (Zoned) Structure from the Erosion Model drop down. 

This option activates the Core Data on in the right column of 
the editor.

Figure: Core geometry and soil parameters associated with the Composite Structure 
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Algorithms.

In a one-way breach, the model will use the surface erosion algorithms (described above) to erode 
the top and downstream face of the embankment, until it encounters the core (see Figure below). 
DLBreach then computes erosion along the top of the core and the (steeper) downstream slope of 
the core using the core soil parameters highlighted in Figure 8. The example in Figure 8 uses the 
cohesionless surface transport equations to erode the top of the embankment and the downstream 
face until the clay core is exposed. When the clay core is exposed, the example in Figure 8 uses the 
excess shear equation to erode the cohesive material in the core. Core materials are usually less 
erodible than the embankment materials, but the downstream slope of the core is also, often, 
steeper, exposing them to higher shear stresses. 

Schematic of the DLBreach approach to one-way breaching for embankments with a clay core.

At some point, however, the core can erode enough, that it becomes unstable, and fails. DLBreach 
evaluates the core stability each time step by balancing the forces acting on a failure plane. The 
failure plane is the horizontal line from the place the downstream embankment slope intersects with 
the core material (see figure above).  

If the driving forces on the core exceed the resisting forces, DLBreach immediately removes all of the 
core material above the failure plane and the upstream embankment soil above the failure plane to 
simulate the core failure. After a core failure, DLBreach continues to apply the surface erosion 
equations (cohesionless transport and/or excess shear) to erode the breach.

Core Geometry
DLBreach requires data that define the core geometry. These are in the top section of the core data 
column and are illustrated in the Figure below. The core geometry fields are described below:
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Figure: The core geometry (and some related embankment geometry) data in HEC-RAS.

Core Height: The vertical distance between the Min Possible Bottom Elev in the main breach 
embankment editor (left panel) and the top of the core.
Core Width: The width of the flat top of the core, in the direction of flow.
Core Center Location: This is the centerline station of the core relative to the Center Station of the 
embankment. The stationing is based on the inline structure stationing.
Core US Slope: The upstream slope of the core (horizontal displacement divided by vertical 
displacement).
Core DS Slope: The downstream slope of the core (horizontal/vertical).
Core Manning n: The manning n value used to compute hydraulic parameters for surface erosion 
equations on the exposed core.

Core Soil Parameters
The core soil parameters are the same as the embankment soil parameters. See that section above 
for these parameter descriptions.

Cover
Some dams and levee include cover material that is more-or-less resistant to flow than the 
embankment material. DLBreach allows a cover layer with any of the erosion models. To turn on the 
cover layer, check the Model a cover layer  option to activate the cover fields. 
The Cover Soil Parameters are the same as the core and embankment soil parameters. See these 
parameter descriptions above.



Performing a 1D Unsteady Flow Analysis

HEC-RAS User's Manual– 364

Figure: Cover material parameters and local thickness.

The three data fields unique to the cover layer are all related to the cover thickens. DLBreach allows 
users to define separate cover thicknesses for the top of the embankment, the upstream slope and 
the downstream slope. These fields control those initial cover thickness as illustrated in the Figure 
below.
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Figure: Cover thicknesses in DL Breach and the HEC-RAS interface.
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Conversions: 

 

 

Using HEC-RAS to Compute Ungaged Lateral Inflows
This section of the manual illustrates how to use the ungaged lateral inflow option in HEC-RAS. The 
ungaged inflow can be used either to recreate historical, lateral inflows, or it can be used in forecast 
mode to determine the inflows for future downstream routing. This section discusses the required 
input data and viewing the output. A more technical discussion of the numerical modeling can be 
found in the hydraulic reference manual.

Observed Stage and Flow Data
After an unsteady RAS project has been calibrated, the first step in developing an ungaged inflow 
model is to enter the internal observed stage and flow data at the known gage locations. From the 
Unsteady Flow editor, select the river station that the gage is at, press the "Add a Boundary 
Condition Location" button and then click on "IB Stage/Flow" (Figure 7-63).



Performing a 1D Unsteady Flow Analysis

HEC-RAS User's Manual– 367

Figure 7 63. Unsteady Flow Boundary Conditions Editor. 

This will bring up the Observed Stage and Flow Hydrograph editor:
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Figure 7 64. Internal Stage and Flow Boundary Condition Editor. 

The gage data may either be linked to a DSS file or it can be entered in the table. For use in forecast 
mode, (optimization based on stage), stage is the only data that is required. For use in historical flow 
mode, (optimization based on flow), both stage and flow data is required (see hydraulic reference for 
more info).

Lateral Inflow Computations
Next, the required data for the ungaged lateral inflow should be entered. From the Unsteady Flow 
Analysis editor, choose Options and click on ungaged lateral inflow. (After ungaged inflow data has 
been entered, there will be a text message at the bottom of the unsteady run editor indicating that 
this plan has ungaged inflow. The ungaged lateral inflow editor can be accessed directly by clicking 
on this message.)
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Figure 7 65. Selecting the Ungaged Lateral Inflow Option. 

Now the data for the ungaged lateral inflow can be entered (Figure 7-66).
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Figure 7 66. Ungaged Lateral Inflow Editor. 

By default, the Optimization Mode and Optimization Target are set to Sequential and Stage, 
respectively (see hydraulic reference manual). The "Number of Iterations" is the maximum number 
of times that HEC-RAS will iterate (estimate ungaged inflow, lag and route the lateral inflow, run the 
unsteady model, and check for convergence) when computing the ungaged inflow. The "Flow Conv 
Criteria" is the flow tolerance (in cfs or m^3/s). RAS will iterate until the flow tolerance is met (based 
on average, least-squared difference—see hydraulic reference) or the maximum number of iterations 
has been met. If the user enters a value for the "Smoothing Window," then RAS will apply a running-
average when computing the ungaged inflow (hydraulic reference…). The previous data (the 
information at the top of the editor) is only entered once and it applies to all of the known gage/
routing reaches.
To enter information for a particular gage, the first step is to click on <New> and enter the name of 
the gage (or other descriptive name for the inflow into this routing reach). Next, clicking on <Set RS> 
allows the user to enter the location of this gage. (Important: this river station should match a river 
station that was entered on the unsteady flow editor for Internal Observed Stage and Flow!)
The unknown lateral inflows are added by clicking on <Add Lateral Inflow> (for a stream or point 
source) or by clicking on <Add Uniform Lateral Inflow> (for a disperse inflow). The "Contrib. Area" 
column is used to enter the contributing area for each of the unknown lateral inflows for the current 
reach. These areas are summed and then a percentage is assigned to each lateral inflow. This is only 
applicable if a particular known gage/routing reach has more than one unknown inflow. After RAS 
has determined the total unknown inflow for a given routing reach, the program will proportion the 
flow between the various lateral inflows based on the ratio of Contributing Areas. In the above 
example, the contributing area has been entered as a percentage. The uniform inflow stating at river 
station 70 will get 20% of the flow and the lateral inflow at RS 50 will get the remaining 80%. The 
contributing areas could also have been entered as a decimal fraction (0.2 and 0.8). Alternately, the 
user could enter the actual size of the contributing watersheds (e.g., 100 and 400 sq. mi. ). Since the 
division is proportionately based, the units of contributing area do not need to be specified. 
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Regardless of how the area is entered, RAS will compute and display the percent flow for each area.
The "Lag Time" is used by the program when routing the unknown inflow. The amount of unknown 
inflow is computed at the gage location. However, this unknown inflow enters the river system 
upstream (that is, at an earlier point in time). The lag time is the amount that the program will shift 
the lateral hydrograph back in time when it routes the inflow and reruns the program. It should be 
the approximate travel time from the lateral inflow location to the gage station.
For each unknown inflow, the user can specify an optional maximum and minimum flow. The 
program will limit the lateral inflow to these values. This may be needed to prevent the program 
from computing hydraulically unreasonable flows.
Finally, an Optional DSS B part can be specified. After the inflows have been computed, RAS will 
write the lateral hydrograph out to DSS. The B part of the pathname will either be that specified by 
the user, or the default name. The default name is, "UNGAGED INFLOW #," where # is the river station 
for a particular lateral inflow (either 70 or 50 in the above example).
After all the lateral inflow information has been entered, additional routing reaches can be added 
(only applicable if the given RAS project has more than one known gage) by clicking the <New> 
button and repeating the process. Different routing reaches can be selected from the drop down 
menu next to the Ungaged Area Name. Clicking <Delete> will remove the actively displayed routing 
reach. 

Computations and Output
After all the information has been entered, the ungaged inflows can be computed by running RAS 
normally (clicking the <Compute> button on the main run editor). The results can be viewed by using 
the DSS viewer inside of RAS. 

Figure 7 67. HEC-DSS Viewer inside of HEC-RAS 

Once a record is selected to view, press the Plot/Tabulate Selected Pathname(s) button and the 
plot will appear as shown in Figure 7-68.
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Figure 7 68. Plot of Computed Ungaged Inflows. 
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9 VIEWING RESULTS
After the model has finished the steady or unsteady flow computations the user can begin to view 
the output. Output is available in a graphical and tabular format. The current version of the program 
allows the user to view cross sections, water surface profiles, general profiles, rating curves, X-Y-Z 
perspective plots, hydrographs, detailed tabular output at a single location, and summary tabular 
output at many cross sections. Users also have the ability to develop their own output tables. 
Additionally, if your model is georeferenced, you can also create inundation maps, and perform 
animations of inundated areas within HEC-RAS Mapper.  This section will discuss the following:

Cross Sections, Profiles, and Rating Curves
3D Perspective Plots
Stage and Flow Hydrographs
Breach Hydrograph Plot
Tabular Output
Viewing Results From The River System Schematic
Viewing Computational Level Output for Unsteady Flow
Viewing Ice Information
Viewing Data Contained in an HEC-DSS File
Exporting Results to HEC-DSS
Inundation Mapping with HEC-RAS Mapper

Cross Sections, Profiles, and Rating Curves
Graphical displays are often the most effective method of presenting input data and computed 
results. Graphics allow the user to easily spot errors in the input data, as well as providing an 
overview of the results in a way that tables of numbers cannot.

Viewing Graphics on the Screen
To view a graphic on the screen, select Cross Sections, Water Surface Profiles, or Rating Curves
from the View menu on the HEC-RAS main window. Once you have selected one of these options, a 
window will appear with the graphic plotted in the viewing area. An example cross-section plot is 
shown in Figure 8-1. The user can plot any cross section by simply selecting the appropriate reach 
and river station from the list boxes at the top of the plot. The user can also step through the cross 
section plots by using the up and down arrows. 
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Figure 8 1 Example Cross Section Plot

An example profile plot is shown in Figure 8-2. The profile plot displays the water surface profile for 
the first reach in the river system. If there is more than one reach, additional reaches can be selected 
from the Options menu on or the reach button at the top of the window.

An example rating curve plot is shown in Figure 8-3. The rating curve is a plot of the water surface 
elevation versus flow rate for the profiles that were computed. A rating curve can be plotted at any 
location by selecting the appropriate reach and river station from the list boxes at the top of the plot.
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Figure 8 2 Example Profile Plot

Figure 8 3 Example Rating Curve Plot
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Graphical Plot Options
Several plotting features are available from the Options menu on all of the graphical plots. These 
options include: zoom in; zoom out; selecting which plans, profiles, reaches and variables to plot; 
and control over labels, lines, symbols, scaling, grid options, zoom window location, font sizes, and 
land marks. In addition to using the options menu at the top of each graphic window, if a user 
presses the right mouse button while the cursor is over a graphic, the options menu will appear right 
at the cursor location. In general, the options are about the same on all of the graphics.

Zoom In. This option allows the user to zoom in on a portion of the graphic. This is accomplished by 
selecting Zoom In from the Options menu, then specifying the area to zoom in on with the mouse. 
Defining the zoom area is accomplished by placing the mouse pointer at a corner of the desired 
zoom area. Then press down on the left mouse button and drag the mouse to define a box 
containing the desired zoom area. Finally, release the left mouse button and the viewing area will 
display the zoomed-in graphic. A small window showing the entire graphic will be placed in one of 
the corners of the graphic. This window is called the Zoom Window. The Zoom Window shows the 
entire graphic with a box around the zoomed in area. The user can move the zoom box or resize it in 
order to change the viewing area.

Zoom Previous. This option will re-display the graphic back to the size that it was one operation 
previous (i.e. if I zoomed in three times, then select Zoom Previous, the window would go back to the 
size it was after the second zoom in). HEC-RAS will remember the last 10 window sizes of the graphic 
and allow the user to use the Zoom Previous to go back through them.

Zoom Out. This option doubles the size of the currently zoomed in graphic.

Zoom In/Out Shortcut. User can now use the mouse wheel to zoom in and out. Place the mouse 
pointer over the location where you want to zoom in and push the mouse wheel foreword. To zoom 
out, pull the mouse wheel back.

Full Plot. This option re-displays the graphic back into its original size before you zoomed in. Using 
the Full Plot option is accomplished by selecting Full Plot from the Options menu.

Pan. This option allows the user to move the graphic around while in a zoomed in mode. After 
zooming in, to move the graphic around, select Pan from the Options menu. Press and hold the left 
mouse button down over the graphic, then move the graphic in the desired direction. A shortcut to 
selecting the Pan option is to hold down the Shift Key to put the pointer into the Pan mode. Simply 
release the Shift Key to turn off the Pan mode.

Measuring Tool. On any of the HEC-RAS graphics, even the river system schematic, the user can turn 
on a measuring tool and draw a multi point line (Called a polyline), and HEC-RAS will report back the 
length of the line, the area of the polygon formed by connecting the first and last point drawn, the dx 
length, the dy length, and the slope (dx/dy). To use this option simply hold down the Control Key
while over the graphic, then draw the multi point line by pressing the left mouse button at each 
location you want to have a point. To end the line, simple release the Control key after the last point 
is drawn.

Animate. This option was developed for unsteady flow output analysis, but can also be used for 
steady flow output. This option works with the cross section, profile, and X, Y, Z perspective plots. 
When this option is selected, a window will appear that allows the user to control the animation of 
any currently opened graphics. The user has the option to too "play" a graphic, which means to step 
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through the time sequence of computed profiles. In a steady flow analysis, it can be used to switch 
between the profiles conveniently.

Plans. This option allows the user to select from the available Plans for plotting. The default plan is 
the currently opened plan. The user can select additional plans to view for comparison of results 
graphically.

Profiles. This option allows the user to select which profiles they would like to have displayed on the 
graphic. This option does not apply to the rating curve, it automatically plots all of the profiles.

Reaches. This option allows the user to select which river reaches they would like to have displayed. 
This option only applies to the profile plot.

Variables. This option allows the user to select whatever variables are available for plotting. The 
number and type of variables depends on what type of graphic is being displayed. The following is a 
list of variables that can be found on the profile plot: water surface, energy, critical water surface, 
observed water surfaces, Left main channel bank elevation, right main channel bank elevation, reach 
labels, ice cover, left and right levees, pilot channels, sediment elevations, and left and right lateral 
structures. The cross section plot is has the following eight variables: water surface, filled in water 
surface, energy, critical depth, observed water surface, ice cover, Manning's n values, and pilot 
channels.

Labels. This option allows the user to change the labels for the plot caption, as well as the labels 
used for the axis. The user can select any or all of the following items to be added to the caption: 
project title, plan title, run date, run time, geometry title, flow title, river and reach names, cross 
section descriptions, cross section river stationing, cross section node names, and any user defined 
additional text.

Lines and Symbols. This option allows the user to change the line types, line colors, line widths, 
symbol types, symbol sizes, and symbol colors, fill patterns, and the line labels. When the user 
selects this option, a window will appear as shown in Figure 8-4.

Figure 8 4 Line and Symbol Options Window



Viewing Results

HEC-RAS User's Manual– 378

When the Line and Symbol Options window comes up, it will list only the information from the 
current plot. When this window is in the "Current Plot Line Styles" mode, the user can only change 
the information for the current plot. If the user wants to change the default line and symbol options 
for all of the plots, they must select Default Line Styles at the top of the window. When this option is 
selected, the user will be able to change the label, line, and symbol options for every variable that is 
plotted in the program. To use this option, the user finds the variable that they want to change from 
the list on the left side of the window. Select that variable by clicking the left mouse button while 
over top of the variable. Once a variable is selected, the options that are set for that variable will be 
highlighted with a red box around each option. The user can change whatever option they want, as 
well as changing the label for that variable. If a variable does not have a default label, you cannot 
enter one for that variable. Once the user has made all of the changes that they want to all of the 
desired variables, they should press the OK button. The changes will be saved permanently, and any 
plot that is displayed within HEC-RAS will reflect the user-entered changes.

Scaling. This option allows the user to define the scaling used for the plot. Users are allowed to set 
the minimum, maximum, and labeling increment for the X and Y axis. Scaling can be set temporarily, 
or scaling can be set to be persistent (scaling stays constant for all cross sections). Persistent scaling 
is only available for the cross section and rating curve plots.

Grid. This option allows the user to overlay a grid on top of the graphic. Users have the option to 
have both major and minor tics displayed, as well as a border around the plot.

Zoom Window Location. This option allows the user to control which corner of the plot that the 
zoom window will be placed, and the size of the window.

Font Sizes. This option allows the user to control the size of all of the text displayed on the graphic.

Land Marks. This option is specific to profile plots. With this option the user can turn on additional 
labels that will be displayed as land marks below the invert of the channel. Three types of land marks 
can be displayed: cross section river stations; node names; or cross section descriptions. In addition 
to these three variables, once one of the three are displayed, the user can select to edit the land 
mark labels. This will allow the user to put a label at a specific location on a plot.

Plotting Velocity Distribution Output
The user has the option of plotting velocity distribution output from the cross section viewer. 
Velocity distributions can only be plotted at locations in which the user has specified that flow 
distribution output be calculated during the computations. To view the velocity distribution plot, 
first bring up a cross section plot (select "Cross Sections" from the view menu of the main HEC-RAS 
window). Next, select the cross section in which you would like to see the velocity distribution 
output. Select Velocity Distribution from the Options menu of the cross section window. This will 
bring up a pop up window (Figure 8-5) that will allow you to set the minimum velocity, maximum 
velocity, and velocity increment for plotting. In general, it is better to let the program use the 
maximum velocity range for plotting. Next, the user selects Plot Velocity Distribution, then press 
the "OK" button and the velocity distribution plot will appear as shown in Figure 8-6.

For details on how to select the locations for computing the velocity distribution, see Chapter 7 and 8 
of the User's Manual. For information on how the velocity distribution is actually calculated, see 
Chapter 4 of the Hydraulic Reference Manual.
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Figure 8 5 Velocity Distribution Options

Figure 8 6 Velocity Distribution Plot

Plotting Other Variables in Profile
To plot variables other than the water surface in profile, select General Profile Plot from the View 
menu of the main HEC-RAS window. Any variable that is computed at a cross section can be 
displayed in profile. An example would be to plot velocity versus distance. Other variables can be 
selected from the Plot Variables option under the Options menu of the plot. The user can plot 
several different variable types at one time ( e.g., velocity and area versus distance), but the scaling 
may not be appropriate when this is done. Once a user has selected variables for plotting in profile, 
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the plot can be saved as a User Defined Plot. This is accomplished by selecting Save Plot from the 
Options menu at the top of the window. Once a user saves a plot, the plot can be recalled for any 
data set from the User Plots menu at the top of the window. An example of plotting variables in 
profile is shown in Figure 8-7. Additionally, the general profile plot has some predefined plots that 
the user can pick from. The predefined plots can be found under the Standard Plots menu at the top 
of the graphic window.

Figure 8 7 General Profile Plot of Variables Versus Distance

Plotting One Variable versus Another
The rating curve plotting window has the ability to plot other variables besides discharge versus 
water surface elevation. Any variable that is computed at a cross section can be displayed against 
another computed variable (or variables). An example of this capability is shown in Figure 8-8. In this 
example, Discharge (x-axis) is being plotted against total flow area and main channel flow area (y-
axis).

To plot other variables, the user selects the X Axis Variable and Y Axis Variables from the Options
menu of the rating curve plotting window. When selected variables to plot, keep in mind that all 
variables selected for a particular axis should have a similar range in magnitude. 
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1.

2.

3.

Figure 8 8 Example of Plotting One Variable Against Other Variables

Sending Graphics to the Printer or Plotter
All of the graphical plots in HEC-RAS can be sent directly to a printer or plotter. The printer or plotter 
used depends on what you currently have set as the default printer or plotter in the Windows Print 
Manager. To send a graphic to the printer or plotter, do the following:

Display the graphic of interest (cross section, profile, rating curve, X-Y-Z, or river system schematic) onto the 
screen.
Using the available graphics options (scaling, labels, grid, etc.), modify the plot to be exactly what you would 
like printed.
Select Print from the File menu of the displayed graphic. When this option is selected, a pop up window will 
appear allowing you to modify the default print options. Change any desired options and press the Print 
button. The graphic will be sent to the Windows Print Manager. The print manager will then send the plot to 
the default printer or plotter.

Note: The user can print multiple cross-sections at one time by using the Print Multiple option from 
the File Menu of the cross section and rating curve plots. This option also allows the user to establish 
how many cross sections or rating curves they would like to have printed on each page.

Sending Graphics to the Windows Clipboard
All of the HEC-RAS graphics can be sent to the Windows Clipboard. Passing a graphic to the clipboard 
allows that graphic to then be pasted into another piece of software (i.e., a word processor or 
another graphics program). To pass a graphic to the windows clipboard, and then to another 
program, do the following:
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1.
2.
3.

4.

Display the graphic of interest on the screen.
Using the options menu, modify the plot to be exactly what you want.
Select Copy Plot to Clipboard from the File menu of the displayed graphic. The plot will automatically be 
sent to the Windows Clipboard.
Bring up the program that you want to paste the graphic into. Select Paste from the Edit menu of the 
receiving program. Once the graphic is pasted in, it can be re-sized to the desired dimensions.

HEC-RAS sends and displays all graphics in a Window's Meta file format. Since Meta files are vector 
based graphics, the graphic can be resized without causing the image to distort.

3D Perspective Plots
Another type of graphic available to the user is the 3D Perspective Plot. The 3D plot is a 3-
dimensional plot of the terrain on the computed results (Depth, water surface, velocity, etc.). 
The HEC-RAS 3D Viewer was developed to help engineers convey hydraulic modeling results to 
decision-makers. The HEC-RAS 3D Viewer is accessed from either the HEC-RAS program or inside RAS 
Mapper.  The 3D Viewer provides a three-dimensional visualization of HEC-RAS simulation results 
and terrain data. 

To access the 3D Viewer through the HEC-RAS program interface, go to View | 3D View ... menu item 
or press the  3D Viewer button, shown below.

Figure 8 9. HEC-RAS Main Window with 3D Viewer Button.

To access the 3D Viewer through RAS Mapper, press the  3D Viewer button, shown below.

Figure 8 10. 3D Viewer Access Button in HEC-RAS Mapper.
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Then select the result to show in the 3D Viewer

Another way to access the 3D Viewer is by right clicking on a particular result and selecting the View 
Result in 3D menu item

Figure 8 11. Selecting the 3D Viewer from HEC-RAS Mapper Menu.

The last way to access the 3D Viewer is by right clicking a particular result map and selecting the 
View Map in 3D Viewer menu item
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Figure 8 12. Accessing 3D Viewer from a Result Map Layer.

Pre-processing Results for 3D Viewing
Performing any of the various ways to access the 3D Viewer will bring up a pre-proccessing window if 
this is the first time you have run the 3D Viewer or if you have cancelled pre-processing the last time 
you opened this result in the 3D Viewer.

The 3D Viewer has to do much more processing compared to RAS Mapper to show a time step in the 
simulation.  Pre-processing offloads the processing to a file in the same directory as the result file 
that was selected.  It will be named the same except the extension will be sqlite. 

Pre-processing will make subsequent loading for this result to be a smoother experience.  It will also 
make playing the results animation smoother.  Pre-processing is optional, press the Cancel button if 
you do not wish to pre-process at this time.

3D Viewer
Performing any of the various ways to access the 3D Viewer will bring up a pre-proccessing window if 
this is the first time you have run the 3D Viewer or if you have cancelled pre-processing the last time 
you opened this result in the 3D Viewer.
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The 3D Viewer has to do much more processing compared to RAS Mapper to show a time step in the 
simulation.  Pre-processing offloads the processing to a file in the same directory as the result file 
that was selected.  It will be named the same except the file extension will be 
"3DViewerCache.sqlite". 

Pre-processing will make subsequent loading for this result to be a smoother experience.  It will also 
make playing the results animation smoother.  Pre-processing is optional, pressing the Cancel 
button will stop the pre-processing step.

Pre-processing file size is dependent on area extent and density of hydraulic results.  For example, 
more 2D cells means bigger file size.

The 3D Viewer interface, shown below, is comprised of a menu, a toolbar, a mini-map and the view 
itself.

Figure 8 13. 3D Viewer Interface.

Menu and Options

To access the menu to see options, help, and to quit the application, either click on the menu button 
on the top left corner or press the escape key.

Figure 8 14. 3D Viewer Menu and Options Buttons.
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When the Options button is selected a window will appear with four Tabs (General; Graphics; 
Controls; and Particle Tracing). The following tables describe each of the options on the four Tabs.

General Options

Table 8 1. General Options

Option Description

Water During Animation When this option is turned on, the water resolution will be the same resolution as 
the terrain, based on Level of Detail settings.   Animation may play slower than 
usual with this option turned on

Z Scale How much the terrain elevation is scaled by.  Higher value exaggerates the 
elevations of the terrain, making it easier to see subtle changes in terrain.

Graphics

Table 8 2. Graphics Options

Option Description

Aspect Ratio The aspect ratio of the desired resolution.  Most monitors are 16:9 aspect ratio.  
Changing the aspect ratio will change the available resolutions. 

Resolution The resolution of rendering in 3D.  Higher resolution means more detail.  Can only 
set resolution to resolutions available for your monitor.

Level of Detail Controls the distance at which lower resolution 3D models are used  Higher level 
of detail means more distance before lower resolution 3D models are used. 

Shading Mode Controls how shading is done.  Sharp shading will create a more accurate 
representation of shading, at a cost of performance.  Smooth shading is less 
accurate but more performant 

Controls

There are three ways to control the 3D Viewer, mouse and keyboard, just mouse, and a game 
controller.  These controls options controls certain aspects of using the mouse, keyboard, and game 
controller. 
Table 8 3. Controls for mouse and controller sensitivity.
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Option Description

Mouse Sensitivity Controls how much the view changes with mouse movement.  Higher sensitivity means 
more view change with mouse movement. Default is 0.1

Controller X 
Sensitivity

Control how much the view changes with the right stick of the game controller, horizontal 
axis only.  Default is 0.3

Controller Y 
Sensitivity

Control how much the view changes with the right stick of the game controller, vertical axis 
only.  Default is 0.15

Invert Y Axis When this is turned on, moving the vertical axis on either the mouse or game controller will 
change the view in the opposite direction.  Default is off

Pressing the Change Key/Controller bindings button will bring up a different window where you 
can change the various bindings for all the controls of the 3D Viewer.  
Table 8 4. Controls for Moving around within the 3D Viewer.

Action Default Key 
Binding

Default Controller 
Binding

Description

Move Forward W Left Stick up Moves the viewer forward in space

Move Backward S Left Stick down Moves the viewer backward in space

Strafe Left A Left Stick Left Moves the viewer in a left side-step fashion in space

Strafe Right D Left Stick Right Moves the viewer in a right side-step fashion in space

Increase Elevation Space Right Shoulder 
Button

Moves the viewer up in space

Decrease Elevation Left Control Left Shoulder 
Button

Moves the viewer down in space

Change Results 
Map

M North Button (Y on 
Xbox, Triangle on 
PS)

Changes the results map between 4 different maps, a 
realistic map, depth map, velocity map, and water surface 
elevation map

Toggle Particles P West Button (X on 
Xbox, Square on 
PS)

Turns on or off the particle tracing effect

Flight Path Play/
Pause

Return 
(Enter)

East Button (B on 
Xbox, Circle on PS)

While a flight path is active, will either play the path or 
pause it.

Increase Viewer 
Speed

Right Arrow Right Directional 
Arrow

Makes the viewer travel faster.  The viewer can only go so 
fast however.

Decrease Viewer 
Speed

Left Arrow Left Directional 
Arrow

Makes the viewer travel faster.  The viewer can only go so 
slow however.

Turn Left Unbound Right Stick Left Rotates the view to the left
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Turn Right Unbound Right Stick Right Rotates the view to the right

Profile Increment 
Increase

Up Arrow Up Directional 
Arrow

While the animation is playing, the number next to the play 
button shows how many profiles advance every time the 
scroll bar scrolls.  This increases that number.

Profile Increment 
Decrease

Down Arrow Down Directional 
Arrow

While the animation is playing, the number next to the play 
button shows how many profiles advance every time the 
scroll bar scrolls.  This decreases that number.

Change View Up Unbound Right Stick Up Rotates the view up (No changeable binding yet)

Change View Down Unbound Right Stick Down Rotates the view down (No changeable binding yet)

Toggle Mouse 
Pointer

Tab Left Trigger Button Will either show or hide the mouse pointer (No 
changeable binding yet)

Figure 8 15. Spatial representation of action bindings for an Xbox controller.

Particle Tracing

Table 8 5. Controls for Controlling Particle Tracing.

Option Description

Speed  Refers to the animation speed of the particle trace.  Default value is 1.

Density Refers to concentration of tracers in an area.  Default value is 1.

Width Refers to the width of the particle.  Default value is 5.
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Lifetime Refers to how long the particle exists on screen before it disappears and a new particle spawns 
in its place. Default value is 300.

#Particles Refers to how many particles are shown at any one time.  Default value is 10,000.

RGB Changes the color of the tracers.  Each field accepts an integer between 0 and 255.  R 
corresponds to Red, G corresponds to Green and B corresponds to Blue

Toolbar

The Toolbar is located at the top left of the 3D Viewer window. The following Table describes each of 
the tools. 
Table 8 6. Description of each of the 3D Viewer Tools located on the Toolbar.

Tool Description

Select                           Wherever the select pointer is at, it will show the 
value of either the terrain elevation or water 
surface value, dependent on the map type 
chosen.  
While using the select pointer it's possible to 
navigate through the terrain through middle-
clicking and dragging on the terrain.

Pan                     Left click with the pan pointer to navigate through 
the terrain by clicking and dragging the terrain.

Change Camera Modes           Allows you to change how the 3D Viewer is 
controlled.  

When in helicopter mode  , the viewer will 
move forward, backward, left and right on a 
plane. Elevation is controlled by the elevation up 
and down keys 

When in airplane mode  , the viewer will 
move forward in space in relation to where it is 
currently looking.  For example, this means that 
looking straight up and going forward will cause 
the viewer to go straight up. (Not Implemented 
Yet)

Zoom to Entire Extent           Zooms to the maximum viewable extent of the 
terrain, and forces the viewer to look straight 
down.

Measure Tool Measure the distance in map units. (Not 
Implemented Yet)

Toggle Particle Tracing Toggles whether particles show on the water 
surface.
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Particle Tracing Options A shortcut to get to Particle Tracing Options

Change Results Map     Changes the results map between 4 different 
maps, a realistic map, depth map, velocity map, 
and water surface elevation map

Select a Flight Plan Opens the flight plan window to choose a flight 
plan. See Flight Plans/Paths section for more 
information.

Set to Simulation Maximum Max Sets the water surface to simulation maximum.

Set to Simulation Minimum Min Sets the water surface to simulation minimum. 

Animation Bar Change the animation bar position to change the 
time of the simulation.  When a portion of the 
animation bar is grey, it means that the simulation 
has not loaded at that time yet.

Play/Pause
 / 

Plays or pauses the animation

Profile Increment +1, +2, +3, +5, +10, +25, +50, +100 This number indicates how many profiles advance 
every time the scroll bar scrolls.  This will also 
start loading portions of the simulation that fall 
on the increments.

Change Animation Speed Changes the delay before changing time step in 
the animation.  Note that there is an inherent 
delay that is unavoidable for each time step.  That 
delay depends on whether you pre-processed the 
dataset, 
and whether you have high resolution water 
turned on during animation. (Not Implemented 
Yet)

Min map

The mini map is shown to assist with acquiring bearings when using the 3D Viewer. Shown in the 
Figure below is an example of the mini map, which is displayed in the upper right hand corner of the 
3D Viewer.
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Figure 8 16. Example of the 3D Viewer Mini Map.

There are three components to the mini map, which are explained in the Table below. 
Table 8 7. Components of the 3D Viewer Mini Map.

Component Description

Hide/Show 
Button

On the top right of the mini-map is a button that will hide or show the mini-map.

Mini-map              
A character on the mini-map  shows where the viewer is in relation to the map, and also 
shows what direction the viewer is currently facing.  Here the character is facing north 
The mini-map also grants the ability for the viewer to be moved anywhere on the map.  With 

either the Select  or Pan  tool, left click anywhere to move the viewer to that location. 
The left mouse button can also be held down to move the viewer with the mouse drag.

Simulation 
Date/Time       

Shows the current Date/Time for the simulation
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Speed/Position Information

On the bottom left corner of the viewer is information about the viewer's speed and its position. A 
description of these components is in the Table below.

Table 8 8. Speed and Location Components.

Component Description

Top Speed The maximum speed that the viewer can currently travel.  Can be increased/decreased with 
the Increase/Decrease Viewer Speed key bindings.  
The fraction shows what top speed is currently selected out of the possible top speeds.  The 
top speeds are generated based on terrain size.

Current Speed  While the viewer is moving, the current speed will update to show the viewer's current speed.

X,Y      The position of the viewer on the XY plane.  These coordinates are the same ones used in RAS 
Mapper

Z The elevation of the viewer

Notes on Large Terrains/Dense Models

The 3D viewer currently works better for dense terrains that are are on the smaller side.  The initial 
loading process (the splash screen) has to create a node for every terrain tile in the terrain model, so 
if the terrain is expansive and it has high resolution data, it may take a little bit of time before the 3D 
Viewer can load.   The 3D Viewer's current Level of Detail implementation also works better for less 
expansive terrains.  There are tools for cutting terrains to either a certain view extent, or the extent of 
the geometry.  It is possible you may have to cut small sections and view the various sections 
separately.  See Exporting RAS Terrains

How To Use the 3D Viewer

Movement

How movement works on the keyboard/controller depends on what camera mode the 3D Viewer is 

currently set.  By default, the 3D Viewer is set to Helicopter mode ( ), which means the 
movement keys will move the viewer as if it's on a geometric plane.  For example, pressing the 
forward key will move the viewer forward. 

Movement for the mouse works the same for either camera mode.  If the cursor is currently the 

Select cursor ( ), middle-click and drag on the terrain will move the viewer proportional to how 

much the mouse is dragged.  If the cursor is the Pan cursor ( ), then a left-click and drag is all 
that is needed.

https://www.hec.usace.army.mil/confluence/rasdocs/rmum/latest/terrain-layer#id-.TerrainLayerv6.0-ExportingRASTerrains
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Changing View/Rotation

Changing the view of the viewer is accomplished through the mouse or the right stick on the 
controller.  It can also be done through the keyboard but the keys are unbound by default to 
discourage using the keyboard. 

To change the view with the mouse right-click and drag on the screen.  This only applies when the 
mouse cursor is visible.  If the view changes too little with the mouse drag then you can change the 
mouse sensitivity in the options.  When the mouse cursor is not visible there is no need to right-click, 
the view will change with mouse movement.  See Mouse Lock/Unlock for more information.

To change the view with a game controller, use the right stick. This only applies when the mouse 
cursor is not visible.  If the view changes too little with the right stick then you can change the 
controller sensitivity in the options.  When the cursor is visible the left stick controls the mouse.  See 
Mouse Lock/Unlock for more information.

Changing Elevation

To change the elevation with the mouse, scroll up to decrease in elevation, scroll down to increase in 
elevation.

Changing elevation with the keyboard or game controller depends on what camera mode the 3D 

Viewer is currently set.  By default the 3D Viewer is set to Helicopter mode ( ), in Helicopter mode 

elevation is changed by pressing the Elevation Up or Elevation Down keys.  In Airplane mode ( ), 
these keys are disabled, and to change elevation in this mode look in the direction you wish to 
ascend/descend.

Mouse Lock/Unlock

By default, the mouse is shown and it considered to be "unlocked".  The purpose of an unlocked 
mouse is to allow easy access to the buttons on the user interface. 

To make changing the view with the mouse less tedious, the mouse can be "locked" to the screen by 
pressing the Tab key.  This will hide the mouse cursor, but will no longer require the mouse to right-
click to change view. 

Flight Plans/Paths
The 3D Viewer allows the user to specify a flight path polyline in RAS Mapper for the viewer to follow 
like a train on tracks

To lay out a flight path, first open RAS Mapper.  To open RAS Mapper, on the main RAS window select 

the GIS Tools | RAS Mapper menu item or by pressing the    RAS Mapper button, shown 
below.



Viewing Results

HEC-RAS User's Manual– 394

Figure 8 16. HEC-RAS Main Window with HEC-RAS Mapper Button Highlighted.

A flight path layer will be needed to lay out flight paths.  To do that right click on Features Group in 
the tree view, and then select Create New Layer | Flightpath Layer

Figure 8 17. HEC-RAS Mapper Menu with Flightpath Layer Selection shown.

Then lay out the polyline you want to use for the flight plan.  When you have finished right click the 
layer and select Stop Editing.
A shape file will be generated under the Flight Paths folder in the root project directory.

Go back to the 3D Viewer and press the Select a Flight Plan button in the toolbar (  )

If you saved your flight path layer in the default location, then the form will automatically select the 
shapefile for you.  Otherwise, find the flight path shapefile using the Browse button.

Next, select the polyline from the list on the bottom left of the form.
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Option Description

Constant Elevation The elevation of the viewer will stay constant throughout the flight path.  The 
elevation can still be changed as described in Changing Elevation section

Offset From The Terrain Follows the elevation of the terrain at the viewer's position at a constant offset.  
The elevation can still be changed as described in Changing Elevation section. 
(Not Implemented Yet)

Always Look Forward The viewer's rotation will stay locked along the polyline.  No need to change 
rotation of the viewer in this mode.  Changing the view while the flight path is 
running will pause the flight plan

Pitch is the angle the viewer is looking up or looking down.  It can be changed 
while the flight plan is running.

Allow Free Look The viewer's rotation will behave the same as before. Changing the view will not 
pause the flight plan

Start From First/Last Point in 
Polyline

Where to start on the polyline.  Starting from the first point will cause the viewer 
to go towards the last point.  Starting from the last point will cause the viewer to 
go to the first point
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Flight Plan Toolbar

Tool Description

Play/Pause Flight 
Plan       / 

Continues the flight plan along the flight path, or pauses the flight plan.  If the 
flight plan is paused, the viewer can move freely anywhere.  When the flight plan is 
resumed the viewer will go back along the flight path.

Restart Restarts the flight plan to either the first point in the flight path or the last point, 
depending on what direction the flight plan is moving.

Change Direction 
        / 

Changes the direction of the flight plan.  The arrow indicates the current direction.

Lock/Unlock 
Camera     / 

When the lock is on this icon, the view will always look forward as described 
above.  When there is no lock then the view is in free look mode, as described 
above. 

Pitch The pitch in degrees, which is the angle at which the viewer is looking up or down.

An example 3D Perspective plot is shown in Figure 8-18. The older X-Y-Z Perspective Plot of 1D cross 
sections is still available from the View menu.

Figure 8 18. Example 3D Perspective Plot.

Breach Hydrograph Plot
If the user is running HEC-RAS in unsteady flow mode (1D or 2D), and you have added breaching 
information for one or more of the structures that can be breached (Inline structures, Lateral 
structures, and SA/2D Area Connections), then the Breach Hydrograph plot can be used to display 
key information about the breach.
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The Breach Hydrograph plot has three simultaneous plots and a table all on the same window. By 
default the plot will come up with a summary table at the top, then three plot windows: 1) Stage and 
flow hydrographs for the structure; 2) Breach bottom width vs time; and 3) Average velocity vs time 
through the breach. Additionally there is a Table Tab just left of the breach. If the Table tab is 
selected, the user will see a detailed table for the left half of the window, and the plot will be on the 
right half of the window (the user can adjust the size of both). This table contains all of the time 
series data being shown in the plots.
An example of the new Breach Hydrograph plot for an inline structure (Dam in this example) is 
shown in Figure 8-19 below.

Figure 8 19. Breach Hydrograph Plot for Inline Structure with a Breach.

As shown in Figure 8-19, if the user left clicks on the plot window, a series of "Bobbers" will show up 
on top of each line, and the value of each line at that point is shown to the right of the Bobber Dot. 
This is a very handy feature for obtaining the magnitude of each piece of data at the same point in 
time.

From the Type menu at the top of the window, user's can select from the three types of structures 
that can contain breaching information: Inline Structures; Lateral Structures; and SA/2D Area 
Connections. Once a Breach Hydrograph Type is selected, the program will only load that type of 
structure, and only the ones that have breach information.
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Under the Options menu, there are Options for selecting multiple Plans to plot, and there is an 
option for setting the number of decimal places of the numerical values shown on the plot and in 
the tables.
Additionally, if the user right click on the plot window, a Popup menu will appear with options to: 
Zoom In; Zoom Previous; Zoom Out; Full Plot; Pan; Select; Point Bobber; Copy to Clipboard; 
Tabulate; Lines and Symbols; Font sizes and Styles; grid; and Chart options.

Stage and Flow Hydrographs
If the user has performed an unsteady flow analysis, then stage and flow hydrographs will be 
available for viewing. To view a stage and/or flow hydrograph, the user selects Stage and Flow 
Hydrographs from the View menu of the main HEC-RAS window. When this option is selected a plot 
will appear as shown in Figure 8-20. The user has the option to plot just the stage hydrograph, just 
the flow hydrograph, or both as shown in the figure. Additionally, there are three tabs on the plot. 
The tabs are for plotting (Plot), viewing the data in tabular form (Table), and plotting a rating curve 
of the event (Rating Curve). By default, the window comes up in a plotting mode.

The stage and flow hydrograph plot also has a menu option to select the specific node types to be 
viewed. By default, the plot comes up with a node type of cross section selected. This allows the user 
to view hydrographs at cross sections only. Other available node types include: Bridges/Culverts; 
Inline Structures; Lateral Structures; Storage Areas; Storage Area Connections; and Pump Stations.
There are several options available for viewing this graphic. These options are the same as described 
previously for the cross section, profile, and rating curve plots. Additionally, this graphic can be sent 
to the windows clipboard, or the printer, as described under the previous plots.

Additional output for the hydrograph plot includes statistics about the hydrographs (peak stage and 
flow, time of peak, and volume). Also, the user can simultaneously plot observed hydrograph data at 
locations where they have gaged information stored in a DSS file. The user attaches gaged 
hydrograph information to cross section locations from the Unsteady Flow Data editor. 
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Figure 8 20 Stage and Flow Hydrograph Plot

Tabular Output
Summary tables of the detailed water surface profile computations are often necessary to analyze 
and document simulation results. Tabular output allows the user to display large amounts of 
detailed information in a concise format. HEC-RAS has two basic types of tabular output, detailed 
output tables and profile summary tables.

Detailed Output Tables
Detailed output tables show hydraulic information at a single location, for a single profile. To display 
a detailed output table on the screen, select Detailed Output Tables from the View menu of the 
main HEC-RAS window. An example detailed output table is shown in Figure 8 21.
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Figure 8 21 Example Cross Section Detailed Output Table

By default, this table comes up displaying detailed output for cross sections. Any cross section can 
be displayed in the table by selecting the appropriate river, reach and river station from the list 
boxes at the top of the table. Also, any of the computed profiles can be displayed by selecting the 
desired profile from the profile list box. Additionally, different plans can be viewed by selecting a 
plan from the plan list box.
Users can also view detailed hydraulic information for other types of nodes. Other table types are 
selected from the Type menu on the detailed output table window. The following types are available 
in addition to the normal cross section table (which is the default):

Culvert. The culvert table type brings up detailed culvert information. This table can be selected for 
normal culverts, or for culverts that are part of a multiple opening river crossing. An example culvert 
specific table is shown in Figure 8-22.
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Figure 8 22 Example Culvert Type of Cross Section Table

Bridge. The bridge table type brings up detailed output for the cross sections inside the bridge as 
well as just upstream of the bridge. The bridge table type can be selected for normal bridge 
crossings, or for bridges that are part of a multiple opening river crossing. An example of the bridge 
specific cross section table is shown in Figure 8-23.
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Figure 8 23 Example Bridge Type of Cross Section Table

Multiple Opening. The multiple opening type of table is a combination of the cross section table and 
the bridge and culvert tables. That is, if the user has defined multiple opening (bridges, culverts, and 
conveyance areas), then this table can be used to view the hydraulic results for each specific 
opening.

Inline Structure. The Inline Structure type of table can be used to view detailed output for any inline 
weirs and/or gated spillways that have been entered by the user.

Lateral Structure. The Lateral Structure type of table can be used for viewing detailed output from a 
lateral weir, gated spillway, culvert, and rating curves.

Storage Area. This table provides output about an individual storage area. Information includes 
water surface elevation, total inflow, total outflow, and net inflow.

Storage Area Connection. This table provides detailed information about storage area connections. 
Storage area connections can consist of weirs, gated spillways, and culverts.

Pump Stations. This table provides detailed information about pump stations. Pump station output 
includes to and from water surface elevations, total flow, flow through each pump group, flow 
through each pump, head difference, and efficiency.
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Flow Distribution In Cross Sections. The Flow Distribution table type can be used to view the 
computed flow distribution output at any cross section where this type of output was requested. An 
example of the flow distribution table output is shown in Figure 8-24.

Figure 8 24 Example of the Flow Distribution Type of Table

At the bottom of each of the detailed output tables are two text boxes for displaying messages. The 
bottom text box is used to display the definition of the variables listed in the table. When the user 
presses the left mouse button over any data field, the description for that field is displayed in the 
bottom text box. The other text box is used to display any Errors, Warnings, and Notes that may have 
occurred during the computations for the displayed cross section.

Detailed Output Table Options
Plans. This option allows the user to select which plan, and therefore output file, they would like to 
view. This option is available from a list box at the upper right-hand side of the window.
Under the Options menu of the cross-section table window, the user has the following options:

Include Interpolated XS's. This option allows the user to either view interpolated cross-section 
output or not. Turning the "include interpolated XS's" option on (which is the default), allows 
interpolated sections to be selected from the river station box. Turning this option off gets rid of all 
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the interpolated sections from the river station selection box, and only the user entered cross-
sections are displayed.

Include Errors, Warnings, and Notes in Printout. This option allows the user to have the errors, 
warnings, and notes information printed below the table, when the option to print the table is 
selected.

Units System for Viewing. This option allows the user to view the output in either English or Metric 
units. It does not matter whether the input data is in English or Metric, the output can be viewed in 
either system.

Profile Summary Tables
Profile summary tables are used to show a limited number of hydraulic variables for several cross 
sections. To display a profile summary table on the screen, select Profile Summary Table from the 
View menu of the main HEC-RAS window. An example profile summary table is shown in Figure 8-25.

Figure 8 25 Example Profile Table

There are several standard table (Std. Tables) types available to the user. Some of the tables are 
designed to provide specific information at hydraulic structures (e.g., bridges and culverts), while 
others provide generic information at all cross sections. The standard table types available to the 
user are:

Standard Table 1. The is the default profile type of table. This table gives you a summary of some of 
the key output variables.

Standard Table 2. This is the second of the standard summary tables. This table provides 
information on the distribution of flow between the left overbank, main channel, and right overbank. 
This table also shows the friction losses, as well as contraction and expansion losses that occurred 
between each section. Energy losses displayed at a particular cross section are for the losses that 
occurred between that section and the next section downstream.

Four XS Culvert. This standard table provides summary results for the four cross sections around 
each of the culverts in the model. The four cross sections are the two immediately downstream and 
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the two immediately upstream of the culvert. This table will list all of the culverts in the model for 
the selected reaches.

Culvert Only. This standard table provides hydraulic information about the culvert, as well as the 
inlet control and outlet control computations that were performed.

Six XS Bridge. This table provides summary results for the six cross sections that make up the 
transition of flow around a bridge. The six cross sections include the two cross sections just 
downstream of the bridge; the two cross sections inside of the bridge; and the two cross sections just 
upstream of the bridge. The program will display results for all the bridges in the model within the 
selected reaches. When viewing this table, on occasion there will be no displayed results for the 
cross sections inside of the bridge. This occurs only when the user has selected a bridge modeling 
approach that does not compute results inside of the bridge. This includes: Yarnell's method; both 
pressure flow equations; and pressure and weir flow solutions.

Bridge Only. The bridge only table shows summary information specifically for bridges.

Bridge Comparison. The bridge comparison table shows the results for all of the user selected 
bridge modeling approaches that were computed during the computations. For example, the 
program can calculate low flow bridge hydraulics by four different methods. The resulting upstream 
energy for the user selected methods will be displayed in this table.

Multiple Opening. This table shows a limited number of output variables for each opening of a 
multiple opening river crossing.

Four XS Inline Structure. This table displays summary results of the four cross sections immediately 
around an inline weir and/or gated spillway. The four cross sections are the two immediately 
upstream and the two immediately downstream of the inline weir and/or gated spillway.

Inline Structure. This table shows the final computed water surface and energy just upstream of 
each of the inline weir and/or gated spillways. In addition to these elevations, the table displays the 
total flow, the flow over the weir, and the total flow through all of the gates.

Lateral Structure. This table shows a limited set of output variables for all of the lateral weir/
spillway structures within the selected reaches.

Encroachment 1, 2, and 3. These three standard tables provide various types of output for the 
computations of floodway encroachments.

HEC-FDA. This table provides information that can be exported to the HEC Flood Damage Analysis 
(FDA) program. The table displays total flow, channel invert elevation, and water surface elevation.

HEC-5Q. This table provides information that can be exported to the HEC-5Q (river and reservoir 
water quality analysis) program. The table displays only the specific parameters required by the 
HEC-5Q program.

Ice Cover. This table shows summary output of ice information. This table was designed for 
performing a study that includes ice cover.

Junctions. This summary table provides a limited set of output for all of the cross sections that 
bound a junction. This table will show this output for all of the junctions found in the model.
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Storage Areas. This table shows a limited amount of output for all of the storage areas in the model. 
Output includes: water surface elevation; minimum storage area elevation; surface area; and 
volume.

Conn with Culverts. This table will show summary output for storage area connections that contain 
culverts.

Pump Stations. This table shows a limited amount of output for any of the pump stations contained 
within the model.
To view one of the types of tables, select the desired table type from the Std. Tables menu on the 
profile summary table. In addition to the various types of profile tables, the user can specify which 
plans, profiles and reaches to include in the table. The plans, profiles and reaches options are 
available from the Options menu on the profile plot.
The user also has the ability to turn the viewing of interpolated cross sections on or off. The default is 
to view all cross-sections, including the interpolated ones. To prevent the interpolated sections from 
showing up in the table, de-select Include Interpolated XS's from the Options menu.

Another feature available to users is the ability to set the number of decimal places that will be 
displayed for any variable of the pre-defined tables. Once a pre-defined table is selected from the 
Tables menu, select Standard Table # Dec Places from the Options menu. A window will appear 
displaying the current number of decimal places for each variable. The user can change the number 
of decimal places to whatever they wish.

User's also have the ability to view summary output tables in either English or metric units. This is 
available from the Options menu on the profile tables. It does not matter whether the input data is 
in English or metric, the output can be viewed in either system.

User Defined Output Tables
A special feature of the profile summary tables is the ability for users to define their own output 
tables. User defined output tables are available by selecting Define Table from the Options menu of 
the profile table. When this option is selected, a window will appear, as shown in Figure 8-26. At the 
top of the window is a table for the user selected variable headings (Table Column Headings), the 
units, and the number of decimal places to be displayed for each variable. Below this table is a table 
containing all of the available variables that can be included in your user-defined table. The variables 
are listed in alphabetical order. In addition to the variable names, to the right of each variable is a 
description.

To add variables to the column headings, simply double click the left mouse button while the mouse 
pointer is over the desired variable. The variable will be placed in the active field of the table column 
headings. To select a specific column to place a variable in, click the left mouse button once while 
the mouse pointer is over the desired table column field. To delete a variable from the table 
headings, double click the left mouse button while the mouse pointer is over the variable that you 
want to delete. The number of decimal places for each variable can be changed by simply typing in a 
new value.
User defined tables are limited to 15 variables. Once you have selected all of the variables that you 
want, press the OK button at the bottom of the window. The profile table will automatically be 
updated to display the new table.
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2.

Figure 8 26 User Defined Tables Window

Once you have the table displayed in the profile table window, you can save the table headings for 
future use. To save a table heading, select Save Table from the Options menu on the profile table 
window. When this option is selected, a pop-up window will appear, prompting you to enter a name 
for the table. Once you enter the name, press the OK button at the bottom of the pop-up window. 
The table name will then be added to a list of tables included under the User Tables menu on the 
profile table window. To delete a table from the list of user defined tables, select Remove Table
from the Options menu of the profile table window. When this option is selected, a pop-up window 
will appear displaying a list of all the user-defined tables. Click the left mouse button over the tables 
that you want to delete, then press the OK button. The selected tables will then be deleted from the 
User Tables menu list.

Sending Tables to the Printer
To send a table to the printer, do the following:

Bring up the desired table from the tabular output (cross section or profile tables) section of the program.
Select Print from the File menu of the displayed table. When this option is selected, a pop-up window will 
appear allowing you to modify the default print options. Once you have set the printer with the desired 
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1.
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options, press the Print button. The table will be sent to the Windows Print Manager. The Windows Print 
Manager will control the printing of the table.

The profile summary type of tables allow you to print a specific portion of the table, rather than the 
entire table. If you desire to only print a portion of the table, do the following:

Display the desired profile type table on the screen.
Using the mouse, press down on the left mouse button and highlight the area of the table that you would 
like to print. To get an entire row or column, press down on the left mouse button while moving the pointer 
across the desired row or column headings.
Select Printer from the File menu of the displayed table. Only the highlighted portion of the table and the 
row and column headings will be sent to the Windows Print Manager.

Sending Tables to the Windows Clipboard
To pass a table to the Windows Clipboard, and then to another program, do the following:

Display the desired table on the screen.
Select Copy to Clipboard from the File menu of the displayed table.
Bring up the program that you want to pass the table into. Select Paste from the Edit menu of the receiving 
program.

Portions of the profile tables can be sent to the Clipboard in the same manner as sending them to the 
printer. 

Viewing Results from the River System Schematic
The user has the option of either bringing up graphics and tables from the View menu on the main 
HEC-RAS window (as discussed above), or from the river system schematic (found under geometric 
data). Once data have been entered, and a successful simulation has been made, the user can 
interact with the river system schematic. When the left mouse button is pressed over the river system 
schematic, a pop-up menu will appear listing options that are relevant to the area of the schematic 
that is located under the mouse pointer. An example of this is shown in Figure 8-27.

In Figure 8-27, the pop-up menu shown comes up whenever the user presses the left mouse button 
over a cross section. In this particular example, the mouse button was pressed over the cross section 
located at river station 9.9 of the Upper reach of Fall river. As shown in the menu, the user has the 
choice of editing the cross section data; plotting the cross section; plotting the profile for the reach 
containing this cross section; bringing up the XYZ plot for that reach; viewing tabular output; plotting 
the computed rating curve at this cross section; or viewing a picture of the location. Other popup 
menus are available for bridges; culverts; junctions; and reach data. 
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Figure 8 27 Geometric Data Window with Popup Menu

Viewing Computational Level Output for Unsteady Flow
When performing an unsteady flow analysis the user can optionally turn on the ability to view output 
at the computation interval level. This is accomplished by checking the box labeled Computation 
Level Output on the Unsteady Flow Analysis window (In the Computations Settings area on the 
window). When this option is selected an additional binary file containing output at the computation 
interval is written out. After the simulation the user can view computation level output by selecting 
either Unsteady Flow Spatial Plot or Unsteady Flow Time Series Plot from the View menu of the 
main HEC-RAS window. Shown in Figure 8-28 is an example of the Spatial Plot.
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Figure 8 28. Unsteady Flow Spatial Plot for Computational Interval Output

As shown in Figure 8-28, the user can view either a profile plot, a spatial plot of the schematic, or 
tabular output. The user can select from a limited list of variables that are available at the 
computation level output. These are water surface elevation (XS WSEl); Flow (XS Flow); computed 
maximum error in the water surface elevation (XS WSEL ERROR); computed maximum error in the 
flow (XS FLOW ERROR); and maximum depth of water in the channel (DEPTH). Each of the plots can 
be animated in time by using the video player buttons at the top right of the window. This type of 
output can often be very useful in debugging problems within an unsteady flow run. Especially 
plotting the water surface error and animating it in time.

The other type of plot available at the computation interval output level is the Unsteady Flow Time 
Series Plot. When this option is selected the user will get a plot as shown in Figure 8-29.
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Figure 8 29. Unsteady Flow Time Series Plot at Computation Interval Level

As shown in Figure 8-29, the user has the option to plot or tabulate the time series output. 
Additionally, the user can select from five variables to display on the plot/table. The variables are 
chosen from the Variables button at the top of the window.

Viewing Ice Information
River ice information can be viewed both in a graphical and tabular format.

Graphical Ice Information
To view graphical ice information on the screen, select either Cross Sections, Profiles, or X-Y-Z 
Perspective Plot from the View menu on the HEC-RAS main window.

Cross Section Plot. Figure 8-30 is an example cross section plot displaying ice. The ice cover is 
displayed by selecting Variables under the Options menu, then selecting the Ice Cover option. The 
ice thicknesses in the right overbank, main channel, and left overbank are displayed. The default 
color and fill pattern can be changed by the user by selecting Lines and Symbols under the Options
menu. Note that multiple profiles and multiple plans can be displayed on the same plot.
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Figure 8 30 Cross Section Plot with Ice

Profiles Plot. An example of a profile plot with ice is shown in Figure 8-31. In this case, the WS-EG 
Profile was selected. As with the Cross Section plot, the ice cover is displayed by selecting Variables
under the Options menu, then selecting the Ice Cover option. The ice thicknesses in the right 
overbank, main channel, and left overbank are displayed. The default color and fill pattern can be 
changed by the user by selecting Lines and Symbols under the Options menu. Note that multiple 
profiles and multiple plans can be displayed on the same plot. 
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Figure 8 31 Profile Plot with Ice Cover

Ice information can also be displayed in profile plots by selecting the General Profile option and 
then selecting Variables under the Options menu. This provides a number of ice variables, including 
ice volume in the channel, left, and right overbanks; ice thickness in the channel, left, and right 
overbanks; top of ice elevation in the channel, left, and right overbanks; and bottom of ice elevations 
in the channel, left, and right overbanks. These plots can all be viewed in different widow sizes and 
printed.

X-Y-Z Perspective Plot. As with the Cross-Section plot, the ice cover is displayed by selecting 
Variables under the Options menu, then selecting the Ice Cover option. The ice thicknesses in the 
right overbank, main channel, and left overbank are displayed. The default color and fill pattern can 
be changed by the user by selecting Lines and Symbols under the Options menu.

Tabular Ice Information
Tabular information describing the results of the ice calculations can be displayed by selecting 
Profile Summary Table under the View menu on the HEC-RAS main window. Ice information is 
available directly by selecting the Ice Cover option under the Std. Tables menu of the Profile Table 
window. The Ice Cover option provides a table that includes the ice volume, ice thickness, and 
composite Manning's n value for the main channel, left overbank, and right overbank. In addition, 
the Ice Cover Table includes the water surface elevation and the cumulative ice volume starting from 
the downstream end of the channel. An example table of ice information is shown in Figure 8-32. 
Tables of ice information can also be created using the Define Table option under the Options menu 
of the Profile Table window.



Viewing Results

HEC-RAS User's Manual– 414

Figure 8 32 Ice Cover Table

Viewing Data Contained in an HEC-DSS File
The HEC-RAS software can write and read data to and from the HEC-DSS (Data Storage System) 
database. The steady flow portion of HEC-RAS can read flow data to be used as profile information, 
and can write water surface profiles, storage-outflow information, and rating curves. The unsteady 
flow portion of HEC-RAS can read complete hydrographs (stage and flow), profiles, rating curves, as 
well as gate settings to be used during a simulation. Observed data contained in a DSS file can be 
attached to specific cross sections for comparison with computed results at those locations, and 
computed profiles and hydrographs are written to the DSS file during an unsteady flow simulation.

Because a DSS file can be used to share information between different HEC programs (such as HEC-
HMS and HEC-RAS), it is often necessary to be able to view data contained within a DSS file. A DSS 
viewer is available from within the HEC-RAS software. To bring up the DSS viewer select DSS Data
from the View menu of the main HEC-RAS window (Or press the button labeled DSS on the main 
window). When this option is selected a window will appear as shown in Figure 8-33.
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Figure 8 33 HEC-DSS Viewer Window

As shown in Figure 8-33, all of the DSS files associated with the current Plan will be loaded and are 
shown at the top of the window. Users can turn specific DSS files on and off. Additional DSS files not 
associated with the project can also be loaded by pressing the plus  button to the left of the table. 
When a DSS file(s) is selected, a list of the available pathnames within that file will show up in the 
table. Each DSS pathname represents a record of data stored within the DSS file(s). The user can 
select one or more DSS pathnames to be plotted and/or tabulated. A pathname is selected by using 
the left mouse button to select a row(s) in the table. Users can use the Control Key plus left mouse 
click to select additional pathnames. Additionally, the Shift key can also be used to select a range of 
pathnames. Once a Pathname or Pathnames are selected, the data will be plotted in the Plot 
window below the Pathname table as shown in Figure 8-33.

There is also an option to the left of the plot to bring up a table of the data shown within the plot. If 
the user hits the right arrow above the Table option, then a table will appear as shown in Figure 8-34. 
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Figure 8 34 Example Plot from the HEC-RAS DSS Viewer

Data can be viewed from one or more DSS files simultaneously. The user simple selects the check 
box for the desired DSS files and picks the desired pathnames. The data will automatically be plotted 
and there is the option to tabulate the data.

The user has options available for setting the Time Window for plotting the data. By default, the time 
window will be set to the currently opened Plans time window. In the upper right corner of the plot is 
a Time Window drop down that allows the user to select from: Plan Time; All Available Data; and 
User Specified.

Users also have an option to control the number of decimal places displayed for the data in the 
tables. This can be selected from the Options menu at the top.

Exporting Results to HEC-DSS
The HEC-RAS software has the ability to export a limited set of results to a HEC-DSS file for both 
steady and unsteady flow simulations. When performing an Unsteady flow simulation, the program 
automatically writes stage and flow hydrographs to the DSS file, but only for the user-selected 
hydrograph output locations. Water surface profiles are also automatically written to the DSS file. 
The profiles are written for the user selected detailed output interval, as well as the overall maximum 
water surface profile (profile of the maximum stage at every cross section).
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Once a steady flow or unsteady flow simulation is performed, the user can write the following 
information to a DSS file: water surface profiles; computed rating curves; and storage-outflow 
information. To export computed results to a DSS file the user selects Export To HEC-DSS from the 
File menu of the main HEC-RAS window. When this option is selected a window will appear as shown 
in Figure 8-35.

Figure 8 35. Export Computed Results to DSS Window

As shown in Figure 8-35, there are three tabs on the window; one for profiles, rating curves, and 
storage outflow. To export computed water surface profiles, select the Profiles tab from the 
window. Select the type of profiles that you want to export (water surface elevations or flow). Next 
select the specific profiles to be exported, as well as the reaches that you want to have profiles for. 
Select how you want the stationing to be labeled. This is accomplished by selecting one of the 
options under the field labeled Reach Starting Station. The user can have the river stationing 
labeled in feet or miles, and have it start at zero or whatever the magnitude is of the most 
downstream cross section. The final option is to press the Export Profile Data button, and the data 
will then be written to the DSS file.

To write computed rating curves to the DSS file select the Rating Curve tab. When the rating curve 
tab is selected, the window will change to what is shown in Figure 8-36.
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Figure 8 36 Exporting Computed Rating Curves to HEC-DSS

As shown in Figure 8-36, to export a computed rating curve to DSS, select the river, reach, and river 
stations that you want to have exported to the DSS file. Then simply press the Export Rating Curves
button to have the program write the data to the DSS file. If your profiles are not in the order from 
lowest flow to highest flow, turn on the option that says Sort flows in rating curve. This option will 
ensure that the curve is written in the order of increasing flow rate.

The HEC-RAS program computes cumulative storage volumes for each of the water surface profiles. 
This information can be used for hydrologic routing in a hydrology model such as HEC-HMS or HEC-1. 
The HEC-RAS program allows the user to write out storage versus volume information to a DSS file. 
To use this option, select the Storage Outflow tab from the Export to DSS window. When this option 
is selected a window will appear as shown in Figure 8-37.
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Figure 8 37 Exporting Storage-Outflow Information to HEC-DSS

As shown in Figure 8-37, the user selects the River, upstream reach, upstream river station, 
downstream reach, and downstream river station to completely define a routing reach in which they 
want to have storage-outflow information written to the DSS file. This can be done for as many 
reaches as you want within the model. After all of the reaches are defined, simply press the button 
labeled Export Volume Outflow Data to write the information to the DSS file.

Inundation Mapping with HEC-RAS Mapper
If you have a model that is georeferenced, and you have terrain data to cover the model extents, you 
can use HEC-RAS Mapper to perform inundation mapping for either steady flow or unsteady flow 
models. An example of an inundation map developed with HEC-RAS Mapper is shown below in Figure 
8-38. For details on how to use HEC-RAS Mapper, please see the HEC-RAS Mapper User's Manual. 

https://www.hec.usace.army.mil/confluence/rasdocs/rmum/latest
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Figure 8 38. Example Inundation map from HEC-RAS Mapper.



Performing a Floodplain Encroachment Analysis

HEC-RAS User's Manual– 421

•
•
•

•
•

10 PERFORMING A FLOODPLAIN ENCROACHMENT ANALYSIS
The evaluation of the impact of floodplain encroachments on water surface profiles can be of 
substantial interest to planners, land developers, and engineers. Floodplain and floodway 
evaluations are the basis for floodplain management programs. Most of the studies are conducted 
under the National Flood Insurance Program and follow the procedures in the "Flood Insurance 
Study Guidelines and Specifications for Study Contractors," FEMA 37 (Federal Emergency 
Management Agency, 11085).

FEMA 37 defines a floodway "...as the channel of a river or other watercourse and the adjacent land 
areas that must be reserved in order to discharge the base flood without cumulatively increasing the 
water-surface elevation by more than a designated height." Normally, the base flood is the one-
percent chance event (100-year recurrence interval), and the designated height is one foot, unless 
the state has established a more stringent regulation for maximum rise. The floodway is usually 
determined by an encroachment analysis, using an equal loss of conveyance on opposite sides of the 
stream. For purposes of floodway analysis, the floodplain fringe removed by the encroachments is 
assumed to be completely blocked.

HEC-RAS contains five optional methods for specifying floodplain encroachments. For information 
on the computational details of each of the five encroachment methods, as well as special 
considerations for encroachments at bridges, culverts, and multiple openings, see Chapter 10 of the 
HEC-RAS hydraulics reference manual. This section describes how to enter floodplain encroachment 
data, how to perform the encroachment calculations, viewing the floodplain encroachment results.

Overview
The HEC-RAS floodplain encroachment procedure is based on calculating a natural profile (existing 
conditions geometry) as the first profile in a multiple profile run. Other profiles, in a run, are 
calculated using various encroachment options, as desired. Before performing an encroachment 
analysis, the user should have developed a model of the existing river system. This model should be 
calibrated to the fullest extent that is possible. Verification that the model is adequately modeling 
the river system is an extremely important step before attempting to perform an encroachment 
analysis. 

HEC-RAS steady flow program has 5 methods to determine floodplain encroachments. These 
methods are:

Method 1 -User enters right and left encroachment stations
Method 2 -User enters fixed top width
Method 3 -User specifies the percent reduction in 
conveyance
Method 4 -User specifies a target water surface increase
Method 5 -User specifies a target water surface increase and maximum change in energy

The goal of performing a floodplain encroachment analysis is to determine the limits of 
encroachment that will cause a specified change in water surface elevation. To determine the 
change in water surface elevation, the program must first determine a natural profile with no 
encroachments. This base profile is typically computed using the one percent chance discharge. The 
computed profile will define the floodplain, as shown in the figures below. Then, by using one of the 
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5 encroachment methods, the floodplain will be divided into two zones: the floodway fringe and the 
floodway. The floodway fringe is the area blocked by the encroachment. The floodway is the 
remaining portion of the floodplain in which the one-percent chance event must flow without raising 
the water surface more than the target amount (allowable surcharge). 

Plan View - Floodway Definition Sketch

Cross Section View - Floodway Definition Sketch

Steady Flow Floodway Encroachment Analysis
Within HEC-RAS, the data for performing a steady flow floodplain encroachment analysis are entered 
from the Steady Flow Analysis window. Encroachment information is not considered as permanent 
geometry or flow data, and is therefore not entered as such. The encroachment information is saved 
as part of the existing Plan data.
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Steady Flow Encroachment Data Entry
To bring up the floodplain encroachment data window, select the Encroachments option from the 
Options menu of the Steady Flow Analysis window. When this option is selected an Encroachment 
window will appear as shown in the figure below (except yours will be blank when you first open it).

As shown in figure below, there are several pieces of data that the user must supply for an 
encroachment analysis. The encroachment analysis can only be performed for profiles 2 through 15 
(or what ever number has been set by the user in the flow data editor). Encroachments are not 
performed on profile one because most of the encroachment methods rely on having a base profile 
for comparison.

Floodplain Encroachment Data Editor

The data for an encroachment analysis should be entered in the following manner:

Global Information. Global information is data that will be applied at every cross section for every 
profile computed. The first piece of global information is the Equal Conveyance Reduction
selection box at the top of the Encroachment data editor window. Equal conveyance reduction 
applies to encroachment methods 3, 4, and 5. When this is turned on, the program will attempt to 
encroach, such that an equal loss of conveyance is provided on both sides of the stream. If this 
option is turned off, the program will encroach by trying to maintain a loss in conveyance in 
proportion to the distribution of natural overbank conveyance. The default is to have equal 
conveyance reduction on.
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5.

The second item under global information is the Left bank offset and the Right bank offset. The left 
and right offsets are used to establish a buffer zone around the main channel for further limiting the 
amount of the encroachments. For example, if a user established a right offset of 5 feet and a left 
offset of 10 feet, the model will limit all encroachments to 5 feet from the right bank station and 10 
feet from the left bank station. The default is to have no right or left offset, this will allow the 
encroachments to go up to the main channel bank stations, if necessary. River, Reach and River 
Station Selection Boxes. The next piece of data for the user to select is the river and reach in which 
to enter encroachment data. The user is limited to seeing one reach at a time on the encroachment 
data editor. Once a reach is selected, the user can then enter a Starting and Ending River Station to 
work on. By default, the program selects all the sections in the reach. The user can change this to any 
range of cross sections within the reach.

Profile. Next, the user should select a profile number to work on. Profiles are limited to 2 through the 
maximum number set in the currently opened flow data (e.g., 2 through 4, if the user has set 4 
profiles in the flow data editor). The user can not set encroachments for profile 1.

Method and Target Values. The next step is to enter the desired encroachment method to be used 
for the currently selected profile. Once a method is selected, the data entry boxes that corresponds 
to that method will show up below the method selection box. Some of the methods require only one 
piece of data, while others require two. The user should then enter the required information that 
corresponds to the method that they have selected. For example, if the user selects encroachment 
method 4, only one piece of information is required, the target change in water surface elevation. 
The available encroachment methods in HEC-RAS are:

Method 1 -User enters right and left encroachment station
Method 2 -User enters a fixed top width
Method 3 -User specifies the percent reduction in conveyance
Method 4 -User specifies a target water surface increase
Method 5 -User specifies target water surface increase and maximum change in energy

Set Selected Range. Once the encroachment method is selected, and its corresponding data are 
entered, the user should press the Set Selected Range button. Pressing this button will fill in the 
table below with the selected range of river stations; the selected method; and the corresponding 
data for the method. Note that, if the selected method only has one data item, that method's data 
will go under the Value 1 column of the table. If the selected method has two data items, the first 
goes into the Value 1 column and the second goes into the Value 2 column. Once the data is put into 
the table, the user can change the method and corresponding data values directly from the table.

At this point the user should repeat these tasks until all of the encroachment data are entered (i.e., 
for all the reaches and locations in the model, as well as all of the profiles for which the user wants to 
perform the encroachment analysis). Once all of the encroachment data are entered, the user 
presses the OK button and the data will be applied and the window will close. The user can return to 
the encroachment window and edit the data at any time. The encroachment data are not saved to 
the hard disk at this time, they are only saved in memory. To save the data to the hard disk, the user 
should either select Save Project from the File menu of the main HEC-RAS window, or select Save 
Plan from the File menu of the Steady Flow Analysis window.

The Import Method 1 option, allows the user to transfer the computed encroachment stations from 
a previous run (output file) to the input data for a future run. For example, if the user performs a 
preliminary encroachment analysis using any of the methods 2 through 5, they may want to convert 
the results from one of the runs to a method 1 encroachment method. This will allow the user to 
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further define the floodway, using method 1, without having to enter all of the encroachment 
stations. The import of encroachment stations, in this manner, is limited to the results of a single 
encroachment profile for each reach.

Performing Steady Flow Encroachment Analysis
The HEC-RAS floodway procedure is based on calculating a natural profile (no encroachments) as the 
first profile of a multiple profile run. Subsequent profiles are calculated with the various 
encroachment options available in the program.

In general, when performing a floodway analysis, encroachment methods 4 and 5 are normally used 
to get a first cut at the encroachment stations. Recognizing that the initial floodway computations 
may provide changes in water surface elevations greater, or less, than the "target" increase, initial 
computer runs are usually made with several "target" values. The initial computer results should 
then be analyzed for increases in water surface elevations, changes in velocities, changes in top 
width, and other parameters. Also, plotting the results with the X-Y-Z perspective plot, or onto a topo 
map, is recommended. From these initial results, new estimates can be made and tested.

After a few initial runs, the encroachment stations should become more defined. Because portions of 
several computed profiles may be used, the final computer runs are usually made with 
encroachment Method 1 defining the specific encroachment stations at each cross section. 
Additional runs are often made with Method 1, allowing the user to adjust encroachment stations at 
specific cross sections to further define the floodway.

While the floodway analysis generally focuses on the change in water surface elevation, it is 
important to remember that the floodway must be consistent with local development plans and 
provide reasonable hydraulic transitions through the study reach. Sometimes the computed 
floodway solution, that provides computed water surfaces at or near the target maximum, may be 
unreasonable when transferred to the map of the actual study reach. If this occurs, the user may 
need to change some of the encroachment stations, based on the visual inspection of the topo map. 
The floodway computations should be re-run with the new encroachment stations to ensure that the 
target maximum is not exceeded.

Viewing Floodplain Encroachment Results
Floodplain encroachment results can be viewed in both graphical and tabular modes. Graphically, 
the encroachment results show up on the cross section plots as well as the X-Y-Z Perspective plot. An 
example cross-section plot is shown in the figure below.
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Example Cross Section Plot with Encroachments

As shown in the figure above, the encroachments are plotted as outlined blocks. In this example, the 
water surface profile for the base run (first profile) is plotted along with one of the encroached 
profiles. The user can plot as many profiles as they wish, but it may become a little confusing with 
several sets of encroachments plotted at they same time.

Another type of graphic that can be used to view the encroachments is the X-Y-Z perspective plot, an 
example is shown in the figure below. In this example, the base profile (Profile 1) as well as one of the 
encroached profiles is plotted at the same time over a range of cross sections. This type of plot 
allows the user to get a reach view of the floodplain encroachment. The user can quickly see if the 
encroachments transition smoothly or if they are erratic. In general, the final encroachments should 
have a consistent and smooth transition from one cross section to the next. With the assistance of 
this type of plot, the user may want to further refine the final encroachment stations and re-run the 
model.
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Example X-Y-Z Perspective Plot with Base and Encroached Profiles

Encroachment results can also be viewed in a tabular mode from the Profile Output Tables. Select 
Profile Table from the View menu of the main HEC-RAS window. When the table comes up, the user 
can select from three different pre-defined encroachment tables. To bring up one of the 
encroachment tables, select Encroachment 1 from the Std. Tables menu on the Profile table 
window. An example of Encroachment 1 table is shown in the figure below. The table shows the 
basic encroachment results of: computed water surface elevation; change in water surface from the 
base profile; the computed energy; top width of the active flow area; the flow in the left overbank, 
main channel, and right overbank; the left encroachment station; the station of the left bank of the 
main channel; the station of the right bank of the main channel; and the right encroachment station.
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Example of the Encroachment 1 Standard Table

Encroachment 2 table provides some additional information that is often used when plotting the 
encroachments onto a map. This table includes: the change in water surface elevations from the first 
profile; the top width of the active flow area; the percentage of conveyance reduction in the left 
overbank; the left encroachment station; the distance from the center of the main channel to the left 
encroachment station; the station of the center of the main channel; the distance from the center of 
the main channel to the right encroachment station; the right encroachment station; and the 
percentage of conveyance reduction in the right overbank. An example of the Encroachment 2 
standard table is shown below.
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Example of the Encroachment 2 Standard Table

The last encroachment table, Encroachment 3, provides the minimum floodway data for reporting. 
This table includes: the active flow top width; the flow area (including any ineffective flow area); the 
average velocity of the entire cross section; the computed water surface elevation; the base water 
surface elevation (profile 1); and the change in water surface from the first profile. An example of this 
table is shown below.
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Example of the Encroachment 3 Standard Table

1D Unsteady Flow Floodway Encroachment Analysis
Encroachment analyses can also be performed with the unsteady flow computations module within 
HEC-RAS in both 1D and 2D. The 1D unsteady approach utilizes similar techniques using the same 
methods available in steady flow analysis.  These same 5 methods are listed below.

Method 1 -User enters right and left encroachment station
Method 2 -User enters a fixed top width
Method 3 -User specifies the percent reduction in conveyance
Method 4 -User specifies a target water surface increase
Method 5 -User specifies target water surface increase and maximum change in energy
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a.
4.

5.

6.

7.

8.

An additional method for encroachment analysis is available which utilizes Encroachment Regions 
within RAS Mapper to establish left and right encroachment locations for 1D and 2D unsteady flow 
modeling.

When performing a floodway encroachment analysis, the base information should be consistent, 
meaning that the geometry, flow, and plan data should all be identical.  Identical data allows for a 
consistent evaluation of the impacts to the model results given the encroachment information.  
Therefore, there are some basic guidelines that should be considered.

The geometry must be the same for both the Base and Encroached plans.
The flow data must be the same for both the Base and Encroached plans.  Normal depth is a good 
downstream boundary condition as it will account for the change in flow conditions.
The plan data must be the same for the the Base and Encroached plans.
The Base plan must be run prior to the Encroachment analysis

Traditional 1D Unsteady Flow Approach
Because unsteady flow models can have significant run times, a 1D steady flow model can be used to 
inform and assist in performing an unsteady floodway encroachment analysis.  A suggested 
procedure for performing an encroachment analysis with a 1D unsteady flow model is the following:

Develop the unsteady flow model of the river system and calibrate it to the extent possible.
Develop an unsteady flow plan of the base flows (100-yr event) in order to establish the base floodplain.
Create a steady flow plan using the peak flows from the unsteady flow run as the base flow for the model.

Set up the model for two profiles with the same flows.
Perform a steady flow encroachment analysis using the available steady flow encroachment methods to 
calculate the approximate floodway.
Copy the unsteady flow plan to a new plan (using the Save As option), and give it a name that represents the 
encroached plan.
Adjust the boundary conditions file to reflect an increased water surface elevation at the downstream 
boundary for the range of possible flows. If using a rating curve, you will need to develop a new rating to 
reflect the encroached condition at the downstream boundary. If you are using normal depth or critical 
depth, no change is necessary, since the program will calculate a new water surface with the 
encroachments.
Go to the Options menu of the unsteady flow analysis window and select Unsteady Encroachments. This 
will bring up the Unsteady flow Encroachment editor shown below.
Import the final encroachments from the steady flow encroachment run in to the unsteady flow 
encroachment editor. 
This is accomplished by pressing the button labeled "Get Encroachments from Steady Flow Plan", and 
then selecting the appropriate plan and profile number from the steady flow encroachment analysis.
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11.
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The data will then populate the 1D Encroachment Table Paramaters shown below.

Select the "Base Plan" for results comparison.
Run the unsteady flow model with the encroachments and compare the output of the encroached unsteady 
flow plan with the output from the base unsteady flow plan.

Adjust the encroachments as necessary to stay within the limits for increased water surface elevations.
Re-run the unsteady flow model.
Repeat this process until a final floodway is achieved.

Unsteady Flow Encroachment Table
1D Unsteady flow encroachment analysis provides capability for the 5 traditional methods of 
analysis as well as integrating Encroachment Regions for limiting the water surface in the floodplain 
fringe.  For 2D unsteady flow encroachment analysis, the Encroachment Regions method is the only 
procedure available.  It is intended that users can perform floodway encroachment analysis on 1D, 
2D, or combined 1D/2D models with a mix of encroachment methods.  However, it is anticipated that 
the final runs will be performed using Encroachment Regions.

In the figure below, is the Unsteady Flow Encroachment Editor. Access to the Unsteady Flow 
Encroachment Editor is available from the Unsteady Flow Analysis window from the Options | 
Unsteady Encroachment menu item. The Unsteady Flow Encroachment Table allows the user to 
enter information for all encroachment parameters and methods and choose which method to apply 
to each cross section.  In order to enable the encroachment analysis, select the base plan from the 
"Base Plan for Encroachments" list.
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A description of the parameters in the Unsteady Flow Encroachment Editor are described below.

Parameter Description

Base Plan for 
Encroachments

Base Plan used for results comparison.  Choose the "Disabled - (No Encroachment 
Analysis)" to not run an encroachment.

Target WS Rise Max allowable water surface rise for the encroached floodway.  This value will be 
used to compute a new RAS Terrain to simulate a filling in of the floodplain at the 
water surface edge for 1D and 2D unsteady simulations.

Encroachment Regions If Encroachment Regions (polygons) are specified in the Plan data in RAS Mapper, 
the polygons will be used a eliminate flow up to the specified Target Rise.  If there is 
greater surcharge than the Target Rise it will be evident in the floodplain mapping.

Fill Slope on Terrain 
Modifications

Sloping of fill on the Terrain Modification in the new encroached RAS Terrain layer.  
The base elevation for the Terrain Modification is based on the Target Rise.

Additional Fill on Terrain 
Modifications

Additional fill height added to the Target Rise for creating the Terrain Modification 
for the Encroached RAS Terrain.

Minimum Bank Offset 
Distance

Limits the floodway encroachment to within the specified offset of the channel bank 
stations on 1D cross sections

Get Encroachments from 
Steady Flow Plan

Allows the user to import Left and Right Encroachment Stations at cross sections 
from a Steady Flow simulation into Method 1 data.

Floodway encroachment analysis must be performed using a Base Plan that has identical 
geometry.  Therefore, HEC-RAS will only allow the user to choose a plan that shares the same 
geometry.
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Parameter Description

Overbank Encroachment 
Method

The optimization in Method 5 attempts to maintain floodplain equity either by 
removing conveyance in the left and right overbanks through an (1) Equal 
Conveyance Reduction (based on the encroached water surface) or by (2) Preserving 
the Prior Conveyance Ratio (where prior is the base water surface).

Number of Trials Specifies the number of unsteady simulations for Method 5 runs, when attempting 
to solve for the encroachment.

Method 1 through 5 
(column)

Data needs specified for the encroachment analysis method.

Method (column) Method used for the specified cross section.

Encroachment Regions 
(column)

If geospatial polygons are specified by the Encroachment Region layer, the Left and 
Right intersection with the cross section is specified.

Performing Unsteady Flow Encroachment Analysis
The HEC-RAS encroachment procedure is based on previously calculated natural water surface 
elevations (base plan).  Subsequent simulations utilize the base plan to compare against the 
encroached results.  In general, when performing a floodway encroachment analysis, encroachment 
Method 4 and Method 5 are normally used to get a first cut at the encroachment stations. 
Recognizing that the initial floodway computations may provide changes in water surface elevations 
greater, or less, than the "target" increase, multiple computer trial runs are usually made with 
several "target" values ("K Rise WS") specified in the Encroachment Data Table. 

If an encroachment simulation is being run, the Computation Log File will echo that "1D Unsteady 
Encroachments" were requested.  As shown in the figure below, Method 5 was used for the unsteady 
encroachment analysis with 4 Trials.

After initial trial simulations, the encroachment stations will become more defined. Subsequent 
encroachment runs may be made using a method that specifically sets the Left and Right 
encroachment stations which allows the user to refine the floodway encroachment through detailed 
analysis of changes in the water surface elevations, velocities, and energy.  The final encroachment 
run should be made using a method that specifically sets the Left and Right encroachment stations 
using Method 1 or Encroachment Polygons. 
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While the floodway analysis generally focuses on the change in water surface elevation, it is 
important to remember that the floodway must be consistent with local development plans and 
provide reasonable hydraulic transitions through the study reach. Sometimes the computed 
floodway solution, which provides computed water surfaces at or near the target maximum, may be 
unreasonable in visualizing the mapping results.  Visual inspection of the changes in water surface 
elevations, velocities, energy, and shape of floodway is imperative in the evaluation of the final 
solution to ensure reasonable floodway results and that the target maximum is not exceeded.  

Encroachment Regions

To assist with establishing the floodway, RAS Mapper provides the capability to convert the 
encroachment stations at cross sections into polygons. The procedure to convert computed 
encroachment stations to encroachment polygons is enumerated below.

Open RAS Mapper
Expand the Plans group and Encroachment Plan

Select the Encroachment Regions layer
Start Editing
Right-click on the Encroachment Regions layer and select the Generate Floodway Encroachment Polygons
menu item
Stop Editing

The Unsteady Flow Encroachment Editor will indicate the presence of Encroachment Regions, as 
shown below. If Encroachment Regions are present at a cross section, the Left and Right 
Encroachment Station will be used regardless of the method specified in the "Method" column of the 
data table.
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Viewing Floodplain Encroachment Results
Floodplain encroachment results are available in both graphical and tabular results, both from using 
traditional methods and through RAS Mapper.  The traditional XS Plot is shown in the figure below 
comparing the encroached plan to the base plan.  Similarly, water surface Profile Plot is available.

HEC-RAS Mapper, however, provides much more visualization capability.  Tables, plots, and maps 
are available to assist modelers with encroachment analysis.  The Encroachment Results Table and 
the Encroachment Results Profile plot are available by right-clicking on the Plan Name or on 
Encroachment Regions layer in the Plan's Results group, while an Encroachment Surcharge and 
Velocity Difference maps are automatically generated.

Show Encroachment Results Table

The Encroachment Results Table shows the encroachment stations for each cross section and allows 
the user to compare computed variables such as water surface elevations for the Base Plan and the 
Encroached Plan.  The table allows the user to customize the table based on the output they wish to 
view.  A full list and description of the variable is described below.
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Variable Description

River, Reach, River Station Identifies the cross section

Left Station / Right Station Specifies the Encroachment location for the Left Station and Right Station

Base / Encroached WSE Computed Water Surface Elevation for the specified plan

Delta WSE Computed Surcharge between the Base and Encroached runs (Delta = 
Encroached - Base)

% K Reduced Left/Right Percentage Conveyance reduced in the Left and Right overbanks

K Rise WS Target WS surface used for Method 4 or final value for Method 5

Base/Encroached Top Width Wetted top width of cross section for the specified plan

Base/Encroached Area Wetted area of the cross section for the specified plan

Base/Encroached Velocity Velocity of the cross section for the specified plan

Plot Encroachment Results Profile

The Profile Plot allows the user to quickly identify differences between the Encroached plan and the 
Base plan.  The top plot shows the allowable Target WS Rise with the computed difference between 
the Encroached WSE and the Base WSE.  The change in Energy Grade between the two plans is also 
available.   The bottom of the plot shows the computed water surface profile for both plans.

Encroached Terrain

When an encroachment run is performed, a new RAS Terrain is created using the computed (or set) 
encroachment stations to establish Terrain Modifications.  The Terrain Modification will have the 
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elevations within the modification increase to the specified Target WS Rise.  This will assist the user 
to visualize the change to the floodplain and in computing the amount of fill that may be required, 
should development occur to the floodway fringe.  The new RAS Terrain will be a Clone of the Terrain 
used for the base plan and will have the base Terrain name suffixed with the encroached plan and 
"Encr" (e.g. Terrain.1DEncroached.Encr").

The addition of the Terrain Modification identifies the direct impact of filling in the floodway fringe.  
To investigate the impacts of encroachment to the hydraulic results, tables and plots are available 
via layers in the Results group.  Right-clicking on the Encroachment Regions will provide access to a 
customizable table and plot.

A comparison of the Terrain models with the Encroached water surface is shown in the figure below.

Encroachment Surcharge

An Encroachment Surcharge map is also automatically created.  This map is the water surface 
elevation difference between the Encroached and Base plans.  The Surcharge map can be used to 
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quickly identify locations that do not meet expectations and assist in refining the floodway 
encroachment.  An example Encroachment Surcharge map is shown below.

Velocity Difference

A Velocity Difference map is also automatically created.  This map is the difference in velocities 
between the Encroached and Base plans.  The Velocity map should be used to quickly identify 
locations that may adversely affect the stability of the river floodplain.  An example Velocity 
Difference map is shown below.

Because the Surcharge Map is taken as the difference in the Encroached WSE and the Base WSE, 
it may show shallow depths out in the floodplain where the Terrain Modification has taken 
place.  This is a result of a high water surface that did not meet the Target Water Surface Rise 
criteria and, therefore, would inundate the modification.
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2D Unsteady Flow Floodway Encroachment Analysis
2D Floodway Encroachment analyses can be performed with the unsteady flow computations 
module within HEC-RAS. The 2D approach for encroachment analysis utilizes Encroachment Regions 
within RAS Mapper to establish left and right encroachment locations for 2D unsteady flow 
modeling.

When performing a floodway encroachment analysis, the base information should be consistent, 
meaning that the geometry, flow, and plan data should all be identical.  Identical data allows for a 
consistent evaluation of the impacts to the model results given the encroachment information.  
Therefore, there are some basic guidelines that should be considered.

The geometry must be the same for both the Base and Encroached plans.
The flow data must be the same for both the Base and Encroached plans.  Normal depth, or a rating curve, is 
a good downstream boundary condition as it will account for the change in water surface elevations due to 
changes in flow conditions.
The plan data must be the same for the Base and Encroached plans.
The Base plan must be run prior to running the Encroachment analysis

A summary of the steps performed in 2D Unsteady Flow Floodway Encroachment Analysis is 
provided below.

Create and run a base plan.
Create a new encroached plan.
Create Encroachment Regions in RAS Mapper.
Identify the base plan in the Encroachments editor.
Run the encroached plan.
Evaluate the results
Refine the Encroachment Regions.
Evaluate, refine, run, and repeat, as necessary.
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Unsteady Flow Encroachment Data
Prior to beginning the encroachment analysis, you will need to have simulated a base run and 
created a new encroachment plan.  From the new encroached plan, you will proceed with creating 
the encroachment data.

For 2D unsteady flow encroachment analysis, the Encroachment Regions method is the only 
procedure available.  It is intended that users can perform floodway encroachment analysis on 1D, 
2D, or combined 1D/2D models with a mix of encroachment methods.  However, for portions of the 
2D model domain, Encroachment Regions are the only method to control the floodway analysis.

From the new encroachment plan, access to the Unsteady Flow Encroachment Editor, shown below, 
from the Unsteady Flow Analysis window from the Options | Unsteady Encroachment menu item. 
 In order to enable the encroachment analysis, select the base plan from the "Base Plan for 
Encroachments" list.

A description of the parameters in the Unsteady Flow Encroachment Editor are described below.

Parameter Description

Base Plan for 
Encroachments

Base Plan used for results comparison.  Choose the "Disabled - (No Encroachment 
Analysis)" in order to not run an encroachment analysis.

Target WS Rise Max allowable water surface rise (allowable surcharge) for the encroached floodway. 
This value is used to (1) set the elevation comparison for the surcharge map, (2) set 
the elevation comparison target line in the profile plots, and (3) will be used for a fill 
elevation Terrain Modification for a new RAS Terrain to simulate a filling in of the 
floodplain at the water surface edge for 1D and 2D unsteady simulations.

Encroachment Regions If Encroachment Regions (polygons) are specified in the Plan data in RAS Mapper, the 
polygons will be used a eliminate flow up to the specified Target Rise.  If there is 
greater surcharge than the Target Rise it will be evident in the floodplain mapping.

Fill Slope on Terrain 
Modifications

Sloping of fill (away from the floodway) for the Terrain Modification in the new 
encroached RAS Terrain layer.  The base elevation for the Terrain Modification is 
based on the Target Rise. (This option is implemented to facilitate rain on grid 
modelling for runoff to enter the floodplain.)  This value may be set to 0.

Additional Fill on Terrain 
Modifications

Additional fill height added to the Target Rise for creating the Terrain Modification for 
the Encroached RAS Terrain.

Floodway encroachment analysis must be performed using a Base Plan that has identical 
geometry.  Therefore, HEC-RAS will only allow the user to choose a plan that shares the same 
geometry.
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Performing Unsteady Flow Encroachment Analysis
The HEC-RAS encroachment procedure is based on previously calculated natural water surface 
elevations (base plan).  Subsequent simulations utilize the base plan to compare against the 
encroached results.  To perform floodway encroachment for a 2D model, you will need to create and 
refine Encroachment Regions which will control the movement of water into the floodplain fringe.  
The Encroachment Region will be used to create a Terrain Modification using the Target Water 
Surface Rise to "fill" the floodplain fringe.

The Terrain Modification results in a new RAS Terrain and associates it with the geometry used for 
the floodplain encroachment analysis.  Therefore, each subsequent simulation will require that new 
hydraulic property tables are created.

Data Preparation

Encroachment Regions are an editable layer in the Plan group.  Encroachment Regions are a fully 
editable data layer that may be created manually, imported from shapefile (created outside of HEC-
RAS), or created with a tool in RAS Mapper.  You may wish to create a 1D HEC-RAS model and copy 
encroachment result from that run.  In the end, the goal is to make the Encroachment Regions layer 
flexible to allow you to create the polygons wherever convenient.

Open RAS Mapper
Expand the Plans group and Encroachment Plan

Select the Encroachment Regions layer
Start Editing
Create encroachment polygons
Stop Editing

To assist with establishing the floodway, RAS Mapper provides the capability to convert mapping 
results (from a base plan) to encroachment polygons.   An example for creating encroachment 
polygons can be explained through the use of a Depth*Velocity output layer.

Evaluate the results from a base plan.  In the figure below, a DV map is shown for one of the 
timesteps in the unsteady simulation.  Use the cursor to identify a DV threshold that is of interest.  
There is a plot option on the layer that will contour the map based on the value at the cursor.

Extending the Encroachment Regions beyond the edges of the 2D Flow Area polygons is 
recommended.
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Once an initial value for the floodway has been identified, you can use tools to auto-generate the 
encroachment polygons. The procedure for creating encroachment polygons from existing map 
results is outlined below.

Start Editing the Encroachment Regions layer.
Select the Generate Floodway Encroachments Polygons | From Map Results menu item.

Select the base plan and press OK.
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c.
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ii.
iii.

d.

e.

5.
6.

Provide information in the Generate Floodway Encroachment Polygons dialog.

Select the Map Layer. Only layers in the selected plan are available.
Provide Resample Cell Size (if desired).  Resampling the map results will lead to more approximate 
answers, however, the computation of the encroachment polygons will be faster with a larger cell 
size
Provide a Contour Value. 

A polygon will be created encapsulating all values greater than the contour value. 
The polygon will be intersected with the modeling domain (2D Mesh).
The interior polygon (the river floodway) will then be deleted leaving the Encroachment 
Regions.

Provide a Filter Tolerance (Optional).  If specified, the Encroachment Regions will have a point filter 
applied that looks at three consecutive points, removing the middle point if it falls within the 
tolerance. (A larger value will remove more points than a smaller value.)
Provide a Simplify Tolerance (Optional).  If specified, the Encroachment Regions will be buffered in 
and then buffered out, in an attempt to smooth the polygons (removing "peninsulas" and "islands".  
Points are then filtered using the Filter Tolerance.

Further refinement may be necessary.
Stop Editing and Save edits

The Unsteady Flow Encroachment Editor will indicate the presence of Encroachment Regions, as 
shown below. 
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Simulation

With the Encroachment Regions specified, the Unsteady Flow simulation will be ready to perform the 
computations.  Prior to running the unsteady-flow simulation, HEC-RAS will create a new terrain 
model.  The RAS Terrain will be a Clone of the terrain model associated with the base plan with the 
name suffixed with PlanName.Encr. 

The Cloned terrain model will then have a Terrain Modification created based on the polygon 
boundaries in the Encroachment Regions layer.  The Terrain Modifications will have the elevation of 
the base water surface along the river's edge plus the Target Water Surface Rise and will fill the 
floodplain fringe.  An example of terrain model before and after modification is shown below.

New Hydraulic Table parameters will be computed for the 2D Flow Areas and the unsteady-flow 
simulation will be performed.

Filling of the floodplain fringe with the Terrain Modification may block culverts.  Blocked culverts 
(culverts where the terrain minimum is higher that the culvert soffit) will not run in HEC-RAS 6.4.   
Workarounds include: removing the culvert, adding an additional channel modification, or 
adjusting the encroachment region.  HEC-RAS 6.5 does not have this limitation.
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Viewing Floodplain Encroachment Results
Floodplain encroachment results are available along with standard results through RAS Mapper. 
Encroachment Surcharge and Encroachment Velocity Difference maps are available by default to 
identify areas that meet (or exceed) the desired water surface rise threshold.

Encroachment Surcharge

This map is the water surface elevation difference between the Encroached and Base plans.  The 
Surcharge map can be used to quickly identify locations that do not meet expectations and assist in 
refining the floodway encroachment.  An example Encroachment Surcharge map (needing 
improvement) is shown below.

Velocity Difference

This map is the difference in velocities between the Encroached and Base plans.  The Velocity map 
should be used to quickly identify locations that may adversely affect the stability of the river 
floodplain. An example Velocity Difference map is shown below.

Because the Surcharge Map is taken as the difference in the Encroached WSE and the Base WSE, 
it may show shallow depths out in the floodplain where the Terrain Modification has taken place. 
 This is a result of a high water surface that did not meet the Target Water Surface Rise criteria 
and, therefore, would inundate the modification. (This is evident in the figure above where light 
blue depths are adjacent to red depths.)
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Reference Lines

A traditional profile plot can be generated by creating a Reference Line whereever you would like to 
evaluate the encroachment results.  The Reference Lines are created in the Geometry and must be 
created prior to simulation.  To view results, select the Result and choose the Plot Results Profile
context menu. 

The Plot Results Profile will display the water surface elevation profile for any Reference Lines along 
with a Difference plot with the Target WS Rise. An example plot for a line running down the center of 
the river is shown below.

The plot for a Reference Line that spans the river (a cross section) is shown in the figure below, 
showing the difference in water surface elevations. Note, the Ground line is only plotted for the 
Encroached plan.

You should NOT use the Velocity Difference plot for the Maximum, rather evaluate one of the 
output time steps.  Often, poor velocities (high velocities) will be computed at as the floodplain 
wets.  These poor velocities are considered when evaluation the Maximum, but are erroneous 
and should not be considered in the final analysis.
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11 HYDRAULIC DESIGN (HD) CALCULATORS
HEC-RAS includes a suite of hydraulic and sediment transport calculators called the Hydraulic 
Design tools.  These tools are HEC-RAS post-processors that use results from 1D steady and/or 
unsteady hydraulic computations to perform common, classic, or simplified analyses for hydraulic 
design or sediment transport problems.

This suite of tools is actively expanding, including a new Riprap Calculator and Rating Curve 
Calculator, with more planned for upcoming versions.

To use one of the Hydraulic Design Calculators press the HD button , or select the Run →
Hydraulic Design Functions menu from the main HEC-RAS editor.  The HD editor automatically 
opens to the Bridge Scour tool.  To select any of the other HD calculators, select the Type menu and 
choose one of the other options.

The Hydraulic Design tools currently include the following six hydraulic and sediment transport 
calculators:

Ico
n

Analysis Description

Bridge 
Scour

Applies the US Federal Highway Administration's bridge scour equations and algorithms from 
HEC-18 to a steady flow hydraulics profile 

Riprap Computes a stable rock size for bank protection using the USACE guidance in EM 1110-2-1601 and 
applies a suite of general and bend scour equations to help design toe protection.

Uniform 
Flow

A normal depth calculator, that allows users to apply manning's equation to compute a hydraulic 
geometry without a full HEC-RAS model. 

https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.1/hydraulic-design-hd-calculators/computing-scour-at-bridges
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.1/hydraulic-design-hd-calculators/computing-scour-at-bridges
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.1/hydraulic-design-hd-calculators/riprap-and-scour-calculator
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.1/hydraulic-design-hd-calculators/riprap-and-scour-calculator
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.1/hydraulic-design-hd-calculators/uniform-flow-computations
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.1/hydraulic-design-hd-calculators/uniform-flow-computations
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Ico
n

Analysis Description

Stable 
Channel 
Design

A suite of tools (including tractive force, Lane, and Copeland methods) that compute the hydraulic 
geometry that is in transport equilibrium with the flow and sediment in a channel, or visa versa.

Sediment 
Transport 
Capacity

Simplified calculator that computes sediment transport capacity for a steady flow profile - with a 
suite of sediment transport equations - ignoring supply, flux, or feedback that make a sediment 
transport model both more useful, and more difficult.

SIAM The Sediment Impact Analysis Methods is a sediment budget tool that uses steady flow results 
from HEC-RAS, transport functions, and user specifications of watershed and point-source loads 
to screen sediment impacts alternatives on a watershed scale. 

Sediment 
Rating 
Curve 
Analysis 
Tool

Imports sediment load, concentration, and load-gradation data and leads analysts through 
common statistical and conceptual analyses to help them fit an appropriate rating curve through 
the data cloud. 

Computing Scour at Bridges
The computation of scour at bridges within HEC-RAS is based upon the methods outlined in 
Hydraulic Engineering Circular No. 18 (FHWA, 2001). Before performing a scour analysis with the 
HEC-RAS software, the engineer should thoroughly review the procedures outlined in the Hydraulic 
Engineering Circular No. 18 (HEC 18) report. This chapter presents the data input required for 
computing contraction scour and local scour at piers and abutments. 
For information on the bridge scour equations, please see Chapter 10 of the HEC-RAS Hydraulic 
Reference Manual.

IMPORTANT NOTE: The HEC-RAS software is based on the 2001 version of the FHWA HEC No. 18 
manual. This manual has been modified since that time. However, the HEC-RAS software has not 
been modified to keep up with the changes that FHWA has made to the Bridge Scour document. The 
bridge scour routines have been left in HEC-RAS in order to reproduce previous studies that used this 
software and that version of the HEC No. 18 document.

General Modeling Guidelines
In order to perform a bridge scour analysis, the user must first develop a hydraulic model of the river 
reach containing the bridge to be analyzed. This model should include several cross sections 
downstream from the bridge, such that any user defined downstream boundary condition does not 
affect the hydraulic results inside and just upstream of the bridge. The model should also include 
several cross sections upstream of the bridge, in order to evaluate the long term effects of the bridge 
on the water surface profile upstream.

The hydraulic modeling of the bridge should be based on the procedures outlined in Chapter 5 of the 
Hydraulic Reference Manual. If observed data are available, the model should be calibrated to the 

https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.1/hydraulic-design-hd-calculators/stable-channel-design-functions
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.1/hydraulic-design-hd-calculators/stable-channel-design-functions
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.1/hydraulic-design-hd-calculators/sediment-transport-capacity
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.1/hydraulic-design-hd-calculators/sediment-transport-capacity
https://www.hec.usace.army.mil/confluence/rasdocs/rassed1d/hydraulic-design-functions/sediment-impact-analysis-methods-siam
https://www.hec.usace.army.mil/confluence/rasdocs/rassed1d/hydraulic-design-functions/sediment-impact-analysis-methods-siam
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool
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fullest extent possible. Once the hydraulic model has been calibrated (if observed data are 
available), the modeler can enter the design events to be used for the scour analysis. In general, the 
design event for a scour analysis is usually the 100 year (1 percent chance) event. In addition to this 
event, it is recommended that a 500 year (0.2 percent chance) event also be used in order to evaluate 
the bridge foundation under a super-flood condition. 
The next step is to turn on the flow distribution option in the HEC-RAS software. This option allows 
for additional output showing the distribution of flow for multiple subdivisions of the left and right 
overbanks, as well as the main channel. The output of the flow distribution option includes the 
following items for each flow slice: percentage of flow; flow area; wetted perimeter; conveyance; 
hydraulic depth; and average velocity. The user can control the number of slices in each flow 
element (left overbank, main channel, and right overbank), up to a maximum of 45 total slices. The 
flow distribution output is controlled from the Options menu of the Steady Flow Analysis window 
(see Chapter 7, Simulation Options).

The user must request the flow distribution output for the cross sections inside the bridge, the cross 
section just upstream of the bridge, and the approach section (cross section upstream of the bridge 
at a distance such that the flow lines are parallel and the flow has not yet begun to contract due to 
the bridge constriction). Flow distribution output can be requested at additional cross sections, but 
these are the only cross sections that will be used in the bridge scour computations. The flow 
distribution option must be turned on in order to get more detailed estimates of the depth and 
velocity at various locations within the cross section. Once the user has turned this option on, the 
profile computations must be performed again in order for the flow distribution output to be 
computed and included in the output file.

After performing the water surface profile calculations for the design events, and computing the flow 
distribution output, the bridge scour can then be evaluated. The total scour at a highway crossing is 
comprised of three components: long-term aggradation and degradation; contraction scour; and 
local scour at piers and abutments. The scour computations in the HEC-RAS software allow the user 
to compute contraction scour and local scour at piers and abutments. The current version of the 
HEC-RAS software does not allow the user to evaluate long-term aggradation and degradation. Long 
term aggradation and degradation should be evaluated before performing the bridge scour analysis. 
Procedures for performing this type of analyses are outlined in the HEC No. 18 report.

Entering Bridge Scour Data
The bridge scour computations are performed by opening the Hydraulic Design Functions window 
and selecting the Scour at Bridges function. Once this option is selected the program will 
automatically go to the output file and get the computed output for the approach section, the 
section just upstream of the bridge, and the sections inside of the bridge. The Hydraulic Design 
window for Scour at Bridges will appear as shown in Figure 11-1.
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Figure 11 1. Hydraulic Design Window for Scour at Bridges

As shown in Figure 11-1, the Scour at Bridges window contains the input data, a graphic, and a 
window for summary results. Input data tabs are available for contraction scour, pier scour, and 
abutment scour. The user is required to enter only a minimal amount of input and the computations 
can be performed. If the user does not agree with any of the data that the program has selected from 
the output file, the user can override it by entering their own values. This provides maximum 
flexibility in using the software.

Entering Contraction Scour Data

Contraction scour can be computed in HEC-RAS by either Laursen's clear-water (Laursen, 1963) or 
live-bed (Laursen, 1960) contraction scour equations. Figure 11-2 shows all of the data for the 
contraction scour computations. All of the variables except K1 and D50 are obtained automatically 
from the HEC-RAS output file. The user can change any variable to whatever value they think is 
appropriate. To compute contraction scour, the user is only required to enter the D50 (mean size 
fraction of the bed material) and a water temperature to compute the K1 factor. 
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Figure 11 2. Example Contraction Scour Calculation

Each of the variables that are used in the computation of contraction scour are defined below, as 
well as a description of where each variable is obtained from the output file.

Y1: The average depth (hydraulic depth) in the left overbank, main channel, and the right overbank, 
at the approach cross-section.

V1: The average velocity of flow in the left overbank, main channel, and right overbank, at the 
approach section.

Y0: The average depth in the left overbank, main channel, and right overbank, at the contracted 
section. The contracted section is taken as the cross section inside the bridge at the upstream end of 
the bridge (section BU).

Q2: The flow in the left overbank, main channel, and right overbank, at the contracted section 
(section BU).

W2: The top width of the active flow area (not including ineffective flow area), taken at the 
contracted section (section BU).

D50: The bed material particle size of which 50% are smaller, for the left overbank, main channel, 
and the right overbank. These particle sizes must be entered in millimeters by the user.



Hydraulic Design (HD) Calculators

HEC-RAS User's Manual– 454

Equation: The user has the option to allow the program to decide whether to use the live-bed or 
clear-water contraction scour equations, or to select a specific equation. If the user selects the 
Default option (program selects which equation is most appropriate), the program must compute 
Vc, the critical velocity that will transport bed material finer than D50. If the average velocity at the 
approach cross section is greater than Vc, the program uses the live-bed contraction scour equation. 
Otherwise, the clear-water contraction scour equation will be used.

Q1: The flow in the left overbank, main channel, and right overbank at the approach cross-section.

W1: The top width of the active flow area (not including ineffective flow area), taken at the approach 
cross section.

K1: An exponent for the live-bed contraction scour equation that accounts for the mode of bed 
material transport. The program can compute a value for K1 or the user can enter one. To have the 
program compute a value, the K1 button must be pressed. Figure 11-3 shows the window that comes 
up when the K1 button is pressed. Once a water temperature is entered, and the user presses the OK 
button, the K1 factor will be displayed on the main contraction scour window. K1 is a function of the 
energy slope (S1) at the approach section, the shear velocity (V* ) at the approach section, water 
temperature, and the fall velocity (w) of the D50 bed material.

Figure 11 3. Computation of the K1 Factor

Approach XS River Sta.: The river station of what is being used as the approach cross section. The 
approach cross section should be located at a point upstream of the bridge just before the flow 
begins to contract do to the constriction of the bridge opening. The program assumes that the 
second cross section upstream of the bridge is the approach cross section. If this is not the case, the 
user can select a different river station to be used as the approach cross section.

As shown in Figure 11-2, the computation of contraction scour is performed separately for the left 
overbank, main channel, and right overbank. For this example, since there is no right overbank flow 
inside of the bridge, there is no contraction scour for the right overbank. The summary results show 
that the computed contraction scour, Ys, was 2.06 feet for the left overbank, and 6.67 feet for the 
main channel. Also note that the graphic was updated to show how far the bed would be scoured 
due to the contraction scour.
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Entering Pier Scour Data

Pier scour can be computed by either the Colorado State University (CSU) equation (Richardson, et 
al, 1990) or the Froehlich (1988) equation (the Froehlich equation is not included in the HEC No.18 
report). The CSU equation is the default. As shown in Figure 11-4, the user is only required to enter 
the pier nose shape (K1), the angle of attack for flow hitting the piers, the condition of the bed (K3), 
and a D95 size fraction for the bed material. All other values are automatically obtained from the 
HEC-RAS output file.
As shown in Figure 11 4, the user has the option to use the maximum velocity and depth in the main 
channel, or the local velocity and depth at each pier for the calculation of the pier scour. In general, 
the maximum velocity and depth are used in order to account for the potential of the main channel 
thalweg to migrate back and forth within the bridge opening. The migration of the main channel 
thalweg could cause the maximum potential scour to occur at any one of the bridge piers.
Each of the variables that are used in the computation of pier scour are defined below, as well as a 
description of where each variable is obtained from the output file.

Maximum V1 Y1: If the user selects this option, the program will find the maximum velocity and 
depth located in the cross section just upstream and outside of the bridge. The program uses the 
flow distribution output to obtain these values. The maximum V1 and Y1 will then be used for all of 
the piers.
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Figure 11 4. Example Pier Scour Computation

Local V1 Y1: If the user selects this option, the program will find the velocity (V1) and depth (Y1) at 
the cross section just upstream and outside of the bridge that corresponds to the centerline 
stationing of each of the piers.

Method: The method option allows the user to choose between the CSU equation and the Froehlich 
equation for the computation of local scour at bridge piers. The CSU equation is the default method.

Pier #: This selection box controls how the data can be entered. When the option "Apply to All 
Piers" is selected, any of the pier data entered by the user will be applied to all of the piers. The user 
does not have to enter all of the data in this mode, only the portion of the data that should be 
applied to all of the piers. Optionally, the user can select a specific pier from this selection box. When 
a specific pier is selected, any data that has already been entered, or is applicable to that pier, will 
show up in each of the data fields. The user can then enter any missing information for that pier, or 
change any data that was already set.

Shape: This selection box is used to establish the pier nose (upstream end) shape. The user can 
select between square nose, round nose, circular cylinder, group of cylinders, or sharp nose 
(triangular) pier shapes. When the user selects a shape, the K1 factor for the CSU equation and the 
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Phi factor for the Froehlich equation are automatically set. The user can set the pier nose shape for 
all piers, or a different shape can be entered for each pier.

a: This field is used to enter the width of the pier. The program automatically puts a value in this field 
based on the bridge input data. The user can change the value.

D50: Median diameter of the bed material of which 50 percent are smaller. This value is 
automatically filled in for each pier, based on what was entered for the left overbank, main channel, 
and right overbank, under the contraction scour data. The user can change the value for all piers or 
any individual pier. This value must be entered in millimeters.

Y1: This field is used to display the depth of water just upstream of each pier. The value is taken from 
the flow distribution output at the cross section just upstream and outside of the bridge. If the user 
has selected to use the maximum Y1 and V1 for the pier scour calculations, then this field will show 
the maximum depth of water in the cross section for each pier. The user can change this value 
directly for each or all piers.

V1: This field is used to display the average velocity just upstream of each individual pier. The value 
is taken from the flow distribution output at the cross section just upstream and outside of the 
bridge. If the user has selected to use the maximum Y1 and V1 for the pier scour calculations, then 
this field will show the maximum velocity of water in the cross section for all piers. The user can 
change this value directly for each or all piers.

Angle: This field is used to enter the angle of attack of the flow approaching the pier. If the flow 
direction upstream of the pier is perpendicular to the pier nose, then the angle would be entered as 
zero. If the flow is approaching the pier nose at an angle, then that angle should be entered as a 
positive value in degrees. When an angle is entered, the program automatically sets a value for the 
K2 coefficient. When the angle is > 5 degrees, K1 is set to 1.0.

L: This field represents the length of the pier through the bridge. The field is automatically set by the 
program to equal the width of the bridge. The user can change the length for all piers or each 
individual pier. This length is used in determining the magnitude of the K2 factor.

K1: Correction factor for pier nose shape, used in the CSU equation. This factor is automatically set 
when the user selects a pier nose shape. The user can override the selected value and enter their 
own value.

K2: Correction factor for angle of attack of the flow on the pier, used in the CSU equation. This factor 
is automatically calculated once the user enters the pier width (a), the pier length (L), and the angle 
of attack (angle).

K3: Correction factor for bed condition, used in the CSU equation. The user can select from: clear-
water scour; plane bed and antidune flow; small dunes; medium dunes; and large dunes.

D95: The median size of the bed material of which 95 percent is finer. The D95 size fraction is used in 
the computation of the K4 factor, and must be entered in millimeters directly by the user.

K4: The K4 factor is used to decrease scour depths in order to account for armoring of the scour hole. 
This factor is only applied when the D50 of the bed material is greater than 0.006 feet (0.2 mm) and 
the D95 is greater than 0.06 feet (2.0 mm). This factor is automatically calculated by the program, 
and is a function of D50; D95; a; and the depth of water just upstream of the pier. The K4 factor is 
used in the CSU equation.
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a: The projected pier width with respect to the direction of the flow. This factor should be calculated 
by the user and is based on the pier width, shape, angle, and length. This factor is specific to 
Froehlich's equation.

Phi: Correction factor for pier nose shape, used in the Froehlich equation. This factor is 
automatically set when the user selects a pier nose shape. The user can override the selected value 
and enter their own value.
For the example shown in Figure 11 4 the CSU equation was used, resulting in a computed pier scour 
of 10.61 feet at each pier (shown under summary results in Figure 11 4). Also shown in Figure 11 4 is 
an updated graphic with both contraction and pier scour shown.

Entering Abutment Scour Data

Abutment scour can be computed by either the HIRE equation (Richardson, 1990) or Froehlich's 
equation (Froehlich, 1989). The input data and results for abutment scour computations are shown 
in Figure 11-5.

Figure 11 5. Example Abutment Scour Computations

As shown in Figure 11-5, abutment scour is computed separately for the left and right abutment. The 
user is only required to enter the abutment type (spill-through, vertical, vertical with wing walls). The 
program automatically selects values for all of the other variables based on the hydraulic output and 
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default settings. However, the user can change any variable. The location of the toe of the abutment 
is based on where the roadway embankment intersects the natural ground. This stationing is very 
important because the hydraulic variables used in the abutment scour computations will be 
obtained from the flow distribution output at this cross section stationing. If the user does not like 
the stationing that the model picks, they can override it by entering their own value.
Each of the variables that are used in the computation of abutment scour are defined below, as well 
as a description of where each variable is obtained from the output file.
Toe Sta at Bridge: This field is used to define the stationing in the upstream bridge cross section 
(section BU), where the toe of the abutment intersects the natural ground. The program 
automatically selects a value for this stationing at the point where the road embankment and/or 
abutment data intersects the natural ground cross-section data. The location for the abutment toe 
stationing can be changed directly in this field.

Toe Sta at App.: This field is used to define the stationing in the approach cross section (section 4), 
based on projecting the abutment toe station onto the approach cross section. The location for this 
stationing can be changed directly in this field.

Length: Length of the abutment and road embankment that is obstructing the flow. The program 
automatically computes this value for both the left and right embankments. The left embankment 
length is computed as the stationing of the left abutment toe (projected up to the approach cross 
section) minus the station of the left extent of the active water surface in the approach cross section. 
The right embankment length is computed as the stationing of the right extent of the active water 
surface minus the stationing of the toe of the right abutment (projected up to the approach cross 
section), at the approach cross section. These lengths can be changed directly.

Y1: This value is the computed depth of water at the station of the toe of the embankment, at the 
cross section just upstream of the bridge. The value is computed by the program as the elevation of 
the water surface minus the elevation of the ground at the abutment toe stationing. This value can 
also be changed by the user. This value is used in the HIRE equation.

K1: This value represents a correction factor accounting for abutment shape. The user can choose 
among: vertical abutments; vertical with wing walls; and spill-through abutments.

Skew: This field is used to enter the angle of attack of the flow against the abutment. A value of 90 
degrees should be entered for abutments that are perpendicular to the flow (normal situation). A 
value less than 90 degrees should be entered if the abutment is pointing in the downstream 
direction. A value greater than 90 degrees should be entered if the abutments are pointing in the 
upstream direction. The skew angle is used in computing the K2 factor.

K2: Correction factor for angle of attack of the flow on the abutments. This factor is automatically 
computed by the program. As the skew angle becomes greater than 90 degrees, this factor increases 
from a value of one. As the skew angle becomes less than 90 degrees, this value becomes less than 
one.

Equation: This field allows the user to select a specific equation (either the HIRE or Froehlich 
equation), or select the default mode. When the default mode is selected, the program will choose 
the equation that is the most applicable to the situation. The selection is based on computing a 
factor of the embankment length divided by the approach depth. If this factor is greater than 25, the 
program will automatically use the HIRE equation. If the factor is equal to or less than 25, the 
program will automatically use the Froehlich equation.
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L': The length of the abutment (embankment) projected normal to the flow (projected up to the 
approach cross section). This value is automatically computed by the program once the user enters 
an abutment length and a skew angle. This value can be changed by the user.

Ya: The average depth of flow (hydraulic depth) that is blocked by the embankment at the approach 
cross section. This value is computed by projecting the stationing of the abutment toe's up to the 
approach cross section. From the flow distribution output, the program calculates the area and top 
width left of the left abutment toe and right of the right abutment toe. Ya is then computed as the 
area divided by the top width. This value can be changed by the user directly.

Qe: The flow obstructed by the abutment and embankment at the approach cross section. This value 
is computed by projecting the stationing of the abutment toes onto the approach cross-section. 
From the flow distribution output, the program calculates the percentage of flow left of the left 
abutment toe and right of the right abutment toe. These percentages are multiplied by the total flow 
to obtain the discharge blocked by each embankment. These values can be changed by the user 
directly.

Ae: The flow area that is obstructed by the abutment and embankment at the approach cross 
section. This value is computed by projecting the stationing of the abutment toes onto the approach 
cross-section. From the flow distribution output, the program calculates the area left of the left 
abutment toe and right of the right abutment toe. These values can be changed by the user directly.

V1: The velocity at the toe of the abutment, taken from the cross section just upstream and outside 
of the bridge. This velocity is obtained by finding the velocity in the flow distribution output at the 
corresponding cross section stationing of the abutment toe. These values can be changed by the 
user directly.
In addition to the abutment input data, once the compute button is pressed, the bridge scour 
graphic is updated to include the abutment scour and the summary results window displays the 
computed abutment results. For the example shown in Figure 11-5, the program selected the HIRE 
equation and computed 10.92 feet of local scour for the left abutment and 15.49 feet of local scour 
for the right abutment.

Computing Total Bridge Scour

The total scour is a combination of the contraction scour and the individual pier and abutment scour 
at each location. Table 12.1 shows a summary of the computed results, including the total scour. 
Table 12.1
Summary of Scour Computations 
Contraction Scour
Left O.B. Main Channel Right O.B.
Ys =2.06 ft (0.63 m)6.67 ft (2.03 m)0.00 ft (0.0 m)
Eqn =Clear-Water Live-Bed
Pier Scour
Piers 1-6 Ys = 10.61 ft (3.23 m)
Eqn. =CSU equation
Abutment Scour
Left Right
Ys =10.92 ft (3.33 m)15.49 ft (4.72 m)
Eqn =HIRE equation  HIRE equation
Total Scour
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Left Abutment =12.98 ft (3.96 m)
Right abutment =22.16 ft (6.76 m)
Piers 1-2 (left O.B.)=12.67 ft (3.86 m)
Piers 3-6 (main ch.)=17.28 ft (5.27 m)

Once all three types of scour data are entered, and the compute button is pressed, the bridge scour 
graphic is updated to reflect the total computed scour. Shown in Figure 11-6 is the graphic of the 
final results (the graphic has been zoomed in to see more detail). The graphic and the tabular results 
can be sent directly to the default printer, or they can be sent to the Windows Clipboard in order to 
be pasted into a report. A detailed report can be generated, which shows all of the input data, 
computations, and final results.

The bridge scour input data can be saved by selecting Save Hydraulic Design Data As from the File 
menu of the Hydraulic Design Function window. The user is only required to enter a title for the data. 
The computed bridge scour results are never saved to the hard disk. The computations can be 
performed in a fraction of a second by simply pressing the compute button. Therefore, when the 
Hydraulic Design Function window is closed, and later re-opened, the user must press the compute 
button to get the results.

Figure 11 6. Total Scour Depicted in Graphical Form
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Riprap and Scour Calculator
HEC added the Riprap and Scour calculator to HEC-RAS version 6.1.  This tool computes riprap size 
and gradation and the potential toe scour that the design must account for.  An introductory video 
and the files used in that video are included below.

Introduction and Conceptual Approach

Riprap Calculator: Sizing Rock Gradation

Scour Calculator: Computing Launchable Volume

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=M3AVtQIpcAo

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=USqcACyNpGw

http://youtube.com/watch?v=M3AVtQIpcAo
http://youtube.com/watch?v=USqcACyNpGw
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1.
2.

Introduction and Conceptual Approach

The Hydraulic Design, Riprap and Scour Calculator has two components that track the two main 
tasks associated with bank-protection design.

Size the Rock and Select an Available Gradation
Compute the Potential Scour to Determine the Depth of Toe Protection

HEC developed these calculators together because these computations are often used in tandem to 
determine the size of rock required and the volume of launchable stone required to protect the toe.

Riprap Calculator:

Size Rock and

Select Gradation

Step 1 Run HEC-RAS Steady Flow 
Hydraulics (or compute flow 
depth and width externally).

Step 2 Identify Upstream 
"Reference" or "Crossing" 
Cross Section

Step 3 Compute Radius of 
Curvature and Enter Data

Step 4 Compute d30 of Stable Rock 
Gradation

Step 5 Select Appropriate Riprap 
Gradation and Compute 
Thickness

Scour Calculator:

Compute Key Depth

or Launchable Volume

Step 1* Run HEC-RAS Steady Flow Hydraulics (or compute hydraulic parameters externally).

Step 2*  Identify Upstream "Reference" or "Crossing" Cross Section

Step 3* Compute Radius of Curvature and Enter Data

Step 4 Select Appropriate Equations

Step 5 Compute Ensemble Scour Depths

Step 6 Visualize Results: Select a Toe Station to Plot Bend Scour
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•

Step 7 Select a Reasonable Scour Depth Based on Calculations, Regional Geology, and 
Engineering Judgement

Step 8 Use Selected Scour Depth to Compute Volume of Launchable Rock or Depth of Stone 
Key

The Riprap and Scour calculations share steps 1-3
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Riprap Calculator: Sizing Rock Gradation
The Riprap Calculator in the current version of HEC-RAS follows the approach described in the 
USACE Engineering Manual EM 1110-2-1601: Hydraulic Design of Flood Control Channels (USACE, 
1994). The design approach is outlined in Chapter 3 of EM 1601 and is based on the work of Dr. 
Stephen Maynord.  

See also, Maynord (1992) "Riprap Resistance Tests From a Large Test Channel" 
and
Maynord S., Ruff, J., and Abt, S. (1989) Riprap Design, ASCE Journal of Hydraulics..

The recommended approach is based on a series of experiments conducted at the Engineering 
Research and Development Center (ERDC, formerly Waterways Experimentation Station – WES) 
Riprap Test Facility, which measured rock stability in a series of bends in a mesoscale flume 
(pictured below).

https://www.publications.usace.army.mil/Portals/76/Publications/EngineerManuals/EM_1110-2-1601.pdf
https://erdc-library.erdc.dren.mil/jspui/bitstream/11681/10724/1/MP-HL-92-5.pdf
https://ascelibrary.org/doi/abs/10.1061/%28ASCE%290733-9429%281989%29115%3A7%28937%29
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The general workflow of the USACE riprap design approach is illustrated in the figure below:
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Future versions of HEC-RAS will include other Riprap sizing methods.
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Step 1: Calculate Hydraulics and Select Profile

Compute Hydraulics

HEC included the Riprap calculator into HEC-RAS because many engineers sizing riprap use HEC-RAS 
to compute hydraulic parameters required for riprap design.  The Riprap Calculator opens the 

Limitations

The EM 1601 design guidance applies to riprap design for open channels not immediately 
downstream of stilling basins or other highly turbulent areas (for stilling basin riprap, use HDC 
712-1, EM 1601 Plates 29 and 30).
Transitions in size or shape may also require riprap protection. The procedures in this calculator 
are applicable to gradual transitions where flow remains tranquil. In areas where flow changes 
from tranquil to rapid and then back to tranquil, riprap sizing methods applicable to hydraulic 
structures (HDC 712-1) should be used. In expanding transitions, flow can concentrate on one 
side of the expansion and design velocities should be increased. For installations immediately 
downstream of concrete channels, a vertical velocity distribution coefficient of 1.25 (an option in 
the calculator) should be used due to the difference in velocity profile over the two surfaces.
Both the EM 1601 riprap computation and HEC-RAS model application are suitable for shallow 
slopes with gradually varied flow. As the Froude number approaches 1.0 (critical depth), the user 
should strongly consider alternative methods. For steep slopes ranging from 2 to 20 percent 
where unit discharge is low, EM 1601 presents a separate design process that is not included in 
the riprap calculator.  A typical application is a rock-lined chute (EM 1601 section 3.7 (e)).
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output associated with the active steady flow plan.  Therefore, the user must select the appropriate 
plan and run the simulation before launching the Riprap Calculator.

Open the Riprap Calculator from the Hydraulic Design Menu

The Riprap Calculator is part of the Hydraulic Design tools. The Hydraulic Design suite is a collection 
of calculators, tools, and post processors that apply river mechanics and river engineering analyses 
to HEC-RAS results.

To Launch the Hydraulic Design Editor, select the HD icon from the Main HEC-RAS menu  or 
select the *Run →  Hydraulic Design Functions…* menu.
From the Hydraulic Design editor, Select Type to get a list of the different HD calculators and tools, 
and select the Riprap and Scour Calculator from that list.

Finally, select the appropriate steady flow profile for the rock size analysis. The Riprap calculator can 
only compute rock size for one steady flow profile at a time. If your plan has multiple profiles select 

Note: Use a Calibrated Hydraulic Model for These Calculations

Riprap and scour calculations will only be as good as the hydraulic calculations that they are 
based on. Additionally, because these calculators not only utilized depth, but also velocity, they 
will be sensitive to hydraulic roughness, ineffective flow areas, and other hydraulic parameters, 
even though the user does not enter these directly into the calculators. The hydraulic model 
should be calibrated at or near the design flow before the hydraulics are used to compute riprap 
and scour.  If you have an unsteady flow run, determine the flow rate that results in the design 
condition, then develop a steady flow file and steady plan file for that flow condition.
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the appropriate profile in the dropdown box at the top of the calculator.

Select Design Flow

The USACE riprap sizing approach uses a different design flow for braided and unbraided systems. 
The first step of the riprap analysis workflow is reproduced below:

If the channel is not braided, the design discharge (Qd) should be the flow that generates the 
maximum channel velocity. This is often bank-full flow. But it is important to test larger, less 

frequent flows as well. You can use the Hydraulic Rating Curve Tool  in HEC-RAS to evaluate 
the maximum channel velocity. Right click on the plot to change the "Y Variable" to Vel Chan:

However, flow-velocity relationships do not always have a clear maximum like the example above. 
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Velocity often increases with flow, with no convenient or obvious maximum or critical condition.

In these cases, the project team must select a design flow based on risk and uncertainty principles 
and cost-benefit analyses.  Evaluating several flows, including the channel forming discharge, 
bankfull flow, 1.5-2 year event, and important design floods (e.g. 10%, 2%, and/or 1% Annual 
Exceedance Probability) can help the project delivery team evaluate the rock size and costs 
associated with different risk levels.

If the channel is braided, EM 1110-2-1601 recommends selecting the minimum flow that inundates 
the bars in the channel for riprap design.  EM 1110-2-1601 provides additional considerations for 
application on braided channels with impinging flow in section 3.7 (5). 

Once you have identified the design flow, run steady flow hydraulics with that flow (or flows) and 
select the profile associated with each flow in the Riprap Calculator (blue arrow in figure below).

Warning: Be Careful Using Models Developed Flood Risk Analysis

Many HEC-RAS projects are developed for flood risk management or flood insurance mapping 
applications.  The riprap design flow is often closer to the bankfull condition.  Riprap and scour 
protection features often require a new HEC-RAS geometry with hydraulic model parameters 
selected for reasonable estimates of project design velocity in the Riprap Calculator. 
 Considerations include seasonal roughness variation, expansion and contraction coefficients, 
ineffective flow area, blocked obstructions, looped rating curve effects, and other HEC-RAS 
model parameters.  



Modeling Note:

The critical hydraulic condition governing riprap sizing may not coincide with the peak flow rate. 
In some cases lower flow rates during a rising limb of a flood hydrograph will generate in higher 
velocities than peak flow conditions where storage areas have filled and submerged backwater 
conditions may have developed.
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The Riprap 
Calculator will automatically populate the average velocity, depth, and width associated with the 
Upstream Reference Cross Section, and XS Hydraulics (channel or full cross section) selected. 

Overriding HEC-RAS Results

The riprap calculator only uses three hydraulic parameters from HEC-RAS, making the tool easy to 
use with or without a steady flow simulation. To use the calculator without HEC-RAS results, open 
the HD editor without a simulated plan.

Alternatively the user can overwrite HEC-RAS results. In the HD editors, if a user replaces a hydraulic 
parameter that the tool generally reads from HEC-RAS output, the calculations update based on the 
change. But the Riprap and Scour Calculator will update the value from green to red, to indicate that 

the value has changed.
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Step 2: Identify Design and Upstream Reference XSs

Choose the River, Reach, and River Station of the design and reference cross sections in the Edit tab 
above the main riprap calculator.

Select the Design Cross Sections

The Design Cross Section should be the cross section that will exert the highest hydraulic forces on 
the bank. This will be the critical condition for rock mobility, and will determine rock size. 
The critical cross section location is generally on the outside and downstream end of a bend.

Select the Reference Cross Sections

The USACE Riprap equation is based idealized 1D measurements. A schematic of the ERDC Riprap 
test facility - used to develop these equations - is included below. The stable rock size in the bends 
was not correlated to local velocities, or even the average velocity in the bend, but in a straight, 

Note:

The USACE riprap calculation is only based on the reference cross section. It does not use the 
design cross section anywhere in the calculations. But you still must identify a design cross 
section to compute the radius of curvature and it is just good design and engineering practice to 
identify the worst-case design location. The Scour Calculator does use the design cross section in 
its calculations.
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symmetrical, idealized reach upstream of the bends.

To respect the assumptions of the analysis and transfer these mesoscale laboratory data to field 
applications, we must not only use 1D cross-section average velocities, but 1D velocities in a 
relatively symmetrical, idealized reach upstream of the bend.

The figure below identifies an idealized design and reference cross section. The design cross section 
is highly asymmetrical, with a deep pool on the outside of the bend. This cross section shape is the 
result of helical flow and multi-dimensional processes. An average XS velocity from this cross section 
is not appropriate for the empirical equations used in this calculator. The "crossing" or "run" cross 
section upstream has a more symmetrical geometry. One-dimensional, cross section averaged, 
velocities at this cross section are a better approximation of system velocities and the analysis 
assumptions.
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The next figure shows the selected design ("evaluation") and reference cross sections for an actual 
USACE study on the American River (Howard et al., 2021). 

Hydraulic Averaging Assumption

HEC-RAS can provide two average velocities for the Design and Reference Cross Sections. The model 
can average velocity over the entire cross section (including channel and flood plains/overbanks) or 
it can report an average velocity for the channel alone (the region of the model between the bank 
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1.

2.

3.

4.

stations ).

The riprap experiments used the entire cross section, but only used idealized, trapezoidal channels. 
They did not consider or measure results from compound channels. Therefore, qualitative 
engineering judgement is often required to apply these results to natural, compound channels. The 
channel velocity will usually be more appropriate for this analysis and is the default.

Results will be sensitive to the reference cross section selected, so Sensitivity Analysis are 
recommended (see section on the persistent d30 tool).

The Riprap and Scour Calculator use the same design and reference cross section. These are global 
options that affect both tabs.

Summary of Hydraulic Modeling Considerations for Riprap Analysis

 The typical USACE project design approach is to select the critical velocity / stone size from the reference 
and design cross sections for an entire reach and use that for rock size, gradation, and construction plans. 
Most USACE projects will use only one or two riprap gradations for the entire project to be economical from 
the quarry and for constructability
The user often will create a geometry with modified parameters (ineffective flow, roughness, expansion / 
contraction coefficients) to compute the best estimate velocity for use with the calculator.
Converting unsteady flow models to steady flow for application with the Riprap calculator will often require 
revised model calibration. 
Run a full range of frequency profiles to select the most critical design condition with informed user choices 
for risk tolerance. 

Modeling Note:

It is important that bank stations are defined appropriately for the riprap design flow. Bank 
stations that have been set based on the low-flow channel may need to be revised to reflect the 
effective main channel for the design condition. 



https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.1/hydraulic-design-hd-calculators/riprap-and-scour-calculator/riprap-calculator-sizing-rock-gradation/step-5-select-gradation-to-compute-thickness#id-.Step5:SelectGradationtoComputeThicknessv6.1-d30CrossSectionSensitivityAnalysis
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Step 3a: Define Manual Input Variables

The Riprap Calculator requires five additional measurements and parameters that do not come 
directly from HEC-RAS results. Three of those parameters populate with default values, two require 

user input:

Radius of Curvature (R)

Both the riprap and scour equations are based on a dimensionless ratio of the radius of curvature to 
the channel width (R/W) which is a relative measure of bend severity. HEC-RAS will compute the 
width of the selected cross section. The numerical width is the wetted top-width between the 
channel banks (or the distance between the channel banks if the entire channel is inundated).

You must compute and enter a Radius of Curvature which quantifies the severity of a bend.

An example of the Jones Creek Bend on the Brazos River in Fort Bend County, Texas is included 
below. A circle was fit to the bend in Google Earth, which reported the radius. This bend has a radius 
of curvature of 1,155 ft and a channel width of 410 ft for an R/W ratio of 2.8. The riprap and bend 
scour calculations are all very sensitive to the R/W ratio. Therefore, identifying the appropriate radius 
of curvature, and carefully distinguishing the curvature scales of compound bends (see next section) 
will affect results.
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Computing the Radius of Curvature

You can compute the radius of curvature in a GIS, but Google Earth also has all the tools you will 
need to measure this input. The Radius of Curvature computation has three steps:

Delineate the critical bankline, which is usually on the outside of the downstream third of the bend.
Fit a circle to the critical section of the bend where the bend scour equation will be applied.
Compute the radius of that circle.

The following figure illustrates an example radius of curvature calculation.

Modeling Note: Radius of Curvature Extent

Different agencies and manuals of practice measure the radius of curvature differently.  Some 
extend the circle that measures this radius to the edge of the bank.  Others extend it to the 
centerline of the river.  This variability in practice is part of the uncertainty in these calculations.
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Compound Bends

Some bends do not have simple geometries, making it difficult to fit one, idealized circle to the bend. 
Bends that curve on multiple scales are called "compound bends." Brice (1974) Brice, J. (1974) 
"Evolution of Meander Loops" Geological Society of America Bulletin, 85, 581-586. illustrated and 
classified several examples of compound bends in the figure below:

The following figure includes an example of a compound section, which includes river bends at 

https://watermark.silverchair.com/i0016-7606-85-4-581.pdf?token=AQECAHi208BE49Ooan9kkhW_Ercy7Dm3ZL_9Cf3qfKAc485ysgAAAuwwggLoBgkqhkiG9w0BBwagggLZMIIC1QIBADCCAs4GCSqGSIb3DQEHATAeBglghkgBZQMEAS4wEQQM-K5e5JfeQnUeTX4-AgEQgIICn7v5cnNEL39_06qdh-FBSvgBoYiVgefna0S5SQlUmcycg3sXDsLx8zKEKsfJG9cnOIxrU-OXX_xV8odl8CEG4dcleZmdmgb8CiTnTLxnm_-P1DyvPqt8Mn-UuMH8SCJmWEcPLEsDCFxSj8uK_qj-5rRzGhU_AYpMlskHdqpX0PXF3c2VtzO17HN24QH1TiOU4IMSW6dOyIq2_oXLnUNWD5dF7vqF_S-iJ0oQeJRrAOChZ2fmfJhEAiQumyf_Yem6pjcsjjUUaDfJ3EJ5wiEt6mo4YyniBOJXp15Bk2oD__nb9ED3DrPFGuff2QXhEcVuUXJSgI9g7Sej_puy2XPk5bKTzBzEbp_1yK6_IXQf-k5IyRKcAhLAJRMMYbGLVtZ9g8timeXWtjjYYcV5jlKj8OGggiukuA13HdcqSMGhdsJVpPG2OjYgYgXl-6WWc-QQjglSPJqEPJ_aGzGe3iyGJaR-R4RApgI1luZ4BQQ9BCfHFPIx9lhiERBRUHjnQBBaKyZ3iA3wjY9KPbraNaRA2bNAbf9E8LMR8jZe3GZyCWWWDaU1JsEav1t7G_Vrhl4gV9-QxMEprdwB6KfZkAefdFgXYXzKnrt1kBsj_o6zqYphW1DGm62magQIKainJ7NrkevpHa9hYA1UnpvxSeLjjkcBtrSxAaifMyiW7h-K3G-I-87ZV2HqiJpXxrYgA4mLxv4Uswgy9FS8CiC0SHRWOXwV1Wy_dGIZ4ig3Sxt5RSZElN3nFYEbFgyJ3xukcxo_p70riH2voTRNoLPLYempmHo0GZbjgJ8x_5WEhO2IzVxj19DCx65670F2zqEgIEgP0vV1g7ZiyytWFhb5y6VYTR05-1bS638h237j8-al5zcgjQXrGELeM5PrlxatHGFS
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multiple scales (David May, personal communication). It is important to select the bend radius (and 
scour) at the critical location on a compound bend and the critical (usually the smallest), associated 
radius of curvature. 

Radii of curvature appropriate for bend scour analysis on different locations along a compound 
bend. The section most susceptible to scour is often the downstream, outside bank of a tight sub-
meander (the critical radius in the image).
It can be useful to compute stable rock size and scour at several locations within a compound bend 
to identify the critical location.

For more radius of curvature guidance and examples, see the detailed discussion in the National 
Cooperative Highway Research Program (2004) Handbook for Predicting Stream Meander Migration 
and Supporting Software.

Side Slope ( )

There are three common and interchangeable ways to define the side slope angle in engineering and 
architecture. HEC-RAS usually uses the ratio of horizonal distance to vertical rise (H:V) or the inverse. 
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The Riprap Calculator requires the bank side slope in degrees.  Equations for converting V:H or % 
slope measurements to degrees (and back again) are included in the next section.

Converting Side Slope (Degrees, V:H, Percent)

Engineering and architecture use three interchangeable methods to quantify slope: degrees, V:H, 
and percent. The following equations and table will help you convert between them.

Safety Factor (FS)

HEC-RAS sets the safety factor to 1, by default. This provides the unfiltered results of the equation, 
and allows the user to make their own choice about the risk tolerance built into the Factor of Safety.

However, USACE Guidance (EM 1110-2-1601) recommends setting the Factor of Safety to 1.1.

The riprap calculator will multiply the calculated d30 by the factor of safety (so FS=1.14 will increase 
the d30 by 14%), increasing the W30 by approximately 50%.  EM 1110-2-1601 includes several 
considerations that should lead a project team to increase the Factor of Safety.

Unit Weight

HEC-RAS uses the unit weight to convert riprap diameter to dry placement weight, using the 
equation:

This is only used if the user requests results and gradations in terms of weight, instead of rock size 
(which is a common convention in riprap design).
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Angle of Repose ( )

The angle of repose is the angle of the maximum slope an aggerate develops before it starts to move. 
It is a function of the size, compaction, and angularity of the material. Riprap tends to vary between 
35 and 45 degrees. HEC-RAS populates a default of 40o.

The riprap calculation only uses the angle of repose in the 
analytical calculation of K1.

 Angle of Repose diagrams from Simons and Senturk and the NRCS Engineering Handbook

Modeling Note: Spherical Particles

The weight-diameter conversion assumes spherical particles.  The volume is approximately half 
of an equivalent cube with edges matching the diameter. Some methods suggest using a ratio of 
75%-85% of the equivalent volume of a cube, which would increase the weight or a stable 
particle diameter. Applying the assumption of angular riprap in the calculations does not affect 
the weight-diameter relationship.
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Step 3b: Select Riprap Coefficient Parameters

The riprap equation has several empirical coefficients or coefficient equations that the riprap 
calculator selects based on user options in the Edit ribbon:

These options translate into the following equation coefficients, equations, and parameters in the 
d30 calculation described in the Step 4:

These parameters and equations will be discussed in more detail in the next section on the d30
calculations, but are briefly described below:

Channel Type: 
Choose Natural for a non-engineered channel with native materials in the bed and banks and some 
bank vegetation. Chose Trapezoidal for an engineered channel. The riprap calculator will choose the 
equation to compute the side slope velocity based on this selection. The calculator will generally 
compute higher side slope velocities for trapezoidal channels for all observed bends (as long as R/
W>1).

Rock Type: The Stability Coefficient (Cs) was the original coefficient in the riprap equation. This is a 
linear coefficient in the equation, and is 0.3 for rounded rock (e.g. natural river stone and cobbles) 
and 0.375 for angular rock (e.g. riprap).

Site Alignment: The riprap calculator will also require a larger d30 if the site alignment deviates from 
a straight channel. This option selects the Vertical Velocity Distribution Coefficient (Cv) in the 
riprap equation, which is 1 for straight channels and 1.25 for locations where the channel transitions 
Images?
from an engineered section to an un-protected section (downstream of a concrete lining or the end 
of a dike. At the outside of the bend, it computes the Cv coefficient based on the logarithm of the R/W 
ratio:

Warning

Community partners, project biologists, and landscape architects will often advocate for 
rounded river rock instead of angular, crushed riprap because it is aesthetically appealing. It is 
important to carefully account for rock type in the stability analysis. According to this equation, 
rounded rock must be 25% larger and 100% heavier (weight increases to the cube power of 
diameter) to provide comparable protection.
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This value falls between 1 and 1.22 for 2<R/W<25. If R/W>25 the 
equation computes Cv less than 1, but the Riprap Calculator enforces a minimum value of Cv=1.

K1 Method: The riprap equation incudes a Side Slope Correction Factor (K1). This factor is in the 
denominator of the Maynord equation and is a function of a trigonometric function of the side slope 

angle ( ), making the rock size directly related side slope (e.g. steeper slopes require larger rock).

Early approaches used a relationship between the side slope angle and the angle of repose from 
Carter, Carleson, and Lane (1953):

This is the "Analytical Approach" in the Riprap Calculator.

But the USACE Manual of Practice (EM 1110-2-1601) follows Maynord (1988), who found this 
relationship too conservative, and unhelpfully dependent on the angle of repose – which is 
uncertain. Therefore, the USACE recommended approach selects K1 based on a recommended curve 
from Plate 39 in EM 1110-2-1601:

This is the "Graphical Approach" in the Riprap Calculator, which is the default.

Note:

Increasing the side slope has a direct, gravitational, impact on side slope rock size. But the K1
factor is also included in the bed size equation. This effect is less direct.



Note: Slope Angle Approaching Angle of Repose

In some riprap sizing methods, as the side slope approaches the angle of repose, the required 
rock size approaches infinity because the rock is at the critical conditions for incipient motion.
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Step 4: Compute the d30 of the Stable Rock Size

The Riprap Calculator uses the Maynord equation to compute riprap size. The Maynord equation 
computes the 30th percentile rock size that should remain stable at the design velocity on the 
channel bed and on the side slope. Because of the gravitational component, the stable rock size on 
the side slope will be larger than the bed.

Computing Side Slope Velocity (Vss) and Depth (Dss)

The Riprap Calculator uses the average channel velocity (V) and the hydraulic depth (D) from the 
upstream reference cross section to compute the riprap size on the channel bed. Then it computes 
modified side slope velocities (Vss) and depth (Dss) from V and D to compute the stable d30 on the 
side slopes.

The Maynord equation computes the side slope velocity and depth based on a point located 20% of 
the length up the slope from the toe along an idealized wetted bank (based on the user entered side 

slope). The riprap calculator 
computes Dss with simple trigonometry (see next section).

Vss Calculation

Computing the velocity at this critical side slope location (Vss), from the 1D, channel-averaged 
velocity is not intuitive. EM 1110-2-1601 includes two empirical equations, based on measurements 
at this side slope location, from the Riprap Test Facility. The riprap calculator determines which 
equation to use based on whether the user selects Natural or Trapezoidal channel:

The Riprap Calculator uses the following relationships to compute the ratio of the side slope velocity 
to the average channel velocity (Vss/Vavg). Because the side slope velocity (Vss) is assumed to be at 
the outside of the bend, the side slope velocity should be greater than or equal to the average 
velocity (Vss≥Vavg). Therefore, when the logarithmic Vss/Vavg relationships drop below 1, the Riprap 
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Calculator sets Vss=Vavg.

Dss Calculation

The Riprap Calculator computes the depth 20% up the idealized side slope with simple trigonometry 
based on the side slope angle and the depth in the main channel:

This equation can also be formulated in terms of a V:H 

slope:
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The Maynord Equation

USACE guidance uses the Maynord equation to compute the minimum riprap size. This equation 
computes the 30th percentile grain size of the recommended rock gradation. The Maynord equation 

is: Where:
       SF = Safety Factor (USACE recommended = 1.1)
       Cs = Stability coefficient for incipient failure (0.3-0.375)
       Cv = Vertical velocity distribution coefficient (≥1.0)
       D = Depth (either Davg for bed or Dss for side slope) (ft, m)
       V = Velocity (either Vavg for bed or Vss for side slope) (ft/s, m/s)
       gw = Unit Weight of Water (lb/ft3, kg/m3)

       gs = Unit Weight of solids (lb/ft3, kg/m3)

       g = Gravitational constant (ft/s2, m/s2)
       d30 = 30th percentile of recommended riprap gradation (computed in ft, reported in in, mm)

The Riprap Calculator applies this equation in the bed and banks, applying the appropriate depths 
(D) and velocities (V) in each equation

The calculator uses the hydraulic depth (Depth) and the average velocity (Vavg) to compute the 
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d30(Bed) in the bed. It uses the side slope velocity (Vss) and side slope (Dss) depth (computed 20% up 
the bank slope) for the side slope d30(SS).

Step 5: Select Gradation to Compute Thickness

The Maynord equation and the Riprap Calculator compute a stable d30. However, you will have to 
select a gradation to find the d50 and d100 required to compute the design riprap thickness. The 
Riprap Calculator uses an interactive plot tool to select a gradation for the bed and side slope 
computations, to complete the analysis.

Select a Gradation to Compute Thickness

The Riprap Calculator plots the computed d30s with the selected or user-input gradations. To 
associate a gradation with the bed or side slope analysis, click the radio button under Selecting, and 
then click on the curve or polygon associated with the gradation.

Note:

The Maynord equation and EM 1110-2-1601 also include a thickness coefficient CT. But CT=1 for 
the recommended thicknesses of Max(1.0d100 or 1.5 d50) which is the reported thickness in the 
Riprap Calculator. Therefore, the interface and documentation do not include this coefficient.
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You can also toggle between the selected gradation with the Bed and Side Slope options in the 
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Gradation ribbon: When you click on a gradation curve or polygon in the plot, 
to associate it with the bed or bank riprap calculations, the calculator will pull the d50 and d100 from 
the curve or area. It will use these sizes to compute the thickness.

EM 1110-2-1601 recommends sizing the riprap thickness to the d100 or 150% of the d50. Therefore, 
the riprap calculator reports the d100 of each selected gradation and the thickness (maximum of d100
or 1.5 d50).

d30 Cross Section Sensitivity Analysis

The computed d30 is often very sensitive to the reference cross section selected. Selection of a 
reference cross section is a qualitative judgement, so it is appropriate to evaluate the sensitivity of 
the result to that decision.

HEC added a "persistent d30" feature to the plot,  like the persistent XS 
tool in the cross-section editor to support XS-sensitivity analysis. For example, the plot below 
includes results for three, candidate, Upstream Reference cross sections. The grey dots indicate d30
results from previous selected cross sections, showing the sensitivity of the d30 calculations to the 
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Reference Cross Section selection.

Add New Gradations

The Riprap Calculator includes a few sample gradations to allow initial thickness computations 
without customized gradations. The default gradations are theoretical riprap size curves from EM 
1110-2-1601, which will fill out a d100 and thickness, but are very limited for design.

It is strongly recommended that users enter the gradations available at local quarries or from local 
suppliers.

To define (or manage) riprap gradations, select the Gradation tab (see below) or press the 

Gradations button at the bottom right of the plot. 
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Define a new gradation by pressing New Gradation  on the Gradation tab or 

pressing the Gradation button. 

The editor for entering a new gradation curve is included below:

You can define a gradation curve or polygon (under Gradation Type – see below) and can define 
percent finer or percent lighter. Users can also change the Name of the gradation or material. The 
editor reads the unit weight - which the calculator uses to convert size-to-weight – from the main 
editor.
A new gradation automatically populates three default grain size percentiles d30, d50, d100. Users can 

add or delete these using the + and – buttons. 

Gradation Curves

A Gradation Curve has a single weight or size associated with each grain-class percentile.  It does 
not include a range and can be represented with a single curve.  While the default gradations are 
polygons, representing a range, the new gradations default to Curves, reflecting a single value for 
each percentile.

Warning

The dxx values are editable, but for the Riprap Calculator to work, a gradation must include a 
minimum one gradation ≤d30 and a d100.



Warning

 Percent finer should Always be defined in terms of particle weight rather than particle count. 
The % finer is the % of the total weight that is finer than a particular grain size or weight of rock 
not the number of particles. See further discussion and guidance below.
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To select this approach set Gradation Type to Curve:  .

Gradation curves are monotonic relationships between grain class percentile, (e.g. d30, d100, etc) and 
either size of weight.

In the example below, the user added a d0 and a d85 to the default gradations to define a five-point 
curve:

The gradation editor automatically converts size to weight (and visa versa) and stores them 
together, so the interface can toggle between them. The riprap calculator enforces a standard 
relationship between size and weight based on the equations:

Where W% is the weight percentile, gs is the unit weight, and dxx is the grain class percentile.
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Gradation Polygons

Use gradation polygons for quarry gradations and rock specifications defined with a range of sizes or 
weights for each size percentile:

Managing Gradations

Manage gradations by pressing the gradation button on the main window of the Riprap Calculator. 

The gradation button launches a riprap gradation editor which allows 
users to preview gradations and turn them on and off.

Note:

If you represent a USACE district and have standard gradations you would like to include in the 
Riprap calculator, please contact HEC.
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Press the Apply All button to add or remove these gradations from the riprap gradation display on 
the main riprap editor.

The default gradations come from EM 1110-2-1601, the USACE guidance on riprap design.  The riprap 
editor can get cluttered with too many gradations, so the tool starts with every second EM1601 
gradation activated.  Use the check boxes to turn gradations on and off to get the best resolution 
around the computed d30s.

The example below includes bank and side slope d30 calculations at the bottom of the range of these 
default gradations.  The top pane plots these d30s with every other EM1601 gradation (the default 
visualization).  The bottom pane replaces these with the finest five gradations to provide better 
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resolution around the computed values.

Percent Finer by Weight

All gradation percentiles (e.g. d30) in riprap analysis should be specified in terms of percent-finer by 
weight (e.g. the d50 is the particle size that for which 50% of the aggregate weight has smaller 
diameters). Most standard sieve analyses are reported in percent-finer by weight because the weight 
of material on each sieve is measured. However, particle counts and some surrogate grain size 
measurements can report grain size in percent-finer by count (e.g. 50% of the particles counted are 
smaller than the d50).

The example below for a hypothetical sample of 24 stones illustrates the importance of defining 
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percent-finer in terms of the weight of the finer material, not the particle count. The median particle 
size by count is less than half the median particle size by mass in this example.
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Rock Size and Weight Specifications

Most sediment and geotechnical analyses that quantify soil or rock gradations deal with rock and 
soil size in terms of diameter. However, riprap design often specifies rock size in terms of the weight 
of the rock because rock weight is a more direct measurement of the protection provided.

The Riprap Calculator converts between size and weight calculations in several places. The Size/
Weight toggle in the Edit menu sets the approach in most of the interface:

Weight mode reports the 30th and 100th percentile particle in weight units (W30 and W100) but 

Modeling Note:

The documentation accompanying some riprap sizing methods implies that the percent finer 
refers to the number of stones; however, this assumes that the count is conducted by sampling a 
single particle at regular intervals, which corrects for the presence of multiple smaller particles 
that are not counted. Any documentation referring to “half the particles” assumes the term “by 
weight,” whether or not it is explicitly stated. -Modeling Note provided by Krey Price
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converts the W50 and W100 to d50 and d100 to compute the layer thickness (Max (d100, 1.5d50)), which it 
reports in length units.

The Riprap Calculator uses the following equations to covert between Size and Weight: 

Where W% is the weight percentile, gs is the unite 
weight, and dxx is the grain class percentile.

Limitation: Why Doesn’t the Riprap and Scour Calculator use 2D Results?

One of the first questions that arises around these analyses is "why are they limited to one 
dimensional hydraulics?" HEC-RAS is moving to multi-dimensional hydraulics and many projects are 
modeled exclusively with 2D. It might seem counter-intuitive to build a 1D model to compute the 
kind of local velocities required for scour and riprap calculations, when a 2D depth and velocity field 
would be superior.

While 2D depths and velocities would be more precise, they are not appropriate for the equations. 
Both the riprap and scour equations are simple, empirical, equations based on cross-section 
averaged velocity measurements. In most cases, stable rock size and scour depth are not even 
correlated with the local depth-average velocities, but an idealized, upstream, depth-averaged 
velocity.

Because these equations are so empirical, they must be used in the manner they were developed. 
Plugging local, 2D depths and velocities into these equations developed for idealized, upstream, 
crossing, 1D, velocities violates the assumptions of the equations and is not likely to improve model 
performance over 1D hydraulics. To use 2D hydraulics with this calculator, a modeler must use a 
transect to compute a cross-section average hydraulic depth and velocity at an upstream reference 
cross section, and input it manually into the calculator.

The adjustments that are applied to the average channel velocity in the Maynord equation are 
intended to represent both horizontal variability (accounted for in 2D models) and vertical variability 
(not accounted for in depth-averaged 2D models) in the water column that affects localized 
hydraulic conditions and riprap stability.

Maricopa Method

The latest version of HEC-RAS includes the "Maricopa Method" in addition to the USACE method 
from EM 1601.  The Maricopa Method was developed by the Flood Control District of Maricopa 
County and is described in the 2018  Drainage Design Manual for Maricopa County, Arizona, - 
Hydraulics (See Section 6.6.3 Riprap Lined Channels).  The Maricopa Method is a case-dependent 
modification of the Ishbash Equation (which is also in the latest version of HEC-RAS). In version 6.3, 

Version 6.4

These methods will be available in version 6.4


https://www.maricopa.gov/DocumentCenter/View/2371/2015-02-Drainage-Design-Manual-for-Maricopa-County-Volume-II-Hydraulics-PDF
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•
•

only Ishbash-related Maricopa County’s riprap sizing equations are implemented. Other riprap sizing 
equations from Maricopa County will be implemented in the future versions

The Maricopa Method modifies the Isbash equation and calculates the d50 (median size) of the 
riprap for four cases:

On the Channel Bed or on the Banks
For Straight or Curved Channels

The Maricopa Method also includes special equations for several specific design conditions (e.g. 
downstream of a grade control or drop structure) and assumptions to extend the d50 into a 
gradation.

Channel and Bank Riprap Equations

The Isbash Equation for Riprap is:

Where:

V=Maximum Velocity (ft/s)
        (Estimated at 1.33 times the cross section average velocity in the channel)
Va=Cross Section Average Velocity in the Channel (ft/s) (from HEC-RAS)
        (0.86 for high-turbulence; 1.2 for low-turbulence per EM 1601, Appendix F, page F-5)
C=An Empirical Turbulence Coefficient (-)
g=Acceleration of Gravity (ft/s2)
γw = Unit Weight of Water (lb/ft3)
γs = Unit Weight of Soil (lb/ft3)
s = Specific Gravity

The Maricopa Method modifies the Isbash Equation in three ways.  It has specific turbulence 
coefficients (C) for straight and curved reaches, it estimates the maximum velocity (V) as a function of 
the average velocity (V=1.33Va) which HEC-RAS computes and it adds a slope factor (cosine of the 
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bank angle, from Vanoni) to the denominator for riprap on the bank:

This works out to four basic equations:

Multiplying all the constant and coefficients, these equations become:

Where φ is the bank angle, already required for the USACE analysis.

Maricopa Channel and Bank Equations in HEC-RAS - Single Cross Section Analysis 

As with the other Riprap and Scour Methods, access the Maricopa Riprap Calculator by selecting the 
Hydraulic Design Tools and then Selecting Riprap from the Type menu.
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The target cross section is one of the main differences between the Maricopa method and the EM 
1601 method.  While the USACE method only uses the upstream refernce cross section for the 
straight, idealized channel above the bend, the Maricopa method uses the hydraulics from the local 
cross section under evaluation.  Therefore, the Maricopa Method will be insensitive to the Reference 
Cross section Selected:

Access the Maricopa Method Inputs by selecting the Maricopa Method tab (see figure below).  This is 
a modular tab, so users can move it around and stack it on the USACE Input Tab if they are not using 
both features.  At the to of the Maricopa Editor, select Channel/Banks to use the equations above.  
The Maricopa Method also requires a Side Slope Angle in the global Input Data (see below) to 
compute bank gradations:
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User Input

The Maricopa Method only requires three user decision.  As mentioned (and illustrated) above, you 
must define the side slope angle under the general Input Data.  HEC-RAS will use this side slope for 
all methods.

Then the user makes two choices under Inputs.  

Choose a Channel Alignment from the drop down.  This drop down provides two choices: Straight 
and Curved.  The Maricopa method recomends the Straight equation if the angle between the 
upstream flow direciton and the tangent of the bend is greater than 30 degrees 
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(see figure below modified from the Maricopa Manual and Simon, Li, and Associates 1981).

Finally, the user must specify whether the rock is angular or rounded.  This has the same effect as it 
does on the USACE riprap method.   Rounded rock diameters must be 30% larger (which translates 
to almost 100% larger by weight).

Single Cross Section Results

Gradations

The Maricopa Method computes gradational ranges for the whole riprap mixture based on the d50 
(see chart below).  For example, the range of acceptable d85s is a range between 1.2 and 1.4 times 
the d50.  Weight ranges are computed the same way, with the weight thresholds of 100%, 85%, 50% 
and 15% finer all all specified as multiples of the median weight (W50).

  
HEC-RAS translates these ranges into gradation bands in the gradation plotter.  For example, in the 
plot below, HEC-RAS computes d50s for the channel and the banks (side slopes) with the Maricopa 
method.  Then it calculates the ranges for the d100, d85, d50, and d15 according to the guidance in 
the above table, and plots it.  This allows users to leverage the gradation tools, and compare locally 
available aggregate to the gradation bands suggested by the method.
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See the documentation on adding customized gradations to learn how to add available rock 
gradations to the riprap tool and evaluate them based on the gradation ranges plotted.  (Note: If the 
Maricopa method is selected curves and polygons associated with the USACE method are 
deemphasized in the plot but still available for comparison.  Unclick these polygons and points in the 
legend - as depicted in the figure above - to only plot Maricopa Results).

Multiple Cross Section Results

Because the Maricopa method uses the design cross section instead of an upstream reference cross 
section HEC-RAS can apply the method to multiple cross sections at once.  The Riprap tool provides 
tabular data of the bank (side slope) and bed (channel) d50s for each cross section based on the 
categorical coefficients specified in the editor and the local, 1D, hydraulics at each cross section. If 
the user defines a reference and design cross section as well, these tabular data will also include a 
single USACE d30 (at the design location, but using the reference cross section hydraulics).
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Downstream of a Stilling Basin

The Maricopa method has several customized equations for specialized settings.  This version of 
HEC-RAS includes the method to size the riprap downstream of a stilling basin. 

To select this method, click the method box at the top of the Maricopa Method tab, and select 
Downstream of a Stilling Basin (see figure below).  This will shift both the cross section and the 
global, tabular results to this equation.  This method computes a single riprap d50 and gradation for 
the stilling basin-to-channel transition (i.e. it does not have separate bed and bank values).

Evaluate if the Selected Coefficients are Appropriate for Each Cross section

Just because HEC-RAS will apply the Maricopa equations to all of the cross sections at once, does 
not mean that the equation parameters selected are appropriate for each cross section.  The 
Maricopa approach requires users to specify whether the design cross section is in a straight or 
curved reach and updates the turbulence coefficient based on that information.  Be careful of 
applying the same equation to long reaches with bends and runs/crossings.  
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The riprap thickness calculation for this method is more complicated.   It requires a different 
thickness for the "horizontal" and "sloped" portions of a pre-defined stilling basin design (see figure 
below).
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The thickness on the horizontal apron downstream of a stilling basin is 1.5d100 or 2.5d50.  The 
method uses 2.0d50 for the riprap thickness on a 3:1 slope downstream of the stilling basin.
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Compute riprap thickness downstream of a stilling basin manually for version 6.3

HEC-RAS does not compute these thicknesses in version 6.3.  Compute these externally, based 
on your design configurations.



https://www.maricopa.gov/DocumentCenter/View/2371/2015-02-Drainage-Design-Manual-for-Maricopa-County-Volume-II-Hydraulics-PDF
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Scour Calculator: Computing Launchable Volume
Toe scour and undercutting are common bank protection failure modes. Rivers often scour during 
floods. Scour, local erosion, often concentrated at the outside toe of a bend, can dig beneath placed 
rock. Riprap can collapse into a scour hole, after which, it no longer protects the bank.

Because 
toe scour is one of the most common bank protection failure modes, toe protection is a critical bank 
protection design principle. There are several approaches to protecting the toe of a rock protection 
or bioengineering project. Two primary approaches include:

1. Burying toe protection to the projected scour depth.

2. Placing "launchable" toe protection, sacrificial rock that will dynamically line a scour hole.
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Both these toe protection designs require an estimate of the scour depth. The project team must 
place a keyed toe deeper than the projected scour depth or compute the correct volume of 
launchable rock to line the scour hole. In both cases, estimating the scour depth is critical to the 
design. However, local scour and bend scour are complex processes that are highly sensitive to the 
local soil properties and the multi-dimensional local flow field. Physical modeling or careful, 3D/CFD 
modeling paired with extensive soil data collection are the only way to predict local scour depth with 
any confidence, and even these approaches can have significant uncertainty if they are not 
calibrated.

Therefore, the riprap and scour calculator includes a suite of simple scour calculators, that take an 
ensemble approach to scour calculations. The scour calculator applies the most widely used local 
and bend scour equations to the riprap design cross section, to provide the range of scour depths 
expected from these empirical approaches. The design team should filter these results, ignoring 
equations that are not applicable or results that are unreasonable, and use the suite of results with 
engineering judgement, field observations, expert elicitation, geologic controls, and other 
quantitative and qualitative metrics to determine a maximum, likely, scour depth.

Step 1: Compute Hydraulics

The first two steps of the scour calculation are the same as the first three steps of the riprap 
calculation. If you are doing these analyses together, use the results from the riprap analysis (or visa 
versa). If you are only using the calculator to compute scour, see Step 1, Step 2, and the Radius of 
Curvature section of Step 3 in the riprap portion of the manual. This section includes some scour-
specific implications for these analyses where the steps differ from the Riprap Calculator.

Hydraulic Scour Parameters

The Scour Calculator imports more hydraulic results from the HEC-RAS results file (e.g. p01.hdf) than 
the Riprap Calculator. Each of the seven scour equations uses a small subset of these parameters. 
But the ensemble approach requires a range of hydraulic inputs. Apart from the Neill equation 
(which requires manual bankfull data), most of the data for these equations come from the HEC-RAS 
hydraulics.

The Calculator automatically computes results for each when the required data become available. In 
most cases, the model results are sufficient for General Scour results (with a categorical sinuosity 

https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.1/hydraulic-design-hd-calculators/riprap-and-scour-calculator/riprap-calculator-sizing-rock-gradation/step-1-calculate-hydraulics-and-select-profile
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.1/hydraulic-design-hd-calculators/riprap-and-scour-calculator/riprap-calculator-sizing-rock-gradation/step-2-identify-design-and-upstream-reference-xss
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.1/hydraulic-design-hd-calculators/riprap-and-scour-calculator/riprap-calculator-sizing-rock-gradation/step-3a-define-manual-input-variables#id-.Step3a:DefineManualInputVariablesv6.1-RadiusofCurvature(R)
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parameter that has a default) and the Bend Scour results require a manual radius of curvature.

Selecting a Design Flow

Design flow selection for scour analysis follow similar principles as riprap analysis. See that section 
for reference. However, most of these equations were based on flows at or below bankfull. Maynord 
1996 (from Thorne) notes empirical methods are valid up until significant interaction between main-
channel and overbank flow. Overbank depth should not exceed 20% of channel depth.

Step 2: Identify Design and Reference Cross Sections

The Scour calculator uses the same "Upstream Reference Cross Section" concept as the riprap 
calculator. But unlike the riprap calculator, it also uses hydraulic parameters at the design cross 
section. The figure below illustrates reference and design cross sections on a 1D HEC-RAS model.
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•
•

In general,

The general scour equations use the design cross section hydraulics and
The bend scour equations use the upstream reference cross sections.

General scour equations tend to be used for pipe crossings or other analyses on river runs or 
crossings where flow hydraulics are approximately one-dimensional. Therefore they use the local 
hydraulics. However, hydrodynamics at the outside of a bend are fundamentally multi-dimensional. 
Therefore, like the riprap computations, the bend scour regressions use hydraulics from a run or 
crossing cross section upstream of the more complicated bend geometry.
Bend scour equations correlate complex multi-dimensional processes with one-dimensional 
hydraulic properties by tying the equation to an upstream "refence" or "approach" cross section. 
The reference or approach cross section should be a relatively symmetrical upstream section where 
one-dimensional assumptions are appropriate. This is usually the closest cross section in the straight 
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crossing or run, upstream of the bend that also has similar hydraulic properties as the bend (i.e. 
bankfull depths/widths, channel slope, overbank depths/widths, roughness, etc.).

Step 3: Define Manual Input Variables

Like the riprap calculator, the scour equations get most of their required data directly from the HEC-
RAS simulation (with the exception of the bankfull data required by Neill). The only three user 
parameters required are Radius of Curvature, d50, and a categorical assessment of the bend severity.

Radius of Curvature: 
The Radius of Curvature for the Scour Calculation is the same as the riprap calculation. See the 
Radius of Curvature section in the Riprap section for a discussion of how to compute this parameter. 
This parameter should match the Radius of Curvature in the riprap calculator.

d50: 
The d50 is only used in the Lacey Equation. It is the median grain size of the bed sediment.

Bend Severity: 
Finally, the Scour calculator requires a qualitative, categorical, assessment of the reach sinuosity. 
The bend scour equations use the Radius of Curvature, but the general scour equations still require 
some information about the channel alignment. Most of the general scour equations use a 
qualitative factor (Z) to scale scour to one of three discrete bend-severity categories: Straight, 
Moderate, or Severe.

Howard et al. (2021) has quantitate guidance for these categories, based on the ratio of the Radius of 
Curvature and Width (R/W):

Channel Description 
(for Z parameter in Table 1)

R/W Range 
(ratio of radius of curvature to width)

Severe RW<3 or 4

Moderate 3 or 4<RW<10

Straight RW>10

The riprap calculator reports the R/W ratio and the recommended sinuosity category below the 

dropdown box where users can select it to guide this choice.

https://erdc-library.erdc.dren.mil/jspui/bitstream/11681/40702/1/ERDC-CHL%20TR-21-7.pdf
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1.
2.

Step 4: Select the Appropriate Equations

It is very difficult to predict potential flood scour potential without historical measurements or a 
calibrated numerical model. However, it is important to consider scour failure modes even when 
data or calibrated models are not available. A suite of simple, empirical equations can bound the 
potential scour risk in these situations. These equations are not universally applicable and often 
generate a wide variety of scour depths. But applying the applicable equations - in an ensemble 
approach - can provide a possible range of scour depths. Many of these methods were collected in 
the US Bureau of Reclamation design manual (Pemberton and Lara, 1984) and despite their age and 
limitations remain the standard practice at the time of publication.

But it is critical to carefully select the equations that are appropriate for the design setting, or to 
weigh the results of each equation relative to their applicability. 
The scour equations fall into two categories:

General Scour
Bend Scour

The first decision users must make is which suite of equations to consider. General scour equations 
tend to apply to straighter reaches and are often used to determine the depth of a pipeline or other 
infrastructure buried beneath a river crossing. Bend scour computes maximum local scour on the 
outside of the bend and is usually used to determine the depth of toe protection required to protect 
a bank or levee.

Bend scour estimates the multi-dimensional forces that scour the river bed on the outside of a bend. 
Bend scour equations are very sensitive to the "radius of curvature" of the bend. General Scour 
equations target straighter reaches, but most of these equations still have a categorical term that 
increases scour based on the curvature of the reach. These equations are based on 1D cross-section 
averaged variables and often – particularly the bend scour equations - refer to hydraulic parameters 
of an upstream, reference cross section. Equation variables that come from the upstream cross 
section have a subscript "US" below (e.g. DUS). Howard et al (2021) and Baird et al (2019) provide 
more detailed descriptions of the context and application of the equations summarized in this 
section.

These scour equations are included in a scour and RipRap calculator in the hydraulic modeling 
software HEC-RAS, which reads the hydraulic parameters directly from 1D model results and 
computes the applicable equations. For more information on the Scour equations and an example 
application, see Howard et al. (2021):
Howard, A., Pak, J., May, D., Gibson, S., Haring, C., Alberto, B., Snyder, M. (2021) "Approaches for 
Assessing Riverine Scour," Regional Sediment Management Technical Report.

General Scour

The general scour equations were compiled by Neill (1973) to compute scour at "constricted 
waterways." Pemberton and Lara (1984) present them as a method to "design buried pipe, buried 
canal siphon, or a bank line structure" and the complete suite are summarized in Baird (2019) and 
Howard et al. (2021). These equations estimate scour in different river settings, including bends or 
straighter reaches (Table 1) and are generally based on the hydraulic parameters at the design 
location (i.e. they do not refer to an upstream reference cross section).



Hydraulic Design (HD) Calculators

HEC-RAS User's Manual– 515

Most of the General Scour equations (Neill Incised, Blench, Lacey, and USBR average velocity) have a 
similar form and using an empirical factor (Z) to account for sinuosity. Z is a categorical reduction 
factor with three options for "straight", "moderate", and "severe bends". The value of Z varies for the 
different equations based on the bend category collected. But the Z coefficient ranges from 0.25 to 
0.75 for most natural river settings, reducing scour more (lower Z) for straighter reaches. Assigning a 
quantitative reduction factor to qualitative bend categories introduces uncertainty (and 
nonlinearity/step functions) into the analysis. But USACE Subject Matter Experts have some rule-of-
thumb approaches to calculating these categories based on the ratio of the radius of curvature (Rc) 
and the bank-full channel width (W), summarized in Table 2.

Where:
∆y is the scour depth below the initial channel invert
Qd is the design flow
dm median grain size
D is depth. Depth takes several forms in these equations including:
Dh, the hydraulic depth, which is the area divided by the top width
Dbf, the average bankfull cross section depth, but is often approximated with Dh and
D_Max, the maximum cross section depth.
Z is an empirical parameter accounting for channel sinuosity based on a categorical classification 
(See chart).
W is the flow width of the design event
Wbf is the banfull flow width 
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Qbf is the bankfull flow
FB0 is Blench's Zero Bed Factor from the figure below. 

Chart to determine Blench's Zero Bed Factor as a function of dm (from Pemberton and Lara (1984) 
after Blench (1969)). 
Radius of curvature to width ratios for curvature categories used to determine the Z factor.

Channel Description 
(for Z parameter in Table 1)

R/W Range 
(ratio of radius of curvature to width)

Severe R/W<3 or 4

Moderate 3 or 4<R/W<10

Straight R/W>10

Bend Scour Equations

The bend scour equations try to account for multi-dimensional forces on the outside of a bend by 
quantifying the bend severity based on the bend curvature and computing constriction and avoiding 
the complexities of multi-dimensional hydraulics at the bend by tying the equations to an upstream 
"crossing" or "run" reference cross section (illustrated in the Figure below).

Pemberton form of Lacey Equation

Richards (2018) points out that the form of the Lacey equation in Pemberton and Lara (1984) - 
which is based on the total flow and is currently used in this calculator - is the regime form from 
the Lacey (1930) paper.  Richards argues that the general version that uses unit flow is more 
appropriate in most situations.  HEC and USACE are evaluating this finding.  For now, the scour 
calculator uses the Bureau of Reclamation equation above, which is also applied by multiple 
other State and Federal agencies.   But we are evaluating this equation and - for now- use this 
result with caution.



https://ascelibrary.org/doi/10.1061/9780784481424.013
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Most of these equations were based on flows at or below bankfull. Maynord 1996 (from Thorne) 
notes empirical methods are valid up until significant interaction between main-channel and 
overbank flow. Overbank depth should not exceed 20% of channel depth.
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Warning and Error Messages

The Scour calculator will display a warning icon  next to the computed value if it is problematic. 
Hover the cursor over the warning icon for a description of the error.

Negative Scour: 
In the current version, negative scour values will be the main reason for the warning icon. Because 
these equations are simple regressions of limited data sets, it is relatively common for them to 
report negative scour. But negative scour should never be included in a statistical analysis or 
interpreted as deposition. A negative scour is just a numerical artifact of a simple regression 
equation pushed outside its limits. Some practitioners and calculators report negative scour as 0, 
interpreting everything in the negative range as stable. In some cases, it may be appropriate to 
consider negative results part of a larger body of evidence that scour will be low. But the HEC-RAS 
scour calculator intentionally leaves these values negative to signal that the equation is outside the 
range of the equation and should be interpreted with care. 

Outside the Equation Range: 
Some equations will also show an error button if the calculator is applying the equation outside the 
stated range of the equation. The user can decide if the results are still valuable outside this range 
but should consider these warnings when selecting an applicable suite of equations.
In future versions HEC will add warnings for equations that are applied outside of their intended 
range. But for now, it is the user's responsibility to figure out which equations are site-appropriate.

Step 5: Compute Ensemble Scour Results

The Scour Calculator automatically populates results for each equation as soon as the required data 
are available and updates them immediately in response to user edits. The calculator selects all of 
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the equations by default. Use the check boxes to deselect equations that are not applicable.

Step 6: Visualizing Scour Results

The riprap and scour calculator will plot selected results with the design cross section to help 
visualize the magnitude and range of computed scour.
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Visualizing General Scour

The general scour results plot automatically, reproducing the portion of the cross section between 
the channel banks, offset vertically by the scour result.

Visualizing Bend Scour

Visualizing bend scour requires user input. Bend scour is not distributed across the whole channel, 
but is generally concentrated at the toe of one bank. So the Riprap and Scour calculator requires a 
Toe Station to display the bend scour results correctly.

In the following figure, the Toe Station is 165. The display includes an orange, dotted, line to 
indicate the location of this user-defined Toe Station. The cross section has no station-elevation 
point right at station 165, so it selects the closest point (which is at the left toe of the engineered, 
trapezoidal channel).
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The bend scour visualization applies the computed scour depths to the selected station-elevation 
point, and connects them to the adjacent station-elevation points.

Note:

The bend scour visualization is dependent on the number and location of station elevation 
points. For example, the bend scour visualization above would look very different if the modeler 
used more station-elevation points to define the cross section.
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 These figures plot the same bend scour results on the same cross section. The only difference is the cross 
section on the right has more station-elevation points. The additional station elevation points do not affect 
the result but change the visualization substantially.

Step 7: Select a Reasonable Scour Depth Based on Calculations, Regional Geology, and 
Engineering Judgement

The scour equations are simple and empirical, regressions of data from systems that likely diverge 
from the system you are analyzing in several ways. The scour calculator includes a suite of these 
equations – in part – to help users and managers to understand the uncertainty in these calculations. 
The calculator does not automatically combine results into a single scour metric (e.g. average, max, 
or geometric mean) because these results should inform a broader decision and design process that 
also includes qualitative information, system observations, expert judgment, and common sense. 
The ensemble scour calculations provide a range of results that can bound the design scour depth 
(and communicate uncertainty). But the final scour depth requires the project engineer to take 
responsibility for the scour depth decision.

These equations are best used in the following decision approach:

1. Exclude equations that are not applicable to the setting or generate unrealistic results (e.g. 
negative scour). This requires review of the assumptions associated with each equation and deciding 
if each equation is appropriate for the design setting.

2. Report the median value, and the range. Look for clusters of results (several equations with similar 
scour depths) but recognize that some equations artificially generate similar results because they 
have similar forms or structure. Because some equations tend to produce similar results, the scour 
calculations cannot be treated as "independent observations" for statistical analysis. 

3. Use these results with other qualitative assessments, local system expertise, and subject matter 
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experts to agree on a design depth that reflects the likely scour depth, the risk tolerance, and the 
desired factor of safety.

Ongoing Work and Wish List
HEC is working on the following developments for future versions:

Add the Maricopa County Riprap Design Approach
Add the Blench Scour Calculation
Automatically read bankfull hydraulics for Neill equation by selecting a second HEC-RAS profile
Automate the Radius of Curvature Calculation in RASMapper
Import Cross-Section Averaged 2D Results Directly from a User Selected Transect
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Appendix A: Example Calculations

Riprap Examples

Riprap Calculator Example Calculations:
EM 1110-2-1601 Example H1 (from Appendix H)
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Example Data Set, Q=4,000 cfs
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Scour Examples
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Uniform Flow Computations
The uniform flow computations are performed by opening the Hydraulic Design Functions window 
and selecting the Uniform Flow from the Type menu item. Once this option is selected the program 
will automatically go to the geometry file and plot a cross section with the station and elevation data 
entered into the table. The user can select any cross section from the available rivers and reaches. 
The Hydraulic Design window for uniform flow will appear as shown in Figure 13-1.

As shown in Figure 13-1, the Uniform Flow window contains the input data, a graphic, and a window 
for summary results. Input data tabs included are the S/Q/y/n tab and the Width tab. The S/Q/y/n tab 
is used for calculating the normal slope, discharge, depth, or roughness for the current cross section. 
The Width tab is used to calculate the bottom width for a uniform flow solution of a user-entered 
compound channel (with up to 3 trapezoidal templates). The station, elevation, and roughness 
values for both the current cross section and the user-defined cross section can easily be 
manipulated in the table and applied to the current geometry file. The user is required to enter only 
a minimal amount of input and the computations can be performed.

Figure 13 1. Hydraulic Design Window for Uniform Flow
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Solving for Slope, Discharge, or W/S Elevation
When the S/Q/y/n tab has been selected, to calculate a slope that satisfies the uniform flow 
equations for the current cross section, simply enter values into the Discharge and a W/S Elev fields 
and press the Compute button. A value for the slope is then automatically entered into the Slope 
field. Likewise, for solving for discharge or water surface elevation, enter values for the other two 
parameters.

The roughness values are automatically taken from the geometry file, but these can be changed to 
better represent the bed characteristics of the cross section. In addition to changing the value of the 
roughness factor (in the default case, Manning's n), the function for defining roughness can be 
changed. To do this, click on any cell in the equation column of the table and select a function from 
the dropdown list. The available functions to choose from are Manning's, Keulegan, Strickler, 
Limerinos, Brownlie, and five grass-lined channel methods. Each of these functions is discussed in 
detail in Chapter 15 of the Hydraulic Reference Manual.
For the Limerinos and Brownlie functions, gradation distribution is necessary and can be entered by 
pressing the Gradation button. Only one gradation distribution can be used for a given cross section 
and should be applied only to the main channel, as these functions were developed for bed material. 
The Gradation window is shown in Figure 13-2. The following gradation variables are defined as the 
following:

d84: The sediment particle size for which 84% of the sediment mixture is finer (mm).
d50: The sediment particle size for which 50% of the sediment mixture is finer (mm).
d16: The sediment particle size for which 16% of the sediment mixture is finer (mm).

Figure 13 2. Gradation Window

The Brownlie function requires a sediment specific gravity to be entered and the Keulegan function 
requires a temperature to be entered. The Compute button only becomes active once all required 
input is entered.
To solve for a roughness value, click on and delete only one of the roughness values in the table. 
Only one roughness section can be solved for at a time. Make sure Slope, Discharge, and W/S Elev are 
specified and all other required input are entered. RAS then computes a Manning's n value to satisfy 
the uniform flow equation for the portion of the cross section that is desired. Then, the roughness 
value is back-calculated to match the selected roughness function. Only Manning, Keulegan, and 
Strickler functions can be used to solve for roughness, since the other functions do not have a 
representative roughness value to solve for.
Once one computation has been made, the value that was solved for will be shown in bold font. For 
subsequent computations, any of the four uniform flow parameters that is emboldened will be what 
is solved for to avoid having to delete out the value every time. Once a new parameter is deleted out, 
it will then be solved for and emboldened.
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Solving for Bottom Width
Bottom width can be solved for the uniform flow equation only with a compound channel that is 
defined by the user. The compound channel may contain up to three trapezoidal templates, a low 
flow channel, the main channel, and the overbank channel. The bottom width of either the main 
channel or the overbank may be solved for. The addition or subtraction of width may be applied to 
right of centerline, left of centerline or equally to both sides.
When the bottom width tab is selected, the window shown in Figure 13-3 is displayed. To define the 
compound channel, enter the appropriate values into the compound channel table, which is located 
below the station elevation table. Data for the Overbank, Main, and Low Flow channels can be 
entered, however data for the low flow channel can only be applied if a main channel is also defined. 
The following variables are defined as follows:

SSL: The side slope of the left side of the channel. Entering a value of "0" provides a vertical slope (1Vertical : 
__Horizontal).
SSR: The side slope of the right side of the channel. Entering a value of "0" provides a vertical slope 
(1Vertical : __Horizontal).
WL: The bottom width of the left side of the channel from the centerline of the channel to the toe of the side 
slope (ft or m).
WR: The bottom width of the left side of the channel from the centerline of the channel to the toe of the side 
slope (ft or m).
Height: The height of the respective channel from its invert to the top of its side slope (ft or m).
Invert: The invert of the respective channel (ft or m).

Once the channel template data is entered, the user may plot the data by selecting Apply Geometry. 
When this button is selected, the channel design is shown in the plot window and entered in the 
station elevation table with the default roughness information. A Manning's n value of 0.03 will be 
applied to each of the channel templates defined. The user may then adjust the roughness values, 
change the roughness functions, or add more roughness change locations within the cross section 
on the station elevation table. Any changes made can be reapplied to the plot by pressing Apply 
Geometry. See Figure 13-4. If either the Brownlie or Limerinos functions are chosen, gradation data 
will have to be entered.

A value for the energy slope, discharge, and water surface elevation must be entered in the 
appropriate fields. The user can then select how to solve for the bottom width by using the 
dropdown boxes in the "Compute Widths" section. Either the main channel or the overbank channel 
can be solved for and the width can be applied to the left side of the channel (Left of CL only), the 
right side of the channel (Right of CL only), or equally to both (Total).
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Figure 13 3. Bottom Width Calculation
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Figure 13 4. Example Bottom Width Data Entry

When all required data is entered, the Compute button will become active. The computations are 
constrained from creating unrealistic geometries. One example is the overbank bottom width cannot 
become less than the top width of the main channel. Likewise, the main channel bottom width 
cannot become less than the low flow channel top width. If this situation occurs within the 
computations, the user is notified and a course of action is suggested. However, if the top width of a 
lower channel becomes greater than the bottom width of the channel above it within the 
calculations, the program automatically increases the upper channel's bottom width to compensate. 
When a solution is obtained, the new widths are updated in the compound channel table, the station 
elevation table and the plot.

Applying Uniform Flow Data to the Geometry File
The resulting cross section, displayed in the plot window can be added to the existing geometry data 
by clicking on the "Copy XS to Geometric Data" command button. The following window will appear:
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Figure 13 5. Copy Cross Section Window
Enter in the river station you want this cross section to be applied to. If the selected river station 
already contains a cross section, RAS will ask if you want to copy over it. If there is no cross section at 
the entered river station, RAS will automatically adjust the distances between the new cross section 
and its adjacent ones. Make sure that once the new cross section has been copied to the geometry, 
appropriate values for the bed elevations are reentered. This can easily be done by selecting "Adjust 
Elevations…" in the Option menu of the Cross Section Data window.

Saving Uniform Flow Data
To save the uniform flow data, click on File…save. This will add all pertinent data from all the HD 
Functions to an ascii file with the extension *.h##. The content of this file can easily be read within 
any word processing program.

Stable Channel Design Functions
The channel design functions within HEC-RAS are based upon the methods available in the SAM 
Hydraulic Design Package for Channels (USACE, 1998), developed by the U.S. Army Corps of 
Engineers Waterways Experiment Station. This chapter presents the data input required for 
computing uniform flow parameters, stable channel dimensions, and sediment transport capacity 
for a given cross section. 
For information on the Channel Design Functions equations and theory, please see Chapter 15 of the 
HEC-RAS Hydraulic Reference Manual.

General Modeling Guidelines
The Stable Channel Design Functions within HEC-RAS are meant to be used as an aid in the design of 
stable channels. The purpose of this application is to provide the qualitative, easy-to-use 
methodology of the SAM software package within the HEC-RAS framework. Specifically, the Stable 
Channel Design Functions will allow the user to easily compute the hydraulic parameters of a given 
cross section, use that information to design a stable channel with regard to its size and armoring, 
and determine the sediment transport capacity of that cross section.

General Command Buttons

The general command buttons can be seen in the top right-hand corner of the window shown in 
Figure 13-1. The Defaults button restores the current hydraulic design function's fields to the default 
values. The Apply button will store the entries on the current window into memory. These values will 
remain in memory until a new hydraulic design file is opened or the user exits HEC-RAS. The 
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Compute button initiates the computations for whatever hydraulic design function is currently 
active. The Report button displays a printable report providing detailed hydraulic design 
information. Output will be displayed in the report window if the computations have been run.

Stable Channel Design
Stable channels can be computed using three different methods:

Copeland
Regime
Tractive Force

To access the stable channel design window, click on Type…Stable Channel Design in the Hydraulic 
Design Window. The following window will become active:
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Stable Channel Design Window

Copeland Method

Dr. Ron Copeland developed the "Copeland Method" (aka the Stable Channel Analytical Method) as a 
simplified tool to screen channel restoration alternatives.  It is a useful method to quickly evaluate a 
range of possible slope-width-depth combinations that are likely to remain in relative continuity 
with the sediment transport (e.g. less likely to erode or deposit).  The method combines a sediment 
transport function (Brownlie) with a roughness equation to compute a suite of slope-with and slope-
depth pairs that would be in rough continuity with the computed sediment load.

   

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=VV5uGG_NBGM

http://youtube.com/watch?v=VV5uGG_NBGM
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To use the Copeland Method, select the tab named "Copeland." There are a number of required and 
optional fields to enter data into for both the design section and the upstream section. To enter in 
data for the design section, simply add data to the fields shown.

Discharge: The design discharge. Can be the 2-year, 10-year, bankfull, etc. Must represent the 
channel forming discharge (cfs or m3/s).

Specific Gravity: Particle specific gravity. Default is 2.65.  Rarely changes.

Temperature: A representative temperature of the water. Default is 55 degrees F or 10 degrees C.

Valley Slope: (Optional) The maximum possible slope for the channel invert (i.e. no channel 
sinuosity). If the slope returned is greater than the valley slope, HEC-RAS will indicate that this is a 
"sediment trap."

Med. Channel Width: (Optional) Median channel width. The median width of the array of 20 bottom 
widths that are solved for. There will be 9 widths less than and 10 widths greater than the median 
channel width all at an increment of 0.1 X Med. Channel Width (ft or m). If this is left blank, the 
median width assigned will be equal to the regime width by the following equation: B = 2Q0.5

Side Slope: Slope of the left and right side slopes. (1Vertical : __Horizontal).

Equation: Can choose from Mannings or Strickler to solve for the side slope roughness.

n or k: If Mannings is selected, enter a Mannings "n" value. If Strickler is selected, enter a "k" value (ft 
or m for k values).
Gradation of the sediment is required for Copeland method and can be entered by clicking on the 
Gradation command button. Values for d84, d50, and d16 must be entered.
The user has the ability to designate the default regime for the computations. The HEC-RAS default is 
lower regime, but this can be changed by clicking on the "Default Regime…" button and selecting 
"Upper Regime". Any time the computations result in a solution that is in the transitional regime, the 
default regime will be used and the user will be notified in the output table that this occurred. See 
chapter 12 of the Hydraulic Design Manual for more information.

Once all required data for the design section has been entered, click on the "Inflow Sediment…" 
command button to input information about the upstream section for sediment concentration 
computations. The window shown in Figure 13-7 becomes active. The user can either enter in a value 
for the inflowing sediment concentration or let HEC-RAS calculate it. If HEC-RAS is to calculate the 
inflow sediment concentration, then the following information about the upstream section must be 
entered:

Supply Reach Bottom Width: Width of the bed of the supply reach (ft or m).

Supply Reach Bank Height: A representative value of the bank elevation minus the channel invert 
elevation of the supply section. This is only used in the computations to target a depth and does not 
limit the solution to this height (ft or m).

Supply Energy Slope: A representative energy slope at the supply section. Water surface slope is 
typically used.

Side Slope: Slope of the left and right side slopes of the supply section. (1Vertical : __Horizontal).
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Equation: Can choose from Mannings or Strickler to solve for the side slope roughness of the supply 
section.

n or k: If Mannings is selected, enter a Mannings "n" value. If Strickler is selected, enter a "k" value 
for the supply section (ft or m for k values).

Figure 13 7. Inflow Sediment Concentration Window

Click OK to apply the input and return to the main HD Functions window. Once all of the required 
input has been entered, the Compute button will be activated. Click the Compute button to run the 
computations. When the computations are complete, the output table will be shown. The output 
table lists all of the channel widths solved for along with the corresponding depth, slope, composite 
n value, hydraulic radius, velocity, Froude number, shear stress and bed transport regime. An 
example is shown in Figure 13-8. There will be twenty different stable channel geometries plus one 
for the minimum stream power. The user can select one of these geometries for display on the plot 
window. Once the desired section is selected, click OK and the HD Functions window will become 
active with the selected section plotted in the plot window.

When the computations have been run, the Table button, the two Stability Curve buttons and the 
Copy to Geometry button become active. The Table button simply allows the user to pull up the 
output table again, and select a different stable section, if desired. Clicking on the Stability Curve 1 
button will bring up a plot of the stability curve showing slope versus width, indicating for what 
slope/width combination aggradation or degradation can be expected. Figure 13-9 shows an 
example.



Hydraulic Design (HD) Calculators

HEC-RAS User's Manual– 540

Figure 13 8. Copeland Method Output Table

Figure 13 9. Stability Curve
Stability Curve 2 brings up a similar plot, only with slope compared to depth. In addition to viewing 
the plots, the table tab can be clicked to view the stability curves in tabular form.
As with the uniform flow computations, the section that has been plotted from the Copeland Method 
can be applied to the current geometry file by clicking on the Copy to Geometry button.
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Technical Reference

Regime Method

To use the Regime Method, select the tab named "Regime." The window shown in Figure 13-10 
becomes active.

Figure 13 10. Regime Method

Enter in all required input which are:

Discharge: Channel forming discharge (cfs or m3/s).

Brownlie is Limited to Sand Beds

The version of the Copeland Method currently in HEC-RAS only uses the Brownlie equations for 
transport and roughness.  The Brownlie equations are limited to sand bed streams and designed 
for rivers with bedforms.  The orriginal Copeland method also provided a MPM option for gravel 
bed streams.  But the HEC-RAS method is limited to Brownlie and Sand Bed Streams.



Wish List - MPM Copeland Method

HEC would like to include the MPM version of the Copeland method for gravel bed streams.


https://www.hec.usace.army.mil/confluence/rasdocs/ras1dtechref/latest/stable-channel-design-functions/stable-channel-design/copeland-method
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d50: Median particle size (mm).

Sediment Conc, C ppm: The bed material sediment concentration, in ppm.

Temperature: A representative temperature of the water. Default is 55 degrees F or 10 degrees C.

Side Factor, Fs: The side factor as defined by Blench. Blench suggests 0.1 for friable banks, 0.2 for 
silty, clayey, or loamy banks, or 0.3 for tough clay banks. Default value is 0.2.
Once these values are entered, the compute button becomes activated and the stable channel 
regime values for depth, width, and slope will be solved for and entered into the appropriate fields. 
In addition, the plot window will display the resulting cross section.
The displayed cross section can be added to the existing geometry file by clicking on "Copy XS to 
Geometric Data."

Tractive Force Method

To use the Tractive Force Method, select the tab named "Tractive Force." The window shown in 
Figure 13-11 becomes active.

Figure 13 11. Tractive Force Method

Enter in all required input which are:

Discharge: Design discharge (cfs or m3/s).
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Temperature: Temperature of the water. Default is 55 degrees F or 10 degrees C.

Specific Gravity: Specific gravity of the sediments for the left side slope, bed, and right side slope.

Angle of Repose: The angle of repose of the sediment for the left side slope, bed, and right side 
slope. See Figure 11-9 in the HEC-RAS Hydraulic Reference Manual for suggested values.

Side Slope: Left side slope and right side slope (1Vertical : __Horizontal).

Equation: the roughness equation for the left side slope, bed, and right side slope. Mannings and 
Strickler are available for use.

n or k: If Mannings is selected, enter a Mannings "n" value. If Strickler is selected, enter a "k" value 
for the left side slope, bed, and right side slope (ft or m for k values).

Method: Solve for critical shear using either Lane, Shields, or by entering in your own critical 
mobility parameter.
The remaining values are the dependant variables. Only two can be solved for at a time. The other 
two must be entered by the user. The three fields for particle diameter (left side slope, bed, right side 
slope) are considered one variable such that any one of the remaining variables plus any or all of the 
particle diameters can be solved for.

d50/d75: The particle diameter in which 50%/75% of the sediment is smaller, by weight. d50 is used 
for Shields and user-entered. d75 is used for Lane (mm).

D: The depth of the stable cross section (ft or m).

B: The bottom width of the stable cross section (ft or m).

S: The slope of the energy grade line at the stable cross section.

Once the required values plus two of the dependent variables are entered, the compute button 
becomes activated and the stable channel values for the remaining dependent variables will be 
solved for and entered into the appropriate fields. In addition, the plot window will display the 
resulting cross section.
The displayed cross section can be added to the existing geometry file by clicking on "Copy XS to 
Geometric Data."

Sediment Transport Capacity

Known Issue - Include all XSs in Sediment Reach

Current and some previous versions of HEC-RAS compute bad capacity values if some (not all) of 
the cross sections are selected in the Sediment Reach.  The tool appears to be working if the 
sediment reach includes all of the cross sections.  As a work around, set the US RS to the 
upstream most cross section and the DS RS to the downstream most XS.
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The sediment transport capacity computations can only be run once steady or unsteady flow 
computations have been run. Sediment Transport Capacity for any cross section can be computed 
using any of the following sediment transport functions:

Ackers-White
Engelund-Hansen
Laursen
Meyer-Peter Müller
Toffaleti
Yang

To access the sediment transport capacity window, click on Type…Sediment Transport Capacity in 
the Hydraulic Design Window. The following window will become active:

Figure 13 12. Sediment Transport Capacity Window

To perform sediment transport capacity computations, the user must define one or more sediment 
reaches. A sediment reach indicates for which cross sections transport rates will be computed and 
contains information necessary to fulfill the computations. Sediment reaches can vary spatially 
within the geometry, can have different input parameters such as temperature, specific gravity, and 
gradation, or can simply use different sediment transport functions. A sediment reach cannot span 
more then one river reach, however there can be multiple sediment reaches within one river reach. 
Sediment reaches cannot have overlapping cross sections.
When the sediment transport capacity window is opened, if there are not any previously defined 
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sediment reaches defined for the current hd file, the user will be automatically prompted to name a 
new sediment reach. To create a new reach otherwise, click on File…New Sediment Reach. The user 
also has the option of copying, deleting, and renaming existing sediment reaches under the File 
menu option. The name selected for the new sediment reach will appear in the Sed. Reach 
dropdown box along with all other existing sediment reaches for the particular hydraulic design file.

Once a new sediment reach has been named, the user must define its spatial constraints by selecting 
the river, reach, and the bounding upstream and downstream river stations. Next, one of the existing 
profiles must be selected.

Sed.Reach: Indicates which sediment reach is active. This dropdown box lists all existing sediment 
reaches for the current hydraulic design file.

River: The river where the current sediment reach is located.

Reach: The reach where the current sediment reach is located.

US RS: The upstream bounding river station of the current sediment reach.

DS RS: The downstream bounding river station of the current sediment reach.

Profiles: The profile to be used in the sediment transport computations for the current sediment 
reach.

River Sta: The river station currently displayed on the plot.

Temperature: Temperature of the water. Default is 55 degrees F or 10 degrees C.

Specific Gravity: Specific gravity of the moveable sediments. Default is 2.65.

Bed Sta Left/Right: The cross section stations that separate the left overbank from the main 
channel from the right overbank for sediment transport capacity computations. Defaults are the 
main bank stations. These values can be changed for every cross section within the sediment reach. 
The selected stations appear on the cross section plot as yellow nodes, and are bracketed by 
"MB" (mobile bed) location arrows on the top of the plot.

Conc. of Fines (opt): The concentration of fine sediments (wash load) in the current sediment reach. 
This is an optional value and is used to adjust the transport rate based on Colby's (Colby, 1964) 
findings regarding the effects of fine sediment and temperature on kinematic viscosity, and 
consequently particle fall velocity. Values are given in parts sediment per one million parts water, by 
weight.

Functions: The user can select one or more sediment transport functions from this list box. By 
clicking the checkbox, a check will appear and RAS will compute for that function. When clicking on 
the name of the function, a brief description of the function and its applicability will appear in the 
text box below.

Gradation: This is entered for the left overbank (LOB), main channel (Main) and right overbank (ROB) 
as defined by the left and right bed stations. The user can enter nothing or up to 50 particle size/
percent finer relationships. By right-clicking on one of the tabs, the grid can be expanded for easier 
viewing. Right-click again to return the grid to its compact display. Typically 5 to 10 gradation points 
are enough to represent a typical gradation curve. The particle diameter is entered in mm under the 
column header Diam, mm, and the percent of the representative sediment that is finer than that 
particle diameter is entered under the column header %Finer. RAS then takes this gradation input to 
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determine the fraction of the sediment that is in each standard grade size class. If a zero percent 
value and/or a 100% value are not entered by the user, the program will assign zero percent to the 
next lowest grade class and 100% to the next highest grade class. See the hydraulic reference 
manual for more detail.

Plot Gradation: This button gives the user a graphical representation of the sediment gradation.
The user has the option to compute sediment transport capacity rates for the currently selected 
sediment reach (Compute for this Sediment Reach) or for all existing sediment reaches (Compute 
for all Sediment Reaches) within the currently opened hydraulic design file.

A text box is provided for brief descriptions of selected transport functions. In addition to a summary 
of the selected function, the range of input parameters, from both field and laboratory 
measurements, used in the development of the respective function is also provided. Where 
available, these ranges are taken from those found in the SAM package user's manual (Waterways 
Experiment Station, 1998) and are based on the developer's stated ranges when presented in their 
original papers. The ranges provided for Engelund and Hansen are taken from the database (Guy, et 
al, 1966) primarily used in that function's development. 
The following variables are used in the summaries:

d, overall particle diameter
dm, median particle diameter
s, sediment specific gravity
V, average channel velocity
D, channel depth
S, energy gradient
W, channel width
T, water temperature

Defaults: The Defaults button will restore all input boxes for the currently selected sediment reach 
to the default values.

Apply: The Apply button will be enabled any time new input has been added which has not been 
stored into memory. By clicking on the Apply button, all input for the current sediment reach will be 
stored to memory.

Compute: The compute button will be enabled once all required input is entered. Pressing the 
compute button initiates the computations for sediment transport capacity.

Options Menu: The Options Menu drop down list is on the top of the Sediment Transport Capacity 
form and includes:

Fall Velocity: This option allows the user to select the method of fall velocity computation. If 
"Default" is selected, the method used in the research and development of the respective function is 
chosen. Otherwise, any functions used in the computations will use the selected fall velocity 
method. The three fall velocity methods available are: Toffaleti, Van Rijn, and Rubey.

Depth/Width: This allows the user to select which depth and width parameters to use in the solution 
of the transport functions. If "Default" is selected, the program will use the depth/width combination 
used in the research of the selected functions(s). If any of the other depth/width combinations is 
used, all selected functions will be solved using those specific parameters.

Eff. Depth/Eff. Width: Used in HEC 6, this is the effective depth and effective width. Effective 
Depth is a weighted average depth and the effective width is calculated from the effective depth 
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to preserve aD2/3 for the cross section:

 

Hyd. Depth/Top Width: The hydraulic depth is the area of the cross section divided by the top 
width.

Hyd. Radius/Top Width: The hydraulic radius is the Area divided by the wetted perimeter. Is 
equivalent to hydraulic depth for relatively wide, shallow streams.

Hiding Factor for Ackers-White: An optional "hiding factor" adjustment is available for the Ackers-
White function only. The user can choose whether or not to use this feature. The default is "No."

Compute for Small Grains Outside Applicable Range: By default, RAS will perform calculations for 
grain sizes which are smaller than the applicable range of a given transport function. By selecting 
"No", the user can override this and have RAS compute for only the grain sizes within the 
applicability range of each sediment transport function, as defined in Table 12.7 in the Reference 
Manual.

 Sediment Rating Curve Plot/Table: This button displays a plot of the sediment transport 
capacity rates for a selected cross section within a sediment reach. It is only enabled once 
computations for that reach have been performed. Display options can be selected from the 
dropdown buttons. Figure 13-13 shows a sediment rating curve plot. In addition to viewing the plots, 
the table tab can be clicked to view in tabular form.

Figure 13 13. Sediment Transport Capacity Rating Curve
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 Sediment Transport Profile Plot/Table: This button displays a plot of the sediment transport 
capacity rates along a selected sediment reach. It is only enabled once computations for that reach 
have been performed. Display options can be selected from the dropdown buttons. Figure 13-14 
shows the sediment transport profile plot. In addition to viewing the plots, the table tab can be 
clicked to view in tabular form.

Figure 13 14. Sediment Transport Capacity Plot

Both plot windows have a list box at the bottom with warning messages. These warnings are meant 
to make the user aware of how sediment transport rates are being computed. If the user selects the 
option to compute sediment transport rates for all grade sizes within the user-specified range, a 
warning stating this will be shown. If the user selects the option to compute sediment transport rates 
for only those grade sizes within the respective function's applicability range, then a warning a 
different warning message will appear.

The "Compute for Small Grains Outside Applicability Range" option is located in the menu item 
"Options" on the Hydraulic Design window for sediment transport capacity.

Report: The Report button is located in the plot window and generates a report summarizing the 
input and output data. The output data is displayed as per the selections made in the dropdown 
buttons. Because the amount of output has the potential for being quite large, the report that is 
generated can likewise be very large. Figure 13-15 shows an example of the sediment transport 
capacity report. As with other report windows found in HEC-RAS, the user has the ability to send this 
report to the clipboard, print it, or save it as a text file.
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Figure 13 15. Sediment Transport Capacity Report

Sediment Rating Curve Analysis Tool
The Sediment Rating Curve Analysis Tool downloads sediment loads, concentrations, and 
gradations directly from the USGS (or uploads them from a tab delimited file or Excel) and applies a 
range of statistical analyses and visualizations to help modelers and scientists understand their data 
and develop rating curves or trends to include in sediment budgets or models.

This video is a brief demo of the capabilities in the 6.2 release version.
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Sediment Rating Curve Challenges and Best Practices
Sediment data are noisy.  They tend to include a lot of uncertainty, measurement error, and natural 
variability.  But sediment models require modelers to summarize these data into more concrete 
inputs and trends that the model can use.  The two most common data analysis tasks users 
encounter include summarizing the flow-load data with a sediment rating curve and evaluate 
sediment load gradation trends. 

The Sediment Transport User Guide includes an extensive discussion of common data challenges 
encountered in the process of developing a sediment rating curve and analyses that modelers 
should do with their data before settling on a sediment relationship for their boundary conditions.  
These are also summarized in this video:  

Recent versions of HEC-RAS includes a Sediment Rating Curve Analysis Tool that standardizes these 
analyses and provides simple tools to help sediment modelers and analysts think carefully about 
their data and develop quality relationships for model boundaries or sediment budgets.  The tool 
includes the following capabilities:

Import Sediment Data The Rating Curve Analysis Tool can import data directly 
from the USGS website (for US users) or from standard csv 
formats.

Bias Correction The tool provides two methods to rectify bias implicit to 
the log-transform regression used to develop sediment 
rating curves

Piecewise Linear The tool includes new methods to fit "bent" rating curves 
to sediment data (e.g. for supply limited scenarios)

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=278wsFaVtBc

https://www.hec.usace.army.mil/confluence/rasdocs/rassed1d/1d-sediment-transport-user-s-manual/entering-and-editing-sediment-data/sediment-boundary-conditions
https://www.hec.usace.army.mil/confluence/rasdocs/rassed1d/1d-sediment-transport-user-s-manual/entering-and-editing-sediment-data/sediment-boundary-conditions/rating-curve
https://www.hec.usace.army.mil/confluence/rasdocs/rassed1d/1d-sediment-transport-user-s-manual/entering-and-editing-sediment-data/sediment-boundary-conditions/rating-curve#RatingCurve-Load-GradationData:
https://www.hec.usace.army.mil/confluence/rasdocs/rassed1d/1d-sediment-transport-user-s-manual/entering-and-editing-sediment-data/sediment-boundary-conditions/rating-curve/creating-a-sediment-rating-curve-best-practices
https://youtu.be/cBr3KkLTW1Y
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/importing-sediment-data
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/importing-sediment-data
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.2/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/bias-correction
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.2/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/bias-correction
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/piecewise-linear-regression
http://youtube.com/watch?v=278wsFaVtBc
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Stationarity These are visualization methods to explore how sediment 
data change over time and fit rating curves to temporal 
sub-sets of the observations

Temporal Averaging

and Autocorrelation

Groups observations collected within a specified time 
window to avoid over-representing them and violating the 
independence assumption.

Hysteresis Traces the temporal path of flow-load/concentration data 
over a water year

LOESS  (v6.4) Applies a non-parametric, local regression based on a user 
defined (or computed, optimal) "span." 

Rating Curve Results These tools allow users to build their rating curve power 
function or populate their flow-load table for HEC-RAS.

Load-Gradation Trends These tools help users visualize the load-gradation data 
and determine if there is a fining or coarsening trend with 
flow.

Sediment Time Series

& Annual Load

(v6.4)

Computes a sediment time series from the selected rating 
curve and the available USGS flow data and computes an 
average annual load.

These video includes more information on these methods and tools.

https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/stationarity
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.2/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/temporal-averaging-and-autocorrelation
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.2/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/temporal-averaging-and-autocorrelation
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.2/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/temporal-averaging-and-autocorrelation
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.2/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/hysteresis-visualization
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.2/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/hysteresis-visualization
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.4/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/loess
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.2/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/analytical-and-tabular-rating-curve-results
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.2/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/gradation-trend-analysis
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/6.2/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/gradation-trend-analysis
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Opening the Sediment Rating Curve Analysis Tool

Funding and Support
The Rating Curve Analysis Calculator development was funded by the Mississippi River 
Geomorphology and Potamology Program (MRG&P).  Additional features and documentation were 
funded by the Hydrology, Hydraulics and Coastal Community of Practice, Science and Engineering 
Technology program (HH&C- SET).

Importing Sediment Data
The Rating Curve Analysis Tool includes several methods to import and input data.  Most of these 
methods follow US Geological Survey data formats because most US users will get sediment data 
directly from the USGS data portals (and most will use the automatic download tools described 
below).

HEC-RAS requires paired flow-load/concentration data to use the sediment rating curve tool.  It can 
only display load or concentration, but it can import either (or both formats) and convert between 
them.   It is also helpful to include dates and times for these flow-load/concertation pairs.  USGS data 
should include these dates and times automatically.   If you are entering flow-load/concertation data 
manually or creating an import file in one of the supported formats, and do not have dates and 
times, you can still import dateless flow-load/concentration and gradation information.  But several 
analyses with temporal components (e.g. stationarity, autocorrelation, and hysteresis) will not work 
without dates and times.
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In the United States, the most common approach to retrieve sediment data will be to request it 
directly from the USGS website.  The next section describes that process in detail.  Go to the section 
on other file formats for information on formatting and importing other data or to the clipboard 
section for information on how to copy and paste data directly from Excel.

Downloading Data From USGS

Most practitioners in the United States get their data directly from USGS data portals.  Historically, 
sediment scientists and modelers have downloaded data-dense text-based files to retrieve these 
data and post processed them in spreadsheets.  More recently , the USGS has provided access 
through R packages.  The Rating Curve Analysis Tool bypasses these processes and imports sediment 
load, concentration, and load-gradation data directly into HEC-RAS.

To download data, go to File→Import→USGS Web Importer. 

The automatic web import tool requires two search parameters to narrow the list of gages to 
provide: the state and a text string (see red box below).  The text string will recognize the gage 
number if you know the exact gage you are looking for, but if you input the river name it can also 
populate summary statistics for all the gages on the river to help decide which gages to work with.   If 
the search returns a long list of gages, the importer can take a few seconds to populate the statistics 
for all the gages.

To find the gages with the most data, sort by any of the headings.  In the following figure, ordered the 
Missouri River data from Nebraska by the number of sediment load or concentration measurements.  
But users can also sort by the total number of samples, the number of different water quality 
constituents measured, or the load-gradation samples available.

https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/importing-sediment-data#id-.ImportingSedimentDatav6.1-ImportingDataFiles
https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/hydraulic-design-hd-calculators/sediment-rating-curve-analysis-tool/importing-sediment-data#id-.ImportingSedimentDatav6.1-ClipboardImport
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Selecting a gage will provide more information about the gage, including searchable meta-data and 
information on each available constituent (using the USGS codes).  HEC-RAS can only import 
sediment data for now, but provides information on the other data available.
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Press the Import button to download the sediment data into the Rating Curve Analysis Tool.  

Some water quality measurements are stored with paired flow data but many of them are not.  All of 
the capabilities of the Rating Curve Analysis Tool use paired sediment-flow data, so the tool will only 
import sediment data if it has paired flow data.  If the water quality record has a measured flow 
(daily or instantaneous) associated with it, the Rating Curve Calculator will import both.  But if the 
gage has sediment measurements without flows, the tool will show the option below.  The top 
button just imports the sediment measurements paired with flows in the water quality data.  But the 
bottom button reports how many sediment measurements do not have paired flows, and offers to 
reach out to the gage flow data and select the closest flow from the gage to pair with the sediment 
observation.  This second option is recomended.
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Before the data download, HEC-RAS will launch another download tool to guide users through some 
common decisions about which data they want and how the model should handle it:

Even if you decide to import and/or convert all data , regardless of native type (instantaneous/daily, 
load/concertation) HEC-RAS color codes the imported data in the data grid to classify them by their 
native format.
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This will bring the data into the Sediment Rating Curve Analysis tool.  The tool will plot the flow-load/
concentration data in the main Rating Curve plot and populate the tabular data in the table on the 
left.  However, it will also import the load-gradation data and plot them in the secondary tabs.  By 
default, the tool will calculate a bias-corrected rating curve through the data with the Duan bias-
corrector.

Converting Between Flow and Concertation

The Flow-Load Conversion tool is the orange button on the bottom-left corner of the Rating 
Curve Data grid.  It is common to collapse the data grid to provide more room for the plot (and less 
for a table of numbers).  But you can only access the Load-Concertation conversion tool if the data 
are visible.  If you hover over this button, it will expand to tell you what action it will perform (based 
on what state the data are in).

 

Clipboard Import
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Users can also simply copy data from excel and paste it into the editor.  The data must have the same 
four headings (Date, Time, Flow, Load), though not all the data are required.  Copy the four columns 
from Excel.  The select File→ Import → Clipboard.  The tool will check if the clipboard data are in the 
correct format.  If they are, it will provide the editor pictured above, allowing users to identify their 
sediment data type.  If not, it will return an error, explaining that the format is not correct.  An 
example of a good excel format is below:

Importing Data Files

The import tool can also import four data file formats.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=lLuhxrTbE0g

http://youtube.com/watch?v=lLuhxrTbE0g
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The first two data formats are just extensions of the USGS Web importer.  These are USGS data 
formats that can be downloaded from their website.  These are useful if users already have USGS 
data downloads they want to use, but will mostly be replaced by the automatic web importer.

But the Rating Curve Analysis Tool does include two generic file formats that the model can import.  
These generic formats currently only support flow-load/concentration data, not load-gradation 
data.  Sample files of each format are included below.  You can download these and replace the data 
with your data to import data into the tool.
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If you want to include data with just flow and load/concentration data, the file will still need the Date 
and Time columns, but they can be blank.
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File Format

Comma Delimited

with Date/Time

Comma Delimited 

w/o Date/Time

This importer will also allow users to specify whether the data they are importing are load or 
concentration before they import. 

Warning - Remove Commas from Numbers for Comma Delimited Files

If you are creating a comma delimited file to import into the Rating Curve tool, be careful to 
format the numbers without commas.



Wish List - Other Water Quality Constituents
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Bias Correction
Sediment transport is non-linear.  Therefore, a flow-load or flow-concentration rating curve is almost 
always non-linear.

We usually represent a flow-sediment relationship with a power function, such that:

Qs=aQb

Where Qs is the sediment load, Q is the flow, a is a small coefficient, and b is a power (usually 
between 1.5 and 2.5).

But the most common method to fit a power function to data like these includes an intrinsic bias.  
The log-transform, Least Mean Square Error, that a program like Excel uses to fit a power function 
includes an implicit bias, making the rating curve it produces systematically low.  

It is important to correct for this bias when you create a power function rating curve through 
sediment data.

The Rating Curve Analysis Tool applies a bias correction by default.   But it also has two options for 
this bias correction and it is useful to understand what the software is doing.  

This section describes these bias corrections.

Where Does The Bias Come From?

Before describing the bias correction, it is helpful to understand where the bias comes from.  

The Least Mean Square Error (LMSE) approach to linear regression measures the residuals between 
the regression and each observation and computes the line (slope and intercept) that minimizes 
those errors.

Fitting a power function to log-distributed data usually uses a log-transform approach.  The figure 
below includes a synthetic power function and data sampled from it with random residuals.  The 
power function is non-linear in arithmetic space.  But in log-log space the power function becomes 
linear.  This is because a log-transform of the power function takes a linear form (see below).  So, by 
log-transforming the data, the form of y = b + mx and we can apply the tools of simple linear 
regression to the log residuals. 

Now that HEC-RAS can download data directly from the USGS Water Quality sites, it will not be a 
major effort to expand the functionality to other constituents.  We are looking to partner with 
water quality modelers who use these other constituents to understand how these methods 
transfer to other constituents.
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Log-transforming the regression makes it relatively easy to fit a power function to log-distributed 
data.  However, it also introduces a bias when the data are untransformed.  For example, the 
observations in the figure below have equal and opposite residuals in the logarithmic transformation 
(0.7).  However, when these residuals untransform, the positive residual is larger than the negative 
residual.  Therefore, the log-transformed linear regression ends up with larger positive residuals than 
negative, making the fit power function systematically low.  This rating curve will under-predict 
sediment load for a given flow.
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Bias Correction Functions

There are several bias correction functions (sometimes called "predictor correctors").   The Duan 
Smearing Estimate is widely used, but USACE practitioners have also used Ferguson.  The Sediment 
Rating Curve Analysis Tool uses Duan by default, but also reports Furguson, and allows users to 
toggle between them.  These methods all tend to quantify the variability of the residuals and backs 
out the asymmetry in the residuals to come up with a linear correction coefficient.  For example, the 
Duan Smearing Estimate (E) is a linear coefficient in front of the power function, such that:

On the whole, the more spread the sediment data have, the higher the bias correction.

Bias Correction Results

The Rating Curve Analysis tool automatically reports the Duan and Ferguson bias corrections, 
including factors for all of the data, the results after same-day (or a user-specified temporal 
grouping) data are averaged, and then the bias correction associated with the piecewise-linear 
model if one is (or was) selected.  In the example below, the averaged data have a Duan Factor 
of E=1.16 which means that the rating curve increases the load 16% to account for the regression 
bias.  The rating curve (green line in figure below) automatically inclueds the selected bias-
correction.  Users can select which bias correction to plot by toggling between Duan and Ferguson.

https://www.jstor.org/stable/2288126?seq=1#metadata_info_tab_contents
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These correction factors also show up in the tabular data.
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The coefficients are reported (with the a and b coefficients for the power function) in the Regression 
Results, and included in any rating curve output described as Unbiased (based on the approach 
selected in the Bias Correction control window). 

References

Duan, N. (1983). “Smearing estimate: A nonparametric retransformation method.” Journal of the 
American Statistical Association, 78(383), 605–610.

Piecewise Linear Regression
Often, a single power function does not capture the complexity of the data.  Sediment data tend to 
over-represent low flows, which can dominate the regression in the moderate-to-large flow range 
that is most morphologically active.  Additionally, "bent" or "inflected" rating curves are relatively 
common, particularly in supply limited systems.  Future version of this tool will include local 
regression methods, that will allow users to develop more sophisticated rating curves.  But a two-
slope, piece-wise linear, regression can capture some of this complexity.   HEC worked with UC Davis 
() to develop a piecewise linear algorithm that identifies the inflection point in an inflected or bent 
rating curve and fits a continuous model to the upper and lower halves of the data. 

https://www.jstor.org/stable/2288126?seq=1#metadata_info_tab_contents


Hydraulic Design (HD) Calculators

HEC-RAS User's Manual– 567

Piecewise Regression Approach

The simplest form of the piecewise linear model is included in the figure above.  Change the Range
from None to All Data.  The calculator evaluates every data point as a potential inflection point (i.e. 
"knot" in the statistical terminology) and fits separate-but-continuous power functions to the 
upstream and downstream data.  The algorithm selects the inflection point with the lowest Root 
Mean Square Error (RMSE).  In the case pictured above, the model computed an inflection point at 
6,490 cfs, and fit a steeper slope to the lower flows than the higher flows (which is typical of rivers in 
this region).  Because most of the sediment moves in the moderate-to-large flow range, fitting a 
separate slope to these larger flows can affect the sediment budget and model dramatically.

The piecewise linear model also computes biased and unbiased regressions.  If you select this 
option, it will update the Piecewise correction factors for both Duan and Furguson (below) and will 
plot and report the unbiased result by default.  Users can request the biased result, but this is not 
recommended.
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Constraining the Inflection Point Range

Because sediment data often over-represent the low flows, the flow-load inflection point that 
minimizes the RMSE can turn up in the lower flows (see Figure below).  But because these flows do 
not deliver much sediment, the total sediment load will not be very sensitive to this constraint.  

In some cases, the data can have multiple, local, minimums, in the RMSE, including a potential 
inflection point in the higher flow data that is not the global RMSE minimum.  For example, the 
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following figure includes the RMSE computed from each candidate inflection point.  The global 
minimum is associated with a low flow, but there is a much higher flow inflection point that 
improves the overall fit substantially.

In versions 6.4 and later, you can plot these residuals by pressing the View Computed Residuals 

button.  

By constraining the inflection-point candidates to a particular flow range, users can force the model 
to select a local minimum and specify an inflection point that is more morphologically meaningful.  
The tool includes three options to constrain the search range:
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The Upper Half and Lower Half methods split the data and search the specified half for a local 
minimum, or users can specify a range over which the algorithm will search for a minimum.  

The following figure fits a piecewise linear model to the same data that set the inflection point at 
14cfs above, but searches for an inflection point above 1,000 cfs.  The rating curve below the 
inflection point is very similar to the simple power function, but the piecewise linear model fits those 
higher flows better.
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Finally, if the analyst has a physical justification for specifying an inflection point at a particular flow, 
the tool includes a User Specified option.  In this option, the algorithm will assume the specified 
inflection point and minimize the slopes above and below it for the lowest error regression.

Do Not Use Inflection Points on the Edge of the Range

Be careful of inflection points on the edge of the range.  If you constrain the range to half the 
data, and the algorithm computes the median flow as the inflection point, it did not find a local 
minimum in the specified half of the data.  Both the local and global minimum are outside the 
range, and a larger range should be used.  This is also the case if the inflection point corresponds 
to either end of the user-specified range.
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Use Temporal Averaging with Piecewise Linear Regression

Like all of the statistical tools, the piecewise linear model assumes data points are independent.  
Analyze the data for autocorrelation and apply any temporal averaging before selecting a final 
rating curve.
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Stationarity
The relationship between flow and load can change systematically over time.  If you cannot assume 
that the relationship between flow and load is "stationary" (constant over time), it may not be 
appropriate to use all the data for an analysis or model.  For, example, when calibrating a model in a 
system with a non-stationary sediment data, it is appropriate to use the historic rating curve that 
reflects the data over the calibration period.  Alternately, when forecasting, it is appropriate to use a 
rating curve based on the most recent relationship.  Scientists and modelers should always - at a 
minimum - evaluate their data stationarity.  But if sediment data are non-stationary, they must 
partition their data to develop a rating curve appropriate for the time period under consideration.

The rating curve calculator includes stationarity tools that allows users to visualize stationarity by 
plotting the data before and after a selected year in different colors, and reports separate rating 
curves for those before and after data.

The Stationarity Slide Bar

By default the rating curve data uses all the data available.  For example, in the first image below, the 
tool fits a single, bias-corrected, power function through a data set.  The Stationarity tool partitions 
the data by date to visualize and quantify temporal trends.  The Stationary tool provides a scroll bar 
that spans the time between the earliest and latest measurement.  Users can then move the bar to 
evaluate stationarity across different dates.  The date before and after the selected year will plot in 
different colors to help visualize non-stationarity.  For example, the second figure below uses the 
same data as the first, but plots the measurements prior to 1953 in yellow and those after in purple.  
The older data trend higher, but were also collected over a larger range of flows.  This is typical of 
changes observed after dam constrcution.
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Warning - Stationarity Analysis Requires Temporal Data

The rating curve calculator can fit a bias corrected rating curve (or a piecewise linear model) to 
sediment data without any temporal data.  Users can input simple, paired, flow-load/
concertation information  without dates or times and use these features.  But stationarity is a 
temporal analysis.  The stationary options will only be available if the data include dates and 
times.



Wish List - Additional Stationarity Methods
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Temporal Averaging and Autocorrelation
Sampling programs sometimes take multiple sediment measurements in a single sampling event. 
Because of sediment's natural variability, these sediment loads can vary dramatically, even though 
they were collected a few minutes or hours from each other and at about the same flow.  The gage 
below includes a number of these multi-measurement, same-day replicates. 

The vertical "striations" in the data often indicate these kinds of same-day replicates.

We would like to add several additional stationarity analysis methods, including color coding 
data by date (e.g. monochrome plotting with the lightest tone earliest and the darkest latest) or 
color coding the data by temporal bins (e.g. decades).  We would also like to compute load for a 
given flow(s) with the before and after rating curves for the entire date range to explore how the 
rating curves evolve over time.
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Regression analysis assumes each observation is independent.  But these same-day replicates often 
are not.  In this gage, the historical data mostly include single sample measurements.  Therefore, if 
the regression analysis considered each contemporary replicate as an independent sample, it would 
overrepresent these data.
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Temporal Averaging

The temporal averaging/autocorrelation tool allows users to automatically average replicates 
collected within a specified time frame.  This control reports the number of "clusters" which are the 
collections of replicates that fall within the specified time threshold of each other (12 hours by 
default).  At this gage, 2400 measurements fall within 12 hours of another measurement, and they 
group into 207 12 hour clusters.  97% of these data were collected as multi-measurement replicates 
within a single sampling event.

The Mode provides two options.  The tool plots all the data and computes the regression as if they 
are independent by default.  This can be appropriate for small rivers with flashy hydrographs, where 
samples collected in close succession have very different flows.  But for large rivers, it is almost 
always appropriate to average these temporal clusters.
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At this gage, averaging the clusters reduces the power of the contemporary measurements and 
generates a higher rating curve (though the analyst should also note the non-stationarity and decide 
if it is appropriate to use all of the data).  The plot replaces the replicates with the cluster-average 
loads or concentrations (red).  The Sediment Rating Curve Analysis tool also marks the 
measurements that fall within the time tolerance of other measuremnts in the data grid.

Setting the Temporal Averaging Threshold

By default, the temporal averaging tool averages observations collected within 12 hours of each 
other.  But that time threshold is variable.

To change it, go to Options → Correlation Analysis.  

This opens an editor that allows users to set the temporal averaging threshold.
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Plotting Original and Averaged Points

By default, the temporal averaging tool only plots the average measurements.  However, under 
Options → Correlation Analysis users can select Show Points.  This plots both the average and the 
averaged data so users can see the original measurements.

The plot below includes single-measurement observations (grey), replicates (green) and replicate 
cluster averages (red).  The green line is the unbiased regression for all of the measurements.  The 
red is the unbiased regression of the single-measurement observations and the temporal averages.
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Hysteresis Visualization
A process that is path dependent, that takes a different path on the way up than it does on the way 
down, has hysteresis.

Sediment load data often has hysteresis.  Loads are often higher on the rising limb of the hydrograph 
than they are on the falling limb of the hydrograph.

The data below include the flow hydrograph and sediment time series measured at the Porto Velho 
gage on the Madeira River (right).  The plots on the left show the sediment measurements from water 
years 2011 and 2014 connected in time.  This system has strong clockwise hysteresis (sediment loads 
are much higher on the rising limb of the hydrograph than the falling limb).
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Sediment modelers and scientists often lose track of hysteresis effects when we simply plot flow vs 
load or concentration as temporally naïve paired data.

Because a rating curve does not distinguish between the rising and falling limb of a hydrograph, but 
make a 1-to-1 relationship between flow and load, the hysteresis tools in this software do not affect 
the rating curve or calculations.  However, it can be very useful to visualize hysteresis.  In some cases, 
this may motivate modelers to use a sediment time series for a model boundary condition instead of 
a rating curve).   

The Rating Curve Analysis Tool connects sediment measurements collected in the same water year.  
Type in a water year or move the scroll bar to track the temporal path of the observations in that 
year.  The gage below is plotting the hysteresis associated with a 2011 event, which delivered much 
more sediment on the rising limb than the falling limb.
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Analytical and Tabular Rating Curve Results
After the analyses and visualization, modelers and analysts eventually will want to reproduce the 
rating curve.  To get the rating curve results, go to the Results tab (that is grouped with the Controls
in the standard layout). 



Hydraulic Design (HD) Calculators

HEC-RAS User's Manual– 584

•
•

This tab provides two types of results:

Regression Results that will help reconstruct an analytical power function and
Rating Curve Output, which computes the loads for user specified flows in a tabular format

Regression Results (Analytical Results)

The Regression Results provide the ingredients to reconstruct the 

By default, the tool computes the unbiased regression (with both correctors) for all the data and the 
temporally averaged data.  The tool offers these regressions by default because averaging replicates 
and bias correction are best practices for most applications.  The parameters fit the equation

Qs = E a Q b

where Qs is the sediment load (or concentration if the analysis used concentration), a and b are the 
coefficient and the power, and E is the bias corrector (Duan or Ferguson).  So, the results in the figure 
above translate into an analytical rating curve of:

Qs = (1.1596) 0.0026445 Q 1.5395

with the Duan correction of the temporally averaged data.
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Regression Results from Stationarity Analysis

If you use the Stationarity Control (e.g. the results below are associated with the stationarity control 
bar also pictured below) the analytical rating curve results will also populate the coefficients for the 
"historic" and "contemporary" regressions.  The historic regression includes the data before the 
split-year selected in the stationarity scroll bar and  the "Contemporary" coefficients reproduce the 
power function fit to the data points more recent than the stationarity threshold.

For example, in this analysis, the measurements before 1994 (with the Duan correction) yield a rating 
curve of:

Qs = (1.2015) 4.836E-8 Q 2.6154

while the data after 1994 (with Duan) yield:

Qs = (1.2015) 0.002941 Q 1.5203

Piecewise Linear Regression Does Not Have an Analytical Result

Because the piecewise linear regression is actually two power functions forced to connect within 
the data domain, it cannot be characterized by a single set of power-function coefficients.  Use 
the below feature (the tabular rating curve) to generate a piecewise rating curve (and make sure 
you select one point at or very close to the inflection point).
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Generating a Tabular Rating Curve (Tabular Results)

HEC-RAS sediment, rating-curve boundary conditions require a tabular flow-load or flow-
concentration rating curve.  An example of a flow-load rating curve boundary condition in the HEC-
RAS sediment model is included below.

The tabular data requires user input.  It is blank by default.  The user must input flows (see figure 
below).  When the user inputs flows, the tool will compute loads with the active methods (the 
methods used in the Control menu).  In the example below, the user input four flows and the tool 
returned the biased and unbiased results, assuming all measurements were independent and the 
unbiased results (with the method selected in the Controls menu - Duan in this case) with temporal 
averaging.  The tool returns the Unbiased, Temporally Averaged results by default, because these 
are considered best-practice for most systems.  These results were transposed into the HEC-RAS 
sediment boundary condition above.

https://www.hec.usace.army.mil/confluence/rasdocs/rassed1d/1d-sediment-transport-user-s-manual/entering-and-editing-sediment-data/sediment-boundary-conditions/rating-curve
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Piecewise Linear Result

Flow-load power functions can be defined with two points (these points should bound the highest 
and lowest flows expected, not the highest and lowest flows observed in the data).  But a piecewise 
linear result requires at least three, and should include a point at or very close to the inflection point 
(i.e. the "knot").  For example, in the result below, the user has only entered bounding flows (high 
and low) in the tool.  The tool is providing an error message, that to get good results from the 
piecewise linear tool, they must include a flow close to the inflection point (or knot).

Logarithmically Interpolate Between Tabular Results

The tabular results reproduce the rating curve with two or more points.  To compute loads for 
other flows, modelers and scientists will have to interpolate between these flow-load pairs.  But 
these are logarithmically distributed data that fall along a power function (log transformed linear 
relationship).  A simple linear interpolation is not appropriate.  HEC-RAS log-interpolates 
between these data.  Other applications should as well.
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When the user copies the inflection point for the piecewise linear analysis into the flow data, the tool 
generates a three-point curve and the error goes away.
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Gradation Trend Analysis
Multiple grain class sediment models not only require flow-load or flow-concentration rating curves, 
they also require users to partition those loads by grain class.  Sediment transport is very sensitive to 
the size distribution of the transporting sediment.  HEC-RAS requires not-only a flow-load/
concentration relationship but also requires users to specify the fraction of each grain class 
associated with each load.

Wish List - Local Regression

We would like to add LOESS local regression analysis to fit independent but continuous non-
linear relationships to different portions of the curve.  These approaches do not devleop simple 
analytical equations, but could generate tabular results that could feed a model.



https://www.hec.usace.army.mil/confluence/rasdocs/rassed1d/1d-sediment-transport-user-s-manual/entering-and-editing-sediment-data/sediment-boundary-conditions/rating-curve#RatingCurve-Load-GradationData:
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Estimating the grain-class partition of each load is often the most difficult boundary condition to 
estimate in a sediment model.  The data are often scarce, and when the exist, they are usually noisy.  
HEC added a gradation analysis tool to the Sediment Rating Curve Calculator to help modelers and 
scientists to visualize and quantify these trends.

Suspended Load Gradation Trends

Suspended load can fine or coarsen with flow, or remain approximately the same.  This process 
diversity complicates gradational trend analysis.  The figure below includes data from a gage that 
coarsens with higher flows and another that fines.  Gibson and Cai (2017) describes these trends and 
provides some context for these trends.

Load Gradations Must Include Bedload

Most of the sediment load and gradation data downloaded from the USGS are suspended load 
measurements.  But river morphology is disproportionately sensitive to the bed load gradations.  
Therefore, even thought bed load might be a small percentage of the load, augmenting the 
suspended load gradations with bed load grain classes is often essential to get a sediment model 
to reproduce prototype behavior.  Some gages have bedload data and future versions of this tool 



https://agupubs.onlinelibrary.wiley.com/doi/full/10.1002/2016WR020135
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Viewing Suspended Load Gradations

If a gage has gradation data associated with flows, the Sediment Rating Curve analysis tool will 
automatically import them.  The importer groups gradation data assigned to the same sample, 
builds a geotechnical (% finer) curve and computes gradation statistics for each sample.

To view the gradations, select the Flux Gradation tab on the main plot of the tool.  This provides two 
different visualizations of the gradation data.

The plot on the left is a monochromatic plot of the gradation curves.  The monochromatic color 
scheme plots by flow, so gradations associated with lower flows are light blue and those associated 
with higher flows are darker.  For the gage pictured above, the lighter colors plot to the upper left, 
and the darker lines plot to the left, which means the higher flows are coarser.  

The visualization on the right plots summary statistics against flow.  The gage pictured above depicts 
the d85 tending up with flow, also indicating flow-coarsening. 

may import and integrate those measurements.  But bed load data are rare and bed load 
gradations are more rare.  Modelers must use scientific intuition to add bed load gradations 
based on the bed material and often adjust these fractions during calibration.

Wish List: Binning, Bed Load, and Statistics

There are several statistical and visualization strategies that can help users understand the 
trends in these data, which can be very noisy, and are not always monotonic.  We would like to 
add binning, regression, and other visualization and summary tools, including several included 
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LOESS

LOESS Local Regression Overview

LOESS is a non-parametric, localized regression model that develops a rating curve over smaller 
ranges of flows than the standard regression or piecewise linear.    This can generate a more detailed 
flow-load or flow-concentration relationship that you can use to develop a rating curve with multiple 
inflection points or to evaluate the inflection point of a piecewise linear or polynomial (in future 
versions) rating curve.  LOESS does not extrapolate beyond the data, so it does not replace the other 
models.  But i

in Gibson and Cai (2017).  We would also like to import bed load data and gradations where 
available and find intuitive ways to plot those with the suspended data and integrate them into 
the summary results.

  

https://agupubs.onlinelibrary.wiley.com/doi/full/10.1002/2016WR020135
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LOESS fit with a 0.5 span of Big Blue River at Randolph, KS (USGS Gage 06886000)

This video presents an accessible introduction to the basic ideas behind this approach (including a 
discussion of the "span") in HEC-RAS:

(This video is even simpler and shorter, if a little quirky).

Calculate LOESS

Press the Calculate LOESS button to compute and plot the local regression curve with whichever 
span is selected (see section on selecting a span below) 

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=b7oryuMP3r8

https://youtu.be/Vf7oJ6z2LCc
http://youtube.com/watch?v=b7oryuMP3r8
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Selecting a Span

A span of 0.1 includes 10% of the data in each local regression, weighing the observations closer to 
the evaluation flow  more than those farther away.  The  span  of 0.5  includes half the observations  
in each local regression, and the span of 1.0  includes all of the  points  in each calculation, but 
weights the observations closer to the evaluation flow more than those farther away, so the  local 
regression for each flow is still variable, but the curve  is smoother.  

Smaller spans put more weight on local trends and perturbations, and run the risk of over-fitting 
(following random perturbations in the data too closely and incorporating noise into the model).  
Large spans smooth the data but could  miss detailed trends.  For sediment  work, it  usually makes 
sense  to select  a larger span and avoid the noise of overfitting.  In  the case pictured  above, the 
span  (0.5)  closest to the recommended value (0.45 - see the  next section) is  probably the  best  
model for these data).

Computing a Span

A larger span smooths the curve because it considers more of the data at each point of the local 
regression.  HEC-RAS includes two methods (GCV and AICC) to compute an appropriate span that 
balances the tradeoffs between over-fitting (span too small) and over-smoothing (too large).  Press 
the Predict Optimal Span button to run these algorithms.  (Note: These are relatively 
computationally expensive and can take up to a minute).  HEC-RAS will report the span that 
minimizes GCV and AICC in the Optimal Span field.  Users can then use that number (or experiment 
with numbers in that vicinity) in the Calculation Span field and re-Calculate LOESS. 
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To evaluate the span metrics users can select View LOESS Prediction Graph which plots the GCV 
and AICC metrics for the whole range of spans.  In the example below, the 0.5 is the minimum of both 
metrics, but the results from 0.4 to 0.7 are relatively consistent, so anything in this range would be 
appropriate.

Harvesting a Rating Curve

One of the liabilities of LOESS is that it does not generate a "closed form solution" (i.e. an equation 
like Qs=aQ^b).  Therefore you will need to pick flow-load pairs off the chart (the most recent version 
of 6.4 does not 

References

This method was developed with help from Dr. Andrew Blandino who provided this technical 
documentation of the method.

Cleveland, W.S. (1979) "Robust Locally Weighted Regression and Smoothing Scatterplots," Journal of 
the American Statistical Association, Vol. 74, pp. 829-836.
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Sediment Time Series and Average Annual Load
There are two main reasons scientist and engineers develop sediment rating curves.  One is to 
develop a flux boundary condition for a sediment transport model (like 1D or 2D mobile-bed HEC-
RAS).  But the other main reason to develop a sediment rating curve is to compute a term for a 
sediment budget.  Sediment budgets are usually computed in terms of average annual load.  
Computing the average annual load requires analysts to 1) compute a sediment rating curve, 2) 
convert a flow time series (hydrograph) into a load time series (sedigraph) and 3) annualize that time 
series into a tons/year term.

When the Rating Curve Calculator downloads data from a USGS gage, it can now do all of those steps 
automatically.  The Time Series tab of the Rating Curve Calculator will download all the flow data 
associated with the sediment gage, apply the user specified rating curve to compute sediment loads 
for each flow, and compute an average annual load.

Downloading Flow Data from the USGS

The US Geological Survey serves flow data from a different API than the sediment data.  The Rating 
Curve Calculator already downloads these data to fill in flows for sediment samples that are not 
paired with flows.  In the future, the tool will download these data automatically, but for now, in 
order to develop the sediment time series, always press the bottom button when importing the 
sediment data that says Import With USGS Daily Flows.

Viewing your Sedigraph

Make the choices in the rating curve calculator that you think are appropriate to develop your flow-
load or flow-concentration relationship.  The tool will automatically use the active choices in the 

Wish List: Import Flows From Other Sources

This feature is not currently available for non-USGS analyses.  The Rating Curve Calculator can 
import sediment data from csv files (or pasted from excel) but it can not import flows from either 
of those sources yet, making this feature temporarily unavailable.
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rating curve Controls to convert flows to sediment load.  The Sedigraph should update as you 
change the rating curve assumptions.  Press the Time Series tab to view the Sedigraph with the 
hydrograph.

In the figure above, the blue line is the flow hydrograph, the brown line is the sedigraph (sediment 
time series) computed based on the rating curve decisions represented in the Controls (e.g. Duan 
bias correction and a Piecewise Linear regression for all data).  The black points are actual sediment 
measurements (from the rating curve) plotted as a time series with the computed sedigraph.
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Computing Average Annual Load

The tool automatically computes the Average Annual Load and updates it based on new rating curve 
decisions.  the Tool reports this number on the Results tab.

Development Plan
Known issues

Issue  Jira 

Annual Load Does Not Update RAS-2533

Saving Issues RAS-2259

Plot Biased Rating Curves by Default RAS-2548

Cluster colors override stationarity RAS-2595

Pressing Delete and CtrlV crashes 

Check animations (for performance impact) Done

Precompute LOESS and LMSE on SI Convert

Menu issues

Improvements
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Improvement Jira

Report PW coefficients RAS-2549

Convert btwn US Cust and SI RAS-2619

Plot Gradation Bins RAS-1372

Make PW sensitive to Stationarity

Apply PW to Temporally Stratified Flows

Convert SI RAS-2546

Import SI

Filter Low Flows RAS-1170

Report SSE for All methods

Average All Gradations RAS-2245

Plot AEP and RI Flows

Filter Data (Low Data and Outliers)

Features

New Features Jira

Import Sampling Meta Data RAS-1590

Serial Correlation Algorithm RAS-1171

Other WQ Parameters RAS-1200

Compute Effective Flow

Quantitative Non-Stationarity

Stratify by Rising limb and falling limb
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12 TROUBLESHOOTING WITH HEC-RAS
For a steady flow analysis, the HEC-RAS software is designed to continue its computations all the 
way through completion, even when the user has entered poor data. Because of this, the fact that 
the program executes a complete run does not necessarily mean that the results are good. The user 
must carefully review the results to ensure that they adequately represent the study reach and that 
they are reasonable and consistent. The HEC-RAS software is an engineering tool, it is by no means a 
replacement for sound engineering.

The HEC-RAS software contains several features to assist the user in the development of a model; 
debugging problems; and the review of results. These features include: built in data checking; an 
Errors, Warnings, and Notes system; and a computational Log Output file. In addition to these 
features, the user can use the graphical and tabular output to review the results and check the data 
for reasonableness and consistency. 
Most of the information contained within this chapter is based on performing a steady flow analysis. 
Much of the information is also useful when performing an unsteady flow analysis. More assistance 
for solving unsteady flow stability problems can be found in Chapter 7 of this manual (Performing a 
1D Unsteady Flow Analysis).

Built in Data Checking
The HEC-RAS user interface has two types of built in data checking. The first type of data checking is 
performed as the user enters the data. Each data field of the data entry editors has some form of 
data checking. The second type of data checking occurs when the user starts the steady flow or 
unsteady flow computations. When the user presses the compute button, on the steady flow or 
unsteady flow analysis window, the entire data set is processed through several data checks before 
the computations begin. A detailed discussion of each of these two data checking features is 
described below.

Checking the Data as it is Entered
This type of data checking occurs whenever the user enters data into a single data field or table. 
Once the user leaves a particular data entry field or table, the program will automatically check that 
data for reasonableness. The following is a list of some of the types of data checks that are 
performed:

Minimum and maximum range checking for variables.
Alpha and numeric data checks. This is done to ensure that the right type of data is entered in each field.
Increasing order of station for cross sections, bridge deck/roadway, and abutments.
Data consistency checks (i.e., when the main channel bank stations are entered, the program checks to see if 
they exist in the cross section station and elevation data).
Data deletion warnings. When you delete data the software will give you a warning before it is deleted.
File management warnings (i.e., program will give you a chance to save the data to the hard disk before the 
program is closed, or a different data set is opened).
Data geometry checks (i.e., when a bridge deck/roadway is entered, the program checks to ensure that the 
deck/roadway intersects with the ground data).
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Data Checking before Computations are Performed
The second type of data checking is performed to evaluate the completeness and consistency of the 
data. This type of data checking occurs before the computations take place. When the user presses 
the Compute button on the Steady Flow or Unsteady Flow Analysis window, the program will 
perform a series of data checks before the computations are allowed to proceed. If any data errors 
are found, the program will not perform the computations. The following is a list of some of the types 
of checks that are made during this time:

Data completeness. These data checks insure that all of the required data exists for the entire data set. If any 
missing data are found, a complete list of all the missing data and their specific locations is displayed on the 
screen. An example of this is shown in the figure below.
Data consistency. This type of data checking is performed to ensure that the data is consistent with the 
computations that are being requested. For example, if the user asks to perform a mixed flow regime 
computation, the program checks to ensure that upstream as well as downstream boundary conditions 
have been specified. Likewise, if an encroachment analysis is requested, the program checks to ensure that 
the number of profiles lines up with the number specified in the encroachment data. There are several other 
checks of this type.

Data Completeness Checking Window

Errors, Warnings, and Notes
The HEC-RAS software has a system of Errors, Warnings, and Notes that are passed from the 
computation programs to the user interface. During the computations, the computation programs 
will set flags at particular nodes (nodes are cross sections, bridges, culverts, or multiple openings) 
whenever it is necessary. These message flags are written to the standard output file, along with the 
computed results for that node. When the user interface reads the computed results from the output 
file, if any errors, warnings, or notes exist, they are interpreted and displayed in various locations 
from the interface.

The user can request a summary of all the errors, warnings, and notes that occurred during the 
computations. This is accomplished by selecting Summary Errors, Warnings, and Notes from the 
View menu on the main HEC-RAS window. Once this is selected, a window will pop up displaying all 
of the messages. The user can select a specific River and Reach, as well as which Profile and Plan to 
view. The user has the options of expanding the window; printing the messages; or sending them to 
the windows clipboard. An example of the Errors, Warnings, and Notes window is shown in the figure 
below.
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Summary of Errors, Warnings, and Notes Window

Besides the summary window, messages will automatically appear on the cross section specific 
tables. When a cross section or hydraulic structure is being displayed, any errors, warnings, or notes 
for that location and profile will show up in the Errors, Warnings, and Notes message box at the 
bottom of the table. An example of this table is shown in the figure below.

In general, the errors, warnings, and notes messages should be self explanatory. The three 
categories of messages are the following:

Errors: Error messages are only sent when there are problems that prevent the program from being able to 
complete the run.
Warnings: Warning messages provide information to the user that may or may not require action on the 
user's part. In general, whenever a warning is set at a location, the user should review the hydraulic results 
at that location to ensure that the results are reasonable. If the hydraulic results are found to be reasonable, 
then the message can be ignored. However, in many instances, a warning level message may require the 
user to take some action that will cause the message to disappear on future runs. Many of the warning 
messages are caused by either inadequate or bad data. Some common problems that cause warning 
messages to occur are the following:

Cross sections spaced to far apart. This can cause several warning messages to be set.
Cross sections starting and ending stations not high enough. If a computed water surface is higher 
than either end point of the cross section, a warning message will appear.
Bad Starting Water Surface Elevation. If the user specifies a boundary condition that is not possible 
for the specified flow regime, the program will take action an set an appropriate warning message.
Bad Cross Section Data. This can cause several problems, but most often the program will not be 
able to balance the energy equation and will default to critical depth.

Notes: Note level messages are set to provide information to the user about how the program is performing 
the computations.
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Cross Section Table with Errors, Warnings, and Notes

Steady Flow Log Output
This option allows the user to set the level of the Log file for a steady flow analysis. This file contains 
information tracing the program process. Log levels can range between 0 and 10, with 0 resulting in 
no Log output and 10 resulting in the maximum Log output. In general, the Log file output level 
should not be set unless the user gets an error during the computations. If an error occurs in the 
computations, set the log file level to an appropriate value. Re-run the computations and then 
review the log output, try to determine why the program got an error.

When the user selects Set Log File Output Level from the Options menu, a window will appear as 
shown in the figure below. The user can set a "Global Log Level," which will be used for all cross 
sections and every profile. The user can also set log levels at specific locations for specific profiles. In 
general, it is better to only set the log level at the locations where problems are occurring in the 
computations. To set the specific location log level, first select the desired reach and river station. 
Next select the log level and the profile number (the log level can be turned on for all profiles). Once 
you have everything set, press the Set button and the log level will show up in the window below. 
Log levels can be set at several locations individually. Once all of the Log Levels are set, press the OK
button to close the window.
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Log File Output Level Window

Unsteady Flow Log Output
The unsteady flow computation program can write out a detailed log file of its computations. This 
file is very different from the steady flow program, but serves the purpose of debugging 
computational problems. This option is turned on by selecting Output Options from the Options 
menu on the Unsteady Flow Analysis window. When this option is selected a window will appear as 
shown in Figure 10-5.

Warning

Setting the global log output level to 4 or 5 can result in very large log file output. Global log level 
values of 6 or larger can result in extremely large log files.
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Unsteady Flow Output Control Window

As shown in the figure above, this option controls various types of output. To turn on the detailed log 
output, the user must check the box labeled Write Detailed Log Output for Debugging. The user 
has the option for setting a time window, which will limit the output to only within this time frame. 
After this option is selected, the computations must be rerun in order for the output to be produced.

Viewing the Log File
This option allows the user to view the contents of the log file. For steady flow analyses, the user 
brings up the log output by selecting View Log File from the Options menu of the Steady Flow 
Analysis window. For unsteady flow analyses, the user brings up the log output by selecting View 
Computation Log File from the Options menu of the Unsteady Flow Analysis window. The interface 
uses the Windows Write program to accomplish viewing the output (unless the user has set a 
different program to be used as the default file viewer). It is up to the user to set an appropriate font 
in the Write program. If the user sets a font that uses proportional spacing, the information in the log 
file will not line up correctly. Some fonts that work well are: Line Printer; Courier (8 pt.); and 
Helvetica (8 pt.). Consult your Windows user's manual for information on how to use the Write 
program.

Reviewing and Debugging the Normal Output
After the user has successfully completed a run, and reviewed all the errors, warnings, and notes, the 
normal output should be reviewed for consistency and reasonableness.

Viewing Graphics
In general, the graphical output should be used as much as possible to get a quick view of the 
results. The user should look at all of the cross sections with the cross section plotting capability. The 
cross section plots will assist the user in finding data mistakes, as well as possible modeling mistakes 



Troubleshooting With HEC-RAS

HEC-RAS User's Manual– 606

1.

2.

3.

4.

(mistakes in ineffective flow areas, levees, n values, etc.). 
The profile plotting capability is a good way to get a quick overview of the entire study area. The 
user should look for sudden changes to the energy grade line and the water surface. In general, these 
two variables should transition smoothly along the channel. If the user finds rapid changes in the 
energy or the water surface, the results at those locations should be reviewed closely to ensure that 
they are correct.
The X-Y-Z Perspective Plot can also be used to get a quick view of an entire reach. This plot is very 
helpful for viewing the top width of the flow area. If the user finds dramatic changes in the top width 
from one cross section to the next, then the results at those locations should be reviewed closely. 
Dramatic changes in top width may indicate the need for additional cross sections.

Viewing Tabular Output
There are several types of tabular output. The user should try to make use of all of them when 
viewing tabular results. In general, the profile summary types of tables should be used to get an 
overview of some of the key variables at several locations. If any problems are found, or any results 
that seem suspect, the user should use the detailed output specific tables to get detailed results at a 
single location.

The Occurrence of Critical Depth
During the steady flow water surface profile calculations, the program may default to critical depth 
at a cross section in order to continue the calculations. Critical depth can occur for the following 
reasons:

Bad cross section data: If the energy equation can not balance because of bad cross section data, the 
program defaults to critical depth.
Program can not balance the energy equation above or below the top of a levee or ineffective flow area: On 
occasion, when the program is balancing a water surface that is very close to the top of a levee, or an 
ineffective flow area, the program may go back and forth (above and below the levee) without being able to 
balance the energy equation. When this occurs, the program will default to critical depth.
Cross sections spaced too far apart: If the cross sections are spaced to far apart, the program may not be 
able to calculate enough energy losses to obtain a subcritical water surface at the upstream section.
Wrong flow regime: When calculating a subcritical profile, and the program comes to a reach that is truly 
supercritical, the program will default to critical depth. Likewise, when calculating a supercritical profile, if 
the reach is truly subcritical, the program will default to critical depth.

Computations Do Not Run to Completion
While running the computational part of the software, when the steady flow program is finished you 
should get the message "Finished Steady Flow Simulation" or "Finished Post Processing," for an 
unsteady flow run. If the user has entered bad data, the computational program may not be able to 
run to completion. When this happens the program will stop and write an error message to the 
screen. This message may be a trapped error by the program, or it could be just a generic Fortran 
error message. Fortran error messages come from the Fortran compiler that was used to develop the 
computational program. The message basically says that a math error occurred and therefore the 
program could not continue. When this type of error occurs, it is most often a data input problem. 
There is a possibility that it could be a bug in the program, but the user should exhaust all the 
possible data input errors before assuming that the program has a "Bug."
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The first step in finding the problem is to realize where the error is occurring. For a steady flow 
analysis, the program will display which cross section it is working on, and for which profile. This 
means that the error occurred at that cross section (or hydraulic structure, such as a bridge). Go to 
the Geometric Data editor and review the input data closely at the problem location.
During an unsteady flow analysis, the program displays the time step that it is working on and the 
number of iterations it took to solve the equations. As the program is running, if it consistently goes 
to the maximum number of iterations (20 is the default), the user should take not of the time step 
that this started to occur. The user must turn on the detailed log output, and then review that output 
in the vicinity of that particular time step, in order to figure out what is going wrong.

Computational errors often occur at bridges. Check your data closely for any inconsistencies in the 
bridge geometry. Many of the problems that occur at bridges are due to bad Deck/Roadway data. Go 
to the Bridge/Culvert Data editor and turn on the option Highlight Weir, Opening Lid and Ground
from the View menu. This option will assist you in finding any geometric mistakes in the bridge data.
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13 PERFORMING CHANNEL DESIGN/MODIFICATIONS
The channel design/modification tools in HEC-RAS allow the user to perform a series of trapezoidal 
cuts into the existing channel geometry or to create new channel geometry. The current version of 
HEC-RAS has two tools for performing channel modifications. These tools are available from the 
Tools menu of the Geometric Data editor and are labeled Channel Design/Modification and 
Channel Modification (original). The tool labeled Channel Design/Modification is a new tool for 
HEC-RAS as of version 4.0. The tool labeled Channel Modification (original) is the original channel 
modification tool developed for HEC-RAS. The original channel modification tool has been left in 
HEC-RAS for those user's who may prefer this tool to the new one. Both channel modification tools 
will be described in this chapter. In general, these tools are used for planning studies, but it can also 
be used for hydraulic design of flood control channels.

This chapter does not cover the concepts of stable channel design. This software is designed to 
evaluate the hydraulics of various channel modifications. It is up to the user to ensure that any 
channel modification will not cause further scour of the channel bed and banks. Discussions on 
stable channel design can be found in many hydraulic text books, as well the Corps Engineering 
Manual "Hydraulic Design of Flood Control Channels" (USACE, 1991).

This section discusses: general modeling guidelines for using the channel modification option; how 
to enter the necessary input data; performing the channel modifications; and how to compare 
existing condition and modified condition results.

General Modeling Guidelines
In order to perform a channel modification analysis, the user should first develop a hydraulic model 
of the existing river reach containing the area in which the channel modification will be analyzed. 
This model should include several cross sections downstream from the study reach, such that any 
user defined downstream boundary condition does not affect the hydraulic results inside the 
channel modification region. The model should also include several cross sections upstream of the 
study reach, in order to evaluate the effects of the channel modification on the water surface profile 
upstream.
Once a model of the existing river system is completed, the user can use the Channel Modification 
(old tool) or Channel Design/Modification tools to perform trapezoidal cuts and fills into the existing 
geometry. Once the user has performed all of the desired channel modifications, then the modified 
geometry data is saved into a new geometry file. The user can then create a new plan, which 
contains the modified geometry and the original flow data that was used under the existing 
conditions plan. Computations can then be performed for the modified condition, and the user can 
compare the water surface profiles for both existing and modified conditions.

The Channel Modification (original) Options
Multiple trapezoidal cuts (up to three)
Independent specification of left and right trapezoidal side slopes
Ability to change the Manning's n value for the trapezoidal cut
Separate bottom widths for each trapezoidal cut
Ability to set new channel reach lengths
Multiple ways of locating the main channel centerline
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User can explicitly define the elevation of the new channel invert, or it can be based on the original channel 
invert, or it can be based on projecting a slope from a downstream cross section or an upstream cross 
section
The centerline of the trapezoidal cut can be entered directly, or it can be located midway between the 
original main channel bank stations
Option to fill the existing channel before performing cuts
Cut and fill areas and volumes are computed

Entering Channel Modification Data
Within HEC-RAS, the data for performing a channel modification analysis are entered from the 
Geometric Data window. The channel modification data are stored within the geometry file of the 
base geometric data (the geometric data set in which the channel modification is being performed 
on).

To bring up the Channel Modification Data window, select Channel Modification (original) from the 
Tools menu of the Geometric Data window. When this option is selected, a Channel Modification 
window will appear as shown in the figure below (except yours will not have any data in it the first 
time you bring it up).

Channel Modification Data Editor
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As shown in the figure above, there are several pieces of data that the user must enter in order to 
perform a channel modification analysis. The editor is divided into three separate areas. The top 
portion of the window contains selection boxes for the River and Reach; titles for the base geometry 
file and the modified geometry file; buttons for performing the cuts and viewing cut and fill volumes; 
and controls for rotating the graphic. The middle portion of the window contains a data input area 
for entering channel modification information over a range of cross sections, as well as a graphic of 
the cross sections that are being modified. The bottom portion of the window contains a table that 
lists the channel modification data for all of the cross sections in the selected Reach of a particular 
River.

The first step in performing a channel modification is to select the River and Reach in which you want 
to perform the analysis. This is accomplished from the River and Reach selection boxes in the upper 
left corner of the window. The next step is to select a range of cross sections in which you would like 
to perform a channel modification. This is accomplished by first selecting a cross section from the 
Starting Riv Sta box and then from the Ending Riv Sta box. Once this is done, all of the cross sections 
within the range of the specified starting and ending river stations will appear in the graphic on the 
right. The next step is to specify the channel modification data that you would like to apply to this 
range of cross sections. This is accomplished by entering information into the table contained in the 
"Set Range of Values" area of the window. This table allows the user to enter information for up to 
three cuts, which can then be applied to the selected range of cross sections. The information 
contained in this table is as follows:

Center Cuts (y/n): This column in the table is used to define how the trapezoidal cuts will be 
centered within the existing cross section data. If the user enters a "y" in this column, then that 
particular cut will be centered between the existing cross-section main channel bank stations. When 
all of the cut information is entered, and the Apply Cuts to Selected Range button is pressed, the 
program will automatically fill in the center stationing of the trapezoidal cuts in the lower table. If an 
"n" is entered, then it is up to the user to specify the center stationing for each cross section, and 
each cut, in the table at the bottom of the window.

Bottom Width: This column is used for entering the bottom width of the trapezoidal cuts. If this 
column is left blank, it is assumed that the bottom width will be zero. The user always has the option 
of directly entering the bottom width for each cross section in the table at the bottom of the window.

Invert Elevation: This column is used to specify the invert elevation of the trapezoidal cuts. If this 
column is left blank for a particular cut, then it is assumed that the invert elevation of that 
trapezoidal cut will be set equal to the invert elevation of the existing channel. If the user wants to 
have invert elevations that are not equal to the existing channel inverts, then they must enter 
elevations into this column and select one of the slope projection options below this table. The user 
has the option to use the specified invert elevations for each of the cross sections in the selected 
range; or they can enter elevations for the most upstream cross section and have the other invert 
elevations computed by projecting the cuts on a constant slope; or the elevations entered can be 
applied to the most downstream cross section of the range, and all others will be computed by 
projecting a user specified slope upstream.

Left Slope: This column is used to specify the slope of the left bank for each of the trapezoidal cuts. 
The slope is entered in units of horizontal distance to one unit in the vertical. (e.g., a value of 2 means 
the left bank slope will project 2 feet horizontally for every 1 foot vertically).
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Right Slope: This column is used to specify the slope of the right bank for each of the trapezoidal 
cuts. The slope is entered in units of horizontal distance to one unit in the vertical. (e.g., a value of 2 
means the right bank slope will project 2 feet horizontally for every 1 foot vertically).

Cut n Val: This column is used to specify the new Manning's n value to be applied to each of the 
trapezoidal cuts. If this column is left blank for any cut, then the existing n values will be used for that 
cut.
Once this table has been filled out, the user must select one of the three slope projection options 
listed below the table. The three options are:

Same Cut to all sections: If this option is selected, then the channel modification data entered into 
the table will be applied to all of the cross sections in the selected range.

Project cut from upper RS at slope: When this option is selected, the invert elevations that were 
entered into the table will be applied to the most upstream cross section in the selected range. The 
invert elevation of all of the other cross sections will be based on projecting a user entered slope 
from the most upstream cross section to each cross section downstream. The user must enter a 
slope when this option is selected. The elevations of each cross sections trapezoidal cuts are based 
on the user entered slope times the distance that each cross section is from the most upstream cross 
section. The distance is the cumulative main channel reach length for each of the individual cross 
sections.

Project cut from lower RS at slope: When this option is selected, the invert elevations that were 
entered into the table will be applied to the most downstream cross section in the selected range. 
The invert elevation of all of the other cross sections will be based on projecting a user entered slope 
from the most downstream cross section to each cross section upstream. The user must enter a 
slope when this option is selected. The elevations of each cross section's trapezoidal cuts are based 
on the user entered slope times the distance that each cross section is from the most downstream 
cross section. The distance is the cumulative main channel reach length for each of the individual 
cross sections.

A final option that can be applied to the selected range of cross sections is the Fill Channel option. 
When this option is turned on, the main channel of the base cross-section data will be filled before 
any of the trapezoidal cuts are applied. The main channel is filled to an elevation equal to the 
elevation of the lower of the two main channel bank stations.
Once the user has filled in all of the desired data in the "Set Range of Values" data area, then the 
Apply Cuts to Selected Range button should be pressed. When this button is pressed, the lower 
table is filled with the specific information that will be applied to each of the cross sections in the 
selected range. The cut information is then applied to each of the cross sections, and the graphic is 
updated to show both the existing cross section and the modified cross sections.

The user has the option of entering and modifying the channel modification data directly in the table 
at the bottom of the window, or they can use the "Set Range of Values" data area to apply a set of 
channel cut properties to a range of cross sections (this can be done several times for different 
ranges of cross sections within the reach). 
A final option available to the user is Cut cross section until cut daylights once. This is a global 
option that will be applied to all of the channel modification data. When this option is selected, as 
the program performs the cutting of the trapezoidal channel, the left and right banks of the channel 
will start at the bottom of the trapezoid and cut through the ground until they reach open air, then 
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the cutting will stop. If this option is turned off, the left and right banks of the trapezoid will be 
projected to infinity, continually cutting any ground that lies above them.

Performing the Channel Modifications
Once all of the desired channel modification data are entered for a reach, the user should press the 
Compute Cuts button at the top of the graphic. When this button is pressed, all of the channel 
modification data from the lower table is applied and the graphic is updated to reflect the new cut 
information. The user can continue to modify the data and press the Compute Cuts button as many 
times as is necessary to get the desired cuts. The cut information is always applied to the base 
geometry data.

Once the user has completed the desired channel modifications for the reach, they can view the cut 
and fill quantities by pressing the Cut and Fill Areas button. When this button is pressed, a window 
will appear as shown in the figure below.

Channel Modification Cut and Fill Quantities

The cut and fill quantities table shows the cut, fill, and net areas and volumes for each of the 
individual cross sections, as well as the totals for the reach. The table shows the cut and fill 
quantities that were necessary in order to transform the existing cross-section data into the modified 
cross-section data. The areas and volumes are provided in the categories of left overbank, main 
channel, right overbank, and total. These categories are based on the main channel bank stations of 
the base geometry data. The volumes listed at a particular cross section, represent the volume 
between that cross section and the next downstream cross section. The total volume and area at a 
particular cross section is the sum of the left overbank, main channel, and right overbank quantities 
for that individual cross section only. Total volumes for the entire reach are listed at the bottom of 
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the table. The Cut and Fill Quantities table can be printed, sent to a file, or copied to the clipboard, 
by pressing the desired button at the bottom of the window.

The channel modification option has been set up to work with one Reach of the model at a time. If 
the user needs to perform channel modifications to more than one reach of a multiple reach model, 
they can simply select a new reach at any time. While the information in the tables and the graphic 
only show a single reach, the channel modification information is stored for all of the reaches. 
Once the user has finished all of the desired channel modifications, for all of the desired reaches, a 
new geometry file should be created for the modified geometry. To create a modified geometry file, 
the user must enter a title for the modified geometry file in the upper right hand side of the window. 
Once the new geometry file title is entered, the file can be created by pressing the Create Modified 
Geometry button at the bottom of the window. When this button is pressed, a Save Geometry Data 
As window will appear. The user has the options to change the directory in which the geometry file 
will be stored, change the name of the geometry file title, or select an existing geometry file to over 
write. Once the user has decided on a title and a directory, the OK button can be pressed to save the 
modified geometry to the hard disk. However, the original geometry file is still the one that is in 
memory. If the user wants to work with the new modified geometry file, they will need to open it 
from the Geometric Data Editor window.

Note: the data entered into the channel modification editor is saved as part of the base geometry file 
(i.e., it is not saved with the modified geometry file). This allows the user to open the base geometry 
file and recreate the modified geometry. In order for this data to be saved, the user must select Save 
Geometry Data from the file menu of the geometric data editor, after they have entered the channel 
modification data.

The Channel Design/Modification Tool Options
Identifying river reach channel designs by Alternative
Independent specification of cuts for the left and right overbank (width, depth, side slopes, and Manning's n
values)
Ability to set new channel reach lengths
Identifying separate channel cut data in a Template
User can explicitly define the elevation of the new channel invert, or it can be based on the original channel 
invert, or it can be based on projecting a slope from a downstream cross section or an upstream cross 
section
The centerline of the trapezoidal cut can be entered directly, or it can be located midway between the 
original main channel bank stations
Option to fill the existing channel before performing cuts
Cut and fill volumes are computed

The general concept behind the Channel Design/Modification tool is that a user develops a cross-
section Template. The Template may then be applied to existing cross-sectional data (as performed 
historically in HEC-RAS) to perform Channel Modifications. The Template may be also be used in 
Channel Design to create new cross sections on a river reach.

Entering Channel Modification Data
Within HEC-RAS, the data for performing channel modifications are entered from the Geometric Data 
window. The channel modification data are stored within the geometry file of base geometric data 
(the geometric data set on which the channel modifications are being performed).
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To bring up the Channel Design/Modification data window, select Channel Design/Modification
from the Tools menu of the Geometric Data window. When this option is selected, a Channel Design/
Modification window will appear, as shown in the figure below.

Channel Design/Modification data editor.

As shown in the figure above, there are several pieces of data that the user must enter to perform 
channel modifications or create new cross sections. The editor is comprised of two main 
components: data entry and data visualization. The table at the bottom of the window displays a 
summary of all modifications (by "Alternative") that will be made to the selected River and Reach 
when new geometry is created. Several buttons are provided to allow the user to quickly enter data 
into the summary table. As data is entered into the editor the graphics plot in the upper portion of 
the window will be updated. Note that there are different graphic plots and each graphic plot may 
have more than one way to display data. Once data has been specified for the cross sections to be 
modified, the user may create a new geometry file by pressing the Create a Geometry File with 
these Modifications … button.
Identify the River and Reach to perform the channel modification and select or create a new Channel 
Design/Modification Alternative. This will update the channel modifications summary table, 
displaying the all of the cross sections for the selected River and Reach and cut data for the specified 
Alternative. You then have access to directly change the data in the table provided.

Alternatives

The Channel Design/Modification Alternative is used to group a set of cross section cut data. The 
default name for an Alternative is "Alternative #1", but may be renamed as desired. To the right of 
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the Alternative select list box are buttons that allow you to Create, Rename, Delete, or Copy an 
Alternative. These functions are also available from the Options menu. 
All of the data provided in the Channel Design/Modification Alternative data table is associated with 
the Alternative. Data that is displayed in black has been saved to the Alternative while that data 
shown in red has not. Switching between multiple alternatives will automatically save the data 
currently displayed in the Alternative.

When the summary data table showing the cross section cut data is loaded, some of the data comes 
from the existing cross sections and some comes from the modification data. Some of the data may 
be edited while the grayed out fields are set or computed internally. Manual entry of data may be 
performed on a cell-by-cell basis or over a selected range. Further, the Selected Area Edit Options 
may be used to automate data entry. Tool tips are provided for each of the buttons: Add, Multiply, 
Set, Replace, Interpolate, Copy Invert, Reset Lengths, and Reset Stations. The table fields and 
their use are described below.

River – This column identifies the River that the cross section is location on. It is not editable by the 
user.

Reach – This column identifies the Reach that the cross section is location on. It is not editable by 
the user.

RS – This column identifies the River Station of the cross section and is not editable.

Invert Elev. – This column displays the computed lowest point in the existing cross section. It is not 
editable by the user.

Template Elev. – This is the elevation at which the cross section Template will be applied. While this 
column is not directly editable, it is set based on the values applied in the Fixed Elev., Slope US, or 
Slope DS columns. By default the values in this column are copied from the Invert Elev. column.

LOB Length – This is the Reach Length for the Left Overbank. The default value displayed comes 
from the cross-sectional data.

Channel Length – This is the Reach Length for the main Channel. The default value displayed comes 
from the cross-sectional data.

ROB Length – This is the Reach Length for the Right Overbank. The default value displayed comes 
from the cross-sectional data.

Center Station – This is the station at which the center of the cross-section Template will be applied. 
The default value is computed as the center of the existing cross section between the main channel 
bank stations.

Template – This is name of the cross-section Template. The Template name is selected from a drop 
down list in the table. The user must create a Template using the Template Design editor prior to 
selecting one in the table. The Template contains several parameters not displayed in the summary 
table.

Fixed Elev. – This is the elevation at which the bottom of the Template will be applied to the cross 
section as fixed by the user. This value is copied to the Template Elev. column.

Slope US – The Template Elev. is computed using the Slope projected from the Upstream XS and the 
upstream Channel Length.



Performing Channel Design/Modifications

HEC-RAS User's Manual– 616

Slope DS – The Template Elev. is computed using the Slope projected from the Downstream XS and 
the current Channel Length.

Interp. Dist. – The maximum interpolation distance between the current cross section and the next 
cross section downstream. Leaving the Interp. Dist. field blank means that no interpolation is 
desired.

Transition – The name of the Transition type that will be applied between cross sections. Default is 
linear.

Cut Area – This column displays the computed Cut Area for the cross section.

Fill Area – This column displays the computed Fill Area for the cross section.

Template Design

The Cross Section Template Design editor, shown in the figure below, is used to create a cross-
section Template to modify existing cross sections. Template data are saved with the geometry file, 
so that it may be used repetitively to perform channel modifications on various cross sections. The 
Template Design editor provides the user with tools to manage templates by name, edit the 
template cuts and properties, and visualize the resulting template. The user has two methods 
available for creating a template. One template option is a User Entered Table of DX, DY, Slope, and 
Mannings n values for the left and right side of the template. The other template option is a Simple 
Trapazoid. The simple trapezoid template option allows the user to enter a channel depth, bottom 
width, side slope, and Manning's n value to create the trapezoid.



Performing Channel Design/Modifications

HEC-RAS User's Manual– 617

Cross-Section Template Design editor with User Entered Table option selected.

Prior to entering Template information, the user must create a new Template. Templates are 
managed from the Options menu or using the buttons shown below the menu bar at the top of the 
editor. The Options available from the Template Design editor include New, Rename, Delete, and 
Copy. New, Rename, and Copy will prompt the user for a new Template name. Delete will remove 
the currently active Template from the geometric data.
If the user has selected the User Entered Table option for creating a template, cut data are entered 
into the table for the Left and Right side of the template separately. Data is entered starting from the 
centerline of the template and moving out towards the overbanks (i.e. the first line in the table is 
information that starts at the centerline of the template and goes to the left and right). Data that 
defines the shape of the template includes DX, DY, Slope, N Val, and main channel Bank location for 
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the left and right sides of the template. Other data to consider is whether to Fill Channel Below 
Template and the value to Cut to Daylight Side Slope (horizontal to 1 vertical).

DX – This column specifies the length of the cut in the horizontal direction over the corresponding 
elevation change of DY.

DY – This column specifies the change of elevation over the length specified in corresponding DX.

Slope – This is the slope of DY/DX. It will be calculated if DX and DY are specified. If only DX (or DY) is 
already specified, the Slope may be entered to calculate DY (or DX).

N Val – This is the Manning's n value to be applied to this portion of the template cross section.

Bank? – This column is used to specify the hinge point used to establish the main channel Bank 
Station for the template. Only one row per side may be selected for the bank station.

Fill Channel Below Template – If checked, this option will fill the main channel of the cross section 
prior to applying the Template.

Cut to Daylight Side Slope – This is the slope (horizontal to 1 vertical) to apply a cut above the last 
point in the template. The default (blank) will result in vertical wall after the last point in the 
template. (e.g. a value of 2 means that the cuts for the left and right bank beyond the last point of the 
template will be projected to the existing cross section 2 units horizontally for every 1 foot vertically).

Copy Left to Right – This button is used to copy the information specified for the left side of the 
template to the right side. This is a convenience function that can be used when the right side of the 
template is a mirror image of the left side.

If the user has selected the Simple Trapezoid option for the template type, then the template editor 
will look like what is shown in Figure 12-5. When this type of template is picked, the user enters a 
channel Depth; Bottom Width; Side Slope; and Manning's n Value for the simple trapezoid. Multiple 
trapezoidal templates can be developed and saved under different names, and then applied within a 
given Channel Design/Modification Alternative.
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Template editor with Simple Trapezoid option selected.

Modify a Range of XS

Channel design/modification information may be entered to a range of cross sections using the 
Modify a Range of XS editor, shown in the figure below, rather that entering the data in the table 
provided on the main Channel Design/Modification editor. This editor is appropriate when you want 
to create a channel within one River Reach by applying the same Template to a number of cross 
sections at a given slope. A Template should have been defined prior to entering the editor, but the 
Template Design button allows the user access to the Template Design editor.

The intended use of this editor is to allow the user to apply a template over an existing set of cross 
sections; however, the Add New XS button allows the user to specify a new cross section at a river 
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station along the specified River Reach. The new cross section will be created only when the user 
presses the Create a New Geometry File with these Modifications button. The user is not provided 
with the option to specify any cross-sectional properties such as station-elevation data, Manning's n
value data, or downstream reach lengths. Therefore, cross sections should be added to the geometry 
in this manner sparingly.

Apply channel modifications to a range of cross sections.

When the Modify a Range of Cross Sections button is pressed, the window will initially open with the 
current River and Reach selected, but the user may select any River Reach currently in the data set. 
The user will then select the Template to apply to the specified reach. If a Template has not yet been 
defined the user can access the template Design editor through the button provided.
Cross sections over which the Template information should be applied are selected using the US RS
(Upstream River Station) and DS RS (Downstream River Station) list boxes. All cross sections in the 
exiting geometry, as well as those "new XS" locations that have been added, will be available to 
select. As a river station is selected, elevation data and reach length data on the form will be 
updated.
Each time a river station is selected from the US RS or DS RS list box the corresponding elevation 
data will be updated from the information on the main Channel Design/Modification editor. After 
selecting the US and DS river stations fix the elevations for the Template invert at the river stations. 
This may be done by entering an elevation value in the Elev. field or by entering a slope value. If one 
of the slope fields is chosen, the invert elevation for the river station will be computed using the 
reach length to the cross section (US or DS) and the cross section's invert elevation. If both 
elevations are specified for the US and DS river station the Template will be applied to the range of 
cross sections on constant slope between the river stations.
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Performing the Channel Modifications
Once a design Template has been specified for a given cross section, a preview of the channel as 
modified is displayed in the XS Plot graphic area. The XS Plot will display the cross section of the row 
that is currently active in the summary cut table at the bottom of the window.

As shown in the figure below, the original cross section is displayed in black, while the new cross 
section is shown in magenta. Then Manning's n value data that is furnished at the top of the plot are 
the values associated with the new, modified cross section. The new bank stations will also be 
shown in magenta. The Plot Template option will toggle on/off the entire channel design Template, 
displaying the Template as a dashed line.

Preview of a modified cross section in the Channel Design/Modification editor.

New (interpolated) cross sections may also be inserted into the channel modification editor. They 
will appear as if they are part of the original geometry (in the design/modification editor) to allow 
you to apply templates; however, as shown in the figure below, the row will be grayed out to indicate 
the cross section doesn't actually exist. 
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A new cross section is added at River Station 10.5 into the Channel Design/Modification editor.

To insert a cross section, select the  (Add new design cross section) button. You will be asked 
to enter a river station for the new cross section, just like adding a cross section in the geometric 
editor. You are then required to input reach length data to allow HEC-RAS to interpolate the cross 
section from existing data. (You will also need to adjust the downstream reach lengths for the 
upstream cross section.) Entry of the Template Elevation into the Fixed Elev. field, inspection of the 
Center Station for placing the template, and selecting a Template will also be required. To remove 

and inserted cross section, select the  (Remove design cross section) button. This button is 
only available when an inserted section is selected in the table, as shown in in the figure below. 
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Channel design/modification editor with an inserted cross section with completed data.

Cut and Fill areas are also computed for each cross section. Detailed cut and fill data are available 
from the Summary Cut and Fill data table. The Cut and Fill Summary Table is accessible by pressing 

the  button. There are several options for displaying the Cut and Fill Volume and Area 
information. A summary of Volumes is shown in the figure below. If any of the Area options are 
selected, information for the Upstream (U/S) and Downstream (D/S) cross sections will be displayed. 
If a section is modified back in the Channel Design/Modification Editor, the Refresh Table button 
can be used to recomputed the Cut/Fill information and update the summary table.
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Summary Cut and Fill information for the channel configuration.

Once the desired channel modification data have been entered for all of the desired reaches, a new 
geometry file must be created. A new geometry file with the Template data applied is created by 
pressing the Create a Geometry File with these Modifications button. An intermediate window will 
appear to allow the current geometric data set to be saved.

The new geometry will not contain the channel modification data.

The user will then be prompted to enter a new title for the geometry file that is going to be created. If 
a title is entered that has already been used for a geometric data set, you will be prompted to 
overwrite the existing data file.  Note that the data entered into the Channel Design/Modification 
editor is saved with the base geometry file and is not saved with the modified geometry file. This 
allows the user to open the base geometry file and recreate the modified geometry.

Comparing Existing and Modified Conditions
Once a modified geometry file is created, the user can create a new plan that will incorporate the 
modified geometry and the previously defined flow data. This is accomplished by first opening the 
modified geometry file from the Geometric Data window. The next step is to open the Steady Flow 
Analysis window and create a new Plan. Creating a plan is accomplished by selecting New Plan from 
the File menu of the Steady Flow Analysis window. Once a new plan is created, the computations 
can be performed.
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After the water surface profile computations have been performed for the modified channel 
conditions, the user can compare the results of the existing and modified conditions on any of the 
graphics and tables. An example cross-section plot of the two plans is shown in the figure below - the 
geometry of the modified and existing conditions, along with the computed water surface elevations 
from both the existing and modified plans. To display the geometry and results from more than one 
plan on a graphic, the user can select Plan from the Options menu on any of the graphics. At the top 
of the plan selection window, turn on the option that says "Compare Geometry As Well As Output." 
Select the two plans to be viewed and hit the OK button. The geometry and output for both plans 
will be displayed.

Existing and Modified Geometry and Water Surface Elevations.

In addition to graphical output, the user can review the computed results from both plans in a tabular 
form. The figure below shows the computed results for both plans in Standard Table 1 of the Profile 
Output table.
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Existing and Modified Geometry and Water Surface Elevations.
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14 ADVANCED FEATURES FOR UNSTEADY FLOW ROUTING
HEC-RAS has several advanced features that can be used when modeling complex unsteady flow 
situations. These features include mixed flow regime capabilities (subcritical, supercritical, hydraulic 
jumps, and draw downs); the ability to perform a dam break analysis; levee overtopping and 
breaching; hinge pool calculations for navigation dams; how to model pressurized pipe flow in HEC-
RAS; and using generic rules to control gate operations at hydraulic structures.

The advanced features discussed in this section are list below.

Mixed Flow Regime
Dam Break Analysis
Levee Breaching and Overtopping
Pump Stations
Navigation Dams
Modeling Pressurized Pipe Flow
User Defined Rules for Controlling Gate Operations
Automated Calibration of Manning's n Values for Unsteady Flow

Mixed Flow Regime
Modeling mixed flow regime (subcritical, supercritical, hydraulic jumps, and draw downs) is quite 
complex with an unsteady flow model. In general, most unsteady flow solution algorithms become 
unstable when the flow passes through critical depth. The solution of the unsteady flow equations is 
accomplished by calculating derivatives (changes in depth and velocity with respect to time and 
space) in order to solve the equations numerically. When the flow passes through critical depth, the 
derivatives become very large and begin to cause oscillations in the solution. These oscillations tend 
to grow larger until the solution goes completely unstable.

In order to solve the stability problem for a mixed flow regime system, Dr. Danny Fread (Fread, 1986) 
developed a methodology called the "Local Partial Inertia Technique." The LPI method has been 
adapted to HEC-RAS as an option for solving mixed flow regime problems when using the unsteady 
flow analysis portion of HEC-RAS. This methodology applies a reduction factor to the two inertia 
terms in the momentum equation as the Froude number goes towards a user entered Froude 
Number Threshold (Default = 0.8). The modified momentum equation is show below:

and

where:
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σ = LPI factor to multiply by inertial terms.
FT = Froude number threshold at which factor is set to zero. This value has a practical 
application range from 0.0 to 2.0 (default is 0.8). If you use zero, the inertial terms are always 
zeroed out, and in affect you have a Diffusion Wave routing scheme, rather than Full Unsteady 
Flow equations.
Fr = Froude number.
m = Exponent of equation, which changes the shape of the curve. This exponent can range 
between 1 and 128 (default value is 4). A practical upper limit would be 32.
h = Water surface elevation
Sf = Friction slope
Q = Flow rate (discharge)
A = Active cross sectional area
g = Gravitational force

The default values for the equation are FT = 0.8 and m = 4. When the Froude number is greater than 
the threshold value, the factor is set to zero. The user can change both the Froude number threshold 
and the exponent. As you increase the value of both the threshold and the exponent, you decrease 
stability but increase accuracy. As you decrease the value of the threshold and/or the exponent, you 
increase stability but decrease accuracy. To change either the threshold or the exponent, select 1D 
Mixed Flow Options tab from the Options/Computational Options and Tolerances menu of the 
Unsteady Flow Analysis window. When this option is selected, the unsteady mixed flow options 
window will appear as shown in Figure 14-1.

As shown in Figure 14-1, the graphic displays what the magnitude of the LPI factor will be for a given 
Froude number and a given exponent m. Each curve on the graph below represents an equation with 
a threshold of 1.0 (FT) and a different exponent (m).
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Figure 14 1. Unsteady Mixed Flow Options Window

By default, the mixed flow regime option is not turned on. To turn this option on, check the Mixed 
Flow Regime box, which is contained at the top of the Mixed Flow regime window. This window and 
option is shown in the Figure 14-2.
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Figure 14 2. Unsteady Flow Analysis Window with Mixed Flow Regime Option Turned On

In general, when modeling a river system that is completely subcritical flow, you should not turn on 
the mixed flow regime option. If the system is mostly subcritical flow, with only a few areas that pass 
through critical depth, then this option can be very useful for solving stability problems. However, 
there may be other options for modeling the areas that pass through critical depth. For example, if 
the system has a location with a drops in the bed where flow passes through critical depth over the 
drop, but is subcritical just downstream of the drop, this would be a good location to model the drop 
as an inline weir within HEC-RAS. By modeling the drop as an inline weir, the program is not 
modeling the passing through critical depth with the momentum equation, it is getting an upstream 
head water elevation for a given flow from the weir equation. If the river system has several areas 
that pass through critical depth, go supercritical, and go through hydraulic jumps, then the mixed 
flow methodology may be the only way to get the model to solve the unsteady flow problem.

A profile plot of a mixed flow regime problem is shown in Figure 14-3. This example was run with the 
unsteady flow simulation capability within HEC-RAS using the mixed flow regime option. The 
example shows a steep reach flowing supercritical, which then transitions into a mild reach. A 
hydraulic jump occurs on the mild reach. The mild reach then transitions back to a steep reach, such 
that the flow goes from subcritical to supercritical. Because of a high downstream boundary 
condition (for example backwater from a lake), the flow then goes from supercritical to subcritical 
though another hydraulic jump. 
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Figure 14 3. Example Mixed Flow Regime Run with Unsteady Flow Routing

Dam Break Analysis
The failure of several dams in this country (Buffalo Creek, West Virginia 1972; Teton dam, Idaho 1976; 
Laural Run Dam and Sandy Run Dam, Pennsylvania 1977; Kelly Barnes Dam, Georgia 1977; and 
others), has led our nation to take a strong look at dam safety. One aspect of dam safety is to answer 
the question, "What will happen if the dam were to fail?" The ability to evaluate the results of a dam 
failure has been added into the HEC-RAS software.
HEC-RAS can be used to model both overtopping as well as piping failure breaches for earthen dams. 
Additionally, the more instantaneous type of failures of concrete dams can also be modeled. The 
resulting flood wave is routed downstream using the unsteady flow equations. Inundation mapping 
of the resulting flood can be done with the RAS-Mapper portion of the software when GIS data 
(terrain data) are available.

Dams are modeled within HEC-RAS by using the Inline Structure editor or the SA/2D Area Connection 
(for 2D modeling). Each of these editors allows the user to put in an embankment, define overflow 
spillways and weirs, gated openings (radial and sluice gates), culverts, rating curves, and time series 
of flow releases. Gated openings can be controlled with a time series of gate openings or using the 
elevation control gate operation feature in HEC-RAS. For more information on modeling inline 
hydraulic structures within HEC-RAS, please review Chapter 5 of this manual (Entering and Editing 
Geometric Data).

The lake area upstream of the dam can either be modeled with cross sections, a storage area (Figure 
14-4.), or a 2D Flow Area. If cross sections are used, then HEC-RAS will perform full unsteady flow 
routing through the reservoir pool and downstream of the dam. If a storage area is used, HEC-RAS 
uses level pool routing through the lake, then unsteady flow routing downstream of the dam. If a 2D 
Flow Area is used then full 2D modeling can be used within the reservoir pool and downstream of the 
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dam. When using a storage area to represent the reservoir pool, HEC-RAS requires two cross sections 
inside of the reservoir pool, then the inline structure representing the dam, and then the 
downstream cross sections (see Figure 14-4). The routing reach is hydraulically connected to the 
reservoir (storage area) with the first (most upstream) cross section. This cross sections water 
surface is forced to the elevation of the water surface in the storage area during the unsteady flow 
routing. The second cross section in the pool area is required as a bounding cross section for the 
inline structure (the dam).

One additional caution for using a storage area to represent the pool area: When the initial 
conditions are computed by backwater analysis, it is up to the user to ensure that the water surface 
computed just upstream of the dam (for the two cross sections) is consistent with the starting water 
surface entered for the storage area. If this is not the case, the model will most likely have stability 
problems at the very start of the unsteady flow routing. There are two ways to ensure these water 
surfaces are consistent. The first is to adjust the low flow gate openings and initial base flow in the 
reach to produce a water surface that is consistent with the desired starting pool elevation. The 
second way is to use the option that allows the user to force the water surface at a cross section 
during the initial conditions calculations. This option is called Internal RS Initial Stages, and is 
available from the Options menu of the Unsteady Flow Data editor. This option can be used to set 
the water surface just upstream of the dam to the same elevation as the storage area.

Figure 14 4. Alternate Methods for Modeling a Dam and Reservoir Pool in HEC-RAS.

An example of using the Inline Structure feature to model a dam is shown in Figure 14-5. As shown in 
the Figure, the user enters the embankment and overflow spillway as one piece using the Weir/
Embankment editor. The embankment is shown as the gray filled in area above the ground. The 
overflow spillway is the rectangular notch on the upper left hand side of the embankment. The main 
outlet works consist of two rectangular gates, which are entered through the gate editor. The gates 
are shown towards the bottom of the embankment in this example. 
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Figure 14 5. Inline Structure Editor with Example Dam Shown

Entering Dam Break Data
Entering dam breach information is accomplished by pressing the button labeled Breach (plan 
Data). The breach information is stored as part of the current Plan. This was done to facilitate 
evaluating dam and levee breaching in a real time river forecasting mode. By putting the breach 
information in the Plan file, the geometric pre-processor does not have to be run again, thus saving 
computation time during forecasting. The user can also access dam breach information by selecting 
Dam Breach (Inline Structure) from the Options menu of the Unsteady Flow Analysis window. Once 
the Breach button is pressed, the Dam Breach window will appear as shown in Figure 14-6.
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Figure 14 6. Dam Breach Data Editor with Example Dam

As shown in Figure 14-6, the user selects a particular Inline Structure to perform the breach on. At the 
top left of the editor is an option labeled: Breach This Structure - This check box is used to decide if 
the program will perform the breach or not. In order for the breach to occur this box must be 
checked. This box was added to allow the user to turn certain breaches on or off, without losing the 
user entered breach information.

Inline Structure. This field is used to select the particular inline structure that you want to perform a 
breach analysis on. The user can enter breach data and perform a breach for more than one dam 
within the same model.

Delete This Breach. This button is used to clear all of the dam breach information for the currently 
opened inline structure.

Delete All Breaches. This button is used to delete the dam breach information for all of the inline 
structures in the model.

Breach This Structure. This check box is used to turn the breaching option on and off without 
getting rid of the breach data. This box must be checked in order for the software to perform the 
dam breach. When this box is not checked, no breaching will be performed on this structure.
Next the decision needs to be made as to which "Breaching Method" to use. Currently the user has 
three Breaching Methodologies to choose from, either User Entered Data, Simplified Physical, or 
Physical Breaching (DLBreach). The User Entered Data method requires the user to enter all of the 
breach information (i.e. breach size, breach development time, breach progression, etc…). The 
Simplified Physical breaching method allows the user to enter velocity versus breach down-cutting 
and breach widening relationships, which are then used dynamically to figure out the breach 
progression versus the actual velocity being computed through the breach, on a time step by time 
step basis. The Physical Breaching (DLBreach) requires material properties for the dam, the core of 
the dam, and the outer face of the downstream sideslope.
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User Enter Breach Data

If the "User Entered Data" Breaching Method is selected, then the following data must be entered 
for the breaching analysis:

Center Station. This field is used to enter the cross section stationing of the centerline of the breach. 
The stationing is based on the inline structure that is shown in the graphic.

Final Bottom Width. This field is used to enter the bottom width of the breach when it has reached 
its maximum size.

Final Bottom Elevation. This field is used to enter the bottom elevation of the breach when it has 
reached its maximum size.

Left Side Slope. This field is used to enter the left side slope for the trapezoid that will represent the 
final breach shape. If a zero is entered for both side slopes, the breach will be rectangular. Side 
slopes are entered in values representing the horizontal to vertical ratio. For example, a value of 2 
represents 2 feet horizontally for every 1 foot vertically.

Right Side Slope. This field is used to enter the right side slope for the trapezoid that will represent 
the final breach shape. If a zero is entered for both side slopes, the breach will be rectangular. Side 
slopes are entered in values representing the horizontal to vertical ratio. For example, a value of 2 
represents 2 feet horizontally for every 1 foot vertically.

Breach Weir Coef. This field is used to enter a weir coefficient that will be used to compute flow 
through the breach, when the breach is open to the atmosphere. A default value of 2.6 is set 
automatically, but user's may want to adjust this depending upon the type of dam, and breaching 
process.

Breach Formation Time (hrs). This field is used to enter the time required for the breach to form. It 
represents the time from the initiation of the breach, until the breach has reached its full size. The 
modeler should be very careful in selecting this time. If a linear breach progression rate is selected, 
then the breach time should be limited to when the breach begins to significantly erode and up to 
when the major portion of the breach is formed. More information on the breach formation time is 
provided later in this chapter.

Failure Mode. This selection box contains two options for the failure mode of the breach, a Piping
failure or an Overtopping failure. The overtopping failure mode should be selected when the water 
surface overtops the entire dam and erodes its way back through the embankment, or when flow 
going over the emergency spillway causes erosion that also works its way back through the 
embankment. The Piping failure mode should be selected when the dam fails due to seepage 
through the dam, which causes erosion, which in turn causes more flow to go through the dam, 
which causes even more erosion. A piping failure will grow slowly at first, but tends to pick up speed 
as the area of the opening begins to enlarge. At some point during the breach, the embankment 
above the breach will begin to sluff, at which time a large mass wasting of the embankment will 
occur.

Piping Coefficient. This field is only used if the Piping failure mode has been selected. The user 
enters an orifice coefficient into this field. The orifice equation is used to calculate the flow through 
the breach opening while it is acting in a piping flow manner. Once the embankment above the 
opening sloughs, and the water is open to the atmosphere, the program transitions to a weir 
equation for computing the breach flow.
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Initial Piping Elev. This field is used to enter the elevation of the center of the piping failure when it 
first begins to occur.

Trigger Failure At. This field is used to enter the mode in which the breach initiation will be 
triggered. There are three options available within HEC-RAS for initiating the start of the breach: a 
water surface elevation (WS Elev), a specific instance in time (Set Time), and a combination of 
exceeding a water surface elevation for a user specified duration (WS Elev + Duration). With the third 
option (WS Elev + Duration) the user enters a threshold water surface elevation to start monitoring 
the location. A duration is also entered. If the water surface remains above the threshold value for 
the user entered duration, then the breach is initiated. Additionally the user can enter a water 
surface elevation labeled "Immediate Initiation WS." If the water surface elevation gets up to or 
beyond this elevation, the breach is immediately initiated.

Starting WS. This field is only used if the user has selected a trigger failure mode of water surface 
elevation (WS Elev). The user enters a water surface elevation into this field. The water surface 
represents the elevation at which the breach will begin to occur.

WS Elev+Duration . If the user selects WS Elev+Duration for the trigger mechanism of the failure, 
then they have three additional fields of data to enter. The first variable is Threshold WS. This 
variable is the water surface elevation at which the program starts to monitor the flow for duration 
above this water surface. The second variable is Duration above Threshold. This variable is used to 
specify the duration that the water surface must be above the threshold water surface elevation 
before the failure will initiate. The final variable, Immediate initiation WS, is used to instruct the 
program to begin the breach if the water surface in the structure reaches this elevation or higher, 
regardless of the duration requirement. This last field is optional.

Set Time. If the user selects the Set Time option, then a starting date and time to initiate the breach 
must be entered.
Breach Plot.

When this tab is selected, a plot of the inline structure will show up in the graphic window. The plot 
will show the proposed breach maximum size and location in a red color. 

Breach Progression. 
When this tab is selected a table will appear in the graphic display window. The table is used to enter 
a user defined progression curve for the formation of the breach. This is an optional feature. If no 
curve is entered, the program automatically uses a linear breach progression rate. This means that 
the dimensions of the breach will grow in a linear manner during the time entered as the full breach 
formation time. Optionally, the user can enter a curve to represent the breach formation as it will 
occur during the breach development time. The curve is entered as Time Fraction vs. Breach 
Fraction. The Time Fraction is the decimal percentage of the full breach formation time. The breach 
fraction is the decimal percentage of the breach size. Both factors are entered as numbers between 
zero and one. An example of a user entered nonlinear breach progression rate is shown below. 
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User Specified Vertical/Horizontal Growth Rate. When the Breach Progression Tab has been 
selected, the user can select either the User Specified Vertical/Horizontal Growth Rate (default) or 
the Proportional Vertical/Horizontal Growth Rate. If the User Specified Vertical/Horizontal Growth 
Rate option is selected, then the breach will grow in the horizontal direction at a rate that will allow 
it to reach its full length during the user specified breach time (Figure 14-7.). However, the vertical 
growth rate, will be based on the user entered Vertical to Horizontal ratio. For the typical case where 
the breach is wider than it is deep, the breach will reach the final bottom elevation before it has 
reached the final width. See discussion on Breach Growth Shape, below.

Use Proportional Vertical/Horizontal Growth Rate. When the Breach Progression Tab has been 
selected, the user can select to use the User Specified Vertical/Horizontal Growth Rate (default) or 
Proportional Vertical/Horizontal Growth Rate. If Proportional… is selected, then the breach will grow 
in the horizontal direction based on the formation time. A growth rate will be computed based on 
the breach width and breach development time, which is then applied to the vertical breach growth 
rate. See discussion on Breach Growth Shape, below. 

Figure 14 7. Dam Breach Editor with Nonlinear Breach Progression
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NOTE: Previous to version 4.2, the horizontal and vertical growth rate of the breach was base on 
reaching the maximum breach depth and width at the user entered "Breach Formation Time". This 
means if a user put in breach dimensions of 400 ft wide and 100 ft deep, over a period of 2 hours, the 
horizontal growth rate was 200ft/hr and the vertical growth rate was 50 ft/hr. While this was 
generally ok for Dam breaches, it was not ok for levee breaching, in that levee breaches are much 
wider than they are tall. As of version 4.2, RAS computes the breach growth rate based on the breach 
"Final Bottom Width" and the user entered "Breach Formation Time". Then this same breach growth 
rate is used for the vertical down cutting of the breach. So in the previous example of a 400 ft breach 
bottom width and a 2 hour breach development time, the growth rate is 200 ft/hr, which is used for 
both the down cutting and widening rates. User's can change the vertical Breach Growth Rate by 
entering a value other than 1.0 under the option labeled "User Specified Vertical/Horizontal Growth 
Ratio" and the Breach Progression Tab. If a user enters a value of 0.5, that means you want the 
vertical growth rate to be half of what the Horizontal growth rate gets computed to be.

WARNING: The breach growth rate change described in the previous paragraph will generally results 
in RAS version 4.2 and newer yielding a higher peak flow through the breach, than versions 4.1 and 
older. If the user wants the same results as version 4.1 and older, you must compute a vertical/
horizontal growth rate that will results in the breach reaching its maximum width and depth at the 
end of the breach formation time. For example (assuming an overtopping breach), if you specified a 
400 ft breach bottom width and a 2 hour breach formation time, this is a horizontal growth rate of 
200 ft/ hour. However, if you Dam is only 100 ft high, then to reproduce the version 4.1 or older 
results, the user would need to enter a "User Specified Vertical/Horizontal Growth Ratio" of 0.25. This 
would cause the program to grow the breach vertically down to the 100 ft depth in exactly 2 hours. 
Piping breaches are more complicated, in that they have an initial elevation for the hole, and the 
vertical growth is both up and down.

Breach Repair (Optional). This option allows the user to have the breach fill back in during a 
simulation. This would most often be used for levee breaches, but could also be used for a dam 
breach if the user were running a long term simulation or if it was assumed that some effort would 
be put in place to fill a breach back in during a failure. When the Breach Repair tab is selected, the 
editor will appear as shown in Figure 14-8.
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Figure 14 8. Dam Break Editor with Breach Repair Tab Active.

The Breach Repair Option requires the user to enter three pieces of information:

Number of hours after full breach to start repair: This field is used to enter the amount of time (in 
hours) it takes to start the repair process after the breach has occurred.

Total repair time (hours): This field is used to enter the total amount of time that it will take to 
perform the breach repair, in hours.

Final filled in elevation: This field is used to enter the top elevation of the final repaired breach.

Simplified Physical Breaching

If the User selects to use the "Simplified Physical" Breach Method from the drop down at the top of 
the editor, the Breaching Editor will change to look the following way:
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Figure 14 9. Simplified Physical Breaching Option for HEC-RAS 

Once the User selects "Simplified Physical" breaching option, there are several fields in which labels 
change, some additional information required, and some previous information that is not required. 
The main changes between this method and the "User Entered Data" breach method, are the 
following:

Max Possible Bottom Width – This field is now used to enter a maximum possible breach bottom 
width. This does not mean this will be the final breach bottom width, it is really being used to limit 
the breach bottom width growth to this amount. The actual bottom width will be dependent on the 
velocity verses erosion rate data entered, and the hydraulics of flow through the breach. This field is 
used to prevent breaches from growing larger than this user set upper limit during the run.

Min Possible Bottom Elev – This field is used to put a limit on how far down the breach can erode 
during the breaching process. This is not necessarily the final breach bottom elevation, it is a user 
entered limiter (I.e. the breach cannot go below this elevation). The final breach elevation will be 
dependent on the velocity verses erosion rate data entered, and the hydraulics of flow through the 
breach.

Starting Notch Width or Initial Piping Diameter – If the Overtopping failure mode is selected, the 
user will be asked to enter a starting notch width. The purpose of this is that the software will us this 
width at the top of the dam to compute a velocity, from the velocity it will get a down cutting erosion 
rate (based on user entered data), which will be used to start the erosion process. If a Piping Failure 
model is selected, the user must enter an initial piping diameter. Once the breach is triggered to 
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start, this initial hole will show up immediately. A velocity will be computed through it, then the 
down cutting and widening process will begin based in user entered erosion rate data.

Mass Wasting Feature – This option allows the user to put a hole in the Dam or the Levee at the 
beginning of the breach, in a very short amount of time. This option would probably most often be 
used in a levee evaluation, in which a section of the levee may give way (Mass Wasting), then that 
initial hole would continue to erode and widen based on the erosion process. The required data for 
this option is a width for the mass wasting hole; duration in hours that this mass wasting occurs over 
(this would normally be a short amount of time); and the final bottom elevation of the initial mass 
wasting hole (it is assumed that the hole is open all the way to the top of the levee or Dam if this 
option is used).

Velocity vs. Downcutting and Widening Erosion Rates. When using the "Simplified Physical" 
breaching option, the user is required to enter velocity versus Downcutting erosion rates, as well as 
velocity versus erosion widening rates. To enter this data the user selects the "Simplified Physical" 
breach Tab. When this Tab is selected the editor will look like the following:

Figure 14 10. HEC-RAS Simplified Physical Breach Option. 

As shown in Figure 14-10 above, the user is required to enter Velocity versus Down-cutting erosion 
rates and velocity versus erosion widening rates. This data is often very difficult to come by. User's 
will need to consult with Geotechnical engineers to come up with reasonable estimates of this data 
for your specific Levee or Dam. Another way to estimate this information is to try to derive it by 
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simulating a historic Levee or Dam breach, and adjusting the velocity versus erosion rate data until 
the model simulates the correct breach width and time. This is obviously an iterative process, and 
may require the user to perform this at multiple locations to see if there is a consistent set or erosion 
rates that will provide a reasonable model for simulating Levee breaches (or Dams) in your 
geographical area.

We realize that this data is not readily available for any specific levee or dam. The hope is that over 
time we will be able to develop guidelines for these erosion rates based on analyzing historical levee 
and dam breaches.
Once all of the Dam Breach data are entered, press the OK button to have the data accepted. 
However, the data is not saved to the hard disk at this point. You must save the currently opened 
plan in order for the breach information to be save to the hard disk.

Breach Growth Shape
The shape and progression of the breach depends on the user entered data. Is the User has selected 
to use the "Simplified Physical Breaching" option, the Breach Growth is dependent upon the user 
entered Downcutting and Breach Widening rates entered by the user, as well as the event being 
modeled. If the user has selected the "User Entered Data" breaching method, then the Breach 
Formation shape is dependent upon the Breach Bottom Width, height of the structure, and the 
Breach Formation Time. For example, consider a breach with the following parameters: Final Bottom 
Width is 400 feet, Final Bottom Elevation is 100 feet (top of weir is 200 feet—full breach is 100 feet 
deep), Formation Time is 4 hours, Breach Progression is Linear. The breach has to grow 400 feet wide 
in 4 hours so the growth rate is 100 feet/hour (this growth rate is used for both the horizontal and 
vertical growth rate by default). The breach will start out as a tiny trapezoid (or rectangle if side 
slopes are zero) at the top of the weir based on the Center Station. The trapezoid will grow such that 
after one hour, the breach will have just reached the Final Bottom Elevation (100 feet deep) and the 
breach will be 100 feet at wide (at the bottom). Over the next three hours, the breach will grow 
horizontally from 100 feet wide to the final width of 400 feet wide, at the bottom. The side slopes of 
the trapezoid always remain the same. In the less common situation where the breach is deeper than 
it is wide, the growth rate is based on the vertical depth divided by the formation time—the 
maximum width would be reached before the maximum depth.

The user has the option to specify a vertical/horizontal growth rate. The default value is 1.0. 
However, if the user feels the vertical growth rate should be slower or faster than the horizontal 
growth rate, they can select this option and enter a ration of vertical to horizontal growth rate (e.x. a 
value of 0.5 would produce a vertical growth rate that is half the speed of the horizontal growth rate).

If the Breach Progression is non-linear, then the horizontal growth will be adjusted, as needed. 
Progression in the vertical direction will match the horizontal growth (taking into account whether 
the Same/Proportional option has been selected). For the above example, if data has been entered 
such that the breach is only 10% (0.1) formed after 25% of the time, then the breach would be 40 feet 
wide after one hour. It would be 40 feet deep for Same Growth… or, alternately, it would be 10 feet 
deep for Proportional Growth.

If the Failure Mode is changed to Piping, then the breach starts out as a tiny square (or rectangle) 
based on the center station and Initial Piping Elevation. For the original example with Same Growth 
and an Initial Elevation of 120 feet, the sides of the square will grow at the rate of 100 feet/hour. The 
vertical growth is split between up and down. After 6 minutes, the square will be 10 feet on a side. 
The top of the square would be at an elevation of 125 feet and the bottom at an elevation of 115 feet. 
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Once the bottom of the square reaches the Final Bottom Elevation, all of the growth is applied 
upward. When the elevation of the top of the square is higher than the water surface elevation in the 
breach, it is assumed the breach will cave in. The breach will now be an open rectangle with the 
current bottom elevation and current bottom width ( the rectangle extending vertically to the top of 
the weir). If the breach has not yet reached the Final Bottom Elevation, it will grow downward at the 
full vertical growth rate. The bottom of the breach will continue to grow horizontally at the same rate 
(or adjusted rate for non-linear). If the side slopes are not zero (vertical), then the side slopes of the 
rectangle/trapezoid will progress from vertical to the maximum side slope, linearly over the 
remaining time (or adjusted for non-linear progression based on user selection). So if the Side Slope 
is 3 and the piping breach becomes an open breach after one hour, then the side slope would be 1 at 
the end of the second hour, 2 at the end of the third hour, and 3 at the end of the fourth hour. If the 
water surface remains high enough, then the piping breach will not turn into an open breach until 
the top of the piping breach reaches the top of the weir. It will then grow to the final trapezoidal 
shape as previously described.

For a Piping failure with Proportional Growth, the piping breach would be a rectangle that grows 
vertically at 25 feet/hour. Whether the breach is growing up and down, only up, or only down, is the 
same as before, as is the open breach behavior and the non-linear growth option.

Estimating Dam Break Parameters
If the modeler uses the "User Entered Data" option for the breaching method, it is up to the user to 
enter the key parameters that must be estimated for the breach dimensions, such as the breach 
formation time and the maximum size of the breach opening. Several researchers have developed 
regression equations to estimate breach sizes and times from historical dam breach information. 
Additionally, a few researchers have tried to develop computer models to simulate the physical 
breach process. The bulk of the research in this area has been summarized in a 1998 publication 
entitled "Prediction of Embankment Dam Breach Parameters", by Tony L. Wahl of the U.S. Bureau of 
Reclamation. Wahl documents the data from most of the historical dam breaches that have occurred 
in the world, as well as describing the equations and modeling approaches developed for predicting 
the dam breach parameters.
For the HEC-RAS software, the modeler must estimate the maximum breach dimensions and breach 
formation time either outside of the HEC-RAS program, or with the Breach "Parameter Calculator" 
provided on the Breach Data editor. Because the breaching process is complex, it is suggested that 
the modeler try to come up with several estimates of the breach parameters, and then put together a 
matrix of potential breach sizes and times. One example would be to use two different sets of 
regression equations and one of the breach simulation models to estimate the breach parameters. In 
several studies performed at HEC we have used both the Froelich (1995), MacDonald\Langridge-
Monopolis (1984), and the Van Thun and Gillete (1990) regression equations, as well as the BREACH 
model by Dr. Danny Fread (Fread, 1988). All four methods give different answers for the breach 
dimensions, as well as the time for the breach to form. In general, a range of breach parameter 
estimates should be run as separate trials within HEC-RAS in order to test the sensitivity of the 
results to the breach dimensions and times. It is always good to test the sensitivity of the breaching 
parameters, since they are the most unknown factor in this process.
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Breach Parameter Calculator

To assist users in estimating the Breach dimensions and development time, HEC has added a 
"Parameter Calculator" to the Breach Data editor. To use this calculator select the Parameter 
Calculator Tab from the breach editor, and the editor will look like the following screen:

Figure 14 11. Breach Parameter Calculator from Regression Equations.

As shown in Figure 14-11 above, the Breach Parameter Calculator contains five regression equations 
(MacDonald\Langridge-Monopolis; Froehlich 1995; Froehlich 2008; Von Thun and Gillete; and Xu & 
Zhang 2009). The user is required to enter several parameters that describe the Dam and the volume 
of water behind the structure at the time of failure. These parameters include: Top of Dam elevation; 
Breach Bottom Width; Pool elevation at Failure; Pool Volume at Failure; Failure Mode; Dam Crest 
width, upstream and downstream embankment slopes; Earth Fill Type; Dam Type; and Dam 
Erodibility factor. Not all values are used for all regression equations as noted on the editor. Some of 
the variables are specific to the MacDonald equation, and the last two are specific to the Xu & Zhang 
equation. Once the values are entered the calculator computes Breach Bottom Width; Side Slopes; 
and Breach Development Times from each of the regression equations. The user can then select the 
answers from one of the equations to by pressing the Select button next to the equation results that 
they would like to use.
Each of the breach parameter estimates will yield a different outflow hydrograph from HEC-RAS. 
However, once these hydrographs are routed downstream, they will tend to converge towards a 
common result. How close they get to each other will depend on the distance they are routed, the 
steepness of the stream, the roughness of the river and floodplain, and the amount of floodplain 
storage available for attenuating the hydrograph. If the populated areas below the dam are quite a 
distance away (say 20 miles or more), then the resulting hydrographs from the various dam breaches 



Advanced Features for Unsteady Flow Routing

HEC-RAS User's Manual– 645

may be very similar in magnitude by the time they reach the area of interest. However, if the areas of 
interest are closer to the dam, then the resulting breach hydrographs could produce a significant 
range in results. In this situation, the selection of the breach parameters is even more crucial.

HEC-RAS Output for Dam Break Analyses
Several plots and tables are available for evaluating the results of a dam break analysis within HEC-
RAS. Graphics include cross section, profile, and 3 dimensional plots, all of which can be animated 
on a time step by time step basis in order to visualize the propagation of the flood wave. An example 
cross-section plot of a dam while it is breaching is shown in Figure 14-12. Additionally, the 
corresponding water surface profile for the same instance in time is shown in Figure 14-13. 
Hydrographs can be viewed at any location for which the user requested hydrograph output. Shown 
in Figure 14-14 is a series of hydrographs from the breach shown in the previous figures. These 
hydrographs represent the flow leaving the dam and then subsequent locations downstream as the 
flood wave moved through the river system.

Figure 14 12. Example Plot of Dam While Breaching
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Figure 14 13. Example Profile Plot of Dam Breaching

Figure 14 14. Flow Hydrographs from Dam to Downstream Locations
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Levee Overtopping and Breaching
Levee overtopping and breaching can be analyzed within HEC-RAS by modeling the levee as a lateral 
structure. When modeling a levee with a lateral structure, the area behind the levee should not be 
included in the cross section data of the main river. The cross sections should stop at the top of the 
levee. The lateral structure (levee) can be connected to a 2D Flow Area, a storage area, or another 
river reach. The strategy for modeling the area behind the levee will depend upon what will happen 
to the water if the levee overtops or breaches. If the water going over or through the levee will take 
many flow paths and have varying water surface elevations, then a 2D Flow Area is probably the 
most appropriate for modeling the area behind the levee. If the water going over or through the 
levee will fill up like a bathtub (Level pool water surface), then a storage area would be the most 
appropriate for modeling the area behind the levee. If the water will continue to flow in the 
downstream direction (and acting like a separate 1D channel), and possibly join back into the main 
river, then it may be more appropriate to model that area as a separate river reach. Shown in Figure 
14-15 is an example schematic with a levee modeled as a lateral structure connected to a storage 
area to represent the area behind the levee. An example cross section with a lateral structure (levee) 
on the right hand side is shown in Figure 14-16.

Figure 14-15. Schematic with Example Levee and Storage Area. 
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Figure 14-16. Example Cross-Section with Lateral Structure.

The user defines the levee by entering a series of station and elevation points that represent the top 
of levee profile. This station and elevation data is then used as a weir profile for calculating the 
amount of water going over top of the levee. An example levee entered as a lateral structure is shown 
in Figure 14-17. 
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Figure 14-17. Lateral Structure Editor with Levee Modeled as a Weir.

In the example shown in Figure 14-17, the levee is connected to a storage area that will be used to 
represent the area behind the levee. As the levee overtops and/or breaches, the storage area will fill 
up until it reaches the same elevation as the water in the river. After the flood passes, the water in 
the storage area can pass back out any breach that may have occurred.
The levee information is entered as station and elevation data in the Lateral Weir/Embankment 
editor shown on the Lateral Structure editor. The station elevation data represents the top of the 
levee. The levee information is entered from the upstream end of the levee to the downstream end of 
the levee. An example of this editor with levee data is shown in Figure 14-18.
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Figure 14 18. Lateral Weir/Embankment Editor with Example Levee Data.

As shown in Figure 14-18, the user enters the width of the levee (which is only used for drawing 
purposes); the head reference for weir flow calculations; the lateral weir coefficient; the weir crest 
shape; the distance that the upstream end of the levee is from the nearest upstream cross section; 
and the station and elevation data representing the top of levee. For more information on this editor, 
see Lateral Structures in Chapter 6 of this manual.
Once the physical levee information is entered, the user can press the Breach button in order to 
bring up the levee breach editor. The user can have a single breach location per levee (Lateral 
structure). If more than one levee breaching location needs to be modeled, then break the levee into 
multiple lateral structures (one for each levee breach location). An example of the levee breach 
editor is shown in Figure 14-19.
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Figure 14-19. Levee Breach Editor with Example Levee and Breach. 

As shown in Figure 14-19, the information required to perform a levee breach is the same as 
performing a dam break. To get the details of each data field, please review the information found 
under the Dam Break section above in this chapter.

After all of the data are entered and the computations are performed, the user can view output for 
the lateral structure (levee). Plots such as the profile plot, lateral structure hydrographs, and storage 
area hydrographs, can be very helpful in understanding the output for a levee overtopping and/or 
breach. Shown in the figure below is an example profile plot with a levee breach. Shown in Figure 
14-21 is a stage and flow hydrograph plot for the lateral structure. In this plot there are three stage 
lines and three flow lines. The stage lines represent; the stage in the river at the upstream end of the 
levee (Stage HW US); the stage in the river at the downstream end of the levee (Stage HW DS); and 
the stage in the storage area (Stage TW). The river is always considered to be the headwater, and the 
storage area is the tailwater. The flow lines on the plot represent: the flow in the river at the 
upstream end of the levee (Flow HW US); the flow in the river at the downstream end of the levee 
(Flow HW DS); and the flow leaving the river over the lateral weir to the storage area (Flow Leaving).
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Figure 14-20. Profile Plot with Levee Breach.

Figure 14-21. Lateral Structure Stage and Flow Hydrographs 
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In addition to the profile plot and the lateral structure hydrographs, it is a good idea to plot the stage 
and flow hydrographs for the storage area. This allows the user to easily see the amount of flow 
coming into and out of the storage area, and the change in the water surface elevation. Shown in 
Figure 14-22 is the stage and flow hydrograph for the storage area in this example.

Figure 14-22. Stage and Flow Hydrograph Plot for Storage Area.

Referring to Figure 14-21 and Figure 14-22, as the levee breaches, the flow going into the storage 
area and the stage increase quickly, while the stage and flow in the main river drop. In addition to 
the graphics in HEC-RAS, tabular results are also available. Shown in Figure 14-23 is a detailed output 
table for the lateral structure. The user can select a specific time line for viewing the output by 
selecting a specific profile. The profiles are labeled by the date and time they occurred in the model 
simulation.
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Figure 14-23. Detailed Tabular Output for Lateral Structure.

Modeling Pump Stations
Pump stations can be connected between storage areas; a storage area and a river; between a 
storage area and a 2D Flow Area; between two 2D Flow Areas; Between a 1D river and a 2D Flow Area; 
and between river reaches. HEC-RAS allows up to ten different pump groups at a pump station, and 
each pump group can have up to ten identical pumps. Each pump can have its own on and off trigger 
elevation. To learn how to connect a pump, enter pump data, and use pump override rules, please 
review the section on pumps in Chapter 5 of this user's manual.

Pump stations can be used for many purposes, such as pumping water stored behind a levee 
(interior sump) into the main river. An example schematic of an interior ponding area behind a levee 
is shown in Figure 14-24. Note that the pump is connected from the storage area to a river station at 
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the downstream end of the levee.

Figure 14 24. Example Pumping Station for Interior Ponding Area

In the example shown in Figure 14-24, a lateral structure was entered to represent the levee. This 
structure has a gravity draining culvert with a flap gate. The flap gate only allows water to drain from 
the storage area to the river. Additionally, a pump station is included to pump flows over the levee 
during a rainfall event. The pump station was drawn by selecting the Pump Station tool, then 
drawing a connection from the storage area to the cross section at river station 5.39.

In this example, there is a hydrograph attached to the upstream end of the river reach, which 
represents the incoming flood wave to this reach. There is also a lateral inflow hydrograph attached 
to the storage area, which represents the local runoff collecting behind the levee. The pumps are 
used to pump water from the storage area, over the levee, to the river. The top of the levee is at 
elevation 220 feet. Therefore, the pump station is constantly pumping to a head of 220 feet. The 
Pump station data editor is shown in Figure 14-25.
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Figure 14 25. Pump Station Data Editor with Example Data

The second tab on the editor brings up the Pump Group Data (Figure 14-26). As shown is Figure 
14-26, there is one pump group with three identical pumps (pumps are the same size and flow 
capacity). However, each of the pumps has a different on and off trigger elevation. The pump 
efficiency curve is used for all three of the pumps. 
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Figure 14 26. Pump Group Data on Pump Editor.

The third tab, Advanced Control Rules, allows the user to enter rules to override the normal pump 
station operations. When this tab is selected a window will appear as shown in Figure 14-27.
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Figure 14 27. Advanced Control Rules editor for Pump Station.

A shown in Figure 14-27, two rules have been applied to this pump station. The first rule sets an 
absolute maximum pump flow of 800 cfs and a minimum of 1cfs for the entire pump station. This 
rule will always be applied. The second rule sets a maximum flow of 700 cfs to be applied only 
between 12 April 0000 and 24 April 0000, but only if the water surface at storage area Bayou is greater 
than 209. Also, the second part of this rule sets a minimum flow for the same time period, but only if 
the stage at storage area Bayou is less than 206.5. Details of how to use the rules can be found in 
chapter 6, under the section on Pumps.

After the computations are performed, the user can view output for the pump station by selecting 
the stage and flow plotter, then selecting Pump Stations from the Type menu at the top of the 
window. An example stage and flow plot for the pump station is shown in Figure 14-28. As shown in 
the figure, the stage for the tailwater location (Stage TW) is a constant 220 ft. This is due to the fact 
that the pump is constantly pumping over the levee at elevation 220. The stage at the headwater 
location (stage HW) is the water surface elevations in the storage area. The storage area elevation 
starts out at an elevation of 205 ft., goes up to around 206.6, and then back down to around 205.1. 
The flow through the pumps was zero until an elevation of 206 was reached within the storage area, 
which triggered the first pump. The second pump turned on when the storage area got to elevation 
206.2, and the third at elevation 206.5. On the falling side of the hydrograph the pumps began to turn 
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off as the stage went down in the storage area. Shown in Figure 14-29 are the stage and net inflow to 
the storage area. The net inflow represents all the inflows minus the outflows at each time step. 

Figure 14 28. Stage and Flow Hydrographs for Pump Station
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Figure 14 29. Stage and Flow Hydrographs for the Storage Area

Navigation Dams
This section discusses the navigation dam option in HEC-RAS.  For a navigation dam, the program 
will try to maintain both a minimum and maximum water surface at one or more locations along a 
navigation channel.  The program does this by controlling the gate settings on an inline structure.  
The user enters a target water surface (and various other calibration data) and the program will 
adjust the gate settings at user specified time intervals in order to meet the target water surface as 
closely as possible.  This section describes the data requirements for a navigation dam and includes 
a general discussion of how the gate operations are performed.

The first step in modeling a navigation dam is to add the physical data for the navigation dam by 
selecting the Inline Structure option on the Geometry Data editor and entering the appropriate 
information.  The next step is to add the inline structure as a boundary condition on the Unsteady 
Flow editor and then click the Navigation Dams button.  The editor, as shown in Figure 14-30, will 
appear (note:  the fields will be blank when the editor first appears).
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Figure 14‑30. Navigation Dam Editor with Flow Monitor

Normal gate change time increment – This field states how often the program will adjust the gate 
settings.  In the example shown in Figure 14-30, the program will only make adjustments to the gates 
every six hours under normal operations.

Rapidly varying flow change increment – This field represents the minimum length of time between 
gate setting adjustments.  For example, during rapidly changing conditions, the program can adjust 
the gates up to once an hour in order to maintain the appropriate water surfaces.

Initial gate change time – This field is the time (military style) for when the first gate change will take 
place.  In this example, it is 10:00am.  If the simulation starts after 10:00am then the gates will be first 
adjusted at 4:00pm, 10:00pm, or 4:00am as appropriate.

Gate minimum opening – This field is the minimum opening for the first gate group (the first gate 
group as defined on the Geometry editor).  The program will keep the gates on this gate group open 
to at least 0.1 feet.  The other gate groups may be closed completely (see discussion of gate opening 
and closing below).

Gate maximum opening – This field is the maximum opening for the first gate group (the first gate 
group as defined on the Geometry editor).  The program will not allow the gates on this gate group to 
open more than the specified value.  If this field is left blank, then the default is the physical gate 
maximum opening from the geometric data.

The final two fields [Gate opening and Gate closing rate] are the maximum speed that the gates in any 
gate group can be opened or closed.  Generally this rate is determined by the physical speed with 
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which the gates can be adjusted.  Sometimes, however, opening or closing the gates too quickly can 
cause instability in the unsteady solver.  In this case, it may be necessary to reduce the opening or 
closing rate.  A shorter time step may also help.

Pool Only Control
There are several types of navigation dam operations. The simplest is pool only control (as shown in 
Figure 14-30). In this case, the program tries to maintain the water surface immediately upstream of 
the dam within user specified targets. In the other operations (see below), the target water surface is 
located some distance upstream of the dam and there may or may not be limits on the water surface 
right at the dam.
In order to keep the water surface at the dam within the user specified limits, while only infrequently 
changing the gate settings (i.e., every six hours), the program needs to know what the approximate 
inflow at the dam will be some time into the future. This is done by monitoring the flow at an 
upstream cross section. The user must enter this location. In this example (Figure 14-30), the Flow 
Monitor tab has been activated and the flow monitor location has been entered as river station 
315.5. The flow monitor location should be chosen so that the river travel time between the monitor 
location and the navigation dam is on the order of (or somewhat less than) the normal gate 
increment. In this example (Figure 14-30) the gate time increment is every six hours, so a location a 
few hours upstream would be appropriate.

The calibration of the navigation dam control data involves some empirical decisions and trial and 
error experimentation. This is true of the flow monitor location as well as most of the remaining data 
explained below.
The flow monitor location must be a normal cross section in the model. This means that cross 
sections must be extended far enough upstream of the dam to account for this location. Note also 
that the monitor point can be located upstream of other hydraulic structures, including other 
navigation dams. As long as another upstream navigation dam does not have a significant storage 
capacity, it should not affect the results of the flow monitor. 
After the flow monitor location has been chosen, the Pool Control tab can be pressed bringing up the 
editor shown in Figure 14-31.
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Figure 14 31. Navigation Dam Editor with Pool Control

The user enters a range of water surfaces and corresponding Flow Factors. In this example, the ideal 
target water surface has been entered as 459.35. The primary target range is from 459.2 (Target Low) 
to 459.5 (Target High). In general, if the water surface is between Target Low and Target High and it is 
time to change the gate settings, then the program will adjust the gates to get an average of the 
current flow at the dam and the monitor flow.
For instance, assume that at time 10:00 the current discharge from the navigation dam is 10,000 cfs, 
11,000 cfs of flow is observed at the monitor location, and the water surface at the dam is 459.4 feet. 
Since 459.4 is in the primary target range, the program will compute the average of the flows, 10,500 
cfs. By trial and error, the program will change the gates (and compute the corresponding flow) until 
there is 10,500 cfs (plus or minus the tolerance) of discharge at the dam. The tolerance is 1% of the 
flow, in this case 105 cfs. So the program will actually stop iterating whenever it first determines a 
gate setting that results in a flow that is between 10395 cfs and 10605 cfs. After the gates have been 
changed, they won't (normally) be adjusted for the next six hours. The flow from the dam willl vary 
as the water surface at the dam fluctuates.

As the water surface at the dam gets out of the primary target range, then the flow (that is, the 
discharge from the dam) is adjusted by the Flow Factors. In general, when the stage is between 
Target High and Maximum, then the flow is multiplied by Flow Factor Target High (in this case 1.03). 
Between Maximum and Maximum High, it is multiplied by at least 1.07. Between Maximum High and 
water surface Open River, the flow is rapidly increased up to at least Flow Open River (listed as 
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50,000). Flow Open River does not represent a cap. If the flow at the monitor location gets high 
enough, the discharge at the dam can go above Flow Open River based on the Flow Factors. Above 
water surface Open River, all the gates are opened all of the way.

The operations below the target zone work the same way. Flow Factor Target Low and Flow Factor 
Minimum are applied in the same way. Between Minimum Low and water surface Close Gates, the 
flow will be rapidly decreased to Flow Minimum, but again, this is not an absolute minimum. If the 
water surface remains low enough, the program will continue to close the gates and reduce flow. 
The only absolute minimum is that the program will not close the first gate group below the gate 
minimum opening.

The water surface targets are basically calibration knobs and no particular water surface targets 
have to exactly match the operationally prescribed limits on the pool surface. However, the best 
response will probably be obtained if the Maximum and Minimum are close to the prescribed limits.

Hinge Point Only Control
The next type of navigation dam operation is hinge point control. This is similar to pool control. The 
main difference is that instead of the water surface targets being located right at the face of the dam, 
the water surface targets are located some distance upstream. Figure 14-32 shows the Hinge Point 
Only editor. (Hinge point control is selected by clicking on the drop down box near the top right of 
the editor.)
In this example, the navigation dam is located at river station 714.35, and the hinge point is located 
at river station 728.28. The program will adjust the gates at the dam in order to maintain an 
approximate water surface of 645.5 feet (the target water surface) at river station 728.28. The target 
water surfaces and Flow Factors behave the same as for pool control. A flow monitor location is still 
needed. It should be located an appropriate distance upstream of the hinge point. For this dam, it is 
located a few hours upstream at river station 750.1.

The Steady Profile Limits Table is an optional feature (see Figure 14-32). It can make the navigation 
dam operations more robust for rapidly changing flow. It addresses the situation where the water 
surface for a given flow at the dam diverges significantly from the water surface that would be 
expected at the dam for a steady state, uniform flow condition.

A typical example is the trailing end of a high flow hydrograph. For instance, the flows at the hinge 
point and monitor location may have fallen considerably below the Open River condition, but the 
water surface at the dam is still a little high (compared to the flow). When the program computes a 
desired flow at the dam, e.g. 10,000 cfs, it adjusts the gates to get this flow. Over the next six hours, 
however, as the water surface at the dam continues to fall toward a lower equilibrium, the discharge 
can drop significantly below 10,000. This means that the navigation dam response is either sluggish 
in returning to the target water surface at the hinge point and/or the gates have to be changed more 
frequently. This is where the table becomes useful.

The data in this table give the water surfaces at the dam that will produce the target water surfaces 
at the hinge point for steady state conditions. For this navigation dam, it is desired to keep the water 
surface at the hinge point between 645.35 and 645.65 feet (Minimum and Maximum values from the 
water surface elevations table). If, for instance, there is a long term (steady state) flow of 10,000 cfs 
between the hinge point and the dam, then maintaining a water surface at the dam of 645.19 feet 
will result in a water surface of 645.35 feet at the hinge point. Similarly, a water surface of 645.59 at 
the dam will result in a water surface of 645.65 feet at the hinge point, for the same 10,000 cfs flow. 
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The user can generate these profile limits by putting together a steady flow run from the dam up to 
the hinge point location. An iterative process of forcing elevations at the dam and computing them 
at the hinge point is required. The user must find the elevations at the dam that will get to the high 
and low hinge point elevations from a steady flow backwater computation. Then the values used at 
the dam to produce the max and min at the hinge point should be entered into this table.

Figure 14 32. Navigation Dam Editor with Hinge Control

Continuing on with the 10,000 cfs flow example, before the program starts to iterate, it checks the 
current water surface at the dam against the table. If the current water surface is between the limits 
(in this case 645.19 and 645.59), the program continues normally as it would if the table was not 
being used (that is, the user had left it blank). However, let's assume that the water surface at the 
dam is 646.0 feet. This would mean that the water surface at the dam is above the limits. In this case 
the program will temporarily assume a headwater of 645.59 feet at the dam and determine the gate 
settings that will result in a discharge of 10,000 cfs for this lower, assumed, headwater. After this has 
been done, the program will use the new gate setting and continue on normally. This gate change 
will result in the flow at the dam initially being above the 10,000 cfs target. However, as the water 
surface at the dam drops, the flow should also drop down towards the 10,000 cfs range. This will, 
hopefully, produce a faster response without over shooting the target water surface at the dam.

If the water surface is on the low side, it works the same way except the lower limit is used. If the 
water surface at the dam were 645.0 then the gate setting would be based on an assumed water 
surface of 645.19. The profile table is optional and can be left blank. However, it can produce a better 
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response, at least for some data sets. That being said, it should also be noted that the table will not 
perform as well when the flow at the dam is being heavily influenced by tailwater conditions.

Hinge Point and Minimum Pool Operations
The hinge point navigation dam operation can also be combined with limits on the water surface at 
the dam. Hinge point and minimum pool operation will try to maintain the water surface within 
targets at the hinge point, but only when the water surface at the dam is above certain limits. When 
the water surface at the dam drops too low, the program will adjust the gates based on the water 
surface at the dam, essentially reverting to pool only control.
The hinge point and the minimum pool operation are each treated as separate control points. In 
addition to the water surfaces and Flow Factors for the Hinge control, the pool minimum has its own 
full set of water surfaces and

Flow Factors as shown in Figure 14-33 (these are accessed by clicking on the Min Pool Control 
button). Even though the minimum pool control is only trying to maintain a minimum water surface 
at the dam, a full range of water surfaces and Flow Factors are needed. These include the "too high" 
numbers such as Maximum High and Flow Open River. This allows the program to smoothly 
transition between hinge control and pool control. It also allows the pool control response to be fully 
calibrated between sluggish and overly sensitive transitions.
For hinge and minimum pool navigation dams, the program independently determines a desired 
flow for each control point (that is, the hinge and the pool minimum). It will then take the lower of 
the two flows and use that for determining the gate settings.

For example, assume the flows at the monitor location and the hinge point are 40,000cfs and that the 
water surfaces at the hinge point and the dam are 645.6 and 644.9 respectively. Based on the hinge 
point conditions (water surface at hinge point, Targets and Flow Factors for the hinge point), the 
program might compute a desired flow of 41,000 cfs. Next, the program will look at the conditions, 
targets, and Flow Factors at the dam and compute a desired flow of, perhaps, 42,000 cfs. Since the 
desired flow for the hinge point targets is lower than the desired flow for the navigation dam targets, 
the pool minimum is not a limiting factor. The program will adjust the gate settings to get 41,000 cfs 
and the navigation dam is operating under hinge control.
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Figure 14 33. Navigation Editor with Hinge Point and Minimum Pool Operations and Control

The next time the gates are adjusted, assume the flow at the monitor and hinge point are still 
basically 40,000 cfs, but that the water surfaces have dropped to 645.5 feet at the hinge and 644.4 
feet at the dam. The new computed flows might be 40,000 cfs at the hinge and 39,000 at the dam. In 
this case the program would use the 39,000 cfs figure and the dam would be under pool minimum 
control. In other words, the water surface at the dam has dropped to the point that the program has 
to operate the gates to maintain a minimum water surface at the dam regardless of what is 
happening at the hinge point.
The hinge and pool minimum operation is usually under hinge control for low and normal flows. At 
high flows the water surface at the dam must be lowered in order to keep the hinge point within the 
target range. At even higher flows, the water surface at the dam cannot be lowered far enough to 
keep the hinge point in range, thus the dam reverts to pool minimum control. Ideally, the pool would 
be kept at the specified absolute minimum (perhaps 644.1 feet in the above example) until the hinge 
point dropped back down into the target range. This is not possible without continuous adjustments 
of the gates, which is not practicable.
Instead, the water surface at the dam will fluctuate slightly even when it is operating under pool 
minimum control (just like it would fluctuate for pool only control). This is reflected in the range of 
target water surfaces for pool minimum control. The spacing of the target water surfaces has to be 
determined by trial and error. For example, if the water surface Target, Target High, and so on, are 
set to relatively high elevations (compared to the desired value), then the water surface at the dam 
might stay significantly above the minimum of 644.1. This is not desired when the water surface at 
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the hinge point is above the targeted range. Moving the dam target water surfaces closer together 
(closer to 644.1) will cause the program to increase the flows more quickly in order to drive the water 
surface back down. However, this can also cause the program to overshoot the desired target 
leading to frequent gate changes and/or bouncing water surfaces.

If the pool minimum is a hard minimum (a hard minimum might be, the pool should not be allowed 
to drop below 644.1 feet), then this minimum should be coded as one of the lower target water 
surfaces. For example, if 644.1 is the operationally prescribed absolute minimum and the user coded 
the primary water surface Target as 644.1, then the pool would fluctuate around the value of 644.1 
during pool control. It would be better, in this case, to code it to the Minimum Low. On the other 
hand, if the minimum is a "soft" minimum (a soft minimum might be 644.45 +/- .25 feet) then setting 
Target Low or even perhaps the primary Target to 644.45 might give better results. As already 
mentioned, the user should be prepared to take a trial and error approach in order to get the best 
results.

For hinge point and minimum pool operation, the Steady Profile Limits table can still be optionally 
used. This table is only used when the dam is operating under hinge control. The water surface 
values in the table can be lower elevations than the actual limits on the pool. These values are still 
used, but the pool control minimum will still apply. For example, the values in the table go below the 
644.1 desired minimum at the pool. During rapidly changing conditions, when the water surface for a 
given flow diverges from the steady state water surface (for that flow), these lower values can still be 
used and will (in some cases) give a faster response. However, if the water surface actually drops 
down to around the 644 to 645 level, the flow based on pool control will eventually be lower than 
that based on the Hinge/Steady Profile table and the dam will revert to pool control (which, again, 
does not use the tables).

Hinge Point and Minimum and Maximum Pool Control
The final type of navigation dam operations is combining hinge point control with both a minimum 
and maximum limit on the water surface at the dam. This editor has a third button as shown in the 
figures below.

The minimum and maximum pool controls are treated as separate control points even though they 
are both located immediately upstream of the dam. They each have a full set of target water surfaces 
and Flow Factors. The program will compute a desired flow for each control point. Therefore, there 
will be a flow based on the hinge point targets, a flow based on the minimum pool elevation, and a 
flow based on the maximum pool elevation. During normal operations, the flow will be based on the 
hinge point target. However, the desired flow will not be allowed to go below the minimum pool 
control flow and it will not be allowed to go above the maximum pool control flow.
Having separate control points for the minimum and maximum control allows a smooth transition 
between pool control (either high or low) and hinge control for a full range of flows. It also provides 
the greatest control and sensitivity for allowing the water surface at the pool to be maintained within 
the tightest tolerances.
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The optional steady profile limits table may still be used. As before, it only applies to hinge control. 

Figure 14 34. Navigation Editor with Hinge and Maximum and Minimum Control (Min Pool Control 
Shown)
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Figure 14 35. Navigation Editor with Hinge and Minimum and Maximum Control (Max Pool Control 
Shown) 

Modeling Pressurized Pipe Flow

HEC-RAS can be used to model pressurized pipe flow during unsteady flow calculations. This is 
accomplished by using the Preissmann slot theory applied to the open channel flow equations. To 
model pressure flow with HEC-RAS, the user must use cross sections with a Lid option. The cross 
section is entered as the bottom half of the pipe and the Lid is entered as the top half of the pipe. Any 
shape pipe can be modeled, however, the details of the pipe shape will depend on how many points 
the user puts in for the bottom (cross section) and the top (Lid). An example of adding a lid to a cross 
section is shown in Figure 14-36.

NOTE: This option only works with the 1D Finite Difference solution scheme. This option does not 
work with the 1D Finite Volume solution scheme.
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Figure 14 36. Cross Section with the Lid Option entered.

To enter a Lid at a cross section, select Add a Lid to XS from the Options menu on the Cross Section 
editor. When this option is selected, a window will appear as shown in Figure 14-37.

Figure 14 37. Cross Section Lid Editor

Additionally, the user must instruct the program to use the Preissmann Slot option for that 
particular cross section. The Preissmann Slot option can be turned on for an individual cross section 
from the Cross Section Lid Editor by checking the box at the top of the editor. The user can also bring 
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up a table that will show all of the locations where cross sections with lids exist. This table can be 
viewed by selecting Preissmann's Slot on Lidded XS's from the Tables menu on the Geometric 
Data Editor. When this option is selected, a window will appear as shown in Figure 14-38. 

Figure 14 38. Preissmann Slot Table for Cross Sections with Lid's. 

The Preissmann Slot table will show all cross section locations that contain lids. The user can turn on 
or off the Preissmann slot option by simply checking the box next to the desired cross section 
location. All of the check boxes can be turned on or off simultaneously by clicking on the Add 
Preissmann Slot column heading at the top of the table.

In general, lids can be added to any cross section in the HEC-RAS model. Several cross sections in 
succession with lids can be used to represent a pipe. Multiple interconnected pipes can be modeled. 
Lidded cross sections can be used around stream junctions to represent pressurized junctions. 
However, HEC-RAS does not compute minor losses at junctions, bends, or where pipes change size. 
This is currently a limitation in modeling pressurized pipe flow with HEC-RAS. Lateral flows can be 
modeled by either using lateral structures with culverts, or by directly inputting hydrographs as 
lateral flow boundary conditions. The lateral structure option can be used to mimic drop inlets 
connecting the surface flow to the pipe. An example of a pressurized pipe with lateral structures 
connected to the surface is shown in Figure 14-39.
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Figure 14 39. Example Pressurized Pipe modeled with Cross Sections and Lids. 

For the computational details of how the Preissmann slot option works, please see the section on 
modeling pressurized pipes in the Hydraulic Reference Manual.

User Defined Rules for Hydraulic Structures and Pumps
The operating procedures for determining and controlling the releases from reservoirs and other 
types of hydraulic structures can be quite complex. HEC-RAS allows flexibility in modeling and 
controlling the operations of hydraulic structures through the use of rules (Figure 14-40).
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Figure 14 40. Selecting Rules from the Unsteady Flow Data Editor

The rules can be used to operate the height of the gate openings. Alternately, the rules can directly 
control (or constrain) the flow despite the gate openings (or even without gates at all). Examples of 
variables that could be used to control releases from a hydraulic structure are: current flows and 
water surfaces at the structure, current flows and stages at downstream or upstream cross section 
locations, time considerations (winter, morning, etc), and/or previously computed values 
(accumulated outflows, running averages, etc). These variables can be combined with math 
operations and conditional operations to produce sophisticated controls. Rule operations in HEC-
RAS are available for inline hydraulic structures, lateral hydraulic structures, and storage area 
connections.

The rules can also be used at pumping stations. The basic operation for pumping stations, such as 
the water surface at which a pump turns on, is entered on the geometry editor. Rules can be used to 
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modify these operations, for instance by setting a maximum pump flow. Or the rules can entirely 
replace the geometry based operations by specifying when and how the pumps turn on and off.

Entering Rule Operations
Rules for controlling hydraulic structures can be entered after an inline structure, lateral structure, or 
storage area connection has been added to the project. From the Unsteady Flow Data editor, add or 
select the given structure and then click on the Rules button (figure 14-40). This will bring up the 
Rule Operations editor as shown in figure 14-41. In the Gate Parameters table near the top of the 
editor, some initial information can be entered for any gate groups that are in the hydraulic 
structure.

Figure 14 41. Gate Rule Operations Editor

The Open and Close Rate controls how fast the gates can move. So if, for example, a rule operation 
required the gate to open one additional foot and the gate opening rate was 0.1 ft/min and the user 
had selected a one minute time step, it would take ten time steps for the gate to reach the new 
opening height. The Open and/or Close Rate can be left blank, which means the gate can move to 
any new setting in a single time step.
The Max and Min Opening will constrain the maximum and minimum gate opening settings. Building 
on the above example of opening the gate one additional foot, if the gate was at 3.5 feet and the 
maximum was set to 4 feet (even though the gate was 6 feet tall), over a five minute period, the gate 
would open to 4 feet and then stop. If the Max is left blank, then the gate maximum opening is 
limited only by the height of the gate. If the Min is left blank, then the minimum opening is fully 
closed (i.e. 0.0).

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=KMbV-cexP7w

http://youtube.com/watch?v=KMbV-cexP7w
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The Initial Opening provides the first setting for the gate. This opening height will be used during the 
initial backwater computation. The gate will be left at this setting until it is changed by a rule 
operation. The Initial Opening is required for all gate groups, if any, in the hydraulic structure and 
may not be left blank.

At the top of the editor, the user has the option of entering a description of the rule set. This can be a 
useful tool for documentation especially if the user has multiple plans with different rule operations.

Rule Sets

A group of rules for one hydraulic structure is referred to as a rule set. At the start of each time step, 
each rule set is evaluated to check for changes to the operation of the given hydraulic structure. Rule 
operations are performed from the first (top) rule to the last (bottom) rule. By default, each rule 
operation is evaluated once. However, branching operations (If/Then/Else, etc) can cause some rule 
operations to be skipped. No looping or jumping to prior rule operations is allowed. That is (during a 
given time step), a rule operation may not be performed more than once.

Note: A rule set is only called once during a time step, even if the program iterates during that given 
time step. (Whatever rules are "in force" at the start of the time step will apply during all of the 
iterations). At some point, a user option may be added to RAS to let the rule set be called for every 
iteration. This would allow the rule set to use a more "current" water surface and/or respond to 
stability problems.

When the Rule Operations editor is opened, the rules for that hydraulic structure are displayed 
beneath the Rule Operations heading. The rule set shown in figure 14-41 has 7 types of operations.

In this example, operation #1 gets the current gate opening. Operation #2 gets the current flow going 
through the gate. Operation #3 checks if the flow is less than 500 cfs. If it is, then operation #4 sets 
the gate opening to the current opening + 0.1 feet. After operation #4, control would jump to after 
the End If (operation #7). However, since there are no more operations after the End If, the rule set 
would be done for this time step.

If the flow is greater than or equal to 500 cfs, then operation #3 is false. In this case, control would 
jump to operation #5. Operation #5 checks if the flow is greater than 750 cfs. If it is, then operation #6 
will close the gate 0.1 feet. In either case, the rule set would again be finished for this time step.

Operation Rules
To add, delete, or edit rule operations, click on the Enter/Edit Rule Operations… button at the 
bottom of the Rule Operations editor. This will bring up the Operation Rules editor as shown in figure 
14-42.
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Figure 14 42. Operation Rules Editor 
Seven different types of operations can be added by clicking one of the buttons under the Insert New 
Operation field. A brief overview is given immediately below and this is followed by a detailed 
description of each rule operation type.

Operation Types
Comment. Provides a user entered line of text (for documentation only).
New Variable. Allows the user to create a variable and give it a custom name.
Get Simulation Value. A variable is set equal to a given value in the simulation, such as the flow at a cross 
section or the time of day.
Set Operation Parameter. Changes the operation of the hydraulic structure, for example, adjusting the gate 
height or setting a maximum discharge.
Branch (If/Else). Controls which operations are executed on the basis of an If-Then test (e.g., do different 
gate operation checks based on seasonal considerations).
Math. Performs math operations such as summing flows or averaging water surfaces.
Table. This operation allows the user to enter a table and perform table lookups to get a value.

Comment

Clicking the Comment button allows the user to enter a line of text. This "operation" is not used 
during the computations. Rather, it is intended to make the rule set operating procedure easier to 
understand by allowing the user to document the rules inside of the rule set (see figure 14-43). Note: 
because RAS uses a comma as an internal delimiter, it will not allow a "," to be part of a comment 
line.
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Figure 14 43. Operation Rules Editor with comment line shown

New Variable

The New Variable button brings up the editor as shown in figure 14-44. The name of the variable 
must be entered in the User Variable Name field. The name must be unique. That is, it can't be the 
same as any other variable name in the given rule set. A duplicate name will cause a run time check 
error, as discussed below.
By default, the variable type is real (which includes fractional numbers such as 11.35). The 
alternative type is integer (counting numbers such as -2, 0, 1, 5, 10, etc). If the user selects integer, 
the value of the variable will always be an integer. So if the current value of a user integer is 4 and a 
math operation (see below) adds 1.7 to it, the final value will be rounded to the nearest integer (in 
this case 6).
The user may enter an initial value for the variable (by default the value is zero). The variable is only 
initialized to this value at the start of the simulation. (To initialize a variable every timestep, use a 
Math operation.) It will equal this value until (or unless) it is changed by another rule. For example, if 
the user variable, "Test Case" has an initial value of 3 and at the start of the fourth time step it is 
changed (by another rule) to a value of 6. At the fifth time step, it will equal 6 (it is not "reinitialized" 
to 3) and will continue to equal 6 until/unless it is changed again.
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Figure 14 44. Operation Rules Editor with New Variable operation shown

If the user checks the optional "Include Variable in Summary," then the variable will be listed on the 
main Rule Operation editor as shown in figure 14-45. The initial value can then be entered or 
changed directly on the Rule Operations editor. 
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Figure 14 45. Rule Operations Editor with Summary of Variable Initializations

Get Simulation Value

The Get Simulation Value operation provides information about the current state of the model. In 
the example shown in figure 14-46, the operation is getting the day of the month at the beginning of 
the time step and putting it into a new variable called "Day Beg time step." For example, if the 
simulation time window went from 01Jan2000 to 03Jan2000 and the run was about halfway through, 
the "Day Beg time step" variable would be set to 2.
This is another way to create a "new variable" (a variable does not have to be created with the New 
Variable button). However, variables created in this manner cannot be integers (they may only be 
real types), they cannot be assigned an initial value (or rather, the initial value is always zero), and 
they cannot be included in the Variable Summary.
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Figure 14 46. Operation Rules Editor with Get Simulation operation shown

If the user selected to change the Assign Result to Existing Variable, then a drop down menu would 
appear as shown in figure 14-47. Selecting one of the previously defined variables would put the 
result (day of the month in this example) into that variable instead of creating a new one. 

Figure 14 47. Get Simulation Value assigning to an existing variable

Note: on renaming New/Existing variables. A new variable (whether it is from a user variable, get 
simulation, math, or table operation) can be renamed by typing in a new name. However, any 
references to that variable will not be automatically renamed! A reference to a non-existent 
variable will result in a run time check error. The user will have to manually change all references to 
that variable (whether on the Assign Result to an Existing Variable or using an Existing Variable in an 
Expression, see below). This is also covered in the discussion of Check Rule Set, below.
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There are currently eight categories of simulation variables (more may be added later). These are 
Time, Solution, Cross Section, Inline Structure, Lateral Structure, Storage Areas, Storage Area 
Connectors, and Pump Stations. Clicking on the "+" will expand the list for that category. A complete 
list and definition of each variable is given at the end of this section of the manual.
For all the variables under Time, the user can select to use the time at the beginning of the time step 
(default), the end of the time step, or the previous time step. For example, assume the time step was 
30 minutes long and the program had just finished the time step that ended at 12:15 (the program 
had just gone from 11:45 to 12:15 and was getting ready to go from 12:15 to 12:45). The minute of the 
hour at the beginning of time step would be 15. The hour of the day (fractional) for the beginning of 
the time step, end of time step, and previous time step would be 12.25, 12.75, and 11.75, 
respectively. The hour of the day at both the beginning and end of the time step would be 12. The 
previous hour of the day would be 11.

To get a water surface or flow at a normal cross section, expand the Cross Section list and highlight 
either the Flow or WS Elevation field as shown in figure 14-45. This will also display the standard 
node selector to allow the user to select the river, reach and river station for the desired cross section 
(also shown in figure 14-48).

Figure 14 48. Selecting water surface at a cross section

At the far right is another drop down menu that allows additional choices for when and how the 
simulation value (water surface in this example) is computed, see figure 14-49. The default is the 
Value at the current time step. In the time example above, this would be the water surface at 12:15 
for river station 73.75. Alternately, the user could select the Value at previous time step, which 
would be the water surface at 11:45 in the above example.
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Figure 14 49. Changing how simulation values are computed

The remaining choices provide various options for the value further back in time. Selecting Value at 
specified lag, will display a window where the lag time in hours is specified. So continuing to build 
on the same example, a lag time of 1.5 hours would get the water surface at the given cross section 
at 10:45 (12:15 minus 1.5 hours equals 10:45). For the next four options, the user must specify a 
starting and ending lookback time. Selecting Sum over previous time window, the user could enter 
1.5 for the starting time and 0 for the ending time (for the specified time window to end at the 
current time step, the ending time should be 0). So if the user selected flow, this would sum the flow 
for the previous 1.5 hours. In other words, it would return the volume of water passing the given 
node for the previous 1.5 hours (since the value takes into account the length of each time step, this 
is more technically an integral instead of a sum). Or the user could select water surface, select 
Average over the previous time window, enter 2 hours for starting time and 1 hour for ending time, 
see figure 14-50. This would return the average water surface at the cross section between 10:15 and 
11:15. The next two options will return either the maximum or minimum value over the given user 
specified time window (e.g. the highest water surface). 

Figure 14 50. One hour average water surface starting two hours ago

Under the inline structure simulation variables as shown in figure 14-51, some of the choices are 
shown in bold font. The variables shown in bold are user settable operational parameters (Figure 
14-52) for the current hydraulic structure (which happens to be an inline structure). These variables 
are also provided under the Get Simulation Value. This provides a way to check what an operational 
parameter has been set to (if it has been set at all). So, for instance, if a maximum flow had been set 
for the structure, then the Structure – Flow Maximum variable would return the value that this had 
been set to. The variables listed in bold are only available for the current inline structure—this is the 
hydraulic structure that this particular rule set is attached to.)
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Figure 14 51. Getting an Operational Parameter

Set Operational Parameter (for hydraulic structures)

Clicking the Set Operational Param button brings up the editor that allows a change to be made to 
the hydraulic structure operations (i.e. adjusting a gate opening).  Changes can only be made for the 
hydraulic structure or pumping station that the rule set is attached to.  This is the hydraulic structure 
(inline, lateral, or storage area connection) that was selected on the Unsteady Flow Data editor.

Figure 14‑52. Setting an Operational Parameter

Figure 14-52 shows a change being made to the gate opening height (the gate will be moved to the 
new gate setting based on the Opening/Closing rate and maximum and minimum values, if any).  If a 
gate variable is used, the appropriate gate group must be selected from the drop menu at the 
bottom.  The new value is set equal to the value of the expression.  (The expression might be a 
constant, such as the number “5”, a user variable as shown in Figure 14-52, or a simple math 
operation.  See Math operations, below, for a detailed description of using expressions).  The 
Opening Rate or Closing Rate changes the rate at which the gate can open or close.  This overrides 
any value that the user may have entered on the Rule Operations editor.
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Gate - Flow (Fixed) sets the gate flow to the given value.  However, setting or changing the Flow 
(Fixed) value does not affect the gate opening height (the given amount of flow will be released 
through this gate group from the reservoir regardless of the gate opening height).  The Fixed flow 
value will be used each time step until the Fixed flow is changed or removed.  To remove the Gate - 
Flow (Fixed) parameter, set the Flow (Fixed) expression to “Not Set” as shown in figure 14-53 (see 
Math below for editing expressions).

Figure 14‑53. Turning off the Gate Fixed Flow

Gate - Flow Maximum and Minimum puts limits on the gate flow.  For example, if the user sets the 
flow maximum to 1000 cfs, the program would first compute the flow through the given gate based 
on the gate opening and water surface(s), if the flow is below 1000, it would use that value.  If the 
computed flow was larger, the program would restrict the flow to the user entered amount (1000 
cfs).  Note, however, that the Gate Maximum and Minimum flow will not override a Gate Fixed flow 
value.  Gate Maximum and Minimum flow can be removed by using the “Not Set” value.

Gate - Flow (Desired) will cause the program to adjust the gate opening in order to give the given, 
desired, flow (based on the water surfaces and the gate characteristics) through the gate group.  
Once the gate opening is determined, the program will use this opening height to compute the 
actual flow.  Since determining the gate opening is an inexact, iterative process, the actual 
computed flow may not perfectly match the desired flow.  Note also that the program will not open/
close the gates faster than the current Opening/Closing Rate, if any, allows.  The program will adjust 
the gate opening each time step as long as the Gate Flow Desired has a value.  This feature can be 
turned back off by using the “Not Set” value.  Having the Desired value on will not prevent the final 
gate flow from being overwritten by a Maximum, Minimum, or Fixed flow.  If the user wishes to force 
a given gate flow, but also wishes to know the [approximate] gate settings that would result in that 
flow, then this can be done by setting both the Fixed flow and the Desired flow to the same value 
(e.g. 3000 cfs).

The rule set shown in figure 14-54 illustrates how these gate features can be used and combined.  
The resulting output is shown in figure 14-55.
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Figure 14‑54. Desired and Fixed Flow Gate Operations

The initial gate opening is 6.0 feet.  The If/Then test on row #2 is false until the time reaches 1:15 (this 
is 1.25 in fractional hours).  At that point, row #4 is executed and the Desired Flow is set to 600 cfs.  
The gates open (at the user set opening rate) until the flow is approximately 600 cfs.  After 1:30, the 
Desired Flow is turned off (“not set”).  The gates then remain at that, current, gate height (6.1295 
feet).  At 1:45 row #8 is executed and the flow is fixed at 700 cfs (but the gate opening height is not 
changed).  At 2:30, the Desired Flow is turned back on by setting it to 700 cfs (same as the fixed flow).  
This causes the gates to adjust.  However, the actual release remains exactly 700 cfs because the 
Fixed Flow is still set to 700.
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Figure 14‑55. Output from Desired and Fixed Flow Gate Operations

In addition to the gate control operations for individual gate groups, the user can set limits on all of 
the gates groups combined:

Structure - Total Gate Flow sets the flow for all of the gate groups.  Instead of summing the flow 
from each gate group (and regardless of whether the gate group flow is “natural” or “fixed”), this 
flow is used instead.

Structure - Total Gate Flow Maximum sets a maximum flow for all of the gate groups.  It will not 
override Structure - Total Gate Flow.

Structure - Total Gate Flow Minimum sets a minimum flow for all of the gate groups.  It will not 
override Structure - Total Gate Flow.

The next category of structure operation parameters are for weirs:

Weir – Flow fixes the amount of flow over the weir.

Weir - Flow Maximum sets the maximum flow over the weir.  It will not override Weir – Flow.

Weir - Flow Minimum sets the minimum flow over the weir.  It will not override Weir – Flow.

Weir - Weir Coefficient sets the weir coefficient for the weir.  (Tip:  this allows a straight forward way 
to adjust the weir coefficient based on the depth and/or velocity of flow over the weir).

Weir - Minimum Elev for Weir Flow changes the minimum weir elevation that is required before the 
program will compute flow for the weir.

Weir - C Simple (Positive) sets the linear routing coefficient for positive flow (linear routing weirs 
only).

Weir - C Simple (Negative) sets the linear routing coefficient for negative flow (linear routing weirs 
only).

The final category of structure operation parameters are for the overall structure:

Structure - Total Flow (Fixed) forces the given flow for the inline structure.  This flow is used 
regardless of the flow from the gates and/or weir.

Structure - Flow Maximum sets a maximum flow for the inline structure.  It will not override the 
structure Fixed flow.

Structure - Flow Minimum sets a minimum flow for the inline structure.  It will not override the 
structure Fixed flow.

Structure - Flow Additional will add in the additional given flow to the inline structure.  It will not 
override the structure Maximum, Minimum, or Fixed flow.

Structure - Total Flow (Desired) computes gate settings to provide the total given flow for the 
inline structure.  It works in a similar manner to Gate - Flow (Desired).  However, it will open or close 
any/all of the gate groups to get the correct flow.  (To increase flow, gate groups are opened in a left 
to right manner.  To decrease flow, gate groups are closed from right to left.)  Weir flow (and Flow 
Additional) is included in the desired flow (if the desired flow is 2000 cfs and the weir flow is 500 cfs, 
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the gates will be adjusted to get 1500 cfs of flow).  Structure - Total Flow (Desired) will not override 
Structure - Total Flow (Fixed).  However, it will still adjust the gate group settings.

Structure - Stage (Fixed) will force the given water surface immediately upstream of the inline 
structure.  This option is very similar to the stage part of the Internal Boundary (IB) Stage and Flow 
Hydrograph option from the Unsteady Flow Data editor (see chapter 8).  When the Unsteady Solver 
determines all of the flows and water surfaces at all the cross sections during the solution of a given 
time step, it will compute the amount of flow at the inline structure that is required in order to 
produce the given water surface.  It is easy to generate instability and/or hydraulically unrealistic 
flows when using this option.  For instance, a large increase in the fixed stage over a single time step 
could potentially cause very small or even negative flows through the inline structure and/or cause 
the model to go unstable.  A large drop in the fixed stage may generate a flow that is physically 
greater than the structure is capable of passing.  To avoid these problems when changing the given 
water surface, it is recommended that the fixed stage is gradually adjusted over a period of time.  In the 
sample data sets that are included in the HEC-RAS installation, there is an example that illustrates 
this.

It should be noted that the Fixed Stage option is not compatible with the other set operational 
parameters.  The flow through the inline structure is completely controlled by the requirement to 
generate the correct, given water surface.  Therefore, any maximum, minimum, and/or fixed flow 
rules, that would otherwise be in effect, are ignored.  Additionally, when the Fixed Stage rule is being 
used, HEC-RAS will automatically adjust the gates (and will also ignore any set operations for the 
gate openings).  The gates are adjusted in order to approximate the gate opening that would be 
needed to accommodate the computed flow.  Effectively, a Total Flow (Desired) rule is put into effect 
where the desired flow is set equal to the flow that is being forced through the structure by the Fixes 
Stage option.  This will generally allow the Fixed Stage option to be turned off (using the “not set” 
feature) and normal gate flow to be resumed without causing instability.

Set Operational Parameter (for pumping stations)

Clicking the Set Operational Param button for pumping station brings up the editor shown below 
(figure 14-56). 
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Figure 14 56. Setting an Operational Parameter for Pumping Stations 

The operation of rules to control a pumping station is generally similar to the operation of rules to 
control a hydraulic structure, but, there is at least one notable difference. If a Rules Boundary 
Condition is selected for a hydraulic structure, then all of the control of that structure (e.g., gate 
openings) is handled by the Rules entered from the Operation Rules Editor. 
However, this does not have to be the case for a pumping station. When a Rule Set is entered for a 
pumping station, the Rule Operation could be used in order to modify the control of the pumping 
station without entirely superseding the information that was entered as part of the geometry. For 
example, a pumping station may have a set of rules that determine a maximum amount that can be 
pumped, but the rules do not specify when the pumps should be turned on and off. This results in a 
hybrid control situation. Whether the pumps are pumping or not is determined from the data 
entered as part of the geometry. The amount of pump flow is also determined from the pump 
efficiency curve from geometry information, but this amount is not allowed to exceed the maximum 
set by the rules.
Alternately, the user can override the geometry control by the use of rule operations. But even after 
the rules have superseded the geometry, the rules can still "hand control" back to the geometry 
control. This brings up an important concept about the control of a pumping station.
When using rules, there are two fundamentally different modes of operation for turning individual 
pumps on and off.
Initially, the pumps are turned on and off based on the WSEL On and WSEL Off elevations that have 
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been entered in the Geometry Pump Station Data editor. This is referred to as the WSEL On and Off 
mode of operation. (That is, this mode is active.) The pump rules can be used to modify the water 
surface elevations (the water surface elevations entered from the geometry) that the pumps turn on 
and off. This does not, in itself, change the WSEL On and Off mode. If the mode was active, it stays 
active.
However, a pump can also be turned on or off by directly using a rule. Anytime a rule is used to turn a 
pump on or off, then the WSEL On and Off mode is automatically deactivated for that pump. When 
the WSEL On and Off mode is deactivated, the On/Off water surfaces elevations (that were entered as 
part of the geometry) will no longer control that specific pump. (The pump can continue to be turned 
on and off using rule operations, of course.) If it is desired to return control to the On/Off water 
surfaces on the geometry editor, then the WSEL On and Off mode must be made active. This is done 
by using the Reactivate WSEL On and Off mode rule (see below).

Station – Pump Flow sets the pumping station flow to the given value.

Station – Pump Flow Maximum sets a maximum flow for the pumping station.

Station – Pump Flow Minimum sets a minimum flow for the pumping station.

Station – Turn All Pumps On starts turning all the pumps on (this will make the WSEL On and Off 
mode inactivate for all pumps).

Station – Turn All Pumps Off starts turning all the pumps off (this will make the WSEL On and Off 
mode inactivate for all pumps).

Group – Pumps Flow sets the group pump flow to the given value.

Group – Pumps Flow Maximum sets the maximum group pump flow to the given value.

Group – Startup Time sets the time to ramp on the pumps in this group to the given value.

Group – Shutdown Time sets the time to ramp off the pumps in this group to the given value.

Group – Flow Factor sets a multiplier for the pump flow in this group to the given value.

Group – Head Maximum sets a maximum head this group will pump against.

Group – Head Minimum sets a minimum head this group will pump against.

Group – Additional Head sets an additional head this group will pump against.

Group – Turn All Pumps On starts turning all the pumps in this group on (this will make the WSEL On 
and Off mode inactivate for pumps in this group).

Group – Turn All Pumps Off starts turning all the pumps in this group off (this will make the WSEL 
On and Off mode inactivate for pumps in this group).

Pump – Flow sets the pump's flow to the given value.

Pump – Flow Maximum sets the pump's maximum flow to the given value.

Pump – Flow Minimum sets the pump's minimum flow to the given value.

Turn Pump On starts turning the pump on (this will make the WSEL On and Off mode inactivate for 
this pump).
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Turn Pump Off starts turning the pump off (this will make the WSEL On and Off mode inactivate for 
this pump).

Reactivate WSEL On and WSEL Off mode this will make the WSEL On and Off mode activate for this 
pump. The pump will turn on and off based on the water surface elevations entered on the Geometry 
Pump Station Data editor.

WSEL On sets the water surface elevation to turn this pump on (when the WSEL On and Off mode is 
active for this pump).

WSEL Off sets the water surface elevation to turn this pump off (when the WSEL On and Off mode is 
active for this pump).

Branch (If/Else):

The branching Branch(If/Else) operation allows for decision making based on the value of two (or 
four) expressions. Figure 14-57 shows a simple example. If the gate flow is less than 500 cfs, then the 
program will go from row #4 to the next operation at row #5. Otherwise, it will skip down to the first 
row after the End If (row #7). Note that the editor automatically indents the operations between the 
If and the End If.

Figure 14 57. Branching Operations

Clicking the Branch(If/Else) button brings up a blank (i.e. not set) If/Then as shown in figure 14-58. 
The user must define a value for both expressions. Going back to figure 14-57, the first expression is 
the flow through the gate and the second expressions is the constant 500. The user must also choose 
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a comparison test from the drop down menu between the two expressions. In figure 14-57 (row #4), 
the comparison is less than. So the If/Then test is true when the first expression is a smaller number 
than the second (i.e., the flow is under 500 cfs). The comparisons that the user can choose from are: 
less than, less than or equal to, greater than, greater than or equal to, equal to, or greater than or 
less than (i.e. not equal to).

Figure 14 58. Creating a (blank) If/Then Operation

The user must add the End if that is associated with each If/Then. This is done by clicking on the 
Branch(If/Else) which brings up another blank If/Then as shown in figure 14-59. For the Branching 
Line Type, select End If as shown in figure 14-60. 

Figure 14 59. Adding another blank If/Then Operation (first step in adding an End if)



Advanced Features for Unsteady Flow Routing

HEC-RAS User's Manual– 693

Figure 14 60. Changing the Branching Line Type to an End if

Important! There must be one, and only one, End If for each If/Then.
The rule set as shown in figure 14-59 is not valid because it has three If/Then operations but only two 
End Ifs. Notice how the last operation, row #10, is indented. If the last row is indented, then the rule 
set is missing at least one (if not more than) End if.

Although not required, it is highly recommended that the user create the End If operation 
immediately after adding the If/Then operation.
When the If/Then is added (figure 14-59), all the remaining operations are indented, which can look 
confusing. Figures 14-59 and 14-60 show the steps in adding the End if. To add the End If, the 
Branch(If/Then) is clicked again, which adds another If/Then that causes the remaining operations 
to be indented even further (figure 14-58). However, once the rule operation is changed from an If/
Then to an End If (figure 14-59) the remaining operations return to their appropriate location. With 
the desired If/Then and End If in place, the If/Then operation can be defined and additional rule 
operations can be inserted between the If/Then and the End If as desired. The program will allow the 
operations to be added in any order. So the user could, of course, create the If/Then and then add 
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the additional operations, before finally creating the End If. However, up until the End If is added, the 
indentation on the display is liable to cause confusion.

Warning! When an If/Then rule operation is deleted, the user must also delete the appropriate End 
If.
Just as it is possible to have more If/Then operations than End If operations, it is also possible to 
have too many End If operations. There is an erroneous End If in row #7 of figure 14-61 (if there is an 
End If that does not have an If/Then, it will be displayed in red). If a rule set has a large number of 
operations with complex, nested If/Then operations, it may be worthwhile to note which End If 
corresponds to which If/Then before beginning to delete either rule operation.

Figure 14 61. Erroneous "End If" is displayed in red

Instead of simple If/Then, a two part if test can be done by selecting the If And/Or Then option under 
the Branching Line Type. This requires the user to define four expressions and select a logical 
operator, figure 14-62. In the first part, the first two expressions are compared (using a greater than 
for the example in figure 14-62). In the second part, the third and fourth expressions are compared 
(using a less than or equal to, in the example). The final step is testing the two parts with the logical 
operator. For figure 14-62, And has been selected from the drop down menu between the two sets of 
expressions. If both the first part and the second part are true, then the overall If test is true. If either, 
or both, the first or second part are false, then the overall If test will be false. The two parts can also 
be tested with an Or logical operator by changing the selection on the drop down menu. If this is 
done, the test will be true if either the first or the second part is true. Only if both parts are false will 
the If test then be false.
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Figure 14 62. Two part If/Then test 

If/Then operations can be nested. Figure 14-63 shows an example where the check for the gate 
adjustment is made at the top of the hour and half past the hour. If the first If/Then is false (not an 
appropriate time), then control will jump to after the corresponding End If (as shown by the level of 
indentation) at row 12. Continuing the example, If the first If/Then is true (time to make flow check) 
then the second If/Then will be evaluated (row #5). Control will go to row #6 or row #8 depending on 
whether the second If/Then is true or false.

Figure 14 63. Nested If/Then test

After an If/Then and corresponding End If have been added, an Else can be added as shown in figure 
14-64. When the original If is false, control will go to the first line after the Else (row #12 in the 
example). When the original If is true, the operations between the If and the Else will be performed. 
Once control reaches the Else, it will jump to the End If (after row #10 control will jump to row #14).
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Figure 14 64. Else Operation 

Instead of a simple Else, another option is an ElseIf. In this case, there is a second conditional. The 
operations after the ElseIf will only be performed if the initial If is false and the second If (that is, the 
ElseIf) is true. Additional ElseIfs can be added as shown in figure 14-65. An Else can also be combined 
with the ElseIf(s). However, there can only be one Else and it must come after the ElseIf(s). Therefore, 
after a simple Else operation, there may not be any more ElseIf or Else operations. (The limitations 
on ElseIfs/Else only apply to branching types at the same level of indentation, that is, in the context 
of the given If/Then End If. There may still be other "nested" conditionals with their own ElseIfs and 
Else operations).
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Figure 14 65. Elseif Operations 

The display of the rule operations between an If/Then and the corresponding End If may be 
"collapsed." Note the "" at the beginning of each If/Then rule. Clicking the "" will change it to a "" 
and the display of the rules between the If/Then to End If will collapse as shown in figure 14-66. 
These rules are still in effect (collapsing rules does not change their operation). This option merely 
changes the display, and it is intended to make large rule sets easier to understand and manage. 
Clicking the "" will expand the rules back to their original form. Note: all of the operations under the 
Current Selection Changes (cut, copy, paste, etc), see below, function normally even on collapsed 
regions. In the above example where the collapsed region is highlighted, clicking the Delete button 
would delete rules 47 through 66. 
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Figure 14 66. Collapsed If-Then

Math

Clicking the Math operation button creates a [blank] math operation as shown in figure 14-67.  The 
result of the math operation can be assigned to either a new variable or an existing variable (in the 
same way that a get simulation variable can be assigned, as above).

The math operation itself is composed of up to four different “expressions.”  Each expression that is 
defined will return a real number.  Expressions should be defined from left to right.  So if a math 
operation is composed of two expressions, the left two expressions should be defined and the right 
two expressions should be left as “[not set]” (i.e. they should be left blank).  If more than one 
expression is defined, then the user must choose an algebraic connector from the drop down menu 
between them.  The choices are:  addition, subtraction, multiplication, and division.

The value of each individual expression is determined and then the remaining algebraic operations 
are performed from left to right.  So if the math operation has the three expressions as shown in 
figure 14-68, the first two expressions are added together and that sum is then divided by the third 
expression.
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Figure 14‑67. Blank Math Operation

Figure 14‑68. Three Expression  Math Operation

Expression.  To define an expression, click on the Edit button to bring up the Edit Rule Expression 
editor as shown in figure 14-69.  If no values have been entered (or if the Clear Expression button 
has been clicked), then the current expression will be shown as “[not set].”
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Figure 14‑69.  Blank Rule Expression

Up to five fields in the expression editor can be defined.  Any that are not defined are ignored.  The 
simplest expression is to enter a single number in the Constant field as shown in figure 14-70.  In this 
example, this expression will always have a value of 5.

Figure 14‑70.  Rule Expression set to a constant

Another simple example is shown in figure 14-71.  Here a preexisting variable has been selected from 
the drop down menu.  This expression will return the current value of this variable.  An optional 
coefficient can be added in front of the selected variable and a value may also still be added under 
the constant field.
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Figure 14‑71. Rule Expression set to an existing variable

The Variable can also be raised to an exponent by entering a value in either or both of the fields 
inside of the parenthetical.  If only the Exponent Coefficient or the Exponent Variable is defined, then 
the variable is raised to the given value of the Exponent Coefficient or Exponent Variable, see figure 
14-72.  If both are defined, then the Exponent Variable is multiplied by the Exponent Coefficient and 
the given Variable is raised to the resulting product.

Figure 14‑72. Variable raised to an exponent multiplied by a coefficient

Note:  each expression is always determined before operations between expressions are performed.

Table

The final operation type is a table lookup.  Clicking the Table operation button creates a table 
operation as shown in figure 14-73.  The result of the table lookup can be assigned to a new variable 
or an existing variable.  The table can be either one or two dimensional.
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Figure 14‑73. Table lookup operations

Figure 14-73 shows a one dimensional table operation.  The table data can be entered (and/or 
viewed) by clicking on the Enter/Edit Table Data… button.  This brings up the Rule Table editor as 
shown in figure 14-74.
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Figure 14‑74. Rule Table Editor

When the table operation is performed, the program will determine the value of the Expression, 
which starts out ‘Canal Dam’ in the example in figures 14-73 and 14-74.  The location of the 
Expression value is determined in the left hand column of the table (figure 14-74) and the 
corresponding lookup value is determined from the right hand column.  In the above figure, if the 
value of the expression happens to equal 13.08, the result of the table lookup would be to assign the 
value 1.2 to the variable “Head Opening #1.”

The Argument Name (“Flow MGD” in the above example) is used as the heading for the left column.  
This is only used as a label.  (Alternately, the program could have used the numeric formula in the 
given expression as the heading label, but this could be rather long and awkward.)  This label is only 
used as a heading in the Rule Table editor (it is not a user selectable variable).

The right hand column is labeled with the assignment result.  In this example, the result of the table 
lookup is being assigned to a new variable called “Head Opening #1.”
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By default, the lookup will interpolate between values.  So in the above example, if the expression 
equaled 14.78, the lookup would return 1.3.  This can be changed by the drop down menu that is just 
above the Enter/Edit Table Data.  There are three other choices.  “Nearest index value” will move up 
or down to the nearest value (14.7 would return 1.2 and 14.8 would return 1.4, in the above table).  
“Index <=value” and “Index >=” will go down or up to the next value in the table.  These other options 
can be useful for forcing exact gate settings.  For instance, if it was desired that the gates only be 
opened to the nearest tenth of a foot, values in tenths (e.g., 3.0’, 3.1’, 3.2’, etc) could be entered in a 
table and “Nearest index value” selected.  The result of the table lookup could then be used to set 
the gate.

Tip:  Another possibility for forcing exact gate settings is to use an integer user variable.  Assume that 
the gate can be opened in hundredths of a foot (e.g., 3.00’, 3.01’, 3.02’, etc.).  These could be [tediously] 
entered into a table.  Alternately, the approximate gate opening could be determined, say for example, 
3.028 feet.  This value could be multiplied by 100 to get 302.8.  This value, 302.8 could be assigned to an 
integer user variable which would result in 303.  Finally, this could be divided back by a 100 (assigning 
the result back to a real variable) to get 3.03 that could then be used to set a gate opening.

NOTE:  By default the software will extrapolate at both ends of the user entered tables.  
Meaning, if a value is requested above the last value of the Table, the software will take the last 
two points in the table, project a straight line, and then extrapolate to get a value.  The same 
thing is done at the lower end of the table.  If a value is requested that is below the lowest point 
in the table, the first two vales are used to create a straight line, and a value is extrapolated 
below the table.  Therefore if you want to control the lower end of the table, you will need to 
put in an extra row that will encompass all possible values requested.

Instead of a one dimensional table, the other option is a two dimensional table as shown in figure 
14-75.  The editor now has two expressions and two argument Names (the top argument name 
corresponds with the left expression and the bottom argument name corresponds with the right 
expression).  Clicking Enter/Edit Table Data brings up an expanded Rule Table as also shown in 
figure 14-75.  As before, the left most column corresponds to the value in the first expression.  The 
top row now corresponds to the second expression.  The value in the table is determined by two way 
interpolation (or nearest value depending on the interpolation option).  So in the table shown, if the 
first expression (“Inline Flow”) is equal to 5000 and if the second expression (“Hour”) is equal to 9, 
then the value from the table lookup would be 400.
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Figure 14‑75. Two dimensional Table

Current Selection Changes.  On the right hand side of the Operation Rule editor (figure 14-76), are 
six buttons for manipulating the current, highlighted rule (or selection of rules).  The Cut, Copy, 
Paste, and Delete buttons operate in a normal, Windows manner.  One or more rules may be 
selected using the keyboard (e.g. Shift + down arrow) or the mouse pointer (e.g. Ctrl + click) as 
shown in figure xxx.  A copy of the rule(s) can be put on the Clipboard with the Copy button and can 
then be pasted (using the Paste button) to another location, as shown in figure 14-80.
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Figure 14‑76. Copying Highlighted Rules

The copy function makes an exact duplicate of the selected rules.  This can generate potential 
“errors” that the user will have to correct.  For instance, in the above example of using the copy 
function, rule 6 is a Get operation that assigns the result to the “New Variable” named Gate Elv New.  
The copy of this rule, rule 13 in figure 14-77, is also assigning the result to the same “New Variable” 
named Gate Elv New.  After copying this rule, the user must change one of the “Gate Elv New” names 
to something else.  Or, if it is intended that the copy use the same variable, the user should change 
the assign result for the copied rule to “Existing Variable” and then select Gate Elv New from the drop 
down menu.

Since the copy function uses the standard Windows Clipboard, rules can be pasted into a completely 
different rule set, or the user can even open up a different plan (or different RAS project) and paste 
the results.  The user will have to correct any erroneous variable names or references (different 
cross section river stations, different gate group names, etc.).

Figure 14‑77. Pasting Rules
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The Cut button will move the highlighted rule(s) to the clipboard.  After the rules have been removed 
by cutting, the Paste button can then be used as a “move” operation.  The Delete button 
permanently removes the highlighted rules.  There is no “undo” operation, so care should be 
exercised when using the Delete button.  However, if a mistake is made, the Cancel button will 
cancel all the changes that have been made since the Operation Rules editor was opened.  Tip:  
frequently saving the changes made in the Operation Rules editor allows the Cancel button to be used 
as an “undo” operation without canceling too much work.

Note:  If a collapsed If/Then-End If block is highlighted, then it will still be subject to copy, paste, and 
delete/cut, just as it would be in its fully expanded state.

Tip:  The standard Windows shortcut keys:  Ctrl + “x”, “c” or “v” may be used instead of clicking 
on the Cut, Copy, or Paste buttons.

Checking the Disable button is a quick way to temporarily remove the highlighted operations (it will 
cause the highlighted operations to be displayed as green comment lines with a strikethrough), see 
figures 14-78 and 14-79.  These operations will no longer be performed by the program (be careful 
disabling Branching Line Types).  Clicking the Enable button will restore the operations.

Figure 14‑78. Disabling Highlighted Rules
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Figure 14‑79. Disabled Rules

The Copy Rules Text to Clipboard will copy the display text of the entire rule set to the clipboard 
(figure 14-80).  This can then be pasted, for instance, as simple text into Notepad or a Word 
document report (figure 14-81).  This copy if for “display” only and may not be pasted back into a 
rule set.

Figure 14‑80. Copying Rule Text to the Clipboard

Figure 14‑81. Text Pasted into Notepad

Clicking the right mouse button (on a given row) will display a popup editor as shown in figure 14-82.  
In addition to the functions described above, the Insert New Operation functions are also available in 
this manner.
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Figure 14‑82.  Right mouse click on a line

Clicking the Check Rule Set… button will cause RAS to check the rule set for common user errors.  
All of the rule sets in the model will also be checked when an unsteady flow run is launched.  The 
Check Rule Set… button is just a convenient way to find and fix rule errors for the given rule set 
while the Operation Rules editor is opened.

If no errors are found, RAS will display a message stating that no inconsistencies were found.  
Otherwise, RAS will display a list of the mistakes and the line numbers they occur.  An example is 
shown in figure 14-83.  Common problems are:  a variable name that has been defined more than 
once, a reference to a non-existent variable (the variable was renamed or deleted), “unbalanced” If/
Then End If operations, or a reference to a non-existent node (e.g. a river station that has been 
removed from the project).
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Figure 14‑83. Checking the Rule Set

Font.  In the upper right hand corner of the Operation Rule editor, there is a drop down menu where 
the user can change the rule operation font size.  The font can also be toggled between normal and 
bold by checking the Bold Font box.

Detailed Log Output.  If the detailed log output is turned on, then results from each rule set will be 
sent to the log file during runtime, see figure 14-84.  On the left side is the row number of the 
operation followed by the result of the operation.  For instance, the operation at row #19 results in 
the variable ‘Tampa Dam Flow’ being set equal to 324.9499.  Row #32 is an If/Then test that came 
back false.  For this time step, for this operation, the first and second expressions are both equal to 
4.  This results in the less than or greater than (i.e. ‘not equal to’) test being false.  Since the test is 
false (and there is not a corresponding ElseIf or Else), control jumps to after the End If, which 
happens to be row #121.  Row #121 is a two part If/Then test that is also false.  It is expected that 
additional, (tabular and graphical) output from rule set operations will be added to future versions of 
HEC-RAS.  For the current version of RAS, the log output may be the best way to track down user 
programming mistakes.  Rule operations that are valid (as far as RAS is concerned), but do not 
produce the result desired by the user.  For instance, a Get operation that references the wrong cross 
section node.
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Figure 14‑84. Detailed log output

Simulation and Operational Variables. 

The following is a list of the currently available simulation output variables and operational variables 
that can be set.

Time variables

Julian Day:  Days since December 31, 1899 (e.g. 01Jan2000 = 36525).

Year:  Year (e.g. 2006).

Month: Month of the year (e.g. August = 8).

Day of Year:  e.g. Jan 1 = 1. Feb. 1 = 32.  Dec 31 is 365 (non-leap year).

Day of Water Year:  e.g. Oct 1 = 1.  Sept 30 = 365 (non-leap year).

Day of Month:  e.g. 22Jan2000 = 22.

Day of Week:  Integer day starting on Sunday. e.g. Sunday = 1, Monday = 2, Saturday = 7.

Hour of Day:  Integer hours since midnight (e.g.  01Jan2000 1245 = 12).

Minute of Hour:  Integer minutes after hour (e.g.  01Jan2000 1245 = 45).

Second of Minute:  Integer seconds after minute (e.g.  01Jan2000 1245:15 = 15).

Hour of Day (fractional):  (fractional) Hours since midnight (e.g.  01Jan2000 1245 = 12.75).

Hour of Simulation:  (fractional) Hours since simulation started.

Solution variables

Time Step:  Length of current time step in hours.

Iteration Number:  Number of iterations, for given time step (“current time step” will not have 
relevance until rules are allowed for every iteration, see above, but “previous time step” will return 
the number of iterations from the last time step).
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WS Error Max:  Maximum error, for given time step, in computed water surface at any cross section 
(“current time step” will not have relevance until iterations are allowed, see above, but “previous 
time step” will return the maximum error from the last time step).

Flow Error Max:  Maximum error, for given time step, in computed flow at any cross section (previous 
time step only).

WS SA Error Max:  Maximum error, for given time step, in computed water surface at any storage area 
(previous time step only).

Cross Sections variables

WS Elevation:  Water surface.

Flow:  Flow.

WS Change:  Change in water surface, for given time step (previous time step only).

Flow Change:  Change in flow, for given time step (previous time step only).

WS Error:  Error in water surface, for given time step (previous time step only).

Flow Error:  Error in flow, for given time step (previous time step only).

Bed Change:  The change in elevation of the thalweg (only applicable for Unsteady Sediment 
simulations).

Sediment Concentration:  The concentration of sediment leaving the cross section (only applicable 
for Unsteady Sediment simulations).

Inline Structures, Lateral Structures, and Storage Area Connections variables:

Structure - Total Flow:  Total flow for the inline structure.

Structure - Total Flow (Fixed):  Force the given flow for the inline structure.

Structure - Total Flow (Desired):  Compute gate settings to provide the total given flow for the inline 
structure.

Structure - Flow Additional:  Add in the additional given flow to the inline structure.

Structure - Flow Maximum:  Set a maximum flow for the inline structure.

Structure - Flow Minimum:  Set a minimum flow for the inline structure.

Structure - Total Gate Flow:  Flow for all of the gate groups.

Structure - Total Gate Flow Maximum:  Set a maximum flow for all of the gate groups.

Structure - Total Gate Flow Minimum:  Set a minimum flow for all of the gate groups.

Structure - Stage (Fixed):  Sets the given stage.  Computes the flow through the inline structure that 
is required to produce the given stage.

Weir - Flow:  Flow over the weir.

Weir - Flow Maximum:  Set a maximum flow over the weir.
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Weir - Flow Minimum:  Set a minimum flow over the weir.

Weir - Weir Coefficient:  Weir coefficient for the weir.

Weir - Minimum Elev for Weir Flow:  Minimum weir elevation for flow for the weir (water surfaces 
below this elevation will not produce weir flow).

Weir - C Simple (Positive):  Linear routing coefficient for positive flow (linear routing weirs only).

Weir - C Simple (Negative):  Linear routing coefficient for negative flow (linear routing weirs only).

Weir - Submergence:  Fractional submergence for the given weir (e.g. 0.97).

Gate - Flow:  Flow through the gate group.

Gate - Flow (Fixed):  Force the given flow for the gate group.

Gate - Flow (Desired):  Compute gate setting to provide the given flow for the gate group.

Gate - Flow Maximum:  Set a maximum flow through the gate group.

Gate - Flow Minimum:  Set a minimum flow through the gate group.

Gate - Opening:  The [current] gate opening height for the gate group.

Gate – Opening (target position):  Gate target opening height set by user/rule.  If the user has 
specified a new gate opening (by using the rules), but this gate opening has not yet been reached 
because of constraints in how fast the gate can open or close, then this variable will be the new, 
target opening.  If no target position has been specified, then this variable will be the current gate 
opening height.

Gate - Submergence:  (fractional) Gate submergence for the gate group (e.g. 0.88).

Gate - Opening Rate:  Gate opening rate for the gate group.

Gate - Closing Rate:  Gate closing rate for the gate group.

Lake Superior (Plan 1977A):  This get simulation value will determine the nominal monthly outflow 
for Lake Superior as specified by the Plan 1977A regulations.  This computation is based on the value 
of user defined variables that must be in a specific order.  The first twelve rule operations (excluding 
comment lines) must be defined in the order show in figure 14-41.

Storage Areas variables

WS Elevation:  Water surface elevation for the given storage area.

Net Inflow:  Net inflow for the given storage area (e.g. Total Inflow - Total Outflow).

Total Inflow:  Total inflow for the given storage area (gross inflow, ignores outflow).

Total Outflow:  Total outflow for the given storage area (gross outflow, ignores inflow).

Area:  Current surface area of storage area.

Volume:  Current volume of storage area.
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Pump Stations variables:

Station – Pump Flow:  Total pump flow for the pump station.

Station – Pump Flow (transition complete):  What the total pump flow would be (at current heads) 
when all pumps have finished ramping on or ramping off.  If there are no pumps that are currently 
ramping on or off, then this variable will equal Station – Pump Flow.

Station – Pump Flow Maximum:  Set a maximum flow for the pumping station.

Station – Pump Flow Minimum:  Set a minimum flow for the pumping station.

Station – Turn All Pumps On:  Starts turning all the pumps on.

Station – Turn All Pumps Off:  Starts turning all the pumps off.

Station – WSEL Inlet:  Water surface at pump inlet.

Station – WSEL Outlet:  Water surface at pump outlet.

Station – WSEL Reference:  Water surface at the reference node (as defined on the Geometry Pump 
Station Data editor).

Group – Pump Flow:  Total pump flow for the pump group.

Group – Pump Flow (transition complete):  What the total pump flow would be (at current heads) 
when all pumps in this group have finished ramping on or ramping off.  If there are no pumps that 
are currently ramping on or off, then this variable will equal Group – Pump Flow.

Group – Pump Flow Maximum:  Set a maximum flow for the pump group.

Group – Startup Time:  Sets the time to ramp on the pumps in this group.

Group – Shutdown Time:  Sets the time to ramp off the pumps in this group.

Group – Flow Factor:  Sets a multiplier for the pump flow in this group.

Group – Head Maximum:  Sets a maximum head this group will pump against.

Group – Head Minimum:  Sets a minimum head this group will pump against.

Group – Additional Head:  Sets an additional head this group will pump against.

Group – Turn All Pumps On:  Starts turning all the pumps in this group on.

Group – Turn All Pumps Off:  Starts turning all the pumps in this group off.

Group – Number of Pumps On:  The number of pumps in this group that are on.  Any pumps in the 
process of ramping off will not be included.

Pumps On (fraction):  A decimal fraction that represent whether this pump is on or off or 
transitioning.  This value is 0.0 when the pump is fully off, it is 1.0 when fully on, and it is a fraction 
between  0.0 and 1.0 when it is ramping on or off.

Pump – Flow:  Pump flow.
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Pump – Flow (transition complete):  What the pump flow would be (at current heads) when this 
pump has finished ramping on or ramping off.  If the pump is not currently ramping on or off, then 
this variable will equal Pump – Flow.

Pump – Flow Maximum:  Set a maximum flow for the pump.

Pump – Flow Minimum:  Set a minimum flow for the pump.

Turn Pump On:  Starts turning the pump on.

Turn Pump Off:  Starts turning the pump off.

Reactivate WSEL On and WSEL Off mode:  This will make the WSEL On and Off mode activate for this 
pump.

WSEL On:  Sets the water surface elevation to turn this pump on (when the WSEL On and Off mode is 
active for this pump).

WSEL Off:  Sets the water surface elevation to turn this pump off (when the WSEL On and Off mode is 
active for this pump).

Automated Calibration of Manning’s n Values for Unsteady Flow
In order to assist engineers in the calibration of unsteady flow models, we have added an automated 
Manning's n value calibration feature. This Option requires observed stage time series data (flow 
time series is optional) in order to be used. Manning's n values are calibrated on a reach basis. One or 
more reaches can be calibrated within the same run. Hydrographs are broken into flow zones from 
low to high in order to allow Manning's n values to vary with flow rate. The results from using this 
feature are a set of flow versus roughness factors for each reach that it is applied too.

This automated calibration feature can be applied in either a "Global" or "Sequential" optimization 
mode. The "Global" mode optimizes Manning's n values for all reaches at the same time. While the 
"Sequential" mode optimizes Manning's n values for one reach at a time, working from upstream to 
downstream. Manning's n values are optimized (adjusted) for each flow zone until the maximum 
flow zone error is less than a user entered tolerance, or until a maximum number of iterations is 
reached.

To better understand how this works; let's look at the optimization procedure for a single reach, as 
shown in Figure 14-85. 
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Figure 14 85. Single Reach Example

For the single reach example shown in Figure 14-85 above, there is a flow hydrograph introduced as 
the upstream boundary condition and a rating curve used as the downstream boundary for the 
reach. An observed stage hydrograph is attached to the model at the most upstream cross section 
(labeled as location A). Location A is where the software will compare the computed stages to the 
observed stages, in order to make decisions on how to change the Manning's n values for the reach. 
The user must set up a flow versus roughness factor table for the reach to be calibrated (optimized). 
For this example, let's assume we will have the entire reach set up as a single flow versus roughness 
factor reach. The user will enter flows versus roughness values into a table. The hydrograph is 
broken into flow zones from low to high in order to allow Manning's n values to vary with flow rate 
(Figure 14-86). The number of flow values entered in the flow versus roughness factor table will 
dictate how the hydrograph is broken up into flow zones for that reach. The roughness factors can be 
entered simply as values of 1.0 to start out, which assumes no change to the base Manning's n 
values. The optimization process will adjust the flow roughness factors for each flow zone in order to 
improve the model calibration. 
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Figure 14 86. Flow Zones Versus Manning's roughness factors. 

As shown in Figure 14-86, the hydrograph for this example is broken into 6 flow zones (this is 
controlled by the user). The software first runs the entire analysis just using the base Manning's n 
values (those entered by the user in the Geometric data editor). Then the computed versus observed 
stages are compared for each flow zone (Figure 14-87). The model adjusts roughness for each flow 
zone depending on the magnitude and direction of the error in that flow zone. The product of the 
optimization run is a set of Flow versus roughness factors that best fits the observed data given the 
information provided. 
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Figure 14 87. Computed and observed stages broken into flow zones for comparison. 

Using the Automated Calibration Feature
To use this feature, users must first enter an initial set of Manning's n values for all of the cross 
sections in the model. The initial set of Manning's n values should be a reasonable estimate of the 
main channel and overbank areas based on land use, Ariel photography, and knowledge of the river 
in general.

The second step in using the automated Manning's n value option is to break up the river system into 
logical calibration reaches in which a set of flow versus roughness values can be applied. Flow versus 
roughness factors can be applied to an entire river reach, or multiple flow versus roughness factor 
sets can be set up within a single river reach. However, each flow versus roughness factor calibration 
reach will need to be assigned an observed stage hydrograph in order for the automated procedure 
to perform a comparison of computed versus observed values. An example of how one could break 
up a river system for this purpose is shown in Figure 14-88.
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Figure 14 88. Example Calibration Reach Layout.

As shown in Figure 14-88, each calibration reach must have an observed hydrograph location to 
compare against. It is not an absolute requirement that the observed hydrograph be at the very 
upstream end of each calibration reach, but it generally makes sense to do it that way, as Manning's 
n value changes that occur downstream will affect water surface elevation upstream. However, the 
observed hydrograph locations can be anywhere (even outside of that particular calibration reach), 
as long as the roughness changes that occur within the calibration reach will directly impact the 
computed water surface elevations at the observed hydrograph location.
The next step in performing the automated Manning's n value calibration is to set up a Flow Versus 
Roughness table for each calibration reach (Figure 14-89). The initial values entered, will be a 
placeholder for the automated routine to start from. In general, users should enter a range of flows 
that encompass the entire range of flows that will be experienced for the river system. However, the 
initial roughness factors can all be set to 1.0 (which means no change from the base Manning's n 
values). To get to the Flow Versus Roughness Factor Editor, the user can select it from the Geometric 
Data Editor under "Tools", then "Flow Roughness Factors". Flow versus roughness factors can also 
be set up as part of the Plan file by selecting the "Options" menu from the Unsteady Flow Analysis 
window, then selecting "Flow Roughness Factors". Shown below is the Flow versus roughness editor, 
with a starting set of factors of 1.0.
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Figure 14 89. Flow versus Roughness Factor Editor. 

The next required step to using the Automated Unsteady Flow Manning's n value calibration option 
is to enter observed stage hydrographs into the Unsteady Flow Data editor (Figure 14-90). Observed 
stage hydrographs must be assigned to each calibration reach in order to use this automated 
calibration feature. All observed stage data must be contained within an HEC DSS file and attached 
to specific cross section location from within the Unsteady Flow Data editor. To attach observed time 
series data to cross section locations, bring up the Unsteady Flow Data editor and select "Options", 
then "Observed (Measured) Data, then "Time Series in DSS". The following window will then appear: 
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Figure 14 90. Observed Time Series Data Editor 

To learn more about how to assign observed time series data to cross section locations, review 
Chapter 7 of this manual, and the section on Unsteady Flow Data Options.
Once the user has set up flow versus roughness tables (With place holder factors of 1.0), and 
attached observed stage time series to cross sections, then the Automated Manning's n Value tool 
can be used. To use this feature select the "Options" menus from the Unsteady Flow Analysis 
window, then select "Automated Roughness Calibration". The following window will appear: 
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Figure 14 91. Automated Manning's n Value Editor for Unsteady Flow Analyses. 

A shown in Figure 14-91, the Automated Manning's n Value calibration editor has three areas for data 
entry. These areas are labeled: Calibration Parameters; Calibration Regions; and Forcing Internal 
Observed Flows and Stages.

Calibration Parameters

The top area, called "Calibration Parameters" is required to use this tool. This is where the main 
information is entered to control the optimization feature. The following information is entered in 
this part of the editor:

Error Evaluation Method. There are two options for the error evaluation method: Average Error 
(default) and Squared Error. The error is computed separately for each flow band (ranges of flow 
rates) within the hydrograph. The Average Error is computed by taking the sum of the difference 
between the computed and observed water surface elevations (for all points within the optimization 
time window), and then dividing by the number of points. The Average Error equation is as follows:
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The squared error method is computed by taking the sum of the computed minus the observed 
water surface elevations, squaring that value, dividing by the number of points, then taking the 
square root. The sign of the error (positive or negative) is kept track of separately in order to decide if 
the n values should be increased or decreased. The use of the Squared Error method will put more 
weight on the points that have larger differences. The Squared Error equation is as follows:

Optimization Method. There are two optimization methods available within the HEC-RAS Unsteady 
Flow Roughness Calibration methodology: Global (this is the default); and Sequential. 
The Global method optimizes all calibration reaches simultaneously. Manning's n values are 
modified for all of the calibration reaches by adjusting the flow versus roughness values for each 
flow band. A full unsteady flow simulation is performed for the entire model for each iteration. The 
optimization process continues until either the convergence criteria is met or the maximum number 
of iterations is reached. This method is the preferred method. This is due to the fact that 
downstream stage changes will affect upstream stages, and upstream flow routing is affected by 
changes in roughness. So a simultaneous optimization of all reaches will often produce better results 
for the Manning's n values.

The Sequential method optimizes calibration reaches one at a time from upstream to downstream. 
This method requires more observed data, in that the user must have an observed stage hydrograph 
at the downstream end of each calibration reach to be used as a downstream boundary condition. 
This is in addition to the observed stage at the upstream end, which is used for comparing observed 
and computed stages (see Figure 14-92). A computed or an observed flow can be used at the 
upstream boundary condition for each reach. The optimization is performed in its entirety for a 
single upstream reach, then the 2nd and subsequent reaches are optimized separately, until all 
reaches are optimized. While this process does a good job at isolating each reach from any 
downstream influences/errors (this is due to using the observed stage hydrograph as a downstream 
boundary for each reach), the method takes much more compute time, and can end up with sets of 
flow versus roughness factors that do not work as well once they are used in a normal simulation 
mode, without forcing all the stages in the middle of the system. 
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Figure 14 92. Decomposition of Reaches for the Sequential Optimization Method

Maximum Number of Iterations. This field is used to set the maximum number of iterations that the 
optimization process will try in order to adjust the roughness factors to the optimal values. The 
default value is 10 iterations, however the user can enter anywhere from 1 to 100. For each 
optimization iteration, the model is run for the entire time window, before evaluating the model 
error and adjusting the roughness factors. So for example, if a single model run takes 5 minutes, then 
10 iterations will take 50 minutes.

Maximum Change in Factor per iteration (Optional). This field is used to enter a maximum 
amount that any roughness factor can change from one iteration to the next. While this field is 
optional, it can be very useful in ensuring that the optimization method does not make too large of a 
change at any one location between iterations.

Error evaluation tolerance. This field is used to enter the tolerance that is used to compare against 
the computed error for each flow band. The optimization process will continue until either the 
maximum flow band error (Average error or squared error) is less than the user entered tolerance in 
this field, or the maximum number of iterations is reached. If computed water surface elevations are 
in feet, then this tolerance is in feet. If computed water surface elevations are in meters, then this 
tolerance is in meters.

Limits to flow roughness factors (Maximum Factor and Minimum Factor). These fields are used 
to enter maximum and minimum values for the flow roughness factors. In other words, during the 
optimization no flow factor will be allowed to go above the "Maximum Factor", and no roughness 
factor will be allowed to go below the "Minimum Factor".

Optional specified optimization time window. This area is used to enter a starting data and time, 
and an ending data and time for evaluating the computed versus observed data. This does not 
change the actual computation window. It only changes the time window in which computed versus 
observed flows will be compared for computing the model error and evaluating changes in 
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roughness factors. This is very useful for windowing in around the main hydrograph, such that the 
error in computed versus observed data is only evaluated in the important region of the event, and 
not during times of insignificant results. Very often in unsteady flow modeling, the very beginning of 
the simulation can be off by quite a bit due to bad starting conditions. So not including this 
beginning model warm-up period can often produce better optimization results.

Calibration Regions

The second area, labeled "Calibration Regions" displays all of the locations in which flow versus 
roughness tables have been set up on a reach basis (see Figure 14-91). These are the regions (user 
define flow versus roughness reaches) in which the calibration option can be applied to. The user can 
turn on any one region, combinations of regions, or all of the regions, by checking the Calibrate
column for that region. Additionally, this table is used to assign an observed gage location (Observed 
stage data) to a calibration region. Note: Assigning an observed stage hydrograph to each 
calibration region (calibration reach) is required in order to perform the optimization process.

Forcing Internal Observed Flows and Stages

The third area of the editor, labeled "Forced Internal Observed Flows" and "Forced Internal 
Observed Stages" is only used if the Sequential optimization method is being applied (Figure 14-91). 
If the "Sequential" Optimization method is turned on, then the user must turn on the options to 
"Force Internal Observed Stages" at the downstream end of every Calibration Region (calibration 
reach). See the example in Figure 14-92, that shows how a model would be broken into reaches when 
the "Sequential" optimization method is used. The table labeled "Forcing Internal Observed Flows" 
is an optional input. This is an optional method, and it requires observed flow time series in addition 
to the observed stage time series.

For more information on how to use the automated roughness calibration feature for unsteady flow 
modeling, please see example 24 in the HEC-RAS Applications Guide. 

Flow Hydrograph Optimization
Flow Hydrograph Optimization in HEC-RAS is an automated tool that allows the user to specify a 
Reference Location for the model to monitor either Stage or Flow and perform adjustment to the 
inflow hydrographs to hit a Target Value specified by the user.  This option may to be used to identify 
flow requirements by scaling a predefined hydrograph (or set of hydrographs) by a specified Flow 
Ratio for flows coming into a reservoir or in a river at a levee location in order to bring the stage up 
to a specific height (to breach a structure or keep water from over-topping).

The Flow Hydrograph Optimization procedure is available for both 1D and 2D unsteady flow models. 
In order to successfully use the capability, you must have a stable unsteady flow model that has 
been tested for the range of flows the model may need to run.  As the complexity of the model 
increases with things such as over-topping high ground, spillage into the floodplain, gates adjusting, 
etc. the successful completion flow hydrograph optimization will decrease.

The application of the Flow Ratio is applied to the the entire flow hydrograph including if the 
hydrograph Multiplier is specified.
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•
•

Data Entry
The Flow Hydrograph Optimization capability is accessible from the Unsteady Flow Analysis window 
from the Options | Automated Flow Optimization menu item.  The Automated Flow Ratio 
Optimization window (shown below) is available for both 1D and 2D Unsteady Flow simulations.  In 
order to used the hydrograph optimization tools, you must first create a Reference Location for the 
Geometry of interest (this can be done in RAS Mapper or the Geometric Data Editor).  A Reference 
Point can be used to specify a reference stage, while a Reference Line is used to specify a reference 
flow.

Once a Flow Optimization Mode is specified (Stage or Flow), the user will specify the Reference 
Location (previously created), and the Target Value (Stage or Flow).  There are various optimization 
parameters; however, the you must specify an Initial Flow Ratio for the first Trial.

Parameter Description

Flow Optimization Mode Specifies which flow optimization mode to use (None, Flow, Stage). Choose None to 
turn off optimization.

Reference Location Reference location to optimize. The user then selects a reference location that was 
previously created.

Reference Point is used for Stage optimization
Reference Line is used for Flow optimization.

Target Value The value to optimize to. 
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•

•

Parameter Description

Tolerance The tolerance for optimization to the Target Value.

Initial Flow Ratio Flow ratio to use for the 1st Trail. (A value of 1.0 would use the existing flow data a 
specified)

Minimum Flow Ratio Minimum value the optimization will attempt to use during a Trial.

Maximum Flow Ratio Maximum value the optimization will attempt to use during a Trial.

Maximum number of Trials Maximum number of Trials to be used to attempt to satisfy the Target Value.

Flow Hydrographs to Scale A specification of which flow hydrographs will be adjusted to the optimization 
trials.

Restart Approach The restart approach is used to satisfy the initial conditions of the unsteady flow 
simulation.

Re-use Initial Conditions (Default) - this method uses the initial conditions from 
the un-modified flow hydrographs and will transition to the hydrograph of the 
current trial during the Transition Period.  This method is intended to provide 
model stability by using initial conditions that were specified by the user.
Recompute Each Trial - this method will use the new, scaled hydrograph to 
establish initial conditions.

Transition Period This is the time period (in hours) used to transition from the initial conditions (from 
the base hydrograph) to the scaled hydrograph.

Optimization Procedure
Once optimization information has been entered, the Unsteady Flow Analysis window will indicate 
Automated Flow Ratio Optimization will be utilized (at the bottom of the window) during the 
simulation.
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The first Trial simulation will run using the Initial Flow Ratio to scale the base hydrograph.  (If you 
aren't sure how the model will perform, you could use a value of 1.0; however, you may already know 
which way you should scale the hydrograph to achieve the desired results.)  After the first Trial, the 
Computed result (stage or flow) will be compared with the desired Target value and reported with 
the runtime messaging.  

Based on the Difference (Computed - Target), the flow optimization will vary the Flow Ratio and re-
run the next Trial simulation.

During simulation, the runtime messages will inform the user that Flow Optimization has been 
turned on and echo the Target value and Reference Location.  As the Trials progress, the user is 
informed of progress and the final, optimized Hydrograph Ratio will be written to the messages.

If the Hydrograph Flow Optimization is not able to converge with the given optimization parameters 
(Min Flow Ratio, Max Flow Ratio, or Number of Trials), the user will be informed of the failed 
convergence.

Depending on model complexity and model stability, there is a possibility that the unsteady flow 
simulation will iterate (more than expected) and may even go unstable.  If the simulation goes 
unstable, RAS will stop running new Trials.

Viewing Results
All of the normal plots and maps are available for data analysis for evaluating the floodplain water 
surface elevations, depths and velocities.  A Flow Optimization layer is added to the results group 
for the identified plan under the Plan node.  This will allow a user to visualize the Reference 
Location used and the Boundary Conditions of the model.  The boundary conditions used for the 
hydrograph optimization will be highlighted with the highlight color.  (Note, the Flow Optimization 
layer is an aggregate of multiple layers and will use the base symbology for each layer.)
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Flow Hydrograph Optimization results are available by right clicking on the Plan name and choosing 
View Flow Optimization Plot, shown below.  The Flow Optimization Plot will indicate the desired 
Target value and the Flow Ratio used for each Trial.
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15 MODEL COMPARISON TOOL
The Model Comparison Tool in HEC-RAS in intended to allow users to evaluate the components of an 
HEC-RAS project to identify differences in the primary modeling objects.  The purpose of the 
comparison tools is to assist the user to identify subtle differences between HEC-RAS plans.  If the 
model differences are significant and excessive  Differences in the project files, geometry, flow, and 
results can be visualized through tables and spatial plots.  The focus of the Model Comparison tools 
are for unsteady-flow models (comparison capabilities for steady-flow models is not as robust as for 
unsteady models).

When comparing datasets, the Model Comparison tool can compare data using the geometry file or 
the plan file (which will have Flow, Geometry, and may include Results).

Project
Access to the Model Comparison tools is available from the File | Compare Model Data menu item.  
The tool is primarily intended to compare data within a single project; however, you can compare 
data from multiple projects.  Show in the figure below is the Project summary.  Each project will be 
listed by name with the unit system.

The Project tab shows a diagram view of the HEC-RAS project with components represented by an 
element box.  The Contents List on the left side of the window will indicate what data was used in the 
project and allow you to turn on those data layers available.  The Flow, Plan/Result, and Geometry 
data will always be available.  If the project contains Terrain, Landcover, Infiltration, or a 
Sediment Bed Material layer they will be available to turn on/off to customize the project view.

This feature is new for HEC-RAS 6.5.

This tool is dependent on datasets stored in the HDF5 file format and, therefore, only works for 
model data in HEC-RAS 6.  To compare geometry from older HEC-RAS models, open the project 
in HEC-RAS 6.0 or newer and save the geometry.  To compare results, the models will need to be 
re-run in the newer version of HEC-RAS.
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For the Flow, Plan/Result, and Geometry the Short ID is listed along with the file extension plan 
number (e.g. .p##). If a Plan has not been run, and therefore a Result does not exist, the Plan/Result 
name will be grayed out (indicating results are not available).

Each layer that is used for a given Plan will be connected by a line trace.  To more clearly identify file 
dependencies, click on an element.  The elements and dependency trace will be highlighted.  An 
example of trace is shown in the figure below.

The Project compare functionality allow for you to compare both Geometry and Plan/Result 
information.

To compare plans or geometries double-click on the element to add it to the comparison list. (You 
can also right-click on the element and choose Add to List.)  As the data are added to the 
comparison list, the element names will be added to the top of the Model Comparison window, as 
shown in the figure below.  If data are different the the tabs for Flow, Plan, Geometry, and Results 
will become active (if the data are not different the tabs will be gray.)

Comparing a Plan will have a link to a Geometry file (which may or may not have been edited 
after a simulation).  However, a Result will have a copy of the Geometry used for the simulation. 
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The data will be added with by name and with colors to identify one piece of data from another.  In 
the example shown above one Plan is Orange, while the other is Blue.  Data visualization will be 
enhanced by these colors throughout the model comparison tabs (Flow, Plan, Geometry, and 
Results).  To change the Name or Color, right-click on the data you are comparing and choose 
Change Alias or Change Color menu item. (You can also access these properties via the Tools | File 
Aliases and Tools | Color Palettes menu items.)

If you wish to change the file names, the Change Alias menu item allows you to change the name that 
is shown throughout the comparison tools.  This is convenient if the previously used name is very 
long or you are new to a project and need to simplify the names.  Provide the "Alias" and hit the OK 
button in the dialog provided.

Multiple Projects
Files from multiple projects can be achieved using the File | Add Project menu item.  Once a second 
project is added Plan/Results and Geometry files can be compared as if they were from the same 
project.  The project is added with the name in the upper left had corner.  To remove the project, 
click the Remove button (X) next to the project name.
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Differences vs All

The Model Comparison Tool is intended to provided users access and identification to differences in 
model data.  However, if you want to see specific data within the construct of all data, choose the 
view All option rather than the default Differences option.  As you navigate through the model data, 
all features associated with the file will be listed.

As you peruse the model data, you will find visual cues (through color and fonts) to assist in 
identifying information.

Visual Cue Description

Black Differences exists for identical features

Bold Differences exists for identical features

Gray No differences for identical features

Color 1 This feature only exists in Dataset 1

Color 2 This feature only exists in Dataset 1

Changing the default colors is available from the Tools | Color Palettes menu item.
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Flow
The Flow tab provides a spatial view of the locations and a table of pertinent flow hydrograph 
information (Location Name, Minimum, Maximum, and Volume information).  The contents list will 
organize data on the left and allow you to identify the features of interest. (Note: Steady Flow data 
are not available to compare.) As shown in the figure below, this model only has one location where 
flow differs.

To highlight a location in the in the map, click on a row in the table.  Conversely, when selecting a 
location in the map, the corresponding row in the table will be highlighted.  For flow data, an the 
Hydrograph icon will allow you to plot a comparison plot showing the hydrographs and the 
difference(see below). Differences are computed based on the reverse order listed at the top of the 
Model Comparison window (second plan minus first plan).
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To see a plot of the difference between hydrographs, turn on the Options | Plot Differences menu 
item.

Plan
Plan information for basic information such as the Geometry and Flow file names and more detailed 
computation parameters are provided through tabular data.  The tables easily allow you identify 
model differences.

In the figure below, basic Plan Information is shown (note that it is all different).
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In the figure below, Plan Parameters are shown with the different calculation parameter shown in 
black/bold text and all others shown in gray.

Geometry
When accessing the Geometry tab, you will first need click the Compute Geometry Differences
button, shown below. 

Geometry data are not automatically computed, as there may be a noticeable delay when 
comparing geometry files.  As the geometry data are compared a progress bar will provide updates.  
Once the data have been compared, the Summary and Detailed tabs will allow you to investigate the 
data.

Summary
The Summary tab is intended to give you a information at a glance (as shown in the figure below) for 
feature layers.  As you select a feature from the contents list in the left pane, the upper panels with 
indicate the number of unique, different, and identical (same) features in each Geometry.  Color bars 
quickly show quantity and relationship. The lower panel shows the different attributes and a table of 
features (Differences being the default table).
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The upper portion of the window (shown below) provides a quick feature summary.  For this 
example, one file has 3 Unique features, the other file has 4 Unique features, and the geometry 
shares 5 Features that have the same name but are different and 53 features that are identical.  The 
color bar is able to provide a visual summary by color.

The feature differences are identified by the Differences attribute list (shown below).

If you wish to sort the table by attribute difference, select the attribute element. For instance, you 
want to see which cross sections have difference n values, select the Manning Data attribute 
element. As shown below, the list of cross sections is filtered to just the cross section having different 
n values.  The data can then be plotted either in a table or a plot, depending on the datatype.  If the 
data are tabular data (such as Ineffective Flow Areas, Blocked Obstructions, Manning's n values) a 
table button will allow you to tabulate the data differences in a side pane.
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If the data can be shown through a plot (such a cross section profile) a plot button will invoke a 
separate plotting window.  The plot will color code the profile and show a difference in elevation 
values in the upper portion of the window.

To see a plot of the difference between profiles, turn on the Options | Plot Differences menu item.

Detailed
The Detailed tab provides an integrated spatial mapping of data along with tabular data.  Similar to 
how you interact with RAS Mapper, there is a toolbar with Select, Pan, Zoom, and Zoom to Layer 
Extent buttons.  Features can be displayed with or without a background layers by clicking on the 
Layers button and selecting from available layers (the Check button will allow for toggling on/off the 
background layers).  A layer list will allow you to select background layers and set their symbology 
similar to RAS Mapper.  Colors are used to indicate model differences in the mapping window and 
bold values in the the table indicate differences in table values (this is also true for plot functions 
where Bold icons have different data and gray icons do not.)

As shown in figure below, Cross Section features shown in Black are the same cross section but have 
an attribute difference, Gray cross sections are identical, Blue cross sections are in Geometry 1, and 
Orange cross sections are in Geometry 2.
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Cross Sections

The Cross Section layer is a good example of feature layer.  Each feature has a geospatial location, 
but is identified by it's River, Reach, and River Station.  Each cross section feature can also be 
described by the attributes associated with it such as reach lengths and profile information.

Features can be selected in either the table or the map and are linked so that the selection in one 
place highlights the feature in the other.  As shown in the figure below, the selected feature is shown 
in Magenta when selected in the map or the table. (To select a feature in the map, the Select Tool 
must be active.)
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Icons will be provide for each attribute on the feature in the attribute table visualize data.  Tabular 
data will be shown in a panel to the right, while plotted data will invoke it's own plotting window.  
Manning's n value data plotted for the selected cross section in the figure below.

If you want to work through the table one feature at a time, you can choose the Zoom to Selected
feature option and the map window will recenter to show the feature.

The Feature Table allows for copying contents to the clipboard by right-clicking on the header and 
choosing Copy All.

2D Flow Areas

2D Flow Areas are unique in that they are described by both features (perimeters, breaklines, etc) 
that are easy to quantify and by an intricate layout of grid cells which is difficult to quantify.  
Differences in simple features can be easily identified through comparison and plotting.  Below is an 
example color coded plot of of the 2D Flow Area cells.  This can be done for Perimeters, Computation 
Points, Breaklines, and Refinement Regions.
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For a more intricate plot of how cell size differs, the Model Comparison tool has a Cell Density plot.  
As shown in the figure below, the Cell Density plot will colorize the plot based on the relative density 
of 2D cell area.  For the example below, Blue areas are where Geometry #1 cells are more 
dense, Gray is where there is no difference, and Orange is where Geometry #2 cells are more dense.  
The legend is fully customizable, if the default color ramp does not meet your needs.  A tool tip is 
provided at the location of the cursor for more information.

Results
If you are comparing a Plan with Results, the Result tab will be available.  At this time, the spatial 
results can be evaluated for differences in Inundation extent, Water Surface Elevation, Velocity, and 
Depth. Hydrograph results are also available, however, you will need to press the Compute 
Hydrograph Differences button.
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The list of hydrographs mined from the output file will be available in the features list.

You can click on the Hydrograph icon in the map (with the Select tool ) or the in the table to 
plot the time series.



Model Comparison Tool

HEC-RAS User's Manual– 743

Selecting one of the outputs from the contents list will show the difference in computed results.  A 
difference layer will be computed and shown in the map window, as shown in the figure below. A 
label is provided at the top of the map window to indicate the order of layer operations (2nd Result 
minus 1st Result).  Note that the default Legend is very specific.  The Legend is a blend of colors from 
the 2 results in comparison.  For the example shown below, the Legend goes from Blue (Result #1) 
to Gray (No Difference) to Orange (Result #2).  This quickly indicates which hydraulic results has a 
higher value - orange is higher in Result #1, blue is higher in Result #2.  The legend/color are fully 
user-customizable (just as if you were in RAS Mapper).  The cursor tool tip will update with value that 
is the difference in surface values.
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17 HEC-RAS DATA EXCHANGE
At Version 2.0, HEC-RAS introduced a geospatial component to the geometry for the description of 
river networks and cross sections. This capability makes it possible to import channel geometry from 
CADD or GIS programs though automated data extraction procedures. Similarly, water surface 
elevations and other HEC-RAS results can be exported to CADD and GIS where they can be used to 
created model water surfaces for inundation mapping.
The spatial data the HEC-RAS can import and export are evolving - each new version of the software 
results in additional capabilities. HEC-RAS Version 3.1.3 will import and export data using in a spatial 
data format in an ASCII text file. 
Data import options include:

The structure of the river network, as represented by a series of interconnected reaches.
The location and geometric description of cross sections for elevation data, bank positions, downstream 
reach lengths, Manning's n values data, levee positions and elevations (limited to one per bank), ineffective 
flow area positions and elevations.
Bridge deck information for top-of-weir profile, deck width, and distance to the upstream cross section.
Lateral and inline structure information top-of-weir profile, deck width, and distance to the upstream cross 
section for inline structures.
Storage area elevation-volume information.

Data export options include:

Cross section locations and elevation data.
Water surface elevations at each cross section.
Bounding polygon information for each water surface profile.
Cross-sectional properties.

Spatial Data Format
HEC-RAS Version 3.1.3 will import and export data using a formatted ASCII text file. In general, the 
spatial data format consists of records, keywords and values. This section provides the general rules 
for constructing the and HEC-RAS import and export file. 

This file format is evolving in that additional data types will be added and existing one may be 
modified for future versions. If you are writing software to read and write to the HEC-RAS 
spatial data format, keep in mind that you may need to modify your software to remain 
compatible with future versions of HEC-RAS.

Records
The spatial data format is composed of records, which are composed of keywords and values. All 
records must begin with a keyword. A record can also contain a value or a set of values following the 
keyword. Spaces, tabs, or line ends can be used as delimiters within a record.

A record that contains a keyword and no value marks the beginning or end of a group of related 
records. For example, the record "BEGIN HEADER:" MARKS the beginning of the header section of the 
file. A record that contains a keyword and a value assigns that value to the part of the model being 
named by the keyword.
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Keywords
Keywords are used to identify that values unique to the part of the model being named by the 
keyword will follow. Keywords must end with a colon separating the keyword and the values. All 
keywords will have the spaces removed up to the colon and the letters capitalized. The keywords 
"Begin Header:", "Begin header:", and "Be GiNH eadEr:" are all equivalent. For readability, keywords 
named in this document will contain internal spaces.

Values
A record can assign a single value to a single variable or multiple values in an array. Values can be 
integers, floating point numbers, text strings, or locations (X, Y, Z, label). A single value in an array of 
values is called an "element" of that array.

A numerical value cannot contain internal blanks. A floating point number can contain a decimal 
point; an integer cannot. Elements in an array can be separated by commas, blanks, tabs, or line 
ends.

A text string can contain internal blanks, tabs, and commas, but cannot contain internal line ends.

A location consists of three coordinate values and a label (X, Y, Z, label). The first two coordinates are 
planar and the third is elevation. The coordinate values are floating point numbers and the label can 
by any type of value. In certain contexts, the elevation value or the label may not be required. If a 
label is used, all three coordinate values must be given; the value of "NULL" is valid for the elevation 
coordinate only. The coordinate values and the label can be separated by commas, blanks, or tabs, 
but a location cannot contain internal line ends.

Data Groups
Records in the data file can be collected in two types of groups: objects and file sections. An object is 
a group of records that combine to describe an entity within the model – a cross section, for 
example. A file section is a logical or functional grouping of data. The file header, for example, is a 
section that contains a description of the entire file.

Objects and file sections begin and end with records that contain keywords but no values. A file 
section starts with a record containing the a keyword composed of the word "BEGIN" followed by 
the section name and a colon and ends with a keyword composed of the word "END" followed by the 
section name and a colon. For example, records containing only the keywords "BEGIN HEADER:" and 
"END HEADER:" are used to start and end the header section of a file. An object starts with a record 
containing a keyword naming an object type and "END:" only. For example, a cross-section object 
begins and ends with records containing the keywords "CROSS-SECTION:" and "END:" only.

Comments
Hash characters (#) are used to identify comments. When a hash character is encountered in the file 
all data from the hash to the next line end is ignored. A line that begins with a hash is equivalent to a 
blank line.
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Spatial Data Format
HEC-RAS Version 3.1.3 will import and export data using a formatted ASCII text file. In general, the 
spatial data format consists of records, keywords and values. This section provides the general rules 
for constructing the and HEC-RAS import and export file. 
This file format is evolving in that additional data types will be added and existing one may be 
modified for future versions. If you are writing software to read and write to the HEC-RAS 
spatial data format, keep in mind that you may need to modify your software to remain 
compatible with future versions of HEC-RAS.

RAS GIS Import File (RASImport.sdf)
HEC-RAS reads channel geometry from a text file composed of several sections. A discussion of the 
sections in the import file is provided. And example RAS GIS import File is provided at the end of this 
appendix.

Header
The header is bounded by the records "BEGIN HEADER:" and "END HEADER:" and should contain a 
record to identify the units system used in the imported data set. The units system can be "US 
CUSTOMARY" or "METRIC". A summary of record that may be used in the Header section are 
provided in Table B-1. 

Table B-1. Header options for the spatial data file.

Keyword Value Type Value

UNITS: String US CUSTOMARY or METRIC

DTM TYPE: String Type of terrain model (TIN or GRID)

DTM: String Name of terrain model

STREAM LAYER: String Name of Stream Centerline layer used in the 
CADD or GIS.

NUMBER OF REACHES: Integer Number of hydraulic reaches in the SDF file.

CROSS-SECTION LAYER: String Name of the Cross-Sectional Cut Lines layer used 
in the CADD or GIS.

NUMBER OF CROSS-SECTIONS: Integer Number of cross sections in the SDF file.

MAP PROJECTION: String Projection (coordinate) system used (e.g. 
Stateplane)

PROJECTION ZONE: String Projection zone (if applicable, e.g. 5101)

DATUM: String Reference datum for planar coordinates.

VERTICAL DATUM: String Reference datum for vertical coordinates.
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BEGIN SPATIAL EXTENT: None None. Begin of Spatial Extents object.

Xmin: Float Minimum easting of geospatial data.

Ymin: Float Minimum northing of geospatial data.

Xmax: Float Maximum easting of geospatial data.

Ymax: Float Maximum northing of geospatial data.

END SPATIAL EXTENT: None None. End of Spatial Extents object.

NUMBER OF PROFILES: Integer Number of profile exported from HEC-RAS. RAS 
GIS Export File only.

PROFILE NAMES: String array Water surface profile names exported from HEC-
RAS. RAS GIS Export File only.

River Network
The river network section is bounded by the records "BEGIN STREAM NETWORK:" and "END STREAM 
NETWORK:" and contains records describing reaches and reach endpoints. At a minimum, the 
stream network section must contain at least two endpoints and one reach.
A reach endpoint is represented by a record containing the keyword "ENDPOINT:" followed by four 
comma-delimited values containing the endpoint's X, Y, Z coordinates and an integer ID. 
A reach consists of a multi-record object that begins with a record containing only the keyword 
"REACH:" and ends with a record only containing the keyword "END:". At a minimum, a reach object 
must contain records setting values for a Stream ID, a Reach ID, a FROM point, and a TO point. A 
reach's FROM and TO point IDs must match IDs for endpoints listed before the reach object in the 
file. The reach object must also contain an array of locations defining the stream centerline. This 
array begins with a record containing only the keyword "CENTERLINE:" and ends when any keyword 
is encountered. A location element in the array contains the X, Y, and Z coordinates of a point on the 
stream centerline, and the point's river station. In HEC-RAS, elevation and stationing are optional in 
the stream network definition. If a location element includes a station value, it must occupy the 
fourth field in the element. If the elevation is not known, the word "NULL" must take its place. 
Stationing is used for indexing locations along reaches, and is not used to precisely locate objects in 
the model. A summary of record that may be used in the River Network section are provided in Table 
B-2. 
Table B-2. River network options for the spatial data file.

Keyword Value Type Value

ENDPOINT: Location X, Y, Z coordinates and integer ID.

REACH: None Marks beginning of Reach object.

END: None Marks end of Reach object.

The following records are required for a 
Reach object.
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Keyword Value Type Value

STREAM ID: String River identifier to include reach.

REACH ID: String Unique ID for reach within river.

FROM POINT: String Integer reference to upstream endpoint.

TO POINT: String Integer reference to downstream 
endpoint.

CENTERLINE: Location array Array elements contain coordinates and 
station values.

Cross Sections0
The cross-sectional data section begins with a record containing the only the keyword "BEGIN 
CROSS-SECTIONS:" and ends with a record containing the only the keyword "END CROSS-
SECTIONS:". A cross section is represented by multi-record object beginning with a record 
containing only the keyword "CROSS-SECTION:" and ending with a record containing only the 
keyword "END:." 
A cross-sectional object must include records identifying the Stream ID, Reach ID, and Station value 
of the cross-section, a 2D cut line, and a series of 3D locations on the cross section. Stationing is 
given in miles for data sets with plane units of feet and in kilometers for data sets with plane units of 
meters. A cut line is composed of the label "CUT LINE:" followed by an array of 2D locations. A cross-
sectional polyline consists of the label "SURFACE LINE:" plus 3D coordinates written as comma-
delimited X, Y, Z real-number triples, one triple to a line. A summary of record that may be used in 
the River Network section are provided in Table B-3. 
Table B-3. Cross-sectional data section options for the spatial data format.

Keyword Value Type Value

CROSS-SECTION: None Marks beginning of Cross Section object.

END: None Marks end of a Cross Section object.

The following records are required for a 
Cross Section object.

STREAM ID: String Identifier for the River on which the cross 
section resides.

REACH ID: String Identifier for the Reach on which the cross 
section resides.

STATION: Float Relative position of the cross section on the 
river reach.

CUT LINE: Location array Array elements contain planar coordinates of 
cross section strike line.
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Keyword Value Type Value

SURFACE LINE: Location array Array elements contain 3D coordinates of cross 
section.

The following records are optional for a 
Cross Section object.

NODE NAME: String Description of cross section.

BANK POSITIONS: Float Fraction of length along cut line where main 
channel bank stations are located.(Left, Right)

REACH LENGTHS: Float Distance along left overbank, main channel 
and right overbank flow paths to next cross 
section downstream.(Left, Channel, Right)

N VALUES: Float Manning's n values expressed as a fraction 
along cut line to start of n value.(fraction, n 
value)

LEVEE POSITIONS: String, Float Levee positions expressed as a fraction along 
cut line to position with elevation.(ID, fraction, 
elevation)

INEFFECTIVE POSITIONS: String, Float Ineffective flow areas expressed as a fraction 
along cut line to beginning and end positions 
with trigger elevation.(ID, begin fraction, end 
fraction, elevation)

BLOCKED POSTITIONS: Float Blocked flow areas expressed as a fraction 
along cut line to beginning and end positions 
with trigger elevation.(ID, begin fraction, end 
fraction, elevation)

WATER ELEVATION: String array Water surface profile names exported from 
HEC-RAS. RAS GIS Export File only.

Additional Cross Section Properties
Geospatial data used for display purposes in HEC-RAS for levees, ineffective flow areas, are blocked 
obstructions are stored outside of the Cross Section block of information. A summary of additional 
cross section properties is summarized in Table B-4. 
Table B-4. Addition cross section properties options for the spatial data file.

Keyword Value Type Value

Levee records

BEGIN LEVEES: None Marks beginning of Levees object.
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Keyword Value Type Value

LEVEE ID: String Levee identifier. Corresponds to ID in LEVEE 
POSITIONS object on cross section.

SURFACE LINE: Location array Array elements contain 3D coordinates of levee 
profile points. Array concludes with END:

END LEVEES: None Marks end of Levees object.

Ineffective flow area records

BEGIN INEFFECTIVE AREAS: None Marks beginning of Ineffective Areas object.

INEFFECTIVE ID: String Ineffective area identifier. Corresponds to ID in 
INEFFECTIVE POSITIONS object on cross section. 
Concludes with an "END:".

POLYGON: Location array Array elements contain 2D coordinates of 
ineffective area polygon points.

END INEFFECTIVE AREAS: None Marks end of Ineffective Areas object.

Blocked obstruction records

BEGIN BLOCKED AREAS: None Marks beginning Blocked Obstructions object.

BLOCKED ID: String Blocked obstructions identifier. Corresponds to ID 
in BLOCKED POSITIONS object on cross section.

POLYGON: Location array Array elements contain 2D coordinates of 
ineffective area polygon points.

END BLOCKED AREAS: None Marks end of Blocked Obstructions object.

Bridge_Culverts
The bridge/culvert data section begins with a record containing the only the keyword "BEGIN 
BRIDGE/CULVERTS:" and ends with a record containing the only the keyword "END BRIDGE/
CULVERTS:". A bridge is represented by multi-record object beginning with a record containing only 
the keyword "BRIDGE/CULVERT:" and ending with a record containing only the keyword "END:." 
Bridges/Culverts have the same required records as the Cross Sections object, but have other 
optional records. A summary of Bridge/Culvert records is provided in Table B-5. 
Table B-5. Bridge/Culvert options in the spatial data format file.

Keyword Value Type Value

BRIDGE/CULVERT: None Marks beginning of Bridge/Culvert object.

END: None Marks end of a Bridge/Culvert object.
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Keyword Value Type Value

The following records are required for a 
Briodge/Culvert object.

STREAM ID: String Identifier for the River on which the 
bridge/culvert resides.

REACH ID: String Identifier for the Reach on which the 
bridge/culvert resides.

STATION: Float Relative position of the bridge on the 
river reach.

CUT LINE: Location array Array elements contain planar 
coordinates of bridge location.

SURFACE LINE: Location array Array elements contain 3D coordinates of 
bridge deck.

The following records are optional (but 
recommend) for a Bridge/Culvert object.

NODE NAME: String Description of cross section.

US DISTANCE: Float Distance to upstream cross section.

TOP WIDTH: Float Top width of bridge deck.

Inline Structures
The inline structures data section begins with a record containing the only the keyword "BEGIN 
INLINE STRUCTURES:" and ends with a record containing the only the keyword "END INLINE 
STRUCTURES:". An inline structure is represented by multi-record object beginning with a record 
containing only the keyword "INLINE STRUCTURES:" and ending with a record containing only the 
keyword "END:." 
Inline structures have the same required records as the Bridge/Culvert object. A summary of Inline 
Structures records is provided in Table B-6. 
Table B-6. Inline structure options in the spatial data format file.

Keyword Value Type Value

INLINE STRUCTURES: None Marks beginning of Inline Structure object.

END: None Marks end of a Inline Structure object.

The following records are required for a 
Inline Structure object.

STREAM ID: String Identifier for the River on which the inline 
structure resides.
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Keyword Value Type Value

REACH ID: String Identifier for the Reach on which the inline 
structure resides.

STATION: Float Relative position of the inline structure on 
the river reach.

CUT LINE: Location array Array elements contain planar coordinates 
of inline structure location.

SURFACE LINE: Location array Array elements contain 3D coordinates of 
inline weir profile.

The following records are optional (but 
recommend) for an Inline Structure object.

NODE NAME: String Description of inline structure.

US DISTANCE: Float Distance to upstream cross section.

TOP WIDTH: Float Top width of inline weir.

Lateral Structures
The inline structures data section begins with a record containing the only the keyword "BEGIN 
LATERAL STRUCTURES:" and ends with a record containing the only the keyword "END INLINE 
STRUCTURES:". A lateral structure is represented by multi-record object beginning with a record 
containing only the keyword "LATERAL STRUCTURES:" and ending with a record containing only the 
keyword "END:." 
Lateral structures have the same required records as the inline structures object. A summary of 
Lateral Structures records is provided in Table B-7. 
Table B-7. Lateral structure options in the spatial data format file.

Keyword Value Type Value

LATERAL STRUCTURES: None Marks beginning of Lateral Structures 
object.

END: None Marks end of Lateral Structures object.

The following records are required for a 
Lateral Structure object.

STREAM ID: String Identifier for the River on which the lateral 
structure resides.

REACH ID: String Identifier for the Reach on which the 
lateral structure resides.
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Keyword Value Type Value

STATION: Float Relative position of the lateral structure on 
the river reach.

CUT LINE: Location array Array elements contain planar coordinates 
of lateral structure location.

SURFACE LINE: Location array Array elements contain 3D coordinates of 
weir profile.

The following records are optional (but 
recommend) for a Lateral Structure object.

NODE NAME: String Description of lateral structure.

US DISTANCE: Float Distance to upstream cross section.

TOP WIDTH: Float Top width of weir.

Storage Areas0
The storage areas data section begins with a record containing the only the keyword "BEGIN 
STORAGE AREAS:" and ends with a record containing the only the keyword "END STORAGE 
STRUCTURES:". The keyword "SA ID:" identifies a storage area object. A summary of Lateral 
Structures records is provided in Table B-8.
Table B-8. Storage area options in the spatial data format file.

Keyword Value Type Value

SA ID: String Storage area identifier.

POLYGON: Location array Array elements contain 2D coordinates of 
storage area boundary. Concludes with an 
"END:"

ELEVATION-VOLUME: Float array Elevation volume information for storage 
area. (Elevation, Volume)Concludes with an 
"END:"

The following records are optional for a 
Storage Area object.

TERRAIN: Float array X,Y,Z coordinates for terrain data within 
storage area. Concludes with an "END:".
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Storage Area Connections
The storage areas data section begins with a record containing the only the keyword "BEGIN SA 
CONNECTIONS:" and ends with a record containing the only the keyword "END SA CONNECTIONS:". 
An inline structure is represented by multi-record object beginning with a record containing only the 
keyword "SA CONNECTION:" and ending with a record containing only the keyword "END:." A 
summary of Storage Area Connection records is provided in Table B-9. 
Table B-9. Storage area connection options in the spatial data format file.

Keyword Value Type Value

SACONNID: String Storage area connection identifier.

USSA: String Identifier of upstream storage area (SA ID).

DSSA: String Identifier of downstream storage area (SA 
ID).

CUT LINE: Location array Array elements contain planar coordinates 
of storage area connection location.

SURFACE LINE: Location array Array elements contain 3D coordinates of 
weir profile.

The following records are optional for a 
Storage Area Connection object.

NODE NAME: String Description of storage area connection.

TOP WIDTH: Float Top width of weir.

RAS GIS Export File (RASExport.sdf)
HEC-RAS exports model results to a text file using the same spatial data format as the data import 
file. The contents of the file, however, are not identical. An example HEC-RAS model export file is 
shown at the end of this appendix. A summary of model elements for data export from HEC-RAS that 
differs from the import file is provided in Table B-10.

Table B-10. HEC-RAS export options in the spatial data format file

Keyword Value Type Value

The following records are required for 
Header section of the RAS GIS Export File

NUMBER OF PROFILES: Integer Number of profile exported from HEC-RAS. 
Required if greater than 1.

PROFILE NAMES: String array Water surface profile names exported from 
HEC-RAS. Required if number of profiles is 
greater than 1.
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Keyword Value Type Value

The following records area required in the 
Cross Section portion of the Export File

WATER ELEVATION: Float array Elevation of water surface at the cross 
section. The array must contain a value for 
each profile.

PROFILE ID: String array Water surface profile name(s). This must 
match the name(s) in the Profile Names 
record.

The following records area optional in the 
Cross Section portion of the Export File

VELOCITIES: Float, paired array Fraction along cut line and value of velocity 
(fraction, value). Velocity records must 
follow Profile ID record.

WATER SURFACE EXTENTS: Location array A series of 2D locations marking the limits 
of a water surface on the cross section.

The following records make up a section 
defining Storage Areas in the Export File

BEGIN STORAGE AREAS: None Marks beginning of Storage Area object.

END STORAGE AREAS: None Marks end Storage Area object.

SA ID: String Storage area identifier.

WATER ELEVATION: Float array Elevation of water surface at the storage 
area. The array must contain a value for 
each profile.

POLYGON: Location array Array elements contain 2D coordinates of 
storage area limits.

POLYGON: Location array Array elements contain 2D coordinates of 
water surface limits. A single profile limit 
can be merged from multiple polygons.

The following records make up a section 
defining Bounding Polygons for the water 
surface limits in the Export File

BEGIN BOUNDARIES: None Marks start of boundaries section.
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Keyword Value Type Value

END BOUNDARIES: None Marks end of boundaries section.

PROFILE LIMITS: None Marks start of an object defining the limits 
of a single water surface profile. Concludes 
with and "END:"

PROFILE ID: String Name of the profile. This must match a 
name in the Profile Names record in the 
header.

POLYGON: Location array Array elements contain 2D coordinates of 
water surface limits. A single profile limit 
can be merged from multiple polygons.

Water Surface Bounding Polygon
In addition to a water surface elevation at each cross section (one for each profile), the HEC-RAS 
program sends a bounding polygon for each hydraulic reach in the model (the program outputs a 
new set of bounding polygons for each profile computed). The bounding polygon is used as an 
additional tool to assist the GIS (or CADD) software to figure out the boundary of the water surface 
on top of the terrain.

In most cases, the bounding polygon will represent the outer limits of the cross section data, and the 
actual intersection of the water surface with the terrain will be inside of the polygon. In this case, the 
GIS software will use the water surface elevations at each cross section and create a surface that 
extends out to the edges of the bounding polygon. That surface is then intersected with the terrain 
data, and the actual water limits are found as the location where the water depth is zero.

However, is some cases, the bounding polygon may not represent the extents of the cross-section 
data. For example, if there are levees represented in the HEC-RAS model, which limit the flow of 
water, then the bounding polygon will only extend out to the levees at each cross section. By doing 
this, when the information is sent to the GIS, the bounding polygon will prevent the GIS system from 
allowing water to show up on both sides of the levees.

In addition to levees, the bounding polygon is also used at hydraulic structures such as bridges, 
culverts, weirs, and spillways. For example, if all of the flow is going under a bridge, the bounding 
polygon is brought into the edges of the bridge opening along the road embankment on the 
upstream side, and then back out to the extent of the cross-section data on the downstream side. By 
doing this, the GIS will be able to show the contraction and expansion of the flow through the 
hydraulic structures, even if the hydraulic structures are not geometrically represented in the GIS.

Another application of the bounding polygon is in FEMA floodway studies. When a floodway study is 
done, the first profile represents the existing conditions of the floodplain. The second and 
subsequent profiles are run by encroaching on the floodplain until some target increase in water 
surface elevation is met. When the encroached profile is sent to the GIS, the bounding polygon is set 
to the limits of the encroachment for each cross section. This will allow the GIS to display the 
encroached water surface (floodway) over the terrain, even though the water surface does not 
intersect the ground. 
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Import/Export Guidelines
The following rules apply to channel and cross-section import/export data.

Defining the River Network
The stream network is represented by a set of interconnected reaches. A stream is a set of one or more 
connected reaches that share a common Stream ID.
A stream is composed of one or more reaches with the same Stream ID, and each reach in a stream must 
have a unique Reach ID. Every reach must be identified by a unique combination of stream and reach IDs.
Stream IDs and Reach IDs are alphanumeric strings. Reach endpoint IDs are integers.
Streams cannot contain parallel flow paths. (If three reaches connect at a node, only two can have the same 
Stream ID.) This prevents ambiguity in stationing along a stream.
A reach is represented by an ordered series of 3D coordinates, and identified by a Stream ID, a Reach ID, and 
IDs for its endpoints.
A reach endpoint is represented by its 3D coordinates and identified by an integer ID.
Reaches are not allowed to cross, but can be connected at their endpoints (junctions) to form a network.
The normal direction of flow on a reach is indicated by the order of its endpoints. One point marks the 
upstream or "from" end of the reach, the other marks the downstream or "to" end of the reach.

Defining Cross Sections
Each cross section is defined by a series of 3D coordinates, and identified by a stream name and reach name 
(which must refer to an existing stream and reach) and a station, indicating the distance from the cross-
section to the downstream end of the stream.
A cross-section line can cross a reach line exactly once, and cannot cross another cross-section line.

Results of a water surface calculation are exported in a file that contains cross-section locations in 
plane (2D) coordinates, water-surface elevations for the cross-sections, and boundary polygons for 
the reaches.

Water Surface Export Data Rules
A cross-section is represented by a water surface elevation and a series of 2D coordinates on the cross-
section cut line. The full width of the cross-section is included.
One bounding polygon is created for each reach in the stream network, and for each profile.
A reach's bounding polygon is made up of the most upstream cross-section on the reach, the endpoints of 
all cross-sections on the reach, and the most upstream cross-sections of reaches downstream of the reach.
For purposes of defining bounding polygons only, the endpoints of a cross-section are adjusted to the edge 
of the water surface at the cross-section if the cross-section is part of a floodway, a leveed section of the 
reach, or the water extent is controlled by a hydraulic structure. This allows calculated water surfaces that 
are higher than the land surface to be reported back to the CADD or GIS program.

Sample RAS GIS Import File
#This file is generated by HEC-GeoRAS for ArcGIS
BEGIN HEADER:
DTM TYPE: TIN
DTM: C:\Examples\Baxter\baxter_tin
STREAM LAYER: C:\Examples\Baxter\baxter.mdb\River
NUMBER OF REACHES: 3
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CROSS-SECTION LAYER: C:\Examples\Baxter\baxter.mdb\XSCutLines
NUMBER OF CROSS-SECTIONS: 173
MAP PROJECTION: STATEPLANE
PROJECTION ZONE: 
DATUM: NAD83
VERTICAL DATUM:
BEGIN SPATIAL EXTENT:
XMIN: 6366478.85990533
YMIN: 2010839.52690533
XMAX: 6468128.45990533
YMAX: 2112489.12690533
END SPATIAL EXTENT:
UNITS: FEET
END HEADER: 
BEGIN STREAM NETWORK: 
ENDPOINT: 6453740, 2051685, 60, 1
ENDPOINT: 6421541, 2051194, 34, 2
ENDPOINT: 6387438, 2035323, 32.95776, 3
ENDPOINT: 6426447, 2059280, 52.14808, 4 
REACH:
STREAM ID: Baxter River
REACH ID: Upper Reach
FROM POINT: 1
TO POINT: 2
CENTERLINE:
6453739.98997957, 2051684.77998051, 59.99999997, 89378.4140625
--- many lines omitted ---
6421540.44998505, 2051194.18999834, 34.00000001, 48157.06640625
END: 
REACH:
STREAM ID: Baxter River
REACH ID: Lower Reach
FROM POINT: 2
TO POINT: 3
CENTERLINE:
6421540.44998505, 2051194.18999834, 34.00000001, 48157.06640625
--- many lines omitted ---
6387438.24001357, 2035323.14001705, 32.95775604, 0
END: 
REACH:
STREAM ID: Tule Creek
REACH ID: Tributary
FROM POINT: 4
TO POINT: 2
CENTERLINE:
6426446.76000561, 2059279.84000069, 52.14807890, 12551.4970703125
--- many lines omitted ---
6421540.44998505, 2051194.18999834, 34.00000001, 0
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END: 
END STREAM NETWORK: 

BEGIN CROSS-SECTIONS: 
CROSS-SECTION:
STREAM ID: Baxter River
REACH ID: Upper Reach
STATION: 84815.69
NODE NAME: 
BANK POSITIONS: 0.5417204, 0.6313727
REACH LENGTHS: 343.447, 815.2449, 627.6476
NVALUES:
0, 0.06
0.2595427, 0.035
0.6867172, 0.06
LEVEE POSITIONS:
INEFFECTIVE POSITIONS:
BLOCKED POSITIONS:
CUT LINE:
6451252.61043617, 2049658.48075948
6450473.97548097, 2050754.33739816
6449753.01716107, 2051480.10208855
SURFACE LINE:
6451252.61043617, 2049658.48075948, 125.00000002
--- many lines omitted ---
6449753.01716107, 2051480.10208855, 110.31235503
END: 
CROSS-SECTION:
STREAM ID: Baxter River
REACH ID: Upper Reach
STATION: 77909.16
NODE NAME: 
BANK POSITIONS: 0.4635276, 0.572924
REACH LENGTHS: 223.1558, 229.2013, 233.3537
NVALUES:
0, 0.06
0.4353712, 0.035
0.6486487, 0.06
LEVEE POSITIONS:
INEFFECTIVE POSITIONS:
354, 0, 0.3630761, 93.26781
355, 0.6235623, 1, 105.4026
BLOCKED POSITIONS:
379, 0.37786, 0.9548786, 79.19141
CUT LINE:
6446531.40685930, 2048445.67038340
6446341.91498890, 2048655.03933954
6446207.54346581, 2049102.94440073
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6446140.35770426, 2049409.01289628
6446028.38145080, 2049909.17358660
6445838.02350501, 2050713.98307530
SURFACE LINE:
6446531.40685930, 2048445.67038340, 93.26781466
--- many lines omitted ---
6445838.02350501, 2050713.98307530, 105.40263370
END: 
--- many Cross Sections omitted ---
CROSS-SECTION:
STREAM ID: Baxter River
REACH ID: Lower Reach
STATION: 34251.78
NODE NAME: 
BANK POSITIONS: 0.2088515, 0.2746628
REACH LENGTHS: 678.4368, 652.6373, 592.5861
NVALUES:
0, 0.06
0.2023585, 0.035
0.5760272, 0.05
LEVEE POSITIONS:
380, 0.5949767, 72.00802
INEFFECTIVE POSITIONS:
BLOCKED POSITIONS:
CUT LINE:
6412787.19596798, 2042663.48848210
6412627.43755387, 2043633.45026854
6412056.87180271, 2047399.18430193
SURFACE LINE:
6412787.19596798, 2042663.48848210, 80.15862274
--- many lines omitted ---
6412056.87180271, 2047399.18430193, 77.57256318
END: 
END CROSS-SECTIONS: 

BEGIN BRIDGES/CULVERTS: 
BRIDGE/CULVERT:
STREAM ID: Tule Creek
REACH ID: Tributary
STATION: 4514.028
NODE NAME: Yosemite Street
US DISTANCE: 100
TOP WIDTH: 96
CUT LINE:
6422221.24109452, 2055203.79594125
6421766.89378999, 2055127.22052519
6421302.33643314, 2054958.75468559
6421128.76554372, 2054912.80947382
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6420924.56454467, 2054892.38936919
SURFACE LINE:
6422221.24109452, 2055203.79594125, 88.73309329
--- many lines omitted ---
6420924.56454467, 2054892.38936919, 83.88871764
END: 
--- many Bridges/Culverts omitted ---
END BRIDGES/CULVERTS: 

BEGIN LEVEES: 
LEVEE ID: 380
SURFACE LINE:
6416224.46794023, 2048201.03890064, 80.30300144
--- many lines omitted ---
6408127.91921907, 2047348.05802148, 73.83999635
END: 
END LEVEES: 
BEGIN INEFFECTIVE AREAS: 
INEFFECTIVE ID: 354
POLYGON:
6446126.65267778, 2049275.06766575
6446347.63945516, 2049062.58037434
6446466.63230616, 2048960.58649530
--- many lines omitted ---
6446126.65267778, 2049275.06766575
END: 
INEFFECTIVE ID: 355
POLYGON:
6446009.40721919, 2049877.88188569
6445816.78229256, 2050758.82118551
--- many lines omitted ---
6446009.40721919, 2049877.88188569
END: 
--- many Ineffective Areas omitted ---
END INEFFECTIVE AREAS: 

BEGIN BLOCKED OBSTRUCTIONS: 
BLOCKED ID: 379
POLYGON:
6422107.09773554, 2052558.24567028
6423542.24950153, 2052503.04750541
6422076.43212521, 2052184.12491178
6422107.09773554, 2052558.24567028
END: 
END BLOCKED OBSTRUCTIONS: 

BEGIN LATERAL STRUCTURES: 
LATERAL STRUCTURE:
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STREAM ID: Baxter River
REACH ID: Lower Reach
STATION: 27469.68
NODE NAME: North LS
US DISTANCE: 0
TOP WIDTH: 20
CUT LINE:
6407389.53497197, 2047168.40301990
6406371.11447597, 2046886.24321303
--- many lines omitted ---
6402363.56369299, 2045153.60574580
SURFACE LINE:
6407389.53497197, 2047168.40301990, 69.83999637
--- many lines omitted ---
6402363.56369299, 2045153.60574580, 65.27986148
END: 
END LATERAL STRUCTURES: 

BEGIN STORAGE AREAS: 
SA ID: 369
POLYGON:
6402631.96981374, 2045430.51958869
--- many lines omitted ---
6402631.96981374, 2045430.51958869
END:
ELEVATION-VOLUME:
63.34, 0
64.59, 272682.8
65.84, 2102153
67.09, 1.130536E+07
68.34, 2.241535E+07
69.59, 3.505853E+07
70.84, 4.921408E+07
72.09, 6.477892E+07
73.34, 8.095226E+07
74.59, 9.734569E+07
75.84, 1.142249E+08
END:
TERRAIN:
END: 
END STORAGE AREAS: 
BEGIN SA CONNECTIONS: 
    SA CONNECTION:
        SACONN ID: 444 



HEC-RAS Data Exchange

HEC-RAS User's Manual– 768

1.
2.

        NODE NAME:
        US SA: 369
        DS SA: 371
        TOP WIDTH: 20
 CUT LINE:
6407389.53497197, 2047168.40301990
6406371.11447597, 2046886.24321303
--- many lines omitted ---
6402363.56369299, 2045153.60574580
SURFACE LINE:
6407389.53497197, 2047168.40301990, 69.83999637
--- many lines omitted ---
6402363.56369299, 2045153.60574580, 65.27986148 
    END: 
END SA CONNECTIONS: 

Sample RAS GIS Export File
RAS export file created on DAY DAYMONTHYEAR TIME
by HEC-RAS Version 3.1.3 
BEGIN HEADER:
UNITS: 
DTM TYPE: TIN
DTM: C:\Examples\Baxter\baxter_tin
STREAM LAYER: C:\Examples\Baxter\baxter.mdb\River
CROSS-SECTION LAYER: C:\Examples\Baxter\baxter.mdb\XSCutLines
MAP PROJECTION: STATEPLANE
PROJECTION ZONE: 
DATUM: NAD83
VERTICAL DATUM: 
BEGIN SPATIALEXTENT:
Xmin: 6386768.00418383
Ymin: 2029042.52107352
Xmax: 6454403.07894787
Ymax: 2059837.49270508
END SPATIALEXTENT:
NUMBER OF PROFILES: 3 
PROFILE NAMES: 
50yr
100yr
500yr
NUMBER OF REACHES: 3 
NUMBER OF CROSS-SECTIONS: 179 
END HEADER: 
BEGINSTREAMNETWORK: 
ENDPOINT:6421540.50,2051194.25, , 1
ENDPOINT:6453739.99,2051684.78, , 2
ENDPOINT:6387438.24,2035323.14, , 3
ENDPOINT:6426446.76,2059279.84, , 4 
REACH: 
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STREAM ID: Baxter River 
REACH ID: Upper Reach 
FROM POINT: 2 
TO POINT: 1 
CENTERLINE:
6453739.99, 2051684.78, ,
6421540.45, 2051194.19, ,
END: 
REACH: 
STREAM ID: Baxter River 
REACH ID: Lower Reach 
FROM POINT: 1 
TO POINT: 3 
CENTERLINE:
6421540.45, 2051194.19, ,
6387438.24, 2035323.14, ,
END: 
REACH: 
STREAM ID: Tule Creek 
REACH ID: Tributary 
FROM POINT: 4 
TO POINT: 1 
CENTERLINE:
6426446.76, 2059279.84, ,
6421540.45, 2051194.19, ,
END: 
ENDSTREAMNETWORK: 

BEGIN CROSS-SECTIONS: 
CROSS-SECTION:
STREAM ID:Baxter River 
REACH ID:Upper Reach 
STATION:84815.69
NODE NAME: 
CUT LINE:
6451252.6104362 , 2049658.4807595 
6450473.975481 , 2050754.3373982 
6449753.0171611 , 2051480.1020886
REACH LENGTHS:826.24,806.49,525.17
BANK POSITIONS:0.45159,0.51309
LEVEE POSITIONS:
380,0.93260,79.95625 
WATER ELEVATION:70.39427,76.72782,86.74971
WATER SURFACE EXTENTS:
6450877.21, 2050186.83, 6450289.15, 2050940.40
6450896.85, 2050159.18, 6450262.99, 2050966.73
6450912.28, 2050137.47, 6450189.98, 2051040.23
PROFILE ID:50yr
VELOCITIES:
0.32733, 1.558
0.46174, 2.381
0.55094, 3.764
0.56925, 4.280
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0.58721, 6.164
0.60317, 5.713
0.62166, 3.942
0.64436, 1.926
PROFILE ID:100yr
VELOCITIES:
0.31866, 2.972
0.45698, 3.829
0.55086, 5.019
0.56908, 5.459
0.58709, 7.245
0.60341, 6.737
0.62189, 5.168
0.65404, 3.202
PROFILE ID:500yr
VELOCITIES:
0.31332, 4.739
0.45464, 5.533
0.55081, 6.526
0.56894, 6.860
0.58698, 8.456
0.60365, 7.890
0.62206, 6.635
0.66467, 4.272
SURFACE LINE:
6451252.61, 2049658.48, 125.00
--- many lines omitted ---
449753.02, 2051480.10, 110.31
END:
CROSS-SECTION:
STREAM ID:Tule Creek 
REACH ID:Tributary 
STATION:1595.102
NODE NAME: 
CUT LINE:
6422369.1971783 , 2052943.6596315 
6421588.0439919 , 2052573.50648 
--- many lines omitted ---
6420275.0509832 , 2052670.3666247 
WATER ELEVATION:62.67044,69.44948,78.49661
WATER SURFACE EXTENTS:
6421432.49, 2052554.70, 6420609.83, 2052432.00
6421570.89, 2052571.43, 6420459.69, 2052510.35
6422048.65, 2052791.77, 6420316.40, 2052634.53
PROFILE ID:50yr
VELOCITIES:
0.47364, 0.016
0.65126, 0.056
0.74604, 0.171
0.75411, 0.221
0.76221, 0.247
0.77030, 0.207
0.77842, 0.151
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0.79265, 0.059
PROFILE ID:100yr
VELOCITIES:
0.44844, 0.116
0.62783, 0.185
0.74591, 0.383
0.75406, 0.466
0.76221, 0.514
0.77035, 0.444
0.77857, 0.350
0.81222, 0.177
0.86985, 0.096
PROFILE ID:500yr
VELOCITIES:
0.21051, 0.019
0.42227, 0.092
0.62301, 0.192
0.74582, 0.350
0.75403, 0.407
0.76221, 0.444
0.77039, 0.393
0.77866, 0.327
0.81602, 0.232
0.88706, 0.146
0.94874, 0.075
SURFACE LINE:
6422369.20, 2052943.66, 80.22
--- many lines omitted ---
6420275.05, 2052670.37, 85.26
END: 
END CROSS-SECTIONS: 

BEGIN STORAGE AREAS: 
SA ID: 369 
WATER ELEVATION:65,65,65
POLYGON:
6402631.9698137 , 2045430.5195887 ,
6402648.7543614 , 2046009.5857725 ,
--- many lines omitted ---
6402631.9698137 , 2045430.5195887 ,
END: 
SA ID: 370 
WATER ELEVATION:65,65,65
POLYGON:
6411089.902679 , 2043584.9518455 ,
6411100.24735 , 2041762.9675571 ,
--- many lines omitted ---
6411089.902679 , 2043584.9518455 ,
END: 
END STORAGE AREAS: 
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BEGIN BOUNDS: 
PROFILE LIMITS:
PROFILE ID:50yr
POLYGON:
6449753.02,2051480.10,70.39
--- many lines omitted ---
6449462.09,2051308.23,70.35
POLYGON:
6424775.60,2059535.58,62.69
--- many lines omitted ---
6424246.32,2059434.43,62.69
POLYGON:
6420221.24,2052718.80,62.36
--- many lines omitted ---
6420143.38,2052744.69,62.32
END: 
PROFILE LIMITS:
PROFILE ID:100yr
POLYGON:
6449753.02,2051480.10,76.73
--- many lines omitted ---
6449462.09,2051308.23,76.73
POLYGON:
6424775.60,2059535.58,69.51
--- many lines omitted ---
6424246.32,2059434.43,69.52
POLYGON:
6420221.24,2052718.80,69.19
--- many lines omitted ---
6420143.38,2052744.69,69.17
END: 
PROFILE LIMITS:
PROFILE ID:500yr
POLYGON:
6449753.02,2051480.10,86.75
--- many lines omitted ---
6449462.09,2051308.23,86.83
POLYGON:
6424775.60,2059535.58,78.54
--- many lines omitted ---
6424246.32,2059434.43,78.54
POLYGON:
6420221.24,2052718.80,78.18
--- many lines omitted ---
6420143.38,2052744.69,78.16
END: 
END BOUNDS: 
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18 HEC-RAS OUTPUT VARIABLES

Hydraulic Output Variables
Variable NameUnits Description

Barrels # Number of barrels in a culvert.
Alpha Alpha energy weighting coefficient.
Area sq ft Flow area of the entire cross section including ineffective flow.
Area Channel sq ft Flow area of the main channel including ineffective flow.
Area Left sq ft Flow area of the left overbank including ineffective flow.
Area Right sq ft Flow area of the right overbank including ineffective flow.
Base WS ft Water surface for first profile (used in comparison to encroachment profiles).
Beta Beta momentum weighting coefficient.
BR Open Area sq ft Total area of the entire bridge opening. 
BR Open Vel ft/s Average velocity inside the bridge opening (Maximum of BU and BD).
Br Sel Mthd Selected bridge hydraulic modeling method.
Breach CL ft Center line of weir breach.
Breach WD ft Bottom width of weir breach.
Breach Bottom Elft Bottom Elevation of weir breach.
Breach Top El ft Top Elevation of weir breach.
Breach SSL ft Left side slope of weir breach.
Breach SSR ft Right side slope of weir breach.
C & E Loss ft Contraction or expansion loss between two cross sections.
Center Station ft Stationing of the center of the main channel.
Ch Sta L ft Left station of main channel.
Ch Sta R ft Right station of main channel.
Clv EG No Wr ft Energy grade elevation at the culvert when calculated without the weir.
Coef of Q WSPRO bridge method coefficient of discharge.
Conv. Chnl cfs Conveyance of main channel.
Conv. Left cfs Conveyance of left overbank.
Conv. Ratio Ratio of the conveyance of the current cross section to the conveyance of the 
downstream cross section.
Conv. Right cfs Conveyance of right overbank.
Conv. Total cfs Conveyance of total cross section.
Crit Depth ft Critical depth. Corresponds to critical water surface.
Crit E.G. ft Critical energy elevation. Minimum energy on the energy versus depth curve.
Crit Enrgy 1 ft Energy associated with first critical depth.
Crit Enrgy 2 ft Energy associated with second critical depth.
Crit Enrgy 3 ft Energy associated with third critical depth.
Crit Num # Number of critical depths found.
Crit W.S. ft Critical water surface elevation. Water surface corresponding to the minimum energy on 
the energy versus depth curve.
Crit W.S. 1 ft Water surface elevation of first critical depth.
Crit W.S. 2 ft Water surface elevation of second critical depth.
Crit W.S. 3 ft Water surface elevation of third critical depth.
Culv Crt Depth ft Critical depth inside the culvert.
Culv Depth Blockedft Depth of fill in a culvert.
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Culv EG In ft Energy gradeline inside the culvert at the inlet. 
Culv EG Out ft Energy gradeline inside the culvert at the outlet.
Culv Ent Lss ft Culvert entrance loss (energy loss due only to entrance).
Culv Ext Lss ft Culvert exit loss (energy loss due to exit).
Culv Frctn Ls ft Friction loss through the culvert barrel.
Culv Ful Lngh ft The length that the culvert flows full.
Culv Inlet Mann n The composite n value at the culvert inlet.
Culv Inv El Dn ft Culvert inside invert elevation downstream.
Culv Inv El Up ft Culvert inside invert elevation upstream.
Culv Length ft Length of the culvert barrel.
Culv Nml Depthft Normal depth for this culvert (and flow).
Culv Outlet Mann n The composite n value at the culvert outlet.
Culv Q cfs Flow through all barrels in a culvert group.
Culv Vel DS ft/s Velocity inside of culvert at inlet.
Culv Vel US ft/s Velocity inside of culvert at outlet.
Culv WS In ft Water surface elevation inside the culvert at the inlet.
Culv WS Out ft Water surface elevation inside the culvert at the outlet.
Cum Ch Len ft Cumulative Channel Length.
Deck Width ft Width of bridge/culvert Deck (top of embankment), in direction of flow.
Delta EG ft Change in energy grade line through culvert(s) and bridge(s).
Delta WS ft Change in water surface through culvert(s) and bridge(s).
Dist Center L ft Distance from center of channel to left encroachment.
Dist Center R ft Distance from center of channel to right encroachment.
E.G. DS ft Energy grade elevation at downsteam end of bridge or culvert.
E.G. Elev ft Energy gradeline for calculated WS Elev.
E.G. IC ft Upstream energy gradeline at culvert based on inlet control.
E.G. OC ft Upstream energy gradeline at culvert based on outlet control.
E.G. Slope ft/ft Slope of the energy grade line.
E.G. US. ft Energy grade elevation at upstream end of bridge or culvert (final answer).
Enc Method Encroachment method used at this cross section.
Enc Sta L ft Left station of encroachment.
Enc Sta R ft Right station of encroachment.
Enc Val 1 ft Target for encroachment analysis.
Enc Val 2 ft Second target for encroachment analysis.
Encr WD ft Top width between encroachments.
Energy EG ft Energy grade elevation upstream of bridge for energy only method.
Energy WS ft Water surface elevation upstream of bridge for energy only method.
Energy/Wr EG ft Energy grade elevation upstream of bridge for low energy and weir method.
Energy/Wr WS ft Water surface elevation upstream of bridge for low flow energy method and weir 
flow.
Flow Area sq ft Total area of cross section active flow.
Flow Area Ch sq ft Area of main channel active flow.
Flow Area L sq ft Area of left overbank active flow.
Flow Area R sq ft Area of right overbank active flow.
Frctn Loss ft Friction loss between two cross sections.
Frctn Slope ft/ft Representative friction slope between two cross sections.
Frctn Slp Md Friction slope averaging method used.
Froude # Chl Froude number for the main channel.
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Froude # XS Froude number for the entire cross section.
Gate #Open # The number of gates opened in the current group.
Gate Area sq ft The flow area in an opened gate.
Gate Group Q cfs Flow through all gate openings in a gate group.
Gate Invert ft Gate spillway invert elevation.
Gate Open Ht ft Height of gate opening.
Gate Submerg Degree of gate submergence. The ratio of the downstream depth above the gate to 
the upstream depth above the gate.
Headloss ft Total energy loss between two cross sections.
Hydr Depth ft Hydraulic depth for cross section (Area/Topwidth of active flow).
Hydr Depth C ft Hydraulic depth in channel (channel flow area/topwidth of channel flow).
Hydr Depth L ft Hydraulic depth in left overbank (left overbank flow area/topwidth of left overbank 
flow).
Hydr Depth R ft Hydraulic depth for right over bank (right overbank flow area/topwidth of right 
overbank flow).
Ice Btm Chan ft The bottom elevation of ice in the main channel.
Ice Btm LOB ft The bottom elevation of ice in the left overbank.
Ice Btm ROB ft The bottom elevation of ice in the right overbank.
Ice Err ft Convergence error in ice thickness for dynamic ice jam.
Ice Thick Chan ft Ice thickness in the main channel.
Ice Thick LOB ft Ice thickness in the left overbank.
Ice Thick ROB ft Ice thickness in the right overbank.
Ice Top Chan ft The top elevation of ice in the main channel.
Ice Top LOB ft The top elevation of ice in the left overbank.
Ice Top ROB ft The top elevation of ice in the right overbank.
Ice Vol Total cu ft Cumulative volume of ice in an ice jam.
Ice Vol. Chan cu ft Cumulative volume of ice in the main channel for an ice jam.
Ice Vol. LOB cu ft Cumulative volume of ice in the left overbank for an ice jam.
Ice Vol. ROB cu ft Cumulative volume of ice in the right overbank for an ice jam.
Ice WS Err ft Convergence error in water surface for dynamic ice jam.
Ineff El Left ft The elevation of the left ineffective area.
Ineff El Right ft The elevation of the right ineffective area.
Inflow cfs Net inflow into a storage area.
Invert Slope ft/ft The slope from the invert of this cross section to the next cross section downstream.
IW Gate Flow cfs Total flow through all of the gate groups of an inline weir/spillway.
K Perc L ft Conveyance reduction from left encroachment.
K Perc R ft Conveyance reduction from right encroachment.
L. Freeboard ft The freeboard in the main channel at the left bank (left bank elevation minus water 
surface elevation).
L. Levee Frbrd ft The freeboard before the left levee is overtopped.
Left Sta Eff ft Furthest left station where there is effective flow.
Length Chnl ft Downstream reach length of the main channel.
Length Left ft Downstream reach length of the left overbank.
Length Rght ft Downstream reach length of the right overbank.
Length Wtd. ft Weighted cross section reach length, based on flow distribution, in left bank, channel, 
and right bank.
Levee El Left ft The elevation of the left levee.
Levee El Right ft The elevation of the right levee.
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LOB Elev ft The ground elevation at the left bank of the main channel.
Mann Comp Composite Manning's n value for main channel.
Mann Wtd Chnl Conveyance weighted Manning's n for the main channel.
Mann Wtd Chnl Conveyance weighted Manning's n for the left overbank.
Mann Wtd Rght Conveyance weighted Manning's n for the right overbank.
Mann Wtd Total Manning's n value for the total main cross section.
Max Chl Dpth ft Maximum main channel depth. 
Min Ch El ft Minimum main channel elevation.
Min El ft Minimum overall section elevation.
Min El Prs ft Elevation at the bridge when pressure flow begins.
Min Error ft The minimum error, between the calculated and assumed water surfaces when 
balancing the energy equation.
Min El Weir Flowft Elevation where weir flow begins.
Min Weir El ft Minimum elevation of a weir.
Momen. EG ft Energy grade elevation upstream of bridge for momentum method.
Momen. WS ft Water surface elevation upstream of bridge for momentum method.
Net Flux cfs Net inflow - outflow for a storage area.
Num Trials # Current number (or final number) of trials attempted before the energy equation is 
balanced.
Obs WS ft Observed water surface elevation.
Outflow cfs Net outflow into a storage area.
Perc Q Leaving Percentage of flow leaving through a lateral weir.
Piping Flow ft Flow from piping weir failure.
Power Chan lb/ft s Total stream power in main channel (main channel shear stress times main 
channel average velocity). Used in Yang's and other sediment transport equations.
Power LOB lb/ft s Total stream power in left overbank (left overbank shear stress times left overbank 
average velocity). Used in Yang's and other sediment transport equations.
Power ROB lb/ft s Total stream power in right overbank (right overbank shear stress times right 
overbank average velocity). Used in Yang's and other sediment transport equations.
Power Total lb/ft s Total stream power (total cross section shear stress times total cross section 
average velocity). Used in Yang's and other sediment transport equations.
Prof Delta EG ft Difference in EG between current profile and EG for first profile.
Prof Delta WS ft Difference in WS between current profile and WS for first profile.
Profile # Profile number.
Prs O EG ft Energy grade elevation upstream of bridge for pressure only method.
Prs O WS ft Water surface elevation upstream of bridge for pressure only method.
Prs/Wr EG ft Energy grade elevation upstream of bridge for pressure and/or weir method.
Prs/Wr WS ft Water surface elevation upstream of bridge for pressure and/or weir method.
Pumping Head ft Pumping head for the pump station.
Q Barrel cfs Flow through one barrel in a culvert group.
Q Bridge cfs Flow through the bridge opening.
Q Channel cfs Flow in main channel.
Q Culv cfs Total flow in all culvert groups.
Q DS cfs Flow in cross section downstream of lateral weir.
Q Lat RC cfs Lateral rating curve flow.
Q Leaving Totalcfs Total flow leaving in a lateral weir including all gates. 
Q Left cfs Flow in left overbank.
Q Perc Chan ft Percent of flow in main overbank.
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Q Perc L ft Percent of flow in left overbank.
Q Perc R ft Percent of flow in right overbank.
Q Pump Group cfs Pump group flow.
Q Pump Stationcfs Total flow in all pump groups in a pump station.
Q Right cfs Flow in right overbank.
Q Total cfs Total flow in cross section.
Q US cfs Flow in cross section upstream of a lateral weir.
Q Weir cfs Flow over the weir.
R. Freeboard ft The freeboard in the main channel at the right bank (right bank elevation minus 
water surface elevation). 
R. Levee Frbrd ft The freeboard before the right levee is overtopped.
Rght Sta Eff ft Furthest right station that still has effective flow.
ROB Elev ft The ground elevation at the right bank of the main channel.
SA Area acres Surface area of a storage area.
SA Chan acres Cumulative surface area for main channel from the bottom of the reach.
SA Left acres Cumulative surface area for left overbank from the bottom of the reach.
SA Min El ft Minimum elevation of a storage area.
SA Right acres Cumulative surface area for right overbank from the bottom of the reach.
SA Total acres Cumulative surface area for entire cross section from the bottom of the reach.
SA Volume acre-ft Storage volume of a storage area.
Shear Chan lb/sq ft Shear stress in main channel (γRCH Sf).
Shear LOB lb/sq ft Shear stress in left overbank ( γRLOB Sf).
Shear ROB lb/sq ft Shear stress in right overbank ( γRROB Sf).
Shear Total lb/sq ft Shear stress in total section ( γRT Sf).
Spc Force PR cu ft Specific force prime. For mixed flow, the specific force at this cross section for the 
flow regime that does not control.
Specif Force cu ft The specific force for this cross section at the computed water surface elevation. SF 
= ATYcent + (Q2)/(gAact)
Sta W.S. Lft ft Left station where water intersects the ground.
Sta W.S. Rgt ft Right station where water intersects the ground.
Std Stp Case # Standard step method used to determine WSEL (1 = successful convergence, 2 = 
minimum error, 3 = resorted to critical depth).
Top W Act Chanft Top width of the wetted channel, not including ineffective flow.
Top W Act Leftft Top width of the wetted left bank, not including ineffective flow.
Top W Act Rightft Top width of the wetted right bank, not including ineffective flow.
Top W Chnl ft Top width of the main channel. Does not include 'islands', but it does include 
ineffective flow.
Top W Left ft Top width of the left overbank. Does not include 'islands', but it does include ineffective 
flow.
Top W Right ft Top width of the right overbank. Does not include 'islands', but it does include 
ineffective flow.
Top Wdth Act ft Top width of the wetted cross section, not including ineffective flow.
Top Width ft Top width of the wetted cross section.
Total Gate Flowcfs Total flow through all of the gate groups of an inline/lateral weir.
Trvl Tme Avg hrs Cumulative travel time based on the average velocity of the entire cross section, per 
reach.
Trvl Tme Chl hrs Cumulative travel time based on the average velocity of the main channel, per 
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reach.
Vel Chnl ft/s Average velocity of flow in main channel.
Vel Head ft Velocity head.
Vel Left ft/s Average velocity of flow in left overbank.
Vel Right ft/s Average velocity of flow in right overbank.
Vel Total ft/s Average velocity of flow in total cross section.
Vol Chan acreft Cumulative volume of water in the channel (including ineffective flow).
Vol Left acreft Cumulative volume of water in the left overbank (including ineffective flow).
Vol Right acreft Cumulative volume of water in the right overbank (including ineffective flow).
Volume acreft Cumulative volume of water in the direction of computations (including ineffective 
flow).
W.P. Channel ft Wetted perimeter of main channel.
W.P. Left ft Wetted perimeter of left overbank.
W.P. Right ft Wetted perimeter of right overbank.
W.P. Total ft Wetted perimeter of total cross section.
W.S. DS ft Water surface downstream of a bridge, culvert, or weir.
W.S. Elev ft Calculated water surface from energy equation.
WS Inlet ft WS at the inlet of a pump station.
WS Outlet ft WS at the outlet of a pump station.
W.S. Prime ft Water surface prime. For mixed flow, the water surface of the flow regime that does not 
control.
W.S. US. ft Water surface elevation upstream of bridge or culvert.
Weir Avg Depthft The average depth of flow over the weir.
Weir Max Depthft The maximum depth of flow over the weir.
Weir Sta DS ft Downstream station where weir flow ends.
Weir Sta Lft ft Station where flow starts on the left side of weir.
Weir Sta Rgt ft Station where flow ends on the right side of weir.
Weir Sta US ft Upstream station for weir flow starts.
Weir Submerg The ratio of the downstream depth above the weir to the upstream depth above the 
weir.
Wr Flw Area sq ft Area of the flow going over the weir.
Wr Top Wdth ft Top width of water over the weir.
WS Air Entr. ft Water surface elevation accounting for air entrainment.
WSPRO EG ft Energy grade elevation upstream of bridge for the WSPRO method.
WSPRO WS ft Water surface elevation upstream of bridge for the WSPRO method.
Wtd. n Chnl Conveyance weighted Manning's n for the main channel.
Wtd. n Left Conveyance weighted Manning's n for the left overbank.
Wtd. n Right Conveyance weighted Manning's n for the right overbank.
XS Delta EG ft Change in energy gradeline between current section and next one downstream.
XS Delta WS ft Change in water surface between current section and next one downstream.
Yarnell EG ft Energy grade elevation upstream of bridge for Yarnell method.
Yarnell WS ft Water surface elevation upstream of bridge for Yarnell method.

Sediment Transport Output Variables
Variable Name Units Description 
Ch Invert El ft Minimum elevation of the main channel at each output time step.
Wsel ft Elevation of the water surface at each output time step.
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Observed Data ft Observed elevation of main channel bed, entered by the user.
Invert Change ft Delta change in the minimum elevation of the main channel.
Mass Out: All tons Total sediment mass, for all grain size classes, going out of the sediment control 
volume, per individual computational time step.
Mass Out: Class 1-20 tons Sediment mass leaving the sediment control volume per grain size 
fraction, per computational time step.
Mass In: All tons Total sediment mass, for all grain size classes, coming into the sediment control 
volume, per individual computational time step.
Mass In: Class 1-20 tons Sediment mass entering the sediment control volume per grain size fraction, 
per computational time step
Flow cfs Total flow at the cross section for each output time step.
Velocity ft/s Average velocity of the movable portion of the bed at each time step.
Shear Stress lb/sq ft Average shear stress of the movable portion of the bed at each time step.
EG Slope ft/ft Slope of the energy gradeline at each output time step. This can be a point value at the 
cross section or an average value between cross sections.
Mass Bed Change Cum: All (tons)Cumulative mass of the change in the bed elevation over time.
Mass Bed Change Cum: class 1-20 (tons) Cumulative mass of the change in bed elevation over time, 
per grain size fraction (Bins 1 – 20). This only displays the size fraction bins that are being used.
Mass Bed Change: All tons Incremental total mass change in the bed for the current computational 
time step.
Mass Bed Change: Class 1–20 (tons) Incremental mass change in the bed for the current time step, by 
individual grain size fraction.
Mass Out Cum: All tons Cumulative total sediment mass leaving the sediment control volume for a 
specific cross section, per individual computational time step.
Mass Out Cum: Class 1-20 (tons)Cumulative sediment mass leaving the sediment control volume per 
grain size fraction, at a cross section, per computational time step.
Mass In Cum: All tons Cumulative total sediment mass entering the sediment control volume for a 
specific cross section, per individual computational time step.
Mass In Cum: Class 1-20 (tons)Cumulative sediment mass entering the sediment control volume per 
grain size fraction, at a cross section, per computational time step.
Mass Capacity: All tons/dayTransport capacity in total mass at the current computational time step.
Mass Capacity: Class 1-20 (tons/day)Transport capacity in mass, by grain size fraction, at the current 
computational time step.
Mean Eff Ch Invertft Average channel invert elevation computed by subtracting the effective depth of 
the main channel from the water surface elevation.
Mean Eff Ch Invert Change (ft)Change in the average channel invert elevation, which is computed by 
subtracting the effective depth of the main channel from the water surface elevation.
Long. Cum Mass change (tons) Total change in bed mass, cumulative in space and time. Spatial 
accumulation is from the current cross section to the upstream end of the river reach in which this 
cross section resides.
d50 Cover mm d50 of the cover layer at the end of the computational increment. Used in the Exner 5 
bed sorting and armoring routine.
d50 Subsurface mm d50 of the surface layer material at the end of the computational time step. 
Used in the Exner 5 bed sorting and armoring routine.
d50 Active mm d50 of the active layer of the simple active layer bed sorting and armoring routine.
d50 Inactive mm d50 of the inactive layer at the end of each computational time step. Used in the 
Exner 5 and simple active layer bed sorting and armoring routine.
Cover Thickness ft Thickness of the cover layer at the end of each computational time step. Used in 
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the Exner 5 bed sorting and armoring routine.
Subsurface Thicknessft Thickness of the surface layer at the end of each computational time step. 
Used in the Exner 5 and simple active layer bed sorting and armoring routine.
Active Thickness ft Thickness of the active layer at the start of each computational time step. Used in 
the simple active layer bed sorting and armoring routine.
Mass Cover: All tons Total tons of material in the cover layer at the end of each computational time 
step. Used in the Exner 5 bed sorting and armoring routine.
Mass Cover: Class 1-20 (tons) Tons of material in the cover later at the end of each computational 
time step, by individual grain size fraction. Used in the Exner 5 bed sorting and armoring routine.
Mass Subsurface: All tons Total tons of material in the surface layer at the end of each computational 
time step.
Mass Subsurface: Class 1-20 (tons)Tons of material in the surface layer at the end of each 
computational time step, by individual grain size fraction.
Mass Inactive: Alltons Total tons of material in the inactive layer at the end of each computational 
time increment.
Mass Inactive: Class 1-20 (tons)Tons of material in the inactive layer at the end of each 
computational increment, by individual grain size fraction.
Armor Reduction: All (fraction)Fraction that the total sediment transport capacity is reduce to, based 
on the concepts of a cover layer computation.
Armor Reduction: Class 1-20 (fraction) Fraction for each individual grain size, that the transport 
capacity is reduce to, based on the concepts of a cover layer computation.
Sediment Discharge tons/dayTotal sediment discharge in tons/day going out of the sediment control 
volume for a specific cross section, per individual computational time step.
Sediment Concentration (mg/l) Total sediment concentration in mg/liter going out of the sediment 
control volume at the end of the computational time step.
Eff Depth ft Effective depth of the water in the mobile portion of the cross section, at the end of the 
computational time step.
Eff Width ft Effective width of the water in the mobile portion of the cross section, at the end of the 
computational time step.
Ch Manning n - Main channel manning's n value.
Ch Froude Num - Main channel Froude number at the end of the current computational time step.
Shear Velocity u* ft/s Shear velocity. Used in Shields diagram and several sediment transport 
potential equations.
d90 Cover mm d90 of the cover layer at the end of the computational increment. Used in the Exner 5 
bed sorting and armoring routine.
d90 Subsurface mm d90 of the surface layer material at the end of the computational time step. 
Used in the Exner 5 bed sorting and armoring routine.
d90 Active mm d90 of the active layer of the simple active layer bed sorting and armoring routine.
d90 Inactive mm d90 of the inactive layer at the end of each computational time step. Used in the 
Exner 5 and simple active layer bed sorting and armoring routine.
Dredge Vol Cumft3 Total volume of sediment removed from each cross section by the dredging 
routines. 
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19 IMPORTING HEC-2 DATA
An important feature of HEC-RAS is the ability to import HEC-2 data. This feature makes it easy for a 
user to import existing HEC-2 data sets and start using HEC-RAS immediately. HEC-2 is a steady flow 
hydraulics model that was the predecessor to HEC-RAS. Thousands of hydraulic studies were done 
with HEC-2 in the 70's, 80's, and 90's.

What You Should Know First
Before importing HEC-2 data, there are several things that you should be aware of. First, not all of the 
options available in HEC-2 have been incorporated into the current version of HEC-RAS. The 
following is a list of HEC-2 options that are not available in the current version of HEC-RAS:

Compute Manning's n from high water marks (J1)
Archive (AC)
Free Format (FR) – HEC-2 files that are in free format (comma and single space delimited, instead of the fixed 
format of 8 column fields)
Storage Outflow for HEC-1 (J4)

HEC-2 data sets containing these options can still be imported (except for free format HEC-2 files 
cannot), but these data options will be ignored.
Another important issue to be aware of is how the cross sections are identified. In HEC-RAS, each 
cross section is identified with a River name, Reach name, and a River Station. The river stationing 
must be in order from highest river stationing upstream to lowest river stationing downstream. 
When the user goes to import HEC-2 data, a pop up window will appear (Figure 3-14), asking the user 
to select a method for identifying the river stationing of the cross sections. If you select "Use HEC-2 
Section ID's," the program will use the first field of the X1 record for the river stationing of the cross 
section. If you choose this method, you must be sure that the cross sections in the HEC-2 file are 
numbered with highest river stationing upstream, and that no two cross sections have the same river 
station identifier. If these two requirements are not met, the program will not import the data 
correctly. An alternative is to select "Use Sequential Counter." This method simply assigns river 
stations as 1, 2, 3, etc… in the order in which the cross sections are found in the HEC-2 file (still 
maintaining highest numbers upstream and lowest numbers downstream. 

Method for Identifying River Stations from HEC-2 Data
After the HEC-2 data is imported into HEC-RAS, you may need to make some modifications to the 
data. HEC-RAS is a completely new program. As HEC-RAS was being developed, we tried to improve 
the hydraulic computations in every way we could. Some of these improvements have made it 
necessary to get more information and/or different information from the user for a specific type of 
computation. The following is a list of features in which the data requirements for HEC-2 and HEC-
RAS have changed, and it may be necessary for the user to modify the data after it is imported:

Special Bridge (SB)
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Special Culvert (SC)
Normal Bridge (X2, BT)
Encroachments and Floodway Determination (X3, ET)
Ineffective Flow Areas (X3)

When bridge data are imported, the user must take special care to ensure that the data are correctly 
representing the bridge. The bridge routines in HEC-RAS are more detailed than HEC-2, and therefore 
you may have to modify some data and/or enter some additional data. Whenever you import an 
HEC-2 data set with bridge data, carefully review all the data for each bridge. Chapter 6 of this user's 
manual describes the required data for bridges in HEC-RAS. Appendix C of the HEC-RAS Hydraulic 
Reference Manual contains a detailed discussion of the computational differences between 
HEC-RAS and HEC-2. Some key differences between the bridge routines of HEC-2 and HEC-RAS are 
as follows:

Special Bridge Data Sets

HEC-RAS does not use a trapezoidal approximation for low flow through the bridge opening. The 
actual bridge opening is used in both the Yarnell method and the momentum method. This could be 
a problem for HEC-2 special bridge data sets that do not include low chord information on the BT 
data. If you have a data set like this, you will need to modify the bridge deck information after the 
data have been imported. This can be done from the HEC-RAS Deck/Roadway editor.
The pressure flow equations in HEC-RAS use the actual bridge opening, defined by the ground and 
the bridge data. In HEC-2, the user was required to enter an area for pressure flow. If the actual 
bridge opening produces a different area than what the user had entered in the HEC-2 data deck, the 
program will get different results for pressure flow, and pressure and weir flow answers.
Pier information from the SB record is incorporated as a single pier in the HEC-RAS data set (this is 
how it was treated in HEC-2). Piers are treated as separate pieces of data in HEC-RAS. For special 
bridges that have piers, you may want to change the single pier to multiple piers, depending on what 
is actually at the bridge. Pier information can be modified using the Pier editor.

Normal Bridge Data Sets

Because piers are treated as a separate piece of data in HEC-RAS, they must not be included in the 
cross section data or the bridge deck. Since it is common to include pier information as part of the 
cross section or bridge deck in HEC-2, these data will need to be modified. For data sets that have 
piers, you will need to remove the pier information from the cross section or bridge deck, and then 
add the information back in using the Pier editor.

Steps for Importing HEC-2 Data
To import HEC-2 data, do the following:

Start a new project by selecting New Project under the File menu option on the HEC-RAS main window 
(Figure 3-16). When this option is selected a window will appear allowing you to select the drive and 
directory for the new project, and then enter a project title and filename. Press the OK button, and then a 
pop up window will appear asking you to confirm the information.
Select the Import HEC-2 Data option under the File menu on the main window (Figure 3-15). A pop up 
window will appear (Figure 3-17), which will allow you to select a drive, path, and filename for the HEC-2 
data file. In addition to the filenames being listed, the first line of each HEC-2 data file is shown under the 
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title field on the window. Once you have selected the file you want, press the OK button.

Once you have selected an HEC-2 file and pressed the OK button, a pop up window will appear asking you to 
select a method for identifying the river stationing of the cross sections (this was discussed under the "What 
You Should Know First" section). Select a method and press the Import HEC-2 button.

If the HEC-2 data file contains any bridges or culverts, a note will appear reminding you to look at the 
imported data of all of the bridges and culverts to ensure the data is complete and correct.
The data are automatically saved in HEC-RAS format with default names and titles. The user can change the 
titles at any time by using the Rename feature, which is available from the File menu of the various data 
editors (Geometric data, flow data, and plan data).

Reproducing HEC-2 Results
The HEC-RAS program is a completely new piece of software. None of the hydraulic routines from 
HEC-2 were used in the HEC-RAS software. When HEC-RAS was being developed, a significant effort 
was spent on improving the computational capabilities over those in the HEC-2 program. Because of 
this, there are computational differences between the two programs.
Appendix C, of the HEC-RAS Hydraulic Reference Manual, outlines in detail the computational 
differences between the two programs. Please review this closely!

When importing HEC-2 data, and attempting to reproduce the results of a previous study, the 
following is a list of items that should be considered:

First, is the data that you have imported good data? In other words, did it come from a working HEC-2 
model, and was that model considered as being hydraulically sound. Are there an adequate number of cross 
sections? And are there any mistakes in the cross section data? Review the data closely, before you assume 
that it is good!
The default method for calculating conveyance in HEC-RAS is different from HEC-2. However, HEC-RAS has 
the ability to compute conveyance with the HEC-2 methodology. If you are trying to reproduce HEC-2 
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results, you may want to switch HEC-RAS to the HEC-2 method of computing conveyance. To do this, from 
the Steady Flow Analysis window select Options from the menu bar then select Conveyance Calculations. 
When this is selected, a pop up window will appear as shown in figure shown below. There are two options 
available, the HEC-RAS default method (break in n-value method) and the HEC-2 style method. Select the 
HEC-2 style method if you are trying to reproduce HEC-2 results. For more information on the differences in 
conveyance calculations, see Appendix C of the HEC-RAS Hydraulic Reference manual.

The HEC-RAS bridge routines are more comprehensive than the HEC-2 bridge routines, and therefore 
differences can occur at bridge locations. First, review the bridge data closely and make sure it accurately 
represents the bridge you are trying to model. If you feel it is necessary to match the results of a previous 
study at the bridge, then your only alternative is to adjust the coefficients that are being used in the bridge 
modeling approach (i.e., pressure and weir flow coefficients, low flow coefficients, contraction and 
expansion coefficients, etc...). For detailed information on the differences between the HEC-RAS and HEC-2 
bridge routines, please review Appendix C of the Hydraulic Reference manual.
Sometimes differences can occur at locations where the programs have defaulted to a critical depth 
solution. First you should ask yourself if critical depth is an appropriate solution for this location. It is a 
common problem for both programs to default to critical depth when the cross sections are spaced too far 
apart. If you feel critical depth is an appropriate solution, then in general the HEC-RAS answer will be better 
than HEC-2. The critical depth routines in HEC-RAS are much more comprehensive than HEC-2. HEC-RAS has 
tighter error limits for locating critical depth, as well as the ability to find multiple critical depths and detect 
which is the most appropriate.
Differences can also occur at locations where floodway encroachments are being computed. The HEC-RAS 
floodway encroachment routines have been improved over those available in HEC-2. Also, the default at 
bridges in HEC-RAS is to perform the encroachment analysis, while the default in HEC-2 was to not encroach 
at bridges. For more details on differences between encroachment routines, please review Appendix C of the 
HEC-RAS Hydraulic Reference Manual.
After carefully reviewing items one through five above, if you still have computational differences in the 
computed profiles, you may need to modify Manning's n values in order to reproduce the previous study 
results. In general, this is not suggested. If you do decide to modify the n values, try to keep them within a 
realistic range of what is appropriate for the stream you are working on. 
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20 TERMS AND CONDITIONS OF USE
Use of the program is governed by the terms and conditions of use. They limit what can be done with 
the program software, waive warranty, limit liability, and indemnify the developers and the United 
States government. The program cannot be used unless the terms and conditions of use are 
accepted; the full text is given below.

The United States Government, US Army Corps of Engineers, Hydrologic Engineering Center ("HEC") 
grants to the user the rights to install River Analysis System (HEC-RAS) "the Software" (either from a 
disk copy obtained from HEC, a distributor or another user or by downloading it from a network) and 
to use, copy and/or distribute copies of the Software to other users, subject to the following Terms 
and Conditions of Use:

All copies of the Software received or reproduced by or for user pursuant to the authority of this 
Terms and Conditions of Use will be and remain the property of HEC.

User may reproduce and distribute the Software provided that the recipient agrees to the Terms and 
Conditions for Use noted herein.

HEC is solely responsible for the content of the Software. The Software may not be modified, 
abridged, decompiled, disassembled, unobfuscated or reverse engineered. The user is solely 
responsible for the content, interactions, and effects of any and all amendments, if present, whether 
they be extension modules, language resource bundles, scripts or any other amendment.

The name "HEC-RAS" must not be used to endorse or promote products derived from the Software. 
Products derived from the Software may not be called "HEC-RAS" nor may any part of the "HEC-RAS" 
name appear within the name of derived products.

No part of this Terms and Conditions for Use may be modified, deleted or obliterated from the 
Software.

No part of the Software may be exported or re-exported in contravention of U.S. export laws or 
regulations.

Waiver of Warranty

THE UNITED STATES GOVERNMENT AND ITS AGENCIES, OFFICIALS, REPRESENTATIVES, AND 
EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS PROVIDE HEC-RAS "AS IS", WITHOUT 
ANY WARRANTY OR CONDITION, EXPRESS, IMPLIED OR STATUTORY, AND SPECIFICALLY DISCLAIM 
ANY IMPLIED WARRANTIES OF TITLE, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NON-INFRINGEMENT. Depending on state law, the foregoing disclaimer may not apply to you, and 
you may also have other legal rights that vary from state to state.

Limitation of Liability

IN NO EVENT SHALL THE UNITED STATES GOVERNMENT AND ITS AGENCIES, OFFICIALS, 
REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS, BE LIABLE 
FOR LOST PROFITS OR ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF 
OR IN CONNECTION WITH USE OF HEC-RAS REGARDLESS OF CAUSE, INCLUDING NEGLIGENCE.

THE UNITED STATES GOVERNMENT'S LIABILITY, AND THE LIABILITY OF ITS AGENCIES, OFFICIALS, 
REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS, TO YOU OR 
ANY THIRD PARTIES IN ANY CIRCUMSTANCE IS LIMITED TO THE REPLACEMENT OF CERTIFIED COPIES 
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OF HEC-RAS WITH IDENTIFIED ERRORS CORRECTED. Depending on state law, the above limitation or 
exclusion may not apply to you.

Indemnity

As a voluntary user of HEC-RAS you agree to indemnify and hold the United States Government, and 
its agencies, officials, representatives, and employees, including its contractors and suppliers, 
harmless from any claim or demand, including reasonable attorneys' fees, made by any third party 
due to or arising out of your use of HEC-RAS or breach of this Agreement or your violation of any law 
or the rights of a third party.

Assent

By using this program you voluntarily accept these terms and conditions. If you do not agree to these 
terms and conditions, uninstall the program and return any program materials to HEC (If you 
downloaded the program and do not have disk media, please delete all copies, and cease using the 
program.)
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